Product Information

This document applies to IBM Cognos Business Intelligence Version 10.1.1 and may also apply to subsequent releases. To check for newer versions of this document, visit the IBM Cognos Information Centers [http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp].

Licensed Materials - Property of IBM

© Copyright IBM Corporation 2005, 2011.

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Chapter 1. Introduction .................................. 1

Chapter 2. What’s New? ................................... 3

New Features in Version 10.1.1 .............................. 3
   64-bit Report Server .................................. 3
   IBM Cognos Content Archival ............................. 4
   Generate a script for a content store for IBM DB2 .......... 4
   Install IBM Cognos to IBM WebSphere from the Build Application Wizard ......... 4

New Features in Version 10.1.0 .............................. 4
   Dynamic Query Mode .................................. 4
   Collaboration Using IBM Cognos Business Insight ............... 5
   Access to Software Development Kit Installation and Configuration Guide ......... 6

Changed Features in Version 10.1.0 ............................ 6
   Default Installation Location and Web Alias ..................... 6
   Upgrade Manager is Renamed as Lifecycle Manager ............... 6
   Index Search Capabilities are Native to IBM Cognos BI Server ....... 6
   IBM Cognos Go! Dashboard is Merged with Features from IBM Cognos Viewer into One User Interface ......... 7
   IBM Cognos Special Edition is Integrated with the IBM Cognos BI Server Products ............... 7
   Enhanced Support for Authentication Using a RACF Provider ............... 7
   Support for Informix Dynamic Server Database ................... 8
   IBM Cognos Portal Services ................................ 8
   Secure Access When Monitoring System Metrics Externally ............ 8

Deprecated Features in Version 10.1.0 ........................ 9
   Repository Control for Framework Manager Metadata ............... 9

Removed Features in Version 10.1.0 ............................ 9
   Managing Memory for the IBM Cognos Service ...................... 9

New Features in Version 8.4 .................................. 9
   Additional Language Support .................................. 9
   Support for DB2 Universal Driver for Content Store, Metric Store, Notification, and Logging Databases ....... 10
   DB2 on z/OS as Content Store, Logging, or Notification Database ............... 11
   Support for IBM Cognos BI for Linux on System z .................. 12
   Connecting to a Content Store, Logging, or Notification Database in Oracle for Linux on System Z .............. 12
   Support for IPv6 IP Addresses .................................. 12
   IBM Cognos BI 64-bit Installations ............................ 13
   Support for 64-bit Application Servers ............................ 13
   Hide the Namespace from Users During Login ...................... 13

Changed Features in Version 8.4 .............................. 14
   Change in Version of Report Specification Namespace Affects Upgrade ............ 14
   Installing Supplementary Language Documentation Required for Translated Product Documentation ............... 14
   Default Connection to an IBM DB2 Content Store Replaces Microsoft SQL Server ............... 15
   Composite Information Server is Replaced By IBM Cognos Virtual View Manager ............... 15
   Java Runtime Environment Provided by IBM Replaces Sun Java Runtime Environment ............... 15
   IBM Cognos BI for Microsoft Office Installation ............... 15
   IBM Cognos Portal Services .................................. 16
   Multilingual Support for Microsoft Analysis Services Data Sources ............... 16

Deprecated Features in Version 8.4 .............................. 16
   Support for DB2 JDBC Type 2 Driver for the Content Store, Metric Store, Notification, and Logging Databases on Linux, UNIX and Microsoft Windows Operating Systems (db2java.zip) ............... 17

Removed Features in Version 8.4 .............................. 17
   Text-based User Interface for Installing and Uninstalling on UNIX and Linux ............... 17
   Language Support for IBM Cognos BI User Interface Text and Messages Moved from Supplementary Languages to IBM Cognos BI Server Installation ............... 17

New Features in Version 8.3 .............................. 18
   IBM Cognos Transformer .................................. 18
   IBM Cognos Transformer Installation Download ............... 18

© Copyright IBM Corp. 2005, 2011
Chapter 3. Components used by IBM Cognos Business Intelligence

Server components ........................................ 25
   Web communication - gateway ................................ 25
   Application Tier Components ................................ 25
   Managing Application Data - Content Manager ................. 27
   Optional server components .................................. 27
   Modeling components ....................................... 28
   Other components .......................................... 29
   Infrastructure components ................................... 30

Chapter 4. Distribution Options for IBM Cognos BI. ........................................ 31

Distributing IBM Cognos BI Server Components ......................... 31
   All Components on One Computer ................................. 32
   Gateways on Separate Computers ................................. 33
   Application Tier Components and Content Managers on Separate Computers ..................................... 34
   IBM Cognos BI Products on the Same Computer ................. 36
   Consolidate servers for Linux on System z ..................... 36
   Installing 64-bit Versions of IBM Cognos BI Products ............ 37
Installation Options for Windows Modeling Components ....................... 39
   Firewall Considerations ...................................... 39
   Distributing Framework Manager Components .................... 41
   Distributing Transformer Components ............................. 41
   Distributing Metric Designer Components ........................ 43
Distributing IBM Cognos BI Scorecarding Components ....................... 44
   All Components on One Computer ................................ 45
   Gateways on Separate Computers ................................ 45
   Application Tier Components and Content Managers on Separate Computers ..................................... 46
   IBM Cognos BI Products on the Same Computer ................. 48
IBM Cognos BI with Other IBM Cognos Products .......................... 49
   IBM Cognos Products That Can Be Upgraded to IBM Cognos BI .................................................. 50
   IBM Cognos Series 7 Products That Can Be Migrated to IBM Cognos BI .................................................. 51
   IBM Cognos Products That Interoperate with IBM Cognos BI .................................................. 52
   IBM Cognos Series 7 Content That Can Be Recreated in IBM Cognos BI .................................................. 56

Chapter 5. Preparing to Install. ........................................ 57

Review the Release Notes Before You Install .......................... 57
Review Supported Environments .................................... 57
Verify System Requirements ....................................... 58
Review the Default Port Settings for IBM Cognos Business Intelligence ........................................ 59
Guidelines for Creating the Content Store ............................ 60
   Suggested Settings for Creating the Content Store in DB2 on Linux, Windows and UNIX ...................... 61
   Suggested Settings for Creating the Content Store in DB2 on z/OS .................................................. 64
   Suggested Settings for Creating the Content Store in Oracle .................................................. 64
Chapter 6. Upgrading to IBM Cognos Business Intelligence ........................................ 73

Upgrade activities ........................................................................................................ 73
Upgrade Process ............................................................................................................ 74
Planning the Upgrade .................................................................................................. 74
Review the Documentation ......................................................................................... 75
Assess Applications in the Source Environment ....................................................... 76
Perform a Trial Upgrade .............................................................................................. 77
Moving to the Production Environment ...................................................................... 85
Migrating from IBM Cognos Series 7 ......................................................................... 86
Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI . 87
Upgrade from an Earlier Version of IBM Cognos BI .................................................. 91
Upgrading a DB2 Content Store on a System z Operating System ......................... 97
Upgrading Dashboards in IBM Cognos Business Insight ........................................... 98
Install or Upgrade Other Products ............................................................................. 98
Upgrading Using the Silent Configuration Option ...................................................... 99
Migrate Apache Derby Databases to Cognos Content Database ............................... 100
New Product, File, and Directory Names After Upgrade from ReportNet ................ 101
Upgrade ReportNet to IBM Cognos BI ................................................................. 102
Set Up to Publish IBM Cognos Series 7 PowerCubes After Upgrade from ReportNet . 108
Manually Uninstall the ReportNet Service on Windows ........................................... 109
Upgrade Metrics Manager to IBM Cognos BI ......................................................... 109
Run Multiple Versions or Instances of IBM Cognos BI at the Same Time ............... 114
Upgrading IBM Cognos for Microsoft Office ............................................................ 116
Uninstalling previous versions of IBM Cognos for Microsoft Office products ......... 116
Installing IBM Cognos for Microsoft Office .............................................................. 117
Upgrading Transformer Models and PowerCubes .................................................... 118
Prepare Models in IBM Cognos Series 7 Transformer ............................................. 120
Import Unsecured Models in IBM Cognos Transformer ........................................... 120
Upgrade an IBM Cognos Series 7 Secured PowerCube ........................................... 120

Chapter 7. Installing and Configuring IBM Cognos BI Components on One Computer 123
Install Server Components in Interactive Mode ....................................................... 123
Install IBM Cognos BI Server Components ............................................................ 124
Installing server components on UNIX or Linux ...................................................... 125
Installing server components on Windows .............................................................. 127
Install IBM Cognos Metrics Manager ..................................................................... 129
Installing Fix Packs .................................................................................................. 129
Installing Fix Packs (Windows) ................................................................................. 129
Installing Fix Packs (UNIX/Linux) .......................................................................... 130
Java settings .............................................................................................................. 131
Update the Java Environment .................................................................................. 132
JDBC Driver Options for Using DB2 Database as a Content Store ......................... 132
Set Up Database Connectivity for the Content Store Database .............................. 133
Set Up Database Connectivity for a DB2 Content Store .......................................... 133
Set Up Database Connectivity for an Oracle Content Store ................................... 137
Set Up Database Connectivity for an Informix Content Store ............................... 137
Set Up Database Connectivity for a Sybase Content Store .................................... 138
Database Connectivity for the Reporting Database ................................................ 138
Setting up reporting database connectivity on Windows operating systems ........... 139
Setting up reporting database connectivity on UNIX or Linux operating systems .... 139
Setting up reporting connectivity for relational databases to use the dynamic query mode. 140
Setting up reporting connectivity for OLAP data sources to use the dynamic query mode

Configure IBM Cognos Business Intelligence to use Oracle Essbase

Using Oracle Essbase on a UNIX or 64-bit Microsoft Windows operating system

Start IBM Cognos Configuration

Starting IBM Cognos Configuration (UNIX/Linux)

Starting IBM Cognos Configuration (Windows)

Configure Environment Properties in IBM Cognos Configuration

Enable the 64-bit version of report server

Enable Security

Set Database Connection Properties for the Content Store

Setting Database Connection Properties for a DB2 Content Store on UNIX, Linux, or Microsoft Windows

Setting Database Connection Properties for a DB2 Content Store on z/OS

Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store

Specify a Connection to a Mail Server Account

Start the IBM Cognos services

Configure the Web Server

Creating Virtual Directories

Creating an Application Pool

Test the Installation and Configuration

Set Up the Data Source or Import Source Environment

Create the Metric Store Database

Create a DB2 Metric Store Database

Create a Microsoft SQL Server Metric Store Database

Create an Oracle Metric Store using a New Database

Create an Oracle Metric Store Using an Existing Database

Set Up the Database Client for the Metric Store

Set Up the Database Client for a DB2 Metric Store

Set Up the Database Client for an Oracle Metric Store

Set Up the Database Client for a Microsoft SQL Server Metric Store

Create a Metric Package

Create a Metric Package Using a New Data Source Connection

Create a Metric Package Using an Existing Data Source Connection

Create a Metric Package Using an Existing Metric Store

Chapter 8. Installing IBM Cognos BI Server Components on Different Computers

Installation Sequence for Server Components

Recommendation - Install and Configure the Basic Installation for Distributed Installations

Install Server Components in Interactive Mode

Installing and Configuring Content Manager

Active and Standby Content Manager Components

Install the Content Manager Components

Install Content Manager for IBM Cognos Metrics Manager

Installing Fix Packs

Java settings

Set Up Database Connectivity for the Content Store Database

Start IBM Cognos Configuration

Set Database Connection Properties for the Content Store

Configure Environment Properties for Content Manager Computers

Specify a Connection to a Mail Server Account

Enable Security

Start Content Manager

Test the Content Manager Installation

Installing and Configuring Application Tier Components

Install the Application Tier Components

Install Application Tier Components for IBM Cognos Metrics Manager

Installing Fix Packs

Database Connectivity for the Reporting Database

Start IBM Cognos Configuration

Configure Environment Properties for Application Tier Components Computers

Enable the 64-bit version of report server
### Chapter 11. Using Collaboration with IBM Cognos Business Insight

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation considerations</td>
<td>301</td>
</tr>
<tr>
<td>Installation process</td>
<td>302</td>
</tr>
<tr>
<td>Mandatory Updates Required for IBM Connections Installation</td>
<td>305</td>
</tr>
<tr>
<td>Allow access to IBM Connections from IBM Cognos BI</td>
<td>306</td>
</tr>
<tr>
<td>Enable IBM Connections to accept activities created by Business Insight</td>
<td>307</td>
</tr>
<tr>
<td>Enable single signon between IBM Connections and IBM Cognos Business Intelligence</td>
<td>307</td>
</tr>
</tbody>
</table>

### Chapter 12. Configuring IBM Cognos Components to Use an Authentication Provider

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Anonymous Access</td>
<td>312</td>
</tr>
<tr>
<td>Restrict User Access to the Cognos Namespace</td>
<td>313</td>
</tr>
<tr>
<td>Configuring IBM Cognos Components to Use Active Directory Server</td>
<td>313</td>
</tr>
<tr>
<td>Configure an Active Directory Namespace</td>
<td>314</td>
</tr>
<tr>
<td>Make Custom User Properties for Active Directory Available to IBM Cognos Components</td>
<td>315</td>
</tr>
<tr>
<td>Enabling Secure Communication to the Active Directory Server</td>
<td>316</td>
</tr>
<tr>
<td>Include or Exclude Domains Using Advanced Properties</td>
<td>317</td>
</tr>
<tr>
<td>Enabling Single Signon Between Active Directory Server and IBM Cognos Components</td>
<td>318</td>
</tr>
<tr>
<td>Configuring IBM Cognos to Use IBM Cognos Series 7 Namespace</td>
<td>320</td>
</tr>
<tr>
<td>Configure an IBM Cognos Series 7 Namespace</td>
<td>320</td>
</tr>
<tr>
<td>Enabling Secure Communication to the Directory Server Used by the IBM Cognos Series 7 Namespace</td>
<td>321</td>
</tr>
<tr>
<td>Enabling Single Signon Between IBM Cognos Series 7 and IBM Cognos</td>
<td>321</td>
</tr>
<tr>
<td>IBM Cognos Series 7 Namespaces and the IBM Cognos Series 7 Trusted Signon Plug-in</td>
<td>322</td>
</tr>
<tr>
<td>Configuring IBM Cognos to Use a Custom Authentication Provider</td>
<td>324</td>
</tr>
<tr>
<td>Configure a Custom Authentication Namespace</td>
<td>324</td>
</tr>
<tr>
<td>Hide the Namespace from Users During Login</td>
<td>325</td>
</tr>
<tr>
<td>Configuring IBM Cognos Components to Use LDAP</td>
<td>325</td>
</tr>
<tr>
<td>LDAP Mapping</td>
<td>326</td>
</tr>
<tr>
<td>Configure an LDAP Namespace</td>
<td>326</td>
</tr>
<tr>
<td>Configure an LDAP Namespace for Active Directory Server</td>
<td>328</td>
</tr>
<tr>
<td>Configure an LDAP Namespace for IBM Directory Server</td>
<td>330</td>
</tr>
<tr>
<td>Configure an LDAP Namespace for Novell Directory Server</td>
<td>332</td>
</tr>
<tr>
<td>Configure an LDAP Namespace for Oracle Directory Server</td>
<td>334</td>
</tr>
<tr>
<td>Make Custom User Properties for LDAP Available to IBM Cognos Components</td>
<td>336</td>
</tr>
<tr>
<td>Enable Secure Communication to the LDAP Server</td>
<td>337</td>
</tr>
<tr>
<td>Enabling Single Signon Between LDAP and IBM Cognos Components</td>
<td>338</td>
</tr>
<tr>
<td>Replace Operation</td>
<td>338</td>
</tr>
<tr>
<td>Configuring IBM Cognos Components to Use eTrust SiteMinder</td>
<td>339</td>
</tr>
<tr>
<td>eTrust SiteMinder Configured for More Than One User Directory</td>
<td>339</td>
</tr>
<tr>
<td>eTrust SiteMinder Configured With Only One User Directory</td>
<td>340</td>
</tr>
<tr>
<td>Configure a Netegrity SiteMinder Namespace</td>
<td>341</td>
</tr>
<tr>
<td>Enabling Secure Communication to the eTrust SiteMinder User Directory</td>
<td>342</td>
</tr>
<tr>
<td>Enable Single Signon Between eTrust SiteMinder and IBM Cognos</td>
<td>342</td>
</tr>
<tr>
<td>Protecting the IBM Cognos Web Alias</td>
<td>342</td>
</tr>
<tr>
<td>Hide the Namespace from Users During Login</td>
<td>342</td>
</tr>
<tr>
<td>Configuring IBM Cognos Components to Use an NTLM Namespace</td>
<td>343</td>
</tr>
<tr>
<td>Configure an NTLM Namespace</td>
<td>343</td>
</tr>
<tr>
<td>Enable Single Signon Between NTLM and IBM Cognos Components</td>
<td>344</td>
</tr>
<tr>
<td>Configuring IBM Cognos to Use a RACF Provider for Authentication</td>
<td>344</td>
</tr>
<tr>
<td>Configuring a RACF Namespace</td>
<td>344</td>
</tr>
<tr>
<td>Enabling Single Signon Between RACF and IBM Cognos</td>
<td>345</td>
</tr>
<tr>
<td>Delete an Authentication Provider</td>
<td>346</td>
</tr>
</tbody>
</table>

### Chapter 13. Configuration Options

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start IBM Cognos Configuration</td>
<td>348</td>
</tr>
<tr>
<td>Changing Default Configuration Settings</td>
<td>348</td>
</tr>
<tr>
<td>Change Default User and Password for Cognos Content Database</td>
<td>349</td>
</tr>
<tr>
<td>Port and URI Settings</td>
<td>351</td>
</tr>
<tr>
<td>Configuring Cryptographic Settings</td>
<td>353</td>
</tr>
<tr>
<td>IBM Cognos Application Firewall</td>
<td>357</td>
</tr>
<tr>
<td>Encrypt Temporary File Properties</td>
<td>359</td>
</tr>
</tbody>
</table>
Chapter 14. Configuring Portal Services

Specify the Location of the Applications.xml File

Configuring Security for Portal Services

- Disable Anonymous Access to IBM Cognos Components
- Enable Single Signon Using Shared Secret
- Enable Single Signon for SAP EP with the SAP Logon Ticket
- Enable Single Signon for SAP EP with User Mapping
- Enable Secure Communication Between SAP EP and IBM Cognos Components
- Enable Single Signon for WebSphere Portal Using the Application Server
- Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication
- Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder

Chapter 15. Configuring IBM Cognos Business Intelligence for an Application Server other than Tomcat

Create a Separate JVM Instance

Check the Setup of IBM Cognos Components

Back Up Existing IBM Cognos Information

Set Environment Variables

Adjust the Default Connection Time-out for IBM Cognos Business Intelligence

Add User Role to Enable Single Signon Between IBM WebSphere Profiles

Configure IBM Cognos Components to Run Within the Application Server

Use the Build Application Wizard to build and install IBM Cognos on IBM WebSphere

Identifying the JDK for WebLogic 9 on AIX

Change the Application Server Startup Script for WebLogic

Configure Application Server Properties and Deploy IBM Cognos Components

Configure Application Server Properties and Deploy IBM Cognos Components for WebSphere

Configure Application Server Properties and Deploy IBM Cognos Components for WebLogic

Configure Application Server Properties and Deploy IBM Cognos Components for SAP NetWeaver on Windows

Configure Application Server Properties and Deploy IBM Cognos Components for Oracle Application Server Release 3

Configure Application Server Properties and Deploy IBM Cognos Components for JBoss

Configure Application Server Properties and Deploy IBM Cognos Components for Sun GlassFish Enterprise Server

Enable SSL

Configuring Web Communication

Configure the Web Server

Configure a Virtual Directory for SAP NetWeaver on Windows

Unregister Dispatchers

Import Content Store Data

Upgrade to IBM Cognos Business Intelligence in an Application Server Environment

Upgrade from Metrics Manager to IBM Cognos Business Intelligence in an Application Server Environment

Chapter 16. Advanced Configuration Options

Changing the Version of Java Runtime Environment Used by IBM Cognos BI Components

Changing the JRE versions

Back Up Existing IBM Cognos Information
Appendix D. Troubleshooting

Troubleshooting a problem

Searching knowledge bases

Getting fixes

Contacting IBM Support

Exchanging information with IBM

Subscribing to Support updates

Log Files

Problems starting IBM Cognos Business Intelligence

CFG-ERR-0106 error when starting the IBM Cognos service in IBM Cognos Configuration

Cryptographic error when starting IBM Cognos Business Intelligence

Unable to start the IBM Cognos service because the port is used by another process

IBM Cognos service does not start or fails after starting

IBM Cognos Business Intelligence server fails to start and gives no error message

IBM Cognos Business Intelligence server not available when starting IBM Cognos BI

Cannot log on to a namespace when using IBM Cognos Connection

IBM Cognos services fail to restart after a network outage

No warning that installing a later version of IBM Cognos Business Intelligence will automatically update the earlier version of the content store

Download of resource fails

DB2 returns SQL1224N error when connecting from AIX

Content Manager error when starting IBM Cognos Business Intelligence

Content Manager fails to start or takes a long time to start

DPR-ERR-2014 error displays in log file on Content Manager computer

Non-ASCII characters in installation directory cause run-time errors

Cannot Open an MS Cube or PowerCube

The page cannot be found when starting IBM Cognos Business Intelligence in Windows 2003

The page is not shown when opening a portal after installing IBM Cognos Business Intelligence

DPR-ERR-2058 Error Displays in Web Browser When Starting IBM Cognos Business Intelligence

Report Studio does not start

DPR-ERR-2022 error displays in Web browser when starting IBM Cognos Business Intelligence

Corrupt characters while installing in some languages on Linux

Unable to download the cognos.xts file

Application server startup script fails

IBM Cognos Business Intelligence running under WebLogic Application Server on AIX fails

Deploying IBM Cognos Business Intelligence to an Oracle Application Server or IBM WebSphere Application Server fails

Unable to deserialize context attribute error when deploying the p2pd.war file to WebLogic

Error displays after upgrading IBM Cognos Business Intelligence on a WebLogic Application Server

Chinese, Japanese, or Korean characters are different after upgrade

Accented or double-byte characters may not display correctly when installing IBM Cognos Business Intelligence on Linux

RSV-SRV-0066 a soap fault has been returned or RQP-DEF-0114 the user cancelled the request errors display in high user load environments

Problems configuring IBM Cognos Business Intelligence

Configuration Tool cogconfig.sh Return Values Are Not Compliant with Conventional UNIX Return Values

Running Database and Index Cleanup Scripts

Error trying to encrypt information when saving your configuration

Problems generating cryptographic keys in IBM Cognos Configuration

CAM-CRP-1315 error when saving configuration

CAM-CRP-0221 error when logging into the portal

Manually changing the installation directory name affects installations running under an application server

Configuration data is locked by another instance of IBM Cognos Configuration

Unable to exit a tab sequence when using keyboard-only navigation in IBM Cognos Configuration

Unable to save your configuration

Java error when starting IBM Cognos Configuration

Cryptographic error when starting IBM Cognos Configuration

Restarting the IBM Cognos service to apply configuration settings

CM-CFG-029 error when trying to save a configuration that specifies a Microsoft SQL Server content store
Chapter 1. Introduction

This document is intended for use with IBM® Cognos® Business Intelligence. IBM Cognos BI is a Web product with integrated reporting, analysis, scorecarding, and event management features.

This guide contains instructions for installing, upgrading, configuring, and testing IBM Cognos BI, changing application servers, and setting up samples.

Audience

To use this guide, you should be familiar with
• reporting concepts
• scorecarding concepts
• database and data warehouse concepts
• security issues
• basic Windows and/or UNIX administration skills
• the existing server environment and security infrastructure in your organization

Finding information

To find the most current product documentation, including all translated documentation, access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

IBM Cognos Software Development Kit Product Documentation

After you install the IBM Cognos Software Development Kit, developer documentation is available from within the product.

You can access the documentation by the following methods:
• On Framework Manager computers, from the Start menu, click the IBM Cognos documentation shortcut folder.
• In IBM Cognos Administration, click Help > More Documentation, and under IBM Cognos Documentation you can open Software Development Kit documents in PDF or HTML format.
• In the c10_location\webcontent\documentation\en folder, you can open the documents in PDF or HTML format.

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see “Keyboard Shortcuts for the Installation Wizard” on page 499.
Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 2. What's New?

This section contains a list of new, changed, deprecated, and removed features that affect installation and configuration for this release. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

For information about upgrading, see the Installation and Configuration Guide for your product.

For information about other new features for this release, see the New Features Guide.

For changes to the current release, see:
- New features in Version 10.1.0
- Changed features in Version 10.1.0
- Deprecated features in Version 10.1.0
- Removed features in Version 10.1.0

For changes to previous versions, see:
- New Features in Version 8.4
- Changed Features in Version 8.4
- Deprecated Features in Version 8.4
- Removed Features in Version 8.4
- New Features in Version 8.3
- Changed Features in Version 8.3
- Deprecated Features in Version 8.3
- Removed Features in Version 8.3

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

New Features in Version 10.1.1

Listed below are new features for 10.1.1.

64-bit Report Server

In the 64-bit installations, the report server component, included with the Application Tier Components, is provided in both 32- and 64-bit versions. The 64-bit version of report server is intended for use with packages created for dynamic query mode.
Some IBM Cognos BI components are available for 64-bit systems. When installing on a 64-bit system, the components must be installed in the appropriate directories.

**IBM Cognos Content Archival**

IBM Cognos Content Archival allows you to store report output versions and their source report specifications to an external content archival repository. The software supports an IBM FileNet® Content Manager with IBM FileNet® CMIS external repository.

IBM Cognos Content Archival is bundled with the Business Intelligence software and is used with a file system repository for test and development purposes only.

**Generate a script for a content store for IBM DB2**

You can use IBM Cognos Configuration to generate a DDL file that you can use to create a content store in IBM DB2®.

**Install IBM Cognos to IBM WebSphere from the Build Application Wizard**

You can use the Build Application Wizard in IBM Cognos Configuration to install and configure IBM Cognos BI. Additional options have been added to the wizard to allow you to install and configure the product directly from IBM Cognos Configuration.

**New Features in Version 10.1.0**

Listed below are new features for version 10.1.0.

**Dynamic Query Mode**

IBM Cognos Business Intelligence Server offers improved query functionality and performance with a dynamic query mode that you can use with supported data sources.

Some configuration is required before you can use dynamic query mode.
More Information about Dynamic Query Mode

For more information about dynamic query mode, see the documents listed in the following table.

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Where to find the information</th>
</tr>
</thead>
<tbody>
<tr>
<td>An overview of the dynamic query mode, its benefits, and considerations when using it.</td>
<td>IBM Cognos Business Intelligence Dynamic Query Guide</td>
</tr>
<tr>
<td>Information about enabling connectivity for data sources supported by the dynamic query mode.</td>
<td>Installation and Configuration Guide</td>
</tr>
<tr>
<td>Information about query service administration, including caching and query service properties.</td>
<td>Administration and Security Guide</td>
</tr>
<tr>
<td>Information about publishing packages for the dynamic query mode.</td>
<td>Framework Manager User Guide</td>
</tr>
<tr>
<td>Information about testing reports in the dynamic query mode prior to upgrade.</td>
<td>Lifecycle Manager User Guide</td>
</tr>
<tr>
<td>Information about using the IBM Cognos Software Development Kit to administer query service properties and develop client applications to use dynamic query mode.</td>
<td>IBM Cognos Software Development Kit Developer Guide</td>
</tr>
</tbody>
</table>

Related concepts

“Database Connectivity for the Reporting Database” on page 138

To support communication between IBM Cognos Business Intelligence and the data sources, you must install additional software for your data sources on the same computer that hosts the report server. Depending on the data source and query mode, the required software might include database clients, or Java Database Connectivity (JDBC) driver files, or both.

Collaboration Using IBM Cognos Business Insight

Collaboration capabilities in IBM Cognos Business Insight provide a bridge between using IBM Cognos Business Intelligence to discover a business problem and using social software to track and resolve the problem. In Version 10.1.0, IBM Connections and all software components required to use it with Cognos BI are bundled with the IBM Cognos BI server products.

Business Insight users can create activities in IBM Connections and share them with other users who collaborate in decision-making and problem-solving processes. To take advantage of this capability, you must install and configure IBM Connections and the software that it requires, including IBM WebSphere Application Server and its updates.
Related concepts

Chapter 11, “Using Collaboration with IBM Cognos Business Insight,” on page 301

Collaboration capabilities in IBM Cognos Business Insight provide a bridge between using IBM Cognos Business Intelligence to discover a business problem and acting to resolve it.

Access to Software Development Kit Installation and Configuration Guide

In previous releases, the documentation for IBM Cognos Software Development Kit was not available online.

In Version 10.1.0, the IBM Cognos Software Development Kit Installation and Configuration Guide is available from the IBM Cognos Information Center, at http://publib.boulder.ibm.com/infocenter/cbi/v10r1m0/.

Changed Features in Version 10.1.0

Listed below are changes to features since the last release. Links to directly-related topics are included.

Default Installation Location and Web Alias

The path for the default installation directory is changed in IBM Cognos Business Intelligence, Version 10.1.0.

The default location, represented by $c10_location$ in this guide, is as follows:

- Microsoft Windows operating system
  C:\Program Files\IBM\cognos\c10
- UNIX and Linux operating systems
  /usr/IBM/cognos/c10

The default Web alias in IBM Cognos Configuration is changed from cognos8 to ibmcognos.

Upgrade Manager is Renamed as Lifecycle Manager

Lifecycle Manager is a Microsoft Windows operating system-based application for auditing upgrades from ReportNet® 1.1 MR3 or MR4 and earlier versions of IBM Cognos BI to newer versions of IBM Cognos Business Intelligence. In earlier releases, it was named Upgrade Manager.

Index Search Capabilities are Native to IBM Cognos BI Server

In earlier releases, index search capabilities were available by installing IBM Cognos Go! Search with your IBM Cognos BI server product.

The index search capability is now the default search mode in the IBM Cognos BI server product. You do not need to install a separate package, but some configuration is required to enable index services and configure scalability, and you must create the index before using the index search capability.

For information about creating the index and about configuring user permissions for index search, see the Administration and Security Guide.
Related concepts
“Configuring IBM Cognos Index Search” on page 403
Index search capability is included with your IBM Cognos Business Intelligence server product as the default search capability. To use index search, you must configure the indexing services and create at least one index. If a search result includes a URL, the URL must be in a trusted domain before users can access it.

IBM Cognos Go! Dashboard is Merged with Features from IBM Cognos Viewer into One User Interface
In earlier releases, an interactive dashboard application was available by installing IBM Cognos Go! Dashboard with your IBM Cognos BI server product. In addition, IBM Cognos Viewer provided the basic report consumption experience.

IBM Cognos Go! Dashboard and features from IBM Cognos Viewer are now merged into one user interface. This brings the information consumption, rather than viewing and opening folders, to the forefront of the experience. However, IBM Cognos Viewer is still available and maintained in this release. You do not need to install a separate dashboard package, but some tasks are required to upgrade from IBM Cognos Go! Dashboard.

Related concepts
“Configuring IBM Cognos Business Insight” on page 407
IBM Cognos Business Insight is included with IBM Cognos BI server. It delivers dynamic and customizable features that allow you to quickly and easily assemble interactive workspaces using IBM Cognos content, as well as external data sources. After you test that Business Insight is running, configure access to the secured functions and features.

Related tasks
“Enabling Chart Animation in Business Insight” on page 98
By default, chart animation is not enabled in Business Insight. If your workspaces from IBM Cognos Go! Dashboard include charts with animation, you must add an advanced property in IBM Cognos Configuration to enable the chart animation.

IBM Cognos Special Edition is Integrated with the IBM Cognos BI Server Products
In earlier releases, IBM Cognos Special Edition provided you with all of the IBM products to create an enterprise reporting solution. The products included IBM WebSphere Application Server, IBM DB2 Universal Database™, and IBM HTTP Server. In Version 10.1.0, these products are bundled with the IBM Cognos BI server products.

Enhanced Support for Authentication Using a RACF Provider
In earlier releases, if you wanted to use a Resource Access Control Facility (RACF®) provider for authentication with IBM Cognos BI server, you created a custom Java provider and then configured a Custom Java Provider namespace in IBM Cognos Configuration to use it. In IBM Cognos BI server, Version 10.1.0, you can configure a RACF namespace directly in IBM Cognos Configuration on UNIX AIX® or on Linux for System z® operating systems.
Related tasks

“Configuring IBM Cognos to Use a RACF Provider for Authentication” on page 344

If you use a Resource Access Control Facility (RACF) provider for authentication in your enterprise environment, you can also use it for authentication in IBM Cognos products.

Support for Informix Dynamic Server Database

IBM Cognos Business Intelligence server supports the use of Informix® Dynamic Server as a database for the content store, notification database, and log database.

Scripts are also provided for cleaning up the tables and indexes in an Informix Dynamic Server database.

Related concepts

“Guidelines for Creating the Content Store” on page 60
The content store is a database that Content Manager uses to store global configuration data, global settings (such as the language and currency formats shown in the user interface), connections to data sources, and product-specific content. You must use one of the supported enterprise-level databases as the content store in a production environment.

“Configuring a Repository for Log Messages” on page 375
The BI Bus protocol includes log message processing, an important diagnostic tool for investigating the behavior of IBM Cognos BI.

Related tasks

“Running Database and Index Cleanup Scripts” on page 544
In some troubleshooting situations, you may be advised to start with new configuration data.

IBM Cognos Portal Services

BEA AquaLogic User Interaction (ALUI) Portal is replaced by Oracle WebCenter Interaction Portal.

Related concepts

Chapter 14, “Configuring Portal Services,” on page 429
Portal Services provides a set of IBM Cognos portlets that you can use in IBM Cognos Connection and in other portals. You can use the portlets to navigate, search, and view IBM Cognos reports in your working environment. Other users can view IBM Cognos information without needing to know how to use IBM Cognos products.

Secure Access When Monitoring System Metrics Externally

In earlier releases, you could monitor system metrics externally to IBM Cognos Administration by using Java Management Extensions (JMX), a technology that supplies tools to manage and monitor applications and service-oriented networks. In IBM Cognos BI Server, Version 10.1.0, IBM Cognos Configuration provides two new properties that you can use to enable secure access to the metrics in the Java environment.
You can monitor system metrics outside of IBM Cognos Administration by using industry standard Java Management Extensions (JMX). First, you configure two JMX properties in IBM Cognos Configuration to enable secure access to the metrics in the Java environment. Then you use a secure user ID and password to connect to the metrics through a JMX connection tool.

### Deprecated Features in Version 10.1.0

A deprecated feature is one that is being replaced by a newer version or a better implementation. The intention is to discontinue the use of the feature and provide recommendations for adapting to this change over multiple releases.

Listed below are deprecated features, including links to related topics.

#### Repository Control for Framework Manager Metadata

In earlier releases, you could configure repository control for Framework Manager metadata using the Source Control Systems property in IBM Cognos Configuration. This property is removed from IBM Cognos Configuration. However, you can continue to use an external source control system to manage your Framework Manager metadata.

For more information, see the section about using external repository control in the Framework Manager *User Guide*.

### Removed Features in Version 10.1.0

Listed below are features that are removed since the last release. Links to directly-related topics are included.

#### Managing Memory for the IBM Cognos Service

In earlier releases, you had two options in IBM Cognos Configuration for configuring the maximum amount of memory for the IBM Cognos service. You could adjust the maximum memory value or you could delete the Cognos service and then select a new service that used a small, medium, or large configuration template. In IBM Cognos BI server, Version 10.1.0, you have the single option of adjusting the maximum memory value.

**Related tasks**

[“Adjusting the Memory Resources for the IBM Cognos Service” on page 477](#)

To improve performance in a distributed environment, you can change the amount of resources that the IBM Cognos service uses.

### New Features in Version 8.4

Listed below are new features since Version 8.3. Links to directly-related topics are included.

#### Additional Language Support

In addition to Japanese, German, and French, the installation documentation and the user interface for the installation program and IBM Cognos Configuration are available in the following languages:

- Chinese (simplified)
During the installation you can select the language to use from the first page of the installation wizard. This determines the language of the user interfaces of the installation wizard and IBM Cognos Configuration.

Related concepts
“Install IBM Cognos BI Server Components” on page 124

Use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. Only the components that you choose to install are copied from the disk to your computer.

Support for DB2 Universal Driver for Content Store, Metric Store, Notification, and Logging Databases

DB2 introduced a universal Java Database Connectivity (JDBC) driver that contains both type 2 and type 4 JDBC driver support. IBM Cognos BI Version 8.4 can connect to a DB2 content store, metric store, notification database, or logging database using either type of JDBC connectivity, but you must first copy two JAR files to the IBM Cognos BI installation directory. If you are upgrading, you can continue to use type 2 JDBC connectivity without changing the connection properties for the DB2 content store.

The two JAR files that you must copy to your IBM Cognos BI installation directory are as follows:

- a license file, for example db2jcc_license_cisuz.jar or db2jcc_license_cu.jar
- a driver file, db2jcc.jar
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

If you are using a database other than Cognos Content Database or Microsoft SQL Server as the content store, you may have to install database client software, or Java Database Connectivity (JDBC) drivers, or both, on each computer where you install Content Manager. Doing this allows Content Manager to access the content store database.

If you are using a database other than Microsoft SQL as a metric store, you must install database client software and Java Database Connectivity (JDBC) drivers on each computer where you install the Application Tier Components for Cognos Metrics Manager. Doing this allows Application Tier Components to access the metric store database.

After you create a database for audit logs, additional steps are required to set up the database client if you use Oracle, DB2, Informix Dynamic Server, or Sybase as the database server.

DB2 on z/OS as Content Store, Logging, or Notification Database

You can use DB2 on z/OS® as your content store, logging, or notification database.

Connection settings to DB2 on z/OS are similar to those for DB2 on Linux, UNIX and Microsoft Windows operating systems. However, additional advanced settings must be configured.

You must run scripts to create tablespaces for storing Large Objects (LOBs).
Related concepts

“Suggested Settings for Creating the Content Store in DB2 on z/OS” on page 64
The database you create for the content store must contain the specified configuration settings.

“Suggested Settings for Creating a DB2 Notification Database on z/OS” on page 368
The database you create for the notification database must contain the specified configuration settings.

“Guidelines for Creating a Logging Database” on page 377
You can create a database to store log messages. Creating a logging database involves the following tasks:

Related tasks

“Create Tablespaces for a DB2 Content Store on z/OS” on page 135
A database administrator must run a script to create a set of tablespaces required for the content store database. The script must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

“Create Tablespaces for the DB2 Notification Database on z/OS” on page 368
A database administrator must run scripts to create a set of tablespaces required for the notification database. The scripts must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

“Create Tablespaces for DB2 Logging Database on z/OS” on page 378
A database administrator must run a script to create a set of tablespaces required for the logging database. The script must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

Support for IBM Cognos BI for Linux on System z
IBM Cognos BI, Version 8.4 is available for Linux on System z operating system. After installing the required server components, you must install Framework Manager on a Microsoft Windows operating system computer to complete a basic installation. Optional server and Windows components are available to extend functionality.

Connecting to a Content Store, Logging, or Notification Database in Oracle for Linux on System Z
IBM Cognos Business Intelligence for Linux on System z operating system supports connecting to a content store, logging, and notification database in Oracle.

Support for IPv6 IP Addresses

For IBM Cognos Configuration to accept IPv6 addresses in the local URI properties, you must start IBM Cognos Configuration with the -ipv6 option. You can specify the option each time you open IBM Cognos Configuration from the command line.
On Microsoft Windows operating system, you can set the option permanently by adding the option to the Start menu shortcut.

Related concepts
"Change the IP Address Version" on page 402

IBM Cognos supports two IP address versions: IPv4 and IPv6. IPv4 uses 32-bit IP addresses and IPv6 uses 128-bit IP addresses. For example:

IBM Cognos BI 64-bit Installations

Some IBM Cognos BI server components are available for installation on 64-bit systems.

If your IBM Cognos BI component is available as a 64-bit installation, the default paths that are used for installation and the Start menu are different from the default paths that are used in 32-bit installations.

The default installation directory, represented by the placeholder $c8_location$ in Version 8.x, is as follows:

- For 32-bit installations, C:\Program Files\cognos\c8
- For 64-bit installations, C:\Program Files\cognos\c8_64

The default shortcut in the Microsoft Windows operating system Start menu is as follows:

- For 32-bit installations, IBM Cognos 8
- For 64-bit installations, IBM Cognos 8 - 64

Before you install IBM Cognos BI on a 64-bit system, check the Release Notes for late-breaking information about distributing the components.

Support for 64-bit Application Servers

IBM Cognos Business Intelligence products are now available with support for 64-bit application servers.

For information about supported application servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/)

Related concepts
Chapter 15, “Configuring IBM Cognos Business Intelligence for an Application Server other than Tomcat,” on page 441

IBM Cognos Business Intelligence installs and uses Tomcat as the application server by default. You can choose to run IBM Cognos BI within another supported server instead:

Hide the Namespace from Users During Login

You can now hide namespaces from users during login. This lets you have trusted signon namespaces without showing them on the namespace selection list that is presented when users log in.
Related tasks

“Hide the Namespace from Users During Login” on page 325
You can hide namespaces from users during login. You can have trusted signon namespaces without showing them on the namespace selection list that is presented when users log in.

Changed Features in Version 8.4

Listed below are changes to features since Version 8.3. Links to directly-related topics are included.

Change in Version of Report Specification Namespace Affects Upgrade

In the current release, the version of the report specification namespace is changed. If you have Software Development Kit applications that create, modify, or save report specifications, do not upgrade your report specifications when you install the new version of IBM Cognos BI. You must first update your Software Development Kit applications to comply with the new IBM Cognos BI report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications.

For information about upgrading report specifications, see the IBM Cognos Software Development Kit Developer Guide.

In addition, limit user access to report specifications, so that users do not inadvertently upgrade report specifications before the Software Development Kit applications are updated. For more information about setting access permissions, see the IBM Cognos BI Administration and Security Guide.

Related concepts

“Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI” on page 87
You must upgrade the software to move from an earlier version of IBM Cognos BI, ReportNet, or Metrics Manager to a new version of IBM Cognos BI. You must upgrade all components. Components from different versions are not compatible. If you are using IBM Cognos Series 7 PowerCubes as a data source, it is not necessary to upgrade Transformer unless you want to use the features of the new version of Transformer. PowerCubes that are built using IBM Cognos Series 7.3 Transformer (or later) and IBM Cognos BI, Version 8.3 Transformer (or later) are both supported with IBM Cognos BI reporting and metrics.

Installing Supplementary Language Documentation Required for Translated Product Documentation

You must install the Supplementary Language Documentation to access product documentation in languages other than English.

By default, when you install the IBM Cognos BI gateway component, the setup installation documentation is installed in all supported languages. The product user documentation, such as the studio user guides, is installed in English.
Related tasks

"Translated Product Documentation" on page 293

The product installation includes a limited set of translated documentation for some languages, such as installation guides and release notes. To access a complete set of translated documentation, you must install it from IBM Cognos BI Supplementary Language Documentation.

Default Connection to an IBM DB2 Content Store Replaces Microsoft SQL Server

When you start IBM Cognos Configuration for the first time, the connection to IBM DB2 replaces Microsoft SQL Server for the default content store.

If you did not install IBM Cognos Content Database, and want to use another database server for the content store, you must delete the default content store. After you uninstall, if you install into the same location as a previous release, your configuration is preserved and the existing content store is used.

Related concepts

"Set Database Connection Properties for the Content Store" on page 183

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

Composite Information Server is Replaced By IBM Cognos Virtual View Manager

Composite Information Server was available with earlier releases of IBM Cognos BI. In the current release, Composite Information Server is replaced by IBM Cognos Virtual View Manager, which is an IBM proprietary product that is based on a new version of Composite Information Server. In this release, the default repository is changed, from Microsoft SQL Server to IBM Informix. If you have Composite data sources defined in IBM Cognos Connection, you must migrate the existing repository to the new default repository.

For more information about migrating the repository, see the IBM Cognos Virtual View Manager User Guide. For more information about data source connections, see the Administration and Security Guide.

Java Runtime Environment Provided by IBM Replaces Sun Java Runtime Environment

IBM Cognos BI now contains the IBM version of the Java runtime environment (JRE) as part of Microsoft Windows operating system installations. This replaces the Sun JRE for 32-bit Windows platforms.

The installation location remains the same. Any content encrypted with Sun JRE can be decrypted with the JRE provided by IBM.

IBM Cognos BI for Microsoft Office Installation

In previous releases, the installation program automatically copied the IBM Cognos for Microsoft Office setup files to the installation directory on the server when server components were installed. After installation, the administrator copied the
IBM Cognos for Microsoft Office setup to a location accessible to end users for installation of the IBM Cognos for Microsoft Office software on their Microsoft Windows operating system clients.

In Version 8.4, IBM Cognos for Microsoft Office client installation files are no longer automatically copied to the server. The client can be installed using the IBM Cognos for Microsoft Office disk provided with IBM Cognos BI.

For more information about installing IBM Cognos for Microsoft Office, see the IBM Cognos for Microsoft Office Installation Guide.

**IBM Cognos Portal Services**

Plumtree Portal is replaced by BEA AquaLogic User Interaction (ALUI) Portal.

**Related concepts**

[Chapter 14, “Configuring Portal Services,” on page 429](#)

Portal Services provides a set of IBM Cognos portlets that you can use in IBM Cognos Connection and in other portals. You can use the portlets to navigate, search, and view IBM Cognos reports in your working environment. Other users can view IBM Cognos information without needing to know how to use IBM Cognos products.

**Multilingual Support for Microsoft Analysis Services Data Sources**

Users in different languages can now connect to a Microsoft Analysis Services 2005 data source from a single instance of IBM Cognos BI.

**Related concepts**

[“Data Sources and Framework Manager” on page 230](#)

The IBM Cognos BI modeling tools create and manage metadata. Framework Manager creates and manages metadata for the reporting functions. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for Framework Manager. Commonly, these things depend on the other technology you use for your data or import source.

[“Data Sources and Transformer” on page 252](#)

The IBM Cognos BI modeling tools create and manage metadata. IBM Cognos Transformer creates and manages metadata for PowerCubes. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for IBM Cognos Transformer. Commonly, these things depend on the other technology you use for your data or import source.

**Deprecated Features in Version 8.4**

A deprecated feature is one that is being replaced by a newer version or a better implementation. The intention is to discontinue the use of the feature and provide recommendations for adapting to this change over multiple releases.

Listed below are deprecated features since Version 8.3, including links to related topics.
Support for DB2 JDBC Type 2 Driver for the Content Store, Metric Store, Notification, and Logging Databases on Linux, UNIX and Microsoft Windows Operating Systems (db2java.zip)

DB2 introduced a universal Java Database Connectivity (JDBC) driver that contains both type 2 and type 4 JDBC driver support. This new universal driver replaces the deprecated type 2 driver, db2java.zip.

You can continue to use type 2 connectivity with no configuration changes required. If you choose to use type 4 connectivity, a configuration change is required.

Related concepts
“Set Database Connection Properties for the Content Store” on page 183

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

Removed Features in Version 8.4

Listed below are features that are removed since Version 8.3. Links to directly-related topics are included.

Text-based User Interface for Installing and Uninstalling on UNIX and Linux

In earlier versions of IBM Cognos BI products, you could run a text-based, or console-mode, installation or uninstallation program on systems that did not have XWindows. In Version 8.4, the text-based installation and uninstallation programs are not available. Users who install on UNIX and Linux operating systems without XWindows must run an unattended installation or uninstallation.

Related tasks
Chapter 19, “Setting Up an Unattended Installation and Configuration,” on page 491

Set up an unattended installation and configuration to do the following:
“Set Up an Unattended Installation Using a File From an Installation on Another Computer” on page 492

Use the following steps to copy IBM Cognos BI components from another installation without being prompted for information.

Language Support for IBM Cognos BI User Interface Text and Messages Moved from Supplementary Languages to IBM Cognos BI Server Installation

IBM Cognos BI comes with a set of user interface text and messages in several more languages than in the previous release. You are no longer required to install supplementary languages from a separate installation program to show the user interface in one of the supported languages. The required files are automatically installed when you install the IBM Cognos BI server.

However, you must use Supplementary Language Documentation to install the Andale WT fonts for Japan and Korea. These fonts map the U+005C value as a yen or won character.
Related tasks

“Additional Language Fonts” on page 293

To add support for the Japanese Yen or Korean Won character, you must install additional fonts from the IBM Cognos BI Supplementary Language Documentation disk.

New Features in Version 8.3

Listed below are new features since Version 8.2. Links to directly-related topics are included.

IBM Cognos Transformer

IBM Cognos Series 7 Transformer is now fully integrated with IBM Cognos BI. You can install this optional component in your IBM Cognos BI environment. It offers all the features of IBM Cognos Series 7 Transformer, and it supports user authentication and logon using supported IBM Cognos BI security providers. Transformer runs on all supported IBM Cognos BI platforms, including Linux, HP/UX Itanium, and Windows Vista operating systems.

You can import metadata, which includes the associated filters and prompts, from IBM Cognos BI packages and reports for use as a data source in IBM Cognos Transformer. For more information, see the topic about creating a new model in the IBM Cognos Transformer User Guide.

Secured cubes created in IBM Cognos Transformer are intended for the IBM Cognos Business Intelligence Web studios and are not compatible with IBM Cognos Series 7.x PowerPlay® products.

Unsecured and password-protected PowerCubes built in IBM Cognos Transformer can be accessed in IBM Cognos BI Version 8.3 Mobile Analysis for local (disconnected) use.

IBM Cognos Transformer supports UTF-8 encodings. Although you can use UTF-8 as a model setting when building PowerCubes, IBM Cognos Transformer does not support multilingual PowerCubes. Modelers must also be aware of differences between content locale in saved reports and the locale that Transformer uses when accessing reports to build PowerCubes. For more information about managing languages and locales in Transformer, see the Transformer User Guide.

Related concepts

“IBM Cognos Transformer” on page 245

You can install IBM Cognos Transformer, the metadata modeling tool for creating PowerCubes for use with IBM Cognos BI, on the same computer as other IBM Cognos BI components, or on a different computer. You can install IBM Cognos Transformer on the same computer as IBM Cognos Series 7 Transformer.

IBM Cognos Transformer Installation Download

Transformer can now be made available more easily for business specialists who want to design models and build PowerCubes for their own use.

For example, IT departments can provide business specialists or Transformer modelers with a Web-based, downloadable installation program from a corporate or secured portal, allowing for easy distribution of the installation files.
If you are the business specialist or Transformer modeler, you must now deploy Transformer so that you can build PowerCubes and publish them to selected users or groups.

Your organization may have specialized business or power users who want to build PowerCubes that are modeled on a combination of corporate and personal data sources. These users may want to do their own analysis of the data for their line of business or a small group of users. An installer or administrator can download an executable file to a Web or LAN location, where modelers can run the file to launch the IBM Cognos Transformer installation wizard.

Series 7 IQD Bridge
IBM Cognos Transformer uses the IBM Cognos BI query engine to support the features in IBM Cognos BI. The Series 7 IQD Bridge component enables IBM Cognos Transformer to continue to support IBM Cognos Series 7 .iqd files, whether the files were authored in IBM Cognos Series 7 Impromptu®, or in IBM Cognos Framework Manager as externalized queries. To use an .iqd data source with IBM Cognos Transformer, install the Series 7 IQD Bridge on each Transformer computer that requires access to this data source type.

The Series 7 IQDBridge is an optional component and is not supported on new platforms such as Linux or HP-UX Itanium operating systems.

You can install IBM Cognos Transformer, the metadata modeling tool for creating PowerCubes for use with IBM Cognos BI, on the same computer as other IBM Cognos BI components, or on a different computer. You can install IBM Cognos Transformer on the same computer as IBM Cognos Series 7 Transformer.

Archive Location Property
In older versions of IBM Cognos BI, report output was saved by default in the content store. You can now configure two additional save locations, one inside IBM Cognos BI and one outside IBM Cognos BI.

By default, report output files are saved in the content store. You have the option of saving a copy of the report output in another file location that is outside or inside IBM Cognos BI. If you use this option, a descriptor file with an _descr extension is also saved. Saved files are not managed by IBM Cognos BI.

Portal Services for Microsoft SharePoint
IBM Cognos BI, Version 8.3 now supports Cognos Portlets inside the Microsoft SharePoint portal. If you want to use this feature, you must configure security after deploying the portlets in the SharePoint portal.
Related concepts
Chapter 14, “Configuring Portal Services,” on page 429
Portal Services provides a set of IBM Cognos portlets that you can use in IBM Cognos Connection and in other portals. You can use the portlets to navigate, search, and view IBM Cognos reports in your working environment. Other users can view IBM Cognos information without needing to know how to use IBM Cognos products.

Support for Windows Vista
IBM Cognos BI, Version 8.3 is supported on Microsoft Windows Vista operating system for client components only. With Windows Vista, Microsoft introduced security enhancements to further protect the Program Files directory. This necessitated changes to environment variables and the directories where user profiles are stored.

Related concepts
“File Location Properties on Windows Vista” on page 421
If you install IBM Cognos client components in an environment that includes Windows Vista, you must change file locations properties in IBM Cognos Configuration so that IBM Cognos can use a single data location for all users. The changes must be made on all computers where IBM Cognos client components are installed.

Changed Features in Version 8.3
Listed below are changes to features since Version 8.2. Links to directly-related topics are included.

IBM Cognos BI for Microsoft Office
In the previous release, the installation wizard showed the name IBM Cognos BI for Microsoft Office and used a default installation directory of Cognos Office. In Version 8.3, the installation wizard shows the name IBM Cognos 8 for Microsoft Office and uses the default installation directory of IBM Cognos 8 for Microsoft Office. The wizard is used for a family of IBM Cognos products that work with Microsoft Office.

In the previous release, you could configure security for Microsoft .NET Framework using a Smart client or a COM add-in. IBM Cognos BI for Microsoft Office Version 8.3 uses the COM add-in only, and no action is required to configure it. In addition, the previous release required that you set custom properties in Microsoft Office templates. In Version 8.3, the custom properties are no longer required.

Related concepts
“Deploying IBM Cognos for Microsoft Office Client” on page 298
IBM Cognos for Microsoft Office is available for deployment with IBM Cognos BI components. After IBM Cognos BI is installed and configured, you can install IBM Cognos for Microsoft Office on client workstations.

“IBM Cognos BI for Microsoft Office” on page 296
IBM Cognos BI for Microsoft Office is available for deployment with all IBM Cognos BI products, except for IBM Cognos BI Metrics Manager.

Product Behavior After Upgrade
When you upgrade from IBM Cognos BI, Version 8.2 to Version 8.3, some features in IBM Cognos BI may behave differently after the upgrade. When you upgrade
reports, for example, changes in behavior may cause validation errors. Documentation is available about the behavior changes. This documentation includes examples of the changed behavior and solutions for issues that may occur during the upgrade.

For more information, search for Upgrading to IBM Cognos 8 BI 8.3: Changes in Product Behavior in the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

Installing Transformer

In previous releases, you could not install IBM Cognos Series 7 Transformer and IBM Cognos Transformer Version 8 on the same computer. With IBM Cognos Transformer Version 8.3, you can install it on a computer that has IBM Cognos Series 7 Transformer, with no conflicts.

In previous releases of Transformer, the installation location was a cent directory, where n represented the Transformer 7.x rendition number. In Version 8.3, the IBM Cognos Transformer installation location is the same c8 directory used by all other IBM Cognos BI products.

The IBM Cognos Transformer executable name (on Microsoft Windows and UNIX operating systems) and .ini file names are now cogtr.

Note: When IBM Cognos Transformer is installed on Windows Vista, if you do not have Administrator privileges on the computer and you make changes to the cogtr.xml file, the updated file is saved by default to a Virtual Store directory and not to the c8_location/configuration directory.

Model-, PowerCube- and Log files for IBM Cognos Transformer are maintained in the ..\My Documents\Transformer\ directory, in an appropriate subdirectory. Data Source and Temp file directories are stored in the default locations that are specified in IBM Cognos Configuration. To store them in a separate location, you can specify new locations in Transformer.

Related concepts

"Install IBM Cognos Transformer" on page 246
You install Transformer if you plan to create PowerCubes for use with IBM Cognos BI.

Configuring Transformer

Unlike previous versions of Transformer, which used IBM Cognos Series 7 Configuration Manager, IBM Cognos Transformer uses IBM Cognos Configuration for product configuration. This allows for complete integration with all IBM Cognos Business Intelligence products.

Related concepts

"Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components" on page 249
You must configure IBM Cognos Transformer to communicate with the other IBM Cognos BI components.

IBM Cognos BI Samples

In previous versions of IBM Cognos BI, the samples were installed automatically with the server components. Now the samples are on a separate disk in your IBM
Cognos BI product. If you want to use the samples, you must install them from the IBM Cognos Business Intelligence Samples disk.

Related concepts

“Install the IBM Cognos Business Intelligence Samples” on page 266

The IBM Cognos Business Intelligence samples illustrate product features and technical and business best practices. You can also use them for experimenting with and sharing report design techniques, and for troubleshooting. If you want to use the samples, install them from the IBM Cognos Business Intelligence Samples disk or from the location where you downloaded and extracted the files.

IBM Cognos BI Quick Tours

Quick Tours are not installed automatically when you install IBM Cognos BI. However, the quick tours are accessible to users with Internet access.

If you want to install the quick tours locally, you can install them from the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

Related tasks

“Install Quick Tours Locally” on page 295

The quick tours are accessible from the IBM Cognos Web site for users with Internet access. For users without Internet access, or if you prefer to install the quick tours locally, you can download them from the IBM Cognos Customer Center and install them in the same location as the Gateway component. All language versions of the quick tours are available from the Web site and from the IBM Cognos Customer Center.

Deprecated Features in Version 8.3

A deprecated feature is one that is being replaced by a newer version or a better implementation. The intention is to discontinue the use of the feature and provide recommendations for adapting to this change over multiple releases.

Listed below are deprecated features, including links to related topics.

Configuring Content Manager

The Create symmetric key store property could be enabled or disabled in older versions. It was typically set to true on the active Content Manager and false on standby Content Managers. These settings enabled standby Content Managers to retrieve the master common symmetric key from the active Content Manager.

The Create symmetric key store property is deprecated in Version 8.3 because Content Managers can now dynamically determine the active Content Manager and automatically retrieve the key.
You can install more than one Content Manager to ensure failover, and you can install Content Manager in a separate location than other components to enhance performance.

**Configuring cogformat.xml: Notice of Intent to Change**

Currently, configuring the cogformat.xml file location and format specification properties is done at installation time. The information is saved to a configuration file on the local computer and the configuration file is preserved when you upgrade.

In the next release, configuring the cogformat.xml file location and format specification properties will be done in IBM Cognos Administration. The properties will be stored in the content store and available to all groups and roles. To prepare for this change, you must create a backup of any customizations you made to this file.

**Related concepts**

“Upgrade from an Earlier Version of IBM Cognos BI” on page 91

You can upgrade IBM Cognos BI in the same directory as an earlier version or in a different directory, depending on where you are in the process. For example, if you are setting up your test environment, you install in a new directory. If you have finished testing your applications and want to upgrade the software in your production environment, you can install in the same directory after uninstalling the earlier version.

**Removed Features in Version 8.3**

Listed below are features that are removed since Version 8.2. Links to directly-related topics are included.

**Smart Client Deployment for IBM Cognos BI for Microsoft Office**

IBM Cognos BI for Microsoft Office deployment no longer supports the smart client. You must use the COM add-in client, which requires that an installation be run on user computers. If IBM Cognos Office Connection is upgraded with a later release, COM add-in users must install the newer version.

**Related concepts**

“IBM Cognos BI for Microsoft Office” on page 296

IBM Cognos BI for Microsoft Office is available for deployment with all IBM Cognos BI products, except for IBM Cognos BI Metrics Manager.
Chapter 3. Components used by IBM Cognos Business Intelligence

IBM Cognos Business Intelligence is a Web-based business intelligence solution with integrated reporting, analysis, scorecarding, and event management features. IBM Cognos Business Intelligence includes IBM Cognos Business Intelligence Server and IBM Cognos Business Intelligence Modeling.

IBM Cognos BI integrates easily into your existing infrastructure by using resources that are in your environment. Some of these existing resources are required, such as using a database for the content store. Other resources are optional, such as using a security provider for authentication, or using an application server.

By default, IBM Cognos BI uses Tomcat as an application server. You can configure IBM Cognos BI products to run on supported application servers that you currently use in your environment.

**Server components**

Server components provide the user interfaces for reporting, analysis, scorecarding, and event management, as well as the server functionality for routing and processing user requests.

In the installation program, you can select to install the following server components:

- **gateway**
- **Application Tier Components**
- **Content Manager**

**Web communication - gateway**

Web communication in IBM Cognos Business Intelligence is typically through gateways, which reside on one or more Web servers. A gateway is an extension of a Web server program that transfers information from the Web server to another server.

Gateways are often CGI programs, but may follow other standards, such as Internet Server Application Program Interface (ISAPI), Apache Modules (apache_mod), or as a servlet implementation.

**Application Tier Components**

The IBM Cognos Business Intelligence applications tier contains one or more IBM Cognos BI servers. An IBM Cognos BI server runs requests, such as reports, analyses, and queries, that are forwarded by a gateway. An IBM Cognos BI server also renders the IBM Cognos Connection and studio interfaces.

**Configuring and managing the product - IBM Cognos Configuration**

IBM Cognos Configuration is a tool that you use to configure IBM Cognos BI, and to start and stop its services.
**Publishing, managing, and viewing content - IBM Cognos Connection**

IBM Cognos Connection is a Web portal provided with IBM Cognos BI, providing a single access point to the corporate data available for its products. It provides a single point of entry for querying, analyzing, and organizing data, and for creating reports, scorecards, and events. Users can run all their Web-based IBM Cognos BI applications through IBM Cognos Connection. Other business intelligence applications, and web addresses to other applications, can be integrated with IBM Cognos Connection.

**Central administration - IBM Cognos Administration**

IBM Cognos Administration is a central management interface that contains the administrative tasks for IBM Cognos BI. It provides easy access to the overall management of the IBM Cognos environment and is accessible through IBM Cognos Connection.

**Viewing and interacting with published content - Cognos Viewer**

Cognos Viewer is a portlet in which you can view and interact with any type of published IBM Cognos content. It is accessible through IBM Cognos Connection and any existing enterprise portal.

**Professional reporting - Report Studio**

Using Report Studio, report authors create, edit, and distribute a wide range of professional reports. They can also define corporate-standard report templates for use in Query Studio, and edit and modify reports created in Query Studio or Analysis Studio.

**Ad hoc querying and self-service reporting - Query Studio**

Using Query Studio, users with little or no training can quickly design, create and save reports to meet reporting needs not covered by the standard, professional reports created in Report Studio.

**Monitoring data for exceptional conditions - Event Studio**

In Event Studio, you set up agents to monitor your data and perform tasks when business events or exceptional conditions occur in your data that must be dealt with. When an event occurs, people are alerted to take action. Agents can publish details to the portal, deliver alerts by email, run and distribute reports based on events, and monitor the status of events. For example, a support call from a key customer or the cancellation of a large order may trigger an event, sending an email to the appropriate people.

**Analyzing metrics - Metric Studio**

In Metric Studio, you can create and deliver a customized scorecarding environment for monitoring and analyzing metrics throughout your organization. Users can monitor, analyze, and report on time-critical information by using scorecards based on cross-functional metrics.
Facilitating decision-making - IBM Cognos Business Insight

In IBM Cognos Business Insight, you can create sophisticated interactive workspaces using IBM Cognos content, as well as external data sources such as TM1® Websheets and CubeViews, according to your specific information needs. You can view and open favorite workspaces and reports, manipulate the content in the workspaces, and email your workspaces. You can also use comments and activities for collaborative decision making.

You can also use social software such as IBM Connections for collaborative decision making.

Microsoft Office compatibility - IBM Cognos for Microsoft Office

Using IBM Cognos for Microsoft Office, Microsoft Office users can access data from IBM Cognos reporting products within Microsoft Office applications.

IBM Cognos for Microsoft Office components are included with IBM Cognos BI and must be installed separately.

IBM Cognos for Microsoft Office is not included with IBM Cognos Metrics Manager.

Managing Application Data - Content Manager

Content Manager is the IBM Cognos Business Intelligence service that manages the storage of customer application data, including security, configuration data, models, metrics, report specifications, and report output. Content Manager is needed to publish packages, retrieve or store report specifications, manage scheduling information, and manage the Cognos namespace.

Content Manager stores information in a content store database.

Optional server components

The following optional components are available to install on the server to extend the functionality of IBM Cognos Business Intelligence.

Preconfigured application database - Cognos Content Database

Cognos Content Database is an instance of an Apache Derby database. It is a selectable installation component, and is not installed by default. If you install it in the same location as Content Manager, Cognos Content Database is configured as the default content store for IBM Cognos Business Intelligence.

Use Cognos Content Database in a test or proof-of-concept environment only.

Apache Derby is open source software whose license terms can be found on the Apache Derby web site. Modifying the Apache Derby database or using it with other products is not supported. Any modifications that you make to the Apache Derby database are at your own risk.

You can use Cognos Content Database as a content store or notification database, but not as a query database.
Learning and troubleshooting using sample data - IBM Cognos BI Samples

The IBM Cognos BI samples illustrate product features and technical and business best practices using data from a fictitious company, The Sample Outdoors Company. You can also use them for experimenting with and sharing report design techniques, and for troubleshooting.

Online introductory training - IBM Cognos BI Quick Tours

Quick tours are short online tutorials that illustrate key features in IBM Cognos product components. To view a quick tour, an administrator must download it from the IBM Cognos Customer Center Web site and then install it.

Accessing multiple data sources - IBM Cognos BI Virtual View Manager

IBM Cognos BI Virtual View Manager provides access to additional data sources such as LDAP, Java Database Connectivity (JDBC), Open XML and WSDL, and improves performance when querying data from different data sources.

Modeling components

Modeling components model data within data sources to structure and present data in a way that is meaningful to users. Modeling components include the following tools:

Creating a business view of your data - Framework Manager

Framework Manager is the IBM Cognos Business Intelligence modeling tool for creating and managing business-related metadata for use in IBM Cognos BI analysis and reporting. Metadata is published for use by reporting tools as a package, providing a single, integrated business view of any number of heterogeneous data sources.

Extracting data for scorecarding - Metric Designer

Metric Designer is the IBM Cognos BI modeling tool used to create extracts for use in IBM Cognos BI scorecarding applications. Extracts are used to map and transfer information from existing metadata sources such as Framework Manager and Impromptu Query Definition (.iqd) files.

Multidimensional modeling - IBM Cognos Transformer

IBM Cognos Transformer is the IBM Cognos BI modeling tool used to create PowerCubes for use in IBM Cognos BI. Secured IBM Cognos BI PowerCubes are not compatible with IBM Cognos Series 7.

For information about installing and configuring versions of Transformer that are earlier than 8.4, see the documentation provided with your edition of Transformer.

Series 7 IQD Bridge

The Series 7 IQD Bridge contains the connection information that IBM Cognos BI requires to use IBM Cognos Series 7 Impromptu IQD data sources and IBM Cognos BI Framework Manager externalized queries in IBM Cognos Transformer.
It also supports the multi-processing setting in Series 7 models that are imported into IBM Cognos Transformer.

**Import and manage maps - Map Manager**

Administrators and modelers use a Microsoft Windows operating system utility named Map Manager to import maps and update labels for maps in Report Studio. For map features such as country or region and city names, administrators and modelers can define alternative names to provide multilingual versions of text that appears on the map.

For information about using Map Manager, see the Map Manager *Installation and User Guide*.

**Other components**

In addition to the tools that are provided, IBM Cognos Business Intelligence requires the following components that are created using other resources.

**Content store**

The content store is a relational database that contains data that your IBM Cognos BI product needs to operate, such as report specifications, published models, and the packages that contain them; connection information for data sources; information about the external namespace, and the Cognos namespace itself; and information about scheduling and bursting reports.

Your IBM Cognos BI product includes an embedded database, Cognos Content Database, that you can use to get your product running quickly in a test or proof-of-concept system. When you are ready to set up a production environment with your IBM Cognos BI product, set up the content store to use a supported database that can be secured and tuned for performance and stability. The administration portal provides features that you can use to back up and archive the data from Cognos Content Database before moving to the new content store database in your production environment. For more information, see the topic about deploying the entire content store in the *IBM Cognos Business Intelligence Administration and Security Guide*.

Design models and log files are not stored in the content store.

The IBM Cognos service that uses the content store is named Content Manager.

**Metric store**

A metric store is a relational database that contains content for metric packages. A metric store also contains Metric Studio settings, such as user preferences.

More than one metric store may be created. For example, one metric store may contain content for a sales application and another metric store may contain content for a finance application.

**Data sources**

Data sources, also known as query databases, are relational databases, dimensional or OLAP cubes, files, or other physical data stores that can be accessed through
IBM Cognos BI. Application Tier Components use data source connections to access data sources.

Infrastructure components

In addition to the business intelligence software, some offerings of IBM Cognos Business Intelligence include the following products.

IBM WebSphere Application Server

IBM WebSphere Application Server can be used for the IBM Cognos BI report server components (Application Tier Components) and Content Manager. IBM WebSphere Application Server provides a secure and scalable application infrastructure for the IBM Cognos service-oriented architecture (SOA).

Scripts are provided to automate the process of creating distinct ports for multiple applications.

IBM Connections

IBM Connections is social networking software designed for the workplace. IBM Connections allows you to create and manage activities based on workspaces you create using IBM Cognos Business Insight.

IBM HTTP Server

IBM HTTP Server is a Web server based on a partnership between IBM and the Apache Web server.

IBM DB2 Universal Database

IBM DB2 Universal Database provides the content store for your IBM Cognos BI data. DB2 provides industry leading performance, scalability, and reliability.

Scripts are provided to automate the process of creating and configuring a new content store.
Chapter 4. Distribution Options for IBM Cognos BI

Before implementing IBM Cognos Business Intelligence, decide how you will install it in your environment. You can install all IBM Cognos BI components on one computer, or distribute them across a network. The best distribution option depends on your reporting or scorecarding requirements, resources, and preferences. Configuration requirements differ depending on whether you install all components on one computer or more than one computer.

IBM Cognos BI is compatible with other IBM Cognos products. If your environment includes other IBM Cognos products, you must consider how IBM Cognos BI will fit into that environment.

Distributing IBM Cognos BI Server Components

When you install IBM Cognos BI server components, you specify where to place the gateways, Application Tier Components, and Content Manager. You can install these components using any of these options:

- Install all components on one computer.
  This option is typically used for a demonstration or in a proof of concept environment.
- Install the gateway on a separate computer.
  In this option, the gateway and Web server are on one computer, and the remaining IBM Cognos components are on other computers. You may choose this option if you have existing Web servers available to handle IBM Cognos component requests.
- Install Application Tier Components and Content Manager on separate computers.
  Choose this option to maximize performance, availability, capacity, or security based on the processing characteristics of your organization.
  If you plan to install Cognos Content Database, you can install it on the same computer as Content Manager or on another computer. If you install it on the same computer and in the same location, Cognos Content Database is automatically configured for use as your content store. If you install it on another computer, ensure that you set the connection properties for Cognos Content Database on your Content Manager computer.
- Install IBM Cognos BI server components in the same location as other IBM Cognos BI products.
  Different IBM Cognos BI products share components, such as the Content Manager. If you plan to install the IBM Cognos BI reporting and scorecarding components on the same computer, for example, install them in the same installation location. This conserves resources such as disk space and memory consumption by services.
- Consolidate multiple servers by installing on System z
  IBM Cognos BI is supported for Linux on System z operating system. This type of installation is suitable when you are setting up or customizing an installation in your environment to suit IT and infrastructure requirements.
- Install components on 64-bit systems
Some IBM Cognos BI components are available for 64-bit systems. Whether you are installing all server components together on a single server or on multiple servers, 32-bit and 64-bit components must be in separate directories.

After installing IBM Cognos BI server components, you must configure them so they can communicate with each other.

In addition to installing the Content Manager, Application Tier Components, and gateway components, you must install Framework Manager, the metadata modeling application for business intelligence. You can also choose to install Transformer, the modeling and building tool for creating PowerCubes for use with IBM Cognos BI. No matter which IBM Cognos installation scenario you follow, you can install all modeling components in separate locations.

**All Components on One Computer**

You can install all the IBM Cognos BI reporting components on one computer. Choose this scenario for proof of concept or demonstration environments where the user load is small.

Because the gateway must be located with the Web server, the single computer must also be running a Web server.

A single-computer installation is not possible on UNIX or Linux operating systems, because you must install the Microsoft Windows operating system-based Framework Manager on a separate computer that runs on Windows.

In the following diagram, all server components for IBM Cognos BI reporting, except Framework Manager, are installed on one computer. The content store, query databases, and Framework Manager are located on separate computers.

**Configuration Requirements**

If you install all server components for IBM Cognos BI reporting on the same computer, you must then

- configure your Web server to host IBM Cognos Web content
• specify connection information to the content store
• set up an email account for notifications (if you intend to email reports)

**Gateways on Separate Computers**

The gateway passes queries from the Web server and clients to the dispatcher. It can reside on one or more Web servers.

The IBM Cognos BI gateway provides 32-bit libraries, whether you install on a 64-bit server or a 32-bit server. Some Web servers, such as Apache Web Server, cannot load a 32-bit compiled library in a 64-bit compiled server. In that situation, install the 32-bit version of the IBM Cognos gateway on a 32-bit Web server.

You can install the gateway and a Web server on one computer, and install the remaining IBM Cognos BI reporting components on other computers. If you have a Web farm, you may want to install a gateway on each Web server. Using multiple Web servers to manage incoming requests provides a better level of service.

If you install only the gateway component on the same computer as the Web server, your Web server manages the core Web services and does not process user requests. This separation of processing may be required if you have a firewall between the Web server and your Application Tier Components computers.

In the following diagram, two Web servers each have a gateway installed. Incoming requests are passed to either gateway and forwarded to the Application Tier Components computer.

**Configuration Requirements**

If you install one or more gateways on separate computers, you must ensure that you can view IBM Cognos content and that the gateways can communicate with other IBM Cognos components. On each computer where the gateway is installed you must

• configure your Web server to host IBM Cognos Web content
• configure the Dispatcher URIs
Application Tier Components and Content Managers on Separate Computers

Application Tier Components use the IBM Cognos Connection interface to balance loads, access data, perform queries, schedule jobs, and render reports. Content Manager stores all report specifications, results, packages, folders, and jobs in the content store.

You can install the Application Tier Components and Content Manager on the same computer, or on different computers. Installing on different computers can improve performance, availability, and capacity.

More Than One Content Manager
You can install any number of installations of Content Manager, although only one is active at any time. The other installations each act as a standby Content Manager. One becomes active only if a failure occurs that affects the active Content Manager computer. For failover support, it is advisable to install Content Manager on two or more computers.

Install Multiple Content Managers

Content Manager stores data that IBM Cognos BI needs to operate, such as report specifications, published models, and the packages that use them; connection information for data sources; information about the external namespace and the Cognos namespace itself; and information about scheduling and bursting reports. The content store is a relational database management system (RDBMS). There is only one content store for each IBM Cognos installation.

You may choose to install Content Manager separately from the Application Tier Components. For example, you may want Content Manager in your data tier instead of in the applications tier.

When an active Content Manager fails, unsaved session data is lost. When the new active Content Manager takes over, users may be prompted to logon.

In the following diagram, the gateway passes the request to the dispatcher (not shown), which passes it to the default active Content Manager computer. Because the computer has failed, the request is redirected to the standby Content Manager computer, which became active when the default active Content Manager computer failed.
**Configuration Requirements**

On each computer where you install Content Manager, you must
- specify connection information to the content store
- specify the Dispatcher URIs
- specify all Content Manager URIs
- specify the Dispatcher URI for external applications
- set up a connection to an email account for notifications (if you want to email reports)

**More Than One Application Tier Components Computer**

To improve scalability in an environment in which there is typically a large volume of report requests to process, you can install the Application Tier Components on multiple computers dedicated to processing incoming requests. By installing the Application Tier Components on multiple computers, you distribute and balance loads among the computers. You also have better accessibility and throughput than on a single computer, as well as failover support.

**Example - Distributing Index Services**

To distribute the index services for index search, install one instance of Application Tier Components in the applications tier, with the index search service and index update service enabled. Install addition Application Tier Components in the application tier as needed, with the index search service enabled. Also, install an instance of Application Tier Components in the data tier, with the index data service enabled. The following diagram shows the index search service and index update service in the applications tier, and the index data services in the data tier.
Configuration Requirements

If you install one or more Application Tier Components on a separate computer, to ensure that they can communicate with other IBM Cognos BI reporting components, do the following:

- Specify all Content Manager URIs.
- Specify the Dispatcher URIs.
- Specify the Dispatcher URI for external applications.
- Enable only the services that you require on each Application Tier Components computer.

IBM Cognos BI Products on the Same Computer

IBM Cognos BI products are designed to share components, including the gateway, Content Manager, content store, IBM Cognos Connection, and IBM Cognos Configuration. If you install more than one IBM Cognos BI product on the same computer, you can either use the same gateway or use separate gateways.

Accessing Product Documentation in an Integrated Environment

The documentation for IBM Cognos BI components is installed with the gateway component. If you integrate different IBM Cognos BI products, you can either use the same gateway or use separate gateways.

If you want to use the same gateway, all gateway components must be of the same product version, and you should install the IBM Cognos BI gateway component for each product into the same location on the same computer. This ensures that all the product documentation is available to all users. If you want to use separate gateways for each product, you can install the IBM Cognos BI gateway component for each product on separate computers, but the product documentation on each gateway will be specific for the IBM Cognos BI product you installed.

If you want users to access each IBM Cognos BI product through separate gateways, yet still be able to access documentation for all components, you can install each product's gateway component into the same location as your other IBM Cognos BI gateway components.

Consolidate servers for Linux on System z

Linux on System z operating system is a native implementation of the Linux operating system. Hosting options include running Linux in one or more logical partitions (LPAR).
**Integrated Facility for Linux (IFL)**

IFLs are System z processors dedicated to running Linux operating system workloads either natively, or under virtualization software, depending on your needs. IFLs enable you to consolidate and centrally manage Linux resources on System z.

**Logical Partition (LPAR) Mode**

Linux operating system can run in LPARs and communicate with other Linux partitions using TCP/IP connections.

The horizontal scalability in a large Linux environment is limited by the number of LPARs that can be created. Running Linux in LPARs may be best if you are running a small number of Linux images, and those images will each be using a large amount of processing power, or will require a very large amount of dedicated memory. This ensures that the images will not have underutilized resources allocated to them.

**Installing 64-bit Versions of IBM Cognos BI Products**

Some IBM Cognos BI components are available for 64-bit systems. When installing on a 64-bit system, the components must be installed in the appropriate directories.

The default installation directory that is used by the IBM Cognos BI components depends on the version that you install.

*Table 1. Default paths for 32-bit installations*

<table>
<thead>
<tr>
<th>For a 32-bit Installation on</th>
<th>Default path</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicrosoftWindows operating systems</td>
<td>C:\Program Files\IBM\Cognos\c10</td>
</tr>
<tr>
<td>64-bit MicrosoftWindows operating systems</td>
<td>C:\Program Files (x86)\IBM\Cognos\c10</td>
</tr>
<tr>
<td>UNIX operating systems</td>
<td>/usr/IBM/cognos/c10</td>
</tr>
<tr>
<td>Linux operating systems</td>
<td>/opt/IBM/cognos/c10</td>
</tr>
</tbody>
</table>

*Table 2. Default paths for 64-bit installations*

<table>
<thead>
<tr>
<th>For a 64-bit Installation on</th>
<th>Default path</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicrosoftWindows operating systems</td>
<td>C:\Program Files\IBM\Cognos\c10_64</td>
</tr>
<tr>
<td>UNIX operating systems</td>
<td>/usr/IBM/cognos/c10_64</td>
</tr>
<tr>
<td>Linux operating systems</td>
<td>/opt/IBM/cognos/c10_64</td>
</tr>
</tbody>
</table>

Whether you are installing all server components together on a single server or on multiple servers, the 32-bit and 64-bit components must be in separate directories.

**Server Components That Must Be Installed in the 64-bit Directory**

The following components can be installed together on one 64-bit server or installed separately on multiple 64-bit servers. When installing the components, ensure that you start from the appropriate download directory or disk:

- IBM Cognos BI Server (Content Manager, Application Tier Components, Gateway)
If using a Web server that cannot load a 32-bit compiled library in a 64-bit compiled server, such as Apache Web Server, install the 32-bit version of the Gateway component on a 32-bit Web server.

- IBM Cognos BI Supplementary Language Documentation (32-bit and 64-bit versions available on one disk)
- IBM Cognos BI Samples (32-bit and 64-bit versions available on one disk)

**Server Components That Must Be Installed in the 32-bit Directory**

The following components can be installed together on the 64-bit server, but in a separate directory from the 64-bit components. They can also be installed on a separate 32-bit system:

- IBM Cognos Transformer (UNIX and Linux utility for building PowerCubes)
- IBM Virtual View Manager
- Framework Manager (Windows only)
- IBM Cognos BI for Microsoft Office (Windows only)
- IBM Cognos Transformer (Windows modeling tool)

**Using the 64-bit Version of Report Server**

In the 64-bit installations, the report server component, included with the Application Tier Components, is provided in both 32- and 64-bit versions. In 32-bit installations, only the 32-bit version of the report server component is provided.

Selecting which version you use is done using IBM Cognos Configuration after installation. By default, the report server component is set to use the 32-bit mode, even on a 64-bit computer. The 32-bit mode allows you to run reports from all packages, whereas the 64-bit mode allows you to run only reports created from packages using dynamic query mode.

For packages that are not using dynamic query mode, you must have a 32-bit report server running in your environment. Reports from packages that do not use dynamic query mode will not run using the 64-bit report server.

For example, you can install two Application Tier Components in your environment, and have one using the 32-bit version of report server and the other using the 64-bit version, as shown in the following diagram.
You can control which servers your reports are run on using routing rules for the packages. For more information about setting routing rules, see the Administration and Security Guide.

**Installation Options for Windows Modeling Components**

You install the modeling tools, such as Framework Manager, Metric Designer, and Transformer on Microsoft Windows operating system computers.

To publish packages so that they are available to users, you must configure the modeling tools to use a dispatcher, either directly or through a gateway. If IBM Cognos Connection is secured, you must have privileges to create data sources and publish packages in IBM Cognos Connection.

**Firewall Considerations**

When the modeling tool is outside a network firewall that protects the Application Tier Components, communication issues with the dispatcher can occur. For security reasons, the default IBM Cognos BI configuration prevents the dispatcher from accepting requests from the modeling tool when it is outside the network firewall.

A modeling tool that is outside a network firewall, for example Framework Manager, cannot send requests across a network firewall to the dispatcher on the IBM Cognos BI application server. To avoid communication issues when communicating across a network firewall, install the modeling tool in the same architectural tier as the Application Tier Components. The following diagram shows the Framework Manager computer inside the network firewall, successfully communicating with the dispatcher on the IBM Cognos BI application server.
Alternatively, you can install an additional gateway that is dedicated to communication with the modeling tool as shown in the diagram below. You then configure the modeling tool and its gateway such that the dispatcher accepts requests from the modeling tool.
Distributing Framework Manager Components

Framework Manager communicates with the Application Tier Components, which can be installed on one or more application servers. To publish packages, you must configure Framework Manager to communicate with the dispatcher, either directly or through a dedicated gateway.

Configuration Requirements

On the computer where Framework Manager is installed, configure the following environment properties:

- Gateway URI
- Dispatcher URI for external applications

If the modeling tool is using a dedicated gateway instead of communicating directly with the dispatcher, you must also configure the Dispatcher URIs for gateway property on the dedicated gateway computer.

Distributing Transformer Components

Transformer can be installed on a computer that contains other IBM Cognos BI components or on a computer that is separate from other IBM Cognos BI components. When installed separately, Transformer can be used as a standalone product or it can be configured to communicate with other IBM Cognos BI components.

Transformer consists of the following components. You may have one or both, depending on your environment.
• Transformer Windows
  This is the modeling tool for Microsoft Windows operating system for designing
  PowerCubes that are used in IBM Cognos BI. It can also be used to build and
  publish PowerCubes.

• Transformer UNIX/Linux
  This is a command line utility for building PowerCubes on UNIX and Linux
  operating systems. You first design the models using Transformer Windows or
  MDL scripting, and then use the models to build the PowerCubes.
  You install Transformer PowerCube building components for Linux on System z.

Supported features
When you use Transformer as a standalone product, you can use data sources that
are external to IBM Cognos BI and you cannot create secured views with
dimensional filtering. When you use Transformer with other IBM Cognos BI
components, you can use the following features provided by IBM Cognos BI:
• IBM Cognos BI authentication providers
• IBM Cognos BI data sources, such as published packages, Query Studio reports,
  and Report Studio reports
  You cannot use flat files as data sources.
• IBM Cognos Connection for publishing the PowerCube data source and package
• building PowerCubes

Role-based Server Considerations
You may want to set up dedicated Transformer servers for optimal cube build
performance and accessibility to the IBM Cognos BI users. In this scenario,
consider the following requirements:
• Database client software is installed on any computer where Transformer will be
  used to build PowerCubes or test data sources.
• For data source connectivity, set appropriate environment variables for UNIX
  and Linux servers.
• IBM Cognos BI servers have access to the location where PowerCubes are stored
  so that the report server can access the PowerCubes.

Building and updating production PowerCubes can be scripted and run remotely
when sufficient access and user privileges are set up. For more information about
building and updating production PowerCubes, see the Transformer User Guide.

Business Analysts or Specialists
You may have specialized business or power users who want to build PowerCubes
that are modeled on a combination of corporate and personal data sources. These
users may want to do their own analysis of the data for their line of business or a
small group of users. You can enable such users to be self-sufficient within the IT
and security infrastructure of the organization by meeting the following
requirements:
• Database client software is installed, or available for modelers to install, on the
  Transformer computers that are used to access IBM Cognos BI data sources or
  IBM Cognos Series 7 IQD data sources.
• Modelers must have privileges to create a data source in IBM Cognos
  Administration.
Modelers do not need direct access to IBM Cognos Administration. They can create and update data sources by using Transformer or command line tools. You can provide modelers with a secured folder in IBM Cognos Connection in which to publish PowerCube packages.

- Modelers must have access to a location in which to store the PowerCube after building it.
  This location must also be accessible to the IBM Cognos service and can be a secured share on a LAN.
- To build PowerCubes on a specific Transformer server, modelers should have FTP privileges to transfer models and execute privileges to build cubes on that server.

Modelers can transfer models and execute cube builds using scripts. Modelers can also use automated methods to build PowerCubes. For more information, see the Administration and Security Guide.

**Configuration Requirements**

To publish PowerCube packages, you must configure Transformer to communicate with the dispatcher, either directly or through a dedicated gateway. If IBM Cognos Connection is secured, you must have privileges to create data sources and publish packages in IBM Cognos Connection.

On the computer where Transformer is installed, configure the following environment properties:

- Gateway URI
- Dispatcher URI for external applications

If the modeling tool is using a dedicated gateway instead of communicating directly with the dispatcher, you must also configure the Dispatcher URIs for gateway property on the dedicated gateway computer.

**Related concepts**

- "Install IBM Cognos Transformer" on page 246
  You install Transformer if you plan to create PowerCubes for use with IBM Cognos BI.
- "Data Sources and Transformer" on page 252
  The IBM Cognos BI modeling tools create and manage metadata. IBM Cognos Transformer creates and manages metadata for PowerCubes. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for IBM Cognos Transformer. Commonly, these things depend on the other technology you use for your data or import source.

**Distributing Metric Designer Components**

For Metric Studio, if you want to define and load metrics from relational and dimensional data sources, including cubes, Framework Manager packages, or Impromptu Query Definitions (.iqd files), install Metric Designer to extract the data.

Install Metric Designer after installing and configuring other IBM Cognos BI components. You must install the Microsoft Windows operating system-based Metric Designer on a Windows computer.
**Configuration Requirements**

Metric Designer communicates with the Application Tier Components, which can be installed on one or more application servers. To publish extracts, you must configure Metric Designer to communicate with the dispatcher, either directly or through a dedicated gateway.

You must ensure that Metric Designer can communicate with other IBM Cognos BI scorecarding components. On the computer where Metric Designer is installed, configure the following environment properties:

- **Gateway URI**
- **Dispatcher URI for external applications**

Additional configuration is required after you install Metric Designer so that it can access some types of data sources.

If the modeling tool is using a dedicated gateway instead of communicating directly with the dispatcher, you must also configure the **Dispatcher URIs for gateway** property on the dedicated gateway computer.

**Related concepts**

"Installing and Configuring Metric Designer" on page 235

You can install Metric Designer, the metadata modeling tool for IBM Cognos Metrics Manager, on the same computer as IBM Cognos BI components, or on a different computer. All required files are copied to one computer. Default settings are used for the configuration. However, you may want to change these default settings if existing conditions make the default choices inappropriate, or if you installed IBM Cognos BI on a different computer.

---

**Distributing IBM Cognos BI Scorecarding Components**

When you install IBM Cognos BI Metrics Manager, you specify where to place the gateways, Application Tier Components, and Content Manager. You can install these components using any of these options:

- **Install all components on one computer.**
  This option is typically used for a demonstration or in a proof of concept environment.

- **Install the gateway on a separate computer.**
  In this option, the gateway and Web server are on one computer, and the remaining IBM Cognos components are on other computers. You may choose this option if you have existing Web servers available to handle IBM Cognos component requests.

- **Install Application Tier Components and Content Manager on separate computers.**
  Choose this option to maximize performance, availability, capacity, or security based on the processing characteristics of your organization.
  If you plan to install Cognos Content Database, you can install it on the same computer as Content Manager or on another computer. If you install it on the same computer and in the same location, Cognos Content Database is automatically configured for use as your content store. If you install it on another computer, ensure that you set the connection properties for Cognos Content Database on your Content Manager computer.

- **Install IBM Cognos BI scorecarding components on the same computer as other IBM Cognos BI products.**
IBM Cognos BI products share components, such as Content Manager. If you plan to install IBM Cognos BI scorecarding components on the same computer as other IBM Cognos BI products, install them in the same installation location.

After installing IBM Cognos BI scorecarding components, you must configure them so they can communicate with each other.

In addition to installing the Content Manager, Application Tier Components, and gateway components, you may choose to install Metric Designer, the metadata modeling application for scorecarding. No matter which IBM Cognos installation scenario you follow, you can install Metric Designer and the content store on a computer separate from the Application Tier Components.

The metric store is usually installed on the same computer as Content Manager. The metric store can also be installed on a different computer.

**All Components on One Computer**

You can install all the IBM Cognos BI scorecarding components on one computer. Choose this scenario for proof of concept or demonstration environments where the user load is small.

Because the gateway must be located with the Web server, the single computer must also be running a Web server.

A single-computer installation is not possible on UNIX or Linux operating systems, because you must install the Microsoft Windows operating system-based Metric Designer on a separate computer that runs on Windows.

In the following diagram, all IBM Cognos BI scorecarding components, except Metric Designer, are installed on one computer. The content store and metric store are located on separate computers.

**Configuration Requirements**

If you install all IBM Cognos BI scorecarding components on the same computer, you must

- configure your Web server to host IBM Cognos Web content
- specify connection information to the content store

**Gateways on Separate Computers**

The gateway passes queries from the Web server and clients to the dispatcher. It can reside on one or more Web servers.
You can install the gateway and a Web server on one computer, and install the remaining IBM Cognos BI scorecarding components on other computers. If you have a Web farm, you may want to install a gateway on each Web server. Using multiple Web servers to manage incoming requests provides a better level of service.

By installing the gateway separately from the scorecarding components in the application tier, your Web server manages the core Web services and does not process user requests. This separation of processing may be required if you have a firewall between the Web server and your other IBM Cognos BI scorecarding components.

In the following diagram, two Web servers each have a gateway installed. Incoming requests are passed to either gateway and forwarded to the Application Tier Components computer for processing.

**Configuration Requirements**

If you install one or more gateways on separate computers, you must ensure that you can view IBM Cognos Web content and that the gateways can communicate with the other IBM Cognos dispatchers. On each computer where the gateway is installed, you must
- configure your Web server to host IBM Cognos Web content
- configure the Dispatcher URIs

**Application Tier Components and Content Managers on Separate Computers**

Application Tier Components process IBM Cognos requests, balance loads, execute tasks, and render scorecards. Content Manager stores and retrieves information, such as the data source connections in the content store.

You can install the Application Tier Components and Content Manager on the same computer, or on different computers. Installing on different computers can improve performance, availability, and capacity.

To improve scalability in an environment in which there is typically a large volume of report requests to process, you can install the Application Tier Components on multiple computers dedicated to processing incoming requests. By doing this, you
distribute and balance loads among the computers. You also have better accessibility and throughput than on a single computer, as well as failover support.

**Configuration Requirements**

If you install one or more Application Tier Components on a separate computer, ensure that they can communicate with other IBM Cognos BI components. You must

- specify all Content Manager URIs
- specify the Dispatcher URIs

**More Than One Content Manager**

You can install any number of installations of Content Manager, although only one is active at any time. The other installations each act as a standby Content Manager. One becomes active only if a failure occurs that affects the active Content Manager computer. For failover support, it is advisable to install Content Manager on two or more computers.

**Install Multiple Content Managers**

Content Manager stores data that IBM Cognos BI needs to operate, such as report specifications, published models, and the packages that use them; connection information for data sources; information about the external namespace and the Cognos namespace itself; and information about scheduling and bursting reports. The content store is a relational database management system (RDBMS). There is only one content store for each IBM Cognos installation.

You may choose to install Content Manager separately from the Application Tier Components. For example, you may want Content Manager in your data tier instead of in the applications tier.

When an active Content Manager fails, unsaved session data is lost. When the new active Content Manager takes over, users may be prompted to logon.

In the following diagram, the gateway passes the request to the dispatcher (not shown), which passes it to the default active Content Manager computer. Because the computer has failed, the request is redirected to the standby Content Manager computer, which became active when the default active Content Manager computer failed.
Configuration Requirements

On each computer where you install Content Manager, you must
- specify connection information to the content store
- specify the Dispatcher URIs
- specify all Content Manager URIs

IBM Cognos BI Products on the Same Computer

IBM Cognos BI products are designed to share components, including the gateway, Content Manager, content store, IBM Cognos Connection, and IBM Cognos Configuration.

If you install more than one IBM Cognos BI product on the same computer, install them in the same installation location. The installation program checks to determine whether other IBM Cognos BI components exist in the installation location. If a component exists and can be shared, it is not reinstalled.

Operating as a Standalone Product on 64-bit Systems

IBM Cognos BI Metrics Manager can be installed as a standalone scorecarding product by installing the components in a separate location from the IBM Cognos BI server components. To use IBM Cognos Metrics Manager as a standalone product on a 64-bit system, install all components and configure as you normally would, pointing to the 32-bit libraries in the library path environment variables for the content store and metric store. If there are other IBM Cognos BI products on the system, ensure that you install IBM Cognos Metrics Manager in a separate directory and configure it to use a different content store, aliases, and ports.
Sharing Resources with IBM Cognos BI Server on 64-bit Systems

IBM Cognos BI Metrics Manager is available only in a 32-bit version. To share resources, such as the content store, between IBM Cognos Metrics Manager and IBM Cognos BI Server, you must install 32-bit and 64-bit components in separate directories or on separate computers.

The following list shows an example of distributing components using three servers:

- Server A - the Content Manager server
- Server B - the Application Tier Components server
- Server C - the Web server

Other tasks, such as creating a content store, metric store, installing database clients, setting up environment variables, and configuring the Web server are not listed.

1. On Server A, install Content Manager from the IBM Cognos BI Server 64-bit installation.
2. On Server B, install the Application Tier Components from the IBM Cognos BI Server 64-bit installation.
3. On Server B, install the Metrics Application Tier Components from the IBM Cognos Metrics Server installation.
   Ensure you install these components to a separate directory from the 64-bit Application Server components above.
   Also ensure that you use different port numbers for these components than you used for the 64-bit Application Tier Components.
4. On Server C, install the 32-bit version of the Gateway from IBM Cognos BI Server and the IBM Cognos Metrics Server installations. Install the two gateways to the same location.
5. On Servers A, B, and C, in IBM Cognos Configuration, configure the Gateway URI to point to Server C.
6. On Server C, in IBM Cognos Configuration, configure the Dispatcher URIs for gateway to point to both the 64-bit Application Tier Components and the 32-bit Metrics Application Tier Components on Server B.
7. On Server B, in IBM Cognos Configuration for the Metrics installation, disable the Report Services and the Presentation Service under the IBM Cognos Services section.

IBM Cognos BI with Other IBM Cognos Products

You can install IBM Cognos BI in an environment that includes other IBM Cognos products.

The installation wizard for IBM Cognos BI can recognize compatible directories and shows a warning when conflicts occur. After IBM Cognos BI is installed, you can access objects that are created in another IBM Cognos product in IBM Cognos BI. The requirements for access depend on how you choose to run the two products.

Duplicated Services if Using Multiple Products

Many IBM Cognos products use similar services, such as the report service and the presentation service. If you are using multiple products, such as IBM Cognos
Business Intelligence with IBM Cognos Metrics Manager or IBM Cognos PowerPlay, you must ensure that you disable some of the duplicated services to ensure your products work properly.

For example, you have IBM Cognos Business Intelligence and IBM Cognos PowerPlay installed. Both products have a reports service and an a presentation service. If both products are accessed through the same gateway, reports that must be run on the IBM Cognos BI services could be routed to the IBM Cognos PowerPlay services. The result may be that your reports will display an error.

The following list shows an example of distributing components using three servers, where each server hosts one product. The fourth server hosts the common gateway.

- Server A - IBM Cognos Business Intelligence
- Server B - IBM Cognos Metrics Manager
- Server C - IBM Cognos PowerPlay
- Server D - the Web server used for all products

1. On Server A, you must have the report service and the presentation service enabled.
2. On Server B and Server C, you must disable the report service and the presentation service.
3. On Server D, these services are not present.

### IBM Cognos Products That Can Be Upgraded to IBM Cognos BI

The following IBM Cognos products are earlier versions of components that are now within IBM Cognos BI: ReportNet, IBM Cognos Metrics Manager, DecisionStream, and PowerPlay Web. When you upgrade these products to IBM Cognos BI, you can continue to run the earlier versions concurrently on the same computer until you are satisfied with the transition to IBM Cognos BI.

#### ReportNet

For ReportNet and IBM Cognos BI to run concurrently, each version must have unique ports, content stores, Web aliases, and cookie settings. If you use the default settings, configuration is required only to select new ports and a new content store for IBM Cognos BI.

You cannot use content from ReportNet directly in IBM Cognos BI until you upgrade ReportNet. When you upgrade to IBM Cognos BI, the content store is upgraded to use the IBM Cognos BI schema and cannot be used by previous versions. Therefore, you need to maintain both the old and new content stores to run both product versions. You can maintain both content stores using one of the following approaches:

- create a copy of the ReportNet content store database using database export utilities and use the copy with IBM Cognos BI
- use the embedded export feature in IBM Cognos Connection to export the ReportNet content store database and import the exported deployment into IBM Cognos BI

You can upgrade reports at the same time or upgrade them later if compatibility is required with some existing Software Development Kit applications.
**IBM Cognos Metrics Manager**

To use data store content from IBM Cognos Metrics Manager in IBM Cognos BI, you upgrade by exporting the content from the data store to flat files, installing IBM Cognos BI, and then importing the flat files into the IBM Cognos BI metric store. Note that the cube picker feature (the ability to map specific metrics to cube intersections) in IBM Cognos Metrics Manager is not available in other IBM Cognos BI studios.

**IBM Cognos DecisionStream**

You can continue to run IBM Cognos DecisionStream Series 7 concurrently with IBM Cognos BI products. Catalogs that are created using DecisionStream Series 7 must be upgraded before you can use them with Data Manager.

For instructions about running concurrently and upgrading DecisionStream catalogs to the IBM Cognos BI Data Manager environment, see the chapter about upgrading a catalog in the Data Manager User Guide.

**IBM Cognos PowerPlay Web**

You can continue to use PowerPlay Web reports within the PowerPlay 7 user interfaces in the IBM Cognos BI portal. You can also drill through between PowerPlay Web and IBM Cognos BI. You can publish from PowerPlay Enterprise Server to IBM Cognos BI, provided that you use the same host name or IP address to identify the Series 7 namespace in IBM Cognos Series 7 and in IBM Cognos BI.

You can also upgrade the following reports to IBM Cognos BI reports by using IBM Cognos Migration Assistant:

- PowerPlay Windows reports
- PowerPlay Web Explorer reports
- PowerPlay for Excel reports
- PowerPlay for Windows reports published to PowerPlay Web


For instructions about upgrading, see the Migration Assistant User Guide.

**Related concepts**

"Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI" on page 87

You must upgrade the software to move from an earlier version of IBM Cognos BI, ReportNet, or Metrics Manager to a new version of IBM Cognos BI. You must upgrade all components. Components from different versions are not compatible. If you are using IBM Cognos Series 7 PowerCubes as a data source, it is not necessary to upgrade Transformer unless you want to use the features of the new version of Transformer. PowerCubes that are built using IBM Cognos Series 7.3 Transformer (or later) and IBM Cognos BI, Version 8.3 Transformer (or later) are both supported with IBM Cognos BI reporting and metrics.

**IBM Cognos Series 7 Products That Can Be Migrated to IBM Cognos BI**

You can migrate metadata and applications from IBM Cognos Series 7 to IBM Cognos BI. Content that can be migrated includes Architect models from Windows,
Impromptu client reports and catalogs from Windows, Upfront content, and Web-based content from Windows and UNIX.

For more information, see the Migration Assistant User Guide.

For a list of supported IBM Cognos Series 7 versions and to download IBM Cognos Migration Assistant and documentation, see the IBM Cognos Customer Center [http://www.ibm.com/software/data/support/cognos_crc.html].

**Architect**

You can migrate Architect models for use as a metadata source for Framework Manager.

**Impromptu**

You can migrate Impromptu catalogs and reports to IBM Cognos BI. You use migrated catalogs as a metadata source for Framework Manager. After completing the catalog migration process, you can migrate and deploy Impromptu reports.

**Upfront**

You can migrate Upfront content to IBM Cognos BI. The migration process maps the Upfront content structure to an IBM Cognos Connection folder structure. By preserving the existing Upfront organization, it is easier to complete administrative tasks, such as applying security to the migrated content.

**Impromptu Web Reports**

You can migrate Impromptu Web Reports content, such as schedules and events, to IBM Cognos BI. You migrate Impromptu Web Reports content using an IBM Cognos Series 7 Deployment Manager package as the migration source. Before you migrate Impromptu Web Reports you must migrate the Impromptu catalog metadata used by the reports.

You cannot migrate Impromptu query definition files (.iqd), but you can continue to use existing .iqd files to build cubes in IBM Cognos BI Transformer 8.4. To do so, you must install the optional component, Series 7 IQD Bridge, which is available to install with IBM Cognos BI on IBM Cognos Series 7 supported platforms.

PowerPrompts are not migrated, but you can implement similar functionality using either the built-in administrator functionality or the IBM Cognos Software Development Kit.

**IBM Cognos Products That Interoperate with IBM Cognos BI**

Some IBM Cognos products provide functionality that is not available in IBM Cognos BI. You can use these products in the same environment as IBM Cognos BI. With some products, you can access the different types of cubes or reports in the IBM Cognos BI portal. With other products, you can access unique features in the IBM Cognos BI portal.
IBM Cognos Planning - Analyst

You can access published plan data in IBM Cognos BI by using the Generate Framework Manager Model wizard, which requires IBM Cognos Planning - Analyst 7.3 MR1 or later.

If you want to use this product with the IBM Cognos BI server, you must ensure that both products are the same version.

For more information, see the Analyst User Guide.

IBM Cognos Planning - Contributor

You can access unpublished (real-time) Contributor cubes in IBM Cognos BI by custom installing the IBM Cognos BI - Contributor Data Server component that is included with IBM Cognos Planning - Contributor 7.3 MR1 release or later. You can access published plan data in IBM Cognos BI by using the Generate Framework Manager Model administration extension in Contributor, which requires IBM Cognos Planning - Contributor 7.3 MR1 or later.

If you want to use this product with the IBM Cognos BI server, you must install ensure that both products are the same version.

For more information, see the Contributor Administration Guide.

IBM Cognos Finance

You can access IBM Cognos Finance cubes that are secured against a Series 7 namespace by using the IBM Cognos Finance Network API Service. You can also export data and metadata from IBM Cognos Finance for use in Framework Manager.

IBM Cognos Controller

You can access IBM Cognos BI to create IBM Cognos Controller Standard Reports by using a predefined Framework Manager model that is created when IBM Cognos Controller is installed. You can also access published Controller data and structures in Framework Manager for custom reporting and analysis.

If you want to use this product with the IBM Cognos BI server, you must ensure that both products are the same version.

IBM Cognos Transformer

You can use IBM Cognos PowerCubes and Transformer models that were generated by Transformer 7.3 or later directly in IBM Cognos BI. The cubes and models are upwards compatible and require no migration or upgrade tools. You can run reports and analyses in IBM Cognos BI against the IBM Cognos PowerCubes.

If you want to use the new integration features of Transformer with IBM Cognos BI, you can upgrade IBM Cognos BI Series 7.x Transformer models to IBM Cognos BI Transformer 8.4 or later. This allows you to use IBM Cognos BI data sources (such as published packages), list reports authored in Query Studio or Report Studio, authenticate using IBM Cognos BI security, and publish directly to IBM Cognos Connection.
Before you load the model, the IBM Cognos Series 7 namespace must be configured in IBM Cognos BI and the name ID that is used to configure it in IBM Cognos BI must match the name used in IBM Cognos Series 7.

For more information about upgrading IBM Cognos Series 7 secured PowerCubes, see the IBM Cognos BI Transformer User Guide.

For IBM Cognos Series 7 PowerCubes to be used in IBM Cognos BI, optimize the cubes for use in IBM Cognos BI by using the pcoptimizer utility, which is supplied with IBM Cognos BI. Otherwise, PowerCubes that were created with previous versions of Transformer may take too long to open in the IBM Cognos BI Web studios. This optimization utility is suitable for older PowerCubes created before Transformer 8.4 and does not require access to the model or data source. It is not necessary to run this command line utility for cubes created in Transformer 8.4 or later. For more information about optimizing PowerCubes, see the Transformer User Guide.

You can publish PowerCubes using Transformer 8.4, Framework Manager, or directly in the IBM Cognos BI portal. You can publish single PowerCube data sources and packages to IBM Cognos Connection interactively in Transformer or in the command line. You can also publish silently using batch scripts after building a PowerCube. A user who has privileges to create data sources and packages in IBM Cognos Connection can publish PowerCubes in IBM Cognos Connection as well. The MDC file must be in a secured location that the IBM Cognos BI dispatcher and the report server process can access. Packages that use multiple PowerCubes from different PowerCube definitions or PowerCubes mixed with other data sources must be published using Framework Manager.

If you use an IBM Cognos Series 7 PowerCube as a data source, IBM Cognos BI converts the cube data from the encoding that was used on the system where the PowerCube was created. For a successful conversion, IBM Cognos Series 7 PowerCubes must be created with a system locale set to match the data in the PowerCube.

### Data Manager

Data Manager is used to create data warehouses and data repositories for reporting, analysis, and performance management. When Data Manager is installed in your IBM Cognos BI environment, you can use the Data Movement Service to run builds and JobStreams in IBM Cognos Connection. You must install the Data Manager engine in the same location as your IBM Cognos BI Application Tier Components. Both Data Manager and IBM Cognos BI must be the same version.

### IBM Cognos Analytic Applications

IBM Cognos Analytic Applications is a performance management solution that includes a populated data warehouse, packages that describe the data available in the data warehouse, and a set of predefined reports.

IBM Cognos Analytic Applications Workbench is a performance management solution that includes sample business intelligence data with which you can build applications and documentation source files which you can modify to produce your own customized documentation for the product.

Some IBM Cognos Analytic Application components are available for installation on 64-bit systems. The default installation directories for 64-bit installations are
different from the default installation directories for 32-bit installations. Whether you are installing all server components together on a single server or on multiple servers, 32-bit and 64-bit components must be in separate directories.

**IBM Cognos Mobile**

With IBM Cognos Mobile you can access reports authored with Analysis Studio, Report Studio, Query Studio and Business Insight on a mobile device (such as a Blackberry) or a tablet computer.

To download, view, and interact with reports, IBM Cognos Mobile devices are either web-based, require the download of a native client or require the installation of a rich client, in addition to the installation of IBM Cognos BI components on the server. Both IBM Cognos Mobile and IBM Cognos BI server must be at the same version.

For more information, see the *Mobile Installation and Administration Guide*.

**Lifecycle Manager**

Lifecycle Manager is a Windows-based application for auditing upgrades from ReportNet 1.1 MR3 or MR4 and earlier versions of IBM Cognos BI to newer versions of IBM Cognos BI. It provides a verification feature that validates, executes, and compares report results from two different IBM Cognos BI releases. This helps to identify upgrade and compatibility issues between releases. User interface design and status reporting functionality provide both a proven practice process and support for upgrade project planning and status reporting. Lifecycle Manager also automates much of the process of bundling the required files, such as reports and models, for the test case.

For more information, see the Lifecycle Manager *User Guide*.

**IBM Cognos BI Business Viewpoint Studio**

IBM Cognos BI Business Viewpoint Studio helps to provide you with one version of the truth for dimensions used in an enterprise’s performance management processes. With Business Viewpoint Studio, you have a controlled, collaborative, workflow-oriented business process to manage both manual and automated changes to all data related to how enterprises analyze and manage their business. Both IBM Cognos BI Business Viewpoint Studio and IBM Cognos BI must be at the same version.

**IBM Cognos Content Archival**

With IBM Cognos Content Archival, you can store report output versions and their source report specifications to an external content archival repository. This enhances system performance and extends IBM Cognos product scalability by reducing the size of the Content Store, while helping to adhere to strict regulatory requirements. IBM Cognos Content Archival supports an IBM FileNet Content Manager with IBM FileNet CMIS external repository.

For more information, see the *IBM Cognos Business Intelligence Installation and Configuration Guide*. 
IBM Cognos Series 7 Content That Can Be Recreated in IBM Cognos BI

Some IBM Cognos products cannot be programmatically migrated or upgraded with the migration or upgrade tools for IBM Cognos BI. IBM Cognos BI offers two options for duplicating content or functionality for the products described below: use the Upfront portal within the IBM Cognos BI portal or use IBM Cognos BI studios to duplicate queries, visualizations, or objects.

IBM Cognos Query

You can use IBM Cognos Migration Assistant to identify IBM Cognos Query objects in the IBM Cognos Series 7 migration source. You can then duplicate most IBM Cognos Query functionality in IBM Cognos BI. Foundation queries are available in IBM Cognos BI when you migrate an Architect model to Framework Manager. You can also manually replicate saved queries using SQL components in Report Studio.

IBM Cognos Visualizer

You can duplicate some functionality by using the charting, layout, and formatting options in Report Studio and Analysis Studio.

IBM Cognos NoticeCast

You can duplicate alert and notification functionality by using Event Studio and other IBM Cognos BI components.

IBM Cognos Web Services

You can duplicate most IBM Cognos Web Services functionality using the IBM Cognos Software Development Kit.

IBM CognosScript

You can duplicate automation functionality using the IBM Cognos Software Development Kit.

IBM Cognos Portal Services

You can duplicate most IBM Cognos Portal Services functionality using IBM Cognos Connection.
Chapter 5. Preparing to Install

Before you install IBM Cognos Business Intelligence, you must set up resources in your environment so that the components can operate. For example, you must create a database for the content store, configure Web browsers, and create a user account for IBM Cognos BI.

If you want to use Cognos Content Database as your content store, you do not have to create a database or set up a database client. A database is created during the installation and IBM Cognos BI is configured to use it.

Use the following checklist to guide you through the setup process:

- Review the Release Notes.
- Review supported environments.
- Verify system requirements.
- Review the default port settings.
- Create the database for the content store.
- Configure a user or network server account for IBM Cognos BI.
- Set up environment variables on UNIX operating system for the metric store if using IBM Cognos BI Metrics Manager.
- Configure Web browsers.

After you complete these tasks, continue with Installing IBM Cognos BI Components on One Computer or Installing IBM Cognos BI Server Components in a Distributed Installation.

Review the Release Notes Before You Install

Before you install your IBM Cognos product, it is important to be aware of all issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation guide was created.

Review the Release Notes before you install your product. The Release Notes contains late-breaking information about known issues, and documentation updates and deprecation notices. The Release Notes are available from the first page of the installation wizard or from the product disk. Release Notes updates are also available on the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

Review Supported Environments

To ensure that your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].
It is important to note that the Linux operating system is available in a number of distributions and supports a number of hardware platforms. Ensure that the combination of the operating system and hardware that you are using is supported.

**Verify System Requirements**

Use the following tables to check the minimum hardware and software requirements to install and run IBM Cognos Business Intelligence components on one computer. Additional resources may be required for distributed or production environments.

**Hardware Requirements**

*Table 3. Hardware requirements for a single computer installation*

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td></td>
<td>UNIX</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
</tr>
<tr>
<td></td>
<td>Some IBM Cognos BI components are not supported on Linux.</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components. For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements.</td>
</tr>
<tr>
<td>Printer</td>
<td>To ensure that reports print properly on Windows, Adobe Reader requires that you configure at least one printer on the computer where you install the Application Tier Components. All reports, regardless of the print format that you choose, are sent as temporary PDF files to Adobe Reader for printing.</td>
</tr>
<tr>
<td>Other</td>
<td>To email reports, the system requires the ability to use and access a mail server.</td>
</tr>
</tbody>
</table>
Table 4. Software requirements for a single computer installation (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Cognos Content Database can be installed and configured as the default content store database in a test or proof-of-concept system. You must have one of the following databases available to store IBM Cognos data in a production environment: • Oracle • DB2 • Microsoft SQL Server • Sybase • Informix For IBM Cognos BI Metrics Manager, the following databases are supported for the metric store: • Oracle • DB2 • Microsoft SQL Server TCP/IP connectivity is required for all database types.</td>
</tr>
<tr>
<td>Web browser</td>
<td>For all Web browsers, the following must be enabled: • cookies • JavaScript For Microsoft Internet Explorer only, the following must be enabled: • Run ActiveX controls and plug-ins • Script ActiveX controls marked safe for scripting • Active scripting • Allow META REFRESH</td>
</tr>
<tr>
<td>SAP BW</td>
<td>The following SAP Front-End components installed on each IBM Cognos BI server computer: • SAP GUI • BW Add-ons</td>
</tr>
</tbody>
</table>

Review the Default Port Settings for IBM Cognos Business Intelligence

After installation, you can use the configuration tool to change the settings. You can also change them by editing the cogstartup.xml file.

Default Port Settings for IBM Cognos BI Components

The following table lists the default ports and URI settings for IBM Cognos Business Intelligence.

Table 5. Default Port Settings for IBM Cognos BI Components

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Manager URI</td>
<td><a href="http://localhost:9300/p2pd/servlet">http://localhost:9300/p2pd/servlet</a></td>
<td>The URI to Content Manager</td>
</tr>
</tbody>
</table>
**Table 5. Default Port Settings for IBM Cognos BI Components (continued)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway URI</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the gateway</td>
</tr>
<tr>
<td>Dispatcher URI (Internal, External)</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>Dispatcher URIs for Gateway</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch/ext">http://localhost:9300/p2pd/servlet/dispatch/ext</a></td>
<td>The URI to the primary dispatcher used by the gateway</td>
</tr>
<tr>
<td>Log server port</td>
<td>9362</td>
<td>The port used by the local log server</td>
</tr>
<tr>
<td>Listening port number</td>
<td>1527</td>
<td>The port used by Cognos Content Database.</td>
</tr>
</tbody>
</table>

**Default Port Settings for Tomcat**

The following table lists the default settings used by IBM Cognos BI for Tomcat. The non-SSL and SSL connectors are automatically updated in the server.xml file when you use IBM Cognos Configuration to change the dispatcher port or to enable the SSL protocol. You can directly update the shutdown port using IBM Cognos Configuration.

**Table 6. Default Port Settings for Tomcat**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-SSL Coyote HTTP/1.1 Connector</td>
<td>9300</td>
<td>The port Tomcat uses to pass requests from the Web server to IBM Cognos BI</td>
</tr>
<tr>
<td>SSL Coyote HTTP/1.1 connector</td>
<td>9334</td>
<td>The port Tomcat uses to listen for secure connections</td>
</tr>
<tr>
<td>Shutdown port</td>
<td>9399</td>
<td>The port Tomcat uses to listen for a shutdown command</td>
</tr>
</tbody>
</table>

**Guidelines for Creating the Content Store**

The content store is a database that Content Manager uses to store global configuration data, global settings (such as the language and currency formats shown in the user interface), connections to data sources, and product-specific content. You must use one of the supported enterprise-level databases as the content store in a production environment.

Do not use Cognos Content Database for the content store in a production environment. Cognos Content Database is provided to help you quickly set up a test or proof-of-concept system.

Design models and log files are not stored in the content store.
You must create the content store before you can use your IBM Cognos Business Intelligence product.

If you are using IBM DB2 for your content store, you can generate a DDL to allow your database administrator to create a DB2 database suitable for the content store. For more information, see “Generating a script file that will create a database for a DB2 content store” on page 134.

If you are upgrading from ReportNet or a previous version of IBM Cognos Business Intelligence, you can use your existing content store with the new version of IBM Cognos BI. After the content store is upgraded, you cannot use it with the previous version. If you are upgrading and you want to keep running ReportNet or the older version of IBM Cognos BI, you must create a new content store database for use with IBM Cognos BI. You must follow the appropriate upgrade process (see “Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI” on page 87) when creating the new content store database.

**Database Properties**

You must create the content store database using one of the databases listed in the following table.

The following table shows the character encoding and protocol that is used by the different types of databases.

<table>
<thead>
<tr>
<th>Database</th>
<th>Character encoding</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>UTF-8</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Oracle</td>
<td>AL32UTF8 or AL32UTF16</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>UTF-8 or UTF-16</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Informix</td>
<td>UTF-8</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Sybase</td>
<td>UTF-8</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Cognos Content Database</td>
<td>preconfigured</td>
<td>preconfigured</td>
</tr>
</tbody>
</table>

If you plan to use the Cognos Content Database as your content store, a database is created and preconfigured when the installation is complete.

**Collation Sequence**

Note that Cognos BI uses a single sort order that specifies the rules used by the database to interpret, collect, compare, and present character data. For example, a sort order defines whether the letter A is less than, equal to, or greater than the letter B; whether the collation is case sensitive; and whether the collation is accent sensitive. For more information about collation and collation sequences, see the database documentation.

**Suggested Settings for Creating the Content Store in DB2 on Linux, Windows and UNIX**

The database you create on the Microsoft Windows, Linux, or UNIX operating system for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.
Library Files for DB2

Ensure that you use the appropriate library files for the version of the IBM Cognos Business Intelligence server that you install. IBM Cognos BI requires 32-bit library files when running in a 32-bit application server and it requires 64-bit library files when running in a 64-bit application server. Depending on the version of DB2 that you have installed, you may have to change the library files or change the order in which the library files are listed so that IBM Cognos BI server can find the correct files. Whichever version of library files are needed must be listed first.

Guidelines for Creating the Content Store in DB2 on Linux, UNIX, or Windows

Use the following checklist to help you set up the content store on DB2.

- If you use type 2 JDBC connectivity, set the appropriate environment variables for DB2, which are as shown in the following table.

**Table 7. Environment variables for DB2**

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2PATH</td>
<td>The top level directory that contains the database client software or the entire database installation.</td>
</tr>
<tr>
<td>LD_LIBRARY_PATH</td>
<td>The load library path. You must add the driver location and indicate the 32-bit or 64-bit library files as appropriate for your application server.</td>
</tr>
<tr>
<td></td>
<td>For example (replace ## with 32 or 64 as appropriate), LD_LIBRARY_PATH= $DB2_location/sqlib/lib##: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>Examples (replace ## with 32 or 64 as appropriate):</td>
</tr>
<tr>
<td></td>
<td>For Solaris and Linux:</td>
</tr>
<tr>
<td></td>
<td>LD_LIBRARY_PATH= $DB2DIR/lib##: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>For AIX:</td>
</tr>
<tr>
<td></td>
<td>LIBPATH=$DB2DIR/lib##:LIBPATH</td>
</tr>
<tr>
<td></td>
<td>For HP-UX:</td>
</tr>
<tr>
<td></td>
<td>SHLIB_PATH=$DB2DIR/lib##:SHLIB_PATH</td>
</tr>
<tr>
<td>DB2INSTANCE</td>
<td>The default database server connection.</td>
</tr>
<tr>
<td>DB2CODEPAGE</td>
<td>Setting this optional environment variable to a value of 1208 provides support for multilingual databases.</td>
</tr>
<tr>
<td></td>
<td>For information about whether to use this environment variable, see the DB2 documentation.</td>
</tr>
</tbody>
</table>

- Use UTF-8 as the code set value when you create the database.
To check if your database has the correct code set, using the command line interface, type the following at the command prompt:

**db2 get database configuration for database_name**

The code set value should be UTF-8 and the code page value should be 1208.

- Ensure that you set the configuration parameters as shown in the following table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application heap size (applheapsz)</td>
<td>AUTOMATIC or at least 1024 KB</td>
</tr>
<tr>
<td></td>
<td>If the application heap size value is too small, out of memory errors may occur when there are many users.</td>
</tr>
<tr>
<td>Lock timeout (locktimeout)</td>
<td>240 seconds</td>
</tr>
<tr>
<td></td>
<td>Do not set this to an infinite timeout value.</td>
</tr>
<tr>
<td>DB2 registry variable</td>
<td>YES</td>
</tr>
<tr>
<td>(DB2_INLIST_TO_NLJN)</td>
<td>Setting this variable to YES improves performance.</td>
</tr>
</tbody>
</table>

- Create a buffer pool with a page size of 32 KB, and a second one with a page size of 4 KB.
- Create a system temporary tablespace using the 32 KB buffer pool you created in the previous step.
- Create a user temporary tablespace using the 4 KB buffer pool you created. Global temporary tables will be created in the user temporary tablespace.
- Create a regular user tablespace using the 4 KB buffer pool you created. If you are also creating a logging database, create an additional regular user tablespace with a page size of 8 KB.
- Grant the following database privileges for the user account IBM Cognos BI will use to access the database:
  - connect to database
  - create tables
  - create schemas implicitly

**Tip:** If you want to host more than one content store on your DB2 instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos BI instance is fully isolated from the other.

- Ensure that the user account has use privileges for the user temporary tablespace and other appropriate tablespaces associated with the database.
- Create a schema for the user account IBM Cognos BI will use to access the database, and ensure the user has create, drop, and alter permissions for the schema.
- Create a profile that sources the sqllib/db2profile from the DB2 user's home directory. For example, the content of your profile will be similar to the following:

```bash
if [-f /home/db2user/sqllib/db2profile ]; then
  ./home/db2user/sqllib/db2profile
fi
```
Your database administrator must back up IBM Cognos BI databases regularly because they contain the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Suggested Settings for Creating the Content Store in DB2 on z/OS**

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store.

Use the following checklist to help you set up the content store in DB2 on z/OS.

- Log on to the z/OS system as a user with System Administrator (SYSADM) or System Control (SYSTCTRL) privileges in DB2 to create the database.
- Create a database instance, storage group, and a user account for the content store.

IBM Cognos Business Intelligence uses the credentials of the user account to communicate with the database server.

- Ensure you reserve a buffer pool with a page size of 32 KB, and a second one with a page size of 4 KB for the database instance.
- Administrators must run a script to create tablespaces to hold Large Objects and other data for the content store and grant user rights to the tablespaces. For information about running the script, see "Create Tablespaces for a DB2 Content Store on z/OS" on page 135.
- Your database administrator must back up the content store regularly because it contains the IBM Cognos data application and security information. To ensure the security and integrity of the content store database, protect it from unauthorized or inappropriate access.

**Suggested Settings for Creating the Content Store in Oracle**

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following list to help you set up the content store on Oracle.

- Ensure that the parameter for the database instance compatibility level of the content store database is set to 9.0.1 or higher.
  For example, you can check the COMPATIBLE initialization parameter setting by issuing the following SQL statement:

  ```sql
  SELECT name, value, description FROM v$parameter WHERE name='compatible';
  ```
  For information about changing an instance configuration parameter, see the Oracle documentation.
- Determine if the database is Unicode.

  **Tip:** One method is to type the following select statement:

  ```sql
  select * from NLS_DATABASE_PARAMETERS
  ```
If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database and specify AL32UTF8 for the database character set parameters.

- Determine which user account will be used to access the database.

**Tip:** If you want to host more than one content store on your Oracle instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- Ensure that the user account that accesses the database has permission to do the following:
  - connect to the database
  - create, alter, and drop triggers, views, procedures, and sequences
  - create and alter tables
  - insert, update, and delete data in the database tables

- Your database administrator must back up IBM Cognos BI databases regularly because they contain the Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

### Suggested Settings for Creating the Content Store in Microsoft SQL Server

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following checklist to help you set up the content store on Microsoft SQL Server.

- Ensure that the collation sequence is case-insensitive.
  
  In a Custom installation, you choose a collation, which includes character sets and sort order, during the Microsoft SQL Server setup. In a Typical installation, the installation uses the locale identified by the installation program for the collation. This setting cannot be changed later.

- When connecting to Microsoft SQL Server Management Studio to create the database, use Microsoft SQL Server authentication.
  
  If you connect using Microsoft Windows operating system authentication, the database that you create will also use Windows authentication. In this situation, you must configure the database connection using a database type of **SQL Server database (Windows Authentication)** in IBM Cognos Configuration.

- For the user account that will be used to access the database, create a new login under **Security** and use the following settings:
  - Select **SQL Server authentication**.
  - Clear the **Enforce password policy** check box.

**Tip:** If you want to host more than one content store on your Microsoft SQL Server instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- For Microsoft SQL Server 2008, grant EXECUTE permission to the user account that accesses the database.

- For the content store database, create a new database under **Databases**.

---

Chapter 5. Preparing to Install 65
• Under **Security** for the new database, create a new schema and assign a name to it.

• Under **Security** for the new database, create a new user with the following settings:
  – For **Login name**, specify the new login that you created for the user account.
  – For **Default schema**, specify the new schema.
  – For **Owned Schemas**, select the new schema.
  – For **Role Members**, select `db_datareader`, `db_datawriter`, and `db_ddladmin`.

### Suggested Settings for Creating the Content Store in the IBM Informix Dynamic Server Database

The database that you create for the content store must contain specific configuration settings.

Use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following checklist to help you set up the content store on the IBM Informix Dynamic Server database.

• Set the following environment variables:
  – **GL_USEGLU** - To enable International Components for Unicode (ICU) functionality in Informix Dynamic Server, set the value to 1.
  – **DB_LOCALE** - To set the database locale to Unicode, specify `en_us.utf8`.

• In the file `ONCONFIG.instance_name`, set the property `SHMBASE` to `0x14000000L`.

• Create a database in mode ANSI and with logging turned on.

• For the user account that you use to access the database, grant the DBA database privilege.

**Important:** If you host more than one database on your Informix instance and use them at the same time, use a different user account for each database. You must also define the user account in each instance of the IBM Cognos Configuration application by creating an advanced property parameter and specifying the user account as the value. For multiple content store databases, name the property `CMSCRIPT_CS_ID`. For multiple logging databases, name the property `IPFSCRIPTIDX`.

### Suggested Settings for Creating the Content Store in Sybase

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following checklist to help you set up the content store on Sybase.

• On the Sybase server, create a server instance with an 8 KB server page size.
  For instructions, see the Sybase documentation.

• If required, install jConnect 6.
  This tool sets up the communication between the JDBC driver and the Sybase Adaptive Server instance.
  For instructions, see the Sybase documentation.
If your version of Sybase does not include JConnect 6, you must download the installer from Sybase's Web site.

- Add the UTF-8 character set to the server instance.
- If required, make UTF-8 the default character set on the server.
- Create a database device.

**Tip:** Set log segment to a minimum of 10 MB.

- Set the new database device as the default.
  Information about the new database will be stored in the new database device.
  Keep a backup of the database device for recovery purposes.
- Create the database.
- Determine which user account will be used to access the database.

**Tip:** If you want to host more than one content store on your Sybase instance and you will use them at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- Ensure that the user account has the following privileges for the database: create default, create procedure, create rule, create table, and create view.
- Ensure that the database has the following settings and is restarted:
  - create and drop table privileges for the user account
  - Select into property is set to True

### Configure a User Account or Network Service Account for IBM Cognos Business Intelligence

You can configure either a user account or a network service account for IBM Cognos Business Intelligence.

The user or network service account under which IBM Cognos BI runs must:

- have access to all required resources, such as printers
- have the rights to log on as a service and act as part of the operating system

In addition, the user account must be a member of the local administrator group.

For example, to print reports using a network printer, the account must have access to the network printer, or you must assign a logon account to the IBM Cognos service.

### Configure a User Account

For Microsoft Windows operating system, assign a logon account to the IBM Cognos service. You can configure the IBM Cognos service to use a special user account by selecting the IBM Cognos service from the list of services shown in the Services window in Windows. You can then define the user account properties.

For UNIX or Linux operating system, create a new UNIX or Linux group named ibmcognos. This group must contain the user that owns the IBM Cognos files. Change the group ownership of the IBM Cognos files to the ibmcognos group and change the file permissions for all IBM Cognos files to GROUP READABLE/WRITABLE/EXECUTABLE.
You must configure the Web Server to use aliases. For more information, see the topic about configuring the Web server.

**Configure a Network Service Account**

The network service account is the built in account NT AUTHORITY\NetworkService in the operating system. Administrators do not need to manage a password or maintain the account.

Use an account with administrator privileges if you are installing on Windows Server 2008.

You must configure the Web server to use the application pool. For more information, see the topic about configuring the Web server. You also need the appropriate write permissions to install to the directory.

---

**Setting Up Environment Variables on UNIX for the Metric Store**

For IBM Cognos Business Intelligence, you must specify environment variables on a UNIX operating system before you can use a DB2 or Oracle database as the metric store.

The proper syntax for creating environment variables is shell dependent.

**DB2**

For IBM DB2 databases, you must set the database variables by running the environment setup scripts included with the IBM DB2 installation. For Bourne or Korn shells, run the following command or add it to the .profile script:

```
DB2_installation_path/db2profile
```

IBM Cognos BI Metrics Manager is only available in a 32-bit version. Ensure that the library path environment variable is pointing to the 32-bit libraries.

Contact your database or network administrator for the correct values for your system.

**Oracle**

For Oracle databases, you must set and export the database environment variables for the user of the metric store before you start the IBM Cognos processes. IBM Cognos BI uses these database variables to connect to your database. One way to set these environment variables is to include these commands in the .profile or .login script of the user who starts the IBM Cognos services.

When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

The following table describes environment variables for Oracle databases. Contact your database or network administrator for the correct values for your system.
<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| ORACLE_HOME          | The top level directory that contains the database client software or the entire database installation.  
Example: /usr/oracle  
You may be able to use an Oracle script to create the environment variables. For more information, see the Oracle documentation.  
Example: /usr/local/bin/coraenv |
| TNS_ADMIN            | The directory that contains the tnsnames.ora file, which allows calls to the Oracle database to determine the required server connections.  
Example:  
$ORACLE_HOME/network/admin |
| PATH                 | The variable to locate executable files.  
Example:  
$PATH:$ORACLE_HOME/bin |
| libraryPATH          | The load library path. You must point to the 32-bit library files.  
Examples:  
For Solaris or Linux operating system:  
LD_LIBRARY_PATH=$ORACLE_HOME/lib32:$LD_LIBRARY_PATH  
For AIX:  
LIBPATH=$ORACLE_HOME/lib32:$LIBPATH  
For HP-UX:  
SHLIB_PATH=$ORACLE_HOME/lib32:$SHLIB_PATH |
| NLS_LANG             | The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale. |

**Configure Web Browsers**

IBM Cognos Business Intelligence products use default browser configurations. Additional required settings are specific to the browser.
Browser Settings Required for IBM Cognos BI Portal

The following table shows the settings that must be enabled.

Table 9. Enabled Browser Settings for IBM Cognos BI Portal

<table>
<thead>
<tr>
<th>Browser</th>
<th>Setting</th>
<th>IBM Cognos component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer (settings for studios and portals)</td>
<td>Allow Cookies</td>
<td>IBM Cognos Connection</td>
</tr>
<tr>
<td></td>
<td>Active Scripting</td>
<td>IBM Cognos Administration</td>
</tr>
<tr>
<td></td>
<td>Allow META REFRESH</td>
<td>Cognos Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Report Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Query Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Event Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Metric Studio</td>
</tr>
<tr>
<td>Internet Explorer (settings for some studios)</td>
<td>Run ActiveX controls and plug-ins</td>
<td>Report Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Query Studio</td>
</tr>
<tr>
<td></td>
<td>Script ActiveX controls marked safe for scripting</td>
<td>Analysis Studio</td>
</tr>
<tr>
<td>Internet Explorer (settings for a single studio)</td>
<td>Binary and script behaviors</td>
<td>Report Studio</td>
</tr>
<tr>
<td></td>
<td>Allow programmatic clipboard access</td>
<td></td>
</tr>
<tr>
<td>Firefox</td>
<td>Allow Cookies</td>
<td>IBM Cognos Connection</td>
</tr>
<tr>
<td></td>
<td>Enable Java</td>
<td>IBM Cognos Administration</td>
</tr>
<tr>
<td></td>
<td>Enable JavaScript</td>
<td>Cognos Viewer</td>
</tr>
<tr>
<td></td>
<td>Load Images</td>
<td>Report Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Query Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis Studio</td>
</tr>
</tbody>
</table>

Report Studio and Query Studio use the native Microsoft Internet Explorer XML support, which is a component of the browser. ActiveX support must be enabled because Microsoft applications implement XML using ActiveX. IBM Cognos BI does not provide or download ActiveX controls. Only the ActiveX controls that are installed as part of Internet Explorer are enabled through this configuration.

If Adblock Plus is installed with Firefox, disable it using the per-page option. Adblock Plus prevents some IBM Cognos Connection resources from working properly.

If you use Microsoft Internet Explorer Version 8, you may receive Adobe link errors when you open PDF documents in the IBM Cognos portal. To prevent these errors, in Internet Explorer, from the Tools menu, select Manage Add-ons, and disable Adobe PDF Reader Link Helper.
If you use a Microsoft Internet Explorer Web browser, then you can add the URL for your gateway(s) to the list of Trusted sites. For example, http://<server_name>:<port_number>/ibmcognos. This enables automatic prompting for file downloads.

For more information, see “IBM Cognos Application Firewall” on page 357.

**Cookies Used by IBM Cognos BI Components**

IBM Cognos BI uses the following cookies to store user information.

*Table 10. Cookies used by IBM Cognos BI components*

<table>
<thead>
<tr>
<th>Cookie</th>
<th>Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS_TICKET</td>
<td>Session temporary</td>
<td>Created if IBM Cognos BI is configured to use an IBM Cognos Series 7 namespace</td>
</tr>
<tr>
<td>caf</td>
<td>Session temporary</td>
<td>Contains security state information</td>
</tr>
<tr>
<td>Cam_passport</td>
<td>Session temporary</td>
<td>Stores a reference to a user session stored on the Content Manager server. Administrators can set the HTTPOnly attribute to block scripts from reading or manipulating the CAM passport cookie during a user's session with their web browser. For more information, see the IBM Cognos Business Intelligence Administration and Security Guide.</td>
</tr>
<tr>
<td>cc_session</td>
<td>Session temporary</td>
<td>Holds session information that is specific to IBM Cognos Connection</td>
</tr>
<tr>
<td>cc_state</td>
<td>Session temporary</td>
<td>Holds information during edit operations, such as cut, copy, and paste</td>
</tr>
<tr>
<td>CRN</td>
<td>Session temporary</td>
<td>Contains the content and product locale information, and is set for all IBM Cognos users</td>
</tr>
<tr>
<td>CRN_RS</td>
<td>Persistent</td>
<td>Stores the choice that the user makes for the &quot;view members folder&quot; in Report Studio</td>
</tr>
<tr>
<td>PAT_CURRENT_FOLDER</td>
<td>Persistent</td>
<td>Stores the current folder path if local file access is used, and is updated after the Open or Save dialog box is used</td>
</tr>
</tbody>
</table>
Table 10. Cookies used by IBM Cognos BI components (continued)

<table>
<thead>
<tr>
<th>Cookie</th>
<th>Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>qs</td>
<td>Persistent</td>
<td>Stores the settings that the user makes for user interface elements such as menus and toolbars</td>
</tr>
<tr>
<td>userCapabilities</td>
<td>Session temporary</td>
<td>Contains all capabilities and the signature for the current user</td>
</tr>
<tr>
<td>usersessionid</td>
<td>Session temporary</td>
<td>Contains a unique user session identifier, valid for the duration of the browser session.</td>
</tr>
</tbody>
</table>

After upgrading or installing new software, restart the Web browser and advise users to clear their browser cache.
Chapter 6. Upgrading to IBM Cognos Business Intelligence

New versions of IBM Cognos Business Intelligence (BI) provide enhancements that may affect many components, such as product features and functionality, performance and scalability, and usability. Because of these improvements, upgrading may not be simple, and should be considered a process that you perform in stages.

You should treat upgrading as an IT project that requires careful planning, adequate time, and resources.

If you have IBM Cognos Series 7 content, you can move some of that content to IBM Cognos BI using migration tools that are available in a separate installation.

If you are using previous versions of ReportNet, Metrics Manager, IBM Cognos for Microsoft Office, or Transformer, you can upgrade your content to IBM Cognos BI. You can also upgrade from previous versions of IBM Cognos BI, including full and maintenance (MR) releases.

Upgrade activities

When you upgrade, you perform two distinct activities:
1. Install the new version of the product.
2. Move applications to the new version of the product.

Different groups are commonly involved in each of these activities. As part of the project, you should assess both your current IT environment and your existing applications separately, to ensure that the infrastructure can support your business objectives.

Install the New Version of the Product

You can install the new version of the product in the same location as the existing version after you uninstall, or you can install into a new location.

First install into a new location, such as a test environment. This allows you to test your applications in both the old and new environment to ensure that they work as expected when you upgrade. You can compare the appearance and functionality of the reports in both environments to ensure equivalency.

Move Content to the New Environment

As part of the upgrade process, ensure that your applications work as expected in the new version. Sometimes, changes may introduce unexpected results. It is important to test your applications before you move them.

In IBM Cognos BI, when you move content from one environment to another, you do a deployment.
Upgrade Process

The following diagram shows the approach to upgrade. The diagram shows the stages in the upgrade process. Before you start, you plan the upgrade, assess the applications that you want to upgrade and create a test environment. You should iteratively deploy and test content in both the source and target environments before you move successfully upgraded applications to a production environment.

Upgrade Process Workflow

In some upgrade situations, other tasks may be required. For example, if you use Software Development Kit applications that depend on the report specifications, you must upgrade your Software Development Kit applications before upgrading the report specifications. If you are upgrading from ReportNet 1.1 MR3 or MR4 or from any previous version of IBM Cognos BI, you can use Lifecycle Manager to automate some tasks in the trial upgrade stage.

See the following topics for information about upgrading:
- “Planning the Upgrade”
- “Migrating from IBM Cognos Series 7” on page 86
- “Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI” on page 87
- “Upgrading IBM Cognos for Microsoft Office” on page 116
- “Upgrading Transformer Models and PowerCubes” on page 118

Planning the Upgrade

Plan your upgrade so that you know what to expect at each stage of the process. In the planning stage, you can review the upgrade documentation for information about expected behavior, new features, deprecated features, compatibility between versions, and requirements for preparing your production environment. When you finish the review, you can then conduct a site survey to identify the BI infrastructure, applications, reports, and custom configuration settings. Finally, you
can test the upgrade on a subset of your data so that you can fine tune your reports and data before committing to the full upgrade.

The following diagram shows a high level view of the phases in an upgrade project.

![Figure 1. High level view of the upgrade phases](image)

When planning your upgrade, ensure that you

- gather the necessary information, such as the required inputs and expected outputs for each phase
- assess the applications in your reporting environment and group similar reports together
- install the new software in a test environment and deploy the content to the test environment
- test the upgraded applications to ensure reports run as expected

Deployment and testing is usually an iterative process. Assess any differences between the source and target environments to determine actionable activities. Move to your production environment when you are satisfied that the deployed applications meet your business requirements.

Do not change security providers, such as changing from an IBM Cognos Series 7 namespace to Active Directory as part of the upgrade process. You should treat that as a separate project.

Ensure that you have the skills available, either internal or using external resources. Also consider the hardware that you will need before you begin.

**Review the Documentation**

Documentation is provided from a variety of sources to help you achieve a successful upgrade.

All the documentation is available online at the IBM Cognos Customer Service Center [http://www.ibm.com/software/data/support/cognos_crc.html](http://www.ibm.com/software/data/support/cognos_crc.html).

**Procedure**

1. Read the "What's New" section in this guide.
   - It contains a list of new, changed, deprecated, and removed features for this release.
2. Read the rest of the Upgrade information in this document.
3. Read the topic about IBM Cognos BI with other IBM Cognos products.
   - It contains information about other IBM Cognos products that you may have in your environment and that must be considered in the upgrade.
### Assess Applications in the Source Environment

Preparing to upgrade provides an opportunity to review your current Planning investment, and clean up your source environment. Inventory your Planning applications to understand the strengths, weaknesses, and areas for improvement in your environment.

For example, you may have hundreds of applications in your environment. However, it is not uncommon to find that a number of applications are not used, do not meet the company's requirements, or do not work in the source environments.

You should conduct an audit of your applications to determine which applications you should upgrade. Assessing and reducing the number of applications is a useful exercise. Do not rely only on user feedback to determine which content is used.

An audit of your existing applications may include the following tasks:

- **Do a site survey.**
  Assess the current production environment and identify areas that require attention during an upgrade. The site survey includes information about the infrastructure, applications, users, and configuration settings.

- **Assess the software that you use in your environment.**
  List software, such as operating systems, Web servers, security, databases. Compare the list to the supported versions for your target upgrade version, available from the Production Information, Software Environments links at the IBM Cognos Customer Service Center (http://www.ibm.com/software/data/support/cognos_crc.html). Determine whether any components require updating.

- **Complete a detailed assessment of your applications.**
  The usage, age, size, and complexity of your applications are important factors to consider when planning the upgrade. The total size of the applications may have an impact on the time required to complete the upgrade.

- **List the following information about your configuration:**

#### Table 11. List of upgrade documentation

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Business Intelligence Release Notes</td>
<td>Recent issues that may affect an upgrade</td>
</tr>
<tr>
<td>IBM Cognos Business Intelligence New Features</td>
<td>New features that may affect the behavior of existing content</td>
</tr>
<tr>
<td>Framework Manager User Guide</td>
<td>Upgrading models</td>
</tr>
<tr>
<td>IBM Cognos Report Studio User Guide</td>
<td>Upgrading reports</td>
</tr>
<tr>
<td>IBM Cognos Transformer User Guide</td>
<td>Upgrading user views and upgrading IBM Cognos Series 7 models</td>
</tr>
<tr>
<td>IBM Cognos Migration Assistant User Guide</td>
<td>Moving metadata, Impromptu catalogs and reports, PowerPlay reports, and Upfront content from IBM Cognos Series 7 to IBM Cognos BI</td>
</tr>
<tr>
<td>IBM Cognos Lifecycle Manager User Guide</td>
<td>Using Lifecycle Manager to audit trial upgrades from ReportNet 1.1 MR3 or MR4 to IBM Cognos BI, Version 8.2 or later</td>
</tr>
</tbody>
</table>
- configuration settings that you enabled using IBM Cognos Configuration
  These settings are preserved through the upgrade. They are stored in two files, cogstartup.xml and coglocale.xml.
- changes to other configuration files
  You must make the changes manually to other configuration files during the upgrade. If you changed other configuration files, you must assess the changes that you want to preserve in the upgraded environment. This may include .xml, .txt, and .css files in the configuration, templates, webapps, and webcontent directories of the installation location.

**Important**: Changes to .ini files are not supported. If you changed .ini files, please contact Customer Support.

- Back up all reports, models, configuration data, and files.

Once your audit is complete, you can create an upgrade plan.

**Perform a Trial Upgrade**

Pilot upgrade projects are valuable and practical exercises because they ensure that the upgrade produce the expected and required outcome. In addition, an evaluation of the pilot project ensures that the upgrade is successful.

If unexpected results occur, you can determine whether the differences are enhancements for your situation or whether you should take action to mitigate the differences.

When you upgrade, applications usually work in the new environment, with little or no intervention. By running a pilot upgrade you can validate selected applications to see if the expected results are produced.

You can perform a trial upgrade several weeks before upgrading your production system. The trial upgrade identifies components that will upgrade with minimal effort, and components that may require additional actions before or after the upgrade.

Ensure skilled resources are available to perform migration work, especially for mission-critical applications. Also, test and debug all applications prior to deployment.

**Create the Test Environment**

Create a test environment for the new software in preparation for your trial upgrades.

Initially, the new environment does not need to be large, or be the same as your production environment. For example, if it is acceptable, you may use hardware from existing environments, such as development servers.

The environment can be scaled up and out in a phased way after the basic new environment is up and running.

Alternatively, existing environments can remain untouched. If you want the test environment to become the new production environment, configure the test system to match your production environment.
**Procedure**
1. Ensure the infrastructure is in place.
2. Review the supported environments.
3. Install the new software in the test environment.
   Having the new version of software in a different location than the earlier version ensures that you run both versions at the same time and confirm that your applications work properly in both environments.

**Results**
After you have installed the software, use the deployment process to upgrade the content. For more information, see the online help in the IBM Cognos Administration console.

**Plan Your Deployment**
Deployment involves moving applications, models, macros, administration links, or Planning Analyst libraries from one installation to another.

When you deploy, you must consider how to handle security and whether to deploy the entire content store or to deploy selected packages, folders, and directory content. Other considerations relate to the database you use for the content store, bursting reports, and ownership of entries.

For more information about planning the deployment of content to a new environment, see the IBM Cognos Planning Contributor Administration Guide.

The following diagram summarizes the deployment process.

![Deployment Process Workflow](image)

**Figure 2. Deployment Process Workflow**

**Security**
Before you deploy, you must consider access permissions and security of deployment archives.

To deploy IBM Cognos Connection entries, you must have the following permissions:
- Execute permissions for the **Administration tasks** secured feature.
- Traverse permissions for the **Administration** secured function.

Also, you need to belong to the System Administrators group, and have read and write access to the Cognos namespace, so that you can deploy the System Administrators group.
For more information about security and deployment, see the IBM Cognos Planning Contributor *Administration Guide*.

**References to Namespaces**

Some entries, such as groups, roles, distribution lists, contacts, data source signons, and some report properties, such as email recipients and report contacts, can refer to entities in namespaces, or authentication providers. When you deploy public folders and directory content, you can deploy these entries with or without the third-party references.

**Deploying the Entire Content Store**

Deploying the entire content store ensures that all the data is copied to a new location. For example, if you are moving Planning to another computer, you can move the entire content store from the old environment to the new environment.

When you import an entire content store, configuration data is included in the export, but excluded from the import by default. Do not change this setting.

**Related tasks**

- “Include Configuration Objects in Import of Entire Content Store” on page 82

You can include configuration objects when importing an entire content store. For example, you may want to import the configuration because you have a series of advanced settings for your services that you want from the source environment.

**Create an Export Deployment Specification**

After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, you create an export deployment specification in your source environment.

The entries are exported to an export deployment archive in the source environment. Later, you import the archive entries into the target environment. You can update the entries in the target environment using the entries from the deployment archive.

Stop the IBM Cognos BI service in IBM Cognos Administration before you export and import. For more information, see the *Administration and Security Guide*.

**Create a New Export Deployment Specification for the Content Store:**

To create an export deployment specification in your source environment proceed as follows.

**Procedure**

1. In IBM Cognos Administration, on the Configuration tab, click Content Administration.

2. On the toolbar, click the new export button and follow the instructions in the New Export wizard.

3. To export the entire content store, click Select the entire content store and select whether to include user account information.

4. Click Next.
5. If you want to secure the archive, under **Encryption**, click **Set the encryption password**, type a password, and then click **OK**, and then click **Next**. The summary information appears.

6. Review the summary information and click **Next**.

   **Tip:** If you want to change information, click **Back** and follow the instructions.

7. Determine how you want to run the export by selecting the action you want.

**Results**

After you run the export, you can move the deployment archive. You can also see the export run history.

**Related tasks**

“Copy the Deployment Specification to the Test Environment” on page 82

Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

Create a New Export Deployment Specification for Partial Deployments:

After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, you create an export deployment specification in your source environment.

**Procedure**

1. In **IBM Cognos Administration**, on the **Configuration** tab, click **Content Administration**.

2. On the toolbar, click the new export button and follow the instructions in the **New Export** wizard.

3. To export specific folders and directory content, click **Select public folders and directory content**, and then click **Next**.

4. In the **Select the Public folders content** page, click **Add**.

5. In the **Select entries** page, in the **Available Entries** box, select the packages or folders that you want to export.

   You can browse the Public Folders hierarchy and choose the packages and folders you want. Click the right arrow button to move the selected items to the **Selected entries** box, and click **OK**.

6. For each package and folder that you export, do one of the following:
   
   - If you want to make any changes to the package or folder in the target environment, click the edit button make your changes, and click **OK**.
   
   - To restrict access to the package or folder and its entries, select the check box in the **Disable after import** column. This is useful when you want to test the reports before you make them available in the target environment.

7. Under **Options**, select whether you want to include the report output versions, run history, and schedules and what to do with entries in case of a conflict, and then click **Next**.
8. In the Select the directory content page, select whether you want to export IBM Cognos groups and roles, distribution lists and contacts, and data sources and connections and what to do with the entries in case of a conflict, and then click Next.

9. In the Specify the general options page, select whether to include access permissions and who should own the entries after they are imported in the target environment.

10. Specify the Recording Level for the deployment history, and then click Next.

11. In the Specify a deployment archive page, under Deployment archive, select an existing deployment archive from the list, or type a new name to create one.

   If you are typing a new name for the deployment archive, do not use spaces in the name. If the name of the new deployment specification matches the name of an existing deployment archive, the existing deployment archive is overwritten.

12. If you want to secure the archive, under Encryption, click Set the encryption password, type a password, and then click OK.

13. Click Next.

   The summary information appears.

14. Review the summary information and click Next.

   Tip: If you want to change information, click Back and follow the instructions.

15. Determine how you want to run the export by selecting the action you want.

Results

After you run the export, you can move the deployment archive. You can also see the export run history.

Related tasks

“Copy the Deployment Specification to the Test Environment” on page 82

Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

Run an Export:

After you create an export deployment specification in your source environment, you run the export.

Procedure

1. In the Actions column, click the run with options button.

2. Click Now to run the export immediately, or click Later, and enter the time that you want the export to run.

   You can also schedule a task to run on a recurring basis, and view a list of scheduled tasks using the Schedule Management tool.

Results

You can now move the deployment archive.
Related tasks

"Copy the Deployment Specification to the Test Environment"
Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

Copy the Deployment Specification to the Test Environment
Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

Before you begin
If you plan to move the deployment archive to a location on a LAN, ensure that there is enough disk space.

About this task
Later, you use the deployment archive to import entries into the target environment.

Related concepts

"Import to the Test Environment” on page 83
You import entries from the deployment archive into the target environment. To import the entries, you create an import deployment specification.

Related tasks

"Create a New Export Deployment Specification for the Content Store” on page 79
To create an export deployment specification in your source environment proceed as follows.

"Create a New Export Deployment Specification for Partial Deployments” on page 80
After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, you create an export deployment specification in your source environment.

"Run an Export” on page 81
After you create an export deployment specification in your source environment, you run the export.

"Include Configuration Objects in Import of Entire Content Store”
You can include configuration objects when importing an entire content store. For example, you may want to import the configuration because you have a series of advanced settings for your services that you want from the source environment.

Include Configuration Objects in Import of Entire Content Store
You can include configuration objects when importing an entire content store. For example, you may want to import the configuration because you have a series of advanced settings for your services that you want from the source environment.

By default, configuration objects are excluded when you import an entire content store, even though they are included in the export. Configuration objects include dispatchers and configuration folders used to group dispatchers.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, click Dispatchers and Services.
2. Click the dispatcher you want.
3. Next to **ContentManagerService**, click the set properties button.
4. Click the **Settings** tab.
5. In the **Value** column, click **Edit**.
6. Select the **Override the settings acquired from the parent entry** check box.
7. In the **Parameter** column that appears, type the following in uppercase:
   - **CM.DEPLOYMENTINCLUDECONFIGURATION**
8. In the **Value** column, type **true**
9. Click **OK** to finish.

**Related concepts**
- “Plan Your Deployment” on page 78
  Deployment involves moving applications, models, macros, administration links, or Planning Analyst libraries from one installation to another.

**Related tasks**
- “Copy the Deployment Specification to the Test Environment” on page 82
  Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

**Import to the Test Environment**
You import entries from the deployment archive into the target environment. To import the entries, you create an import deployment specification.

When you import, you select from entries that were exported. You can either accept the default options set during the export, or change them. You can only select options that were included in the deployment archive during the export.

If you do a partial deployment of specific public folders and directory content, the import wizard shows whether packages and folders already exist in the target environment and the date and time they were last modified. You can use this information to help you decide how to resolve conflicts. When you redeploy, the wizard also shows whether the packages and folders were in the original deployment.

**Related tasks**
- “Copy the Deployment Specification to the Test Environment” on page 82
  Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

Create an Import Deployment Specification:
To import the entries, you create an import deployment specification.

**Procedure**
1. In the target environment, in **IBM Cognos Administration**, on the **Configuration** tab, click **Content Administration**.
2. On the toolbar, click the new import button .
   The **New Import** wizard appears.
3. In the **Deployment archive** box, click the deployment archive that you want to import.
4. If the deployment archive is encrypted, type the password, and then click **OK**.

5. Click **Next**.

6. Type a unique name and an optional description and screen tip for the deployment specification, select the folder where you want to save it, and then click **Next**.

7. Select the content that you want to include in the import.

   **Tip:** To ensure that the required target package or folder exists in the target content store, click the edit button next to the package, and check the location. If you want, you can change the target location now.

8. Select the options you want, along with your conflict resolution choice for the options that you select.

9. In the **Specify the general options** page, select whether to include access permissions and who should own the entries after they are imported in the target environment.

10. Specify the **Recording Level** for the deployment history.
    
    The default level, **Basic**, saves the deployment progress and summary information. If you want just the summary information, select **Minimal**. If you want all deployment details, select **Trace**.

11. Click **Next**.
    
    The summary information appears.

12. Review the summary information, and click **Next**.

13. Determine how you want to run the import by selecting the action you want.

**Results**

After you run the import, you can **test the deployment**.

**Run an Import:**

After you create an import deployment specification, you run the import.

**Procedure**

1. In the **Actions** column, click the run with options button.

2. Click **Now** to run the import immediately, or click **Later**, and enter the time that you want the import to run.

3. If you want to upgrade the report specifications, click **Upgrade all report specifications to the latest version**.

   You can also use the Schedule Management tool to schedule a task to run on a recurring basis, and view a list of scheduled tasks.

**Results**

You can now **test the deployment**.

**Test the Deployed Content**

After you import the packages from the deployment archive, you can check that all the entries were deployed successfully in the target environment.

You can test your deployment by doing the following:
• Review the run history for a deployment.
• Ensure that the correct packages and folders were imported, along with their contents.
• Run imported reports and report views.

For more information, see the online help in the IBM Cognos Administration console.

**Recommendation - Test the Upgraded Content**

After you import the packages from the deployment archive, you can check that all the entries were deployed successfully in the target environment.

Test your upgraded content by doing the following:
• View the status of existing deployments.
• Ensure that the correct packages and folders were imported, along with their contents.
• Test models.
• Test applications.
• Repair or exclude models that do not operate correctly.
• Test the repaired models by running them again on the test system.
  Troubleshoot any issues, and contact IBM Cognos Software Services about unresolved upgrade issues.
• Revise the upgrade plan to include adaptations that you made during the trial upgrade.

For more information, see the IBM Cognos Planning Contributor *Administration Guide*.

**Moving to the Production Environment**

When all issues that you discovered during the trial upgrade are resolved, you are ready to begin the full upgrade in your production environment. Your upgrade plan will provide the details for each step of the full upgrade.

The following diagram shows the high level steps in the process of moving upgraded applications to a production environment. After preparing the production environment and backing up data and configuration files, you can uninstall the older version of the software, and install the new version in the same location. Then, you can deploy the content from your test environment.

*Figure 3. High level steps in process of moving upgraded applications to a production environment*

If you want to leverage your existing resources and upgrade in the same directory, you must first back up your configuration data, ensure that Framework Manager...
models are backed up and checked into a source control system (if applicable), and uninstall the older version of IBM Cognos BI.

Use the following checklist to guide you through the process of moving to a production environment:

- Prepare the production environment.
  - Back up files and data.
    You may have modified files other than those in the configuration folder.
    Back up the entire installation directory.
    When you back up the configuration data, store it in a secure directory. You must protect the directory from unauthorized or inappropriate access.
  - Install your new release system in the production environment.
    If you install the new software from the test environment to the same location as the existing software, you must first uninstall the existing software.
  - Configure the system.
- Manually configure customization.
  - If you manually edited any configuration files, the changes will be overwritten during the upgrade. You must reapply the changes. You should keep a record of any customizations to ensure that they can be reapplied after upgrading. You should also back up these files so that you can restore the original version if necessary.
  - The IBM Cognos BI presentation service supports automatic upgrade of some system.xml files. If you made many customization changes to system.xml files, you can use this automatic upgrade feature instead of reapplying the changes manually after upgrading. The system.xml files are overwritten during the installation of IBM Cognos BI. Therefore, you must back up the customized versions of these files and then copy them to the directory after upgrading IBM Cognos BI. The automatic upgrade will be applied when you start the IBM Cognos service.
  - The system.xml files for which automatic upgrade is supported are in the following directories:
    - `c10_location/templates/ps`
    - `c10_location/templates/ps/portal`
    - `c10_location/templates/ps/qs`
    - **Note:** To upgrade customized files, manually reapply changes after the new software is installed. Use automatic upgrade of system.xml files only when you have made a large number of customizations to these files.
- Deploy the application on the production system.
  When upgrading, you can export the entire content store to a deployment archive and then import the deployment archive into IBM Cognos BI after upgrading the software.
- Deploy the reports and models from the test system to the production system.

**Migrating from IBM Cognos Series 7**

You can move content from IBM Cognos Series 7 to IBM Cognos BI. If you are using a version of IBM Cognos Series 7 that is not supported for migrating to IBM Cognos BI, you must first upgrade the software and data to a supported version of IBM Cognos Series 7. Moving other IBM Cognos Series 7 content to IBM Cognos BI is considered a migration.
For a list of supported versions, see the IBM Cognos Customer Service Center [http://www.ibm.com/software/data/support/cognos_crc.html).

You can move the following types of content to IBM Cognos BI:

- IBM Cognos Series 7 Web-based content, such as the following:
  - PowerPlay Web Explorer reports
  - Upfront content, such as NewsBoxes and NewsIndexes
  - Impromptu Web Reports content, such as events, schedules, and Impromptu reports
- PowerPlay reports for Microsoft Windows operating system
- Impromptu reports and catalogs from Windows
- Architect models from Windows
- Transformer PowerCubes, including user class views and user classes from models with secured cubes

If you have published PowerPlay Web reports to IBM Cognos Connection, either the ReportNet version or the IBM Cognos BI version, you can continue to open the PowerPlay Web reports in PowerPlay Web Explorer or you can upgrade the PowerPlay Web reports to Analysis Studio.

Transformer allows you to place security objects from different namespaces within a single custom view. IBM Cognos BI supports multiple namespaces for securing PowerCubes, but only to verify content when migrating from IBM Cognos Series 7 security to an alternate security provider. You cannot deploy PowerCubes that are secured against multiple namespaces in IBM Cognos BI. After verifying the content in the model, you must associate a single namespace with each PowerCube. For more information about deploying PowerCubes, see the Transformer User Guide. For information about upgrading IBM Cognos Series 7 content to IBM Cognos Transformer, see “Upgrading Transformer Models and PowerCubes” on page 118.

If you are moving content from IBM Cognos Series 7, you must install the IBM Cognos Migration Assistant to upgrade your IBM Cognos Series 7 content to IBM Cognos BI.

You can obtain IBM Cognos Migration Assistant by request. For more information, go to the IBM Cognos Customer Service Center [http://www.ibm.com/software/data/support/cognos_crc.html]. The documentation for installing and using Migration Assistant is included with the product.

To upgrade PowerPlay reports that are published to IBM Cognos Connection, after you install IBM Cognos Migration Assistant, you must enable the options to allow users to open the IBM Cognos Series 7 reports in Report Studio or Analysis Studio. You use IBM Cognos Connection to enable the options. For more information, see the Administration and Security Guide.

**Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI**

You must upgrade the software to move from an earlier version of IBM Cognos BI, ReportNet, or Metrics Manager to a new version of IBM Cognos BI. You must upgrade all components. Components from different versions are not compatible. If you are using IBM Cognos Series 7 PowerCubes as a data source, it is not necessary to upgrade Transformer unless you want to use the features of the new
version of Transformer. PowerCubes that are built using IBM Cognos Series 7.3 Transformer (or later) and IBM Cognos BI, Version 8.3 Transformer (or later) are both supported with IBM Cognos BI reporting and metrics.

For more information, see “Upgrading Transformer Models and PowerCubes” on page 118.

If you are using previous versions of ReportNet, Metrics Manager, IBM Cognos for Microsoft Office, or Transformer, you can upgrade your content to IBM Cognos BI. You can also upgrade from previous versions of IBM Cognos BI, including full and maintenance (MR) releases.

You can upgrade directly to IBM Cognos BI from the following product versions:

- IBM Cognos BI, Version 8.1 or later, including MR releases
  
  If you are upgrading from IBM Cognos BI, Version 8.2, 8.3, or 8.4, you can use LifeCycle Manager to automate some tasks in the trial upgrade stage. For more information, see the LifeCycle Manager User Guide.

- ReportNet 1.1 MR1 through MR4
  
  If you are upgrading from ReportNet 1.1 MR3 or MR4, you can use Lifecycle Manager to automate some tasks in the trial upgrade stage. For more information, see the LifeCycle Manager User Guide.

  If you have an earlier version of ReportNet, you must first upgrade to one of the ReportNet 1.1 MR releases (1 through 4) and then upgrade to IBM Cognos BI.

- Metrics Manager 2.0 or later

You can run different versions of the software on your computer at the same time, provided that you install them in different directories and configure each to use a different content store and a different set of ports and URLs for each version.

Before you begin upgrading, you must plan your upgrade strategy “Planning the Upgrade” on page 74. The strategy depends on the data that you want to use and any customizing that you have done with your existing configuration.

When upgrading from ReportNet, if you want to use an existing configuration directory, you must ensure that the configuration data from ReportNet is copied to the IBM Cognos BI installation location. This includes backing up existing data, configuring IBM Cognos BI to use the existing content store or a copy of it, copying the configuration data files to the IBM Cognos BI installation directory, and reapplying any manual edits or customizations that you applied in the earlier version.

If Metrics Manager is on the same computer as ReportNet or an earlier version of IBM Cognos BI, upgrade ReportNet or the earlier version of IBM Cognos BI first, and then upgrade Metrics Manager.

After upgrading to IBM Cognos BI using existing data, additional configuration may be required if you want to use new features. For information about new features in IBM Cognos BI, see IBM Cognos BI New Features.

IBM Cognos BI can read deployment archives produced by ReportNet.
Software Development Kit Applications

You must use compatible versions of IBM Cognos BI Software Development Kit applications and IBM Cognos Business Intelligence.

If you upgrade from ReportNet, you must make some changes to your Software Development Kit program for it to function with the IBM Cognos software version of the WSDL file. Some methods, classes, and properties have been deprecated in IBM Cognos software. Deprecated features continue to function as before, but will be removed in future releases. Some other methods, classes, and properties are obsolete, and have been removed from the IBM Cognos Software Development Kit.

The XLS and singleXLS output formats are deprecated in this release. Reports that use these formats can be viewed, for backwards compatibility. During upgrade or deployment, some properties where outputFormatEnum can be specified are checked for either of these values and automatically changed to XLWA.

For information about changes to methods, classes, properties, and enumeration sets, see the Release Notes appendixes in the IBM Cognos Software Development Kit Developer Guide.

New report specifications have been added in IBM Cognos software. If you run a report that was created in ReportNet or in a previous version of IBM Cognos software, it is automatically upgraded to the new IBM Cognos software format. After a report is upgraded to the new format, it cannot be returned to the ReportNet or older IBM Cognos software format. Because of the potential for users to upgrade report specifications that Software Development Kit applications may depend on, set access permissions on those reports to limit user access. For more information about setting access permissions, see the IBM Cognos Administration and Security Guide.

If you have Software Development Kit applications that create, modify, or save report specifications, do not upgrade your report specifications when you install the new version of IBM Cognos software. You must first update your Software Development Kit applications to comply with the IBM Cognos software report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications. For information about upgrading report specifications, see the IBM Cognos Software Development Kit Developer Guide.

Do not upgrade your report specifications if you are unsure about whether you have Software Development Kit applications that create, modify, or save report specifications. Contact your Software Development Kit administrator for more information about your Software Development Kit applications.

Content Manager

When you start the service after upgrading, Content Manager automatically upgrades the schema and contents in the content store if you use the same content store database as the previous version. Upgraded content store databases are not backward compatible and thus cannot be used by previous versions of IBM Cognos BI. To protect your original content store data, you must configure IBM Cognos BI to use a copy of the content store. You create a copy by backing up the original content store and restoring the data into a new content store.
Content Store

If you saved reports from IBM Cognos Series 7 PowerPlay or scorecards from IBM Cognos Metrics Manager 2.x in ReportNet, the content store upgrade carries the saved reports and scorecards forward into IBM Cognos BI.

Framework Manager

You can use the same models and projects in Framework Manager for IBM Cognos BI that you used with the earlier version. When upgrading models, the validation process produces errors for every model. To upgrade a project, you open and save it in the new version of Framework Manager. For more information, see the Framework Manager User Guide.

If you have Software Development Kit applications that rely on an earlier version of the report specifications, you cannot use Framework Manager to publish your model without losing backward compatibility.

Report Studio

The upgrade does not account for such items as undocumented and unsupported features, changes in report behavior, and changes in formatting and style sheets. For more information, see the Report Studio User Guide.

Metrics Manager Data Stores

In earlier versions, Metrics Manager used a data store database to store, organize, and retrieve information. In IBM Cognos BI, this database is referred to as the metric store. If you want to use data store content from an earlier version, you can export the content from the data store, install IBM Cognos BI, and import the content into the metric store.

You cannot use the metric store with versions of Metrics Manager other than 8.x because it is not compatible. Before exporting the data store content, ensure that you back it up.

Security

When you upgrade from ReportNet or an earlier version of IBM Cognos BI, security may be affected. For example, new roles may exist that were not in earlier releases and some roles may have new capabilities. As a result, the security of your upgraded system may not be at the desired level. To confirm the security level after upgrading, see the Administration and Security Guide.

Dynamic Query Mode

After upgrading to IBM Cognos Business Intelligence, Version 10.1.0, you may want to take advantage of the new feature, dynamic query mode.

Some configuration is required to support dynamic query mode. For more information, see “Set Up Database Connectivity for the Content Store Database” on page 133.

For a complete description of the benefits of using dynamic query mode, see the Dynamic Query Guide.
Operating Systems

As you upgrade your IBM Cognos BI products, you may choose to install some components on new operating systems. You must consider how these operating systems might affect the installation and configuration of IBM Cognos BI.

If your upgrade includes installing IBM Cognos BI client components on Microsoft Windows Vista operating system, you must consider the following:

- **roaming profiles**
  Profiles of users are stored in a different location than in earlier Windows operating systems. The Documents and Settings directory is replaced by the Users directory. The All Users directory is replaced by the Public directory.

- **environment variables**
  The default paths that are associated with environment variables are changed. If you use scripts or applications that reference the paths in the environment variables, you may need to update the scripts and applications.

In addition, you may want to reconfigure the default file locations in IBM Cognos Configuration so that a single file location can be used across operating systems in your IBM Cognos BI environment. For more information, see the topic about updating file location properties in the configuration chapter “File Location Properties on Windows Vista” on page 421.

Installations That Include Earlier Versions of Other IBM Cognos BI Products

If you are upgrading IBM Cognos BI in an environment that includes earlier versions of other IBM Cognos BI products, such as IBM Cognos BI Controller Version 8.x, IBM Cognos BI Planning Version 8.x, or IBM Cognos BI Analysis for Microsoft Excel Version 8.x, install the new version of IBM Cognos BI in a separate location from the other IBM Cognos BI product and configure the new version of IBM Cognos BI to operate independently of that product. After you upgrade the other product to a compatible version with IBM Cognos BI, you can then configure the two products to operate together.

Related concepts

"IBM Cognos Products That Can Be Upgraded to IBM Cognos BI” on page 50

The following IBM Cognos products are earlier versions of components that are now within IBM Cognos BI: ReportNet, IBM Cognos Metrics Manager, DecisionStream, and PowerPlay Web. When you upgrade these products to IBM Cognos BI, you can continue to run the earlier versions concurrently on the same computer until you are satisfied with the transition to IBM Cognos BI.

Upgrade from an Earlier Version of IBM Cognos BI

You can upgrade IBM Cognos BI in the same directory as an earlier version or in a different directory, depending on where you are in the process. For example, if you are setting up your test environment, you install in a new directory. If you have finished testing your applications and want to upgrade the software in your production environment, you can install in the same directory after uninstalling the earlier version.

If you want to upgrade IBM Cognos BI in the same directory, you must first back up your configuration data, ensure that Framework Manager models are backed up and checked into a source control system (if applicable), and uninstall the older version of IBM Cognos BI. For complete instructions, see the steps to install in the same directory.
If you are installing on a new computer, see the steps to install in a new directory.

When you back up the configuration data, you store it in a secure directory. The directory must be protected from unauthorized or inappropriate access.

An alternative method of upgrading includes exporting the entire content store to a deployment archive and then importing the deployment archive into IBM Cognos BI after the upgrade. For more information about deployment, see the Administration and Security Guide. A deployment upgrade is required if you want to change the type of database that you use for the content store. If you use the deployment upgrade method, only the steps for exporting and restoring the configuration data are different. All other steps are the same as documented in this section.

IBM Cognos BI installs and uses Tomcat as its application server by default. If you do not want to use Tomcat, you must follow a different set of steps to upgrade. For more information, see "Upgrade to IBM Cognos Business Intelligence in an Application Server Environment" on page 463.

After the IBM Cognos BI content is upgraded, the report administrator will no longer have access to the Content Administration tool and will not be able to create deployment definitions.

**Customized IBM Cognos BI Files**

If you manually edited any configuration files, the changes will be overwritten during the upgrade. You must reapply the changes. You should keep a record of any customizations to ensure that they can be reapplied after upgrading. You should also back up these files so that the original version can be restored if necessary.

You may have modified files other than those in the configuration folder. Back up the entire installation directory.

The IBM Cognos BI presentation service supports automatic upgrade of some system.xml files. If you made many customization changes to system.xml files, you can use this automatic upgrade feature instead of reapplying the changes manually after upgrading. The system.xml files are overwritten during the installation of IBM Cognos BI. Therefore, you must back up the customized versions of these files and then copy them to the directory after upgrading IBM Cognos BI. The automatic upgrade will be applied when you start the IBM Cognos service.

The system.xml files for which automatic upgrade is supported are in the following directories:

- `c10_location/templates/ps`  
- `c10_location/templates/ps/portal`  
- `c10_location/templates/ps/qs`

**Note:** To upgrade customized files, manually reapply changes after the new software is installed. Automatic upgrade of system.xml files is to be used only when you have made a large number of customizations to these files.

When you complete the upgrade tasks, IBM Cognos BI is fully configured except for new properties and features.
If you use Chinese, Japanese, or Korean characters, you may notice differences in some characters after upgrading from IBM ReportNet to IBM Cognos BI. For more information, see the Troubleshooting section of the Administration and Security Guide.

If you use a DB2 database for the content store, you can tune the database to take advantage of DB2 features. For more information, see the Architecture and Deployment Guide.

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

**Install in the Same Directory**

If you have finished testing your applications and want to upgrade the software in your production environment, you can install in the same directory after uninstalling the earlier version.

**Procedure**

1. Using your database tools, back up your existing content store database.
   For information on how to do this, see the documentation for your database.
2. Back up the following files to a secure location:
   - cogstartup.xml and coglocale.xml in the `c8_location/configuration` directory
   - server.xml in the `c8_location/tomcat4.1.27/conf` directory
   - system.xml in the appropriate directory, if required
   Ensure that you note the original directory path for each backed up file. For example,
   `c8_location/templates/ps`
3. In IBM Cognos Configuration, export the configuration data to the same secure location.
   To make the configuration data usable for upgrading, name the file cogstartup.xml.
   **Important**: Because the exported crnstartup.xml file (ReportNet) or cogstartup.xml file (IBM Cognos BI) contains unencrypted passwords, ensure that the location is secure.
4. Back up any manually edited files in the `c8_location/configuration` and other directories to a secure location.
5. If your earlier version of the product included IBM Cognos Go! Search, back up the card.xml file from the `c8_location/bin/card` directory.
   Some versions of IBM Cognos Go! Search included a csnconfig.xml file. If you refined your index in a previous version of Go! Search, you will find equivalent functionality in IBM Cognos Administration. Take note of any custom settings in the csnconfig.xml file.
6. If you use a source control system such as Concurrent Versions System (CVS), ensure that all Framework Manager models are backed up and checked in before upgrading.
7. Stop all IBM Cognos services and any Web servers hosting IBM Cognos BI content.
8. Prepare Transformer models, if required (see “Prepare Models in IBM Cognos Series 7 Transformer” on page 120).
9. Upgrade or install other products (see “Install or Upgrade Other Products” on page 98).
10. Uninstall IBM Cognos BI from every IBM Cognos BI computer (see Chapter 20, “Uninstalling IBM Cognos BI,” on page 497).

11. Install the newer version of IBM Cognos BI in the same directory that you used for IBM Cognos BI on every computer (see “Install IBM Cognos BI Server Components” on page 124).

12. If your earlier version of the product included IBM Cognos Go! Search, copy the card.xml file from the backup location of your older version to the c10_location/bin/card directory.
   If prompted to overwrite an existing file, click Yes.

13. For files that were manually edited in earlier versions of IBM Cognos BI, edit the same files in the c10_location directory and reapply the changes that were made to the original customized files.
   Do not copy the customized files from the backup location to the c10_location directories. The earlier versions of these files may not be compatible.

14. If you use Oracle for a notification database, logging database, or the content store database, ensure that you have copied the correct library file for your version of the Oracle client to the c10_location\webapps\p2pd\WEB-INF\lib directory.
   If you are using Oracle 10g, you must have ojdbc14.jar.
   If you are using Oracle 11g, you must have ojdbc5.jar.

15. If you use a DB2 content store on a System z operating system, edit and run the script to upgrade the DB2 Content Store.
   You must have permission to create tablespace to run the script.
   The script creates new tablespace and grants Content Manager rights to use the tablespace.

16. In IBM Cognos Configuration, review the configuration, and then save it.
   When you save the configuration, an upgrade dialog box appears and asks if you want to upgrade your report specifications. The default setting is to not upgrade report specifications.

   **Important:** Do not upgrade your report specifications if you have Software Development Kit applications that create, modify, or save report specifications. You must first update your Software Development Kit applications to comply with the IBM Cognos BI report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications. In addition, do not save your reports until the Software Development Kit applications have been updated. For information about upgrading report specifications, see the IBM Cognos BI Software Development Kit Developer Guide.

17. Start IBM Cognos BI.
   IBM Cognos BI automatically upgrades the content store. System.xml files are upgraded, if required, to an IBM Cognos BI compatible version.

18. Install and configure Framework Manager (see “Installing and Configuring IBM Cognos Framework Manager” on page 227).

19. Upgrade your Framework Manager projects and reports as required. For instructions, see the Framework Manager User Guide.
   Report Studio users must clear their Web browser cache to get the latest images.

20. Install and configure Transformer, if required (see “Install IBM Cognos Transformer” on page 246 and “Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components” on page 249).
21. Upgrade Transformer models and PowerCubes (see "Upgrading Transformer Models and PowerCubes" on page 118), if required.

22. If you use SAP Enterprise Portal, upgrade your master iView.

   Old SAP iViews will not work with the new Portal Services producer component. For information, see the topic about deploying Cognos Portlets to SAP Enterprise Portal in the Administration and Security Guide.

23. If your earlier version included Go! Search and included the csnconfig.xml file, recreate the settings in IBM Cognos Administration.

   For more information, see the Administration and Security Guide.

Install in a New Directory

If you are setting up your test environment, you install in a new directory.

Procedure

1. Using your database tools, copy your existing content store database into a new content store database.

   For information on how to do this, see the documentation for your database.

2. Back up the following files to a secure location:
   
   • coglocale.xml in the $c8_location/configuration directory
   
   • server.xml in the $c8_location/tomcat4.1.27/conf directory
   
   • system.xml in the appropriate directory, if required
   
   Ensure that you note the original directory path of the backed up files. For example,

   $c8_location/templates/ps

   • any manually edited files in the $c8_location/configuration and other directories
   
   • the card.xml file from the $c8_location/bin/card directory, if your earlier version of the product included IBM Cognos Go! Search

   Some versions of IBM Cognos Go! Search included a csnconfig.xml file. If you refined your index in a previous version of Go! Search, you will find equivalent functionality in IBM Cognos Administration. Take note of any custom settings in the csnconfig.xml file.

3. In IBM Cognos Configuration, export the configuration data to the same secure location.

   To make the configuration data usable for upgrading, name the file cogstartup.xml.

   Important: Because the exported cogstartup.xml file contains unencrypted passwords, ensure that the location is secure.

4. Prepare Transformer models, if required (see "Prepare Models in IBM Cognos Series 7 Transformer" on page 120).

5. Upgrade or install other products (see "Install or Upgrade Other Products" on page 98).

6. Install IBM Cognos BI in a new directory (see Chapter 8, "Installing IBM Cognos BI Server Components on Different Computers," on page 165).

7. Copy the .xml files from the secure backup location to the following directory:

   • Copy cogstartup.xml and coglocale.xml to $c10_location/configuration.
   
   • Copy server.xml to $c10_location/tomcat4.1.27/conf.
   
   • Copy system.xml to the same directory in the new location as it was in the earlier version, if required.
For example,

c10_location/templates/ps

- If your earlier version of the product included IBM Cognos Go! Search, copy the card.xml file from the backup location of your older version to the c10_location/bin/card directory.

If you are prompted to overwrite existing files, click Yes.

8. For files that were manually edited, edit the same files in the c10_location directory and reapply the changes that were made to the original customized files.

   Do not copy the customized files from the backup location to the c10_location directories. The earlier versions of these files may not be compatible with the new version of IBM Cognos BI.

9. Configure new Web server aliases (see “Configure the Web Server” on page 151).

10. If you use a DB2 content store on a System z operating system, edit and run the script to upgrade the DB2 Content Store.

   You must have permission to create tablespaces to run the script.

   The script creates new tablespaces and grants Content Manager rights to use the tablespaces.

11. In IBM Cognos Configuration, configure IBM Cognos BI to point to the new content store, configure new ports and URLs, use a different cookie path, and then save the configuration (see “Run Multiple Versions or Instances of IBM Cognos BI at the Same Time” on page 114).

   Ensure that the port numbers and service name for this installation are different from those used for earlier versions so that there are no conflicts.

   Ensure that security authentication settings are not changed. For example, the namespaces must be the same for policies, users, roles, and groups to work correctly.

   When you save the configuration, an upgrade dialog box appears and asks if you want to upgrade your report specifications. The default setting is to not upgrade report specifications.

   **Important:** Do not upgrade your report specifications if you have Software Development Kit applications that create, modify, or save report specifications. You must first update your Software Development Kit applications to comply with the IBM Cognos BI report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications. In addition, do not save your reports until the Software Development Kit applications have been updated. For information about upgrading report specifications, see the IBM Cognos BI Software Development Kit Developer Guide.

12. Start IBM Cognos BI.

   IBM Cognos BI automatically upgrades the new content store. System.xml files are upgraded, if required, to an IBM Cognos BI compatible version.

13. Install and configure Framework Manager (see “Installing and Configuring IBM Cognos Framework Manager” on page 227).

14. Upgrade your Framework Manager projects and reports as required. For instructions, see the Framework Manager User Guide.

   Report Studio users must clear their Web browser cache to get the latest images.
15. Open the Administration portal, and unregister the dispatchers that are used with earlier versions of IBM Cognos BI.
   When you open the Administration portal in IBM Cognos BI, you may see the dispatchers that are registered for both versions.
   For more information, see the Administration and Security Guide.

16. Install and configure Transformer, if required (see “Install IBM Cognos Transformer” on page 246 and “Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components” on page 249).

17. Upgrade Transformer models and PowerCubes, if required (see “Upgrading Transformer Models and PowerCubes” on page 118).

18. If you use SAP Enterprise Portal, upgrade your master iView.
   Old SAP iViews will not work with the new Portal Services producer component. For information, see the topic about deploying Cognos Portlets to SAP Enterprise Portal in the Administration and Security Guide.

19. If your earlier version included Go! Search and included the csnconfig.xml file, recreate the settings in IBM Cognos Administration.
   For more information, see the Administration and Security Guide.

20. When you are ready to uninstall the previous version of IBM Cognos BI, do the following:
   • Stop the IBM Cognos service and any Web servers hosting IBM Cognos BI content.
   • Uninstall IBM Cognos BI from all computers.
   For instructions, see Chapter 20, “Uninstalling IBM Cognos BI,” on page 497.

Upgrading a DB2 Content Store on a System z Operating System

If you use a DB2 content store on a System z operating system, you must run a script that creates new tablespaces and grants Content Manager rights to use the tablespaces before you save the configuration for the upgraded IBM Cognos BI product.

Before you begin

You must have permission to create tablespaces to run the script. You must run the script after you install the new version of IBM Cognos BI and before you save the configuration for the new version.

Procedure

1. Go to the c10_location/configuration/schemas/content/db2zOS directory and open tablespaceUpgrade_db2zOS.sql in a text editor.
2. Follow the instructions in the script file to replace the placeholder values in the file with the values for your DB2 database.
   For the placeholders listed in the following table, ensure that you use the same values when you configure the connection to the content store in IBM Cognos Configuration:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Property in IBM Cognos Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSCRIPT_DATABASE</td>
<td>Resource name that appears under Data Access &gt; Content Manager in the Explorer window</td>
</tr>
</tbody>
</table>
3. Save and run the file.

**Results**

You can now continue the upgrade process by opening IBM Cognos Configuration to configure properties and start the IBM Cognos service.

**Upgrading Dashboards in IBM Cognos Business Insight**

In IBM Cognos BI, Version 10.1.0, IBM Cognos Go! Dashboard is integrated into a new report consumption experience, IBM Cognos Business Insight. To upgrade dashboards that were created in Go! Dashboard, you simply open the dashboards in Business Insight. All of the content is maintained, however some interactions and layout customizations might be lost or changed.

**Enabling Chart Animation in Business Insight**

By default, chart animation is not enabled in Business Insight. If your workspaces from IBM Cognos Go! Dashboard include charts with animation, you must add an advanced property in IBM Cognos Configuration to enable the chart animation.

For more information, see the IBM Cognos Business Insight *User Guide*.

**Before you begin**

Ensure that you have performed all of the tasks to upgrade to the new version of IBM Cognos BI server. For more information, see "Upgrade from an Earlier Version of IBM Cognos BI" on page 91. You must export the entire content store when deploying the old content store to the new content store.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, click **Local Configuration**.
3. In the **Properties** window, click in the **Value** column for **Advanced properties**, and then click the edit button in the Properties window.
4. In the **Value - Advanced properties** dialog box, click **Add**.
5. In the **Name** column, type the following:
   - **GoDBCompatMode**
6. In the **Value** column, type the following:
   - **true**
7. Click **OK**.
8. From the **File** menu, click **Save**.
9. From the **Actions** menu, click **Restart**.

**Install or Upgrade Other Products**

When you upgrade IBM Cognos BI, you may need to upgrade to new versions of other products, update some components of other products, or install additional other products to support new features in IBM Cognos BI.
To view a list of other products that are used by IBM Cognos BI, see “Verify System Requirements” on page 58.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Service Center [http://www.ibm.com/software/data/support/cognos_crc.html].

Procedure

If you do not have the supported version of a required product, install or upgrade the product.

Instructions are provided in this guide for these required other products:

- setting up a database client
- updating the Java environment
- configuring a Web server
- configuring a Web browser
- changing the version of Java Runtime Environment used in IBM Cognos BI

For instructions to install or upgrade other products, see the instructions provided with each product.

Upgrading Using the Silent Configuration Option

You can run a silent configuration to upgrade the configuration from ReportNet to IBM Cognos BI. Before you run the silent configuration, you must ensure that the option to upgrade the report specifications is set correctly. If you installed IBM Cognos BI in a new directory, you must also change the settings for ports and the Web server alias.

If you want to upgrade the configuration in silent mode, follow the steps in the preceding section and stop at the step to configure IBM Cognos BI:

- In the steps to install in the same directory, stop after step 12.
- In the steps to install in a new directory, stop after step 9.

When you reach that step, do not start IBM Cognos Configuration. Instead, perform the following steps and then return to the steps in the preceding section.

- Edit the crnstartup.xml file in crn_location/configuration (same directory) or c8_location/configuration (new directory) and look for the following lines:

```
<crn:parameter
  name="doReportSpecUpgrade">
  <crn:value xsi:type="xsd:boolean">false</crn:value>
</crn:parameter>
```

- Set the value for the report specification upgrade:
  - To skip the upgrade of the report specifications, leave the value as false.
  - To upgrade the report specifications, change the value to true.

- Modify other settings as required.

  If you installed IBM Cognos BI in a new directory, see “Run Multiple Versions or Instances of IBM Cognos BI at the Same Time” on page 114 for the settings to modify.

- In the location where you installed the new version of IBM Cognos BI, type the configuration command:
  - On UNIX or Linux operating systems, type
Migrate Apache Derby Databases to Cognos Content Database

If you use your own installation of Apache Derby for the content store or notification databases in IBM Cognos BI, Version 8.1, you must migrate the databases to Cognos Content Database before starting IBM Cognos BI. To do this, remove the CognosCMDerby.jar file from the Apache Derby database and copy the database directories to the content store directory of the IBM Cognos BI installation.

Procedure

1. Ensure that your Apache Derby Network Server is running.
2. Start the ij utility using the ij.bat or ij.ksh script file.
3. Connect to the Apache Derby database by typing the following ij utility command:
   ```
   connect 'jdbc:derby://host:port/db_name;user=username
   ;password=password';
   ```
   Here is an example:
   ```
   connect 'jdbc:derby://localhost:1527/cm;user=cognos; password=cognos';
   ```
   If you changed the port number from the default 1527, use the correct port number for your Apache Derby database. Use the correct name of your Apache Derby database.
4. Clear the derby.database.classpath property of the database by typing the following ij utility command:
   ```
   CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.database.classpath','');
   ```
5. Remove the existing jar file by typing the following ij utility command:
   ```
   CALL sqlj.remove_jar('schema_name.CMFunctionsjar', 0);
   ```
   For example, if your schema is cognos, type
   ```
   CALL sqlj.remove_jar('cognos.CMFunctionsjar', 0);
   ```
6. Enable row level locking on the database by typing the following ij utility command:
   ```
   CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.storage.rowLocking','true');
   ```
7. Close the ij utility by typing the following command:
   ```
   disconnect;
   ```
8. Stop the Apache Derby Network Server.
9. Copy the content store and notification database directories to the contentstore directory.
   ```
   For example:
   xcopy "c:\derby\data\cm" "c:\Program Files\c8\contentstore\cm" /s /i
   xcopy "c:\derby\data\notify_db" "c:\Program Files\c10\contentstore\notify_db" /s /i
   ```
   In this example, the content store database is named cm and the notification database is named notify_db. They are located in the c:\derby\data directory.
New Product, File, and Directory Names After Upgrade from ReportNet

After you upgrade from ReportNet, the product name will be changed to IBM Cognos BI. In addition, some file, directory, and command names will be different. If you install IBM Cognos BI in a different directory from ReportNet, default directory names change when you install IBM Cognos BI. If you install IBM Cognos BI in the same directory as ReportNet, the existing directory names do not change. Some file name changes occur when you install IBM Cognos BI and other changes occur after you save the IBM Cognos BI configuration. You must change the alias for the virtual directory manually, if required.

The names listed in the following table are affected.

<table>
<thead>
<tr>
<th>ReportNet name</th>
<th>IBM Cognos BI name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>crn</td>
<td>c10</td>
<td>Default installation directory (32-bit)</td>
</tr>
<tr>
<td></td>
<td>c10_64</td>
<td>Default installation directory (64-bit)</td>
</tr>
<tr>
<td>crn</td>
<td>ibmcognos</td>
<td>Default Web browser alias or virtual directory</td>
</tr>
<tr>
<td>crnstartup.xml</td>
<td>cogstartup.xml</td>
<td>Configuration data file used when starting IBM Cognos Configuration</td>
</tr>
<tr>
<td>crnstartup_</td>
<td>cogstartup_</td>
<td>Configuration data file that stores choices made each time the configuration is saved</td>
</tr>
<tr>
<td>yyyyymmddhhmm.xml</td>
<td>yyyyymmddhhmm.xml</td>
<td></td>
</tr>
<tr>
<td>crnlocale.xml</td>
<td>coglocale.xml</td>
<td>Configuration data file that stores codes for global configuration settings</td>
</tr>
<tr>
<td></td>
<td>coglocale_</td>
<td>Configuration data file that stores choices made each time global configuration settings are saved</td>
</tr>
<tr>
<td>yyyyymmddhhmm.xml</td>
<td>yyyyymmddhhmm.xml</td>
<td></td>
</tr>
<tr>
<td>crnformat.xml</td>
<td>cogformat.xml</td>
<td>Configuration data file that stores formats for numeric data, dates, and times</td>
</tr>
<tr>
<td>crnserver.log</td>
<td>cogserver.log</td>
<td>Default logging file</td>
</tr>
<tr>
<td>crconfigw.exe</td>
<td>cogconfigw.exe</td>
<td>File to start IBM Cognos Configuration on Microsoft Windows operating system</td>
</tr>
<tr>
<td>crconfig.bat</td>
<td>cogconfig.bat</td>
<td>File to start IBM Cognos Configuration in silent mode on Windows</td>
</tr>
<tr>
<td>crconfig.sh</td>
<td>cogconfig.sh</td>
<td>File to start IBM Cognos Configuration on UNIX and Linux operating systems</td>
</tr>
<tr>
<td>crconfig.prefs</td>
<td>cogconfig.prefs</td>
<td>Configuration data file that stores user preferences for IBM Cognos Configuration</td>
</tr>
<tr>
<td>crconfig_response.csv</td>
<td>cogconfig_response.csv</td>
<td>Silent mode log file that stores activities performed while IBM Cognos Configuration runs in silent mode</td>
</tr>
<tr>
<td>ReportNet name</td>
<td>IBM Cognos BI name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>xstartup</td>
<td>isetup</td>
<td>Command to start the installation wizard on XWindows</td>
</tr>
<tr>
<td>xwsetup</td>
<td>isetup</td>
<td>Command to start the installation wizard on UNIX and Linux</td>
</tr>
<tr>
<td>xwsetup.exe</td>
<td>isetup.exe</td>
<td>File to start the installation wizard on Windows</td>
</tr>
<tr>
<td>ReportNetService_</td>
<td>CognosService_</td>
<td>Sample file for medium or large</td>
</tr>
<tr>
<td>languagecode.xml</td>
<td>languagecode.xml</td>
<td>configuration</td>
</tr>
</tbody>
</table>

**Upgrade ReportNet to IBM Cognos BI**

You can upgrade IBM Cognos BI in the same directory as an earlier version or in a different directory, depending on where you are in the process. For example, if you are setting up your test environment, you install in a new directory. If you have finished testing your applications and want to upgrade the software in your production environment, you can install in the same directory.

If you want to upgrade to IBM Cognos BI in the same directory, you must first back up your data, ensure that Framework Manager models are backed up and checked into a source control system (if applicable), and uninstall ReportNet. For complete instructions, see the steps to install in the same directory.

If you want to install IBM Cognos BI in a new directory, you can keep ReportNet active until you are satisfied with the operation of the new version. If you are installing on a new computer, see the steps to install in a new directory.

When you back up the configuration data, you store it in a secure directory. The directory must be protected from unauthorized or inappropriate access.

An alternative method of upgrading includes exporting the entire content store to a deployment archive in ReportNet and then importing the deployment archive into IBM Cognos BI. For more information about deployment, see the Administration and Security Guide. A deployment upgrade is required if you want to change the type of database that you use for the content store. If you use the deployment upgrade method, only the steps for exporting and restoring the configuration data are different. All other steps are the same as documented in this section.

IBM Cognos BI installs and uses Tomcat as its application server by default. If you upgrade from ReportNet and you do not want to use Tomcat, you must follow a different set of steps to upgrade. For more information, see "Upgrade to IBM Cognos Business Intelligence in an Application Server Environment" on page 463.

After the ReportNet 1.1 content is upgraded, the report administrator will no longer have access to the Content Administration tool and will not be able to create deployment definitions.

If you are upgrading from ReportNet 1.1 MR3 or MR4, you can use Lifecycle Manager to automate some tasks in the trial upgrade stage.
Published IBM Cognos Series 7 PowerCubes in ReportNet

If you published cubes from IBM Cognos Series 7 PowerPlay Enterprise Server in ReportNet, you may not be able to publish those same cubes in IBM Cognos BI. The default cookie path that was used in ReportNet is changed in IBM Cognos BI. To enable publishing of your IBM Cognos Series 7 PowerCubes in IBM Cognos BI, see “Set Up to Publish IBM Cognos Series 7 PowerCubes After Upgrade from ReportNet” on page 108.

Customized ReportNet Files

If you manually edited any configuration files, the changes will be overwritten during the upgrade. You must reapply the changes in the IBM Cognos BI environment. You should keep a record of any customizations to ensure that they can be reapplied after upgrading. You should also back up these files so that the original version can be restored if necessary.

You may have modified files other than those in the configuration folder. Back up the entire installation directory.

The IBM Cognos BI presentation service supports automatic upgrade of some ReportNet system.xml files. If you made many customization changes to system.xml files in ReportNet, you can use this automatic upgrade feature instead of reapplying the changes manually after upgrading. The system.xml files are overwritten during the installation of IBM Cognos BI. Therefore, you must back up the ReportNet versions of these files and then copy them to the directory after installing IBM Cognos BI. The automatic upgrade will be applied when you start the IBM Cognos service.

The system.xml files for which automatic upgrade is supported are in the following directories:

- crn_location/templates/ps
- crn_location/templates/ps/portal
- crn_location/templates/ps/qs

Note: To upgrade customized files, manually reapply changes after the new software is installed. Automatic upgrade of system.xml files is to be used only when you have made a large number of customizations to these files.

When you complete the upgrade tasks, IBM Cognos BI is fully configured except for new properties and features.

If you use Chinese, Japanese, or Korean characters, you may notice differences in some characters after upgrading to IBM Cognos BI. For more information, see the Troubleshooting section of the Administration and Security Guide.

If you use a DB2 database for the content store, you can tune the database to take advantage of DB2 features. For more information, see the Architecture and Deployment Guide.

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.
Install in the Same Directory when Upgrading from ReportNet

If you have finished testing your applications and want to upgrade the software in your production environment, you can install in the same directory after uninstalling the earlier version.

Procedure

1. Using your database tools, back up your existing content store database. For information on how to do this, see the documentation for your database.

2. Back up the following files to a secure location:
   - crnstartup.xml and crnlocale.xml in the crn_location/configuration directory
   - server.xml in the crn_location/tomcat4.1.27/conf directory
   - system.xml in the appropriate directory, if required

   Ensure that you note the original directory path for each backed up file. For example, crn_location/templates/ps

3. In IBM Cognos Configuration, export the configuration data to the same secure location.
   To make the configuration data usable for upgrading, name the file crnstartup.xml.

   **Important:** Because the exported crnstartup.xml file contains unencrypted passwords, ensure that the location is secure.

4. Back up any manually edited files in the crn_location/configuration and other directories to a secure location.

5. If you use a source control system such as Concurrent Versions System (CVS), ensure that all Framework Manager models are backed up and checked in before upgrading.

6. Stop all IBM Cognos services and any Web servers hosting ReportNet content.

7. Prepare Transformer models, if required (see “Prepare Models in IBM Cognos Series 7 Transformer” on page 120).

8. Upgrade or install other products (see “Install or Upgrade Other Products” on page 98).

   For instructions, see the documentation for the older version of ReportNet.

10. Install IBM Cognos BI in the same directory that you used for ReportNet on every computer (see “Install IBM Cognos BI Server Components” on page 124).

11. For files that were manually edited in ReportNet, edit the same files in the crn_location directory and reapply the changes that were made to the original customized files.
   Do not copy the customized files from the backup location to the crn_location directories. The earlier versions of these files may not be compatible with IBM Cognos BI.

12. If you use Oracle for a notification database, logging database, or the content store database, ensure that you have copied the correct library file for your version of the Oracle client to the c10_location\webapps\p2pd\WEB-INF\lib directory.
   - If you are using Oracle 10g, you must have ojdbc14.jar.
   - If you are using Oracle 11g, you must have ojdbc5.jar.

13. In IBM Cognos Configuration, review the configuration, and then save it.
When you save the configuration, an upgrade dialog box appears and asks if you want to upgrade your report specifications. The default setting is to not upgrade report specifications.

**Important:** Do not upgrade your report specifications if you have Software Development Kit applications that create, modify, or save report specifications. You must first update your Software Development Kit applications to comply with the IBM Cognos BI report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications. In addition, do not save your reports until the Software Development Kit applications have been updated. For information about upgrading report specifications, see the IBM Cognos BI Software Development Kit *Developer Guide*.

14. Start IBM Cognos BI.

IBM Cognos BI automatically upgrades the content store. System.xml files are upgraded, if required, to an IBM Cognos BI compatible version.

If the ReportNet service continues to run, manually uninstall the ReportNet service (see “Manually Uninstall the ReportNet Service on Windows” on page 109).

15. Install and configure Framework Manager (see “Installing and Configuring IBM Cognos Framework Manager” on page 227).

16. Upgrade your Framework Manager projects and reports as required. For instructions, see the Framework Manager *User Guide*. Report Studio users must clear their Web browser cache to get the latest images.

17. If you use pages created in ReportNet, you may need to reconfigure the following properties:
   - Title
   - Open links
   For more information, see the *Administration and Security Guide*.

18. If you published IBM Cognos Series 7 PowerCubes in ReportNet, restructure your virtual directories or change your cookie path (see “Set Up to Publish IBM Cognos Series 7 PowerCubes After Upgrade from ReportNet” on page 108).

19. Install and configure Transformer, if required (see “Install IBM Cognos Transformer” on page 246 and “Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components” on page 249).

20. Upgrade Transformer models and PowerCubes, if required see “Upgrading Transformer Models and PowerCubes” on page 249.

21. If you use SAP Enterprise Portal, upgrade your master iView.

   Old SAP iViews will not work with the new Portal Services producer component. For information, see the topic about deploying Cognos Portlets to SAP Enterprise Portal in the *Administration and Security Guide*.

**Install in a New Directory when Upgrading from ReportNet**

If you are setting up your test environment, you install in a new directory.

**Procedure**

1. Using your database tools, copy your existing content store database into a new content store database.

   For information on how to do this, see the documentation for your database.

2. Back up the following files to a secure location:
• crnlocale.xml in the crn_location/configuration directory
• server.xml in the crn_location/tomcat4.1.27/conf directory
• system.xml in the appropriate directory, if required
  Ensure that you note the original directory path for each backed up file. For example,
  crn_location/templates/ps
• any manually edited files in the crn_location/configuration and other directories.

3. In IBM Cognos Configuration, export the configuration data to the same
secure location.
To make the configuration data usable for upgrading, name the file
crnstartup.xml.

Important: Because the exported crnstartup.xml file contains unencrypted
passwords, ensure that the location is secure.

4. Prepare Transformer models, if required (see “Prepare Models in IBM Cognos
Series 7 Transformer” on page 120).

5. Upgrade or install other products (see “Install or Upgrade Other Products” on
page 98).

6. Install IBM Cognos BI in a new directory (see Chapter 8, “Installing IBM
Cognos BI Server Components on Different Computers,” on page 165).

7. Copy the .xml files from the secure backup location to the following directory:
• Copy crnstartup.xml and crnlocale.xml to c10_location/configuration.
• Copy server.xml to c10_location/tomcat4.1.27/conf.
• Copy system.xml to the same directory in the new location as it was in the
  ReportNet location, if required.
  For example,
  c10_location/templates/ps
If you are prompted to overwrite existing files, click Yes.

8. For files that were manually edited in ReportNet, edit the same files in the
c10_location directory and reapply the changes that were made to the original
customized files.
Do not copy the customized files from the backup location to the c10_location
directories. The earlier versions of these files may not be compatible with IBM
Cognos BI.

9. Configure new Web server aliases (see “Configure the Web Server” on page
151).

10. In IBM Cognos Configuration, do the following:
• For the new IBM Cognos BI instance, configure IBM Cognos BI to point to
  the new content store, configure new ports and URLs, and then save the
  configuration (see “Run Multiple Versions or Instances of IBM Cognos BI at
  the Same Time” on page 114).
• For ReportNet, configure ReportNet to use a new default cookie path (see
  “Configuring ReportNet or the older instance of IBM Cognos Business
  Intelligence” on page 115).

Ensure that the port numbers and service name for this installation are
different from those used for earlier versions so that there are no conflicts.
Ensure that security authentication settings are not changed. For example, the
namespaces must be the same for policies, users, roles, and groups to work
correctly.
When you save the configuration, an upgrade dialog box appears and asks if you want to upgrade your report specifications. The default setting is to not upgrade report specifications.

**Important:** Do not upgrade your report specifications if you have Software Development Kit applications that create, modify, or save report specifications. You must first update your Software Development Kit applications to comply with the IBM Cognos BI report specifications schema. Otherwise, your Software Development Kit applications may not be able to access the upgraded report specifications. In addition, do not save your reports until the Software Development Kit applications have been updated. For information about upgrading report specifications, see the IBM Cognos BI Software Development Kit Developer Guide.

11. **Start IBM Cognos BI.**
   IBM Cognos BI automatically upgrades the new content store. System.xml files are upgraded, if required, to an IBM Cognos BI compatible version.

12. **Install and configure Framework Manager** (see “Installing and Configuring IBM Cognos Framework Manager” on page 227).

13. **Upgrade your Framework Manager projects and reports as required.** For instructions, see the Framework Manager User Guide. Report Studio users must clear their Web browser cache to get the latest images.

14. **Open the Administration portal in IBM Cognos BI, and unregister the dispatchers that are used with ReportNet.**
   When you open the Administration portal in IBM Cognos BI, the portal shows the dispatchers that are registered for both versions.
   For more information, see the Administration and Security Guide.

15. **If you use pages created in ReportNet, you may need to reconfigure the following properties:**
   - Title
   - Open action links going outside a portal
   For more information, see the Administration and Security Guide.

16. **If you published IBM Cognos Series 7 PowerCubes in ReportNet, restructure your virtual directories or change your cookie path** (see “Set Up to Publish IBM Cognos Series 7 PowerCubes After Upgrade from ReportNet” on page 108).

17. **Install and configure Transformer, if required** (see “Install IBM Cognos Transformer” on page 246 and “Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components” on page 249).

18. **Upgrade Transformer models and PowerCubes, if required** (see “Upgrading Transformer Models and PowerCubes” on page 118).

19. **If you use SAP Enterprise Portal, upgrade your master iView.**
   Older versions of SAP iViews may not work with the new Portal Services producer component. For information, see the topic about deploying Cognos Portlets to SAP Enterprise Portal in the Administration and Security Guide.

20. **When you are ready to uninstall ReportNet, do the following:**
   For instructions, see the documentation for the older version of ReportNet.
Set Up to Publish IBM Cognos Series 7 PowerCubes After Upgrade from ReportNet

After you upgrade from IBM Cognos ReportNet to IBM Cognos BI, you may not be able to publish cubes from PowerPlay Enterprise Server to IBM Cognos Connection. Similarly, if a user opens a cube from IBM Cognos Connection that was published from PowerPlay Enterprise Server, they may receive the following error when they save the report to IBM Cognos Connection:

*Your session ticket is invalid. It may have expired.*

To enable publishing of IBM Cognos Series 7 PowerCubes after upgrading, you can either restructure your virtual directories so that the IBM Cognos Series 7 and IBM Cognos BI gateways are within the same structure or change the default cookie path in IBM Cognos BI to the value specified below. If you use the specified cookie path value, you cannot run ReportNet and IBM Cognos BI on the same computer.

**Restructure Virtual Directories**
To enable publishing of IBM Cognos Series 7 PowerCubes after upgrading, you can restructure your virtual directories so that the IBM Cognos Series 7 and IBM Cognos BI gateways are within the same structure.

**Procedure**
1. Create an alias called `ibmcognos` that points to the `c10_location\webcontent` directory.
2. Create an alias called `ibmcognos/cgi-bin` that points to the `c10_location\cgi-bin` directory.
3. Create an alias called `ibmcognos/series7` that points to the `series7_location\webcontent` directory.
4. Create an alias called `ibmcognos/series7/cgi-bin` that points to the `series7_location\cgi-bin` directory.
5. Create an alias called `ibmcognos/series7/help` that points to the `series7_location\Documentation` directory.

**Change the Default Cookie Path**
To enable publishing of IBM Cognos Series 7 PowerCubes after upgrading, you can change the default cookie path in IBM Cognos BI to the value specified below. If you use the specified cookie path value, you cannot run ReportNet and IBM Cognos BI on the same computer.

**Procedure**
1. Start IBM Cognos Configuration.
2. Click Actions > Edit Global Configuration, and click the General tab.
3. In the Path box under Cookie Setting, type `/`
4. Click OK.
5. Save the configuration.

**Note:** If you change the cookie path to the specified value, you cannot run ReportNet and IBM Cognos BI on the same computer. If you intend to run ReportNet and IBM Cognos BI on the same computer, correct this problem by changing your virtual directories.
Manually Uninstall the ReportNet Service on Windows

On Microsoft Windows operating system, if the ReportNet service continues to run after you uninstalled ReportNet and then installed IBM Cognos BI, you must manually uninstall the ReportNet service.

You can install more than one version of IBM Cognos BI in different locations on the same computer. If the versions use the same ports, the installation may not upgrade the service correctly. IBM Cognos Configuration upgrades to the most recently configured service for IBM Cognos BI.

Tip: To see if the correct IBM Cognos service is running, check the version number in the About window in IBM Cognos Configuration.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer panel, under Environment > ReportNet Service, right-click Cognos ReportNet (or other name that has been given to the service) and select Stop.
3. Open a Command Prompt window.
4. Go to the crn_location/bin directory.
5. Uninstall the service:
   - If you used the default name for the service, type cogbootstrapservice -u
   - If you specified another name, type cogbootstrapservice -u -name="service_name"
6. Close the Command Prompt window.
7. Restart IBM Cognos Configuration.

Results

IBM Cognos BI upgrades to the correct service.

Upgrade Metrics Manager to IBM Cognos BI

You must install and upgrade to IBM Cognos BI in a different directory from the earlier version of Metrics Manager. You can keep Metrics Manager active until you are satisfied with the operation of IBM Cognos BI.

If Metrics Manager is on the same computer as ReportNet or IBM Cognos BI, upgrade ReportNet or IBM Cognos BI first, and then upgrade Metrics Manager.

IBM Cognos BI and earlier versions of Metrics Manager use different security models. If you want to upgrade the security information for the earlier version of Metrics Manager, you must follow a different set of steps to upgrade. For more information, see "Upgrade Metrics Manager and Security Information" on page 110.

IBM Cognos BI installs and uses Tomcat as its application server by default. If you upgrade from Metrics Manager and you do not want to use Tomcat, you must follow a different procedure to upgrade. For more information, see "Upgrade from Metrics Manager to IBM Cognos Business Intelligence in an Application Server Environment" on page 464.
Procedure

1. Export the contents of any metric store that you want to use with IBM Cognos BI from the earlier version of Metrics Manager.
   For more information, see the documentation provided with your earlier version of Metrics Manager.

2. Install IBM Cognos BI:
   - If you are upgrading only Metrics Manager, install IBM Cognos BI in a different directory from the earlier version of Metrics Manager (see Chapter 8, "Installing IBM Cognos BI Server Components on Different Computers," on page 165).
   - If ReportNet is on the same computer as Metrics Manager, follow the steps to upgrade ReportNet to IBM Cognos BI (see "Upgrade ReportNet to IBM Cognos BI" on page 102).

3. Set up the environment (see Chapter 5, "Preparing to Install," on page 57).
   If you exported the contents of one or more data stores in step 1, create one metric store database for the contents of each data store (see "Create the Metric Store Database" on page 206). For each metric store, set up the database client and environment variables on a UNIX operating system (see "Set Up the Database Client for the Metric Store" on page 211 and "Setting Up Environment Variables on UNIX for the Metric Store" on page 68).

4. Create a metric package (see "Create a Metric Package" on page 212).

5. If you exported content from data stores in step 1, import the contents of each data store into a different metric store.
   For information about importing data, see the Metric Studio User Guide for Authors.

6. Install and configure Metric Designer on Microsoft Windows operating system (see "Installing and Configuring Metric Designer" on page 235).

7. Upgrade Metric Designer projects and extracts as required.

8. When you are ready, stop the earlier version of Metrics Manager and uninstall it as described in the documentation provided with it.

Results

To ensure the security and integrity of IBM Cognos BI, protect the installation directory from unauthorized or inappropriate access.

Upgrade Metrics Manager and Security Information

IBM Cognos BI and earlier versions of Metrics Manager use different security models. Before upgrading to IBM Cognos BI, review the information about IBM Cognos BI security to determine if it meets your requirements.

For information, see the Administration and Security Guide.

If the IBM Cognos BI security model does not meet your requirements and you must upgrade your existing security information, an upgrade utility is available. You use this utility during the upgrade process to map the security permissions for scorecards and metrics in the earlier version to corresponding permissions in IBM Cognos BI.

The upgrade utility does not map the Deny permission if it was used in the earlier version of Metrics Manager. For example, assume a user belongs to two user
classes. For the same scorecard, one user class has Read permission and the other user class has Deny permission. After the upgrade utility is run, the user will have only Read permission for the scorecard.

The upgrade utility maps security information for one data store using the information in a control file that you create. This file is a text file. If you plan to upgrade the content of more than one data store, you must create a control file for each data store and run the upgrade utility for each control file.

The following table describes the properties that must be defined in the control file. An example of a control file is provided below the table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>scorecard_file</td>
<td>A comma delimited list of object_stage (.cmo) files that contain the scorecards from the earlier version of Metrics Manager. The list must include all the scorecards that you want to import into the IBM Cognos BI metric store. Only scorecards are imported; other objects in these files are ignored.</td>
</tr>
<tr>
<td>policy_file</td>
<td>A comma delimited list of source object_link_stage (.cml) files from the earlier version of Metrics Manager that contain the policies to be upgraded. The list of files must contain all the policy links that you want to import into the IBM Cognos BI metric store. Only policy links are imported; other objects in these files are ignored.</td>
</tr>
<tr>
<td>input_file_encoding</td>
<td>The character set of the input files. This property is optional. By default, the default character set of the platform is used.</td>
</tr>
<tr>
<td>flat_file_version</td>
<td>The version of the flat file from the earlier version of Metrics Manager. The value may be 2.0 or 2.2. This property is optional. The default value is 2.2.</td>
</tr>
<tr>
<td>output_file</td>
<td>The name of the file where the generated IBM Cognos BI policies will be written. This property is optional. The default output file name is policies.cms.</td>
</tr>
<tr>
<td>output_file_encoding</td>
<td>The desired character set of the output file. This property is optional. By default, the default character set of the platform is used.</td>
</tr>
<tr>
<td>read_mapping</td>
<td>A comma delimited list of IBM Cognos BI permissions to grant for the read permission level set in the earlier version of Metrics Manager. One of the following suffixes may be added to specify the permissions for a specific object type: .metric or .scorecard.</td>
</tr>
<tr>
<td>write_mapping</td>
<td>A comma delimited list of IBM Cognos BI permissions to grant for the write permission level set in the earlier version of Metrics Manager. One of the following suffixes may be added to specify the permissions for a specific object type: .metric or .scorecard.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| administrator_mapping | A comma delimited list of IBM Cognos BI permissions to grant for the administrator permission level set in the earlier version of Metrics Manager. The permissions include:  
  - Read  
  - Write  
  - Setpolicy  
  - Readannotations  
  - Annotate  
  - Writeproject  
  - Writeactual  
  - Writetarget  
  - Writetolerance  
  - Writeudc  
  One of the following suffixes may be added to specify the permissions for a specific object type: .metric or .scorecard. |

### Example

The following shows an example control file:

```plaintext
scorecard_file=c:\cmm_exports\export_scorecards.cmo
policy_file=c:\cmm_exports\export_permissions.cml
flat_file_version=2.2
output_file=new_policies.cms
read_mapping=read,readannotations
write_mapping=read,readannotations,annotate,writeProject
administrator_mapping=read,readannotations,annotate,writeProject,
write,writeactual,writetarget,writetolerance,writeudc
```

### Upgrade security information for Metrics Manager:

If the IBM Cognos BI security model does not meet your requirements and you must upgrade your existing security information, an upgrade utility is available. You use this utility during the upgrade process to map the security permissions for scorecards and metrics in the earlier version to corresponding permissions in IBM Cognos BI.

### Procedure

1. Export the contents of the data store from the earlier version of Metrics Manager with the exception of users. For more information, see the documentation provided with the earlier version of Metrics Manager.
2. Install IBM Cognos BI:
   - If you are upgrading only Metrics Manager, install IBM Cognos BI in a different directory from the earlier version of Metrics Manager (see Chapter 8, “Installing IBM Cognos BI Server Components on Different Computers,” on page 165).
   - If ReportNet is on the same computer as Metrics Manager, follow the steps to upgrade ReportNet to IBM Cognos BI (see “Upgrade ReportNet to IBM Cognos BI” on page 102).
3. Set up the environment (see Chapter 5, “Preparing to Install,” on page 57). Ensure that you create a metric store database and set up the metric store database client and environment variables on a UNIX operating system (see “Create the Metric Store Database” on page 206, “Set Up the Database Client for the Metric Store” on page 211, and “Setting Up Environment Variables on UNIX for the Metric Store” on page 68). Also, ensure that the IBM Cognos Series 7 namespace is configured and available in the IBM Cognos BI environment.

4. Create a control file that references the object stage (.cmo) files, containing the scorecard definitions, and the object link stage (.cml) files, containing the permission definitions generated in step 1. The control file is a text file. See the table and example above to help you create your control file.

5. In the <i>c10_location</i>/bin directory, type the following command from a command prompt:

   <pre>cmm_migrate_policies control_file_name</pre>

6. Create a metric package (see “Create a Metric Package” on page 212).

7. Import the data store export you created in step 1 into the metric store. You do not have to import the object link stage (.cml) files containing the permission definitions. In the example above, the file containing the permission definition is export_permission.cml.

   For more information about importing, see the Metric Studio User Guide for Authors.

8. Import the contents of the output file generated using the cmm_migrate_policy command. The output file is named new_policies.cms in the example above. Ensure that you specify the import source file format to be 8.1.2MR2.

9. Install and configure Metric Designer on Microsoft Windows operating system (see Chapter 8, “Installing IBM Cognos BI Server Components on Different Computers,” on page 165).

10. Upgrade Metric Designer projects and extracts as required.

11. When you are ready, stop the earlier version of Metrics Manager and uninstall it as described in the documentation provided with it.

Results

To ensure the security and integrity of IBM Cognos BI, protect the installation directory from unauthorized or inappropriate access.

Upgrading Metrics Manager Custom Calendars

If you want to upgrade a Metrics Manager 2.2 calendar that uses a customized period start date and end date, you must create a standard calendar in IBM Cognos BI that reflects your custom calendar as closely as possible. You must then export the standard calendar and modify the import time periods file (.cal), import time levels file (.lvl), and time language text file (.tlt) so that the calendar equals your Metrics Manager 2.2 calendar.
Run Multiple Versions or Instances of IBM Cognos BI at the Same Time

You must change the ports and the Web server alias in IBM Cognos BI if you want to run IBM Cognos BI and ReportNet, or two instances of IBM Cognos BI, on the same computer and at the same time.

In ReportNet, there is no default cookie path, which means the cookie is sent to all URLs on the Web server. If IBM Cognos BI uses the same Web server, IBM Cognos BI will then receive two cam_passport cookies. To prevent this conflict, you must set a cookie path in ReportNet.

Other configuration changes may be required depending on your environment. If you use Portal Services, you must specify the location of the applications.xml file. If you use an ISAPI gateway on an IIS Web server, you must isolate the IBM Cognos BI gateway to prevent a conflict with the ReportNet gateway. For IIS 5, you isolate the gateway by setting the application protection for the Web site and virtual directories to High. For IIS 6 and 7, you must create an application pool for each version of the IBM Cognos BI product and associate the aliases to it.

If you are using the same type of database for the content store with multiple instances or versions of an IBM Cognos BI product, then to avoid conflicts between the database instances, you must change the content store port in IBM Cognos Configuration.

After changing the ports and aliases, you can run ReportNet and IBM Cognos BI, or two instances of IBM Cognos BI, at the same time.

Note: When you change from the default ports in the URI properties on a Microsoft Windows operating system, the port number is automatically appended to the service name. The service name in IBM Cognos Configuration does not show the port number. You can view the service name and port number under Services in your Windows administrative tools.

Configuring the new instance of IBM Cognos Business Intelligence

You must configure the new instance of IBM Cognos Business Intelligence with unique values for ports, the Web server alias, and other settings as required.

Procedure

1. In IBM Cognos BI, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, under Dispatcher Settings, click the value for Internal dispatcher URI.
4. Select the port number and then type the new port number.
5. If required, change the port number for the following URIs to match the new port number that you entered for Internal dispatcher URI.
   - Under Dispatcher Settings, change the port for External dispatcher URI.
   - Under Other URI Settings, change the port for Dispatcher URI for external applications and Content Manager URIs.
     Content Manager URIs does not appear on a gateway computer.
6. Under Gateway Settings, click the value for Gateway URI and ensure that the URI contains the correct Web server alias for IBM Cognos BI.
   For example, replace crn with ibmcognos.
7. If you are using Portal Services, update the applications.xml file:
   - In the Explorer window, click Environment > Portal Services.
   - In the Properties window, ensure that the port number for Location of Applications.xml matches the port for the other URI properties.

8. In the Explorer window, click Data Access > Content Manager > Content Store.

9. In the Properties window, configure IBM Cognos BI to use the new content store:
   - For Database name, specify the name of the new content store.
   - To avoid conflicts with other instances of content store databases, for the Database server and port number property, specify the server name and a different port number.
   - If you are using Cognos Content Database as the content store, and another instance of Cognos Content Database is running on the computer, then you must also specify a different listening port number:
     In the Explorer window, expand Environment > IBM Cognos content database.
     In the Properties window, for Listening port number, type the port number.

   Important: When you install the IBM Cognos BI product, you must select Cognos Content Database in the installation wizard. Cognos Content Database is not for use in a production environment.
   - For User ID and password, click the edit button and specify the userid and password to access the new content store.

10. If you are running two instances of IBM Cognos BI, change the cookie path for the new version of IBM Cognos BI:
    - From the Actions menu, click Edit Global Configuration.
    - In the Global Configuration window, click Cookie Settings.
    - Go to a different path from the one that is used by the older version of IBM Cognos BI.
    - Click OK.

11. Save the configuration and start IBM Cognos BI.

**Configuring ReportNet or the older instance of IBM Cognos Business Intelligence**

You must change the cookie path for ReportNet or the older instance of IBM Cognos Business Intelligence with unique values for ports, the Web server alias, and other settings as required.

**Procedure**

1. In ReportNet or the older version or instance of IBM Cognos BI product, start IBM Cognos Configuration.

2. Change the cookie path:
   - From the Actions menu, click Edit Global Configuration.
   - In the Global Configuration window, click Cookie Settings.
   - Set the path to the installation directory (for example, /crn).
   - Click OK.

3. Save the configuration.
Upgrading IBM Cognos for Microsoft Office

The client components for IBM Cognos for Microsoft Office must be upgraded when a new version of IBM Cognos Business Intelligence software is installed.

Users of the client components must first uninstall the older version and then run a setup file that installs a new version of Microsoft .NET Framework, updates the .NET components, and installs the new version of IBM Cognos for Microsoft Office. To upgrade reports, users must open them in the new version and then save them.

There is no action required to update the server components for IBM Cognos for Microsoft Office. They are included in the upgrade to the new version of IBM Cognos BI.

If you deployed IBM Cognos for Microsoft Office enabled files or templates, you do not have to revise the custom properties in the new version. The custom properties and templates are no longer required.

To support the addition of other IBM Cognos products that work with Microsoft Office, the name used to install the new product is now IBM Cognos for Microsoft Office. This name is used in the installation wizard and in the name of the action pane that appears in your Microsoft Office product after upgrading. In addition, the name of the default installation directory is changed to IBM Cognos for Microsoft Office.

Uninstalling previous versions of IBM Cognos for Microsoft Office products

If you have a previous version of IBM Cognos for Microsoft Office or other IBM Cognos for Microsoft Office products, you must uninstall all previous versions before you can install the new version of IBM Cognos for Microsoft Office.

The uninstall does not completely remove all application files or directories during the uninstall process; therefore, you may have to perform this action manually.

If you installed more than one component in the same location, you can choose the packages to uninstall using the uninstall wizard. All components of the package will be uninstalled.

Before you begin

Before uninstalling, close all Microsoft Office applications.

Procedure

1. From the Start menu, click Programs>IBM Cognos for Microsoft Office>Uninstall IBM Cognos>Uninstall IBM Cognos.

   The Uninstall wizard appears.

   Tip: IBM Cognos for Microsoft Office is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the component.

   The cognos_uninst_log.txt file records the activities that the Uninstall wizard performs while uninstalling files.

   Tip: To find the log file, look in the Temp directory.
Installing IBM Cognos for Microsoft Office

To install IBM Cognos for Microsoft Office, you run an issetup.exe file from the appropriate directory on the product CD or central LAN location. The file installs a security update for Microsoft .NET Framework and then installs the IBM Cognos for Microsoft Office components.

To deploy IBM Cognos for Microsoft Office with PowerPlay, you can configure gateway mappings so that IBM Cognos for Microsoft Office users can access PowerPlay reports that reside on a PowerPlay server. You can also configure the size of report that can be imported from IBM Cognos BI to IBM Cognos for Microsoft Office. For more information about gateway mappings and report size limits, see the IBM Cognos Administration and Security Guide.

Application samples for IBM Cognos for Microsoft Office are on a separate disk. If you want to use the samples, your IBM Cognos BI administrator must install them from the IBM Cognos Business Intelligence Samples disk.

Before you begin

IBM Cognos for Microsoft Office is available as a 32-bit and 64-bit installation. You can install the 32-bit client on a 64-bit operating system, but the 32-bit and 64-bit clients cannot coexist on the same Windows computer.

Before you update and install components, ensure that you
- have administrative privileges on the computer
- installed Microsoft .NET Framework 2.0 or later
- uninstalled any previous version of IBM Cognos for Microsoft Office
- have the appropriate license to use your IBM Cognos for Microsoft Office product

Procedure

1. Insert the IBM Cognos for Microsoft Office CD or go to the location where the installation files were downloaded.
   The Welcome page of the installation wizard appears when you insert the CD.
2. If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.
3. Select the language to use for the installation
   The language that you select determines the language of the user interface.
   You can change the language to any of the installed languages after installation.
4. In the License Agreement page, select I Agree and then click Next.
5. Repeat step 4 for the non-IBM license agreement.
6. In the Installation Location page, select the installation directory, and click Next.
   The following are the default installation paths:
   - If installing on 32-bit Windows, C:\Program Files\IBM\cognos\Cognos for Microsoft Office
   - If installing on 64-bit Windows, C:\Program Files (x86)\IBM\cognos\Cognos for Microsoft Office
If a window is displayed, advising you to uninstall a previous version of the IBM Cognos Office product, follow the prompts and uninstall the previous version, and then resume the installation.

7. In the Component Selection page, select IBM Cognos for Microsoft Office, and then click Next.

8. Follow the directions in the installation wizard to copy the required files to your computer.

9. In the Finish page of the installation wizard, if you want to see late-breaking information about IBM Cognos components, click View IBM Cognos Release Notes.

10. Click Finish.

Results

If you want to use the samples that are available for IBM Cognos for Microsoft Office or IBM Cognos BI, your administrator must install the IBM Cognos BI samples. For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

Upgrading Transformer Models and PowerCubes

You can open IBM Cognos Series 7 models with secured cubes in Transformer and upgrade the IBM Cognos Series 7 user class views and user classes for use in IBM Cognos BI.

Before you load the model, the IBM Cognos Series 7 namespace must be configured in IBM Cognos BI. For more information, see Configuring IBM Cognos to Use IBM Cognos Series 7 Namespace on page 320.

Unsecured models in IBM Cognos Transformer

If you are importing secured models from IBM Cognos Series 7, see the topic about upgrading an IBM Cognos Series 7 secured model in Transformer 8.4.

You can open an IBM Cognos Series 7 model with secured cubes in IBM Cognos Transformer, and convert the IBM Cognos Series 7 user class views to IBM Cognos BI custom views. You can then choose the authentication provider you want to use with the custom views. For more information about adding security, see the Transformer User Guide.

During the transition from an IBM Cognos Series 7 namespace to an alternate security provider, you can use the PowerCube property All applicable namespaces (including unsecured PowerCubes) to associate all applicable namespaces during migration testing. When you associate all the applicable namespaces to the cube, you can ensure that the group, role, or user dimensional filtering is consistent with that which had been applied for the IBM Cognos Series 7 user class. This option is supported only for migration testing, and cannot be used to deploy cubes in production environments.

You can change the association for an IQD data source to that of an IBM Cognos BI data source, thereby taking advantage of the enhancements available when using an IBM Cognos BI package or report data source. You can change the association for IBM Cognos Series 7 .iqd files and for Framework Manager .iqd
files, after the updated model has been saved in Transformer 8.4. For more information about changing a data source type, see the Transformer User Guide.

Transformer 8.4 supports upgrading models from IBM Cognos Series 7.x. When importing .mdl files from earlier versions, some features may not convert correctly, such as legacy data that contains special characters, spaces, and quotation marks. For more information, see the migration documentation delivered with your version of the product.

**IBM Cognos Series 7 Secured PowerCubes**

If you want to move to an IBM Cognos BI supported authentication provider other than Access Manager, you can do this over time.

When you open the IBM Cognos Series 7 secured model in IBM Cognos Transformer, you can choose to:

- import the IBM Cognos Series 7 user class views associated with the model, but not the user classes

  Choose this option when you want to maintain the view operations applied in the IBM Cognos Series 7 user class views but not use an IBM Cognos Series 7 namespace with the custom views, or if you do not intend to expose IBM Cognos Series 7 as an available namespace configured in IBM Cognos BI.

  **Note:** Prior to building and using the IBM Cognos Transformer cube in any of the IBM Cognos BI Web studios, you will need to associate new security objects to the upgraded custom views.

- import the IBM Cognos Series 7 user class views and user classes associated with the model

  Choose this option when you want to maintain the view operations applied in the user class views and use the IBM Cognos Series 7 user classes, or if you want to transition to an alternate security provider but need to maintain the IBM Cognos Series 7 user class objects to ensure the transition is carried out correctly. This option requires you to configure the IBM Cognos Series 7 security on which the upgraded model was designed as an available namespace in IBM Cognos BI. The unique identifier that locates the user class in Access Manager is converted to an IBM Cognos BI identifier, and this process will not be successful if you use this option with a different IBM Cognos Series 7 namespace.

- discard all existing custom views and security objects

  Choose this option when you plan to create new custom views and use only the security objects currently configured in the IBM Cognos BI namespace.

For PowerCubes that are in development and transitioning from an IBM Cognos Series 7 namespace to an alternate security provider, you can associate all the applicable namespaces on the PowerCube property sheet (Data Source tab). This option is intended only for the testing of migration, and requires that the modeler or administrator log on to all the applicable namespaces prior to accessing the PowerCube package in IBM Cognos BI. Failing to log on to all applicable namespaces will result in an inaccurate view of the data. This feature is not supported for the deployment of cubes for end users.

For more information about publishing a PowerCube, see the Transformer User Guide.
Prepare Models in IBM Cognos Series 7 Transformer

To upgrade models created in earlier versions of Transformer, you must save them in Model Definition Language (MDL) format before you can import them into Transformer 8.4. This ensures that equivalent definitions are created for all model objects. You can upgrade models from IBM Cognos Series 7 Transformer Versions 7.x.

Procedure
1. Open the model in the earlier version of Transformer and, from the File menu, click Save As.
2. In the Save as Type box, click Exported Model Files (*.mdl).
   
   Tip: By default, Transformer saves models in the ../My Documents/Transformer/Models directory. You can set the location to which Transformer saves models by changing the Models directory setting on the Directories tab of the Preferences property sheet.
3. Back up the .mdl files in a secure location.

Import Unsecured Models in IBM Cognos Transformer

After you install IBM Cognos Transformer, you can import the .mdl files from IBM Cognos Series 7 into IBM Cognos Transformer.

Procedure
Open the .mdl file in IBM Cognos Transformer, make any required changes to the model design, and save it, again selecting the .mdl format.

Tip: If your IBM Cognos Series 7 model includes security, you will receive a message when you open the model in Transformer version 8.x indicating that you must choose how to manage the security during the upgrade process. For more information, see the topic about upgrading an IBM Cognos Series 7 secured PowerCube in the Transformer User Guide.

When you are ready to use the model in your production environment, you may want to save it as a .pyj-format file.
IBM Cognos Transformer models (.mdl and .pyj) are not backward compatible with Transformer versions 7.x. As a result, maintain the .mdl file for the Transformer 7.x model for a period of time following upgrade.

Upgrade an IBM Cognos Series 7 Secured PowerCube

You can open IBM Cognos Series 7 models with secured cubes in IBM Cognos Transformer, and upgrade the IBM Cognos Series 7 user class views and user classes for use in IBM Cognos BI.

Procedure
1. From the File menu, click Open, browse to the location of the IBM Cognos Series 7 secured model, select the model, and then click Open.
2. In the Import model with IBM Cognos Series 7 user class view dialog box, select the appropriate security import option, and then click Next.
3. If you selected Import user class views and user classes from the model, in the Logon dialog box, select the appropriate namespace and then log on with your user ID and password.
4. In the Available namespace(s) box, select the namespace used to secure the IBM Cognos Series 7 cube.
Tip: If the namespace does not appear in the list, click Logon As to select and log on to the namespace.

5. Click Finish.
Chapter 7. Installing and Configuring IBM Cognos BI Components on One Computer

You can install all IBM Cognos Business Intelligence components on one computer. This is useful when you are setting up a test or evaluation environment, or for small production environments. To use IBM Cognos BI, you must install all components that are selected by default in the installation wizard.

You can also distribute the installation of IBM Cognos BI on different computers. For more information, see Chapter 8, “Installing IBM Cognos BI Server Components on Different Computers,” on page 165.

For uninstallation instructions, see Chapter 20, “Uninstalling IBM Cognos BI,” on page 497.

Install Server Components in Interactive Mode

For a complete installation, you must install components on your server and then configure them to work in your environment.

Typically, you run the IBM Cognos installation and configuration programs in interactive mode. This means that in a graphical user interface (GUI) the installer prompts you to provide information, and the configuration tool enables you to change default settings.

You can choose to install server components in silent mode.

Silent Mode

You can automate the installation of components using response files and running the installation program in silent mode.

You can automate the configuration of components by exporting the configuration settings from one computer to another as long as the installed components are the same. Run IBM Cognos Configuration in interactive mode the first time.

The other option is to edit the cogstartup.xml file, using settings that apply to your environment, and then running the configuration tool in silent mode.

Interactive Mode

Unless you intend to complete a silent-mode installation, install the software from an X Window System workstation, an X terminal, or a PC or other system with X server software installed.

To run an interactive-mode installation, the console attached to your computer must support a Java-based graphical user interface.
Install IBM Cognos BI Server Components

Use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. Only the components that you choose to install are copied from the disk to your computer.

Application samples for your IBM Cognos BI product are on a separate disk. If you want to use the samples, you must install them from the IBM Cognos Business Intelligence Samples disk.

Stopping the Service

If you need to stop the IBM Cognos service, it is important to also stop the following:

- Web servers that host IBM Cognos BI content
- applications that are related to the IBM Cognos service, such as Framework Manager, IBM Cognos Transformer, IBM Cognos Connection, IBM Cognos Administration, and Metric Designer
- any Software Development Kit applications that are running

Upgrading your installation

If you are upgrading from a previous release of IBM Cognos products, you must use the upgrading steps. For information about upgrading from ReportNet or Metrics Manager, see Chapter 6, “Upgrading to IBM Cognos Business Intelligence,” on page 73.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, all the distributed components must be the same version of IBM Cognos BI. If you install IBM Cognos BI on additional or alternate hosts, you must update location-specific properties in IBM Cognos Configuration.

64-bit Installations

The IBM Cognos BI gateway provides 32-bit libraries, whether you install on a 64-bit server or a 32-bit server. Some Web servers, such as Apache Web Server, cannot load a 32-bit compiled library in a 64-bit compiled server. In that situation, install the 32-bit version of the IBM Cognos gateway on a 32-bit Web server.

The report server component, included with the Application Tier Components, is provided in both 32- and 64-bit versions. Selecting which version you use is done using IBM Cognos Configuration after installation. By default, the report server component is set to use the 32-bit mode, even on a 64-bit computer. The 32-bit mode allows you to run all reports, whereas the 64-bit mode allows you to run only reports created for dynamic query mode.

If you are upgrading IBM Cognos BI in an environment that includes earlier versions of other IBM Cognos BI products, such as IBM Cognos BI Controller Version 8.x, IBM Cognos BI Planning Version 8.x, or IBM Cognos BI Analysis for Microsoft Excel Version 8.x, install the new version of IBM Cognos BI in a separate location from the other IBM Cognos BI product and configure the new version of IBM Cognos BI to operate independently of that product. After you upgrade the other product to a compatible version with IBM Cognos BI, you can then configure the two products to operate together.
Windows Installations

For Microsoft Windows operating system installations, ensure that you have administrator privileges for the Windows computer you are installing on. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files from the disk are temporarily copied to this directory.

UNIX Installations

For UNIX operating system installations, you can install server components using a graphical user interface or by running a silent installation. To run graphical-mode installation, the console attached to your UNIX computer must support a Java-based graphical user interface.

Also, IBM Cognos BI respects the file mode creation mask (umask) of the account running the installation program. This affects only the installation directories. It does not affect the file permissions within the directories. However, run-time generated files, such as logs, respect the mask. Use umask 022 on the installation directory.

Cognos Content Database as Content Store

If you want to use Cognos Content Database as your content store, you must select it in the installation wizard. If you are installing components on several computers, you need to only install Cognos Content Database once.

Printer requirements

To ensure that reports print properly on Windows, Adobe Reader requires that you configure at least one printer on the operating system where Application Tier Components are installed. All reports, regardless of the print format that you choose, are sent as temporary PDF files to Adobe Reader for printing.

Installing server components on UNIX or Linux

Use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. Only the components that you choose to install are copied from the disk to your computer.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Set the JAVA_HOME environment variable to point to the installation location of your Java Runtime Environment (JRE).
   An example of the installation location of a Java Runtime Environment is /directory/java/java_version/jre.
   IBM Cognos BI requires a JVM, such as the one that is provided by IBM, to run on Linux operating system.
   If you are installing in a location with other IBM Cognos BI components, use the existing JAVA_HOME environment variable.
3. On HP-UX, set the _M_ARENA_OPTS environment variable as follows: _M_ARENA_OPTS 1:4
This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.

4. On AIX, if you are using a servlet gateway, set the AIXTHREAD_SCOPE environment variable as follows:

```
AIXTHREAD_SCOPE=S
```

This sets the contention scope for user threads to system-wide, which supports more efficient scheduling of user threads.

5. If installing from a download, go to the location where the installation files were downloaded and extracted.

6. If installing from a disk, mount the disk using Rock Ridge file extensions.

To mount the disk on HP-UX, do the following:

- Add the pfs_mount directory in your path.
  
  For example,
  
  ```
  PATH=/usr/sbin/:$PATH
  export PATH
  ```

- To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`

- To mount the drive, type
  
  ```
  pfs_mount -t rrip <device><mount_dir> -o xlat=unix
  ```

  For example,
  
  ```
  pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
  ```

  You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.

- When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.

7. To start the installation wizard, go to the operating system directory and then type

```
/issetup
```

**Note:** When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on UNIX or Linux, first set environment variables LANG=C and LC_ALL=C (where C is the language code, for example ja_JP.PCK on Solaris), and then start the installation wizard.

If you do not use XWindows, run an unattended installation (see Chapter 19, “Setting Up an Unattended Installation and Configuration,” on page 491).

8. Follow the directions in the installation wizard and copy the required files to your computer.

   Install IBM Cognos BI components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

   If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.

   If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.

9. When you are prompted about installing non-English product documentation, click OK to continue.
10. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
     You can later configure IBM Cognos BI using IBM Cognos Configuration by typing cogconfig.sh in the c10_location/bin directory, or by running a silent configuration or editing cogstartup.xml in the c10_location/configuration directory.
   - Click Finish.

11. Append the c10_location/bin directory to the appropriate library path environment variable.
   - For Solaris and Linux, LD_LIBRARY_PATH
   - For AIX, LIBPATH
   - For HP-UX, SHLIB_PATH

12. On Linux, set the PRINTER environment variable to the name of your printer.

Results

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see “Translated Product Documentation” on page 293.

If you want to use the samples that are available for IBM Cognos BI, install the IBM Cognos BI samples.

You must also update your Java security framework (see “Java settings” on page 131) before you can configure IBM Cognos BI. Otherwise, you may receive the following error:

```
[Cryptography]
1. [ ERROR ] java.lang.NoClassDefFoundError:
   javax/net/ServerSocketFactory:
```

Installing server components on Windows

Use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. Only the components that you choose to install are copied from the disk to your computer.

For Windows Vista, Windows 7, or Windows 2008 computers, the default installation location uses the Program Files (x86) directory. If you install to this location, ensure that you run IBM Cognos Configuration as an Administrator. Alternatively, you can install the product outside of the Program Files (x86) directory. For example, you can change the installation directory to something like C:\IBM\cognos\c10.
Procedure

1. If you are installing in a directory with other IBM Cognos BI components, stop the IBM Cognos service.

2. Do one of the following:
   - Insert the IBM Cognos product disk.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.

4. Follow the directions in the installation wizard to copy the required files to your computer.
   Install IBM Cognos BI components in a directory that contains only ASCII characters in the path name. Some Windows Web servers do not support non-ASCII characters in directory names.
   If you are installing IBM Cognos BI on a computer that already has ReportNet, and you want to keep ReportNet running, you must install IBM Cognos BI in a different directory.
   If you are installing in a directory that contains other IBM Cognos BI components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. When you are prompted about installing non-English product documentation, click OK to continue.

6. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
     You can later configure IBM Cognos BI using the Windows Start menu to start IBM Cognos Configuration from the shortcut folder.
   - Click Finish.

Results

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see “Translated Product Documentation” on page 293.

If you want to use the samples that are available for IBM Cognos BI, install the IBM Cognos BI samples.
**Install IBM Cognos Metrics Manager**

If you are installing IBM Cognos Metrics Manager with IBM Cognos Business Intelligence and you want to share resources, you must install each IBM Cognos Metrics Manager component in the same location as each IBM Cognos Business Intelligence component.

You may also want to install Metric Designer (see “Installing and Configuring Metric Designer” on page 235).

**IBM Cognos Metrics Manager and 64-bit Systems**

IBM Cognos Metrics Manager is only available in a 32-bit version. If you are sharing resources with IBM Cognos BI Server on a 64-bit system, you must install the server components in a separate location from the IBM Cognos Business Intelligence components.

After installing the components in separate directories on the 64-bit system, you can configure IBM Cognos Metrics Manager to share resources with the IBM Cognos Business Intelligence server (see “Configure Shared Resources for IBM Cognos Metrics Manager” on page 205).

**Installing Fix Packs**

IBM provides interim maintenance packages that contain updates to one or more components in your IBM Cognos product. If a fix pack is available when you are installing or upgrading your product, you must install it after you install the IBM Cognos components.

If a fix pack becomes available after your IBM Cognos product has been deployed, you must stop the service, install the fix pack in the same location as the IBM Cognos components, and then start the service.

Fix packs are cumulative. When you install the latest fix pack, it includes updates from all the previous fix packs. Fix packs are available for download from IBM Support at [http://www.ibm.com/support/us/en/](http://www.ibm.com/support/us/en/)

Note: Fix packs are not standalone installations. You must install them on computers that have IBM Cognos components installed. Install the fix packs that are appropriate for your product version. To check your version, open the component list file at \c10_location\cmplst.txt and check the line that starts with C8BISRVR_version*.  

**Installing Fix Packs (Windows)**

Use the following steps to install the fix pack.

**Before you begin**

Before you install the fix pack:

1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.
Procedure
1. Insert the fix pack disk for the Windows operating system or go to the location where you downloaded and extracted the files.
2. On the disk or in the download location, go to the win32 directory and double-click the issetup.exe file.
3. Follow the directions in the installation wizard, installing in the same location as your existing IBM Cognos components.
   The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
4. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.
5. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.
6. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server.
   For instructions, see "Configure Application Server Properties and Deploy IBM Cognos Components" on page 453.

Installing Fix Packs (UNIX/Linux)
Use the following steps to install the fix pack.

Before you begin
Before you install the fix pack:
1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

Procedure
1. If using a disk, mount the fix pack disk that is appropriate for your UNIX or Linux operating system, using Rock Ridge file extensions.

   Important: To mount the IBM Cognos disk on HP-UX, do the following:
   • Add the pfs_mount directory in your path.
     For example,
     PATH=/usr/sbin/PATH
     export PATH
   • To start the required NFS daemons and run the daemons in the background, type bg pfs_mountd and then type bg pfsd
   • To mount the drive, type
     pfs_mount -t rrip <device> <mount_dir> -o xlat=unix
     For example,
     pfs_mount -t rrip /dev/dsk/c0t2d0 /cdrom -o xlat=unix
   You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   • When the installation is complete, type pfs_umount /cdrom and kill the pfsd and pfs_mountd daemons to unmount the disk.
2. If using a download, go to the location where you downloaded and extracted the fix pack files.

3. To start the installation wizard, type
   
   ./issetup
   
   If you do not use XWindows, run an unattended installation (see "Set Up an Unattended Installation Using a File From an Installation on Another Computer" on page 492).

4. Follow the directions in the installation wizard to install to the same location as your existing IBM Cognos components.
   
   The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.

5. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.

6. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.

7. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server.
   
   For instructions, see "Configure Application Server Properties and Deploy IBM Cognos Components" on page 453.

---

**Java settings**

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

You can use an existing Java Runtime Environment (JRE) or the JRE that is provided with Cognos BI.

**JAVA_HOME**

If you want to use your own JRE and have JAVA_HOME set to that location on Microsoft Windows operating system or if you are installing on a UNIX or Linux operating system, you must update JAVA_HOME for the cryptographic services.

On Windows, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for it to take effect. If you set it as a user variable, set it so that the environment in which Tomcat (or other application server) is running can access it.

If you do not have a JAVA_HOME variable already set on Windows, the JRE files provided with the installation will be used, and you do not have to update any files in your environment. If JAVA_HOME points to a Java version that is not valid for IBM Cognos BI, you must update JAVA_HOME with the path to a valid Java version.

**Unrestricted JCE Policy File**

Whether you use the default Windows JRE or download a JRE for UNIX or Linux, the JRE includes a restricted policy file that limits you to certain cryptographic algorithms and cipher suites. If your security policy requires a wider range of cryptographic algorithms and cipher suites than are shown in IBM Cognos Configuration, you can download and install the unrestricted JCE policy file.
Update the Java Environment

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

**Procedure**

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   For example, to set JAVA_HOME to a JRE that you are already using, the path is `java_location/bin/jre/version`.
2. If your security policy requires it, download and install the unrestricted JCE policy file.
   For Java that is provided by IBM, the unrestricted JCE policy file is available from the following location:
   For information about configuring the cryptographic provider to support your security policy, see "Configuring Cryptographic Settings" on page 353.

---

### JDBC Driver Options for Using DB2 Database as a Content Store

IBM Cognos Business Intelligence uses Java Database Connectivity (JDBC) to access the database used for the content store.

If you use DB2 on a Microsoft Windows, Linux, or UNIX operating system as your content store you must choose whether to use the type 2 or type 4 JDBC driver depending on how you want to connect to the content store.

If you are using a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

You specify the driver type to use in IBM Cognos Configuration.

#### Configuration Options for the Universal Driver

DB2 introduced a universal JDBC driver that contains both type 2 and type 4 JDBC driver support. The universal driver, `db2jcc.jar`, replaces the deprecated type 2 JDBC driver, `db2java.zip`.

If you are upgrading, you can continue to use a type 2 JDBC connection with no configuration change required. If you want to use a type 4 JDBC connection, you must change your configuration to include the host name and port number of the database server.

For both a type 2 and type 4 JDBC connection, however, you must copy the new universal driver, `db2jcc.jar`, and the accompanying license file, `db2jcc_license_*`.jar, to your IBM Cognos BI installation location.

#### Using the Type 2 JDBC Driver

Type 2 JDBC drivers are comprised of a native-API component and a Java component.
The connection to the DB2 database occurs through the DB2 CLI libraries, which comprise the native component that communicates with the database server.

Because type 2 JDBC drivers require common client code and rely on the native code of the product, a DB2 client must be installed to use this driver. For example, a DB2 client must be installed on the computer where you have Content Manager installed.

**Using the Type 4 JDBC Driver**

Type 4 JDBC drivers are pure Java drivers which provide direct access to DB2 database features through network communication.

The type 4 driver is considered an independent product. It does not require the DB2 client to be installed.

**Related concepts**

- “Set Database Connection Properties for the Content Store” on page 146

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

---

**Set Up Database Connectivity for the Content Store Database**

If you are using a database other than Cognos Content Database or Microsoft SQL Server as the content store, you may have to install database client software, or Java Database Connectivity (JDBC) drivers, or both, on each computer where you install Content Manager. Doing this allows Content Manager to access the content store database.

**Set Up Database Connectivity for a DB2 Content Store**

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. If you are using a type 2 JDBC connection, install the DB2 client software on the Content Manager computers.

   If you are using a type 4 JDBC connection for DB2, you are not required to install the DB2 client software where Content Manager is installed. If you use a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

   For more information about the differences between type 2 and type 4 drivers, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 132.

2. If you are using a type 2 JDBC connection, and the content store is on a different computer than Content Manager, configure a database alias to the content store.

   On Microsoft Windows operating systems, run the DB2 Client Configuration Assistant.

   On UNIX or Linux operating systems, use the DB2 command line interface.
Note: If the content store database and Content Manager are on the same computer, the content store name automatically becomes the alias. When you configure the Content Manager computers, ensure that they are all configured to use the same content store.

3. On Windows, stop the DB2 services and the HTML Search Server.
4. Copy the following files from DB2_installation/sqlib/java directory to the c10_location/webapps/p2pd/WEB-INF/lib directory.
   - the universal driver file, db2jcc.jar
   - the license file
     for DB2 on Linux, UNIX, or Windows, db2jcc_license_cu.jar
     for DB2 on z/OS, db2jcc_license_cisuz.jar
   If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

   Tip: To check the driver version, run the following command
   java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version

5. On Windows, restart the DB2 services and the HTML Search Server.
6. On UNIX, if you are using a type 2 JDBC connection, ensure that the 32-bit DB2 libraries are in the library search path, which is usually the $DB2DIR/lib directory or the $DB2DIR/lib32 directory.
7. Repeat this entire procedure on the IBM Cognos BI computers where Content Manager is installed or where notification is sent to a DB2 database.
   You can tune the database to take advantage of DB2 features. For more information, see "Tuning a DB2 Content Store" on page 477.

Generating a script file that will create a database for a DB2 content store
You can generate a script file to automatically create the content store in IBM DB2 on all platforms. The script file is called a DDL file.

Procedure
1. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
   The default configuration is for an IBM DB2 database. Ensure that the Type is DB2 database.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
5. If you are using a type 4 JDBC connection, in Database server and port number, enter the name of your computer and port number on which DB2 is running. For example, localhost:50000. 50000 is the default port number used by DB2. If you are using a different port number, ensure you use that value.
   If you use a type 2 JDBC connection, you can leave this value blank.
6. Right-click Content Store, and click Generate DDL.
7. Click Details to record the location of the generated DDL file.
The DDL file named createDB.sql is created. The script is created in the c10_location/configuration/schemas/content/db2 directory.

Use this script to create a database in IBM DB2. For more information about using a DDL file, see your IBM DB2 documentation.

Create Tablespace for a DB2 Content Store on z/OS

A database administrator must run a script to create a set of tablespaces required for the content store database. The script must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

If you are using the same DB2 database on z/OS for both the content store and notification databases, run the scripts to create the notification database tablespaces at the same time that you create the content store database tablespaces.

Ensure that you use the naming conventions for DB2 on z/OS. For example, all names of parameters must start with a letter and the length must not exceed eight characters. There are two exceptions to the character length limit:

- CMSCRIPT_CS_ID is no more than 2 characters.
- CMSCRIPT_TABLESPACE is no more than 6 characters.

The reason for the exception is that when the two parameters are concatenated the character length can be no more than 8.

For more information, see the IBM DB2 Information Center.

Procedure

1. Create a database.
2. Ensure that the database administrator grants CONNECT and CREATE TABLE rights to the user of the new content store database, or grant DBADM to the user for the content store database.
   
   For example, to grant DBADM to a user CGCUSER
   
   GRANT DBADM ON DATABASE CMDB841 TO CGCUSER
   
   a. Ensure that the user has privileges to create an index on buffer pools.
      
      For example,
      
      GRANT USE OF BUFFERPOOL BP2 TO CGCUSER
   
   b. Ensure that the user has privileges to create an index on a storage group
      
      For example,
      
      GRANT USE OF STOGROUP SGDBT1DT TO CGCUSER
3. Connect to the database as a user that has privileges to create and drop tablespaces and to allow execution of SQL statements.
4. Go to the directory that contains the scripts: .
   
   c8_location/configuration/schemas/content/db2z0S
5. Make a backup copy of the tablespace_db2z0S.sql script file and save the file to another location,
6. Open the original tablespace_db2z0S.sql script file.
   
   a. Add a connection statement to the beginning of the script.
      
      For example,
      
      connect to databasename user username using password;
   
   b. Use the following table to help you to replace the generic parameters with ones appropriate for your environment.
Not all of the parameters listed are in the script, but some might be added in the future.

Table 12. Parameter names and description for the tablespace script

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSCRIPT_CREATE_IN</td>
<td>Specifies the base tables location. For example, databaseName.baseTablespaceName</td>
</tr>
<tr>
<td>CMSCRIPT_STOGROUP</td>
<td>Specifies the name of the storage group.</td>
</tr>
<tr>
<td>CMSCRIPT_DATABASE</td>
<td>Specifies the name of the content store database.</td>
</tr>
<tr>
<td>CMSCRIPT_CS_ID</td>
<td>Specifies the instance identification for the content store database.</td>
</tr>
<tr>
<td></td>
<td>The ID must not be longer than two characters.</td>
</tr>
<tr>
<td>CMSCRIPT_TABLESPACE</td>
<td>Specifies the name of the tablespace that will contain all of the base tables in the content store. Auxiliary tables are not included. The name cannot be longer than six characters.</td>
</tr>
<tr>
<td>CMSCRIPT_LARGE_BP</td>
<td>Specifies the name of the large buffer pool allocated for especially large objects.</td>
</tr>
<tr>
<td>CMSCRIPT_REGULAR_BP</td>
<td>Specifies the name of the regular size buffer pool allocated for regular and large objects.</td>
</tr>
<tr>
<td>CMSCRIPT_USERNAME</td>
<td>Specifies the user account that accesses the content store database.</td>
</tr>
</tbody>
</table>

7. Save and run the script.
8. Grant the IBM Cognos user rights to the tablespaces that were created when you ran the `tablespace_db2zOS.sql` file script:
   a. Make a copy of the `rightsGrant_db2zOS.sql` script file and store it in another location.
   b. In the remote access tool, open the original `rightsGrant_db2zOS.sql` script file and replace the placeholder parameters with values that are appropriate for your environment.
      Ensure that you use the same values that you used when you allocated resources to the buffer pools and user account.
   c. Add a connection statement to the beginning of the script.
      For example, `connect to databasename user username using password;`
   d. Save and then run the script.
9. If you are using the same database for notification that you use for the content store (the default setup),
   a. Go to the `c8_location/configuration/schemas/delivery/zosdb2` directory.
   b. Open the `NC_TABLESPACES.sql` script file and use the following table to help you to replace the placeholder parameters with ones that are appropriate for your environment.
For parameters that are not in the script, add them.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCCOG</td>
<td>Specifies the name of the content store database.</td>
</tr>
<tr>
<td>DSN8G810</td>
<td>Specifies the name of the storage group used for the content store database.</td>
</tr>
<tr>
<td>BP32K</td>
<td>Specifies the name of the buffer pool used for the tablespaces.</td>
</tr>
</tbody>
</table>

c. Save and run the script.
d. Open the NC_CREATE_DB2.sql script file and replace the NCCOG placeholder parameter with the name of the content store database.

The job and scheduling monitor services will automatically run the script. However, you might choose to run it yourself.

Results

The content store database is created. You can now configure a database connection.

Set Up Database Connectivity for an Oracle Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.
2. Copy the correct library file for your version of the Oracle client to the c10_location/webapps/p2pd/WEB-INF/lib directory on the computer where Content Manager is installed and where notification is sent to an Oracle database.
   
   If you are using Oracle 10g, you must have ojdbc14.jar.
   If you are using Oracle 11g, you must have ojdbc5.jar.
   The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.

Set Up Database Connectivity for an Informix Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. On the computer where Informix is installed, go to the Informix_location/sqllib/java directory.
2. Copy the following files to the c10_location/webapps/p2pd/WEB-INF/lib directory on every computer where Content Manager is installed.
   - the universal driver file, db2jcc.jar
   - the license file, db2jcc_license_cisuz.jar
Set Up Database Connectivity for a Sybase Content Store

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. On the computer where Sybase is installed, go to the `Sybase_location/jConnect-6/classes` directory.
2. Copy the `jconn3.jar` file to the `c10_location/webapps/p2pd/WEB-INF/lib` directory on every computer where Content Manager is installed and where notification is sent to a Sybase database.

Database Connectivity for the Reporting Database

To support communication between IBM Cognos Business Intelligence and the data sources, you must install additional software for your data sources on the same computer that hosts the report server. Depending on the data source and query mode, the required software might include database clients, or Java Database Connectivity (JDBC) driver files, or both.

For IBM Cognos Business Intelligence, the query database (also known as the reporting database) is only accessed by the reporting engine that runs reports. The reporting engine is installed with Application Tier Components and is also used by Framework Manager, Metric Designer, and IBM Cognos Transformer.

Dynamic Query Mode

Dynamic query mode provides communication to data sources using Java/XMLA connections.

For supported relational databases, a type 4 JDBC connection is required. A type 4 JDBC driver converts JDBC calls directly into the vendor-specific database protocol. It is written in pure Java and is platform-independent. It offers improved performance over type 2 drivers because it does not have to convert calls to ODBC or database API calls.

For supported OLAP data sources, Java/XMLA connectivity optimizes access by providing customized and enhanced MDX for the specific source and version of your OLAP technology and it harnesses the smarts of the OLAP data source.

You can use the dynamic query mode with the following OLAP data sources:
- IBM Cognos TM1
- IBM Cognos Real-time Monitoring
- SAP Business Information Warehouse (SAP BW)
- Oracle Essbase
- Microsoft Analysis Services

You can use the dynamic query mode for OLAP over relational (dimensionally-modeled relational) models with the following relational data sources:
- IBM DB2
- IBM DB2 for z/OS
- IBM Cognos Real-time Monitoring
Setting up reporting database connectivity on Windows operating systems

To access the relational databases and OLAP data sources for reporting, you must install the client API software that is provided by your data source vendor on the report server.

Procedure

Ensure that you install the database API software for your relational databases and OLAP data sources on the computer that hosts the report server (where Application Tier Components are installed). On Microsoft Windows operating systems, the reporting engine supports either native database connectivity or ODBC.

Results

If Framework Manager is installed in a separate location from the Application Tier Components, you must also install the client API software on the computer where Framework Manager is installed. For more information, see “Data Sources and Framework Manager” on page 230.

Setting up reporting database connectivity on UNIX or Linux operating systems

To use an ODBC data source on UNIX or Linux to connect to a supported data source, you must configure the environment to locate the .odbc.ini file which contains the references to data source, the connectivity libraries, and their accompanying Driver Manager libraries.

To review supported ODBC data sources, see the Supported Environments link at the IBM Cognos Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html).

After configuring for the ODBC connections, you must create connections to the data sources in IBM Cognos Administration. For information, see the IBM Cognos Administration and Security Guide.

If your database vendor does not supply a driver manager, you can use unixODBC or iODBC, depending on your operating system.

On Linux operating systems, the unixODBC package provided with the operating system provides the ODBC Driver Manager. You must install unixODBC version

For more information about the dynamic query mode, see the IBM Cognos Business Intelligence Dynamic Query Guide.

To review an up-to-date list of environments supported by the IBM Cognos Business Intelligence, including the data source versions supported by the dynamic query mode, see http://www-01.ibm.com/support/docview.wss?uid=swg27019126.

Chapter 7. Installing and Configuring IBM Cognos BI Components on One Computer
2.2.11 or later before you can set up data source connections. To verify the version you have installed, use the following command: `odbcinst --version`.

On UNIX operating systems, the open source iODBC driver manager is provided as part of the IBM Cognos installation.

**Procedure**

1. Create an environment variable to specify the location of the `.odbc.ini` file.
   
   For example,
   ```bash
   export ODBCINI=/usr/local/etc/.odbc.ini
   ```

2. Set the appropriate library path environment variable to specify the location of the connectivity libraries and Driver Manager for your database.
   
   The following table lists the environment variables for each operating system that must specify the location of the driver manager libraries.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris and Linux</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

3. If your database vendor does not provide a driver manager, set the library path to include the path of the local driver manager.
   
   - On UNIX, iODBC is provided as part of the IBM Cognos installation. The library files are located in the `c10_location/bin` directory. Your library path should already contain the `c10_location/bin` directory.
     
     For example,
     ```bash
     LIBPATH=/usr/IBM/cognos/bin:$LIBPATH
     ```
   - On Linux, the unixODBC package provides the required driver manager libraries.
     
     For example,
     ```bash
     LD_LIBRARY_PATH=/usr/lib:$LD_LIBRARY_PATH
     ```

**What to do next**

If you are using multiple ODBC sources on UNIX or Linux operating systems, you may encounter dependencies of library files with common names but different implementations for both the connectivity and the driver manager. In a scenario where one ODBC source validates while another fails based on a dependency, please contact Customer Support. Using a common `.odbc.ini` may result in having incompatible entries for different driver managers. To resolve the problem, review the structure requirements between the driver managers you are using and try to use syntax that is common between the conflicting driver managers.

**Setting up reporting connectivity for relational databases to use the dynamic query mode**

To allow the reporting engine to connect to supported relational databases using dynamic query mode, you must install the required Java Database Connectivity (JDBC) driver files, and then either copy them to the IBM Cognos installation directory or specify their location in a properties file.
When connecting to relational databases, the dynamic query mode is intended for use only with OLAP over relational models.

If you copy the driver files to the IBM Cognos installation directory and modify the properties file, the driver files in the IBM Cognos installation directory take precedence over the settings in the properties file.

**Important:** Dynamic query mode requires Java Runtime Environment (JRE) 1.5 or 1.6. You must use the driver files that are provided with the JRE that your relational database uses.

For information about how to set up connectivity to your relational data source provider, see the IBM Cognos 10 Dynamic Query Cookbook in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

**What to do next**

You must also do the following:

- Create data source connections that use JDBC connectivity to the relational databases.
  
  Existing data source connections will not use JDBC connectivity. For more information, see the IBM Cognos Administration and Security Guide.

- Publish packages with the option to use dynamic query mode.
  
  Existing packages will not use dynamic query mode. For more information, see the IBM Cognos Framework Manager User Guide.

**Setting up reporting connectivity for OLAP data sources to use the dynamic query mode**

To allow the reporting engine to connect to supported OLAP data sources using dynamic query mode, you must install the full, or thick, client provided by the OLAP vendor.

For information about how to set up connectivity to your OLAP data source provider, see the IBM Cognos 10 Dynamic Query Cookbook in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

**What to do next**

You must also do the following:

- If you use Oracle Essbase version 11.1.2 on a UNIX or 64-bit Microsoft Windows operating system, you must configure the ARBORPATH and ESSBASEPATH environment variables.

  During the Oracle Essbase client installation, the two environment variables ARBORPATH and ESSBASEPATH are created. IBM Cognos BI uses these variables to find the Oracle Essbase client location. You must install the 64-bit Essbase client provided by Oracle. This 64-bit client includes a 32-bit client that IBM Cognos BI uses. To point to this 32-bit client, you must manually change the ARBORPATH and ESSBASEPATH environment variables to replace EssbaseClient with EssbaseClient-32.
For more information, see the IBM Cognos 10 Dynamic Query Cookbook in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

- If you use Oracle Essbase version 11.1.2 or version 9, you must edit a configuration file to inform the IBM Cognos BI server of your version.

By default, IBM Cognos BI is configured to use Oracle Essbase version 11.1.1. Therefore, no configuration is required if you use this version. If you use another supported version of Oracle Essbase, you must edit the qfs.config.xml file for your version.

In addition, if you use Oracle Essbase version 11.1.2, you must install Oracle Foundation Services as well as the Oracle Essbase client.

For more information, see the IBM Cognos 10 Dynamic Query Cookbook in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

- Create new data source connections to the OLAP data sources.

Existing data source connections will not use dynamic query mode. For more information, see the IBM Cognos Administration and Security Guide.

- Publish packages with the option to use dynamic query mode.

Existing packages will not use the dynamic query mode unless you republish them with the dynamic query mode option. For more information, see the IBM Cognos Framework Manager User Guide.

**Configure IBM Cognos Business Intelligence to use Oracle Essbase**

If you use IBM Cognos Business Intelligence with an Oracle Essbase data source version 11.1.2 or version 9, you must edit a configuration file to inform the IBM Cognos BI server of your version.

By default, IBM Cognos BI is configured to use Oracle Essbase version 11.1.1. Therefore, no configuration is required if you use this version. If you use another supported version of Oracle Essbase, you must edit the qfs.config.xml file for your version.

In addition, if you use Oracle Essbase version 11.1.2, you must install Oracle Foundation Services as well as the Oracle Essbase client.

**Procedure**

1. Go to the c10_location/configuration directory.
2. Open the qfs_config.xml file in an xml or text editor.
3. Locate the following three lines:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO">
   <!--provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO"-->
   ```

4. For Oracle Essbase 11.1.2, change them as follows:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO">
   <provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO">
   ```

5. For Oracle Essbase 11.1.1, ensure that the lines appear as follows:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO">
   <provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO">
   ```

6. For Oracle Essbase 9, change them as follows:
7. Save the file and restart the IBM Cognos service

Using Oracle Essbase on a UNIX or 64-bit Microsoft Windows operating system

If you use an Oracle Essbase version 11.1.2 data source with IBM Cognos Business Intelligence on a UNIX or 64-bit Microsoft Windows operating system, you must manually configure the ARBORPATH and ESSBASEPATH environment variables.

During the Oracle Essbase client installation, the two environment variables ARBORPATH and ESSBASEPATH are created. IBM Cognos BI uses these variables to find the Oracle Essbase client location.

If you use Oracle Essbase version 11.1.2 with IBM Cognos BI on a UNIX or 64-bit Microsoft Windows operating system, you must install the 64-bit Essbase client provided by Oracle. This 64-bit client includes a 32-bit client that IBM Cognos BI uses. To point to this 32-bit client, you must manually change the ARBORPATH and ESSBASEPATH environment variables to replace EssbaseClient with EssbaseClient-32, as follows:

ARBORPATH=C:\Hyperion\EPMSystem11R1\products\Essbase\EssbaseClient-32
ESSBASEPATH=C:\Hyperion\EPMSystem11R1\products\Essbase\EssbaseClient-32

If you use a 32-bit Microsoft Windows operating system with a 32-bit Oracle Essbase client, no configuration is required for these environment variables.

Start IBM Cognos Configuration

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before starting IBM Cognos Configuration, ensure that the operating environment is properly set up. For example, ensure that all environment variables have been set.

On UNIX or Linux operating systems, do not start IBM Cognos Configuration in the last page of the installation wizard. Additional setup is required before you can configure IBM Cognos BI. For example, you must update your Java environment.

On a Microsoft Windows operating system, you can start IBM Cognos Configuration in the last page of the installation wizard only if additional setup is not required. For example, if you use a database server other than Microsoft SQL or Cognos Content Database for the content store, copy the Java Database Connectivity (JDBC) drivers to the appropriate location before you start the configuration tool.

Starting IBM Cognos Configuration (UNIX/Linux)

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.
Before you begin
Ensure that user or service account is set up.

Procedure
1. Go to the $c10_location/bin directory and then type
   
   $./cogconfig.sh
2. If you want to access the help for IBM Cognos Configuration, go to the $c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   
   For example, if you use Firefox, add the following text to the file:
   
   BrowserPath=$Web_browser_location/firefox
   
   where $Web_browser_location is a path, such as /usr/local/bin/
   
   Your Web browser must support the following syntax:
   
   $ <Web_browser_location> <URL>

Starting IBM Cognos Configuration (Windows)
Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin
Ensure that user or service account is set up.

Procedure
1. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
   
   If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and have installed the product to the Program Files (x86) directory, start IBM Cognos Configuration as an Administrator.
2. If you want to access the help for IBM Cognos Configuration, go to the $c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   
   For example, if you use Firefox, add the following text to the file:
   
   BrowserPath=$Web_browser_location/firefox
   
   where $Web_browser_location is a path, such as \usr\local\bin\
   
   Your Web browser must support the following syntax:
   
   $ <Web_browser_location> <URL>

Configure Environment Properties in IBM Cognos Configuration
Specify the server name or an IP address in the URI properties that are used by IBM Cognos Business Intelligence. This will ensure that users in different locations can connect to reports and workspaces that are sent by email. By default, the URI properties specify the localhost.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, change the localhost portion of all URI properties to the name or IP address of your IBM Cognos BI server by doing the following:
   - For Content Manager URIs, click the value and then click the edit button. Change the value and then click OK.
   - For all other URI properties, click the value to change it.
4. In the Explorer window, under Security > Cryptography, click Cognos, the default cryptographic provider.
5. Under the Certificate Authority settings property group, set the Password property.
   Record the password in a secure location.
6. From the File menu, click Save.

### Enable the 64-bit version of report server

In a 64-bit installation, the report server component is provided in both 32-bit and 64-bit versions. The default option is 32-bit. If you want to use the 64-bit version you must enable it using IBM Cognos Configuration.

The 64-bit version of report server is intended for use with packaged with dynamic query mode enabled. For packages that do not use dynamic query mode, you must also have a server installed with the report server running in 32-bit mode.

To enable the 64-bit version, you must have installed the 64-bit version of the Application Tier Components on a 64-bit computer. If you have installed the 32-bit version of the Application Tier Components or are using a 32-bit computer, do not change the report server mode to 64-bit.

**Procedure**
1. In the IBM Cognos Configuration Explorer window, click Environment.
2. Click the Value box for Report server execution mode, and select 64-bit.
3. From the File menu, click Save.

### Enable Security

By default, IBM Cognos Business Intelligence allows anonymous access. If you want to use security in your IBM Cognos BI environment, you must disable anonymous access and configure IBM Cognos BI to use an authentication provider.

**Procedure**
1. In the IBM Cognos Configuration Explorer window, click Security > Authentication > Cognos.
2. Click the Value box for Allow Anonymous Access, and select False.
4. In the Name box, type a name for your authentication namespace.
5. In the Type list, click the appropriate namespace type and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
6. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
7. From the File menu, click Save.
Set Database Connection Properties for the Content Store

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

In a production environment, you must use an enterprise-level database for your content store. If you have been using Cognos Content Database in a test or proof-of-concept system, you can use the features in the administration portal to back up and archive the data before moving to an enterprise-level database in your production environment. For more information, see the topic about deploying the entire content store in the Administration and Security Guide.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, configure IBM Cognos BI to point to a copy of the existing content store database. After you save the configuration and start the IBM Cognos service, the data in the content store is automatically upgraded and cannot be used by the earlier version. By using a copy of the original database with the new version, you can keep ReportNet or the earlier version running with the original data.

Related concepts

"JDBC Driver Options for Using DB2 Database as a Content Store" on page 132
IBM Cognos Business Intelligence uses Java Database Connectivity (JDBC) to access the database used for the content store.

Setting Database Connection Properties for a DB2 Content Store on UNIX, Linux, or Microsoft Windows

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

Procedure

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access > Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   • Click the Value box next to the User ID and password property and then click the edit button when it appears.
   • Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   If you leave this property blank, a type 2 JDBC connection is used.
   For more information about the differences between the driver types, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 132.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

**Setting Database Connection Properties for a DB2 Content Store on z/OS**

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

**Procedure**

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears. Ensure that you specify the same user ID as the value you specified for CMSCRIPT_USERNAME when you created the tablespaces.
   - Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   To connect to DB2 on z/OS, you must use a type 4 JDBC connection.
   For more information about the differences between the driver types, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 132.
6. In the Explorer window, click Local Configuration.
7. In the Properties window, next to Advanced properties, click inside the Value box, and then click the edit button.
   The Value - Advanced properties dialog box appears.
8. To add the parameters that you used to create the tablespaces, click Add.
   All of the parameters except CMSCRIPT_USERNAME are added.
9. From the File menu, click Save.
   The logon credentials are immediately encrypted.
10. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
    This tests the connection between Content Manager and the content store database.

**Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store**

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

**Procedure**

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, right-click Content Store and click Delete.

   This deletes the connection to the default resource. Content Manager can access only one content store.

3. Right-click Content Manager, and then click New resource, Database.

4. In the Name box, type a name for the resource.

5. In the Type box, select the type of database and click OK.

   If you installed more than one version of IBM Cognos BI, you must use a different content store for each version. When a content store is used by a new version of IBM Cognos BI, it cannot be used by an older version.

   **Tip:** If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

6. In the Properties window, provide values depending on your database type:

   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.

     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property.

     For the Database server with port number or instance name property, include the instance name if there are multiple instances of Microsoft SQL Server.

     To connect to a named instance, you must specify the instance name as a Java Database Connectivity (JDBC) URL property or a data source property. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.

     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:

     ```
     jdbc:JSQLConnect://localhost\instance1/user=sa/
     more properties as required
     ```

     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If an instance name is not specified, a connection to the default instance is created.

   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.

   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.

     Here is an example:

     ```
     (description=(address=(host=myhost)(protocol=tcp)(port=1521)
     (connect_data=(sid=(orcl))))))
     ```

     When you select the advanced Oracle database, IBM Cognos BI uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

   - If you use an Informix database, type the appropriate values for the Database server and port number and Database name properties.

   - If you use a Sybase database, type the appropriate values for the Database server and port number and Database name properties.
7. To configure logon credentials, specify a user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.

8. If you host more than one content store database on an Informix instance, create the advanced property CMSCRIPT_CS_ID and specify the account under which the instance runs:
   - In the Explorer window, click Local Configuration.
   - In the Properties window, click the Value column for Advanced properties and then click the edit button.
   - In the Value - Advanced properties dialog box, click Add.
   - In the Name column, type CMSCRIPT_CS_ID
   - In the Value column, type the user ID of the account under which the instance of the content store runs.
     Use a different user account for each instance of Informix content store database.

9. From the File menu, click Save.
   The logon credentials are immediately encrypted.

10. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
    Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

Results

Content Manager can now create the required tables in the content store when you start the IBM Cognos service for the first time. If the connection properties are not specified correctly, you cannot start the IBM Cognos services.

Specify a Connection to a Mail Server Account

If you want to send reports by email, you must configure a connection to a mail server account.

You must also change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name. Otherwise the URL in the email will contain localhost and remote users will not be able to open the report.

Procedure

1. In the Explorer window, under Data Access, click Notification.
2. In the Properties window, for the SMTP mail server property, type the host name and port of your SMTP (outgoing) mail server.

   Tip: To be able to open reports that are sent by email, you must change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name. Otherwise the URL in the email will contain localhost and remote users will not be able to open the report.

   Tip: To be able to open reports that are sent as links, ensure that the Gateway URI on report servers and notification servers specifies an accessible Web
server hosting IBM Cognos content. If you have mobile users accessing links remotely, consider using an external URI.

3. Click the Value box next to the **Account and password** property and then click the edit button when it appears.

4. Type the appropriate values in the **Value - Account and password** dialog box and then click **OK**.

**Tip:** If logon credentials are not required for the SMTP server, remove the default information for the **Account and password** property. When you are prompted for confirmation to leave this property blank, click . Ensure that the default user name has been removed. Otherwise, the default account is used and notifications will not work properly.

5. In the **Properties** window, type the appropriate value for the default sender account.

6. Test the mail server connections. In the **Explorer** window right-click **Notification** and click **Test**.

   IBM Cognos Business Intelligence tests the mail server connection.

**Results**

If you do not plan to send reports by email, or do not want to set up a mail server account immediately, you are not required. However, when you save the configuration and then you start the services in IBM Cognos Configuration, you will see a warning message when the mail server connection is tested. You can safely ignore the warning.

**Start the IBM Cognos services**

To register the IBM Cognos Business Intelligence service so that users can access it through IBM Cognos Connection, you must start the services. Before you start the services, test the configuration by using the test feature in IBM Cognos Configuration.

**Before you begin**

On a Microsoft Windows operating system, the IBM Cognos service is configured to start automatically by default. On UNIX and Linux operating systems, to start the IBM Cognos BI process automatically, you must configure the process as a daemon. For more information, see your operating system documentation.

To use IBM Cognos BI for reporting, you must install and configure the server components, start the IBM Cognos service, and have a package that references an available data source. Note that if you are upgrading, you can continue to use the same data sources.

Before you begin, ensure that a user or service account is set up. For information, see "Configure a User Account or Network Service Account for IBM Cognos Business Intelligence" on page 67.

**Procedure**

1. Start IBM Cognos Configuration.

   If you are upgrading, a message appears indicating that configuration files were detected and upgraded to the new version.
2. Ensure that you save your configuration, otherwise you cannot start the IBM Cognos service.

3. From the **Actions** menu, click **Test**.
   IBM Cognos Configuration checks the common symmetric keys (CSK) availability, tests the namespace configuration, and tests the connections to the content store and logging database.
   If you are using the notification database and the mail server, they are tested as well.

   **Tip:** If **Test** is not available for selection, in the **Explorer** window, click **Local Configuration**.

4. If the test fails, reconfigure the affected properties and then test again.
   You can test some components individually by right-clicking the component in the **Explorer** panel and selecting **Test**.
   Do not start the service until all tests pass.

5. From the **Actions** menu, click **Start**.
   It may take a few minutes for the IBM Cognos service to start.
   This action starts all installed services that are not running and registers the IBM Cognos service on Windows.

---

**Configure the Web Server**

For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal. If you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool. The steps for creating an application pool vary depending on your operating system.

For IBM Cognos BI for reporting, you must also set the content expiry for the images directory in your Web server so that the Web browser does not check image status after the first access.

On UNIX and Linux operating systems, the account under which the Web server runs must have read access to the cogstartup.xml file in the c10_location/configuration directory. By default the cogstartup.xml file has read permission for others. If you run your Web server under a specific group, you can change the cogstartup.xml file permissions to ensure that it belongs to the same group as the Web server. You can then remove the read permission for others.

**Creating Virtual Directories**

For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal.
Procedure

1. Create the virtual directories shown in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias and you must change the virtual directory in the Gateway URI property to match the new IBM Cognos alias.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, you can continue to use the existing aliases. If you install IBM Cognos BI reporting components in a different location from the earlier version, change the existing aliases to include the new location. If you have more than one version of ReportNet or IBM Cognos BI on one computer, you must use different alias names for IBM Cognos BI.

For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. The ibmcognos/cgi-bin alias must be defined as a ScriptAlias.

2. If you want to use the Report Studio image browser, enable Web Distributed Authoring and Versioning (WebDAV) on your Web server.

   If you use Apache Web Server, specify a directory in which to enable WebDAV. For information about configuring WebDAV, see your Web server documentation.

   If you use Microsoft Internet Information Services (IIS), enable the Read and Directory Browsing properties for the URL you want to access.

3. For IBM Cognos BI for reporting, set the content expiry on the c10_location/webcontent/pat/images virtual directory in your Web server.

   Each time a user opens Report Studio, their Web browser checks with the Web server to determine if images are current. Because there are over 600 images, this can result in excess network traffic. You can postpone this check until a specified date by using the content expiry feature of the Web server.

   For information on setting content expiry, see the documentation for your Web server.

   **Note:** When you upgrade, Report Studio users must clear their Web browser cache to get the latest images.

Results

If you use Web aliases other than ibmcognos, or your Web server is on another computer, or you are using Microsoft Internet Application Interface (ISAPI), apache_mod or a servlet gateway, change the Gateway URI when you configure IBM Cognos components.

Creating an Application Pool

If you are using Microsoft IIS as your Web server and you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool.
For more information about creating an application pool, see your Web server documentation.

**Test the Installation and Configuration**

You can test your configuration settings by running the test feature as you configure IBM Cognos Business Intelligence. After you have completed the configuration and started the services, you can test the installation by connecting to the IBM Cognos BI portal.

**Procedure**

1. Open a Web browser.
2. Test that Content Manager is running by typing the **Content Manager URIs** value from IBM Cognos Configuration. For example,
   
   `http://host_name:port/p2pd/servlet`
   
   The default value for `host_name:port` is localhost:9300.
3. Test the availability of the dispatcher by typing the **Internal dispatcher URI** value from IBM Cognos Configuration. For example,
   
   `http://host_name:port/p2pd/servlet/dispatch`
   
   The default value for `host_name:port` is localhost:9300.
   
   If the response shows a list of content in **Public Folders**, the dispatcher is available.
4. Test the gateway by typing the **Gateway URI** value from IBM Cognos Configuration in your Web browser.
   
   It may take a few minutes for the Web page to open. If you see the **Welcome** page in the IBM Cognos BI portal, your installation is working.

**Set Up the Data Source or Import Source Environment**

Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for Framework Manager or IBM Cognos BI Transformer or set up the import source environment for Metric Designer. Commonly, these things depend on the other technology you use for your data or import source.

The IBM Cognos Business Intelligence modeling tools create and manage metadata for IBM Cognos BI. Framework Manager creates and manages metadata for the reporting functions, IBM Cognos BI Transformer creates and manages metadata for PowerCubes, and Metric Designer creates and manages metadata required for the scorecarding functions.

If you upgraded, you are not required to set up anything in the data source environment. You must set up the data source environment only if you installed your modeling tool in a different location from the older version.

If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) 2000 data source, you must create a separate IBM Cognos BI instance for each language.

Users operating in different languages can connect to an MSAS 2005 data source from the same instance of IBM Cognos BI. Modelers must create a separate package for each language. Users can run reports in any language.
Set Up the Data Source or Import Source Environment

Use this procedure to set up the data source environment for Framework Manager or IBM Cognos Transformer or to set up the import source environment for Metric Designer.

If you use a Sybase data source, these steps are not necessary.

Before you begin

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk.

Procedure

1. Set the environment variable for multilingual support:
   - For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager or Metric Designer and the IBM Cognos BI server are installed by typing the following command:
     \[ NLS_LANG = language\_territory\_character\_set \]
     Examples are:
     \[ NLS_LANG = AMERICAN\_AMERICA.UTF8 \]
     \[ NLS_LANG = JAPANESE\_JAPAN.UTF8 \]
     The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
   - For DB2, set the DB2CODEPAGE environment variable to a value of 1252.
     For more information about whether to use this optional environment variable, see the DB2 documentation.

2. For Oracle, add $ORACLE_HOME/lib to your LD_LIBRARY_PATH.
   When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For Oracle, copy the correct library file for your version of the Oracle client from ORACLE_HOME/jdbc/lib to the c10_location\webapps\p2pd\WEB-INF\lib directory.
   If you are using Oracle 10g, you must have ojdbc14.jar.
   If you are using Oracle 11g, you must have ojdbc5.jar.

4. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.
   Where default values are specified, you may want to modify the values on the SAP system.
   - S_RFC
     Set the Activity field to the value: 16
     Set the Name of RFC to be protected field to the value: SYST, RSOB, SUGU, RFC1, RS\_UNIFICATION, RSAB, SDTX, SU\_USER
     Set the Type of RFC object to be protected field to the value: FUGR
• **S_TABU_DIS**
  Set the Activity field to the value: 03
  Set the Authorization Group field to the value: &NC&

  **Note:** &NC& represents any table that does not have an authorization group. For security reasons, create a new authorization group and assign the table RSHIEDIR to it. The new authorization group restricts the user's access to the above table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

• **S_USER_GRP**
  Set the Activity field to the value: 03, 05
  Set the User group in user master main field to the default value.

• **S_RS_COMP**
  Set the Activity field to the default value.
  Set the Info Area field to the value: InfoArea Technical Name
  Set the Info Cube field to the value: InfoCube Technical Name
  Set the Name (ID) of reporting components field to the default value.
  Set the Type of reporting components field to the default value.

• **S_RS_COMP1**
  Set the Activity field to the default value.
  Set the Name (ID) of reporting components field to the default value.
  Set the Type of reporting components field to the default value.
  Set the Owner (Person Responsible) field to the default value.

• **S_RS_HIER**
  Set the Activity field to the value: 71
  Set the Hierarchy Name field to the value: Hierarchy Name
  Set the InfoObject field to the value: InfoObject Technical Name
  Set the Version field to the value: Hierarchy Version

• **S_RS_ICUBE**
  Set the Activity field to the value: 03
  Set the InfoCube sub-object field to the values: DATA and DEFINITION
  Set the Info Area field to the value: InfoArea Technical Name
  Set the InfoCube field to the value: InfoCube Technical Name

For more information about SAP BW authorization objects, see Transaction SU03.

**Results**

After you complete these tasks, you must configure the IBM Cognos BI components (see Chapter 13, “Configuration Options,” on page 347) to work in your environment.

**Create the Metric Store Database**

You must create a metric store database using Oracle, Microsoft SQL Server, or DB2.

A metric store is a database that contains content for metric packages. A metric store also contains scorecarding application settings, such as user preferences.
Although you run the command to create the metric store from the location where the Application Tier Components are installed, you can specify a different location for the metric store in the command parameters. If the metric store is on a different computer from the Application Tier Components, you must create an alias to the metric store in the Application Tier Components location.

You cannot use Cognos Content Database as a metric store database.

Your database administrator must back up IBM Cognos Business Intelligence databases regularly because they contain the IBM Cognos data. To ensure the security and integrity of databases, it is also important to protect them from unauthorized or inappropriate access.

**Create a DB2 Metric Store Database**

Use this procedure to create a metric store using a DB2 database.

**Procedure**

1. In the Application Tier Components location, in the `c10_location/configuration/schemas/cmm/db2` directory, run the `cmm_create_db.cmd` script by typing the following command:
   - On a Microsoft Windows operating system, type
     
     ```
     cmm_create_db dbinstance user_name password dbname drive dbalias
     ```
   - On a UNIX operating system, type
     
     ```
     cmm_create_db.sh dbinstance user_name password dbname drive dbalias
     ```
   
   Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbinstance</td>
<td>The DB2 instance name where the database will be created.</td>
</tr>
<tr>
<td>user_name</td>
<td>The user ID with permissions to create the database. The user ID must have SYSADM or SYSCTRL privileges, and must have DBADM privileges to create the schema.</td>
</tr>
<tr>
<td>password</td>
<td>The password for the <code>username</code>.</td>
</tr>
<tr>
<td>dbname</td>
<td>The name of the database that will be created. The name must have a maximum of 8 characters, and it cannot start with a number.</td>
</tr>
<tr>
<td>drive/path</td>
<td>On Windows, the drive on which the database objects will be created. On UNIX, the path where the database objects will be created.</td>
</tr>
<tr>
<td>dbalias</td>
<td>The database alias name. This value is optional.</td>
</tr>
</tbody>
</table>

2. Determine which user account IBM Cognos Metrics Manager will use to access the database.

   The user account must have the following privileges:
   - CREATETAB
   - BINDADD
   - CONNECT
   - IMPLICIT_SCHEMA

   **Note:** Your database administrator can review the scripts to ensure they suit your environment. The `initializedb.db2` script is invoked by the `cmm_create_db.cmd` script and defines the buffer pools and tablespaces.
Create a Microsoft SQL Server Metric Store Database

Use this procedure to create a metric store using a Microsoft SQL Server database.

Procedure

1. Determine which user account IBM Cognos Metrics Manager will use to access the database.
   This information is one of the parameters you can use when you run the command to create the database. The user account must be the database owner (dbo) or aliased to the database owner.

2. In the Application Tier Components location, in the $c10_location/configuration/schemas/cmm/sqlserver$ directory, run the cmm_create_db.cmd script by typing the following command:

   \[\text{path_to_script} \text{cmm_create_db} \text{host_name} \text{database_name} \text{user_name} \text{password} \text{[user_to_create]}\]

   Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>host_name</td>
<td>The name of the computer where the database will be created.</td>
</tr>
<tr>
<td></td>
<td>If there are multiple instances of Microsoft SQL Server, specify [host_name]instance_name.</td>
</tr>
<tr>
<td>database_name</td>
<td>The name of the database that will be created.</td>
</tr>
<tr>
<td>user_name</td>
<td>The user ID with permissions to create the database. The user ID must have permission to create the database, such as the sa user. The user ID must also have a default language of English.</td>
</tr>
<tr>
<td>password</td>
<td>The password for the username.</td>
</tr>
<tr>
<td>user_to_create</td>
<td>The user created by the script and given database owner permissions. This value is optional.</td>
</tr>
</tbody>
</table>

Create an Oracle Metric Store Using a New Database

Use this procedure to create a metric store using a new Oracle database.

Procedure

1. Ensure that you are logged into the Oracle server as a user that is a member of the ORA_DBA user group on Windows or the dba group on UNIX.

2. Set the NLS_LANG (National Language Support) environment variable to the UTF-8 character set on the metric store computer by typing the following command:

   \[\text{NLS_LANG} = \text{language_territory.character_set}\]

   Examples are:
   \begin{itemize}
   \item \text{NLS_LANG} = \text{AMERICAN_AMERICA.UTF8}
   \item \text{NLS_LANG} = \text{JAPANESE_JAPAN.UTF8}
   \end{itemize}

   The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
3. Determine which user account IBM Cognos Metrics Manager will use to access the database.
   This information is one of the parameters you can use when you run the command to create the database. You must use a valid Oracle database username with the following permissions granted:
   - CREATE TABLE, CREATE VIEW, CREATE PROCEDURE, CREATE TRIGGER, CREATE TYPE, CREATE SEQUENCE, and CREATE SESSION
   - EXECUTE on DBMS_LOCK and DBMS_UTILITY packages
   The CREATE TABLE and CREATE TRIGGER permissions must be granted directly to the user account rather than to a role.
   You must grant these permissions only. If you grant fewer or more privileges than specified above, the metric store will not initialize.

4. In the Application Tier Components location, in the `c10_location/configuration/schemas/cmm/oracle` directory, run the `cmm_create_db.cmd` script by typing the following command:

   `path_to_script cmm_create_db sid path database_version [user_to_create]`

   Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>path_to_script</td>
<td>The path to the script. For example, c10_location/configuration/schemas/cmm/oracle/</td>
</tr>
<tr>
<td>sid</td>
<td>The SID for the new database that will be created.</td>
</tr>
<tr>
<td>path</td>
<td>The path where the data files will be created.</td>
</tr>
<tr>
<td>database_version</td>
<td>The version of Oracle software that is installed. For example, oracle9 or oracle10.</td>
</tr>
<tr>
<td>user_to_create</td>
<td>The user created by the script and given database owner permissions. This value is optional.</td>
</tr>
</tbody>
</table>

Create an Oracle Metric Store Using an Existing Database

Use this procedure to create a metric store using an existing Oracle database.

**Procedure**

1. Ensure that you are logged into the Oracle server as a user that is a member of the ORA_DBA user group on Windows or the dba group on UNIX.
2. Set the NLS_LANG (National Language Support) environment variable to the UTF-8 character set on the metric store computer by typing the following command:

   `NLS_LANG = language_territory.character_set`

   Examples are:
   - `NLS_LANG = AMERICAN_AMERICA.UTF8`
   - `NLS_LANG = JAPANESE_JAPAN.UTF8`

   The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
3. Determine which user account IBM Cognos Metrics Manager will use to access the database. You must use a valid Oracle database username with the following permissions granted:
   • CREATE TABLE, CREATE VIEW, CREATE PROCEDURE, CREATE TRIGGER, CREATE TYPE, CREATE SEQUENCE, and CREATE SESSION
   • EXECUTE on DBMS_LOCK and DBMS_UTILITY packages.
   The CREATE TABLE and CREATE TRIGGER permissions must be granted directly to the user account rather than to a role.
   You must grant these permissions only. If you grant fewer or more privileges than specified above, the metric store will not initialize.

4. Determine if the database is Unicode.
   Tip: One method is to type the following select statement:
   ```sql
   select * from NLS_DATABASE_PARAMETERS
   ```
   If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database and specify AL32UTF8 for the database character set parameters.
   The `cmm_create_db.cmd` script mentioned in “Create a DB2 Metric Store Database” on page 156 creates a database with AL32UTF8 character encoding.

---

### Set Up the Database Client for the Metric Store

If you are using a database other than Microsoft SQL as a metric store, you must install database client software and Java Database Connectivity (JDBC) drivers on each computer where you install the Application Tier Components for Cognos Metrics Manager. Doing this allows Application Tier Components to access the metric store database.

### Set Up the Database Client for a DB2 Metric Store

Use this procedure to set up the database client for a DB2 metric store.

**Procedure**

1. Install the DB2 client software on the Application Tier Components computer.
2. If the metric store is on a different computer from the Application Tier Components, configure a database alias to the metric store by running the DB2 Client Configuration Assistant.
   - On a UNIX or Linux operating system, use the DB2 command line interface.
   - **Note:** If the metric store database and the Application Tier Components are on the same computer, the metric store name automatically becomes the alias.
3. Copy the following files from `DB2_installation/sqlib/java` directory to the `c10_location/webapps/p2pd/WEB-INF/lib` directory.
   - the universal driver file, `db2jcc.jar`
   - the license file
     - for DB2 on Linux, UNIX, or Microsoft Windows operating systems, `db2jcc_license_cu.jar`
     - for DB2 on a z/OS operating system, `db2jcc_license_zisuz.jar`
   If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.
   **Tip:** To check the driver version, run the following command
   ```sh
   java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version
   ```
   If the directory contains a `db2java.jar` or `db2java.zip` file, delete the file.
Set Up the Database Client for an Oracle Metric Store

Use this procedure to setup the database client for an Oracle metric store.

**Procedure**

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.
2. Copy the correct library file for your version of the Oracle client to the c10_location\webapps\p2pd\WEB-INF\lib directory on the computer where Application Tier Components are installed.
   - If you are using Oracle 10g, you must have ojdbc14.jar.
   - If you are using Oracle 11g, you must have ojdbc5.jar.
   - The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.
3. Install the SQL Loader utility on the computer where Application Tier Components are installed.

Set Up the Database Client for a Microsoft SQL Server Metric Store

Use this procedure to setup the database client for a Microsoft SQL Server metric store.

**Procedure**

1. Install the bcp utility on every Windows computer where Application Tier Components for IBM Cognos Metrics Manager are installed.
2. Add the location of the bcp utility to the path environment variable.

Create a Metric Package

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

A metric package is an IBM Cognos Connection representation of an IBM Cognos Metrics Manager application. A metric package contains connection information, reports, and metric management tasks for that application. The metric package content is stored in a metric store.

Before you can use the New Metric Package wizard, you must have access to a metric store used with Metrics Manager version 2.0 or later or you must create a database for a new metric store. For data to be transferred successfully, the user account that is used to access the database must have a default language of English.

You open the New Metric Package wizard from the toolbar in IBM Cognos Connection and create a metric package using one of the following:

- a new data source connection to a metric store
- an existing data source connection to a metric store
- an existing metric store if the database was used with an earlier version of IBM Cognos Metrics Manager 8.1 or later
Use the wizard to define the metric package name and the data source connection to the metric store. For a new metric store, you also provide the information necessary to initialize the database, including the start and end dates of the fiscal year.

Create a Metric Package Using a New Data Source Connection

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

Before you begin

Before you can use the New Metric Package wizard, you must have access to a metric store used with Metrics Manager version 2.0 or later or you must create a database for a new metric store. For data to be transferred successfully, the user account that is used to access the database must have a default language of English.

Procedure

1. Open IBM Cognos Connection by connecting to the IBM Cognos Business Intelligence portal and clicking IBM Cognos Content on the Welcome page.

2. Click the New metric package button.

3. Type a name and description for the IBM Cognos Metrics Manager application to represent this metric package, and click Next.

4. Click New data source.

5. Type a name and description for the data source connection for the metric store that contains the content for this metric package, and click Next.

6. In the Type box, click the database type.

7. Select the isolation level, and click Next.

8. Specify the information required for your database type and click Finish.

   • For a Microsoft SQL Server database, type the name of the database server using the syntax server\name or server\name\instance\name (if there are multiple instances of Microsoft SQL Server) or server\name:port (if using non-default ports). Type the database name. Select Signons, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

   The user account must have the default language set to English.

   • For an Oracle database, type the connection string. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

   • For a DB2 database, type the name of the database as defined in the DB2 client. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

   The default configuration of the data source connection uses a Type 2 Java Database Connectivity (JDBC) connection. To configure Metrics Manager to use a Type 4 JDBC connection, set the connection string property to JDBC_TYPE4_INFO=host:port/dbName
where host is the name of the server where the DB2 server is installed, port is the what the DB2 server uses to accept client connections, and dbName is the name of the database as defined on the database server.

In most cases, a collation sequence is not required. If you want to provide one, ensure the value you enter is the same as the collation sequence specified when the database was created. For information about collation sequences, see the database documentation.

**Tip:** To test whether the parameters are correct, click **Test the connection**.

9. Click the new data source and click **Next**.

10. Click **Next** and follow the prompts to provide the information necessary to initialize the database. When you see the page that summarizes the data source details and the metric store settings, click **Initialize**.

11. Select **Open this package with Metric Studio after closing the wizard** and then click **Finish**.

**Results**

Metric Studio opens and the new metric package is displayed in IBM Cognos Connection. For information about managing the metric store, including how to load data, see the IBM Cognos BI Administration and Security Guide.

### Create a Metric Package Using an Existing Data Source

**Connection**

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

**Procedure**

1. Open IBM Cognos Connection by connecting to the IBM Cognos BI portal and clicking **IBM Cognos Content** on the **Welcome** page.

2. Click the **New metric package** button.

3. Type a name and description for the IBM Cognos Metrics Manager application to represent this metric package, and click **Next**.

4. Click **New data source** and click **Next**.

5. Click **Next** and follow the prompts to provide the information necessary to initialize the database. When you see the page that summarizes the data source details and the metric store settings, click **Initialize**.

6. Select **Open this package with Metric Studio after closing the wizard** and then click **Finish**.

**Results**

Metric Studio opens and the new metric package is displayed in IBM Cognos Connection. For information about managing the metric store, including how to load data, see the IBM Cognos BI Administration and Security Guide.

### Create a Metric Package Using an Existing Metric Store

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.
Procedure

1. Open IBM Cognos Connection by connecting to the IBM Cognos BI portal and clicking IBM Cognos Content on the Welcome page.

2. Click the New metric package button.

3. Type the name and description for the IBM Cognos Metrics Manager application to represent this metric package and click Next.

4. Click New data source.

5. Type the name and description for the data source connection for the metric store that contains the content for this metric package, and click Next.

6. In the Type box, click the database type and click Next.

7. Specify the information required for your database type:

   - For a Microsoft SQL Server database, type the name of the database server using the syntax server_name or server_name\instance_name (if there are multiple instances of Microsoft SQL Server) or server_name.port (if using non-default ports). Type the database name. Select Signons, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

     The user account must have the default language set to English.

   - For an Oracle database, type the connection string. Under User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

   - For a DB2 database, type the name of the database and the connection string. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

     In most cases, a collation sequence is not required. If you want to provide one, ensure the value you enter is the same as the collation sequence specified when the database was created. For information about collation sequences, see the database documentation.

     Tip: To test whether the parameters are correct, click Test the connection.

8. Click Next.

9. Select Open this package with Metric Studio after closing the wizard and then click Finish.

    Metric Studio opens and the new metric package is displayed in IBM Cognos Connection.

10. Click the new data source and click Next.

11. Click Upgrade.

    The wizard updates the database schemas and other information.

Results

For information about managing the metric store, see the Administration and Security Guide.
Chapter 8. Installing IBM Cognos BI Server Components on Different Computers

Use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. Only the components that you choose to install are copied from the disk to your computer. If you plan to install two or more IBM Cognos Business Intelligence components on the same computer, install them in the same installation location to avoid conflicts among ports and other default settings.

The IBM Cognos BI server components include the following:

- Content Manager
- Application Tier Components
- Gateway

You can install each component on a separate computer, or on the same computer. You must install the gateway on a computer that is also running a Web server.

If you are installing IBM Cognos Metrics Manager, you must create the metric store database (see “Create the Metric Store Database” on page 206) and at least one metric package (see “Create a Metric Package” on page 212). Next, you must install the client components Chapter 9, “Install and Configure Modeling Tools for Reporting and Scorecarding,” on page 227. For uninstalling instructions, see Chapter 20, “Uninstalling IBM Cognos BI,” on page 497.

Application samples for your IBM Cognos BI product are on a separate disk. If you want to use the samples, you must install them from the IBM Cognos Business Intelligence Samples disk.

**Stopping Services Sequence**

If you need to stop services in a distributed environment, the sequence is important. Stop the IBM Cognos service for Application Tier Components first, followed by the standby Content Manager, and then the active Content Manager.

It is important to also stop the following:

- Web servers that host IBM Cognos BI content
- applications that are related to the IBM Cognos service, such as Framework Manager, IBM Cognos Transformer, IBM Cognos Connection, IBM Cognos Administration, and Metric Designer
- any Software Development Kit applications that are running

**Upgrading your installation**

If you are upgrading from a previous release of IBM Cognos products, you must use the upgrading steps. For information about upgrading from ReportNet or Metrics Manager, see Chapter 6, “Upgrading to IBM Cognos Business Intelligence,” on page 73.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, all the distributed components must be the same version of IBM Cognos BI. If you
install IBM Cognos BI on additional or alternate hosts, you must update location-specific properties in IBM Cognos Configuration.

64-bit Installations

The IBM Cognos BI gateway provides 32-bit libraries, whether you install on a 64-bit server or a 32-bit server. Some Web servers, such as Apache Web Server, cannot load a 32-bit compiled library in a 64-bit compiled server. In that situation, install the 32-bit version of the IBM Cognos gateway on a 32-bit Web server.

The report server component, included with the Application Tier Components, is provided in both 32- and 64-bit versions. Selecting which version you use is done using IBM Cognos Configuration after installation. By default, the report server component is set to use the 32-bit mode, even on a 64-bit computer. The 32-bit mode allows you to run all reports, whereas the 64-bit mode allows you to run only reports created for dynamic query mode.

If you are upgrading IBM Cognos BI in an environment that includes earlier versions of other IBM Cognos BI products, such as IBM Cognos BI Controller Version 8.x, IBM Cognos BI Planning Version 8.x, or IBM Cognos BI Analysis for Microsoft Excel Version 8.x, install the new version of IBM Cognos BI in a separate location from the other IBM Cognos BI product and configure the new version of IBM Cognos BI to operate independently of that product. After you upgrade the other product to a compatible version with IBM Cognos BI, you can then configure the two products to operate together.

Windows Installations

For Microsoft Windows operating system installations, ensure that you have administrator privileges for the Windows computer you are installing on. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files from the disk are temporarily copied to this directory.

UNIX Installations

For UNIX operating system installations, you can install server components using a graphical user interface or by running a silent installation. To run graphical-mode installation, the console attached to your UNIX computer must support a Java-based graphical user interface.

Also, IBM Cognos BI respects the file mode creation mask (umask) of the account running the installation program. This affects only the installation directories. It does not affect the file permissions within the directories. However, run-time generated files, such as logs, respect the mask. Use umask 022 on the installation directory.

Cognos Content Database as Content Store

If you want to use Cognos Content Database as your content store, you must select it in the installation wizard. If you are installing components on several computers, you need to only install Cognos Content Database once.
Installation Sequence for Server Components

In a distributed installation, the sequence in which you configure components is important. Configure and start the services in at least one location where you installed Content Manager before you configure other server components.

You must configure the gateway component last so that cryptographic keys are shared and secure communication can take place among the three components. The server specified for the external dispatcher URI property on the gateway computer must be the last server component that you start.

We recommend that you install and configure all server components before you install Microsoft Windows operating system components.

The following diagram shows the sequence of the installation process for distributed components. After planning and preparing your environment, install and configure Content Manager components, then Application Tier Components and then gateways. After server components are installed, you install and configure Framework Manager.

The sequence to stop services is also important. Stop the Application Tier Components first, followed by the standby Content Manager, and then the active Content Manager.

Recommendation - Install and Configure the Basic Installation for Distributed Installations

When you do a distributed installation, there are many different installation and configuration options that you can do to customize IBM Cognos BI so that it fits into your corporate infrastructure.

Do a basic installation first, which involves installing one or more instances of each of the required server components (gateway, Application Tier Components and Content Manager) and installing Framework Manager. Perform only the required configuration tasks, such as configuring distributed components to communicate with each other, to get your distributed environment running before you customize your settings.
Later, you can add optional components and customize your configuration settings to better suit your business intelligence needs.

The sequence in which you configure computers is important. You must configure and then start the services on at least one computer where you installed Content Manager before you configure other server components or Framework Manager. For more information, see “Installation Sequence for Server Components” on page 167.

The simplest and quickest way to get IBM Cognos BI running in your environment is ensuring that a basic installation works in your environment.

### Install Server Components in Interactive Mode

For a complete installation, you must install components on your server and then configure them to work in your environment.

Typically, you run the IBM Cognos installation and configuration programs in interactive mode. This means that in a graphical user interface (GUI) the installer prompts you to provide information, and the configuration tool enables you to change default settings.

You can choose to install server components in silent mode.

**Silent Mode**

You can automate the installation of components using response files and running the installation program in silent mode.

You can automate the configuration of components by exporting the configuration settings from one computer to another as long as the installed components are the same. Run IBM Cognos Configuration in interactive mode the first time.

The other option is to edit the cogstartup.xml file, using settings that apply to your environment, and then running the configuration tool in silent mode.

**Interactive Mode**

Unless you intend to complete a silent-mode installation, install the software from an X Window System workstation, an X terminal, or a PC or other system with X server software installed.

To run an interactive-mode installation, the console attached to your computer must support a Java-based graphical user interface.

### Installing and Configuring Content Manager

You can install more than one Content Manager to ensure failover, and you can install Content Manager in a separate location than other components to enhance performance.

The Content Manager computers must know the location of the content store, the location of other Content Manager components, and the database that is used for notification.
In a distributed installation, at least one of the computers where you install Content Manager must be configured, running and accessible before you configure other computers in your IBM Cognos environment. This ensures that the certificate authority service, which is installed with Content Manager, is available to issue certificates to other computers.

Your installation may include more than one Content Manager, each on a different computer. One Content Manager computer is active and one or more Content Manager computers are on standby.

Permissions

You can install using either root or non-root authority.

Also, IBM CognosBI respects the file mode creation mask (umask) of the account running the installation program. This affects only the installation directories. It does not affect the file permissions within the directories. However, run-time generated files, such as logs, respect the mask. We recommend umask 022 on the installation directory.

Rules for Configuring

In an installation where you have more than one Content Manager components, or where Content Manager is located in a separate location, at least one of the one Content Manager must be configured, running and accessible before you configure other components in your environment. This ensures that the certificate authority service, which is installed with Content Manager, is available to issue certificates to other IBM Cognos computers.

For information about the sequence of the installation process for distributed components, see “Installation Sequence for Server Components” on page 167.

Rules for Active Content Manager

If you are installing multiple Content Manager components, the first Content Manager computer that you start becomes the default active Content Manager. You can designate another Content Manager computer as default active, using IBM Cognos Administration.

The standby Content Manager computers are for failover protection. If the active Content Manager computer is not available because of a software or hardware failure, a standby Content Manager computer becomes active and requests are directed to it.

When the active Content Manager fails, unsaved session data is lost. When another Content Manager becomes active, users may be prompted to log on.

For information about activating a Content Manager service, see the Administration and Security Guide. For information about active and standby Content Manager components, see “Active and Standby Content Manager Components” on page 170.

In installations with multiple Content Managers, configure IBM Cognos BI to use compiled gateways instead of the default CGI gateway. For example, use Apache Module for Apache Server or for IBM HTTP Server, or use ISAPI for IIS. Otherwise, performance may be affected after failover.
Upgrading

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, you can use the existing configuration data. However, some features in IBM Cognos BI are new and may require configuration.

PowerCubes

If you plan to install IBM Cognos Transformer and you will be using PowerCubes that are secured against an IBM Cognos Series 7 namespace, you must install Content Manager on a computer that supports IBM Cognos Series 7.

Active and Standby Content Manager Components

You can install any number of installations of Content Manager, although only one is active at any time. The other installations each act as a standby Content Manager.

The standby Content Manager components are for failover protection. If the active Content Manager is not available because of a software or hardware failure, a standby Content Manager becomes active and requests are directed to it.

When the active Content Manager fails, unsaved session data is lost. When another Content Manager becomes active, users may be prompted to log on.

By default, the first Content Manager installed with IBM Cognos BI is the active one. A IBM Cognos BI server administrator can change the default Content Manager and the active Content Manager at any time. When IBM Cognos BI is started, the default Content Manager locks the content store from access by all other installations of Content Manager. These other Content Manager installations enter standby mode.

This failover mechanism works because dispatchers and the active Content Manager routinely communicate with each other. If a dispatcher can no longer reach Content Manager, the dispatcher signals a standby Content Manager, which becomes the active Content Manager. The other installations of Content Manager remain in standby mode for continuing failover support. The standby Content Managers retrieve cryptographic settings, such as the common symmetric key (used to encrypt and decrypt data), from the active Content Manager.

Install the Content Manager Components

To install Content Manager, use the disk for your operating system. In the installation wizard, clear all components except Content Manager.

If you want to use Cognos Content Database, select that component too unless you want to install it on a separate server.

If you are installing multiple Content Managers, you must ensure that the system clocks on the Content Manager computers are synchronized for successful failover between Content Managers.

Cognos Content Database:

If you want to use the Cognos Content Database as your content store, must select it in the installation wizard. If you are installing components on several computers, you need to only install Cognos Content Database once.
Installing Content Manager on UNIX or Linux

Use the following procedure to install Content Manager on a UNIX or Linux operating system.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Set the JAVA_HOME environment variable to point to the installation location of your Java Runtime Environment (JRE).
   An example of the installation location of a Java Runtime Environment is 
   /directory/java/java_version/jre.
   IBM Cognos BI requires a JVM, such as the Java that is provided by IBM, to run on a Linux operating system.
   If you are installing in a location with other IBM Cognos BI components, use the existing JAVA_HOME environment variable.
3. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:
   _M_ARENA_OPTS 1:4
   This increases the memory allocation for HP-UX to more closely match that of other UNIX operating systems.
4. On AIX, set the AIXTHREAD_SCOPE environment variable as follows:
   AIXTHREAD_SCOPE=S
   This sets the contention scope for user threads to system-wide, which supports more efficient scheduling of user threads.
5. If installing from a download, go to the location where the installation files were downloaded and extracted.
6. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   • Add the pfs_mount directory in your path.
     For example,
     PATH=/usr/sbin/:$PATH
     export PATH
   • To start the required NFS daemons and run the daemons in the background, type bg pfs_mountd and then type bg pfsg
   • To mount the drive, type
     pfs_mount -t rrip <device><mount_dir> -o xlat=unix
     For example,
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   • When the installation is complete, type pfs_umount /cdrom and kill the pfsg and pfs_mountd daemons to unmount the disk.
7. To start the installation wizard, go to the operating system directory and then type
   ./issetup

Note: When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in
Japanese on UNIX or Linux, first set environment variables LANG=C and LC_ALL=C (where C is the language code, for example ja_JP.PCK on Solaris), and then start the installation wizard.


Follow the directions in the installation wizard and copy the required files to your computer.

- When selecting the directory, consider the following:
  - Install Content Manager in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.
  - If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.
  - If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
  - When selecting components, clear all components except Content Manager.
  - If you want to use the pre configured database, also select Cognos Content Database.

In the Finish page of the installation wizard, do the following:

- If you want to see the log files, click View for the appropriate log file.
- If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
- Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
  - You can later configure IBM Cognos BI using IBM Cognos Configuration by typing cogconfig.sh in the c10_location/bin directory, or by running a silent configuration or editing cogstartup.xml in c10_location/configuration directory.
- Click Finish.

Append the c10_location/bin directory to the appropriate library path environment variable.

- For Solaris and Linux, LD_LIBRARY_PATH
- For AIX, LIBPATH
- For HP-UX, SHLIB_PATH

On Linux, set the PRINTER environment variable to the name of your printer.

**Results**

If you want to install Cognos Content Database on a separate computer, run the installation wizard on your database server and select only the Cognos Content Database component.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation in the same location as the Gateway components. For more information, see “Translated Product Documentation” on page 293.
Installing Content Manager on Windows

Use the following procedure to install Content Manager on a Microsoft Windows operating system.

For Windows Vista, Windows 7, or Windows 2008 computers, the default installation location uses the Program Files (x86) directory. If you install to this location, ensure that you run IBM Cognos Configuration as an Administrator. Alternatively, you can install the product outside of the Program Files (x86) directory. For example, you can change the installation directory to something like C:\IBM\cognos\c10.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.

2. Do one of the following:
   - Insert the IBM Cognos product disk.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.

4. Follow the directions in the installation wizard to copy the required files to your computer.
   - When selecting the directory, consider the following:
     Install Content Manager in a directory that contains only ASCII characters in the path name. Some Microsoft Windows operating system Web servers do not support non-ASCII characters in directory names.
     If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.
     If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
   - When selecting components, clear all components except Content Manager.
     If you want to use the pre configured database, also select Cognos Content Database.

5. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
     You can later configure IBM Cognos BI using the Windows Start menu to start IBM Cognos Configuration from the shortcut folder.
   - Click Finish.
Results

If you want to install Cognos Content Database on a separate computer, run the installation wizard on your database server and select only the Cognos Content Database component.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation in the same location as the Gateway components. For more information, see “Translated Product Documentation” on page 293.

Install Cognos Content Database on a Separate Server

If you want to install Cognos Content Database on a separate server, you must do so before you configure Content Manager. In the installation wizard, clear all components and select only Cognos Content Database.

Procedure

1. On your database server, insert the disk for your IBM Cognos product.
   
   On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.

2. If the Welcome page does not appear, start the installation wizard:
   
   - On UNIX or Linux, from the directory for your operating system, type ./issetup
   
   - On a Microsoft Windows operating system, in the win32 directory on the disk, double-click issetup.exe.

3. Follow the directions in the installation wizard and copy the required files to your computer.
   
   Install in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

   When selecting the components, clear all components and then select Cognos Content Database.

4. In the Finish page of the installation wizard, click Finish.

Install Content Manager for IBM Cognos Metrics Manager

If you are installing IBM Cognos Metrics Manager with the IBM Cognos BI server and you want to share resources, it is not necessary to install Content Manager from the IBM Cognos Metrics Manager disk. Your scorecarding product can use the same Content Manager that is installed for the IBM Cognos BI server. If you want your scorecarding product to operate independently of the IBM Cognos BI server, install Content Manager for IBM Cognos Metrics Manager in a different location from Content Manager for the IBM Cognos BI server.

You may also want to install Metric Designer (see “Installing and Configuring Metric Designer” on page 235).

IBM Cognos Metrics Manager and 64-bit Systems

IBM Cognos Metrics Manager is only available in a 32-bit version. You must install it on a 32-bit system or, if sharing resources with IBM Cognos BI server, in a separate directory on a 64-bit system.
When sharing resources with the IBM Cognos BI server, it is not necessary to install Content Manager from the IBM Cognos Metrics Manager disk.

**Installing Fix Packs**

IBM provides interim maintenance packages that contain updates to one or more components in your IBM Cognos product. If a fix pack is available when you are installing or upgrading your product, you must install it after you install the IBM Cognos components.

If a fix pack becomes available after your IBM Cognos product has been deployed, you must stop the service, install the fix pack in the same location as the IBM Cognos components, and then start the service.

Fix packs are cumulative. When you install the latest fix pack, it includes updates from all the previous fix packs. Fix packs are available for download from IBM Support at [http://www.ibm.com/support/us/en/](http://www.ibm.com/support/us/en/)

**Note:** Fix packs are not standalone installations. You must install them on computers that have IBM Cognos components installed. Install the fix packs that are appropriate for your product version. To check your version, open the component list file at `c10_location\cmplst.txt` and check the line that starts with `C8BISRVR_version=`.

**Installing Fix Packs (Windows)**

Use the following steps to install the fix pack.

**Before you begin**

Before you install the fix pack:

1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

**Procedure**

1. Insert the fix pack disk for the Windows operating system or go to the location where you downloaded and extracted the files.
2. On the disk or in the download location, go to the win32 directory and double-click the issetup.exe file.
3. Follow the directions in the installation wizard, installing in the same location as your existing IBM Cognos components.
   The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
4. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.
5. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.
6. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server. For instructions, see "Configure Application Server Properties and Deploy IBM Cognos Components" on page 453.
Installing Fix Packs (UNIX/Linux)

Use the following steps to install the fix pack.

Before you begin

Before you install the fix pack:
1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

Procedure

1. If using a disk, mount the fix pack disk that is appropriate for your UNIX or Linux operating system, using Rock Ridge file extensions.
   
   **Important:** To mount the IBM Cognos disk on HP-UX, do the following:
   - Add the `pfs_mount` directory in your path.
     
     For example,
     
     ```
     PATH=/usr/sbin:/$PATH
     export PATH
     ```
   - To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`
   - To mount the drive, type
     
     ```
     pfs_mount -t rrip <device> <mount_dir> -o xlat=unix
     ```
     
     For example,
     
     ```
     pfs_mount -t rrip /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     ```
     
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   - When the installation is complete, type `pfs_umount /cdrom` and kill the `pfsd` and `pfs_mountd` daemons to unmount the disk.

2. If using a download, go to the location where you downloaded and extracted the fix pack files.

3. To start the installation wizard, type
   
   ```
   /issetup
   ```
   
   If you do not use XWindows, run an unattended installation (see "Set Up an Unattended Installation Using a File From an Installation on Another Computer" on page 492).

4. Follow the directions in the installation wizard to install to the same location as your existing IBM Cognos components.
   
   The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.

5. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.

6. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.

7. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server. For instructions, see "Configure Application Server Properties and Deploy IBM Cognos Components" on page 455.
Java settings

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

You can use an existing Java Runtime Environment (JRE) or the JRE that is provided with Cognos BI.

JAVA_HOME

If you want to use your own JRE and have JAVA_HOME set to that location on Microsoft Windows operating system or if you are installing on a UNIX or Linux operating system, you must update JAVA_HOME for the cryptographic services.

On Windows, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for it to take effect. If you set it as a user variable, set it so that the environment in which Tomcat (or other application server) is running can access it.

If you do not have a JAVA_HOME variable already set on Windows, the JRE files provided with the installation will be used, and you do not have to update any files in your environment. If JAVA_HOME points to a Java version that is not valid for IBM Cognos BI, you must update JAVA_HOME with the path to a valid Java version.

Unrestricted JCE Policy File

Whether you use the default Windows JRE or download a JRE for UNIX or Linux, the JRE includes a restricted policy file that limits you to certain cryptographic algorithms and cipher suites. If your security policy requires a wider range of cryptographic algorithms and cipher suites than are shown in IBM Cognos Configuration, you can download and install the unrestricted JCE policy file.

Update the Java Environment

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

Procedure

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   For example, to set JAVA_HOME to a JRE that you are already using, the path is `java_location/bin/jre/version`.
2. If your security policy requires it, download and install the unrestricted JCE policy file.
   For Java that is provided by IBM, the unrestricted JCE policy file is available from the following location:

   ![Download Link]

   For information about configuring the cryptographic provider to support your security policy, see "Configuring Cryptographic Settings" on page 353.
Set Up Database Connectivity for the Content Store Database

If you are using a database other than Cognos Content Database or Microsoft SQL Server as the content store, you may have to install database client software, or Java Database Connectivity (JDBC) drivers, or both, on each computer where you install Content Manager. Doing this allows Content Manager to access the content store database.

Set Up Database Connectivity for a DB2 Content Store

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. If you are using a type 2 JDBC connection, install the DB2 client software on the Content Manager computers.

   If you are using a type 4 JDBC connection for DB2, you are not required to install the DB2 client software where Content Manager is installed. If you use a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

   For more information about the differences between type 2 and type 4 drivers, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 132.

2. If you are using a type 2 JDBC connection, and the content store is on a different computer than Content Manager, configure a database alias to the content store.

   On Microsoft Windows operating systems, run the DB2 Client Configuration Assistant.

   On UNIX or Linux operating systems, use the DB2 command line interface.

   **Note:** If the content store database and Content Manager are on the same computer, the content store name automatically becomes the alias.

   When you configure the Content Manager computers, ensure that they are all configured to use the same content store.

3. On Windows, stop the DB2 services and the HTML Search Server.

4. Copy the following files from `DB2_installation/sqlib/java` directory to the `c10_location/webapps/p2pd/WEB-INF/lib` directory.

   - the universal driver file, `db2jcc.jar`
   - the license file
     - for DB2 on Linux, UNIX, or Windows, `db2jcc_license_cu.jar`
     - for DB2 on z/OS, `db2jcc_license_cisuz.jar`

   If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

   **Tip:** To check the driver version, run the following command

   ```java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version```

5. On Windows, restart the DB2 services and the HTML Search Server.

6. On UNIX, if you are using a type 2 JDBC connection, ensure that the 32-bit DB2 libraries are in the library search path, which is usually the `$DB2DIR/lib` directory or the `$DB2DIR/lib32` directory.

7. Repeat this entire procedure on the IBM Cognos BI computers where Content Manager is installed or where notification is sent to a DB2 database.
You can tune the database to take advantage of DB2 features. For more information, see “Tuning a DB2 Content Store” on page 477.

Generating a script file that will create a database for a DB2 content store:

You can generate a script file to automatically create the content store in IBM DB2 on all platforms. The script file is called a DDL file.

Procedure
1. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
   
   The default configuration is for an IBM DB2 database. Ensure that the Type is DB2 database.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
5. If you are using a type 4 JDBC connection, in Database server and port number, enter the name of your computer and port number on which DB2 is running. For example, localhost:50000. 50000 is the default port number used by DB2. If you are using a different port number, ensure you use that value.
   - If you use a type 2 JDBC connection, you can leave this value blank.
6. Right-click Content Store, and click Generate DDL.
7. Click Details to record the location of the generated DDL file.
   
   The DDL file named createDB.sql is created. The script is created in the c10_location/configuration/schemas/content/db2 directory.
   
   Use this script to create a database in IBM DB2. For more information about using a DDL file, see your IBM DB2 documentation.

Create Tablespaces for a DB2 Content Store on z/OS:

A database administrator must run a script to create a set of tablespaces required for the content store database. The script must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

If you are using the same DB2 database on z/OS for both the content store and notification (the default setup), then you must run scripts to create the notification tablespaces at the same time that you create the content store tablespaces.

Ensure that you use the naming conventions for DB2 on z/OS. For example, all names of parameters must start with a letter and the length must not exceed 6 characters. For more information, see the IBM DB2 Information Center.

Procedure
1. Connect to the database as a user with privileges to create and drop tablespaces and to allow execution of SQL statements.
2. Go to the directory that contains the scripts:
   
   c10_location/configuration/schemas/content/db2zOS
3. Open the `tablespace_db2zOS.sql` script file and use the following table to help you to replace the generic parameters with ones appropriate for your environment.

   Not all of the parameters listed are in the script, but may be added in the future.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSCRIPT_CREATE_IN</td>
<td>Specifies the base tables location For example, databaseName.baseTablespaceName</td>
</tr>
<tr>
<td>CMSCRIPT_STOGROUP</td>
<td>Specifies the name of the storage group.</td>
</tr>
<tr>
<td>CMSCRIPT_DATABASE</td>
<td>Specifies the name of the content store database.</td>
</tr>
<tr>
<td>CMSCRIPT_CS_ID</td>
<td>Specifies the instance identification for the content store database. The ID must not be longer than two characters.</td>
</tr>
<tr>
<td>CMSCRIPT_TABLESPACE</td>
<td>Specifies the name of the tablespace that will contain all of the base tables in the content store. Auxiliary tables are not included. The name cannot be longer than six characters.</td>
</tr>
<tr>
<td>CMSCRIPT_LARGE_BP</td>
<td>Specifies the name of the large buffer pool allocated for especially large objects.</td>
</tr>
<tr>
<td>CMSCRIPT_REGULAR_BP</td>
<td>Specifies the name of the regular size buffer pool allocated for regular and large objects.</td>
</tr>
<tr>
<td>CMSCRIPT_USERNAME</td>
<td>Specifies the user account that accesses the content store database.</td>
</tr>
</tbody>
</table>

4. Save and run the script.

5. Grant the IBM Cognos user rights to the tablespaces that were created when you ran the `tablespace_db2zOS.sql` file script:
   - In the remote access tool, open the `rightsGrant_db2zOS.sql` script file and replace the placeholder parameters with values that are appropriate for your environment.

   **Tip:** Ensure that you use the same values that you used when you allocated resources to the buffer pools and user account.

   - Save and run the file.

6. Replace placeholder parameters in the following scripts and run them:
   - `dbInitTest_db2zOS.sql`
   - `dbInitMeta_db2zOS.sql`
   - `dbInitScript_db2zOS.sql`
   - `dbInitLock_db2zOS.sql`

7. If you are using the same database for notification that you use for the content store (the default setup), perform the remaining steps.

8. Open the `NC_TABLESPACES.sql` script file and use the following table to help you to replace the placeholder parameters with ones that are appropriate for your environment.

   For parameters that are not in the script, add them.
9. Save and run the script.
10. Open the NC_CREATE.sql script file and replace the NCCOG placeholder parameter with the name of the content store database.
11. Save the script.
   The Job and Scheduling Monitor services will automatically run the script. However, you may choose to run it yourself.

Results

The content store database is created. You can now configure a database connection.

Set Up Database Connectivity for an Oracle Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.
2. Copy the correct library file for your version of the Oracle client to the c10_location\webapps\p2pd\WEB-INF\lib directory on the computer where Content Manager is installed and where notification is sent to an Oracle database.
   If you are using Oracle 10g, you must have ojdbc14.jar.
   If you are using Oracle 11g, you must have ojdbc5.jar.
   The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.

Set Up Database Connectivity for an Informix Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. On the computer where Informix is installed, go to the Informix_location\sqllib\java directory.
2. Copy the following files to the c10_location\webapps\p2pd\WEB-INF\lib directory on every computer where Content Manager is installed.
   - the universal driver file, db2jcc.jar
   - the license file, db2jcc_license_cisuz.jar
Set Up Database Connectivity for a Sybase Content Store
This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

Procedure
1. On the computer where Sybase is installed, go to the Sybase_location/jConnect-6/classes directory.
2. Copy the jconn3.jar file to the c10_location/webapps/p2pd/WEB-INF/lib directory on every computer where Content Manager is installed and where notification is sent to a Sybase database.

Start IBM Cognos Configuration
Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before starting IBM Cognos Configuration, ensure that the operating environment is properly set up. For example, ensure that all environment variables have been set.

On UNIX or Linux operating systems, do not start IBM Cognos Configuration in the last page of the installation wizard. Additional setup is required before you can configure IBM Cognos BI. For example, you must update your Java environment.

On a Microsoft Windows operating system, you can start IBM Cognos Configuration in the last page of the installation wizard only if additional setup is not required. For example, if you use a database server other than Microsoft SQL or Cognos Content Database for the content store, copy the Java Database Connectivity (JDBC) drivers to the appropriate location before you start the configuration tool.

Starting IBM Cognos Configuration (UNIX/Linux)
Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin
Ensure that user or service account is set up.

Procedure
1. Go to the c10_location/bin directory and then type
   ./cogconfig.sh
2. If you want to access the help for IBM Cognos Configuration, go to the c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   For example, if you use Firefox, add the following text to the file:
   
   **BrowserPath=Web_browser_location/firefox**
   where Web_browser_location is a path, such as /usr/local/bin/

   Your Web browser must support the following syntax:
   
   $ <Web_browser_location> <URL>
Starting IBM Cognos Configuration (Windows)
Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin
Ensure that user or service account is set up.

Procedure
1. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
   If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and have installed the product to the Program Files (x86) directory, start IBM Cognos Configuration as an Administrator.
2. If you want to access the help for IBM Cognos Configuration, go to the c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   For example, if you use Firefox, add the following text to the file:
   ```
   BrowserPath=Web_browser_location/firefox
   where Web_browser_location is a path, such as \usr\local\bin\
   Your Web browser must support the following syntax:
   $ <Web_browser_location> <URL>
   ```

Set Database Connection Properties for the Content Store
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

In a production environment, you must use an enterprise-level database for your content store. If you have been using Cognos Content Database in a test or proof-of-concept system, you can use the features in the administration portal to back up and archive the data before moving to an enterprise-level database in your production environment. For more information, see the topic about deploying the entire content store in the Administration and Security Guide.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, configure IBM Cognos BI to point to a copy of the existing content store database. After you save the configuration and start the IBM Cognos service, the data in the content store is automatically upgraded and cannot be used by the earlier version. By using a copy of the original database with the new version, you can keep ReportNet or the earlier version running with the original data.

Ensure that you used one of the supported database servers to create the content store.

Setting Database Connection Properties for a DB2 Content Store on UNIX, Linux, or Microsoft Windows
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.
**Procedure**

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access > Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   • Click the Value box next to the User ID and password property and then click the edit button when it appears.
   • Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   If you leave this property blank, a type 2 JDBC connection is used.
   For more information about the differences between the driver types, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 132.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
   Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

**Setting Database Connection Properties for a DB2 Content Store on z/OS**

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

**Procedure**

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   • Click the Value box next to the User ID and password property and then click the edit button when it appears. Ensure that you specify the same user ID as the value you specified for CMSCRIPT_USERNAME when you created the tablespaces.
   • Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   To connect to DB2 on z/OS, you must use a type 4 JDBC connection.
   For more information about the differences between the driver types, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 132.
6. In the Explorer window, click Local Configuration.
7. In the Properties window, next to Advanced properties, click inside the Value box, and then click the edit button. The Value - Advanced properties dialog box appears.

8. To add the parameters that you used to create the tablespaces, click Add. All of the parameters except CMSCRIPT_USERNAME are added.

9. From the File menu, click Save. The logon credentials are immediately encrypted.

10. To test the connection between Content Manager and the content store database, from the Actions menu, click Test. This tests the connection between Content Manager and the content store database.

Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.

2. In the Explorer window, under Data Access, Content Manager, right-click Content Store and click Delete. This deletes the connection to the default resource. Content Manager can access only one content store.

3. Right-click Content Manager, and then click New resource, Database.

4. In the Name box, type a name for the resource.

5. In the Type box, select the type of database and click OK. If you installed more than one version of IBM Cognos BI, you must use a different content store for each version. When a content store is used by a new version of IBM Cognos BI, it cannot be used by an older version.

Tip: If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

6. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property.
     For the Database server with port number or instance name property, include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name as a Java Database Connectivity (JDBC) URL property or a data source property. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
jdbc:JSQLConnect://localhost/instance1/user=sa/
more properties as required

To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If an instance name is not specified, a connection to the default instance is created.

- If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
- If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.

Here is an example:
(description=(address=(host=myhost)(protocol=tcp)(port=1521)
(connect_data=(sid=(orcl)))))

When you select the advanced Oracle database, IBM Cognos BI uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

- If you use an Informix database, type the appropriate values for the Database server and port number and Database name properties.
- If you use a Sybase database, type the appropriate values for the Database server and port number and Database name properties.

7. To configure logon credentials, specify a user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.

8. If you host more than one content store database on an Informix instance, create the advanced property CMSCRIPT_CS_ID and specify the account under which the instance runs:
   - In the Explorer window, click Local Configuration.
   - In the Properties window, click the Value column for Advanced properties and then click the edit button.
   - In the Value - Advanced properties dialog box, click Add.
   - In the Name column, type CMSCRIPT_CS_ID
   - In the Value column, type the user ID of the account under which the instance of the content store runs.
     Use a different user account for each instance of Informix content store database.

9. From the File menu, click Save.
   The logon credentials are immediately encrypted.

10. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
    Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

Results

Content Manager can now create the required tables in the content store when you start the IBM Cognos service for the first time. If the connection properties are not specified correctly, you cannot start the IBM Cognos services.
Configure Environment Properties for Content Manager Computers

The Content Manager computers must know the location of the content store, the other Content Manager computers, and the database that is used for notification.

After installing Content Manager on the computers you are using for failover protection, you must configure Content Manager on those computers. If you installed more than one Content Manager, you must list all Content Manager URIs on each Content Manager computer.

After you complete the required configuration tasks and start the IBM Cognos BI service, the certificate authority service is available to issue certificates to other computers. You can then perform the required configuration tasks on other computers, such as the Application Tier Components computer and gateway computers. Otherwise, you can continue to configure the Content Manager computers by changing the default property settings (see “Changing Default Configuration Settings” on page 348) so that they better suit your environment. For example, you can configure IBM Cognos BI components to use an authentication provider (see Chapter 12, “Configuring IBM Cognos Components to Use an Authentication Provider,” on page 311), enable and disable services (see “Enable and Disable Services” on page 360) on the Content Manager computers, or change global settings (see “Changing Global Settings” on page 388).

Note that if you change global settings on one Content Manager computer, you must make the same changes on the other Content Manager computers.

Configuring the active Content Manager

The Content Manager computers must know the location of the content store, the other Content Manager computers, and the database that is used for notification.

Procedure

1. On the Content Manager computer that you want to designate as the default active Content Manager, start IBM Cognos Configuration.

   Tip: Use the computer with the highest processor speed for the default active Content Manager.

2. In the Explorer window, click Environment.

3. In the Properties window, click the value for Content Manager URIs and then click the edit button.

4. Specify the URLs for the other Content Manager computers:
   
   • In the Value - Content Manager URIs dialog box, click Add.
   
   • In the blank row of the table, click and then type the full URI of the Content Manager computer.
   
   Do not delete the first value in the table. This value identifies the local Content Manager computer and is required.
   
   Replace the localhost portion of the URI with a host name or IP address. All URI properties must use the same format: all host names or all IP addresses.
   
   • Repeat the previous two bulleted steps for each URI to be added.
   
   You must include all Content Manager URLs in the list.
   
   • Click OK.

5. In the Explorer window, under Security, click Cryptography.
6. In the Properties window, under CSK settings, set Store symmetric key locally to True.
7. From the File menu, click Save.

**Configuring standby Content Managers**
The Content Manager computers must know the location of the content store, the other Content Manager computers, and the database that is used for notification.

**Procedure**
1. Ensure that you already configured the Environment properties on at least one Content Manager computer and that IBM Cognos BI components are running on that computer.
2. On the standby Content Manager computer, start IBM Cognos Configuration.
3. In the Explorer window, click Environment.
4. In the Properties window, click the value for Content Manager URIs, and then click the edit button.
5. Specify the URIs for the other Content Manager computers:
   - In the Value - Content Manager URIs dialog box, click Add.
   - In the blank row of the table, click and then type the full URI of the Content Manager computer.
     Do not delete the first value in the table. This value identifies the local Content Manager computer and is required.
     Replace the localhost portion of the URI with a host name or IP address. All URI properties must use the the same format: all host names or all IP addresses.
   - Repeat the previous two bulleted steps for each URI to be added.
     You must include all Content Manager URIs in the list.
   - Click OK.
6. In the Explorer window, under Security > Cryptography, click Cognos, the default cryptographic provider.
7. Ensure that all cryptographic settings match what you configured on the default active Content Manager computer.
8. In the Explorer window, under Data Access > Content Manager, click Content Store.
9. Ensure that the values for all of the properties match what you configured on the default active Content Manager computer.
10. From the File menu, click Save.

**Specify a Connection to a Mail Server Account**
If you want to send reports by email, you must configure a connection to a mail server account.

You must also change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name. Otherwise the URL in the email will contain localhost and remote users will not be able to open the report.

**Procedure**
1. In the Explorer window, under Data Access, click Notification.
2. In the Properties window, for the SMTP mail server property, type the host name and port of your SMTP (outgoing) mail server.
**Tip:** To be able to open reports that are sent by email, you must change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name. Otherwise the URL in the email will contain localhost and remote users will not be able to open the report.

**Tip:** To be able to open reports that are sent as links, ensure that the Gateway URI on report servers and notification servers specifies an accessible Web server hosting IBM Cognos content. If you have mobile users accessing links remotely, consider using an external URI.

3. Click the **Value** box next to the **Account and password** property and then click the edit button when it appears.

4. Type the appropriate values in the **Value - Account and password** dialog box and then click **OK**.

**Tip:** If logon credentials are not required for the SMTP server, remove the default information for the **Account and password** property. When you are prompted for confirmation to leave this property blank, click . Ensure that the default user name has been removed. Otherwise, the default account is used and notifications will not work properly.

5. In the **Properties** window, type the appropriate value for the default sender account.

6. Test the mail server connections. In the **Explorer** window right-click **Notification** and click **Test**.

   IBM Cognos Business Intelligence tests the mail server connection.

**Results**

If you do not plan to send reports by email, or do not want to set up a mail server account immediately, you are not required. However, when you save the configuration and then you start the services in IBM Cognos Configuration, you will see a warning message when the mail server connection is tested. You can safely ignore the warning.

**Enable Security**

By default, IBM Cognos Business Intelligence allows anonymous access. If you want to use security in your IBM Cognos BI environment, you must disable anonymous access and configure IBM Cognos BI to use an authentication provider.

**Procedure**

1. In the IBM Cognos Configuration **Explorer** window, click **Security >Authentication > Cognos**.

2. Click the **Value** box for **Allow Anonymous Access**, and select **False**.

3. Right-click **Authentication**, and click **New Resource > Namespace**.

4. In the **Name** box, type a name for your authentication namespace.

5. In the **Type** list, click the appropriate namespace type and then click **OK**.

   The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.

6. In the **Properties** window, for the **Namespace ID** property, specify a unique identifier for the namespace.

7. From the **File** menu, click **Save**.
Start Content Manager

After you have set the database connection properties for the content store, you can start the Content Manager computer.

Before you begin

Ensure that user or service account is set up. For information, see “Configure a User Account or Network Service Account for IBM Cognos Business Intelligence” on page 67.

Procedure

1. Start IBM Cognos Configuration.
   If you are upgrading, a message appears indicating that configuration files were detected and upgraded to the new version.
2. Ensure that you save your configuration, otherwise you cannot start the IBM Cognos service.
3. From the Actions menu, click Test.
   IBM Cognos Configuration checks the common symmetric keys (CSK) availability, tests the namespace configuration, and tests the connections to the content store and logging database.
   If you are using the notification database and the mail server, they are tested as well.

   Tip: If Test is not available for selection, in the Explorer window, click Local Configuration.
4. If the test fails, reconfigure the affected properties and then test again.
   You can test some components individually by right-clicking the component in the Explorer panel and selecting Test.
   Do not start the service until all tests pass.
5. From the Actions menu, click Start.
   It may take a few minutes for the IBM Cognos service to start.
   This action starts all installed services that are not running and registers the IBM Cognos service on Windows.

Test the Content Manager Installation

You can test the installation using a Web browser.

Procedure

1. Open a Web browser.
2. Test that Content Manager is running by typing the Content Manager URIs value from IBM Cognos Configuration. For example,

   http://host_name:port/p2pd/servlet
   The default value for host_name:port is localhost:9300.
   The State value should be Running.

Installing and Configuring Application Tier Components

You can install the Application Tier Components on different computers or on the same computer.
Perform the following tasks to install and configure the Application Tier Components:

- Install the Application Tier Components
- Install Application Tier Components for IBM Cognos Metrics Manager if required
- Install fix packs if available
- Set up database connectivity for the reporting database
- Start IBM Cognos Configuration
- Configure environment properties for Application Tier computers
- Start the Application Tier components
- Test the Application Tier components
- Create the metric store database
- Set up the database client for the metric store if required
- Create a metric package

Install the Application Tier Components

You can install Application Tier Components on one or more computers, depending on your environment.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, IBM Cognos BI uses the existing configuration data for the Application Tier Components computers. However, if you installed the Application Tier Components in a new location, you must configure the environment properties.

Ensure that the computer where you installed the active Content Manager is configured and available before you configure Application Tier Components computers.

64-bit Installations

The report server component, included with the Application Tier Components, is provided in both 32- and 64-bit versions. Selecting which version you use is done using IBM Cognos Configuration after installation. By default, the report server component is set to use the 32-bit mode, even on a 64-bit computer. The 32-bit mode allows you to run all reports, whereas the 64-bit mode allows you to run only reports created for dynamic query mode.

Printer Requirements

To ensure that reports print properly on a Microsoft Windows operating system, Adobe Reader requires that you configure at least one printer on the operating system where Application Tier Components are installed. All reports, regardless of the print format that you choose, are sent as temporary PDF files to Adobe Reader for printing.

Installing the Application Tier Components on UNIX or Linux

You can install Application Tier Components on one or more computers, depending on your environment.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Set the JAVA_HOME environment variable to point to the installation location of your Java Runtime Environment (JRE).
   An example of the installation location of a Java Runtime Environment is `/directory/java/java_version/jre`.
   IBM Cognos BI requires a JVM, such as the Java that is provided by IBM, to run on a Linux operating system.
   If you are installing in a location with other IBM Cognos BI components, use the existing JAVA_HOME environment variable.

3. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:
   ```
   _M_ARENA_OPTS 1:4
   ```
   This increases the memory allocation for HP-UX to more closely match that of other UNIX operating systems.

4. On AIX, if you are using a servlet gateway, set the AIXTHREAD_SCOPE environment variable as follows:
   ```
   AIXTHREAD_SCOPE=S
   ```
   This sets the contention scope for user threads to system-wide, which supports more efficient scheduling of user threads.

5. If installing from a download, go to the location where the installation files were downloaded and extracted.

6. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   - Add the pfs_mount directory in your path.
     For example,
     ```
     PATH=/usr/sbin/:$PATH
     export PATH
     ```
   - To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`
   - To mount the drive, type
     ```
     pfs_mount -t rrip <device><mount_dir> -o xlat=unix
     ```
     For example,
     ```
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     ```
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   - When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.

7. To start the installation wizard, go to the operating system directory and then type
   ```
   /issetup
   ```
   **Note:** When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on UNIX or Linux, first set environment variables `LANG=C` and `LC_ALL=C` (where C is the language code, for example ja_JP.PCK on Solaris), and then start the installation wizard.
   If you do not use XWindows, run an unattended installation (see "Set Up an Unattended Installation Using a File From an Installation on Another Computer" on page 492).

8. Follow the directions in the installation wizard and copy the required files to your computer.
• When selecting the directory, consider the following:
  Install Application Tier Components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.
  If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.
  If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
• When selecting components, clear all components except Application Tier Components.

9. In the Finish page of the installation wizard, do the following:
• If you want to see the log files, click View for the appropriate log file.
• If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
• Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
  You can later configure IBM Cognos BI using IBM Cognos Configuration by typing cogconfig.sh in the c10_location/bin directory, or by running a silent configuration or editing cogstartup.xml in c10_location/configuration directory.
• Click Finish.

10. Append the c10_location/bin directory to the appropriate library path environment variable.
• For Solaris and Linux, LD_LIBRARY_PATH
• For AIX, LIBPATH
• For HP-UX, SHLIB_PATH

11. On Linux, set the PRINTER environment variable to the name of your printer.

Results

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation in the same location as the Gateway components. For more information, see "Translated Product Documentation" on page 293.

Installing the Application Tier Components on Windows

You can install Application Tier Components on one or more computers, depending on your environment.

For Windows Vista, Windows 7, or Windows 2008 computers, the default installation location uses the Program Files (x86) directory. If you install to this location, ensure that you run IBM Cognos Configuration as an Administrator.
Alternatively, you can install the product outside of the Program Files (x86) directory. For example, you can change the installation directory to something like C:\IBM\cognos\c10.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Do one of the following:
   • Insert the IBM Cognos product disk.
     If the installation wizard does not open automatically, go to the operating
     system directory, and double-click issetup.exe.
   • Go to the location where the installation files were downloaded and
     extracted and then double-click issetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. All
   supported languages are installed. You can change the user interface to any of
   the installed languages after installation.

4. Follow the directions in the installation wizard and copy the required files to
   your computer.
   • When selecting the directory, consider the following:
     Install Application Tier Components in a directory that contains only ASCII
     characters in the path name. Some Web servers do not support non-ASCII
     characters in directory names.
     If you are installing IBM Cognos BI on a computer that has ReportNet or an
     earlier version of IBM Cognos BI and you want to keep the earlier version,
     you must install IBM Cognos BI in a different directory.
     If you are installing in a directory that contains other IBM Cognos BI
     components, you are prompted to create backup copies of the files that will
     be replaced.
   • When selecting components, clear all components except Application Tier
     Components.

5. In the Finish page of the installation wizard, do the following:
   • If you want to see the log files, click View for the appropriate log file.
   • If you want to see late-breaking information about the product, select the
     check box for IBM Cognos Release Notes.
   • Do not configure IBM Cognos BI immediately because you must do other
     tasks first to ensure that your environment is properly set up. Ensure that the
     IBM Cognos Configuration check box is clear.
     You can later configure IBM Cognos BI using the Windows Start menu to
     start IBM Cognos Configuration from the shortcut folder.
   • Click Finish.

Results

If you want users to see product documentation in a language other than English,
you must install the Supplementary Language Documentation in the same location
as the Gateway components. For more information, see “Translated Product
Documentation” on page 293.

Install Application Tier Components for IBM Cognos Metrics
Manager

If you are installing IBM Cognos Metrics Manager with the IBM Cognos BI server
and you want to share resources, you must install the Application Tier
Components for IBM Cognos Metrics Manager in the same location as the
Application Tier Components for the IBM Cognos BI server. If you want your
scorecarding product to operate independently of the IBM Cognos BI server, install
the Application Tier Components for IBM Cognos Metrics Manager in a different
location from the Application Tier Components for the IBM Cognos BI server.
You may also want to install Metric Designer (see "Installing and Configuring Metric Designer" on page 235).

IBM Cognos Metrics Manager and 64-bit Systems

IBM Cognos Metrics Manager is only available in a 32-bit version. You must install it on a 32-bit system or, if sharing resources with IBM Cognos BI server, in a separate directory on a 64-bit system.

After installing the Application Tier Components for IBM Cognos Metrics Manager in a separate location, you can then configure the Content Manager URLs property to point to the location where Content Manager is installed (see "Configure Shared Resources for IBM Cognos Metrics Manager" on page 205).

Installing Fix Packs

IBM provides interim maintenance packages that contain updates to one or more components in your IBM Cognos product. If a fix pack is available when you are installing or upgrading your product, you must install it after you install the IBM Cognos components.

If a fix pack becomes available after your IBM Cognos product has been deployed, you must stop the service, install the fix pack in the same location as the IBM Cognos components, and then start the service.

Fix packs are cumulative. When you install the latest fix pack, it includes updates from all the previous fix packs. Fix packs are available for download from IBM Support at [http://www.ibm.com/support/us/en/](http://www.ibm.com/support/us/en/)

Note: Fix packs are not standalone installations. You must install them on computers that have IBM Cognos components installed. Install the fix packs that are appropriate for your product version. To check your version, open the component list file at `c10_location\cmplst.txt` and check the line that starts with `C8BISRVR_version=`.

Installing Fix Packs (Windows)

Use the following steps to install the fix pack.

Before you begin

Before you install the fix pack:
1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

Procedure
1. Insert the fix pack disk for the Windows operating system or go to the location where you downloaded and extracted the files.
2. On the disk or in the download location, go to the win32 directory and double-click the issetup.exe file.
3. Follow the directions in the installation wizard, installing in the same location as your existing IBM Cognos components. The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
4. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.

5. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.

6. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server. For instructions, see “Configure Application Server Properties and Deploy IBM Cognos Components” on page 453.

**Installing Fix Packs (UNIX/Linux)**

Use the following steps to install the fix pack.

**Before you begin**

Before you install the fix pack:

1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

**Procedure**

1. If using a disk, mount the fix pack disk that is appropriate for your UNIX or Linux operating system, using Rock Ridge file extensions.

   **Important:** To mount the IBM Cognos disk on HP-UX, do the following:
   - Add the pfs_mount directory in your path.
     For example,
     ```
     PATH=/usr/sbin:/$PATH
     export PATH
     ```
   - To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`
   - To mount the drive, type
     ```
     pfs_mount -t rrip <device> <mount_dir> -o xlat=unix
     ```
     For example,
     ```
     pfs_mount -t rrip /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     ```
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   - When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.

2. If using a download, go to the location where you downloaded and extracted the fix pack files.
3. To start the installation wizard, type
   ```
   /issetup
   ```
   If you do not use XWindows, run an unattended installation (see “Set Up an Unattended Installation Using a File From an Installation on Another Computer” on page 492).

4. Follow the directions in the installation wizard to install to the same location as your existing IBM Cognos components.

   The issetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
5. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.
6. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.
7. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server. For instructions, see “Configure Application Server Properties and Deploy IBM Cognos Components” on page 453.

**Database Connectivity for the Reporting Database**

To support communication between IBM Cognos Business Intelligence and the data sources, you must install additional software for your data sources on the same computer that hosts the report server. Depending on the data source and query mode, the required software might include database clients, or Java Database Connectivity (JDBC) driver files, or both.

For IBM Cognos Business Intelligence, the query database (also known as the reporting database) is only accessed by the reporting engine that runs reports. The reporting engine is installed with Application Tier Components and is also used by Framework Manager, Metric Designer, and IBM Cognos Transformer.

**Dynamic Query Mode**

Dynamic query mode provides communication to data sources using Java/XMLA connections.

For supported relational databases, a type 4 JDBC connection is required. A type 4 JDBC driver converts JDBC calls directly into the vendor-specific database protocol. It is written in pure Java and is platform-independent. It offers improved performance over type 2 drivers because it does not have to convert calls to ODBC or database API calls.

For supported OLAP data sources, Java/XMLA connectivity optimizes access by providing customized and enhanced MDX for the specific source and version of your OLAP technology and it harnesses the smarts of the OLAP data source.

You can use the dynamic query mode with the following OLAP data sources:
- IBM Cognos TM1
- IBM Cognos Real-time Monitoring
- SAP Business Information Warehouse (SAP BW)
- Oracle Essbase
- Microsoft Analysis Services

You can use the dynamic query mode for OLAP over relational (dimensionally-modeled relational) models with the following relational data sources:
- IBM DB2
- IBM DB2 for z/OS
- IBM Cognos Real-time Monitoring
- Oracle
- Microsoft SQL Server
- Teradata
Netezza

For more information about the dynamic query mode, see the IBM Cognos Business Intelligence Dynamic Query Guide.

To review an up-to-date list of environments supported by the IBM Cognos Business Intelligence, including the data source versions supported by the dynamic query mode, see http://www-01.ibm.com/support/docview.wss?uid=swg27019126.

Setting up reporting database connectivity on Windows operating systems

To access the relational databases and OLAP data sources for reporting, you must install the client API software that is provided by your data source vendor on the report server.

Procedure

Ensure that you install the database API software for your relational databases and OLAP data sources on the computer that hosts the report server (where Application Tier Components are installed). On Windows operating systems, the reporting engine supports either native database connectivity or ODBC.

Results

If Framework Manager is installed in a separate location from the Application Tier Components, you must also install the client API software on the computer where Framework Manager is installed. For more information, see "Data Sources and Framework Manager" on page 230.

Setting up reporting database connectivity on UNIX or Linux operating systems

To use an ODBC data source on UNIX or Linux to connect to a supported data source, you must configure the environment to locate the .odbc.ini file which contains the references to data source, the connectivity libraries, and their accompanying Driver Manager libraries.

To review supported ODBC data sources, see the Supported Environments link at the IBM Cognos Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html).

After configuring for the ODBC connections, you must create connections to the data sources in IBM Cognos Administration. For information, see the IBM Cognos Administration and Security Guide.

If your database vendor does not supply a driver manager, you can use unixODBC or iODBC, depending on your operating system.

On Linux operating systems, the unixODBC package provided with the operating system provides the ODBC Driver Manager. You must install unixODBC version 2.2.11 or later before you can set up data source connections. To verify the version you have installed, use the following command: odbcinst --version.

On UNIX operating systems, the open source iODBC driver manager is provided as part of the IBM Cognos installation.
**Procedure**

1. Create an environment variable to specify the location of the .odbc.ini file.
   
   For example,
   
   ```bash
   export ODBCINI=/usr/local/etc/.odbc.ini
   ```

2. Set the appropriate library path environment variable to specify the location of the connectivity libraries and Driver Manager for your database.

   The following table lists the environment variables for each operating system that must specify the location of the driver manager libraries.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris and Linux</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

3. If your database vendor does not provide a driver manager, set the library path to include the path the local driver manager.

   - On UNIX, iODBC is provided as part of the IBM Cognos installation. The library files are located in the `<c10_location>/bin` directory. Your library path should already contain the `<c10_location>/bin` directory.
     
     For example,
     
     ```bash
     LIBPATH=/usr/IBM/cognos/bin:$LIBPATH
     ```

   - On Linux, the unixODBC package provides the required driver manager libraries.
     
     For example,
     
     ```bash
     LD_LIBRARY_PATH=/usr/lib:$LD_LIBRARY_PATH
     ```

**What to do next**

If you are using multiple ODBC sources on UNIX or Linux operating systems, you may encounter dependencies of library files with common names but different implementations for both the connectivity and the driver manager. In a scenario where one ODBC source validates while another fails based on a dependency, please contact Customer Support. Using a common .odbc.ini may result in having incompatible entries for different driver managers. To resolve the problem, review the structure requirements between the driver managers you are using and try to use syntax that is common between the conflicting driver managers.

**Setting up reporting connectivity for relational databases to use the dynamic query mode**

To allow the reporting engine to connect to supported relational databases using dynamic query mode, you must install the required Java Database Connectivity (JDBC) driver files, and then either copy them to the IBM Cognos installation directory or specify their location in a properties file.

When connecting to relational databases, the dynamic query mode is intended for use only with OLAP over relational models.

If you copy the driver files to the IBM Cognos installation directory and modify the properties file, the driver files in the IBM Cognos installation directory take precedence over the settings in the properties file.
**Important:** Dynamic query mode requires Java Runtime Environment (JRE) 1.5 or 1.6. You must use the driver files that are provided with the JRE that your relational database uses.

For information about how to set up connectivity to your relational data source provider, see the IBM Cognos 10 *Dynamic Query Cookbook* in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

**What to do next**

You must also do the following:

- Create data source connections that use JDBC connectivity to the relational databases.
  
  Existing data source connections will not use JDBC connectivity. For more information, see the IBM Cognos Administration and Security Guide.
- Publish packages with the option to use dynamic query mode.
  
  Existing packages will not use dynamic query mode. For more information, see the IBM Cognos Framework Manager User Guide.

**Setting up reporting connectivity for OLAP data sources to use the dynamic query mode**

To allow the reporting engine to connect to supported OLAP data sources using dynamic query mode, you must install the full, or thick, client provided by the OLAP vendor.

For information about how to set up connectivity to your OLAP data source provider, see the IBM Cognos 10 *Dynamic Query Cookbook* in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

**What to do next**

You must also do the following:

- If you use Oracle Essbase version 11.1.2 on a UNIX or 64-bit Microsoft Windows operating system, you must configure the ARBORPATH and ESSBASEPATH environment variables.
  
  During the Oracle Essbase client installation, the two environment variables ARBORPATH and ESSBASEPATH are created. IBM Cognos BI uses these variables to find the Oracle Essbase client location. You must install the 64-bit Essbase client provided by Oracle. This 64-bit client includes a 32-bit client that IBM Cognos BI uses. To point to this 32-bit client, you must manually change the ARBORPATH and ESSBASEPATH environment variables to replace EssbaseClient with EssbaseClient-32.
  
  For more information, see the IBM Cognos 10 *Dynamic Query Cookbook* in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).
- If you use Oracle Essbase version 11.1.2 or version 9, you must edit a configuration file to inform the IBM Cognos BI server of your version.
  
  By default, IBM Cognos BI is configured to use Oracle Essbase version 11.1.1. Therefore, no configuration is required is you use this version. If you use another supported version of Oracle Essbase, you must edit the qfs.config.xml file for your version.
In addition, if you use Oracle Essbase version 11.1.2, you must install Oracle Foundation Services as well as the Oracle Essbase client.

For more information, see the IBM Cognos 10 *Dynamic Query Cookbook* in the Proven Practices section of the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

- Create new data source connections to the OLAP data sources.
  
  Existing data source connections will not use dynamic query mode. For more information, see the IBM Cognos *Administration and Security Guide*.
  
- Publish packages with the option to use dynamic query mode.
  
  Existing packages will not use the dynamic query mode unless you republish them with the dynamic query mode option. For more information, see the IBM Cognos Framework Manager *User Guide*.

**Configure IBM Cognos Business Intelligence to use Oracle Essbase**

If you use IBM Cognos Business Intelligence with an Oracle Essbase data source version 11.1.2 or version 9, you must edit a configuration file to inform the IBM Cognos BI server of your version.

By default, IBM Cognos BI is configured to use Oracle Essbase version 11.1.1. Therefore, no configuration is required if you use this version. If you use another supported version of Oracle Essbase, you must edit the qfs.config.xml file for your version.

In addition, if you use Oracle Essbase version 11.1.2, you must install Oracle Foundation Services as well as the Oracle Essbase client.

**Procedure**

1. Go to the *c10_location/configuration directory.*
2. Open the qfs_config.xml file in an xml or text editor.
3. Locate the following three lines:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO">
   <!--provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO"-->
   ```

4. For Oracle Essbase 11.1.2, change them as follows:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <!--provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO">
   ```

5. For Oracle Essbase 11.1.1, ensure that the lines appear as follows:

   ```xml
   <!--provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"-->
   <provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO">
   <!--provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO"-->
   ```

6. For Oracle Essbase 9, change them as follows:

   ```xml
   <provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO">
   <!--provider name="DB2OlapODP" libraryName="essodp111" connectionCode="DO"-->
   <!--provider name="DB2OlapODP" libraryName="essodp1112" connectionCode="DO"-->
   ```

7. Save the file and restart the IBM Cognos service

**Using Oracle Essbase on a UNIX or 64-bit Microsoft Windows operating system**

If you use an Oracle Essbase version 11.1.2 data source with IBM Cognos Business Intelligence on a UNIX or 64-bit Microsoft Windows operating system, you must manually configure the ARBORPATH and ESSBASEPATH environment variables.
During the Oracle Essbase client installation, the two environment variables ARBORPATH and ESSBASEPATH are created. IBM Cognos BI uses these variables to find the Oracle Essbase client location.

If you use Oracle Essbase version 11.1.2 with IBM Cognos BI on a UNIX or 64-bit Microsoft Windows operating system, you must install the 64-bit Essbase client provided by Oracle. This 64-bit client includes a 32-bit client that IBM Cognos BI uses. To point to this 32-bit client, you must manually change the ARBORPATH and ESSBASEPATH environment variables to replace EssbaseClient with EssbaseClient-32, as follows:

ARBORPATH=C:\Hyperion\EPMSystem11R1\products\Essbase\EssbaseClient-32
ESSBASEPATH=C:\Hyperion\EPMSystem11R1\products\Essbase\EssbaseClient-32

If you use a 32-bit Microsoft Windows operating system with a 32-bit Oracle Essbase client, no configuration is required for these environment variables.

Start IBM Cognos Configuration

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before starting IBM Cognos Configuration, ensure that the operating environment is properly set up. For example, ensure that all environment variables have been set.

On UNIX or Linux operating systems, do not start IBM Cognos Configuration in the last page of the installation wizard. Additional setup is required before you can configure IBM Cognos BI. For example, you must update your Java environment.

On a Microsoft Windows operating system, you can start IBM Cognos Configuration in the last page of the installation wizard only if additional setup is not required. For example, if you use a database server other than Microsoft SQL or Cognos Content Database for the content store, copy the Java Database Connectivity (JDBC) drivers to the appropriate location before you start the configuration tool.

Starting IBM Cognos Configuration (UNIX/Linux)

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin

Ensure that user or service account is set up.

Procedure

1. Go to the c10_location/bin directory and then type
   ./cogconfig.sh
2. If you want to access the help for IBM Cognos Configuration, go to the c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   For example, if you use Firefox, add the following text to the file:
   
   BrowserPath=Web_browser_location/firefox
   where Web_browser_location is a path, such as /usr/local/bin/
Starting IBM Cognos Configuration (Windows)

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin

Ensure that user or service account is set up.

Procedure

1. From the **Start** menu, click **Programs** > **IBM Cognos 10** > **IBM Cognos Configuration**.
   
   If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and have installed the product to the Program Files (x86) directory, start IBM Cognos Configuration as an Administrator.

2. If you want to access the help for IBM Cognos Configuration, go to the **c10_location\configuration** directory and edit the cogconfig.prefs file to add the location of your Web browser.
   
   For example, if you use Firefox, add the following text to the file:
   
   ```
   BrowserPath=Web_browser_location\firefox
   ```
   
   where **Web_browser_location** is a path, such as \usr\local\bin\
   
   Your Web browser must support the following syntax:
   
   $ <Web_browser_location> <URL>

Configure Environment Properties for Application Tier Components Computers

If you install the Application Tier Components component on a different computer than Content Manager, you must configure the Application Tier Components computer so that it knows the location of Content Manager. The distributed components can then communicate with each other.

The Application Tier Components computer must know the location of the Content Manager computers and the notification database to use for job and schedule information. The Application Tier Components computer must use the same notification database that the Content Manager computers use. For more information, see "Change the Notification Database" on page 367.

If you installed more than one Content Manager, you must list all Content Manager URIs on each Application Tier Components computer.

Procedure

1. Start IBM Cognos Configuration.

2. In the **Explorer** window, click **Environment**.

3. In the **Properties** window, change the **localhost** portion of the **Content Manager URIs** property to the name of any Content Manager computer.

4. Specify the URIs for the remaining Content Manager computers:
   
   - In the **Value - Content Manager URIs** dialog box, click **Add**.
• In the blank row of the table, click and then type the full URI of the Content Manager computer. Replace the localhost portion of the URI with a host name or IP address. All URI properties must use the the same format: all host names or all IP addresses.
• Repeat the previous two bulleted steps for each URI to be added. You must include all Content Manager URIs in the list.
• Click OK.

5. Change the localhost portion of the Gateway URI property to the name of the computer on which you plan to install the gateway component. This will ensure that users in different locations can connect to reports and workspaces that are sent by email.

6. Change the localhost portion of the remaining URI properties to the name or IP address of your IBM Cognos BI server.

7. In the Explorer window, under Security > Cryptography, click Cognos, the default cryptographic provider.

8. Under the Certificate Authority settings property group, set the Password property to match what you configured on the default active Content Manager computer.

9. Ensure that all other cryptographic settings match what you set on the default active Content Manager computer.

10. From the File menu, click Save.

Enable the 64-bit version of report server

In a 64-bit installation, the report server component is provided in both 32-bit and 64-bit versions. The default option is 32-bit. If you want to use the 64-bit version you must enable it using IBM Cognos Configuration.

The 64-bit version of report server is intended for use with packaged with dynamic query mode enabled. For packages that do not use dynamic query mode, you must also have a server installed with the report server running in 32-bit mode.

To enable the 64-bit version, you must have installed the 64-bit version of the Application Tier Components on a 64-bit computer. If you have installed the 32-bit version of the Application Tier Components or are using a 32-bit computer, do not change the report server mode to 64-bit.

Procedure

1. In the IBM Cognos Configuration Explorer window, click Environment.
2. Click the Value box for Report server execution mode, and select 64-bit.
3. From the File menu, click Save.

Start the Application Tier Components

After you have configured the environment properties, you can start the services on the Application Tier Components computer.
Before you begin

To use IBM Cognos BI for reporting, you must install and configure the server components, start the IBM Cognos service, and have a package that references an available data source. Note that if you are upgrading, you can continue to use the same data sources.

Ensure that user or service account is set up. For information, see "Configure a User Account or Network Service Account for IBM Cognos Business Intelligence" on page 67.

Procedure

1. Start IBM Cognos Configuration.
   If you are upgrading, a message appears indicating that configuration files were detected and upgraded to the new version.
2. Ensure that you save your configuration, otherwise you cannot start the IBM Cognos service.
3. From the Actions menu, click Test.
   IBM Cognos Configuration checks the common symmetric keys (CSK) availability, tests the namespace configuration, and tests the connections to the content store and logging database.
   If you are using the notification database and the mail server, they are tested as well.

   Tip: If Test is not available for selection, in the Explorer window, click Local Configuration.
4. If the test fails, reconfigure the affected properties and then test again.
   You can test some components individually by right-clicking the component in the Explorer panel and selecting Test.
   Do not start the service until all tests pass.
5. From the Actions menu, click Start.
   It may take a few minutes for the IBM Cognos service to start.
   This action starts all installed services that are not running and registers the IBM Cognos service on Windows.

Test the Application Tier Components

You can test the installation using a Web browser.

Procedure

1. Open a Web browser.
2. Test the availability of the dispatcher by typing the External dispatcher URI value from IBM Cognos Configuration. For example,
   http://host_name:port/p2pd/servlet
   If the response includes the string State: Running, the dispatcher is available.

Configure Shared Resources for IBM Cognos Metrics Manager

If you installed IBM Cognos Metrics Manager in a separate location from the IBM Cognos BI server, you can still share resources between the two products. The Application Tier Components for IBM Cognos Metrics Manager must know the location of the shared Content Manager.
You install IBM Cognos Metrics Manager in a separate location from IBM Cognos BI server when some of the IBM Cognos BI server components are installed on 64-bit system.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, change the **localhost** portion of the **Content Manager URIs** property to the name of any Content Manager computer.
4. Specify the URIs for the remaining Content Manager computers:
   - In the **Value - Content Manager URIs** dialog box, click **Add**.
   - In the blank row of the table, click and then type the full URI of the Content Manager computer.
     Replace the localhost portion of the URI with a host name or IP address. All URI properties must use the the same format: all host names or all IP addresses.
   - Repeat the previous two bulleted steps for each URI to be added.
     You must include all Content Manager URIs in the list.
   - Click **OK**.
5. Change the **localhost** portion of the **Gateway URI** property to the name of the computer on which you plan to install the gateway component.
   This will ensure that users in different locations can connect to reports and workspaces that are sent by email.
6. Change the **localhost** portion of the remaining URI properties to the name or IP address of your IBM Cognos BI server.
7. In the **Explorer** window, under **Security > Cryptography**, click **Cognos**, the default cryptographic provider.
8. Under the **Certificate Authority settings** property group, set the **Password** property to match what you configured on the default active Content Manager computer.
9. Ensure that all other cryptographic settings match what you set on the default active Content Manager computer.
10. From the **File** menu, click **Save**.

**Create the Metric Store Database**

A metric store is a database that contains content for metric packages. A metric store also contains scorecarding application settings, such as user preferences. You must create a metric store database using Oracle, Microsoft SQL Server, or DB2.

Although you run the command to create the metric store from the location where the Application Tier Components are installed, you can specify a different location for the metric store in the command parameters. If the metric store is on a different computer from the Application Tier Components, you must create an alias to the metric store in the Application Tier Components location.

You cannot use Cognos Content Database as a metric store database.

Your database administrator must back up IBM Cognos Business Intelligence databases regularly because they contain the IBM Cognos data. To ensure the security and integrity of databases, it is also important to protect them from unauthorized or inappropriate access.
Create a DB2 Metric Store Database
Use this procedure to create a metric store using a DB2 database.

Procedure
1. In the Application Tier Components location, in the c10_location/configuration/schemas/cmm/db2 directory, run the cmm_create_db.cmd script by typing the following command:
   - On a Microsoft Windows operating system, type
     `cmm_create_db dbinstance user_name password dbname drive dbalias`
   - On a UNIX operating system, type
     `cmm_create_db.sh dbinstance user_name password dbname drive dbalias`
   Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbinstance</td>
<td>The DB2 instance name where the database will be created.</td>
</tr>
<tr>
<td>user_name</td>
<td>The user ID with permissions to create the database. The user ID must</td>
</tr>
<tr>
<td></td>
<td>have SYSADM or SYSCTRL privileges, and must have DBADM privileges to</td>
</tr>
<tr>
<td></td>
<td>create the schema.</td>
</tr>
<tr>
<td>password</td>
<td>The password for the <code>user_name</code>.</td>
</tr>
<tr>
<td>dbname</td>
<td>The name of the database that will be created. The name must have a</td>
</tr>
<tr>
<td></td>
<td>maximum of 8 characters, and it cannot start with a number.</td>
</tr>
<tr>
<td>drive/path</td>
<td>On Windows, the drive on which the database objects will be created.</td>
</tr>
<tr>
<td></td>
<td>On UNIX, the path where the database objects will be created.</td>
</tr>
<tr>
<td>dbalias</td>
<td>The database alias name. This value is optional.</td>
</tr>
</tbody>
</table>

Note: Your database administrator can review the scripts to ensure they suit your environment. The initializedb.db2 script is invoked by the cmm_create_db.cmd script and defines the buffer pools and tablespaces.

2. Determine which user account IBM Cognos Metrics Manager will use to access the database.
   The user account must have the following privileges.
   - CREATETAB
   - BINDADD
   - CONNECT
   - IMPLICIT_SCHEMA
   - LOAD

Create a Microsoft SQL Server Metric Store Database
Use this procedure to create a metric store using a Microsoft SQL Server database.

Procedure
1. Determine which user account IBM Cognos Metrics Manager will use to access the database.
   This information is one of the parameters you can use when you run the command to create the database. The user account must be the database owner (dbo) or aliased to the database owner.
2. In the Application Tier Components location, in the `c10_location/configuration/schemas/cmm/sqlserver` directory, run the `cmm_create_db.cmd` script by typing the following command:

```
path_to_script cmm_create_db host_name database_name user_name password
[user_to_create]
```

Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>host_name</td>
<td>The name of the computer where the database will be created. If there are multiple instances of Microsoft SQL Server, specify <code>host_name\instance_name</code>.</td>
</tr>
<tr>
<td>database_name</td>
<td>The name of the database that will be created.</td>
</tr>
<tr>
<td>user_name</td>
<td>The user ID with permissions to create the database. The user ID must have permission to create the database, such as the <code>sa</code> user. The user ID must also have a default language of English.</td>
</tr>
<tr>
<td>password</td>
<td>The password for the <code>username</code>.</td>
</tr>
<tr>
<td>user_to_create</td>
<td>The user created by the script and given database owner permissions. This value is optional.</td>
</tr>
</tbody>
</table>

### Create an Oracle Metric Store Using a New Database

Use this procedure to create a metric store using a new Oracle database.

**Procedure**

1. Ensure that you are logged into the Oracle server as a user that is a member of the ORA_DBA user group on Windows or the dba group on UNIX.

2. Set the NLS_LANG (National Language Support) environment variable to the UTF-8 character set on the metric store computer by typing the following command:

```
NLS_LANG = language_territory.character_set
```

Examples are:

- `NLS_LANG = AMERICAN_AMERICA.UTF8`
- `NLS_LANG = JAPANESE_JAPAN.UTF8`

The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.

3. Determine which user account IBM Cognos Metrics Manager will use to access the database.

This information is one of the parameters you can use when you run the command to create the database. You must use a valid Oracle database username with the following permissions granted:

- `CREATE TABLE`, `CREATE VIEW`, `CREATE PROCEDURE`, `CREATE TRIGGER`, `CREATE TYPE`, `CREATE SEQUENCE`, and `CREATE SESSION`
- `EXECUTE` on `DBMS_LOCK` and `DBMSUTILITY` packages

The `CREATE TABLE` and `CREATE TRIGGER` permissions must be granted directly to the user account rather than to a role.

You must grant these permissions only. If you grant fewer or more privileges than specified above, the metric store will not initialize.
4. In the Application Tier Components location, in the `c10_location/configuration/schemas/cmm/oracle` directory, run the `cmm_create_db.cmd` script by typing the following command:

```
path_to_script cmm_create_db sid path database_version [user_to_create]
```

Use the values from the following table in your command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>path_to_script</td>
<td>The path to the script. For example, <code>c10_location/configuration/schemas/cmm/oracle/</code></td>
</tr>
<tr>
<td>sid</td>
<td>The SID for the new database that will be created.</td>
</tr>
<tr>
<td>path</td>
<td>The path where the data files will be created.</td>
</tr>
<tr>
<td>database_version</td>
<td>The version of Oracle software that is installed. For example, <code>oracle9</code> or <code>oracle10</code>.</td>
</tr>
<tr>
<td>user_to_create</td>
<td>The user created by the script and given database owner permissions. This value is optional.</td>
</tr>
</tbody>
</table>

**Create an Oracle Metric Store Using an Existing Database**

Use this procedure to create a metric store using an existing Oracle database.

**Procedure**

1. Ensure that you are logged into the Oracle server as a user that is a member of the ORA_DBA user group on Windows or the dba group on UNIX.

2. Set the NLS_LANG (National Language Support) environment variable to the UTF-8 character set on the metric store computer by typing the following command:

```
NLS_LANG = language_territory.character_set
```

Examples are:

- `NLS_LANG = AMERICAN_AMERICA.UTF8`
- `NLS_LANG = JAPANESE_JAPAN.UTF8`

The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.

3. Determine which user account IBM Cognos Metrics Manager will use to access the database. You must use a valid Oracle database username with the following permissions granted:

   - `CREATE TABLE`, `CREATE VIEW`, `CREATE PROCEDURE`, `CREATE TRIGGER`, `CREATE TYPE`, `CREATE SEQUENCE`, and `CREATE SESSION`
   - `EXECUTE` on `DBMS_LOCK` and `DBMSUTILITY` packages.

The `CREATE TABLE` and `CREATE TRIGGER` permissions must be granted directly to the user account rather than to a role.

You must grant these permissions only. If you grant fewer or more privileges than specified above, the metric store will not initialize.

4. Determine if the database is Unicode.

   **Tip:** One method is to type the following select statement:

   ```
   select * from NLS_DATABASE_PARAMETERS
   ```
If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database and specify AL32UTF8 for the database character set parameters. The `cmm_create_db.cmd` script mentioned in "Create a DB2 Metric Store Database" on page 156 creates a database with AL32UTF8 character encoding.

**Manually Define the Deployment Location for Metric Studio**

If your IBM Cognos Business Intelligence product includes IBM Cognos Metrics Manager, you must manually define a deployment location for Metric Studio in the following situations:

- if you installed more than one metric server
- if your metric server is separate from Content Manager

If you have just one metric server and it is on the same computer as Content Manager, IBM Cognos Metrics Manager is automatically configured with a deployment location.

Examples where a deployment location does not need to be manually defined:

- single server with Content Manager + Application Tier Components + Gateway
- multiple servers, where Server A = Content Manager + Application Tier Components
  
  Server B = Gateway

Examples where a deployment location must be manually defined:

- multiple servers, where Server A = Content Manager
  
  Server B = Application Tier Components
  
  Server C = Gateway
- multiple servers, where Server A = Content Manager + Application Tier Components
  
  Server B = Application Tier Components
  
  Server C = Application Tier Components
  
  Server D = Gateway

The deployment location must be defined on every metric server computer (where Application Tier Components are installed).

**Important:** Create just one deployment location folder. The deployment location is selected when a metric package is created. The same deployment location must be used for every metric package. If the deployment location file contains multiple deployment locations, then to avoid the potential for errors, delete all but one location.

**Manually Define the Deployment Location for Metric Studio (UNIX/Linux)**

In a distributed installation, you must manually define a deployment location for Metric Studio.

**Before you begin**

Before you define the deployment location for Metric Studio, create a shared folder that will serve as the deployment location. The folder must be accessible to all of the metric server computers.
**Procedure**

1. On the metric server computer (where Application Tier Components are installed), go to `c10_location/configuration` and edit `deployment_locations.xml` using an XML editor.

2. Select the following section:
   ```xml
   <DeploymentLocation>
     <name>Unix
     Mount</name>
     <value>/mount/deployment</value>
   </DeploymentLocation>
   ```
3. Cut the section and paste it after this line:
   ```xml
   DELETE this line to remove the xml comment tag -->
   ```
4. Replace `/mount/deployment` with the NFS mounted path to the shared folder.
   If IBM Cognos BI is deployed to an application server other than Tomcat, ensure that the location is an absolute path.

**Manually Define the Deployment Location for Metric Studio (Windows)**

In a distributed installation, you must manually define a deployment location for Metric Studio.

**Before you begin**

Before you define the deployment location for Metric Studio, create a shared folder that will serve as the deployment location. The folder must be accessible to all of the metric server computers.

**Procedure**

1. On the metric server computer (where Application Tier Components are installed), go to `c10_location/configuration` and edit `deployment_locations.xml` using an XML editor.

2. Select the following section:
   ```xml
   <DeploymentLocation>
     <name>windows
     share</name>
     <value>\winserver\deployment
     location</value>
   </DeploymentLocation>
   ```
3. Cut the section and paste it after this line:
   ```xml
   DELETE this line to remove the xml comment tag -->
   ```
4. Replace `\winserver\deployment location` with the UNC path to the shared folder.
   If IBM Cognos BI is deployed to an application server other than Tomcat, ensure that the location is an absolute path.

**Set Up the Database Client for the Metric Store**

**Set Up the Database Client for a DB2 Metric Store**

Use this procedure to setup the database client for a DB2 metric store.

**Procedure**

1. Install the DB2 client software on the Application Tier Components computer.
2. If the metric store is on a different computer from the Application Tier Components, configure a database alias to the metric store by running the DB2 Client Configuration Assistant.

On a UNIX or Linux operating system, use the DB2 command line interface.

**Note:** If the metric store database and the Application Tier Components are on the same computer, the metric store name automatically becomes the alias.

3. Copy the following files from `DB2_installation/sqlib/java` directory to the `c10_location/webapps/p2pd/WEB-INF/lib` directory.
   - the universal driver file, `db2jcc.jar`
   - the license file
     - for DB2 on Linux, UNIX, or Microsoft Windows operating systems, `db2jcc_license_cu.jar`
     - for DB2 on a z/OS operating system, `db2jcc_license_cisuz.jar`

If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

**Tip:** To check the driver version, run the following command

```
java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2jcc -version
```

If the directory contains a `db2java.jar` or `db2java.zip` file, delete the file.

### Set Up the Database Client for an Oracle Metric Store

Use this procedure to setup the database client for an Oracle metric store.

**Procedure**

1. On the computer where the Oracle client is installed, go to the `ORACLE_HOME/jdbc/lib` directory.
2. Install the SQL Loader utility on the computer where Application Tier Components are installed.

### Set Up the Database Client for a Microsoft SQL Server Metric Store

Use this procedure to setup the database client for a Microsoft SQL Server metric store.

**Procedure**

1. Install the `bcp` utility on every Windows computer where Application Tier Components for IBM Cognos Metrics Manager are installed.
2. Add the location of the `bcp` utility to the path environment variable.

### Create a Metric Package

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard. A metric package is an IBM Cognos Connection representation of an IBM Cognos Metrics Manager application.
A metric package contains connection information, reports, and metric management tasks for that application. The metric package content is stored in a metric store.

Before you can use the New Metric Package wizard, you must have access to a metric store used with Metrics Manager version 2.0 or later or you must create a database for a new metric store (see “Create the Metric Store Database” on page 206). For data to be transferred successfully, the user account that is used to access the database must have a default language of English.

You open the New Metric Package wizard from the toolbar in IBM Cognos Connection and create a metric package using one of the following:

• a new data source connection to a metric store
• an existing data source connection to a metric store
• an existing metric store if the database was used with an earlier version of IBM Cognos Metrics Manager 8.1 or later

Use the wizard to define the metric package name and the data source connection to the metric store. For a new metric store, you also provide the information necessary to initialize the database, including the start and end dates of the fiscal year.

Create a Metric Package Using a New Data Source Connection
Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

Before you begin

Before you can use the New Metric Package wizard, you must have access to a metric store used with Metrics Manager version 2.0 or later or you must create a database for a new metric store (see “Create the Metric Store Database” on page 206). For data to be transferred successfully, the user account that is used to access the database must have a default language of English.

Procedure

1. Open IBM Cognos Connection by connecting to the IBM Cognos Business Intelligence portal and clicking **IBM Cognos Content** on the **Welcome** page.

2. Click the **New metric package** button.

3. Type a name and description for the IBM Cognos Metrics Manager application to represent this metric package, and click **Next**.

4. Click **New data source**.

5. Type a name and description for the data source connection for the metric store that contains the content for this metric package, and click **Next**.

6. In the **Type** box, click the database type.

7. Select the isolation level, and click **Next**.

8. Specify the information required for your database type and click **Finish**.

   • For a Microsoft SQL Server database, type the name of the database server using the syntax `server_name` or `server_name\instance_name` (if there are multiple instances of Microsoft SQL Server) or `server_name:port` (if using non-default ports). Type the database name. Select **Signons**, select the
Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

The user account must have the default language set to English.

- For an Oracle database, type the connection string. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

- For a DB2 database, type the name of the database as defined in the DB2 client. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.

The default configuration of the data source connection uses a Type 2 Java Database Connectivity (JDBC) connection. To configure Metrics Manager to use a Type 4 JDBC connection, set the connection string property to 

\[ \text{JDBC\_TYPE4\_INFO=host:port/dbName} \]

where host is the name of the server where the DB2 server is installed, port is the what the DB2 server uses to accept client connections, and dbName is the name of the database as defined on the database server.

In most cases, a collation sequence is not required. If you want to provide one, ensure the value you enter is the same as the collation sequence specified when the database was created. For information about collation sequences, see the database documentation.

**Tip:** To test whether the parameters are correct, click Test the connection.

9. Click the new data source and click Next.

10. Click Next and follow the prompts to provide the information necessary to initialize the database. When you see the page that summarizes the data source details and the metric store settings, click Initialize.

11. Select Open this package with Metric Studio after closing the wizard and then click Finish.

**Results**

Metric Studio opens and the new metric package is displayed in IBM Cognos Connection. For information about managing the metric store, including how to load data, see the IBM Cognos BI Administration and Security Guide.

**Create a Metric Package Using an Existing Data Source Connection**

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

**Procedure**

1. Open IBM Cognos Connection by connecting to the IBM Cognos BI portal and clicking IBM Cognos Content on the Welcome page.

2. Click the New metric package button.

3. Type a name and description for the IBM Cognos Metrics Manager application to represent this metric package, and click Next.

4. Click New data source and click Next.
5. Click Next and follow the prompts to provide the information necessary to initialize the database. When you see the page that summarizes the data source details and the metric store settings, click Initialize.
6. Select Open this package with Metric Studio after closing the wizard and then click Finish.

Results

Metric Studio opens and the new metric package is displayed in IBM Cognos Connection. For information about managing the metric store, including how to load data, see the IBM Cognos BI Administration and Security Guide.

Create a Metric Package Using an Existing Metric Store

Before users can use IBM Cognos Metrics Manager, you must create at least one metric package using the New Metric Package wizard.

Procedure

1. Open IBM Cognos Connection by connecting to the IBM Cognos BI portal and clicking IBM Cognos Content on the Welcome page.

2. Click the New metric package button.

3. Type the name and description for the IBM Cognos Metrics Manager application to represent this metric package and click Next.

4. Click New data source.

5. Type the name and description for the data source connection for the metric store that contains the content for this metric package, and click Next.

6. In the Type box, click the database type and click Next.

7. Specify the information required for your database type:
   - For a Microsoft SQL Server database, type the name of the database server using the syntax server_name or server_name\instance_name (if there are multiple instances of Microsoft SQL Server) or server_name,port (if using non-default ports). Type the database name. Select Signons, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.
     The user account must have the default language set to English.
   - For an Oracle database, type the connection string. Under User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.
   - For a DB2 database, type the name of the database and the connection string. Select User ID, select the Password and Create a signon that the Everyone group can use check boxes, and type the user ID and password of the user account with access to the database.
     In most cases, a collation sequence is not required. If you want to provide one, ensure the value you enter is the same as the collation sequence specified when the database was created. For information about collation sequences, see the database documentation.

    Tip: To test whether the parameters are correct, click Test the connection.

8. Click Next.
9. Select **Open this package with Metric Studio after closing the wizard** and then click **Finish**.
   Metric Studio opens and the new metric package is displayed in IBM Cognos Connection.

10. Click the new data source and click **Next**.
11. Click **Upgrade**.
   The wizard updates the database schemas and other information.

**Results**

For information about managing the metric store, see the *Administration and Security Guide*.

---

**Installing and Configuring the Gateway**

You can install the gateway on one or more computers, depending on your environment. If you have a Web farm, you may want to install an IBM Cognos BI gateway on each Web server. Using multiple Web servers to manage incoming requests provides better service. If you install only the gateway component on the same computer as the Web server, your Web server manages the core Web services and does not process user requests. This separation of processing may be required if you have a network firewall between the Web server and your other server components.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, IBM Cognos BI uses the existing configuration data for the gateway computers. However, if you installed the gateway in a new location, you must configure the gateway.

If you plan to install IBM Cognos Metrics Manager and share resources with the IBM Cognos BI gateway, install the gateway on a 32-bit system. For more information, see **“Install the Gateway for IBM Cognos Metrics Manager” on page 220**.

Ensure that the computer where you installed the active Content Manager is configured and available before you configure gateway computers.

Perform the following steps to install and configure the gateway:

- [Install the gateway components](#)
- [Install the gateway for IBM Cognos Metrics Manager components](#) if necessary
- [Install fix packs](#) if available
- [Start IBM Cognos Configuration](#)
- [Configure environment and security properties for the gateway](#)
- [Configure your Web server](#)
- [Test the gateway installation](#)

**64-bit Installations**

The IBM Cognos BI gateway provides 32-bit libraries, whether you install on a 64-bit server or a 32-bit server. Some Web servers, such as Apache Web Server, cannot load a 32-bit compiled library in a 64-bit compiled server. In that situation, install the 32-bit version of the IBM Cognos gateway on a 32-bit Web server.
Install the Gateway Components

You can install the gateway on one or more Web server computers.

If you plan to install IBM Cognos Metrics Manager and share resources with the IBM Cognos BI gateway, install the gateway on a 32-bit system.

Installing the gateway components on UNIX or Linux

You can install the gateway on one or more computers, depending on your environment. If you have a Web farm, you may want to install an IBM Cognos BI gateway on each Web server.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Set the JAVA_HOME environment variable to point to the installation location of your Java Runtime Environment (JRE).
   An example of the installation location of a Java Runtime Environment is /directory/java/java_version/jre.
   IBM Cognos BI requires a JVM, such as the Java that is provided by IBM, to run on a Linux operating system.
   If you are installing in a location with other IBM Cognos BI components, use the existing JAVA_HOME environment variable.
3. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:
   _M_ARENA_OPTS 1:4
   This increases the memory allocation for HP-UX to more closely match that of other UNIX operating systems.
4. On AIX, set the AIXTHREAD_SCOPE environment variable as follows:
   AIXTHREAD_SCOPE=S
   This sets the contention scope for user threads to system-wide, which supports more efficient scheduling of user threads.
5. If installing from a download, go to the location where the installation files were downloaded and extracted.
6. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   • Add the pfs_mount directory in your path.
     For example,
     PATH=/usr/sbin:$PATH
     export PATH
   • To start the required NFS daemons and run the daemons in the background, type bg pfs_mountd and then type bg pfsd
   • To mount the drive, type
     pfs_mount -t rrip <device><mount_dir> -o xlat=unix
     For example,
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   • When the installation is complete, type pfs_umount /cdrom and kill the pfsd and pfs_mountd daemons to unmount the disk.
7. To start the installation wizard, go to the operating system directory and then type 

```
issetup
```

**Note:** When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on UNIX or Linux, first set environment variables LANG=C and LC_ALL=C (where C is the language code, for example ja_JP.PCK on Solaris), and then start the installation wizard.

If you do not use XWindows, run an unattended installation (see Chapter 19 “Setting Up an Unattended Installation and Configuration,” on page 491).

8. Follow the directions in the installation wizard and copy the required files to your computer.

- When selecting the directory, consider the following:
  - Install Gateway components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.
  - If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI, and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.
  - If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
- When selecting components, clear all components except **Gateway**.

9. In the **Finish** page of the installation wizard, do the following:

- If you want to see the log files, click **View** for the appropriate log file.
- If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
- Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
  - You can later configure IBM Cognos BI using IBM Cognos Configuration by typing cogconfig.sh in the `c10_location/bin` directory, or by running a silent configuration or editing cogstartup.xml in `c10_location/configuration` directory.
- Click **Finish**.

10. Append the `c10_location/bin` directory to the appropriate library path environment variable.

- For Solaris and Linux, `LD_LIBRARY_PATH`
- For AIX, `LIBPATH`
- For HP-UX, `SHLIB_PATH`

**Results**

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see “Translated Product Documentation” on page 293.
Installing the gateway components on Windows

You can install the gateway on one or more computers, depending on your environment. If you have a Web farm, you may want to install an IBM Cognos BI gateway on each Web server.

Procedure

1. If you are installing to a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Do one of the following:
   - Insert the IBM Cognos product disk.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.
4. Follow the directions in the installation wizard to copy the required files to your computer.
   - When selecting the directory, consider the following:
     Install Gateway components in a directory that contains only ASCII characters in the path name. Some Microsoft Windows operating system Web servers do not support non-ASCII characters in directory names.
     If you are installing IBM Cognos BI on a computer that has ReportNet or an earlier version of IBM Cognos BI and you want to keep the earlier version, you must install IBM Cognos BI in a different directory.
     If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
   - When selecting components, clear all components except Gateway.
5. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure IBM Cognos BI immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
   - You can later configure IBM Cognos BI using the Windows Start menu to start IBM Cognos Configuration from the shortcut folder.
   - Click Finish.

Results

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see “Translated Product Documentation” on page 293.
Install the Gateway for IBM Cognos Metrics Manager

If you are installing IBM Cognos Metrics Manager with the IBM Cognos BI server and you want to share resources, you must install the Gateway for IBM Cognos Metrics Manager in the same location as the Gateway for the IBM Cognos BI server. If you want your scorecarding product to operate independently of the IBM Cognos BI server, install the Gateway for IBM Cognos Metrics Manager in a different location from the Gateway for the IBM Cognos BI server.

You may also want to install Metric Designer (see “Installing and Configuring Metric Designer” on page 235).

IBM Cognos Metrics Manager and 64-bit Systems

IBM Cognos Metrics Manager is only available in a 32-bit version. You must install it on a 32-bit system. If sharing resources with IBM Cognos BI server, install the Gateway from both products in the same directory on a 32-bit system.

Installing Fix Packs

IBM provides interim maintenance packages that contain updates to one or more components in your IBM Cognos product. If a fix pack is available when you are installing or upgrading your product, you must install it after you install the IBM Cognos components.

If a fix pack becomes available after your IBM Cognos product has been deployed, you must stop the service, install the fix pack in the same location as the IBM Cognos components, and then start the service.

Fix packs are cumulative. When you install the latest fix pack, it includes updates from all the previous fix packs. Fix packs are available for download from IBM Support at [http://www.ibm.com/support/us/en/](http://www.ibm.com/support/us/en/)

Note: Fix packs are not standalone installations. You must install them on computers that have IBM Cognos components installed. Install the fix packs that are appropriate for your product version. To check your version, open the component list file at c10_location\cmplst.txt and check the line that starts with C8BISRVR_version=.

Installing Fix Packs (Windows)

Use the following steps to install the fix pack.

Before you begin

Before you install the fix pack:
1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

Procedure
1. Insert the fix pack disk for the Windows operating system or go to the location where you downloaded and extracted the files.
2. On the disk or in the download location, go to the win32 directory and double-click the issetup.exe file.
3. Follow the directions in the installation wizard, installing in the same location as your existing IBM Cognos components.
   The isetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.
4. To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.
5. If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.
6. If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server. For instructions, see "Configure Application Server Properties and Deploy IBM Cognos Components" on page 453.

**Installing Fix Packs (UNIX/Linux)**

Use the following steps to install the fix pack.

**Before you begin**

Before you install the fix pack:
1. If your IBM Cognos product is running, open IBM Cognos Configuration and stop the IBM Cognos service.
2. Create a backup of the content store database.
3. Back up any customized files from the current installation.

**Procedure**

1. If using a disk, mount the fix pack disk that is appropriate for your UNIX or Linux operating system, using Rock Ridge file extensions.

   **Important:** To mount the IBM Cognos disk on HP-UX, do the following:
   - Add the pfs_mount directory in your path.
     - For example,
       
       ```
       PATH=/usr/sbin:/PATH
       export PATH
       ```
   - To start the required NFS daemons and run the daemons in the background, type **bg pfs_mountd** and then type **bg pfsd**
   - To mount the drive, type
     
     ```
     pfs_mount -t rrip <device> <mount_dir> -o xlat=unix
     ```
     - For example,
       
       ```
       pfs_mount -t rrip /dev/dsk/c0t2d0 /cdrom -o xlat=unix
       ```
     - You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
     - When the installation is complete, type **pfs_umount /cdrom** and kill the pfsd and pfs_mountd daemons to unmount the disk.

2. If using a download, go to the location where you downloaded and extracted the fix pack files.
3. To start the installation wizard, type
   
   ```
   /issetup
   ```

   If you do not use XWindows, run an unattended installation (see "Set Up an Unattended Installation Using a File From an Installation on Another Computer" on page 492).
Follow the directions in the installation wizard to install to the same location as your existing IBM Cognos components.
The isetup program prompts you to allow the fix pack to create a backup copy in the installation folder before copying new files.

To return a deployed IBM Cognos product to service, open IBM Cognos Configuration, save the configuration, and then start the IBM Cognos service.

If you have a distributed environment, repeat these steps for all remaining IBM Cognos servers.

If you are running the IBM Cognos product on an application server other than the default, Tomcat, redeploy the IBM Cognos product to the application server.

For instructions, see “Configure Application Server Properties and Deploy IBM Cognos Components” on page 453.

Start IBM Cognos Configuration

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before starting IBM Cognos Configuration, ensure that the operating environment is properly set up. For example, ensure that all environment variables have been set.

On UNIX or Linux operating systems, do not start IBM Cognos Configuration in the last page of the installation wizard. Additional setup is required before you can configure IBM Cognos BI. For example, you must update your Java environment.

On a Microsoft Windows operating system, you can start IBM Cognos Configuration in the last page of the installation wizard only if additional setup is not required. For example, if you use a database server other than Microsoft SQL or Cognos Content Database for the content store, copy the Java Database Connectivity (JDBC) drivers to the appropriate location before you start the configuration tool.

Starting IBM Cognos Configuration (UNIX/Linux)

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin

Ensure that user or service account is set up.

Procedure

1. Go to the c10_location/bin directory and then type /cogconfig.sh

2. If you want to access the help for IBM Cognos Configuration, go to the c10_location/configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.

For example, if you use Firefox, add the following text to the file:

```
BrowserPath=Web_browser_location/firefox
```

where Web_browser_location is a path, such as /usr/local/bin/

Your Web browser must support the following syntax:
Starting IBM Cognos Configuration (Windows)

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos Business Intelligence components during the installation and configuration process and to start and stop IBM Cognos services.

Before you begin

Ensure that user or service account is set up.

Procedure

1. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
   If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and have installed the product to the Program Files (x86) directory, start IBM Cognos Configuration as an Administrator.

2. If you want to access the help for IBM Cognos Configuration, go to the c10_location\configuration directory and edit the cogconfig.prefs file to add the location of your Web browser.
   For example, if you use Firefox, add the following text to the file:
   BrowserPath=Web_browser_location\firefox
   where Web_browser_location is a path, such as \usr\local\bin\
   Your Web browser must support the following syntax:
   $ <Web_browser_location> <URL>

Configure Environment and Security Properties for Gateway Computers

If you install the gateway component on a different computer than Content Manager or Application Tier Components, you must configure the gateway computer so that it knows the location of a dispatcher. A dispatcher is installed on every Content Manager and Application Tier Components computer. Configure the gateway to use the dispatcher on an Application Tier Components computer.

For failover protection, you can configure more than one dispatcher for a gateway computer. When multiple dispatchers are configured, requests are normally routed to the first dispatcher in the list. If this dispatcher becomes unavailable, the gateway determines the next functioning dispatcher on the list and routes requests there. The primary dispatcher status is monitored by the gateway, and requests are routed back to this component when it returns to service.

After you do the required configuration tasks, the gateway computer can work in your environment.

Before you begin

Ensure that the computers where you installed Content Manager are configured and the default active Content Manager computer is available before you configure gateway computers.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, under Gateway Settings, specify the values for Dispatcher URIs for the gateway:
   - Click in the value column.
   - Click the edit button.
   - Change the localhost portion of the URI to the name or IP address of an Application Tier Components computer.

   This will ensure that users in different locations can connect to reports and workspaces that are sent by email.

   **Tip:** If you want to send requests to the dispatcher from an Software Development Kit application or an IBM Cognos Bi modeling tool that is outside of a network firewall, connect to a dedicated gateway that is configured to connect to the dispatcher using the internal dispatcher URI for your environment (for example, http://localhost:9300/p2pd/servlet/dispatch). For security reasons, the default setting for the Dispatcher URI for gateway property prevents the dispatcher from accepting requests for an Software Development Kit application or modeling tool that is outside the firewall. Ensure that you configure appropriate security for this dedicated gateway, such as SSL (see “Configuring the SSL Protocol” on page 370). Do not change your main gateway to use the internal dispatcher URI. Doing so will reduce the security of the IBM Cognos BI portal and studios. For more information about the modeling tool and network firewalls, see “Firewall Considerations” on page 39.

   - If you want to add another URI, click Add and change the localhost portion of the new URI to the name or IP address of another Application Tier Components computer.

   **Tip:** If you want to use the dispatcher on a standby Content Manager computer, ensure that you add it after you add the Application Tier Components computers. If you add the dispatcher from the active Content Manager computer, ensure that it is last in the list.

   - After you specify all the URIs, click OK.

4. In the Explorer window, under Security > Cryptography, click Cognos, the default cryptographic provider.

5. Under the Certificate Authority settings property group, set the Password property to match what you configured on the default active Content Manager computer.

6. Ensure that all other cryptographic settings match what you set on the default active Content Manager computer.

7. Test that the symmetric key can be retrieved. In the Explorer window, right-click Cryptography and click Test.

   IBM Cognos BI components check the common symmetric keys (CSK) availability.

8. From the File menu, click Save.

**Configure the Web Server**

For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal. If you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for
each product or instance and then associate the aliases for that product or instance to the application pool. The steps for creating an application pool vary depending on your operating system.

For IBM Cognos BI for reporting, you must also set the content expiry for the images directory in your Web server so that the Web browser does not check image status after the first access.

On UNIX and Linux operating systems, the account under which the Web server runs must have read access to the cogstartup.xml file in the c10_location/configuration directory. By default the cogstartup.xml file has read permission for others. If you run your Web server under a specific group, you can change the cogstartup.xml file permissions to ensure that it belongs to the same group as the Web server. You can then remove the read permission for others.

Creating Virtual Directories
For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal.

Procedure
1. Create the virtual directories shown in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias and you must change the virtual directory in the Gateway URI property to match the new IBM Cognos alias.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, you can continue to use the existing aliases. If you install IBM Cognos BI reporting components in a different location from the earlier version, change the existing aliases to include the new location. If you have more than one version of ReportNet or IBM Cognos BI on one computer, you must use different alias names for IBM Cognos BI.

For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. The ibmcognos/cgi-bin alias must be defined as a ScriptAlias.

2. If you want to use the Report Studio image browser, enable Web Distributed Authoring and Versioning (WebDAV) on your Web server.

   If you use Apache Web Server, specify a directory in which to enable WebDAV. For information about configuring WebDAV, see your Web server documentation.
   
   If you use Microsoft Internet Information Services (IIS), enable the Read and Directory Browsing properties for the URL you want to access.

3. For IBM Cognos BI for reporting, set the content expiry on the c10_location/webcontent/pat/images virtual directory in your Web server.

   Each time a user opens Report Studio, their Web browser checks with the Web server to determine if images are current. Because there are over 600 images,
this can result in excess network traffic. You can postpone this check until a
specified date by using the content expiry feature of the Web server.
For information on setting content expiry, see the documentation for your Web
server.

Note: When you upgrade, Report Studio users must clear their Web browser

cache to get the latest images.

Results

If you use Web aliases other than ibmcognos, or your Web server is on another
computer, or you are using Microsoft Internet Application Interface (ISAPI),
apache_mod or a servlet gateway, change the Gateway URI when you configure
IBM Cognos components.

Creating an Application Pool

If you are using Microsoft IIS as your Web server and you plan to run more than
one IBM Cognos BI product, or several instances of the same product, on one
computer, you must create a separate application pool for each product or instance
and then associate the aliases for that product or instance to the application pool.

For more information about creating an application pool, see your Web server
documentation.

Test the Gateway

You can test the installation using a Web browser.

Procedure

1. Ensure that your Web server is running.
2. Open a Web browser.
3. In your address box, type the Gateway URI from IBM Cognos Configuration.
   For example,
   
   http://host_name:port/ibmcognos
   
   The Welcome page of the IBM Cognos BI portal appears.
Chapter 9. Install and Configure Modeling Tools for Reporting and Scorecarding

After you install and configure IBM Cognos Business Intelligence server components, you can install and configure the following modeling components for reporting and scorecarding:

- **Framework Manager**
- **Metric Designer**

**Installing and Configuring IBM Cognos Framework Manager**

You can install IBM Cognos Framework Manager, the metadata modeling tool for IBM Cognos Business Intelligence for reporting, on the same computer as other IBM Cognos BI components, or on a different computer. All required files are copied to one computer. Default settings are used for the configuration. You can change these default settings if necessary, or if you install Framework Manager on a separate computer from IBM Cognos BI.

If you upgraded from an older version of Framework Manager, you can use the same models and projects that you used with the older version. To upgrade existing projects, you must open them in the new version of Framework Manager.

Framework Manager is available as a 32-bit installation only. It must be installed on a 32-bit computer with a Microsoft Windows operating system.

If you are upgrading Framework Manager from an older version, you must first uninstall the older version of Framework Manager. For more information, see Chapter 20, “Uninstalling IBM Cognos BI,” on page 497.

Before you install Framework Manager, close all programs that are currently running to ensure that the installation program copies all the required files to your computer.

Also, ensure that you have administrator privileges for the Windows computer you are installing on. If you are not an administrator, ask your system administrator to add you to the Administrator group on your computer. Administrator privileges are also required for the account that is used to run Framework Manager.

Install and configure all IBM Cognos BI server components before you install Framework Manager.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names. Installing Framework Manager in directory that has an apostrophe in the path name may result in the help not opening properly.

If you are installing the modeling tool in the same directory as IBM Cognos BI and do not stop the IBM Cognos services, you are prompted to do so during the installation.
To help you manage, share, and secure different versions of your metadata, you can configure Framework Manager to use an external source control system. For more information, see the section about using external repository control in the Framework Manager User Guide.

**System Requirements for Framework Manager**

Before you install Framework Manager, ensure that the Windows computer meets IBM Cognos BI software and hardware requirements. The size of your models determines the hardware requirements, such as disk space.

The following table lists the minimum hardware and software requirements to run Framework Manager.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 512 MB</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 500 MB of free space on the drive that contains the temporary directory used by IBM Cognos BI</td>
</tr>
<tr>
<td>Database</td>
<td>Database client software installed on the same computer as Framework Manager (Oracle, DB2, or Sybase only. Microsoft SQL drivers are installed with IBM Cognos BI by default)</td>
</tr>
<tr>
<td></td>
<td>Database connectivity set up</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Data Access Component (MDAC) 2.6 or later for use with product samples</td>
</tr>
</tbody>
</table>

To help you manage, share, and secure different versions of your metadata, you can configure Framework Manager to use an external source control system. For more information, see the section about using external repository control in the Framework Manager User Guide.

To install and configure Framework Manager, follow these steps:

1. Install Framework Manager
2. Update the Java Environment
3. Set up the data source environment for Framework Manager
4. Configure environment properties for Framework Manager
5. Test the Framework Manager installation

**Default Settings for Framework Manager**

The following table lists the default settings for the IBM Cognos BI ports and URIs that are used by Framework Manager.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the IBM Cognos BI gateway</td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>Component</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Log Server Port</td>
<td>9362</td>
<td>The port used by the local log server</td>
</tr>
</tbody>
</table>

After installation, you can use the configuration tool to change the default settings. You can also change them by editing the cogstartup.xml file in the `c10_location\configuration` directory.

**Install Framework Manager**

To install Framework Manager, use the appropriate product disk. When prompted to select the components, install all the components that are selected by default.

**Procedure**

1. If you are installing in a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Do one of the following:
   - Insert the product disk.
     - If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.
3. Select the language to use for the installation.
   - The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.
4. Follow the directions in the installation wizard to copy the required files to your computer.
   - If you are installing IBM Cognos BI on a computer that already has ReportNet or an older version of IBM Cognos BI, and you want to keep the older version running, you must install IBM Cognos BI in a different directory.
   - If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.
5. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - If the server components are configured, select the IBM Cognos Configuration check box so that you can configure Framework Manager immediately.
     - If the server components are not configured, ensure that the IBM Cognos Configuration check box is clear. You can later configure Framework Manager using the Microsoft Windows operating system Start menu to start IBM Cognos Configuration from the shortcut folder.
   - Click Finish.

**What to do next**

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.
Update the Java Environment

In a distributed installation, Framework Manager must load the cryptographic keys from the IBM Cognos BI server. To do this, set up your Java environment by ensuring that the JAVA_HOME environment variable is set up on the server and on the Framework Manager computer.

If you do not have a JAVA_HOME variable already set on a Microsoft Windows operating system, the JRE files provided with Framework Manager will be used, and you do not have to update any files in your environment.

If you want to use your own JRE and have JAVA_HOME set to that location on Windows, the JRE files from that location will be used.

The default Windows JRE that is provided with Framework Manager includes a restricted policy file that limits you to certain cryptographic algorithms and cipher suites. If your security policy requires a wider range of cryptographic algorithms and cipher suites than are shown in IBM Cognos Configuration, you can download and install the unrestricted JCE policy file.

For information about configuring the cryptographic provider to support your security policy, see "Configuring Cryptographic Settings" on page 353.

Update the Java Environment

To support the cryptographic services in IBM Cognos Business Intelligence, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

Procedure

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   For example, to set JAVA_HOME to a JRE that you are already using, the path is \java_location\bin\jre\version.
2. If your security policy requires it, download and install the unrestricted JCE policy file.
   For Java that is provided by IBM, the unrestricted JCE policy file is available from the following location:
   For information about configuring the cryptographic provider to support your security policy, see "Configuring Cryptographic Settings" on page 353.

Data Sources and Framework Manager

The IBM Cognos BI modeling tools create and manage metadata. Framework Manager creates and manages metadata for the reporting functions. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for Framework Manager. Commonly, these things depend on the other technology you use for your data or import source.

If you upgraded from an older version of Framework Manager, you are not required to set up anything in the data source environment. You must set up the data source environment only if you installed Framework Manager in a different location from the older version.
If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) 2000 data source, you must create a separate IBM Cognos BI instance for each language.

Users operating in different languages can connect to an MSAS 2005 data source from the same instance of IBM Cognos BI. Modelers must create a separate package for each language. Users can run reports in any language.

For more information about data source connections, see the IBM Cognos Administration and Security Guide.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk.

**Setting up the data source environment for Framework Manager**

Perform the following steps in the location where you installed Framework Manager.

If you use a Sybase data source, these steps are not necessary.

**Procedure**

1. Set the environment variable for multilingual support:
   - For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager or Metric Designer and the IBM Cognos BI server are installed by typing the following command:
     
     ```
     NLS_LANG = language_territory.character_set
     ```

     Examples are:
     
     ```
     NLS_LANG = AMERICAN_AMERICA.UTF8
     NLS_LANG = JAPANESE_JAPAN.UTF8
     ```

     The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
   - For DB2, set the DB2CODEPAGE environment variable to a value of 1252.
     For more information about whether to use this optional environment variable, see the DB2 documentation.

   No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add $ORACLE_HOME/lib to your LD_LIBRARY_PATH.
   When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.

   Where default values are specified, you may want to modify the values on the SAP system.
   - **S_RFC**
     Set the **Activity** field to the value: 16
     Set the **Name of RFC to be protected** field to the value: SYST, RSOB, SUGU, RFC1, RS_UNIFICATION, RSAB, SDTX, SU_USER
Set the **Type of RFC** object to be protected field to the value: FUGR

- **S_TABU_DIS**
  - Set the **Activity** field to the value: 03
  - Set the **Authorization Group** field to the value: &NC&

  **Note:** &NC& represents any table that does not have an authorization group. For security reasons, create a new authorization group and assign the table RSHIEDIR to it. The new authorization group restricts the user’s access to the above table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

- **S_USER_GRP**
  - Set the **Activity** field to the value: 03, 05
  - Set the **User group in user master main** field to the default value.

- **S_RS_COMP**
  - Set the **Activity** field to the default value.
  - Set the **Info Area** field to the value: InfoArea Technical Name
  - Set the **Info Cube** field to the value: InfoCube Technical Name
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.

- **S_RS_COMP1**
  - Set the **Activity** field to the default value.
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.
  - Set the **Owner (Person Responsible)** field to the default value.

- **S_RS_HIER**
  - Set the **Activity** field to the value: 71
  - Set the **Hierarchy Name** field to the value: Hierarchy Name
  - Set the **InfoObject** field to the value: InfoObject Technical Name
  - Set the **Version** field to the value: Hierarchy Version

- **S_RS_ICUBE**
  - Set the **Activity** field to the value: 03
  - Set the **InfoCube sub-object** field to the values: DATA and DEFINITION
  - Set the **Info Area** field to the value: InfoArea Technical Name
  - Set the **InfoCube** field to the value: InfoCube Technical Name

For more information about SAP BW authorization objects, see Transaction SU03.

**Environment Properties for Framework Manager Computers**

When you install Framework Manager on a different computer from the non-modeling components of IBM Cognos BI, you must configure it to communicate with the other components.

If you install Framework Manager on the same computer as the non-modeling components of IBM Cognos BI, no configuration is required if you

- configure your Web server using the default virtual directories
- use the default ports
- use the default resources
• use the default cryptographic settings

If IBM Cognos BI was installed in more than one location, ensure that all URIs point to the correct version of IBM Cognos BI. Framework Manager must be configured to use the same version of IBM Cognos BI.

Installations with a Firewall

When the modeling tool is outside a network firewall that protects the Application Tier Components, communication issues with the dispatcher can arise. To avoid communication issues, you can install the modeling tool in the same architectural tier as the Application Tier Components or you can install and configure a gateway that is dedicated to modeling tool communications.

For more information about the modeling tool and network firewalls, see “Firewall Considerations” on page 39.

The steps in this topic describe how to configure the modeling tool computer when the computer is inside or outside of the network firewall.

For more information about configuring the dedicated gateway computer, see “Configure Environment and Security Properties for Gateway Computers” on page 223.

Prerequisites

Ensure that the IBM Cognos service on at least one Content Manager computer is running. This ensures that the certificate authority service issues a certificate to the Framework Manager computer.

Ensure that the Web server is configured and running.

You must also set up the data sources before you configure Framework Manager.

Configuring Framework Manager inside the network firewall

Use the following steps to set up communication between Framework Manager and the other IBM Cognos Business Intelligence components when Framework Manager is inside a network firewall.

Procedure

1. On the computer where you installed Framework Manager, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, in the Gateway URI box, type the appropriate value.
   • To use ISAPI, replace cognos.cgi with cognosisapi.dll.
   • To use an Apache Web server, type the following syntax:
     For Apache 1.3 module,
     http://host_name:port/ibmcognos/cgi-bin/mod_cognos.dll
     For Apache 2.0 module,
     http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll
     For Apache 2.2.x module,
     http://host_name:port/ibmcognos/cgi-bin/mod2_2_cognos.dll
     Ensure that you configured your Apache Web Server.
To use IBM HTTP Server, type the following syntax:

http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll

Ensure that you configured your IBM HTTP Web Server.

To use a servlet gateway, type the following syntax:

http[s]://host_name:port/context_root/servlet/Gateway

where context_root is the value you assigned to the ServletGateway Web application when you deployed the ServletGateway application.

Note: Ensure that you configured your Web server to support the servlet gateway.

If you are not using a Web server, then to use the dispatcher as the gateway, type the following syntax:

http[s]://host_name:port/p2pd/servlet/dispatch/ext

4. Change the host name portion of the Gateway URI from localhost to either the IP address or the host name of the computer where the Gateway component is installed.

5. Specify the value for the Dispatcher URI for external applications by typing the URI of the server where Application Tier Components are installed. This value will be the same as the Internal dispatcher URI property on your Application Tier Components computer.

6. In the Explorer window, under Cryptography, click Cognos, the default cryptographic provider.

7. Under the Certificate Authority settings property group, for the Password property, type the same password you configured on the default active Content Manager computer.

8. From the File menu, click Save.

Configuring Framework Manager outside the network firewall

Use the following steps to set up communication between Framework Manager and the other IBM Cognos Business Intelligence components when Framework Manager uses a dedicated gateway and is outside the network firewall.

Procedure

1. Set up a dedicated gateway for Framework Manager.

2. On the dedicated gateway, in IBM Cognos Configuration, change the Dispatcher URIs for gateway property to the URI of the dispatcher on the server where Application Tier Components are installed. This value will be the same as the Internal dispatcher URI property on your Application Tier Components computer.

3. On the computer where you installed Framework Manager, start IBM Cognos Configuration.

4. In the Explorer window, click Environment.

5. In the Properties window, in the Gateway URI box, type the appropriate value for the server you are using as the dedicated gateway.

   - To use ISAPI, replace cognos.cgi with cognosisapi.dll.
   - To use an Apache Web server, type the following syntax:
     For Apache 1.3 module,
     http://host_name:port/ibmcognos/cgi-bin/mod_cognos.dll
     For Apache 2.0 module,
     http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll

234 IBM Cognos Business Intelligence Version 10.1.1: Installation and Configuration Guide
For Apache 2.2.x module,
http://host_name:port/ibmcognos/cgi-bin/mod2_2_cognos.dll

Note: Ensure that you configured your Apache Web Server.

• To use IBM HTTP Server, type the following syntax:
http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll
Ensure that you configured your IBM HTTP Web Server.

• To use a servlet gateway, type the following syntax:
http[s]://host_name:port/context_root/servlet/Gateway
where context_root is the value you assigned to the ServletGateway Web application when you deployed the ServletGateway application.

Note: Ensure that you configured your Web server to support the servlet gateway.

6. Change the localhost portion of the Gateway URI to either the IP address or the host name of the dedicated gateway server.

7. Specify the value for the Dispatcher URI for external applications by typing the URI of the internal dispatcher on the server where Application Tier Components are installed.

Ensure that you change the host name in the URI from localhost.

8. In the Explorer window, under Cryptography, click Cognos, the default cryptographic provider.

9. Under the Certificate Authority settings property group, for the Password property, type the same password you configured on the default active Content Manager computer.

10. From the File menu, click Save.

Results

Framework Manager is configured to communicate with the other components of IBM Cognos BI. If you installed Framework Manager on a Microsoft Windows Vista operating system computer, you must update file location properties on Windows Vista computers.

Test the Installation and Configuration

You can test your configuration by starting the application and creating a project.

Procedure

To start Framework Manager, from the Start menu, click Programs > IBM Cognos 10 > Framework Manager.

You may be prompted to upgrade if the model schema version is older than the currently supported version.

If you see the Welcome page of Framework Manager, your installation is working.

Installing and Configuring Metric Designer

You can install Metric Designer, the metadata modeling tool for IBM Cognos Metrics Manager, on the same computer as IBM Cognos BI components, or on a different computer. All required files are copied to one computer. Default settings are used for the configuration. However, you may want to change these default
settings if existing conditions make the default choices inappropriate, or if you installed IBM Cognos BI on a different computer.

If you upgraded from Metrics Manager version 2.0 or later, you can use the same extracts and projects that you used with the older version. To upgrade existing projects, you must open them in the new version of Metric Designer and redefine the data source connections and other references.

Metric Designer is available as a 32-bit installation only. It must be installed on a 32-bit Microsoft Windows operating system computer.

**System Requirements for Metric Designer**

Before you install Metric Designer, ensure that the Windows computer meets IBM Cognos BI software and hardware requirements. The size of the your models determines the hardware requirements, such as disk space.

The following table lists the minimum hardware and software requirements to run Metric Designer.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows (design interface)</td>
</tr>
<tr>
<td></td>
<td>UNIX operating system (engine only):</td>
</tr>
<tr>
<td></td>
<td>Sun Solaris HP-UX IBM AIX</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 512 MB</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 500 MB of free space on the drive that contains the temporary directory</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Data Access Component (MDAC) 2.6 or later for use with product samples</td>
</tr>
</tbody>
</table>

To install and configure Metric Designer, follow these steps:

- ![Install Metric Designer Components](image)
- ![Set up the database client for the metric store](image)
- ![Configure environment properties for Metric Designer](image)
- ![Set up the import source environment for Metric Designer](image)
- ![Test the Metric Designer installation](image)
Related concepts

“Distributing Metric Designer Components” on page 43

For Metric Studio, if you want to define and load metrics from relational and dimensional data sources, including cubes, Framework Manager packages, or Impromptu Query Definitions (.iqd files), install Metric Designer to extract the data.

**Default Settings for Metric Designer**

The following table lists the default settings for the ports and URIs that are used by Metric Designer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the gateway</td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
</tbody>
</table>

After installation, you can use IBM Cognos Configuration to change the default settings. You can also change them by editing the cogstartup.xml file in the c10_location/configuration directory.

**Install Metric Designer**

Use the following steps to install Metric Designer.

Ensure that you have administrator privileges for the Microsoft Windows computer you are installing on. If you are not an administrator, ask your system administrator to add you to the Administrator group on your computer.

If you are installing the modeling tool in the same directory as IBM Cognos BI and do not stop the IBM Cognos services, you are prompted to do so during the installation.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names.

**Before you begin**

Before you install Metric Designer, close all programs that are currently running to ensure that the installation program copies all the required files to your computer.

Before you configure Metric Designer, other IBM Cognos BI components must be installed and configured, and Metric Designer must be installed.

You should also install and configure the target application where you will load data or metadata.

**Procedure**

1. If you are installing in a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Do one of the following:
   - Insert the Metric Designer disk.
If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.

- Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.

3. Select the language to use to run the installation wizard.

4. Follow the directions in the installation wizard to copy the required files to your computer.

5. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - If the server components are configured, select the IBM Cognos Configuration check box so that you can configure Metric Designer immediately.

   If the server components are not configured, ensure that the IBM Cognos Configuration check box is clear. You can later configure Metric Designer using the Microsoft Windows operating system Start menu to start IBM Cognos Configuration from the shortcut folder.

   - Click Finish.

**Results**

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

**Database Client Requirements for the Metric Store**

If you use DB2, Oracle, or Microsoft SQL Server for the metric store, you must set up the database client or other drivers or utilities on the Metric Designer computer. Doing this allows Metric Designer to access the metric store database.

**Set Up the Database Client for a DB2 Metric Store**

If you use a DB2 database for the metric store, you must set up the database client and drivers on the Metric Designer computer. Doing this allows Metric Designer to access the metric store database.

**Procedure**

1. If you are using type 2 JDBC connectivity, install the DB2 client software on the Metric Designer computer.
   
   If you use type 4 JDBC connectivity for DB2, you are not required to install the DB2 client software where Metric Designer is installed.

   For more information about the differences between type 2 and type 4 drivers, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 132.

2. On a Microsoft Windows operating system, stop the DB2 services and the HTML Search Server.

3. Copy the following files from DB2_installation/sqlib/java directory to the c10_location/webapps/p2pd/WEB-INF/lib directory:
   - the universal driver file, db2jcc.jar
   - the license file, for example db2jcc_license_cu.jar

4. On Windows, restart the DB2 services and the HTML Search Server.
Set Up the Database Client for an Oracle Metric Store
If you use an Oracle database for the metric store, you must set up the database driver and utility on the Metric Designer computer. Doing this allows Metric Designer to access the metric store database.

Procedure
1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.
2. Copy the correct library file for your version of the Oracle client to the c10_location\webapps\p2pd\WEB-INF\lib directory on the computer where Metric Designer is installed.
   If you are using Oracle 10g, you must have ojdbc14.jar.
   If you are using Oracle 11g, you must have ojdbc5.jar.
   The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.
3. Install the SQL Loader utility on the Metric Designer computer.

Set Up the Database Client for a Microsoft SQL Server Metric Store
If you use a Microsoft SQL Server database for the metric store, you must set up the database utility on the Metric Designer computer. Doing this allows Metric Designer to access the metric store database.

Procedure
Install the bcp utility on the Metric Designer computer.

Environment Properties for Metric Designer Computers
If you install Metric Designer on a different computer from other IBM Cognos BI components, you must configure it to communicate with the computers where the gateway and Content Manager are installed.

Install and configure other IBM Cognos BI components before you configure Metric Designer. You must first install and configure Content Manager and then start the IBM Cognos service on at least one Content Manager computer before you configure Metric Designer. This ensures that the certificate authority service issues a certificate to the Metric Designer computer.

Before you configure Metric Designer, ensure that the Web server is configured and running, and the IBM Cognos service is running.

If you are using an Apache Web server, ensure that you configure it first. For more information, see "Configure the Gateway for Apache Server 1.3" on page 396.

Installations with a Firewall
When the modeling tool is outside a network firewall that protects the Application Tier Components, communication issues with the dispatcher can arise. To avoid communication issues, you can install the modeling tool in the same architectural tier as the Application Tier Components or you can install and configure a gateway that is dedicated to modeling tool communications.

For more information about the modeling tool and network firewalls, see "Firewall Considerations" on page 39.
The steps in this topic describe how to configure the modeling tool computer when the computer is inside or outside of the network firewall.

For more information about configuring the dedicated gateway computer, see “Configure Environment and Security Properties for Gateway Computers” on page 223.

**Configure Environment Properties for Metric Designer Computers**

Use the following steps to configure Metric Designer for communication with the gateway and Content Manager.

**Procedure**

1. On the computer where you installed Metric Designer, start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, in the **Gateway URI** box, type the appropriate value:
   - Change the host name portion of the **Gateway URI** from localhost to either the IP address of the computer or the computer name.
   - To use ISAPI, replace cognos.cgi with cognosisapi.dll.
   - To use an Apache Web server, type the following syntax:
     
     \[http://host_name:port/ibmcognos/cgi-bin/module.suffix\]

     where module is as listed in the following table:

     | Version  | Module          |
     |----------|-----------------|
     | Apache 1.3| mod_cognos     |
     | Apache 2.0| mod2_cognos    |
     | Apache 2.2| mod2_2_cognos  |

     and suffix is as listed in the following table:

     | Operating system | Suffix |
     |------------------|--------|
     | Microsoft Windows| dll    |
     | Solaris, AIX     | so     |
     | HP-UX PA-RISC    | sl     |
     | HP-UX IA, Linux operating system | so     |

     Apache module 1.3 is not supported on HP-UX IA or Linux.

4. Specify the value for the **Dispatcher URI for external applications**.
   - If your Web server is configured not to allow anonymous access, type the URI of the dispatcher, ensuring that you change the host name in the URI from localhost.
   - If your Web server supports chunked transfer encoding and Metric Designer is inside the firewall, type the URI of the dispatcher, ensuring that you change the host name in the URI from localhost.
   - If you are using a dedicated gateway for modeling tool communication, type the dispatcher URI.
5. From the **File** menu, click **Save**.
Results

Metric Designer is configured to communicate with other IBM Cognos BI components.

Import Sources and Metric Designer

The IBM Cognos BI modeling tools create and manage metadata. Metric Designer creates and manages metadata required for the scorecarding functions. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the import source environment for Metric Designer. Commonly, these things depend on the other technology you use for your data or import source.

If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) 2000 data source, you must create a separate IBM Cognos BI instance for each language.

Users operating in different languages can connect to an MSAS 2005 data source from the same instance of IBM Cognos BI. Modelers must create a separate package for each language. Users can run reports in any language.

For more information about data source connections, see the IBM Cognos Administration and Security Guide.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk. For more information, see “Additional Language Fonts” on page 293.

Set Up the Import Source Environment for Metric Designer

Use the following steps to set up Metric Designer for Oracle, DB2, or SAP BW import sources.

Procedure

1. Set the environment variable for multilingual support:
   • For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Metric Designer or the Application Tier Components for IBM Cognos Metrics Manager are installed by typing the following command:
     
     NLS_LANG = language_territory.character_set
     
     Examples are:
     
     NLS_LANG = AMERICAN_AMERICA.UTF8
     
     NLS_LANG = JAPANESE_JAPAN.UTF8
     
     The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
   • For DB2, set the DB2CODEPAGE environment variable to a value of 1252.
     
     For more information about whether to use this optional environment variable, see the DB2 documentation.
     
     No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add $ORACLE_HOME/lib to your LD_LIBRARY_PATH.
When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.

Where default values are specified, you may want to modify the values on the SAP system.

- **S_RFC**
  - Set the **Activity** field to the value: 16
  - Set the **Name of RFC to be protected** field to the value: SYST, RSOB, SUGU, RFC1, RS_UNIFICATION, RSAB, SDTX, SU_USER
  - Set the **Type of RFC object to be protected** field to the value: FUGR

- **S_TABU_DIS**
  - Set the **Activity** field to the value: 03
  - Set the **Authorization Group** field to the value: &NC&

  **Note:** &NC& represents any table that does not have an authorization group. For security reasons, create a new authorization group and assign the table RSHIEDIR to it. The new authorization group restricts the user’s access to the above table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

- **S_USER_GRP**
  - Set the **Activity** field to the value: 03, 05
  - Set the **User group in user master main** field to the default value.

- **S_RS_COMP**
  - Set the **Activity** field to the default value.
  - Set the **Info Area** field to the value: InfoArea Technical Name
  - Set the **Info Cube** field to the value: InfoCube Technical Name
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.

- **S_RS_COMP1**
  - Set the **Activity** field to the default value.
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.
  - Set the **Owner (Person Responsible)** field to the default value.

- **S_RS_HIER**
  - Set the **Activity** field to the value: 71
  - Set the **Hierarchy Name** field to the value: Hierarchy Name
  - Set the **InfoObject** field to the value: InfoObject Technical Name
  - Set the **Version** field to the value: Hierarchy Version

- **S_RS_ICUBE**
  - Set the **Activity** field to the value: 03
  - Set the **InfoCube sub-object** field to the values: DATA and DEFINITION
  - Set the **Info Area** field to the value: InfoArea Technical Name
  - Set the **InfoCube** field to the value: InfoCube Technical Name

For more information about SAP BW authorization objects, see Transaction SU03.
Test the Installation and Configuration

You can test your configuration by starting the application and creating a project.

Procedure

To start Metric Designer, from the Start menu, click Programs > IBM Cognos 10 > Metric Designer.

If you see the Welcome page of Metric Designer, your installation is working.
Chapter 10. Install and Configure Optional Components

Optional components provide extended functionality for users.

After you install and configure IBM Cognos Business Intelligence server
components and modeling tools, you can install the following optional
components.

- IBM Cognos Transformer
- Samples
- Translated Product Documentation
- Additional fonts for Japanese and Korean currency symbols
- IBM Cognos BI Quick Tours
- IBM Cognos BI for Microsoft Office

IBMCognosTransformer

You can install IBM Cognos Transformer, the metadata modeling tool for creating
PowerCubes for use with IBM Cognos BI, on the same computer as other IBM
Cognos BI components, or on a different computer. You can install IBM Cognos
Transformer on the same computer as IBM Cognos Series 7 Transformer.

Transformer can be made available more easily for business specialists who want
to design models and build PowerCubes for their own use. For example, IT
departments can provide business specialists or Transformer modelers with a
Web-based, downloadable installation program from a corporate or secured portal,
allowing for easy distribution of the installation files.

Default settings are used for the configuration. You can change these default
settings if necessary, or if you install IBM Cognos Transformer on a separate
computer from IBM Cognos BI.

IBM Cognos Transformer and 64-bit Systems

IBM Cognos Transformer is only available in a 32-bit version. The installation
requirements are as follows:
- UNIX and Linux operating system utility for building PowerCubes
  This component can be installed on a 64-bit system, but in a separate directory
  from 64-bit IBM Cognos BI components. For example, 64-bit components are
  installed to /ibm/cognos/c10_64 by default. 32-bit components are installed to
  /ibm/cognos/c10.
- IBM Cognos Transformer client
  This component must be installed on a Windows computer. It must be on a
  32-bit system or in a separate directory from 64-bit IBM Cognos components on
  a 64-bit system.

Tasks to Install and Configure IBM Cognos Transformer

To install and configure IBM Cognos Transformer, perform these tasks:
- Install IBM Cognos Transformer
- Review default settings
**Configure IBM Cognos Transformer**

**Set up the data source environment for Transformer**

**Test the IBM Cognos Transformer installation**

---

**Install IBM Cognos Transformer**

You install Transformer if you plan to create PowerCubes for use with IBM Cognos BI.

The language that you select in the installation wizard determines the language of the user interface for both the installation wizard and for IBM Cognos Transformer. All available languages are installed.

With a UNIX or Linux operating system, the installation of IBM Cognos Transformer is not complete until you also install IBM Cognos Transformer on a computer with a Microsoft Windows operating system. All components are installed in both environments and you then use the features and tools that are appropriate for each environment. For example, the IBM Cognos Transformer client provides a graphical user interface for designing models on Windows computers. You then build cubes on your UNIX or Linux computer. Models that contain an IQD data source are not supported on Linux.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names.

Before you install IBM Cognos Transformer, close all programs that are currently running to ensure that the installation program copies all the required files to your computer.

If you are installing on Windows, ensure that you have administrator privileges for the Windows computer you are installing on. If you are not an administrator, ask your system administrator to add you to the Administrator group on your computer.

**Note:** When Transformer is installed on Windows Vista, if you do not have Administrator privileges on the computer and you make changes to the cogtr.xml file, the updated file is saved by default to a Virtual Store directory and not to the c10_location/configuration directory.

You must install and configure all IBM Cognos BI server components before you install IBM Cognos Transformer.

**Related concepts**

"Distributing Transformer Components" on page 41

Transformer can be installed on a computer that contains other IBM Cognos BI components or on a computer that is separate from other IBM Cognos BI components. When installed separately, Transformer can be used as a standalone product or it can be configured to communicate with other IBM Cognos BI components.

**System Requirements for IBM Cognos Transformer**

Before you install IBM Cognos Transformer, ensure that the computer meets IBM Cognos BI software and hardware requirements. The size of your PowerCubes determines the hardware requirements, such as disk space.

The following table lists the minimum hardware and software requirements to run IBM Cognos Transformer.
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td></td>
<td>UNIX: Sun Solaris, HP-UX, IBM AIX</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 512 MB</td>
</tr>
<tr>
<td></td>
<td>Optimal: 4 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 500 MB of free space on the drive that contains the temporary directory used by IBM Cognos BI</td>
</tr>
<tr>
<td>Data source</td>
<td>Database client software installed on the same computer as IBM Cognos Transformer</td>
</tr>
<tr>
<td></td>
<td>Database connectivity set up</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Data Access Component (MDAC) 2.6 or later for use with product samples</td>
</tr>
</tbody>
</table>

**Installing IBM Cognos Transformer on UNIX or Linux**

Use the following steps to install IBM Cognos Transformer on UNIX or Linux operating systems.

**Procedure**

1. If installing from a download, go to the location where the installation files were downloaded and extracted.
2. If installing from a disk, mount the IBM Cognos Transformer modeling disk using Rock Ridge file extensions.
   - To mount the disk on HP-UX, do the following:
     - Add the pfs_mount directory in your path.
     - For example,
       ```
       PATH=/usr/sbin:/PATH
       export PATH
       ```
     - To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`.
     - To mount the drive, type
       ```
       pfs_mount -t rrip <device><mount_dir> -o xlat=unix
       ```
     - For example,
       ```
       pfs.mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
       ```
     - You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
     - When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs.mountd daemons to unmount the disk.
3. To start the installation wizard, go to the operating system directory and then type
   ```
   ./issetup
   ```
4. Select the language to use for the installation.
   - The language that you select in the installation wizard determines the language of the user interface for both the installation wizard and for IBM Cognos Transformer. All available languages are installed.
5. Follow the directions in the installation wizard and copy the required files to your computer.

   **Tip:** The Series 7 IQD Bridge component is not supported on Linux and HP-UX Itanium.

6. When you are prompted about installing non-English product documentation, click **OK** to continue.

7. In the **Finish** page of the installation wizard, do the following:
   - If you want to see the log files, click **View** for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure Transformer immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
     You can later configure Transformer using IBM Cognos Configuration by typing cogconfig.sh in the `c10_location/bin` directory, or by running a silent configuration or editing cogstartup.xml in `c10_location/configuration` directory.
   - Click **Finish**.

8. Create a MANPATH environment variable and configure it with the following value:

   `/c10_location/webcontent/documentation/en/cogtr_a.html`

   The cogtr_a.html document provides the syntax for UNIX command line options that are supported by IBM Cognos Transformer. The man page for IBM Cognos Transformer is accessible in UNIX by typing `cogtr man` from the `c10_location/bin` directory.

**Results**

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see "Translated Product Documentation" on page 293.

**Installing IBM Cognos Transformer on Windows**

Use the following steps to install IBM Cognos Transformer on Microsoft Windows operating systems.

**Procedure**

1. Do one of the following:
   - Insert the IBM Cognos Transformer modeling disk.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.

2. Select the language to use for the installation.
   The language that you select in the installation wizard determines the language of the user interface for both the installation wizard and for IBM Cognos Transformer. All available languages are installed.
3. Follow the directions in the installation wizard to copy the required files to your computer.
   If you are installing on a computer that has another version or instance of IBM Cognos BI product, and you want to keep the other version or instance running, you must install IBM Cognos BI in a different directory.
   If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.

4. When you are prompted about installing non-English product documentation, click **OK** to continue.

5. In the **Finish** page of the installation wizard, do the following:
   - If you want to see the log files, click **View** for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - Do not configure Transformer immediately because you must do other tasks first to ensure that your environment is properly set up. Ensure that the IBM Cognos Configuration check box is clear.
     You can later configure Transformer using the Windows **Start** menu to start **IBM Cognos Configuration** from the shortcut folder.
   - Click **Finish**.

**Results**

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

If you want users to see product documentation in a language other than English, you must install the Supplementary Language Documentation component in the location where you installed the Gateway components. For more information, see "Translated Product Documentation" on page 293.

**Default Settings for IBM Cognos Transformer**

The following table lists the default settings for the IBM Cognos BI ports and URIs that are used by IBM Cognos Transformer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the IBM Cognos BI gateway</td>
</tr>
<tr>
<td>Dispatcher URI for external applications</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
</tbody>
</table>

After installation, you can use the configuration tool to change the default settings. You can also change them by editing the cogstartup.xml file in the `c10_location\configuration` directory.

**Communication between IBM Cognos Transformer and IBM Cognos Business Intelligence components**

You must configure IBM Cognos Transformer to communicate with the other IBM Cognos BI components.
The instructions in this topic are for the installer or administrator. If you are the Transformer modeler or business specialist who wants to download and use Transformer, see “Deploying IBM Cognos Transformer for Modelers” on page 426.

If you install IBM Cognos Transformer on the same computer as the non-modeling components of IBM Cognos BI, no configuration is required if you:
- configure your Web server using the default virtual directories
- use the default ports
- use the default resources
- use the default cryptographic settings

You can upgrade models from Series 7.x versions of Transformer if you have saved them as MDL files.

You can continue to use PowerCubes built with Series 7.3 and higher versions of Transformer in IBM Cognos BI. However, to use IBM Cognos BI authentication providers, you must upgrade the PowerCubes.

To upgrade PowerCubes to IBM Cognos BI PowerCubes, you must:
- open the Series 7.x Transformer model MDL file in IBM Cognos Transformer
- rebuild the PowerCube in the IBM Cognos Transformer

For more information about upgrading Series 7 PowerCubes, see “Upgrading Transformer Models and PowerCubes” on page 118.

If IBM Cognos BI was installed in more than one location, ensure that all URIs point to the correct version of IBM Cognos BI. Transformer must be configured to use the same version of IBM Cognos BI.

**Installations with a Firewall**

When the modeling tool is outside a network firewall that protects the Application Tier Components, communication issues with the dispatcher can arise. To avoid communication issues, you can install the modeling tool in the same architectural tier as the Application Tier Components or you can install and configure a gateway that is dedicated to modeling tool communications. For more information about the modeling tool and network firewalls, see “Firewall Considerations” on page 39.

The steps in this topic describe how to configure the modeling tool computer. If you are using a gateway that is dedicated to the modeling tool, you must also configure the gateway computer. For more information, see “Installing and Configuring the Gateway” on page 216.

**Configure IBM Cognos Transformer Computers**

You must configure IBM Cognos Transformer to communicate with the other IBM Cognos BI components.

**Before you begin**

Install and configure IBM Cognos BI components before you configure IBM Cognos Transformer. You must first install and configure Content Manager and then start the IBM Cognos service on at least one Content Manager computer before you configure IBM Cognos Transformer. This ensures that the certificate authority service issues a certificate to the IBM Cognos Transformer computer.
Ensure that the Web server is configured and running.

To support the use of IBM Cognos BI data sources (including packages and reports) in Transformer, ensure that the database client is installed on the Transformer computer.

**Procedure**

1. On the computer where you installed IBM Cognos Transformer, start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, in the **Gateway URI** box, type the appropriate value.
   - To use ISAPI, replace cognos.cgi with **cognosisapi.dll**.
   - To use an Apache Web server, type the following syntax:
     
     \[
     \text{http://host_name:port/ibmcognos/cgi-bin/module.suffix}
     \]
     
     where *module* is as listed in the following table:

     | Version  | Module         |
     |----------|----------------|
     | Apache 1.3 | mod_cognos    |
     | Apache 2.0 | mod2_cognos   |
     | Apache 2.2 | mod2_2_cognos |

     and suffix is as listed in the following table:

     | Operating system | Suffix |
     |------------------|--------|
     | Windows          | dll    |
     | Solaris, AIX     | so     |
     | HP-UX PA-RISC    | sl     |
     | HP-UX IA, Linux  | so     |

     Apache module 1.3 is not supported on HP-UX IA or Linux.
   - To use a servlet gateway, type the following syntax:
     
     \[
     \text{http[s]://host_name:port/context_root/servlet/Gateway}
     \]
     
     where *context_root* is the value you assigned to the ServletGateway Web application when you deployed the ServletGateway application.

     **Note:** Ensure that you configured your Web server to support the servlet gateway. For information, see "Configure the Servlet Gateway" on page 401.
   - If you are not using a Web server, to use the dispatcher as the gateway, type the following syntax:
     
     \[
     \text{http[s]://host_name:port/p2pd/servlet/dispatch}
     \]

4. Change the host name portion of the **Gateway URI** from localhost to either the IP address of the computer or the computer name.

5. Specify the value for the **Dispatcher URI for external applications**.
   - If your Web server is configured not to allow anonymous access, type the URI of the dispatcher, ensuring that you change the host name in the URI from localhost.
   - If your Web server supports chunked transfer encoding and IBM Cognos Transformer is inside the firewall, type the URI of the dispatcher, ensuring that you change the host name in the URI from localhost.


• If you are using a dedicated gateway for modeling tool communication, type the dispatcher URI.

6. In the Explorer window, under Cryptography, click Cognos, the default cryptographic provider.

7. Under the Certificate Authority settings property group, for the Password property, type the same password you configured on the default active Content Manager computer.

8. From the File menu, click Save.

   IBM Cognos Transformer is configured to communicate with the other components of IBM Cognos BI.

9. If you installed Transformer on a Windows Vista computer, or if any IBM Cognos BI component is installed on a Windows Vista computer, update your file location properties:
   • Log on as an administrator.
   • In the c10_location\configuration directory, open cogtr.xml.sample in a text editor.
   • Locate all values that use a relative path, ".\directory".
   • Replace the relative path element, ".", with the same environment variable and root directory as you use for file locations on the other IBM Cognos BI computers.
   • Save the file as cogtr.xml.
   • In the c10_location\CS7Gateways\bin directory, open cs7g.ini in a text editor.
   • Add the locations for your IBM Cognos Series 7 data sources to the file.
   • Save the file.

   Changes are applied the next time you open Transformer.

Data Sources and Transformer

The IBM Cognos BI modeling tools create and manage metadata. IBM Cognos Transformer creates and manages metadata for PowerCubes. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for IBM Cognos Transformer. Commonly, these things depend on the other technology you use for your data or import source.

If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) 2000 data source, you must create a separate IBM Cognos BI instance for each language.

Users operating in different languages can connect to an MSAS 2005 data source from the same instance of IBM Cognos BI. Modelers must create a separate package for each language. Users can run reports in any language.

For more information about data source connections, see the Administration and Security Guide.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk. For more information, see “Additional Language Fonts” on page 293.
Related concepts

"Distributing Transformer Components” on page 41

Transformer can be installed on a computer that contains other IBM Cognos BI components or on a computer that is separate from other IBM Cognos BI components. When installed separately, Transformer can be used as a standalone product or it can be configured to communicate with other IBM Cognos BI components.

Set Up the Data Source Environment for Transformer

Use these steps to set up Oracle or SAP BW data sources for IBM Cognos Transformer.

If you use a Sybase data source, these steps are not necessary.

Procedure

1. Set the environment variable for multilingual support:
   - For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager or Metric Designer and the IBM Cognos BI server are installed by typing the following command:
     
     \[ \text{NLS\_LANG} = \text{language\_territory.character\_set} \]

     Examples are:
     
     \[ \text{NLS\_LANG} = \text{AMERICAN\_AMERICA.UTF8} \]
     \[ \text{NLS\_LANG} = \text{JAPANESE\_JAPAN.UTF8} \]

     The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
   - For DB2, set the DB2CODEPAGE environment variable to a value of 1252.

     For more information about whether to use this optional environment variable, see the DB2 documentation.

     No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add $ORACLE_HOME/lib to the library path.

   When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.

   Where default values are specified, you may want to modify the values on the SAP system.
   - S_RFC

     Set the **Activity** field to the value: 16
     Set the **Name of RFC to be protected** field to the value: SYST, RSOB, SUGU, RFC1, RS\_UNIFICATION, RSAB, SDTX, SU\_USER
     Set the **Type of RFC** object to be protected field to the value: FUGR
   - S\_TABU\_DIS

     Set the **Activity** field to the value: 03
     Set the **Authorization Group** field to the value: &NC&

     **Note:** &NC& represents any table that does not have an authorization group.
     For security reasons, create a new authorization group and assign the table...
RSHIEDIR to it. The new authorization group restricts the user's access to the above table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

- **S_USER_GRP**
  - Set the *Activity* field to the value: 03, 05
  - Set the *User group in user master main* field to the default value.

- **S_RS_COMP**
  - Set the *Activity* field to the default value.
  - Set the *Info Area* field to the value: *InfoArea Technical Name*
  - Set the *Info Cube* field to the value: *InfoCube Technical Name*
  - Set the *Name (ID) of reporting components* field to the default value.
  - Set the *Type of reporting components* field to the default value.

- **S_RS_COMP1**
  - Set the *Activity* field to the default value.
  - Set the *Name (ID) of reporting components* field to the default value.
  - Set the *Type of reporting components* field to the default value.
  - Set the *Owner (Person Responsible)* field to the default value.

- **S_RS_HIER**
  - Set the *Activity* field to the value: 71
  - Set the *Hierarchy Name* field to the value: *Hierarchy Name*
  - Set the *InfoObject* field to the value: *InfoObject Technical Name*
  - Set the *Version* field to the value: *Hierarchy Version*

- **S_RS_ICUBE**
  - Set the *Activity* field to the value: 03
  - Set the *InfoCube sub-object* field to the values: DATA and DEFINITION
  - Set the *Info Area* field to the value: *InfoArea Technical Name*
  - Set the *InfoCube* field to the value: *InfoCube Technical Name*

For more information about SAP BW authorization objects, see Transaction SU03.

**Test the Installation and Configuration**

You can test your configuration by starting the application and creating a model.

**Procedure**

To start IBM Cognos Transformer, from the *Start* menu, click *Programs* > *IBM Cognos 10* > *IBM Cognos Transformer*.

To start IBM Cognos Transformer manually, double-click the cogtr.exe file in the *c10_location\bin* directory.

If you see the *Transformer* window, your installation is working.

**Configuring IBM Cognos Content Archival**

IBM Cognos Content Archival allows you to store report output versions and their source report specifications to an external repository, such as IBM FileNet Content Manager. This enhances system performance and extends IBM Cognos product scalability by reducing the size of the Content Store, while helping to adhere to strict regulatory requirements.
IBM Cognos Content Archival is installed with IBM Cognos BI.

For more information about setting up user capabilities, creating a data source connection to an external repository, and configuring content archiving on folders and packages, see the IBM Cognos Administration and Security Guide.

Content archival can also be configured to use your file system. However, this is not recommended for a production environment.

Creating an aliasRoot for a File System Repository
To archive reports or report specifications to an IBM Cognos Content Archival file system repository, you must create an aliasRoot that points to a file location on a local drive or network share.

Before you begin
Before you can archive reports or report specifications, you must be an administrator and have access to the file location. The computer that is configured to use a file system repository must be able to access this location by using a file URI.

About this task
The file system repository is designed for a test or development environment where the use of an Enterprise Content Management (ECM) repository is not possible. Although the file system for the IBM Cognos Content Archival feature provides the same functionality as an ECM repository, it does not provide the same level of optimization, so performance may become an issue in a production environment.

Procedure
1. Start IBM Cognos Configuration.
2. From the Actions menu, click Stop to stop the IBM Cognos service.
3. From the Actions menu, click Edit Global Configuration.
4. Click the General tab, in the Name column, select Alias Roots, and click Add.
5. In the Name column, type a unique name for your file system repository.

   Note: There is no limit to the number of aliases you can create.

6. Type the path to your file system location:
   • On Windows, in the windowsURI column, type file:// followed by the path, for example, file:///c:/temp/filesystem.
   • On UNIX or Linux, in the unixURI column, type file:// followed by the path, for example, file:///temp/filesystem.

   In a distributed installation, both the Content Manager and Application Tier Components computers must have access to the file location. Use both URIs only in a distributed installation. The UNIX URI and the Windows URI in an alias root must point to the same location on the file system.
7. Click OK.
8. From the Actions menu, click Start to restart the IBM Cognos service. This might take a few minutes.
Results

You have created a new aliasRoot pointing to your file system repository. Use this file system repository name to create a data source connection to use with the Cognos Content Archival software. For more information, see the Administration and Security Guide.

Importing custom classes definitions and properties

To use IBM Cognos Content Archival, you must import a set of custom classes and properties files into IBM FileNet Content Manager.

Custom classes definitions and properties include FileNet specific metadata. You can install these files at any time.

Procedure

1. Go to the c10_location\configuration\repository\filenet directory and copy the CMECMIntegrationObjects_CEEexport._xxx.xml files to a local folder on the FileNet server.
2. Using an XML text editor, open the file named CMECMIntegrationObjects_CEEExport_Manifest.xml.
3. Find the section <ContentLocation> and modify the path to where content will be stored on the FileNet server. For example, <ContentLocation external="true">C:\Documents and Settings\cmdev\Desktop\content</ContentLocation>.
4. Find the section <FileName> and modify the file location for both custom classes definitions and properties files. For example, <FileName>C:\Documents and Settings\cmdev\Desktop\CMECMIntegrationObjects_CEEExport_Group1_x.xml</FileName>
5. Open the FileNet Enterprise Manager Administration Tool and connect to the domain for the FileNet external repository.
6. Select a target Object Store, and click the Import All Items button to import the definitions into the object store.
7. At the Import Options pane, click the Import Manifest File button and browse to where the CMECMIntegrationObjects_CEEexport._xxx.xml files are located.
8. Select the CMECMIntegrationObjects_CEEExport_Manifest.xml file and click the Import button.
9. Restart the Websphere Application Server or FileNet CMIS application.

Specifying an available time to run the archival process

To maintain high system performance during peak hours, you can configure the software to specify when the archive or delete tasks will run. You do this by specifying a blackout period.

A blackout period is a temporary period in which the movement of data is denied. By default, a blackout period is not defined when the software is installed. For example, to specify a weekly blackout period from 8.00 a.m. to 5 p.m., Tuesday through Friday, complete the following procedure.

Procedure

1. Go to the c10_location\webapps\p2pd\WEB-INF\cm\tasks\manager directory.
2. Open the file named tasksManager.xml using an XML text editor.
3. Add the following `<blackoutPeriods>` element as a child element of the `backgroundTasksManager` element.
   - start time = `<hour>08</hour>`
   - stop time = `<hour>17</hour>`
   - days =
     - `<day>Tuesday</day>`
     - `<day>Wednesday</day>`
     - `<day>Thursday</day>`
     - `<day>Friday</day>`

4. If needed, lower the number of threads available to the archiving and deletion processes. The maximum number of threads is 7.

5. Save and close the file.

6. Restart background activities on the Content Manager service. For more information, see the Administration and Security Guide.

### Specifying thread execution times

You can use threads to schedule operating system processing times.

You can specify the execution times by editing a file named `archiveTask.xml`.

The archive and delete background tasks use threads to move content. Threads are units of processing time that are scheduled by the operating system. The example in the following procedure shows the following configuration: three threads execute from midnight to 8.00 a.m., one thread executes from 8.00 a.m. to 5.00 p.m., no threads execute from 5.00 p.m. to midnight, and all threads run every day of the week.

**Procedure**

1. Go to the cl0_location\webapps\p2pd\WEB-INF\cm\tasks\config directory.
2. Using an XML text editor, open the file named `archiveTask.xml`.
3. Add the following `<executionPeriods>` XML element as a child element of the `backgroundTask` element.

```xml
<executionPeriods>
<executionPeriod>
<threads>3</threads>
<startTime>
<hour>00</hour>
<minute>00</minute>
</startTime>
<stopTime>
<hour>08</hour>
<minute>00</minute>
</stopTime>
<days>
<day>Monday</day>
<day>Tuesday</day>
<day>Wednesday</day>
<day>Thursday</day>
<day>Friday</day>
<day>Saturday</day>
<day>Sunday</day>
</days>
</executionPeriod>
<executionPeriod>
<startTime>
<hour>08</hour>
<minute>00</minute>
</startTime>
<stopTime>
<hour>17</hour>
<minute>00</minute>
</stopTime>
<days>
<day>Tuesday</day>
<day>Wednesday</day>
<day>Thursday</day>
<day>Friday</day>
<day>Saturday</day>
<day>Sunday</day>
</days>
</executionPeriod>
<executionPeriod>
<startTime>
<hour>17</hour>
<minute>00</minute>
</startTime>
<stopTime>
<hour>24</hour>
<minute>00</minute>
</stopTime>
<days>
<day>Sunday</day>
</days>
</executionPeriod>
<executionPeriod>
<startTime>
<hour>00</hour>
<minute>00</minute>
</startTime>
<stopTime>
<hour>08</hour>
<minute>00</minute>
</stopTime>
<days>
<day>Monday</day>
<day>Tuesday</day>
<day>Wednesday</day>
<day>Thursday</day>
<day>Friday</day>
<day>Saturday</day>
<day>Sunday</day>
</days>
</executionPeriod>
</executionPeriods>
```
Archiving selected formats of report outputs

You can configure archiving to limit archiving to specific output formats. By default outputs of any given format, including PDF, XML, HTML and Excel, are archived.

You can limit archiving of specific output formats to the repository. For example, the procedure below defines the archiving of only PDF report output versions. An output of any other output format type will not be archived.

Note: You cannot selectively archive multiple file report output versions, for example HTML with graphics.

Procedure

1. Go to the {c10_location}\webapps\p2pd\WEB-INF\cm\tasks\config directory.
2. Using an XML text editor, open the file named archiveTask.xml.
3. Add the following <outputFormats> XML element as a child element of the runOptions XML element.

```
<outputFormats>
  <outputFormat>PDF</outputFormat>
</outputFormats>
```

Tip: You can use the existing sample outputFormats element and modify the list to specify output formats to be archived.

The deleteTask.xml file

The deleteTask.xml file is a configuration file for the background task called deleteTask, which retrieves and deletes marked version objects from the queue.

There are two content maintenance tasks that mark and move version content into a queue:
- Retention Rules Updater that updates and applies retention rules on reports, queries, analysis and document objects
- Content Removal that marks versions and histories.

The deleteTask.xml file is located in the {c10_location}\webapps\p2pd\WEB-INF\cm\tasks\config directory.

For more information about retention rules, see the IBM Cognos Administration and Security Guide.
Specifying that report specifications are not archived

Report specifications describe how data was generated within a report. By default, report specification output is archived.

To turn off the archiving of report specifications to an IBM FileNet Content Manager repository, you must configure both the CM.xml and CM_FILENET.xml files.

Procedure

1. Go to the c10_location\webapps\p2pd\WEB-INF\repositories\config directory.
2. Using an XML text editor, open the file named CM.xml.
3. Comment out or remove the following line:
   `<property name="specifications" metadataPropertyName="specification" useTempFile="true"/>
4. Save and close the file.
5. Go to the c10_location\webapps\p2pd\WEB-INF\repositories\config directory.
6. Using an XML text editor, open the file named CM_FILENET.xml.
7. Comment out or remove the following element:
   `<property repositoryName="REPORTEXECUTIONSPECIFICATION" repositoryType="ASSOCIATED"
    metadataPropertyName="specification">
    <associatedObjectTypes>
      <objectType name="VERSIONSPECIFICATION">
        <properties>
          <property repositoryName="cmis:name" repositoryType="STRING"
            metadataPropertyName="reportVersionDefaultName" valueHandler="com.cognos.cm.
            repositoryPluginFramework.PropertyValueAppendStringHandler" valueHandlerArgument="_specification"/>
        </properties>
      </objectType>
    </associatedObjectTypes>
  </property>
8. Restart background activities on the Content Manager service. For more information, see the Administration and Security Guide.

Results

Report specifications are no longer archived.

Samples

This section explains the purpose, content and location of IBM Cognos Business Intelligence samples. It also discusses the sample company, Great Outdoors, its structure, databases, model and packages.

The Sample Outdoors Company

The Sample Outdoors Company samples illustrate product features and technical and business best practices.

You can also use them for experimenting with and sharing report design techniques and for troubleshooting. As you use the samples, you can connect to features in the product.

For examples related to different kinds of businesses, see the product blueprints at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp For information about specific installation choices and environments, see the IBM Cognos Business Intelligence Architecture and Deployment Guide, or the Proven Practices and the IBM Cognos Implementation Roadmaps on http://
For information about audit samples, see the IBM Cognos Business Intelligence Administration and Security Guide. For information about Mobile samples, see the IBM Cognos Mobile Installation and Administration Guide.

The Sample Outdoors Company, or GO Sales, or any variation of the Sample Outdoors name, is the name of a fictitious business operation whose sample data is used to develop sample applications for IBM and IBM customers. Its fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values, is coincidental. Unauthorized duplication is prohibited.

Where to find the samples

The samples are included with the product and the samples for each studio are described in the related user guide and online help. To use the samples, you must install, set up, and configure them or contact your administrator to find out where they are installed. For instructions on how to install the samples, see the IBM Cognos Business Intelligence Installation and Configuration Guide. For instructions on how to set up and configure samples, see the IBM Cognos Business Intelligence Administration and Security Guide or the IBM Cognos Business Intelligence Installation and Configuration Guide.

Samples outline

The samples consist of the following:
- Two databases that contain all corporate data, and the related sample models for query and analysis
- Five samples cubes and the related models
- A metrics data source including associated metrics and a strategy map for the consolidated company, and a model for Metric extracts.
- Reports, queries, query templates, and workspaces

To run interactive reports, scripts are required. To see all the reports included in the samples packages, copy the files from the samples content installation into deployment folder and then import the deployments into the IBM Cognos Business Intelligence product.

Security

Samples are available to everyone. To implement security, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

The Sample Outdoors Group of Companies

To make designing examples faster, especially financial examples, some general information about The Sample Outdoors Company is useful.

To look for samples that use particular product features, see the individual sample descriptions in this section.

Revenue for The Sample Outdoors Company comes from corporate stores and from franchise operations. The revenues are consolidated from the wholly-owned subsidiaries. There are six distinct organizations, each with its own departments and sales branches. Five of these are regionally-based companies.
The sixth company, GO Accessories:
- Has its own collection of products, differentiated from the other GO companies by brand, name, price, color and size
- Sells from a single branch to all regions and retailers
- Functions both as an operating company based in Geneva, and as a part owner of the three GO subsidiaries in Europe

The diagram below illustrates the consolidated corporate structure, including the percentage changes in ownership for GO Central Europe, and shows the reporting currency and GL prefix for each subsidiary.

![Diagram showing consolidated corporate structure]

*Figure 5. Consolidated corporate structure*

Each corporation has the same departmental structure and the same GL structure, shown in the table below. Divisions may not report in the same currencies. For example, the Americas subsidiary reports in US dollars, but the Corporate division local currency is Canadian dollars, and the Operations division local currency is pesos.
<table>
<thead>
<tr>
<th>Division (GL)</th>
<th>Department (GL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate (1700)</td>
<td>Sales (1720)</td>
</tr>
<tr>
<td></td>
<td>Marketing (1750)</td>
</tr>
<tr>
<td></td>
<td>IS&amp;T (1760)</td>
</tr>
<tr>
<td></td>
<td>Human Resources (1730)</td>
</tr>
<tr>
<td></td>
<td>Finance (1740)</td>
</tr>
<tr>
<td></td>
<td>Procurement (1710)</td>
</tr>
<tr>
<td>Operations (1800)</td>
<td>Production and Distribution (1820)</td>
</tr>
<tr>
<td></td>
<td>Customer Service (1820)</td>
</tr>
</tbody>
</table>

Each corporation has a complete chart of accounts. Most of the accounts, such as those under non-personnel expenses, are at the department level, and contain only summary amounts. For example, although each marketing department has expenses, the cost is unspecified at the transaction level where marketing promotions occur.

**Employees**

The Sample Outdoors data contains a full list of employees in all divisions, departments, and locations.

Data is available for reports about bonuses (Global Bonus report) and sales commissions (Sales Commissions for Central Europe report), training (Employee Training by Year report), and performance reviews and employee satisfaction surveys (Employee Satisfaction 2006). If you use Metric Studio, sample metrics for human resources are also available.

In the GO Data Warehouse (analysis) package, groups of measures and the related dimensions are organized into folders. The employees are organized in hierarchies for region and manager, to make different kinds of aggregation easy to report on. Aggregation has been defined for the Employee Position Summary measures, so that Position count and Planned position count aggregate correctly at each level of time: monthly, quarterly, or yearly. For example, see the Planned Headcount report.

The employees are also listed in a sample LDIF file which could be used for any LDAP IBM product authentication including Tivoli®. This authentication directory is necessary for IBM Cognos Planning samples. No other samples depend on security profiles. For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

**Sales and Marketing**

Data about sales and marketing is available for all of the companies in the Sample Outdoors group.

GO Accessories has richer details to support analysis examples. For example, see the Revenue vs % Profit Margin by Product Brand analysis, based on the Sales and Marketing cube. Marketing and sales campaigns are tied to the Sample Outdoors regional companies.
Overall, the GO companies have experienced solid growth across most product lines (Sales Growth Year Over Year), in all regions (Revenue by GO Subsidiary 2005), because of factors like an increase in repeat business and new or improved products, such as the high margin sunglasses product line. In the product lines sold by the five regional companies (all but GO Accessories) promotions have had mixed success (Promotion Success by Campaign, Bundle and Quarter). If you use Metric Studio, this can also be seen in the sample metrics.

Customer Surveys

The data also contains information from customer surveys. For example, the product line that includes bug spray, sun screen, and so on has not been successful (Product Satisfaction - Outdoor Protection 2005) and a source of retailer dissatisfaction may be the level of customer service rather than the returns (Customer Returns and Satisfaction). If you use Metric Studio, this information can also be monitored in metrics.

Sales Outlets

Revenue from the corporate outlets is available at the transaction level. Revenue from the franchise outlets is available at the consolidated level only (Sales and Marketing cube). Metrics about retailers show that the number of new retail outlets has dropped over the time period covered by this data.

GO Accessories sells worldwide, and sells only accessories. Transaction data for GO Accessories is the primary source for analysis of product by brand, color and size. The other five subsidiaries in the group of companies are regional and sell all product lines for retailers in their region. For example, the report Top 10 Retailers in 2005 uses sparklines and list data to review revenues at the retailer level.

Sample Outdoors Database, Models, and Packages

The Sample Outdoors models illustrate modeling techniques and support the samples.

The models are based on the GO data warehouse and the GO sales transactional database and are the basis for the sample reports and queries. Each model contains two packages for publishing analysis (dimensional) and query views of the data.

For a description of each sample report or query, see the user guide for the studio that you open the sample in. For more information about modeling techniques, see the Guidelines for Modeling Metadata, or the IBM Cognos Framework Manager User Guide.

You must have access to Framework Manager, the modeling tool in IBM Cognos Business Intelligence, to look at the sample models. You may also need to set up the sample databases and connections. For instructions, see the IBM Cognos Business Intelligence Administration and Security Guide or the IBM Cognos Business Intelligence Installation and Configuration Guide.

GO Data Warehouse

The GO Data Warehouse model, great_outdoors_data_warehouse.cpf, is based on the database GOSALESDW. It contains data about human resources, sales and marketing, and finance, grouped into business areas. In the Database view, the three business areas are grouped into separate namespaces. The Database view contains a fourth namespace (GO Data) for the common information.
The Database view is very similar to the structure of the underlying database. All tables (database query subjects) are unchanged. This enables IBM Cognos BI to retrieve metadata directly from the package in most cases, instead of using a metadata call to the database. The following changes and additions have been made in the Database view:

- Joins have been added as necessary.
- To allow aggregation at different levels of granularity, some model query subjects have been created. For example, see the relationships between Time and Sales or Sales fact.
- To allow single joins to be made between the lookup tables and each level in a dimension, lookup tables have been copied. For example, see the Products look up tables.

The Business view contains only model query subjects, with no joins. The following changes and additions have been made in the Business view:

- Calculations were added to the model query subjects. For example, the time dimension contains language calculations.
- Where the database has multiple hierarchies, new dimensions have been created to organize each hierarchy. For example, see the employee hierarchies, where employees are organized by manager and region.

The GO Sales Transactional Database

The GO Sales model, great_outdoors_sales.cpf, is based on the GOSALES database, which is structured as a transactional database. It contains principally sales data.

The Database view is very similar to the underlying database structure. The following changes and additions have been made in the Database view:
To make it possible to join the fact tables to the time dimension, model query subjects and multipart joins have been used.

Other joins have been added as necessary.

The Business view contains only model query subjects, with no joins. The following changes and additions have been made in the Business view:

- Calculations were added to the model query subjects.
- Model query subjects that were created in the Database view to enable joins on the time dimension have been linked as reference shortcuts.
- Where the database has multiple hierarchies, new dimensions have been created to organize each hierarchy.
- Sales Staff is a subset of the slowly changing Employee dimension. There is no unique Employee key in GO Sales, so a filter retrieves the current record only. This model does not use historical data.

**The Samples PowerCubes**

The following cubes are delivered with the Sample Outdoors samples in English, French, German, Japanese and Chinese:

- sales_and_marketing.mdc
- employee_expenses.mdc
- go_accessories.mdc
- go_americas.mdc
- go_asia_pacific.mdc
- great_outdoors_sales_en.mdc

**The Samples Packages**

The Sample Outdoors samples include six packages. Below is a brief description of each available package.

Go Data Warehouse (analysis) is a dimensionally modeled view of the GOSALESDW database. This package can be used in all studios, including IBM Cognos Analysis Studio. Using this package you can drill up and down.

Go Sales (analysis) is a dimensionally modeled view of the GOSALES database. This package can be used in all studios, including Analysis Studio. Using this package you can drill up and down.

Go Data Warehouse (query) is a non-dimensional view of the GOSALESDW database. This package can be used in all studios except Analysis Studio, and is useful for reporting when there is no need for drilling up and down.

Go Sales (query) is a non-dimension view of the GOSALES database. This package can be used in all studios except Analysis Studio, and is useful for reporting when there is no need for drilling up and down.

Sales and Marketing (cube) is an OLAP package, based on the sales_and_marketing.mdc cube.

Great Outdoor Sales (cube) is an OLAP package, based on the great_outdoors_sales_en.mdc cube.
Note: The OLAP packages, Great Outdoor Sales (cube) and Sales and Marketing (cube), are not multilingual. The IBM_Cognos_PowerCube.zip archive contains five versions of each package; one in English, French, German, Japanese and Chinese.

Install the IBM Cognos Business Intelligence Samples

The IBM Cognos Business Intelligence samples illustrate product features and technical and business best practices. You can also use them for experimenting with and sharing report design techniques, and for troubleshooting. If you want to use the samples, install them from the IBM Cognos Business Intelligence Samples disk or from the location where you downloaded and extracted the files.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names.

The packages in the samples are also available for the dynamic query mode. For information about setting up the sample reports for the dynamic query mode, see the Dynamic Query Guide.

Installing samples on UNIX or Linux

Use the following procedure to install the IBM Cognos Business Intelligence samples on UNIX or Linux operating systems.

Procedure

1. Mount the IBM Cognos product disk using Rock Ridge file extensions or go to the location where the installation files were downloaded.

   To mount the IBM Cognos disk on HP-UX, do the following:
   
   • Add the pfs_mount directory in your path.
     
     For example,
     
     PATH=/usr/sbin:SPATH
     
     export PATH
   
   • To start the required NFS daemons and run the daemons in the background, type bg pfs_mount and then type bg pfsd
   
   • To mount the drive, type
     
     pfs_mount -t rrip &ltdevice&gt;&ltmount_dir&gt; -o xlat=unix
     
     For example,
     
     pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
     
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   
   • When the installation is complete, type pfs_umount /cdrom and kill the pfsd and pfs_mountd daemons to unmount the disk.

2. To start the installation wizard, go to the operating system directory and type ./issetup

   Note: When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on a UNIX operating system, first set environment variables LANG=C and LC_ALL=C (where C is the language code, for example ja_JP.PCK on Solaris), and then run an unattended installation. For more information, see "Set Up an Unattended Installation Using a File From an Installation on Another Computer" on page 492.
If you do not use XWindows, run an unattended installation. For more information, see “Set Up an Unattended Installation Using a File From an Installation on Another Computer” on page 492.

3. Follow the directions in the installation wizard and copy the required files to your computer.
   Install the samples in the same location as the server components.
4. In the Finish page of the installation wizard, click Finish.

Installing samples on Windows
Use the following procedure to install the IBM Cognos Business Intelligence samples on Microsoft Windows operating systems.

Procedure
1. Insert the Samples disk or go to the location where the installation files were downloaded and extracted.
   The Welcome page of the installation wizard appears.
2. If no Welcome page appears, go to the operating system directory and double-click the issetup.exe file.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. Follow the directions in the installation wizard to copy the required files to your computer.
   Install the samples in the same location as the server components.
5. In the Finish page of the installation wizard, click Finish.
6. Click Finish.
   Use the Microsoft Windows operating system Start menu to start IBM Cognos Configuration from the shortcut folder.

Setting Up the Samples
To set up the samples, you must perform several set up tasks, such as restoring the samples databases and creating data source connections.

After setting up the samples, you can use them to learn how to use IBM Cognos software, including Framework Manager, Metric Studio, Metric Designer, Event Studio, Business Insight and IBM Cognos Mobile.

IBM Cognos BI provides sample databases that contain sales, marketing, and financial information for a fictional company named the Sample Outdoors Company that sells sporting equipment.

Before you can use the sample databases, IBM Cognos BI must be installed, configured, and running and then the IBM Cognos BI Samples must be installed. To use the modeling tool, you should install the components Framework Manager, Metric Designer and Transformer. For information about installing and configuring IBM Cognos BI components and the samples, see the IBM Cognos BI Installation and Configuration Guide.

Using Samples
You can use the IBM Cognos samples to learn how to use IBM Cognos Business Intelligence, including Framework Manager, Metric Studio, Metric Designer, Event Studio, Business Insight and IBM Cognos Mobile.
IBM Cognos BI provides sample databases that contain sales, marketing, and financial information for a fictional company named the Sample Outdoors Company that sells sporting equipment.

Before you can use the sample databases, IBM Cognos BI must be installed, configured, and running and then the IBM Cognos BI Samples must be installed.

To use the modeling tool, you should install the components for Framework Manager, Metric Designer and Transformer.

For information about installing and configuring IBM Cognos BI components and the samples, see the IBM Cognos BI Installation and Configuration Guide.

To set up the samples, do the following:

- Restore the samples databases. You can manually restore the backup files for the sample databases. For instructions, see "Restore Backup Files for the Samples Databases" on page 270. You can also restore the backup files using scripts. For DB2, see "Restore Backup Files for Sample Databases for DB2 Using Scripts" on page 271. For Oracle, see "Restore Backup Files for Sample Databases for Oracle Using Scripts" on page 274.
- Create the data source connections to the samples databases.
- If you plan to use OLAP data source samples, set up the connection to the sample cubes, if this is required, and create data source connections to the OLAP data sources you want to use.
  
  Setup tasks are required only for Microsoft Analysis Services cubes, Essbase cubes and Cubing Services.
- If you plan to use the Metric Studio sample, set up the Metric Studio sample
- If you plan to use the Metric Designer sample, set up a data source connection to it, set up the Metric Studio sample, and import the IBM_Cognos_Samples and IBM_Cognos_Metrics deployment archives.
- Import the samples content (packages) into the content store.
- If you want to test the sample agent ELM Returns Agent using Event Studio, run the sample agent against changed data.

After you complete these tasks, use IBM Cognos BI to run the sample reports or scorecards. You can later remove the IBM Cognos BI samples.

**Restoring Backup Files for the Samples Databases**

To use the samples, you must restore backup files for the samples databases. This action re-creates multilingual versions of the Great Outdoors databases.

The following sample databases and associated files are provided with IBM Cognos Business Intelligence. For Microsoft SQL Server, each database is delivered as a Microsoft SQL Server backup file. For Oracle, you will need to unzip the file GS_DB_ORA.tar.gz. For DB2, you will need to unzip the file GS_DB.tar.gz. The location for the databases are as follows.

<table>
<thead>
<tr>
<th>Databases</th>
<th>File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>GS_DB_ORA\data</td>
</tr>
<tr>
<td>DB2</td>
<td>GS_DB\data</td>
</tr>
</tbody>
</table>
### Table 19. Microsoft SQL Server Databases and Files

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GOSALESDB.zip</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GOSALES.zip</td>
</tr>
</tbody>
</table>

### Table 20. Oracle Databases and Files

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
</tbody>
</table>

### Table 21. DB2 Databases and Files

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GS_DB.tar.gz</td>
</tr>
</tbody>
</table>

When restoring the samples databases, ensure that you do the following:

- Give the restored databases the same names as the backup or export file names. The names are case-sensitive.
  - You use the correct username and password.
- Create users with select privileges for tables in multiple schemas.
  - Setup for the GO Data Warehouse packages specifies a single connection object and user signon. This requires a single user named GOSALESDB with the select privilege to tables in a single schema named GOSALESDB.
  - Setup for the GO Sales packages specifies a single connection object and user signon. This requires a single user named GOSALES with the select privilege to tables in four schemas: GOSALES, GOSALESHR, GOSALESMR, and GOSALESRT.
- Use the UTF-8 character set on the Microsoft Windows operating system computer that is the Oracle or DB2 client to see reports in multiple languages.
  - For DB2, you must set the DB2CODEPAGE environment variable to a value of 1208. For Oracle, you must set the NLS_LANG environment variable to a value that is specific to a region. For example, set NLS_LANG for Americas to American_America.UTF8.
- Have sufficient disk space available in the target location. Reserve 150MB for the GO Sales data (four schemas) and 200MB for the GO Data Warehouse data (one schema).
Oracle Considerations

To create foreign key constraints in tables that reference different schemas, you must run gs_or_modify.sql, found in the same folder as the .dmp files.

Microsoft SQL Server Considerations

If you restore the Microsoft SQL Server backup files, you must use Microsoft SQL Server 2000 or Microsoft SQL Server 2005. Ensure that TCP/IP connectivity is used for the Microsoft SQL Server.

DB2 Considerations

The data files for db2move and the scripts, to add constraints, are located in the data directory. The data directory is created when you unzip the GS_DB.tar.gz file.

If you use WinZip to extract the DB2 move file on Windows, ensure that the TAR file smart CR/LF conversion option is not selected.

After extracting the DB2 move file, restore the schemas to a database named GS_DB.

To add views, constraints, user privileges, and stored procedures to GS_DB, prepare and run the gs_db_modify files included with the samples in the following order:
- Update the user name and password at the top of the gs_db_modify.sql and save it.
- Execute gs_db_modify.bat

Note: If the script file attempts to create a stored procedure where the procedure does not exist an error is generated. This error does not affect the samples.

Restore Backup Files for the Samples Databases:

Use this procedure to restore backup files.

Procedure

1. On the computer where IBM Cognos BI is installed, go to the sql server, oracle, or db2 directory located in c10_location /webcontent/samples/datasources.
2. If required, copy the backup files for the samples databases to your database backup directory.
   To ensure the security and integrity of IBM Cognos BI, copy the files to a directory that is protected from unauthorized or inappropriate access.
3. Restore the samples databases using your database management tool.

Tip:
- For SQL backup files, restore the database from a device, and ensure that the restore locations are correct for the .ldf and .mdf database files. For more information, see the Microsoft SQL Server documentation or the IBM Cognos Knowledge Base on the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).
- For DB2, when you create the GS_DB database, create a buffer pool with a page size of 16 KB and an associated tablespace.
4. For each database, create at least one user who has select permissions for all the tables in the restored databases.

Results

You can now create the data source connections in the portal.

**Restore Backup Files for Sample Databases for DB2 Using Scripts**

You can use scripts to restore backup files for sample databases for DB2.

To set up the sample database, you must extract the GS_DB.tar.gz file, customize a configuration file, and run the setup script.

There are prerequisites for installing the Great Outdoors sample database for DB2 on Linux, UNIX and Windows. Before you can install the sample databases, you must verify or configure privileges.

1. Extract the GS_DB.tar.gz file and retain the original directory structure. If you use WinZip to extract the DB2 move file on Microsoft Windows operating system, ensure that the TAR file smart CR/LF conversion option is not selected.

2. On Linux and UNIX operating systems, modify the file permissions on the setupGSDB.sh file so that it is executable: chmod u+x setupGSDB.sh.

3. Ensure that the user ID used to set up the database has DBADM authority or the following authorities in DB2:
   - CREATETAB
   - CREATE_NOT_FENCED_ROUTINE
   - LOAD

**Optional: Editing the configuration file**

The configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are.

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_INST</td>
<td>GS_DB</td>
<td>Used to set the name or alias of the database.</td>
</tr>
<tr>
<td>GOSALES_CREATEDB</td>
<td></td>
<td>Optional: Causes an existing database with the same name to be dropped.</td>
</tr>
<tr>
<td>GOSALES_DB_TERRITORY</td>
<td>US</td>
<td>When creating a database this is the territory of the UTF-8 database that is created.</td>
</tr>
<tr>
<td>GOSALES_BP</td>
<td>GOSALES_BP</td>
<td>Optional: Enter the buffer pool and tablespace name, if these are to be created by the script.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td></td>
</tr>
<tr>
<td>Configuration Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GOSALES_GRANTEES</td>
<td>GOSALES, DB2ADMIN</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas. This string needs to follow the syntax of the GRANT command.</td>
</tr>
<tr>
<td>GOSALESDW_GRANTEES</td>
<td>GOSALESDW</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALESDW schema.</td>
</tr>
<tr>
<td>GOSALES_DPF</td>
<td>N</td>
<td>Change to 'Y' if installing a database partitioned environment (DPF)</td>
</tr>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Enter the names to be used for each schema.</td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td></td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td></td>
</tr>
</tbody>
</table>

You can customize the sample configuration file to use settings other than the default values.

The setup script creates the GS_DB database, table spaces, tables, views, grants privileges, and modifies the schema names for the sample database. In most situations, you can accept the default options. If you want to change the database name or modify the users or groups that have permissions on the data, you must update the GOSalesConfig configuration file.

Edit the configuration file by using a text editor.

**Note:** If you edit UNIX shell scripts in a Windows environment, ensure that you preserve the UNIX line endings.

The configuration file on Windows is GOSalesConfig.bat. The configuration file on UNIX is GOSalesConfig.sh.

By default, the GS_DB database name is used and permissions are granted to the DB2ADMIN (Linux, UNIX, Windows) and GOSALES users.

**Running the setup script in interactive mode**

In interactive mode, the setupGSDB script prompts you to confirm or provide configuration information for the GS_DB database installation. You can accept the default settings or provide different settings to replace the defaults.

- Run the setup script for your operating system.
Operating System | Command
---|---
Microsoft Windows | In a DB2 command window, change to the GS_DB/win directory and run the `setupGSDB.bat` script.
UNIX | From a shell prompt, source the db2profile change to the GS_DB/unix directory, and run the `setupGSDB.sh` script.

• Press Enter to proceed. The script displays a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes. For example:

Please confirm the following settings:
Database Name: GS_DB
Drop and Recreate Database: Y
DPF environment: N
Create a 16k Bufferpool named: GOSALES_BP
Create a 16k Tablespace named: GOSALES_TS
GOSALES Grant users/groups: GOSALES, DB2ADMIN
GOSALESIDW Grant users/groups: GOSALESIDW, DB2ADMIN
Administration User Name: db2admin
Import the sample data to the following schemas:
GOSALES
GOSALESIDR
GOSALESIDMR
GOSALESIDRT
GOSALESIDDW
WARNING: If the database GS_DB already exists it will be dropped
Continue creating the sample data with these settings? (Y/N) Default=Y:

The GS_DB database is set up.

Running the setup script with command line options

The `setupGSDB` script lets you provide information on the command line to reduce the number of prompts from the script.

From a command line, run the script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td><code>setupGSDB.bat</code></td>
</tr>
<tr>
<td>UNIX</td>
<td><code>setupGSDB.sh</code></td>
</tr>
</tbody>
</table>

You can run the `setupGSDB` script with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-createdb</code></td>
<td>Creates the database. This option drops any existing database with the same name. It creates the required buffer pool and table space.</td>
</tr>
<tr>
<td><code>-database database name</code></td>
<td>Specifies the name of the database. This value overrides the default value of GS_DB.</td>
</tr>
<tr>
<td><code>-userid administration_user_ID</code></td>
<td>Specifies the name of the DB2 administrator user ID that is used to create the database.</td>
</tr>
<tr>
<td><code>-password administration_user_ID</code></td>
<td>Specifies the password for the DB2 administrator user ID.</td>
</tr>
</tbody>
</table>
**Option Description**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-noprompt</td>
<td>Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.</td>
</tr>
</tbody>
</table>

**Example 1:** You are a DB2 administrator and want to create the default GS_DB database on the local node. You run the following command:

```
setupGSDB -createDB -noprompt
```

**Example 2:** You want to create the tables in an existing database named GSDBY, and you want to use the administrator user ID db2admin. Run the following command:

```
setupGSDB -database GSDBY -userid db2admin
```

The script prompts you for the password when it connects to GSDBY. The script will replace any tables that already exist in the GSDBY database, unless you choose to drop the database.

**Optional: Installing the sample data on a remote server**

If the GS_DB sample database is installed on a remote server in your environment, you can link to it by cataloguing the remote database on your local computer and then running the setup script locally.

- If the sample database does not yet exist on the remote server, create it with the `CREATE DATABASE` command. The database requires a UTF-8 codeset and a default table space with a pagesize of 16 KB or larger. For example, on the remote server, create the database by running the following command:
  ```
  CREATE DATABASE GS_DB USING CODESET UTF-8 TERRITORY US PAGESIZE 16k
  ```
- On your local computer, catalog the remote database:
  ```
  db2
catalog tcpip node nodename remote ipaddr server port_number
db2 catalog database GS_DB as GS_DB at node nodename
  ```
- On your local computer, run the script:
  ```
  setupGSDB
  -database GS_DB -userid administration_user_ID
  ```

You are prompted for a password to connect to the database.

**Restore Backup Files for Sample Databases for Oracle Using Scripts**

You can use scripts to restore backup files for sample databases for Oracle.

To set up the sample database, you must extract the file GS_DB_ORA.tar.gz, customize a configuration file, and run the setup script.

There are prerequisites for installing the Great Outdoors sample database for Oracle. Before you can install the sample databases, you must verify or configure privileges.

- Extract the GS_DB_ORA.tar.gz file and retain the original directory structure.
• On Linux and UNIX operating systems, modify the file permissions on the setupGSDB.sh file so that it is executable: chmod u+x setupGSDB.sh.
• Ensure that the user ID used to set up the Oracle database has authority to create users and run the import utility.

**Editing the configuration file: Optional**

The configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are.

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_IMP_CMD</td>
<td>imp</td>
<td>If necessary can be modified to specify the correct version of the import utility.</td>
</tr>
<tr>
<td>GOSALES_INST</td>
<td></td>
<td>Oracle host string.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td>If users are created by scripts, used to enter the tablespace name to assign to users.</td>
</tr>
<tr>
<td>GOSALES_CREATE_TS</td>
<td></td>
<td>Optional: Used to create the default tablespace for users.</td>
</tr>
<tr>
<td>GOSALES_TEMP_TS</td>
<td></td>
<td>If users are created by scripts, used to name a temporary tablespace to assign to users. Leave blank to use the default temporary tablespace.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Used to enter the username and password for the GOSALES user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA_PW</td>
<td>GOSALESPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td>Used to enter the username and password for the GOSALESHR user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA_PW</td>
<td>GOSALESHRPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td>Used to enter the username and password for the GOSALESMR user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA_PW</td>
<td>GOSALESMRPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td>Used to enter the username and password for the GOSALESRT user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA_PW</td>
<td>GOSALESRTPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td>Used to enter the username and password for the GOSALESDW user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA_PW</td>
<td>GOSALESDWPW</td>
<td></td>
</tr>
</tbody>
</table>
## Configuration Setting Default Description

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_GRANTEES</td>
<td>GOSALES</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE, and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALTER permissions for GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The owner of the GOSALES_SCHEMA will always be granted SELECT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INSERT, DELETE, UPDATE and ALTER privilege on all schemas.</td>
</tr>
<tr>
<td>GOSALESDW_GRANTEES</td>
<td>GOSALESDW</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALTER permissions for GOSALESDW schema.</td>
</tr>
</tbody>
</table>

You can customize the sample configuration file to use settings other than the default values.

The setup script creates the users and schemas specified in the configuration file. In most situations, you can accept the default options. If you want to change the schema names or modify the users or groups that have permissions on the data, you must update the GOSalesConfig configuration file.

Edit the configuration file by using a text editor.

### File Description

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSalesConfig.bat</td>
<td>Configuration file on Microsoft Windows operating system</td>
</tr>
<tr>
<td>GOSalesConfig.sh</td>
<td>Configuration file on UNIX</td>
</tr>
</tbody>
</table>

**Running the setup script in interactive mode**

In interactive mode, the setupGSDB script prompts you to confirm or provide configuration information for the sample database installation. You can accept the default settings or provide different settings to replace the defaults.

- Run the setup script for your operating system.

### Operating System Command

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>In a DOS command window, change to the GS_DBORA\win directory and run the setupGSDB.bat script.</td>
</tr>
<tr>
<td>UNIX</td>
<td>From a shell prompt, change to the GS_DBORA/unix directory, and run the setupGSDB.sh script.</td>
</tr>
</tbody>
</table>
• Press Enter to proceed. The script will run the sample database setup and display a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes. For example:

Please confirm the following settings:

Instance Name is ORAINST123
Create the following user accounts and import the data:
   GOSALES
   GOSALESHR
   GOSALESMR
   GOSALESRT
   GOSALESDE
Default tablespace is GOSALES_TS
Temporary tablespace is DEFAULT
Administration User name is sys

WARNING: If the users already exist they will be dropped

Create a Tablespace named GOSALES_TS
Grant select on the GOSALES schemas to GOSALES
Grant select on the GOSALESDE schema to GOSALESDE

Continue creating the sample data with these settings?
(Y/N) Default=Y:

Tip: If you edit UNIX shell scripts in a Windows environment, ensure that you preserve the UNIX line endings.

Running the setup script with command line options

The setupGSDB script lets you provide information on the command line to reduce the number of prompts from the script.

From a command line, run the script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>setupGSDB.bat</td>
</tr>
<tr>
<td>UNIX</td>
<td>setupGSDB.sh</td>
</tr>
</tbody>
</table>

You can run the setupGSDB script with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-createdb</td>
<td>Creates the users. This option drops any existing users with the same name.</td>
</tr>
<tr>
<td>-database database name</td>
<td>Specifies the name of the Oracle instance. This value overrides the default value specified in the configuration file.</td>
</tr>
<tr>
<td>-userid administration_user_ID</td>
<td>Specifies the name of the Oracle administrator user ID that is used to create the users.</td>
</tr>
<tr>
<td>-password administration_user_ID</td>
<td>Specifies the password for the Oracle administrator user ID.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-noprompt</td>
<td>Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.</td>
</tr>
</tbody>
</table>

**Example 1:** You are an Oracle administrator and want to create the default sample database schemas. You run the following command:

```
setupGSDB -createDB -noprompt
```

**Example 2:** You want to create the tables in the existing schemas specified in the configuration file, and you want to use the administrator user ID sys. Run the following command:

```
setupGSDB -YourOracleInstance -userid sys -sysdba
```

The script prompts you for the password when it connects to the Oracle instance. The script deletes any existing tables or views in the specified schemas and replaces them.

**Create Data Source Connections to the Samples Databases**

You must create data source connections to the samples databases that you restored.

IBM Cognos Business Intelligence uses data source connections to the samples databases to connect to the samples databases and run the sample reports or use the sample package.

**Before you begin**

The DB2 database name that you type must use uppercase letters. Also, in Framework Manager, the schema names that you type for the DB2 data sources must use uppercase letters.

Before you create the data source connections, you must restore the backup files for the samples databases. Also, ensure that the IBM Cognos BI service is running.

To create data sources, you must have execute permissions for the Data Source Connections secured feature and traverse permissions for the Administration secured function. You must have write permissions for the Cognos namespace.

If you have restored the sample databases on a different computer than where you have installed the IBM Cognos BI Application Tier Components, you may have to install the database client to access the sample databases. For more information, see "Set Up Database Connectivity for Reporting Databases" in the Installation and Configuration Guide.

**Procedure**

1. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking **Administer IBM Cognos Content** on the Welcome page.
2. Click the **Configuration** tab.
3. Click the new data source icon 

4. In the Name box, type great_outdoors_sales and then click Next.

5. In the connection page, click the type of database that you restored and want to connect to, select an isolation level, and then click Next.

   The connection string page for the selected database appears.

   Tip: The user specified in the great_outdoors_sales data source must have select privileges on the tables in each of the GOSALES, GOSALESRT, GOSALESMR, AND GOSALESHR schemas.

6. Do one of the following:

   - If you restored the samples databases in Microsoft SQL Server, in the Server Name box, type the name of the server where the restored databases are located. In the Database name box, type GOSALES.

     IBM Cognos BI samples require TCP/IP connectivity with Microsoft SQL Server. Ensure the SQL Server Security is set to SQL Server and Microsoft Windows operating system, instead of Windows Only. The samples use SQL Server security for authentication.

   - If you restored the samples databases in Oracle, in the SQL*Net connect string box, type the instance name of the Oracle database as it is entered in the tnsnames.ora file.

   - If you restored the samples database in DB2, in the DB2 database name box, type GS_DB using uppercase letters. Leave the DB2 connect string box blank.

   - If you deployed the sample cube to IBM InfoSphere™ Warehouse Cubing Services, in the Name box, type sales_and_marketing_cs. On the Specify the connection page for the Type box, select IBM InfoSphere Warehouse cubing services (XMLA). On the Specify the connection string page for the Server URL box, type the name of the server and the XMLA port number for the cube, followed by /IBMXmlAnalysis. For example, myserver:1999/IBMXmlAnalysis.

7. Under Signons, select the both Password and Create a signon that the Everyone group can use check boxes, type the user ID and password for the user that you created when you restored the databases, and then click Finish.

   Tip: To test whether the parameters are correct, click Test the connection....

8. Click Finish.

9. Repeat steps 4 to 9 for the GOSALES DW samples database or schema, and type great_outdoors_warehouse in step 5.

10. If the GOSALESW model will be used by modelers in IBM Cognos Transformer, the connection string must be manually added to the cs7g.ini file.

### Results

The Great Outdoors data source connections appear as entries in Data Source Connections.

You can now import the samples unless there is a syntax error in the connection string or an incorrect parameter.

### Set Up Microsoft Analysis Services Cube Samples

IBM Cognos Connection or Framework Manager provides sample cubes for Microsoft Analysis Services (MSAS).
For finance data, use the GO Finance Fact cube derived from the GOSALES Dw database. This cube contains year-to-date and monthly financial data for all accounts so that you can create financial statements in Analysis Studio, Query Studio, and Report Studio. The data is in actual US dollars submissions for 2004, 2005, 2006, or 2007 (7 months actual data only).

The MSAS2000 version of the finance cube and database is in the GOFinanceFact_XX.cab file. The MSAS2005 version is in the GOFinanceFact_XX.abf file. XX represents the language. For example, XX is replaced with EN which indicates English. The MSAS2008 version of cubes also exists, with report content only for 2000 and 2005 versions.

For sales data, use the GOSalesFact cube derived from the GOSalesFact_XX Analysis Services database, based on the GOSALES Dw SQLSERVER Database. The cube contains measures such as unit cost, unit price, quantity, and gross profit. Dimensions include Time, Product, and Retailers.

The MSAS2000 version of the sales cube and database is archived in the GOSalesFact_XX.cab. The MSAS2005 version is in the GOSalesFact_XX.abf restorable backup file.

The backup files are located in the c10_location/webcontent/samples/datasources/cubes/MSAS directory. The files must be restored to a Microsoft SQL Server database running the applicable Microsoft Analysis Services and hosting the GOSALES Dw database.

**Note:** Both Microsoft XML 6.0 Parser and Microsoft SQL 2005 Analysis Services 9.00 OLEDB Provider must be installed on the local client to establish data source connections to MSAS cubes.

**Procedure**

1. On the computer where IBM Cognos Business Intelligence is installed, go to the c10_location/webcontent/samples/datasources/cubes/MSAS/en directory.
2. Copy the GOSALES Dw.cab and GOSALES Dw.abf files to a directory that you can access from the Analysis Manager console in the Analysis Servers of Microsoft SQL Server.
3. Use the Microsoft Analysis Services Analysis Manager to restore the database from the GOSALES Dw.cab and GOSALES Dw.abf files.

**Results**

You can now create the data source connections to these MSAS datasources in Cognos Administration by referencing either the GOSalesFact_XX or GOFinanceFact_XX cubes you restored.

**Set Up the InfoSphere Warehouse Cubing Services Sample**

IBM Cognos Connection or Framework Manager provides sample cubes for InfoSphere Warehouse Cubing Services.

**Before you begin**

Before you set up the InfoSphere Warehouse Cubing Services samples, you must restore the DB2 sample database.
Procedure

1. On the computer where IBM Cognos software is installed, go to the db2 directory located in \c10_location\webcontent\samples\datasources\cubes\CubingServices\EN.
2. If required, copy the csgodw.xml file to your working directory.
3. In IBM InfoSphere Warehouse Design Studio, import the csgodw.xml metadata file into a data model based on the DB2 GS_DW schema.
4. Deploy the CSGODW cube to the DB2 GS_DW schema.
5. Use the IBM InfoSphere Warehouse Administration Console to add the new cube to a cube server, and run it.
   Note the XMLA port number for the cube, as this number is required for the data source connection.

Results

You can now create the data source connections in the IBM Cognos Connection portal.

Set Up the TM1 Samples

To use the TM1 samples, you must set up the servers, create a shortcut to the configuration file, import the deployment files, and create the data source connections.

To set up the TM1 server samples, unzip and install the greatoutdoors.zip files. To set up the TM1 FinanceFact Server, unzip and install the financefact.zip files. The default installation path for these files is: C:\Program Files\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1.

Procedure

1. Ensure that you have the TM1 software installed and the server started.
2. Create a desktop shortcut to the preconfigured location of the TM1s.cfg configuration file. The default location is: C:\Program Files\IBM\Cognos\TM1\bin\tm1s.exe -z "C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1\greatoutdoors."
3. If the location of your configuration file is different, open the configuration file in a text editor and modify it. An example of a basic configuration file is as follows.

   Security Mode
   - If IntegratedSecurity Mode is set to 1. All clients must provide a database username and password.
   - If IntegratedSecurity Mode is set to 2. The clients will have the choice to connect by providing a database username and password or use the single-login mechanism for authentication.
   - If IntegratedSecurity Mode is set to 3. All clients must use the single-login mechanism for authentication.

   TM1S
   DatabaseDirectory=C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1\greatoutdoors
   LoggingDirectory=C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\tm1\greatoutdoors\LogFiles
   ServerName=GreatOutdoors
   PortNumber=33339
AdminHost=localhost
Language=eng
Protocol=tcp
NetworkFrame=
SaveTime=
DownTime=
RuleTraceOn=

For more information about setting up the configuration file and its parameters, see the TM1 Operations Guide.

4. To start the server, launch the desktop shortcut to TM1s.cfg.
5. To import the report deployment files, Sales_plan.zip, Sales_plan_TC.zip, and TM1_FinanceFact.zip, use IBM Cognos Administration.

Results

The Financefact and Salesplan packages are created. These packages connect to the TM1_FinanceFact and TM1_SalesPlan data sources which you must now create in Cognos Administration.

The deployment packages refer to the following data sources.

Tip: For Traditional Chinese, use the x_TC packages.

<table>
<thead>
<tr>
<th>Application</th>
<th>Data Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors</td>
<td>TM1_SalesPlan</td>
</tr>
<tr>
<td></td>
<td>TM1_SalesPlan_TC</td>
</tr>
<tr>
<td>FinanceFact</td>
<td>TM1_FinanceFact</td>
</tr>
<tr>
<td></td>
<td>TM1_FinanceFact_TC</td>
</tr>
</tbody>
</table>

The deployment packages refer to the following Report Studio reports.

<table>
<thead>
<tr>
<th>Packages</th>
<th>Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>GreatOutdoors</td>
<td>Best Selling Products</td>
</tr>
<tr>
<td></td>
<td>Channel Pricing Comparison</td>
</tr>
<tr>
<td></td>
<td>Forecast Revenue by Region: Golf Shops</td>
</tr>
<tr>
<td></td>
<td>Golf Shop Sales Forecast - Americas versus</td>
</tr>
<tr>
<td></td>
<td>Asia Pacific</td>
</tr>
<tr>
<td>FinanceFact</td>
<td>Gross Margin Forecast</td>
</tr>
<tr>
<td></td>
<td>Balance Sheet - Americas</td>
</tr>
<tr>
<td></td>
<td>Balance Sheet - Central Europe</td>
</tr>
<tr>
<td></td>
<td>Income Statement</td>
</tr>
<tr>
<td></td>
<td>Source and Application of Funds (Central</td>
</tr>
<tr>
<td></td>
<td>Europe)</td>
</tr>
</tbody>
</table>

Set Up the Essbase Cube Sample

To set up the Essbase cube sample, you must have Oracle Essbase and Essbase Integration Services Console installed.
Alternatively, you can set up the smaller Essbase cube GODBRReduced.zip which is a filtered version of the full version, GODWENU. To set up the small version, unzip GODBRReduced.zip, load the OTL and txt file in the Essbase environment, and perform the same steps shown below.

**Procedure**

1. Go to the `c10_location\webcontent\samples\datasources\cubes\Essbase\Outlines_and_Raw_Data` directory.
   This directory contains zip files for the different languages, such as EN.zip or JA.zip for English and Japanese, respectively.

2. Unzip the file for your language.
   Each zip file contains the following two files:
   - `languageU_Data.txt`, such as ENU_Data.txt or JAU_Data.txt.
   - `GODWlanguageU.otl`, such as GODWENU.otl or GODWJAU.otl.

3. Using block storage in Essbase, create a Unicode application.
4. Within the application, create a new database.
   You can use GODWlanguageU, such as GODWENU or GODWJAU, as your database name, or use the name of your choice.

5. Copy and paste the `GODWlanguageU.otl` file in your database directory.

6. If the database name specified in step 4 is different than GODWlanguageU, rename the `GODWlanguageU.otl` file to match the database name that you created.
   Confirm that you want to overwrite the `.otl` file.

7. In *Essbase Administration Services* console, open your database outline and save it.
   Confirm that you want to save the outline even if it was not changed.

8. Copy the `languageU_Data.txt` file and paste it in the same directory as the `.otl` file.

9. In *Essbase Administration Services* console, right-click the database you created and select **Load Data**.

10. Browse to the `languageU_Data.txt` file in your database directory, select the file, and click **OK**.

11. After the data loads successfully, right-click the database and select **Execute Calculation**.

12. Select the default calculation, and click **OK**.
   The calculation process may take up to 5 hours, depending on the computer where Essbase OLAP Server is installed.

**Results**

You can now create a data source connection to the cube.

**Creating Data Source Connections to OLAP Data Sources**

IBM Cognos Business Intelligence provides OLAP samples.

Samples are accessible to everyone by default. To create customized data sources, you must have execute permissions for the **Data Source Connections** secured feature, and traverse permissions for the **Administration** secured function. You must have write permissions for the Cognos namespace.

The OLAP samples are
GO Sales Fact and GO Finance Fact Microsoft Analysis Services cubes
Great Outdoors Company cubes which includes sales_and_marketing, employee_expenses, go_accessories, go_americas, go_asia_pacific, and great_outdoors_sales_en.
Great Outdoors DB2 cube

You must create data source connections to the cubes to use the samples. You must set up the Microsoft Analysis Services cube samples or set up the Essbase cube sample, if you are using them, before creating data source connections.

Create Data Source Connections to PowerCubes:

Use the following procedure to create a data source connection to a PowerCube.

Procedure
1. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking Administer IBM Cognos Content on the Welcome page.
2. Click the Configuration tab.
3. Click the new data source button.
   Note: You must add a data source connection for each cube.
4. To create a data source connection for the Sales and Marketing cube, type sales_and_marketing in the Name box, and then click Next.
5. In the connection page, under Type click IBM Cognos PowerCube, and then click Next.
The connection string page for the selected database appears.
6. Optional: In the Read cache size (MB) box, type the cache size of the cube in megabytes.
   If you leave this field blank or type 0, IBM Cognos Connection uses the default value in the ppds_cfg.xml file in the configuration folder.
7. In the Windows location box, type the location and name of the sales_and_marketing.mdc file for the data source connection. For example, type c10_location/webcontent/samples/datasources/cubes/PowerCubes/En/Sales_and_Marketing.mdc
   You can define a Microsoft Windows operating system path or a UNIX operating system path.
   If you define a UNIX path and you plan to use Framework Manager, you must also define the Windows path and ensure that the cube is also available in the Windows location. Framework Manager can access cubes only from Windows locations.
8. To test whether the parameters are correct, do the following:
   • Click Test the connection.
   • Click Test.
   • When the test finishes, click Close twice.
9. Click Finish.

Results

You can now import the sample package for the PowerCube to use this data source or you can create your own package using cube.
Create Data Source Connections to Oracle Essbase Cubes:

Use the following procedure to create a data source connection to an Oracle Essbase cube.

**Note:** To connect to an Oracle Essbase data source, the client software must be installed and configured on the IBM Cognos Business Intelligence server and in the same location as IBM Cognos Framework Manager.

**Procedure**

1. Launch IBM Cognos Administration.
2. On the **Configuration** tab, click **New Data Source**.
3. In the name and description page, type a unique name for the data source and, optionally, a description and screen tip, and then select **Next**.
4. In the connection page, from the Type drop-down list, select **Oracle Essbase**, and then click **Next**. The connection string page appears.
5. Type the name of the Oracle Essbase server.
6. Select **Signons**, and then click **Password** and **Create a signon the Everyone group can use**.
7. Type the User ID, Password, and then confirm the password for the cube.
8. Select **Test the connection**, and then **Test** to test whether parameters are correct. In the Status column, you can see if the connection was successful. If it was unsuccessful, select **Close**, return to the previous steps, and verify your connection parameters. If it was successful, go to the next step.
9. Click **Finish**.

**Results**

To use this data source, you must create a package using this data source in Framework Manager, and then publish the package.

Create Data Source Connections to Microsoft Analysis Service Cubes:

Use the following procedure to create a data source connection to a Microsoft Analysis Service cube.

**Procedure**

1. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking **Administer IBM Cognos Content** on the **Welcome** page.
2. On the **Configuration** tab, click **New Data Source**.
3. In the **Name** box, type the name of the data source connection, and then click **Next**.
   - For the GOFinanceFact cube, type GOFinanceFact_XX_MSAS2005.
   - For the GOSalesFact cube, type GOSalesFact_XX_MSAS2005.
4. In the **Specify Connection** page of the New Datasource Wizard, click **Microsoft Analysis Services 2005** or click **Microsoft Analysis Services (via ODBO)** as appropriate to the cube you are accessing.
5. Click **Next**.
6. In the **Server Name** box, type the name of the server where the restored databases are located. Back slashes are not required.
7. Under Signon, select the Password check box and then select the Create a signon that the Everyone group can use check box. Type the user ID and password for the MSAS database. For MSAS2005, this is a network login.

8. Click Test the connection, and then click the Test button. Click Close.

9. Click Finish. You are now prompted to create a package.

   Alternatively, you can deploy an existing package from a sample deployment archive. The names of the deployment archives match the datasource connection names specified in step 4 and contain sample reports that work with the associated cubes.

   In Content Administration on the Configuration tab in IBM Cognos Administration, click New Import. The New Import Wizard prompts you to select a deployment archive. When you select a deployment archive, it is important to click Edit and specify a target name for the package to prevent an existing package from being overwritten.

10. To create a package, check Create a Package and then click OK.

11. Specify a package name and then click OK.
   - For the GO Finance Fact cube, type GOFinanceFact_XX_MSAS2005.
   - For the GO Sales Fact cube, type GOSalesFact_XX_MSAS2005.

12. Specify the Analysis Services database you restored either GOFinanceFact_XX or GOSalesFact_XX:
   - For either the GOFinanceFact cube or the GOSalesFact cubes, type GOSALESDW.
   - For the GO Sales Fact cube, type GO Sales Fact.

13. Click the cube applicable to the database.

14. Click Finish.

**Setting Up the Metric Studio Sample**

To set up the Metric Studio sample, you must create a metric store and a new metric package, set the import source, and import the metric data and files into the metric store.

Use the following procedure:

- Create a metric store named GOMETRIC.

- Create a new metric package named GO Metrics that uses the data source go_metrics.

   When prompted by the wizard, select the standard Gregorian calendar and accept the defaults for Years, Quarters, and Months. Select January 1, 2004 as the start date for a period that includes the current year. For example, if it is the year 2008, use a period of at least 5 years.

   For more information, see the section about metrics in the Administration and Security Guide.

- Set the import source.

- Import the metric data and files into the metric store.

**Set the Import Source:**

To set up the Metric Studio sample, you must set the import source.

**Procedure**

1. Copy all text files from the appropriate folder to the folder c10_location/deployment/cmm:
For Microsoft SQL Server or Oracle, copy from `c10_location/webcontent/samples/datasources/metricsdata/GOMetrics_Unicode`

For DB2, copy from `c10_location/webcontent/samples/datasources/metricsdata/GOMetrics_UTF8`

For all databases, for English instead of the multilingual Unicode samples, copy from `c10_location/webcontent/samples/datasources/metricsdata/GOMetrics`.

**Note:** You may need to create the cmm folder.

2. In Public Folders, click **GO Metrics**.
3. In Metric Studio, in the **Tools** list, click **Import Sources**.
4. Click the **Set Properties** icon in the **Actions** column next to the Default Import Source.
5. Under **Metric Deployment Location**, click **cmm** folder. This is the default deployment location.
6. Click **Include sub-directories**.
7. In the **File format** box, click **10.1.1**.
8. Under **Character Set Encoding**, select the appropriate encoding and click **OK**.
   - For Microsoft SQL Server or Oracle, select **Unicode (UTF-16)**
   - For DB2, select **Unicode (UTF-8)**
   - For **GO Metrics** data set, select Western European (Windows-1252), or leave the data set empty by selecting **Other**.

**Results**

You can now use the GO Metrics package in Metric Studio.

**Import Metric Data and Files into the Metric Store:**

To set up the Metric Studio sample, you must import the metric data and files into the metric store.

**Procedure**

1. Choose whether to import the files into the metric store using IBM Cognos Connection or Metric Studio:
   - To use IBM Cognos Connection, in **Public Folders** or **My Folders**, open the GO Metrics package by clicking the view metric package contents icon in the **Actions** column. Click **Metric Maintenance**.
   - To use Metric Studio, in Metric Studio, in the **Tools** list, click **Metric Maintenance**.
2. Click the **Import and transfer data from files into metric store** metric task.

  **Tip:** If an error occurs, click Clear staging area rejected data logs, Clear metric history data only, and Clear metric history and calendar data.

  **Tip:** You can also clear all existing audit log data from the metric data store by clicking Clear audit history. For more information, see the topic about clearing audit history in the Administration and Security Guide.

**Results**

You can now use the GO Metrics package in Metric Studio.
Import the Samples
To use the sample package and other content, you must import them from the sample deployment archive.

Before you begin
Before you import the IBM_Cognos_Samples.zip, IBM_Cognos_Metrics.zip, IBM_Cognos_Mobile.zip, IBM_Cognos_Office.zip, IBM_Cognos_Audit.zip, IBM_Cognos_Statistics.zip, IBM_Cognos_csgodw.zip or IBM_Cognos_DrillThroughSamples.zip deployment archives, you must restore the databases. You must also create data source connections to the samples databases. Every deployment requires a data source connection in order to run reports.

Before you import the IBM_Cognos_PowerCube.zip deployment archive, you must create a database connection to the appropriate PowerCube and select the language that you want to use. The language that you select must be supported by your locale.

Procedure
1. Copy the zip file from the c10_location/webcontent/samples/content directory to the directory where your deployment archives are saved. The default location is c10_location/deployment. The location is set in the configuration tool. For information about changing the location, see the configuration tool online help.
2. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking Administer IBM Cognos Content on the Welcome page.
3. On the Configuration tab, click Content Administration.
   
   Note: To access this area in IBM Cognos Administration, you must have the required permissions for the Administration tasks secured feature.
4. On the toolbar, click the New Import button. The New Import wizard appears.
5. In the Deployment Archive box select the archive:
   - IBM_Cognos_Samples
   - IBM_Cognos_PowerCube
   - IBM_Cognos_Metrics
   - IBM_Cognos_DrillThroughSamples
   - IBM_Cognos_Audit
   - IBM_Cognos_Mobile
   - IBM_Cognos_csgodw
   - IBM_Cognos_Office
6. Click Next.
7. Type a unique name and an optional description and screen tip for the deployment archive, select the folder where you want to save it, and then click Next.
8. In the Public Folders Content box, select the folders that you want to import. The IBM_Cognos_Samples deployment archive has a single folder named Samples with subfolders: Models and Sample Template. The Models folder contains the following packages or folders:
   - GO Data Warehouse (analysis), GO Data Warehouse (query), GO Sales (analysis), GO Sales (query).
Dashboard Folder, Dashboard Objects, Business Insight Samples, Interactive Samples

Note: The Business Insight Advanced folder from the GO Data Warehouse (analysis) package contains reports used for external data.

The IBM_Cognos_PowerCube deployment archive has packages or folders for the following languages:
- English - Sales and Marketing (cube)
- French - localized packages
- German - localized packages
- Japanese - localized packages
- Simplified Chinese - localized packages

The IBM_Cognos_Metrics deployment archive has the following packages or folders:
- GO Metrics

The IBM_Cognos_Mobile deployment contains:
- Sales and Marketing (cube) folder in five languages: English, French, German, Japanese and Chinese

For the IBM_Cognos_Mobile deployment archive, you must set up a data source connection for the following data source:
- the Sales and Marketing cube. A separate connection is required for each language.

The IBM_Cognos_Office deployment contains:
- GO Data Warehouse (analysis), GO Data Warehouse (query), GO Sales (analysis) and Sales and Marketing cube packages

The IBM_Cognos_DrillThroughSamples deployment archive has the following packages and folders:
- Sales and Marketing (cube) package in five languages: English, French, German, Japanese, and Chinese
- GO Data Warehouse (analysis) and GO Data Warehouse (query) package

For the IBM_Cognos_DrillThroughSamples deployment archive, you must set up data source connections for the following data sources:
- the sales and marketing cube. A separate connection is required for each language.
- the great_outdoors_sales. The database name is GOSALES.
- the great_outdoors_warehouse. The database name is GOSLAESDW.

9. Select the options you want, along with your conflict resolution choice for options that you select, and then click Next.

10. In the Specify the general options page, select whether to include access permissions and references to external namespaces, and who should own the entries after they are imported.

11. Click Next.

The summary information appears.

12. Review the summary information and click Next.

13. Select the action that you want:
- To run once now or later, click Save and run once. Click Finish, specify the time and date for the run, then click Run. Review the run time and click OK.
• To schedule at a recurring time, click **Save and schedule**. Click **Finish**, and then select frequency and start and end dates. Click **OK**.

  **Tip:** To temporarily disable the schedule, select the **Disable the schedule** check box.

• To save without scheduling or running, click **Save only** and click **Finish**.

14. When the import is submitted, click **Finish**.

**Results**

You can now use the sample packages to create reports and analyses in Report Studio, Query Studio, and Analysis Studio, view extracts in Metric Designer, or create agents in Event Studio. You can also run the sample reports that are available on the Public Folders tab in the portal.

**Sample Database Models**

Sample models that are included with IBM Cognos Business Intelligence provide information for the fictional company, the Sample Outdoors.

The samples include:

• `great_outdoors_sales`, which refers to the samples database `GOSALES`
• `great_outdoors_warehouse`, which refers to the database `GOSALES/DSW`
• `gosales_scriptplayer`, which refers to the samples databases `GOSALES`

You can use sample database models on different platforms. For information about moving models from one platform to another, see the Framework Manager **User Guide**.

**Note:** Transformer uses some of the reports in the GO Data warehouse (query) package as source data for various cubes. These reports are meant to be simple list reports with no formatting. The description information for the reports indicates if the report was developed to be source data for Transformer.

**GO Sales Model**

This model contains sales analysis information for the fictional company, The Sample Outdoors. It also has the query items required by the Event Studio samples. The model accesses three schemas and has two packages. One package is based on the dimensional view and the other is based on the query (relational) view.

**GO Data Warehouse Model**

This model contains financial, human resources, and sales and marketing information for the fictional company, The Sample Outdoors. The model accesses a dimensional relational data source. The model has two packages. One package is based on the dimensional view, the other is based on the query (relational) view.

**GO Sales Scriptplayer**

These files can be used to run the action logs in sequence. This action generates a model named `gosales_scriptplayer`, and publishes a package to the content store.
**Example - Running the Sample ELM Returns Agent Against Changed Data**

You can change data in the GOSALES database if an Event Studio user wants to test the sample agent ELM Returns Agent. The Event Studio user can then run the sample agent twice and detect a new event.

For more information, see the Event Studio User Guide.

Running the sample agent against changed data involves the following steps:

1. The Event Studio user runs the sample agent against the default data and then asks you to change the data.
2. You simulate the occurrence of some initial events and then ask the Event Studio user to run the sample agent a second time.
3. The Event Studio user runs the sample agent against the changed data. The Event Studio user informs you when the agent has completed running.
4. You simulate the passage of time and the resolution of some events and then ask the Event Studio user to run the sample agent a third time.
5. The Event Studio user runs the sample agent for the final time. The Event Studio user informs you when the agent has completed running.
6. You modify the data so that the ELM Returns Agent detects no events.

**Example - Simulate the Occurrence of Initial Events:**

Run part of the Event_Studio_ELM_Agent_Modify_GOSALES.sql script to simulate data changes.

The data changes include the following:

- change the date to the current date
- change the follow-up code to -1 in four records. A code of -1 indicates that follow-up is required.

**Procedure**

1. In SQL Query Analyzer, from the File menu, click Open.
2. Go to c10_location/webcontent/samples/datasources/sqlserver and double-click the Event_Studio_ELM_Agent_Modify_GOSALES.sql file.
3. In the toolbar, from the list of databases, click GOSALES.
4. In the Query window, under Part 1, select all sixteen lines of code.
5. From the Query menu, click Execute.

**Results**

The database is updated with the changes.

**Example - Simulate the Passage of Time and the Resolution of Some Events:**

Run part of the Event_Studio_ELM_Agent_Modify_GOSALES.sql script to simulate data changes.

First, change it so that two days elapsed since the ELM Returns Agent sample was last run. Second, for three of the four event instances found the last time that the
ELM Returns Agent sample ran, change the follow-up code from -1 to +1. This indicates that only one of the these event instances still requires follow-up and the other instances are resolved.

Procedure
1. In SQL Query Analyzer, from the File menu, click Open.
2. Go to c10_location/webcontent/samples/datasources/sqlserver and double-click the Event_Studio_ELM_Agent_Modify_GOSALES.sql file.
3. On the toolbar, click GOSALES from the list of databases.
4. In the Query window, under Part 2, select all lines of code that appear after the comments.
5. From the Query menu, click Execute.

Results
The database is updated with the changes.

Example - Modify the Data So That the ELM Returns Agent Detects No Events:

When the Event Studio user finishes running the sample ELM Returns Agent against changed data, they should notify you.

You can then modify the GOSALES database so that the agent no longer detects any event instances.

Procedure
Run the following sql commands:
UPDATE GOSALES.RETURNED_ITEM SET FOLLOW_UP_CODE = 0
UPDATE GOSALES.RETURNED_ITEM SET ASSIGNED_TO = 0
UPDATE GOSALES.RETURNED_ITEM SET DATE_ADVISED = NULL

Results
The data is modified. The sample ELM Returns Agent is ready to be used by another Event Studio User.

Remove the Samples Databases from IBM Cognos BI
After you finish using the sample reports to learn about IBM Cognos Business Intelligence, including Framework Manager, you can delete the packages on which the samples are based. This action permanently removes the samples from the content store.

Procedure
1. Open IBM Cognos Connection by connecting to the IBM Cognos BI portal and clicking IBM Cognos Content on the Welcome page.
2. Click the Public Folders tab.
3. Select the check box for the sample package you want to delete.
4. Click the delete button on the toolbar, and click OK.
Translated Product Documentation

The product installation includes a limited set of translated documentation for some languages, such as installation guides and release notes. To access a complete set of translated documentation, you must install it from IBM Cognos BI Supplementary Language Documentation.

Before you begin

Before installing the Supplementary Language Documentation, ensure that:

- IBM Cognos BI is installed and configured correctly
- adequate disk space is available to install supplementary language documentation
  You need at least 220 MB of disk space.
- your software environment is supported

Procedure

1. In the location where the Gateway component is installed, insert the IBM Supplementary Language Documentation disk or go to the directory where the installation files were downloaded and extracted.
   On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.
   On Windows, the installation wizard starts automatically from the product disk.
2. To manually start the installation wizard, go to the operating system directory and do the following:
   - On Windows, if no Welcome page appears, double-click the issetup.exe file.
   - On UNIX or Linux, type
     
     /issetup

     Note: When you use the issetup command with XWindows, Japanese characters may be corrupted.
3. Follow the instructions in the installation wizard to copy the required files to the same location where you installed gateway components for IBM Cognos BI. Install in a directory that contains only ASCII characters in the path name. Some Web servers do not support non-ASCII characters in directory names. The supplementary languages documentation components is selected by default.
4. Choose the option you want in the Finish page of the installation wizard.

Additional Language Fonts

To add support for the Japanese Yen or Korean Won character, you must install additional fonts from the IBM Cognos BI Supplementary Language Documentation disk.

The Unicode code point "U+005C" is officially assigned to the backslash. However, in Japan and Korea, that code point is historically assigned to their currency symbols and many people still prefer to see a yen or won sign in certain parts of software, for example in file paths. To accommodate this, you can install the “Andale WT J” and “Andale WT K” fonts.
Before you begin

Before installing the additional fonts, ensure that following conditions are met:

- IBM Cognos is installed and configured correctly.
- There is adequate disk space available to install additional fonts. You need at least 220 MB of disk space.
- Your software environment is supported.

Procedure

1. In the location where Application Tier Components are installed, insert the IBM Cognos BI Supplementary Language Documentation disk.
   On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.
2. Go to the directory on the disk that is appropriate for your operating system.
3. Start the installation wizard by typing the following command:
   - On Windows, use `issetup`
   - On UNIX or Linux, use `/.issetup`

   Note: When you use the issetup command with XWindows, Japanese characters may be corrupted.
4. Follow the instructions in the installation wizard to copy the required files to the same location where you installed Application Tier Components.
   Install in a directory that contains only ASCII characters in the path name.
   Some Web servers do not support non-ASCII characters in directory names.
   When you are prompted to select components, clear IBM Cognos Business Intelligence Supplementary Languages Documentation, expand Additional Language Fonts, and then select the font.
   These fonts are copied to the `c10_location/bin/fonts` directory. This font location is defined in the Physical fonts location property value in IBM Cognos Configuration under Environment. If you move the fonts to another location, ensure that the new location is added to the Physical fonts location property value.
   Fonts used to display data in a report are selected using a matching process between the fonts requested when the report is designed and the fonts that are available when the report is rendered. For PDF output and charts, this process occurs on the server where all fonts on the server that generates the report can be used.
5. Choose the option you want in the Finish page of the installation wizard.

Results

After you install the additional fonts, you must configure support for them. For more information, see “Configure Support for Japanese Yen and Korean Won Characters.”

Configure Support for Japanese Yen and Korean Won Characters

For Japanese and Korean currency characters to display correctly, you must define the additional fonts in the global style sheet.
Before you begin

Before you configure these fonts, you must install them from the IBM Cognos BI Supplementary Language Documentation disk.

Procedure

   The GlobalReportStyles.css style sheet is located in the c10_location\bin directory.
2. Enable one of the following sections and modify it as shown below:
   • /* For Japanese: */
     .pg,
     .pp
     {
       font-family: 'MS UI Gothic', 'Andale WT J', Tahoma, arial, geneva, helvetica, sans-serif;
     }
   • /* For Korean: */
     .pg,
     .pp
     {
       font-family: Gulim, 'Andale WT K', Tahoma, arial, geneva, helvetica, sans-serif;
     }
   The PDF generator uses the first available font on the server and includes all the characters in the string to be displayed. If you prefer to use other fonts on your server, you can insert them into the list.
4. Restart the IBM Cognos BI server.

Results

Any changes that you make to the style sheet are overwritten if you upgrade IBM Cognos BI. You must repeat this procedure following an upgrade.

Install Quick Tours Locally

The quick tours are accessible from the IBM Cognos Web site for users with Internet access. For users without Internet access, or if you prefer to install the quick tours locally, you can download them from the IBM Cognos Customer Center and install them in the same location as the Gateway component. All language versions of the quick tours are available from the Web site and from the IBM Cognos Customer Center.

Procedure

2. Search for the appropriate version of IBM Cognos Business Intelligence and then find the link for IBM Cognos Business Intelligence Quick Tours.
3. Follow the instructions to download the package and extract the contents.
4. Run the issetup file and follow the instructions in the installation wizard to install the language versions of the quick tours that you need on the IBM Cognos gateway computer in the c10-location directory.

For installations of multiple IBM Cognos BI products that use multiple IBM Cognos gateways, you can install the quick tours on every gateway or on a single gateway.

5. If you install the quick tours on a single gateway in an installation with multiple IBM Cognos gateways, edit the c10_location\webcontent\documentation\language_code\tours\crtours.html file on the other gateways and change the JavaScript string variable sToursLocation to the URL of the gateway that contains the quick tours.

---

**IBM Cognos BI for Microsoft Office**

IBM Cognos BI for Microsoft Office is available for deployment with all IBM Cognos BI products, except for IBM Cognos BI Metrics Manager.

To configure and deploy IBM Cognos BI for Microsoft Office, you can make the client files available for users to install or you can install the client on the user computers, depending on your environment.

IBM Cognos BI for Microsoft Office is available as a 32-bit installation only. It must be installed on a 32-bit Windows computer.

To deploy IBM Cognos BI for Microsoft Office with PowerPlay, you can configure gateway mappings so that IBM Cognos BI for Microsoft Office users can access PowerPlay reports that reside on a PowerPlay server. You can also configure the size of report that can be imported from IBM Cognos BI to IBM Cognos BI for Microsoft Office. For more information about gateway mappings and report size limits, see the Administration and Security Guide.

Use the following checklist to configure IBM Cognos BI for Microsoft Office:

- Copy IBM Cognos BI for Microsoft Office files to the LAN for deployment if required.
- Enable secure sockets layer support if required.
- Enable anonymous access if required.
- Deploy IBM Cognos BI for Microsoft Office to client environments

**Copy IBM Cognos BI for Microsoft Office Client Files to a Central LAN Location**

Before users can deploy IBM Cognos BI for Microsoft Office to their computer, they need access to the installation files. You can give users the installation disk that is included with IBM Cognos BI PowerPlay or you can copy the files from the disk to a central location on the LAN or a Web site.

**Procedure**

From the IBM Cognos BI for Microsoft Office disk or a directory where the installation files were downloaded and extracted, copy the following components to the LAN location:

- the KB908002 folder
- the setup.exe file
- the CognosOfficeSetup.msi file
Results

Users can then run the setup.exe file from the LAN location to deploy IBM Cognos BI for Microsoft Office.

Enable SSL Support for the HTTPS Interface to PowerPlay

If your environment includes IBM Cognos Series 7 PowerPlay Enterprise Server and you are using the HTTPS interface to access PowerPlay, you must enable Secure Sockets Layer (SSL) support. To enable SSL support for the PowerPlay gateway and the IBM Cognos BI dispatcher, you must define a password for the IBM Cognos BI key store and then create and store the Web server Certificate Authority (CA) certificate in the IBM Cognos BI key store.

Enabling SSL support for PowerPlay

Use these steps to enable SSL support for IBM Cognos Series 7 PowerPlay Enterprise Server.

Procedure

1. Save the Web server CA certificate in the c10_location\bin directory and name it ca.cer.
2. If you did not define a password for the IBM Cognos BI key store, do it now in IBM Cognos Configuration:
   - In the Explorer window, click Cryptography > Cognos.
   - In the Properties window, under Certificate Authority settings, set the Certificate Authority key store password.
   - From the File menu, click Save.
   - From the Actions menu, click Restart.
3. From the command line, go to the c10_location\bin directory.
4. Set the JAVA_HOME environment variable to the Java Runtime Environment location used by the application server running IBM Cognos BI.
   The following examples assume that the default Tomcat application server is being used:
   - For Microsoft Windows, type
     set JAVA_HOME=c10_location\bin\jre\version
   - For UNIX operating system Cshell, type
     setenv JAVA_HOME c10_location/bin/jre/version
5. From the same command line, run the certificate tool:
   - For Microsoft Windows, type
     ThirdPartyCertificateTool.bat -T -i -r ca.cer -k ..\configuration\signkeypair\jCAKeystore -p keystore password
   - For UNIX, type
     ThirdPartyCertificateTool.sh -T -i -r ca.cer -k ../configuration/signkeypair/jCAKeystore-p

Results

You can now install the CA certificate on all client computers, or make the CA certificate available for users to install with the IBM Cognos BI for Microsoft Office client.
Installing the CA certificate on the client workstation
Use these steps if you choose the option to install the CA certificate on the client workstations.

Procedure
1. Retrieve the CA certificate from the issuing authority.
   The file has a .cer extension. This is not the same certificate as the one used by the Web server. It is the certificate for the issuing authority itself.
2. Double-click the .cer file, click Install Certificate, and then click Next.
3. Click Place all certificates in the following store.
4. Click Browse, click Trusted Root Certification Authorities, and then click Next.
5. Click Finish.

Making the CA Certificate Accessible to Users
Use this step if you choose the option to make the CA certificate accessible to users.

Procedure
Copy the CA certificate to a central location on the LAN.

Enable Anonymous Access for PowerPlay
When using single signon with Microsoft Internet Information Services (IIS), anonymous access must be enabled for portal users to access IBM Cognos BI for Microsoft Office documents that are based on PowerPlay reports.

If necessary, a second PowerPlay gateway can be used to provide anonymous access for IBM Cognos BI for Microsoft Office. For more information, see the topic about specifying gateway mappings in the Administration and Security Guide.

Procedure
1. On each computer where Content Manager is installed, start IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click Cognos.
3. In the Properties window, click the box next to the Allow anonymous access property and then click True.
4. From the File menu, click Save.

Deploying IBM Cognos for Microsoft Office Client
IBM Cognos for Microsoft Office is available for installation with IBM Cognos BI components. After IBM Cognos BI is installed and configured, you can install IBM Cognos for Microsoft Office on client workstations.

IBM Cognos for Microsoft Office Client is available as a 32-bit installation only. It must be installed on a 32-bit Windows computer.

Deploying IBM Cognos for Microsoft Office to Client Computers
IBM Cognos for Microsoft Office uses Microsoft .NET Framework to allow users to interact with server-based components. Microsoft .NET Framework and the
required updates are downloaded and installed by the setup file when you install IBM Cognos for Microsoft Office. The setup file must be run on all user computers.

For a list of supported versions of Microsoft .NET Framework, see the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

Use the following checklist to guide you through the deployment process:

- Install .NET Framework and IBM Cognos for Microsoft Office.
  For more information about installing IBM Cognos for Microsoft Office, see the IBM Cognos for Microsoft Office Installation Guide.
- Set the macro security level for Microsoft office XP, if required.
- Install the CA certificate for secure sockets layer support, if required.

**Set Macro Security Level for Microsoft Office XP**

For Microsoft Office XP applications to run IBM Cognos for Microsoft Office, you must set your macro security level to an appropriate level. You must set this for Microsoft Office Excel, Microsoft Office Word, and Microsoft Office PowerPoint.

**Procedure**

1. Open your Microsoft Office XP application.
2. From the **Tools** menu, click **Macros**, and then click **Security**.
3. Choose whether to change the security level or the trusted publishers.
   - On the **Security Level** tab, click **Medium** or **Low**, and then click **OK**.
   - On the **Trusted Publishers** tab, select **Trust all installed add-ins or templates**, and then click **OK**.

**Install the CA Certificate for the HTTPS Interface to Series 7 PowerPlay**

If your environment includes IBM Cognos Series 7 PowerPlay Enterprise Server and you are using the HTTPS (https://) interface to access Series 7 PowerPlay, you must install a certificate issued by a certificate authority (CA). The CA certificate is required for secure sockets layer (SSL) support.

**Procedure**

1. Retrieve the CA certificate from your administrator.
   - The file has a .cer extension.
2. Double-click the .cer file, click **Install Certificate**, and then click **Next**.
3. Click **Place all certificates in the following store**.
4. Click **Browse**, click **Trusted Root Certification Authorities**, and then click **Next**.
5. Click **Finish**.
Chapter 11. Using Collaboration with IBM Cognos Business Insight

Collaboration capabilities in IBM Cognos Business Insight provide a bridge between using IBM Cognos Business Intelligence to discover a business problem and acting to resolve it.

Activities is a web-based collaboration tool for collecting, organizing, sharing, and reusing work related to a goal. Members of an activity interact in an online location in which they create, collect, and share a set of ideas and resources to support a goal. An activity is a way for you to organize your work and collaborate with others in a shared web space. Because it is easy to invite new members, you can quickly pull together the right people and resources you need to get the job done. You can post messages, share files and links to web sites, and create and assign to-do items. Activities are part of IBM Connections and are integrated with IBM Cognos Business Insight.

To use activities with Business Insight, you must install IBM Connections and configure it to work with IBM Cognos BI. IBM Connections is social networking software designed for the workplace.

For more information about IBM Connections version 2.5 requirements, see the following:
- the IBM Connections Information Center, at [http://publib.boulder.ibm.com/infocenter/liscnct/v2r0/index.jsp](http://publib.boulder.ibm.com/infocenter/liscnct/v2r0/index.jsp)

For more information about IBM Connections version 3.0 requirements, see the following:

Installation considerations

Installing IBM Cognos BI and IBM Connections requires some deployment choices.

For example, IBM Connections version 2.5 requires you to have IBM WebSphere Application Server version 6.1.0.23 running and to have security enabled on your IBM WebSphere Application Server profile. To allow single signon between IBM Cognos BI and IBM Connections, you will also have to deploy IBM Cognos BI to IBM WebSphere Application Server, rather than using the Apache Tomcat servlet container that is provided with IBM Cognos BI.

IBM Connections and IBM Cognos BI must be installed on computers in the same domain.
When you install IBM Connections, you must, at a minimum, install Activities and Home Page to allow collaboration with IBM Cognos BI. For more information about IBM Connections features, see [http://www.ibm.com/software/lotus/products/connections/features.html](http://www.ibm.com/software/lotus/products/connections/features.html).

IBM Connections has different database support than IBM Cognos BI. IBM Connections requires a database for each of the features you install, such as Activities, Home Page, etc. You do not have to use the same database server for IBM Connections as for your IBM Cognos BI server.

To install IBM Connections, you must install IBM WebSphere Application Server, install updates for IBM WebSphere Application Server, and create the required IBM Connections databases. You must also secure the IBM WebSphere Application Server profile you will be using for IBM Connections against your authentication provider using an IBM WebSphere Application Server federated repository configuration.

If you choose to install the Profiles feature of IBM Connections, you must use the IBM Tivoli Directory Integrator to create user profiles in order for your users to be able to log in to IBM Connections. The directory integrator will create profiles in IBM Connections for users from your LDAP. Users can then log in and create activities from IBM Cognos Business Insight, as well as use any of the other IBM Connections features you have installed.

To use single signon between IBM Cognos BI and IBM Connections, you must deploy IBM Cognos BI to IBM WebSphere Application Server. You must use a separate IBM WebSphere Application Server instance or a separate profile on the same instance.

### Installation process

Use the following checklist to guide you through the install process for the software needed to deploy IBM Cognos BI with IBM Connections.

- • Install a database server or prepare an existing database server
  - Ensure you use a supported database for IBM Connections and for IBM Cognos BI.
  - To install IBM Connections, and to populate user profiles, you require a JDBC driver for your database. You must have the required JDBC driver before you install the product. For more information about the database drivers, see the installation instructions in the IBM Connections Information Center.
  - The Database Wizard for IBM Connections allows you to create the IBM Connections databases on IBM DB2, Microsoft SQL Server, or an Oracle database. For more information, see the following topic in the IBM Connections Information Center: [http://publib.boulder.ibm.com/infocenter/ltsnnet/v2r0/index.jsp?topic=/com.ibm.connections.25.help/_install_databases_using_wizard.html](http://publib.boulder.ibm.com/infocenter/ltsnnet/v2r0/index.jsp?topic=/com.ibm.connections.25.help/_install_databases_using_wizard.html).
  - At a minimum, you must create databases for Activities and Home page to use IBM Cognos BI collaboration with IBM Connections.

- • Install IBM WebSphere Application Server
  - Ensure you use a supported version of IBM WebSphere Application Server for IBM Connections. For example, you must update your IBM WebSphere Application Server 6.1 installation with Fix Pack 23.
Search for the Fix Pack by entering the appropriate search criteria: for example, in **Product Group**, select **WebSphere**. In **Product**, select **WebSphere Application Server**. In **Installed Version** select 6.1.0. In the **Text** box, enter 23. Select the appropriate Fix Pack for your installation. For example, for Microsoft Windows, the Fix Pack would be 6.1.0-WS-WAS-WinX32-FP0000023.


When you install IBM WebSphere Application Server, you can clear the **Enable administrative security** check box. Security is required for IBM Connections, but you can apply it after you have installed the product.

- Create an additional IBM WebSphere Application Server profile, if required
  
  If you are installing IBM Cognos BI and IBM Connections to the same IBM WebSphere Application Server, you must create an additional profile for one of the applications. Do not use the same profile for both applications.

  To set up single signon, you must set a shared key between the profile you are using for IBM Connections and the profile you are using for IBM Cognos BI. For more information, see the IBM WebSphere Information Center page: [http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp](http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp).

  You do not have to install IBM Cognos BI to IBM WebSphere Application Server to use collaboration with IBM Connections. Installing to IBM WebSphere Application Server does, however, provide the option for single signon between the applications. Single signon allows the applications to share your log in information such that users only have to log in once to use either application. If you do not require single signon, you can deploy IBM Cognos BI using Apache Tomcat or a supported application server.

- Secure your IBM WebSphere Application Server profile(s)
  
  You must enable security for the IBM WebSphere Application Server profile into which you will be installing IBM Connections.


  If you are installing IBM Cognos BI to IBM WebSphere Application Server, and you want single signon, you should secure the profile you are using for IBM Cognos BI, as well as IBM Cognos BI, to the same authentication source as your profile for IBM Connections.

- Install IBM Connections
  
  You must have created and secured an IBM WebSphere Application Server profile before you install IBM Connections. You must also have created the required IBM Connections databases.

  During the installation, you are prompted for a database driver to connect to the IBM Connections databases. For more information about the database drivers, see the following topic in the IBM Connections Information Center:
Update IBM Connections for IBM Cognos BI

For more information, see “Mandatory Updates Required for IBM Connections Installation” on page 305.

After you have installed the Fix Pack and the Interim Fix, you must modify a configuration file to allow IBM Cognos BI to communicate with IBM Connections. You do this by modifying two IBM Connections configuration files. For more information, see “Allow access to IBM Connections from IBM Cognos BI” on page 306.

To be able to successfully create Activities from IBM Cognos Business Insight, you must add your domain to your IBM WebSphere Application Server profile security configuration. For more information, see “Enable IBM Connections to accept activities created by Business Insight” on page 307.

Install IBM Cognos BI, and then build the application for IBM WebSphere Application Server, if required

If you are installing IBM Cognos BI on IBM WebSphere Application Server and you want to use single signon between IBM Connections and IBM Cognos BI, you must enable access for a BI User role before you build the application file to install on IBM WebSphere Application Server. For more information, see “Add User Role to Enable Single Signon Between IBM WebSphere Profiles” on page 446.

If you are installing IBM Cognos BI on IBM WebSphere Application Server, you must build the application in IBM Cognos Configuration, and then install the application in IBM WebSphere Application Server. For more information, see “Configure Application Server Properties and Deploy IBM Cognos Components” on page 453.

Configure IBM Cognos BI

When you configure IBM Cognos BI, you must add the server and port information to the Cognos Application Firewall in order to allow access from IBM Cognos BI to IBM Connections. For more information, see “IBM Cognos Application Firewall” on page 357.

When you configure your IBM Cognos BI, you must ensure that you use the full domain name of the computer where your services are running and for your gateway. If you do not include the domain, then IBM Connections will not allow access as it cannot verify the domain from which the access is coming. For more information, see “Port and URI Settings” on page 351.

You can set the domain values when you configure IBM Cognos BI. For more information, see “Configure IBM Cognos Components to Run Within the Application Server” on page 447.

After you have installed and configured your IBM Connections and IBM Cognos BI software, you must set the Collaboration discovery URI in IBM Cognos Administration. The Collaboration discovery URI provides access to creating activities from IBM Cognos Business Insight and adds links to IBM Connections from menus in IBM Cognos Connection. For more information, see “Configuring the Collaboration Discovery URI” on page 406.

Create IBM Connections profiles using the population wizard, if required

If you have installed the IBM Connections Profiles feature, you must create user profiles in IBM Connections using the Tivoli Directory Integrator before users can log in. The directory integrator creates user profiles from your LDAP. For more information about setting up Tivoli Directory Integrator and adding user profiles, see the IBM Connections [http://publib.boulder.ibm.com/infocenter/ltscnnet/v2r0/index.jsp?topic=com.ibm.connections.25.help/t_install_standalone.html](http://publib.boulder.ibm.com/infocenter/ltscnnet/v2r0/index.jsp?topic=com.ibm.connections.25.help/t_install_standalone.html)
Mandatory Updates Required for IBM Connections Installation

To use IBM Connections with IBM Cognos Business Intelligence, you must update your IBM Connections installation by applying required Fix Packs or Interim Fixes.

For the most up-to-date information about required Fix Packs and Interim Fixes, see the Information Center for this product at [http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp](http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp).

You must apply the following to your IBM Lotus® Connections 2.5 installation:

- **Fix Pack version 2.5.0.2**
  Search for the Fix Pack by entering the appropriate search criteria: for example, in Product Group, select Lotus. In Product, select Lotus Connections. In Installed Version select 2.5.0.0. In the Individual fix IDs box, enter 2.5.0.2-LC-Multi-FP000002. The downloaded Fix Pack is named LC2502_FixPack.jar.
  - The following Interim Fixes must be applied:
    - LO52700
    - LO52560
    - LO51723
    - LO53215
    - LO51605
    For IBM Cognos BI integration, you must then install Interim Fix LO52425.
    Search for the Interim Fix by entering the appropriate search criteria: for example, in Product Group, select Lotus. In Product, select Lotus Connections. In Installed Version select 2.5.0.0. For example, in the APAR or SPR box, enter LO52700.

You must apply the following to your IBM Connections 3.0 installation:

- **Interim Fix, or iFix, LO56863 and LO57924**
  Search for the iFix by entering the appropriate search criteria: for example, in Product Group, select Lotus. In Product, select Lotus Connections. In Installed Version select 3.0.0.0. In the APAR or SPR box, enter LO56863.
  The iFix appears in the search results as interim fix: 3.0.0.0-LC-Multi-ACTIVITIES-IFLO56863, and is downloaded as LO56863.jar.
Allow access to IBM Connections from IBM Cognos BI

To enable collaboration between IBM Cognos BI and IBM Connections, you must update a file in your IBM Connections installation and then modify a file to add the domain for the server where IBM Cognos BI is running.

Adding the domain allows access to IBM Connections from computers in that domain. If you do not add the domain, IBM Cognos BI will not be able to create activities. For example, if your IBM Cognos BI server is running on `mycomputer.mycompany.com`, then you must add `mycompany.com` to the list of allowable domains in IBM Connections.

The file to be copied is named `oa-config.xsd` and it is included with the required Interim Fix. The file to be modified is named `oa-config.xml`. `oa-config.xml` allows access from IBM Cognos BI. The files are located in your IBM WebSphere Application Server directory. Ensure that you back up the files before you modify them.

You must have installed the appropriate Fix Pack and Interim Fix before you modify these files.

If you are using a network deployment of IBM Connections, you must modify the files in the `LotusConnections-config` directory on the Deployment Manager computer, then synchronize these changes with the nodes before restarting the profile.

**Procedure**

1. Go to the `WebSphere_location\profiles\lotus_connections_profile\InstalledApps\computer_nameNode###Cell\LotusConnections-config` directory, and make a copy of the file named `oa-config.xsd`.
2. From the IBM Cognos BI product CDs or the location where you downloaded the Interim Fix file, copy the file named `oa-config.xsd` to the `WebSphere_location\profiles\ibm_connections_profile\InstalledApps\computer_nameNode###Cell\LotusConnections-config` directory.
3. In the same directory, open the file named `oa-config.xml` in a text editor.
4. At the bottom of the file, but before the `</config>` element, add the following element:
   ```xml
   <WidgetRedirectWhitelist>
   <domain>.*\.mycompany\.com</domain>
   </WidgetRedirectWhitelist>
   ```
   where `.mycompany` and `.com` make up your domain.
5. Save and close the file.
6. Open the IBM WebSphere Application Server administration console.
7. Click the link for the Secure administration, applications, and infrastructure page.
8. In the Authentication section, click Web Security > Single sign-on (SSO).
9. In the Domain name box, enter your domain name.
   For example, enter `.mycompany.com`.
   Ensure that you include the period before the domain name. If you have different subdomains on your network, ensure that you use only the common part of the domain name.
   For example, IBM Cognos BI is installed on a computer with `.deptA.mycompany.com` as the domain, and IBM Connections is installed on a
computer with .deptB.mycompany.com, you must include only the
.mycompany.com part of the domain name.

10. Click OK, and then click Save.

11. Restart the IBM WebSphere Application Server profile where IBM Connections
is installed.

Results

IBM Cognos BI will now be able to communicate with IBM Connections and to
create activities.

Enable IBM Connections to accept activities created by
Business Insight

To allow IBM Cognos Business Insight to properly create activities in IBM
Connections, you must add your domain to a setting in your IBM WebSphere
Application Server profile where you have installed IBM Connections.

If you do not add the domain, you may see errors when you create the activity in
Business Insight.

Procedure

1. Start the IBM WebSphere Application Server administration console, by clicking
   Start > All Programs > IBM WebSphere > Application Server v6.1 > Profiles
   > profile name > Administrative Console.
   The Integrated Solutions Console appears prompting you to log in.
2. Click Security > Secure administration, applications and infrastructure.
   The Secure administration, applications, and infrastructure page appears.
3. In the Authentication section, click Web Security > Single sign-on (SSO).
4. In the Domain name box, enter the domain for your computer, for example
   enter .mycompany.com, including the period before the domain name.
   Ensure that you use the appropriate domain for your computer.
5. Click OK, and then click Save.

Enable single signon between IBM Connections and IBM
Cognos Business Intelligence

To enable single signon between IBM Connections and IBM Cognos Business
Intelligence using your Web server as the access point, you must install a Web
server plug-in that is provided with your IBM WebSphere Application Server
installation.

Procedure

1. Install the IBM Cognos Business Intelligence components.
   If you are distributing your installation, you must install the Gateway
   component on your Web server computer. If you are using a single server
   installation, install all of the components.
   You must install the Gateway component on the Web server computer so that
   the required static content is available.
2. Create a virtual directory for the Gateway named /p2pd/servlet that points to
   the c10_location/webcontent directory.
3. Run your IBM WebSphere Application Server installation, and select Web
   Server Plug-ins Installation.
4. Follow the steps in the wizard, and ensure sure you select the appropriate Web server for what you have installed.

For more information about installing the plug-in, see the following IBM WebSphere page:


5. After you install the plug-in, you must configure IBM WebSphere Application Server to know about the Web server following the information provided in the Information Center link above.

6. Go to the c10_location\webapps\p2pd\WEB-INF directory on the computer where you installed IBM Cognos BI, and open the file named ibm-web-ext.xmi file in a text editor.

7. Change all values for fileServingEnabled to false.

8. Save and close the file.

9. Go to the c10_location\war\p2pd directory, and do the following:

   • Open the file named application.xml.template in a text editor.
   • Edit the application section to include a security-role element, as shown below:

     ```xml
     <application>
         <display-name>IBM Cognos 10</display-name>
         <module>
             <web>
                 <web-uri>@p2pdwar@</web-uri>
                 <context-root>@p2pd@</context-root>
             </web>
         </module>
         <security-role id="SecurityRole_Cognos_BI_User">
             <description/>
             <role-name>BI User</role-name>
         </security-role>
     </application>
     ```

   • Save and close the file.

   After you have installed the IBM Cognos application to IBM WebSphere, you must enable the role above.

10. Go to the c10_location\webapps\p2pd\WEB-INF directory, and do the following:

    • If you have installed Content Manager on the computer, open the file named web.xml.withCM in a text editor.

    If you have not installed Content Manager, open the file named web.xml.noCM.

    • After the last servlet-mapping section, and before the closing web-apps element, add the following:

      ```xml
      <security-constraint>
        <web-resource-collection>
          <web-resource-name>Cognos Dispatcher</web-resource-name>
          <url-pattern>/servlet/dispatch/ext/*</url-pattern>
          <http-method>GET</http-method>
          <http-method>POST</http-method>
        </web-resource-collection>
        <auth-constraint>
          <role-name>BI User</role-name>
        </auth-constraint>
      </security-constraint>
      <login-config>
        <auth-method>BASIC</auth-method>
        <realm-name>Cognos Dispatcher</realm-name>
      </login-config>
      ```
11. Use IBM Cognos Configuration to create the deployment file to install to IBM WebSphere.
   Ensure that you do not include the static content when you generate the EAR file.

12. Configure IBM Cognos BI as required using IBM Cognos Configuration, including securing it using the same authentication source as you have used for IBM Connections, and save your configuration.

13. Install the IBM Cognos application on IBM WebSphere Application Server.
   For single signon, you must enable a user role after you have installed the application.
   - In the IBM WebSphere administration console, click Applications > Enterprise applications.
   - Click IBM Cognos.
   - In the Detail properties section, click Security role to user/group mapping.
   - Select the Select check box for BI User, and select the All authenticated? check box.
   - Click OK, and then click Save.

14. After you install IBM Cognos to IBM WebSphere Application Server, you must generate and propagate the Web server plug-in configuration.
    To do this, in the IBM WebSphere administration console, under Servers, click Web servers. Select the Web server, and click Generate Plug-in. Then select the Web server again, and click Propagate Plug-in.

15. If you are not using an IBM WebSphere Network Deployment, you must swap keys between your IBM WebSphere profiles.
    - In your IBM WebSphere administration console, click Security > Secure administration, applications, and infrastructure.
    - In the Authentication section, click Authentication mechanisms and expiration.
    - In the Cross-cell single sign-on section, enter a password.
    - Export the key, and then import the key to the other profile.
    - Repeat these steps for the other profile so that you import a key from profile B into profile A, and import a key from profile A into profile B.

16. If you are using the Web server plug-in for load balancing, turn off the internal load balancing done by the dispatcher. For more information, see "Use Cluster Compatible Mode for Dispatchers" in the IBM Cognos Business Intelligence Administration and Security Guide.

Results

To access the IBM Cognos BI portal, your URL will be: http://web_server_name/p2pd/servlet/dispatch/ext
IBM Cognos components run with two levels of logon: anonymous and authenticated. By default, anonymous access is enabled.

You can use both types of logon with your installation. If you choose to use authenticated logon only, you can disable anonymous access.

For authenticated logon, you must configure IBM Cognos components with an appropriate namespace for the type of authentication provider in your environment. You can configure multiple namespaces for authentication and then choose, at run time, which namespace you want to use. For more information, see the Administration and Security Guide.

If you upgraded from ReportNet and IBM Cognos detects a previously configured namespace that is no longer configured, the unconfigured namespace appears in the list of authentication providers in the Administration portal. You can configure the namespace if you still require the user account information. Otherwise, you can delete the namespace. For information about deleting the namespace, see the Administration and Security Guide.

Also, when upgrading from one version to another, you must use the same authentication namespace for both versions. Otherwise, the old secured content will not be available because the new version may not contain the same policies, users, roles, and groups.

IBM Cognos components support the following types of servers as authentication sources:
- Active Directory Server
- IBM Cognos Series 7
- Custom Authentication Provider
- LDAP
- eTrust SiteMinder
- NTLM
- RACF
- SAP

If you use more than one Content Manager, you must configure identical authentication providers in each Content Manager location. This means that the type of authentication provider you select and the way you configure it must be identical in all locations for all platforms. The configuration must contain information that is accessible by all Content Managers.

When IBM Cognos is installed in a single Linux-based computer, or when Content Manager is installed on a Linux-based computer, IBM Cognos can be configured to use only LDAP V3-compliant directory servers and custom providers as authentication sources.
Some authentication providers require libraries external to the IBM Cognos environment to be available. If these libraries are not available on Linux, the authentication provider cannot be initialized.

If you want to configure one of the following as your authentication source, you must install Content Manager on a non-Linux computer:

- IBM Cognos Series 7 namespace
- Active Directory Server
- NTLM
- eTrust SiteMinder
- SAP BW

If you enable security, you must configure security settings immediately after you complete the installation and configuration process. For more information, see the Administration and Security Guide.

**Important:** Do not disable security after you enable it. If you delete a namespace, the user preferences, My Folders, and My Pages entries are permanently lost. Existing permission settings will refer to users, groups, or roles that no longer exist. While this does not affect how the permissions work, a user administering the permission settings may see "unknown" entries. Because these entries refer to users, groups, and roles which no longer exist, you can safely delete them.

After you configure an authentication provider for IBM Cognos components, you can enable single signon between your authentication provider environment and IBM Cognos components. This means that a user logs on once and can then switch to another application without being asked to log on again.

Users can select namespaces when they log in to the IBM Cognos portal. You can hide Custom Java namespaces and eTrust SiteMinder namespaces from users. For more information, see “Hide the Namespace from Users During Login” on page 325 and “Hide the Namespace from Users During Login” on page 342.

To use an authentication provider and to require users to authenticate, do the following:

- **Disable anonymous access** if required.
- Configure IBM Cognos components to use an authentication provider.

---

**Disable Anonymous Access**

If you want to use authenticated logon only, you can use IBM Cognos Configuration to disable anonymous access.

By default, IBM Cognos components do not require user authentication. Users can log on anonymously.

**Procedure**

1. In each location where Content Manager is installed, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security > Authentication**, click **Cognos**.
   The IBM Cognos resource represents the Cognos namespace. The Cognos namespace stores information about IBM Cognos groups, such as the
Anonymous User, contacts, and distribution lists, and refers to objects in other security namespaces. For more information, see the Administration and Security Guide.

3. In the Properties window, click the box next to the Allow anonymous access property and then select False.

4. From the File menu, click Save.

Results

Now, you must configure a namespace so that users are required to provide logon credentials when they access IBM Cognos resources.

Restrict User Access to the Cognos Namespace

You can restrict access to users belonging to any group or role defined in the Cognos built-in namespace.

By default, all users belong to several built-in groups or roles. To restrict access, you must do the following:

- Enable the property to restrict access, using IBM Cognos Configuration.
- Remove the Everyone group from the built-in roles and groups, using IBM Cognos Administration.
- Ensure that authorized users belong to at least one role or group, using IBM Cognos Administration.

Procedure

1. In each Content Manager location, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Authentication.
3. In the Properties window, change the value of Restrict access to members of the built-in namespace to True.
4. From the File menu, click Save.

Results

You must now use the portal to remove the Everyone group from the built-in roles and groups, and then ensure that authorized users belong to at least one built-in role or group.

For information about adding or removing members of a group or role, see the Administration and Security Guide.

Configuring IBM Cognos Components to Use Active Directory Server

If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

If you install Content Manager on a UNIX-based computer, you must instead use an LDAP namespace to configure Active Directory as your authentication source. If you install Content Manager on a mix of Windows and UNIX computers, you must use an LDAP namespace to configure Active Directory for all Content Managers. When you use an LDAP namespace to authenticate against Active Directory Server,
you are limited to LDAP features only. You do not have access to Active Directory features such as advanced properties for domains and single signon using Kerberos delegation.

If you install Content Manager on a Linux-based computer, the same restrictions apply as for UNIX. You must use an LDAP namespace to configure Active Directory as your authentication source.

If you want to use Microsoft SQL Server or Microsoft Analysis Server as a data source and use single signon for authentication, you must use Active Directory as your authentication source.

You cannot connect to the Active Directory Global Catalog, which is a caching server for Active Directory Server. If the connection uses port 3268, you must change it. By default, Active Directory Server uses port 389.

**Procedure**

1. Configure IBM Cognos components to use an Active Directory Server namespace
2. Enable secure communication to the Active Directory Server if required
3. Enable single signon between Active Directory and IBM Cognos components

**Related concepts**

“Enabling Single Signon Between Active Directory Server and IBM Cognos Components” on page 318

By default, the Active Directory provider uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

**Related tasks**

“Include or Exclude Domains Using Advanced Properties” on page 317

When you configure an authentication namespace for IBM Cognos, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

“Configure an LDAP Namespace for Active Directory Server” on page 328

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

**Configure an Active Directory Namespace**

You can use Active Directory Server as your authentication provider.

You also have the option of making custom user properties from the Active Directory Server available to IBM Cognos components.

**Before you begin**

For IBM Cognos to work properly with Active Directory Server, ensure that the Authenticated users group has Read privileges for the Active Directory folder where users are stored.
If you are configuring an Active Directory namespace to support single sign-on with a Microsoft SQL Server or Microsoft Analysis Server data source, ensure the following configuration:

- The IBM Cognos gateway is installed on an IIS Web server that is configured for Integrated Authentication on Microsoft Windows operating system.
- The gateway is assigned to the local intranet Web site in your Web browser.
- Content Manager is installed on a Windows 2000 or Windows 2003 server.
- Content Manager, Application Tier Components, IIS Web server, and the data source server (Microsoft SQL Server or Microsoft Analysis Server) belong to the Active Directory domain.
- The data source connection for Microsoft SQL Server or Microsoft Analysis Server is configured for External Namespace and that namespace must be the Active Directory namespace.

For more information about data sources, see the Administration and Security Guide.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. Specify the values for the Host and port property.
   To support Active Directory Server failover, you can specify the domain name instead of a specific domain controller. For example, use mydomain.com:389 instead of dc1.mydomain.com:389.
8. If you want to search for details when authentication fails, specify the user ID and password for the Binding credentials property.
   Use the credentials of an Active Directory Server user who has search and read privileges for that server.
9. From the File menu, click Save.
10. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Make Custom User Properties for Active Directory Available to IBM Cognos Components**

You can use arbitrary user attributes from your Active Directory Server in IBM Cognos components. To configure this, you must add these attributes as custom properties for the Active Directory namespace.
The custom properties are available as session parameters through Framework Manager. For more information about session parameters, see the Framework Manager User Guide.

You can also use the custom properties inside command blocks to configure Oracle sessions and connections. You can use the command blocks can be used with Oracle light-weight connections and virtual private databases. For more information, see the Administration and Security Guide.

Procedure
1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. In the Properties window, click in the Value column for Custom properties and click the edit button.
4. In the Value - Custom properties window, click Add.
5. Click the Name column and type the name you want IBM Cognos components to use for the session parameter.
6. Click the Value column and type the name of the account parameter in your Active Directory Server.
7. Repeat steps 4 to 6 for each custom parameter.
8. Click OK.
9. From the File menu, click Save.

Enabling Secure Communication to the Active Directory Server

If you are using an SSL connection to the Active Directory Server, you must copy the certificate from the Active Directory Server to the Content Manager location.

Procedure
1. In every Content Manager location, use your Web browser to connect to the Active Directory Server and copy the CA root certificate to the Content Manager location.
2. Add the CA root certificate to the certificate store of the account that you are using for the current IBM Cognos session:
   • If you are running the IBM Cognos session under a user account, use the same Web browser as in step 1 to import the CA root certificate to the certificate store for your user account.
     For information, see the documentation for your Web browser.
   • If you are running the IBM Cognos session under the local account, use Microsoft Management Console (MMC) to import the CA root certificate to the certificate store for the local computer.
     For information, see the documentation for MMC.
3. In IBM Cognos Configuration, restart the service:
   • In the Explorer window, click IBM Cognos services, IBM Cognos.
   • From the Actions menu, click Restart.
Include or Exclude Domains Using Advanced Properties

When you configure an authentication namespace for IBM Cognos, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

If you set a parameter named chaseReferrals to true, users in the original authenticated domain and all child domains of the domain tree can log in to IBM Cognos. Users above the original authenticated domain or in a different domain tree cannot log in.

If you set a parameter named MultiDomainTrees to true, users in all domain trees in the forest can log in to IBM Cognos.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. In the Properties window, specify the Host and port property:
   - For users in one domain, specify the host and port of a domain controller for the single domain.
   - For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
   - For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.
4. Click in the Value column for Advanced properties and click the edit button.
5. In the Value - Advanced properties window, click Add.
6. Specify two new properties, chaseReferrals and MultiDomainTrees, with the values from the following table:

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click OK.
8. From the File menu, click Save.
Related tasks

“Configuring IBM Cognos Components to Use Active Directory Server” on page 313

If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

**Authenticating Domain Trees**

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. In the Properties window, specify the Host and port property:
   - For users in one domain, specify the host and port of a domain controller for the single domain.
   - For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
   - For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.
4. Click in the Value column for Advanced properties and click the edit button.
5. In the Value - Advanced properties window, click Add.
6. Specify two new properties, chaseReferrals and MultiDomainTrees, with the values from the following table:

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click OK.
8. From the File menu, click Save.

**Enabling Single Signon Between Active Directory Server and IBM Cognos Components**

By default, the Active Directory provider uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the Active Directory namespace.

If you do not want Kerberos delegation, you can configure the provider to access the environment variable REMOTE_USER to achieve single signon.
If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

**Single Signon Using Kerberos Delegation**

You can enable single signon between the Active Directory provider and the IBM Cognos components using Kerberos delegation.

By default, Active Directory uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the Active Directory namespace.

**Procedure**

1. Set up Windows integrated authentication on the IIS Web server.
2. Install Content Manager in a location that is part of the domain, for the active and standby Content Managers.
3. Set up the computers, or the user account under which Content Manager runs, to be trusted for delegation.
   
   When setting up the computers using the Active Directory user tool, do not select the **Account** attribute, which is sensitive and cannot be delegated.

**Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER**

If you do not want Kerberos delegation, you can configure the provider to access the environment variable REMOTE_USER to achieve single signon.

You must set the advanced property `singleSignOnOption` to the value `IdentityMapping`. You must also specify bind credentials for the Active Directory namespace.

Microsoft IIS sets REMOTE_USER by default when you enable Windows integrated authentication. If Kerberos authentication is bypassed, single signon to Microsoft OLAP (MSAS) data sources will not be possible.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the **Explorer** window, under **Security > Authentication**, click the Active Directory namespace.
3. Click in the **Value** column for **Advanced properties** and then click the edit button.
4. In the **Value - Advanced properties** dialog box, click **Add**.
5. In the **Name** column, type `singleSignOnOption`.
6. In the **Value** column, type `IdentityMapping`.
7. Click **OK**.
8. Click in the Value column for Binding credentials, and then click the edit button.
9. In the Value - Binding credentials dialog box, specify a user ID and password and then click OK.

Results

The Active Directory provider now uses REMOTE_USER for single signon.

Tip: To switch back to Kerberos delegation, edit Advanced properties and, in the Value column, type KerberosAuthentication.

Configuring IBM Cognos to Use IBM Cognos Series 7 Namespace

You can configure IBM Cognos components to use an IBM Cognos Series 7 namespace as the authentication provider. Users will be authenticated based on the authentication and signon configuration of the IBM Cognos Series 7 namespace.

An IBM Cognos Series 7 namespace is required if you want to use IBM Cognos Series 7 PowerCubes and Transformer models in IBM Cognos Business Intelligence. You must configure the namespace before you load the Transformer models.

Note: You cannot use an IBM Cognos Series 7 Local Authentication Export (LAE) file for authentication with IBM Cognos components.

You can configure IBM Cognos components to use multiple IBM Cognos Series 7 authentication providers. All IBM Cognos Series 7 namespaces must use the same primary IBM Cognos Series 7 Ticket Server. Otherwise, you may receive errors or be prompted for authentication more than once. To maintain performance, also ensure that the ticket server is running.

If you change the configuration information stored in the directory server used for IBM Cognos Series 7, you must restart the IBM Cognos service before the changes take effect in the IBM Cognos installation.

A user must be in at least one Access Manager user class to log on to IBM Cognos components.

Procedure

1. Configure a Series 7 namespace
2. Enable secure communication to the directory server used by the IBM Cognos Series 7 namespace if required
3. Enable single signon between IBM Cognos Series 7 and IBM Cognos

Configure an IBM Cognos Series 7 Namespace

You can configure IBM Cognos to use one or more IBM Cognos Series 7 namespaces for authentication.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the **Type** list, click the appropriate namespace and then click **OK**.
   The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.

5. In the **Properties** window, for the **Namespace ID** property, specify a unique identifier for the namespace.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
   If your IBM Cognos Series 7 namespace version is 16.0, ensure that the **Data encoding** property is set to **UTF-8**. In addition, the locations where Content Manager is installed must use the same locale as the data in the IBM Cognos Series 7 namespace.
   The host value can be a server name or an IP address. If you are publishing from PowerPlay Enterprise Server to IBM Cognos BI, you must use the same value format used in IBM Cognos Series 7 Configuration Manager for the location of the directory server. For example, if the server name is used in IBM Cognos Series 7 Configuration Manager, you must also use the server name in IBM Cognos Configuration for IBM Cognos BI.

7. If your namespace environment includes version 15.2 of the IBM Cognos Series 7 namespace, you must disable the **Series7NamespacesAreUnicode** setting:
   - In the **Properties** window, in the **Advanced Properties** value, click the edit button.
   - In the **Value - Advanced properties** window, click **Add**.
   - In the **Name** box, type **Series7NamespacesAreUnicode**.
   - In the **Value** box, type **False**, and then click **OK**.

8. In the **Properties** window, under **Cookie settings**, ensure that the **Path**, **Domain**, and **Secure flag enabled** properties match the settings configured for IBM Cognos Series 7.

9. From the **File** menu, click **Save**.

10. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

### Enabling Secure Communication to the Directory Server Used by the IBM Cognos Series 7 Namespace

If you are using an SSL connection to the Directory Server used by the IBM Cognos Series 7 namespace, you must copy the certificate from the Directory Server to each Content Manager location.

For more information, see the IBM Cognos Access Manager *Administrator Guide* and the documentation for your Directory Server.

### Enabling Single Signon Between IBM Cognos Series 7 and IBM Cognos

If your IBM Cognos Series 7 namespace has been configured for integration with your external authentication mechanisms for single signon, the IBM Cognos Series 7 provider will automatically use this configuration.

By configuring single signon, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the IBM Cognos Series 7 namespace.
Procedure

1. Ensure that you configured IBM Cognos components to use an IBM Cognos Series 7 namespace as an authentication provider.
2. For IBM Cognos Series 7, start Configuration Manager.
3. Click Open the current configuration.
5. In the Properties window, ensure that the Path, Domain, and Secure Flag Enabled properties match the settings configured for IBM Cognos.
6. Save and close Configuration Manager.
7. If the IBM Cognos Series 7 namespace uses the Trusted Signon plug-in for single signon, you must now define the SaferAPIGetTrustedSignonWithEnv function.

Results

You can now add IBM Cognos Upfront Series 7 NewsBoxes to your IBM Cognos Connection portal pages.

IBM Cognos Series 7 Namespaces and the IBM Cognos Series 7 Trusted Signon Plug-in

If the IBM Cognos Series 7 namespace uses the Trusted Signon plug-in for single signon, you must define the SaferAPIGetTrustedSignonWithEnv function in your plug-in. Then you must recompile and redeploy the library for single signon to be achieved between IBM Cognos components and your authentication mechanism.

The SaferAPIGetTrustedSignonWithEnv function is an updated version of the SaferAPIGetTrustedSignon function. This update is required because IBM Cognos logon is not performed at the Web server as is the case for IBM Cognos Series 7 applications. Therefore, it is not possible for the plug-in to perform a getenv() API call to retrieve Web server environment variables. The plug-in can request that specific environment variables be removed from the Web server using the SaferAPIGetTrustedSignonWithEnv function.

If you are running both IBM Cognos Series 7 and IBM Cognos products using the same plug-in, both the SaferAPIGetTrustedSignonWithEnv and SaferAPIGetTrustedSignon functions are required. For information about the SaferAPIGetTrustedSignon function, see the IBM Cognos Series 7 documentation.

SaferAPIGetTrustedSignonWithEnv Function

For users to be successfully authenticated by Access Manager, OS signons must exist and be enabled in the current namespace.

The memory for the returned trustedSignonName and trustedDomainName is allocated internally in this API. If the function returns SAFER_SUCCESS, Access Manager calls SaferAPIFreeTrustedSignon to free the memory allocated.

The memory for the returned reqEnvVarList is allocated internally in this API. If the function returns SAFER_INFO_REQUIRED, Access Manager calls SaferAPIFreeBuffer() to free the memory allocated.

You must implement both the SaferAPIGetTrustedSignon and SaferAPIFreeBuffer functions to successfully register the library when
SaferAPIGetTrustedSignonWithEnv is implemented. The function SaferAPIGetError is required only if you want specific error messages returned from your plug-in.

**Syntax**

```c
SaferAPIGetTrustedSignonWithEnv( 
    EnvVar envVar[], /*[IN]*/
    char **reqEnvVarList, /*[OUT]*/
    void **trustedSignonName, /*[OUT]*/
    unsigned long *trustedSignonNameLength, /*[OUT]*/
    void **trustedDomainName, /*[OUT]*/
    unsigned long *trustedDomainNameLength, /*[OUT]*/
    SAFER_USER_TYPE *userType, /*[OUT]*/
    void **implementerData); /*[IN/OUT]*/
```

**Parameters for the SaferAPIGetTrustedSignonWithEnv Function**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[in] envVar</td>
<td>An array of environment variable names and values that were retrieved from the Web server. The end of the array is represented by an entry with a null envVarName and a null envVarValue. Note that the first time this API is called, the envVar array contains only the end of array marker.</td>
</tr>
<tr>
<td>[in] reqEnvVarList</td>
<td>A string that contains a comma separated list of environment variable names that are requested by the Safer implementation. The end of the list must be null-terminated.</td>
</tr>
<tr>
<td>[out] trustedSignonName</td>
<td>A sequence of bytes that identifies the currently authenticated user. This value does not need to be null-terminated. This value is mandatory.</td>
</tr>
<tr>
<td>[out] trustedSignonNameLength</td>
<td>An integer value that indicates the length of the trustedSignonName. This length should exclude the null terminator, if there is one. This value is mandatory.</td>
</tr>
<tr>
<td>[out] trustedDomainName</td>
<td>A sequence of bytes that identifies the domain of the currently authenticated user. You do not need to null-terminate this value. If there is no trustedDomainName, the return is null. This value is optional.</td>
</tr>
<tr>
<td>[out] trustedDomainNameLength</td>
<td>An integer value that indicates the length of the trustedDomainName. This length should exclude the null terminator, if there is one. This value is mandatory and must be set to zero if there is no trustedDomainName.</td>
</tr>
</tbody>
</table>
### Table 24. Parameters and description for the SaferAPIGetTrustedSignonWithEnv Function (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[out] userType</td>
<td>A value that indicates the type of user that Access Manager will authenticate. This value is mandatory.</td>
</tr>
<tr>
<td></td>
<td>The following return values are required for Access Manager to successfully authenticate users:</td>
</tr>
<tr>
<td></td>
<td>SAFER_NORMAL_USER</td>
</tr>
<tr>
<td></td>
<td>A named user. OS signons must exist and be enabled in the current namespace.</td>
</tr>
<tr>
<td></td>
<td>SAFER_GUEST_USER</td>
</tr>
<tr>
<td></td>
<td>A guest user. A guest user account must exist and be enabled in the current namespace.</td>
</tr>
<tr>
<td></td>
<td>SAFER_ANONYMOUS_USER</td>
</tr>
<tr>
<td></td>
<td>An anonymous user. An anonymous user account must exist and be enabled in the current namespace.</td>
</tr>
<tr>
<td>[in/out] implementerData</td>
<td>A pointer used to preserve implementation-specific data between invocations. An invocation occurs every time Access Manager calls the trusted signon plug-in. This value is valid only if the trusted signon plug-in was invoked and you set a value for it.</td>
</tr>
</tbody>
</table>

---

### Configuring IBM Cognos to Use a Custom Authentication Provider

If you implemented a custom Java authentication provider with your existing security infrastructure, you can configure IBM Cognos components to use it.

You can use a custom authentication provider to access and authenticate users to an alternate authentication source. You can also use it as a single signon mechanism to integrate IBM Cognos components with your security infrastructure. You can hide the namespace from users during logon.

For more information, see the Custom Authentication Provider Developer Guide.

### Configure a Custom Authentication Namespace

You can configure IBM Cognos components to use a custom authentication namespace. Any additional configuration for authentication source access, single signon, or custom attributes are dependent on the custom authentication provider implementation.

Ensure that the versions of Java runtime environment (JRE) and Java Software Development Kit that you use are compatible with each other. If you use supported versions of the JRE and Java Software Development Kit that are not compatible with each other, then the custom Java authentication provider that you configure will not appear in the list of namespaces in IBM Cognos Configuration.

### Procedure

1. In every location where Content Manager is installed, open IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, right-click **Authentication**, and click **New resource > Namespace**.

3. In the **Name** box, type a name for your authentication namespace.

4. In the **Type** list, select **Custom Java Provider** and then click **OK**.
   The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.

5. In the **Properties** window, for the **NamespaceID** property, specify a unique identifier for the namespace.

   **Tip:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication provider.

7. From the **File** menu, click **Save**.

8. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Hide the Namespace from Users During Login**

You can hide namespaces from users during login. You can have trusted signon namespaces without showing them on the namespace selection list that is presented when users log in.

For example, you may want to integrate single signon across systems but maintain the ability for customers to authenticate directly to IBM Cognos without being prompted to choose a namespace.

**Procedure**

1. In each location where you configured a custom Java authentication provider, open IBM Cognos Configuration.

2. In the **Explorer** window, under **Security > Authentication**, click the custom Java authentication provider.

3. In the **Properties** window, click the box next to **Selectable for authentication** and select **False**.

4. From the **File** menu, click **Save**.

**Results**

The namespace is not shown on the selection list that is presented at login.

**Configuring IBM Cognos Components to Use LDAP**

You can configure IBM Cognos components to use an LDAP namespace as the authentication provider. You can use an LDAP namespace for users that are stored in an LDAP user directory, Active Directory Server, IBM Directory Server, Novell Directory Server, or Oracle Directory Server.

You can also use LDAP authentication with DB2 and Essbase OLAP data sources by specifying the LDAP namespace when you set up the data source connection. For more information, see the *Administration and Security Guide*.
You also have the option of making custom user properties from the LDAP namespace available to IBM Cognos components.

If you want to bind users to the LDAP server, see “LDAP Mapping.”

**Procedure**

1. **Configure an LDAP Namespace**
2. Make custom user properties available to IBM Cognos components if required
3. Enable secure communication to the LDAP server if required
4. Enable single signon between LDAP and IBM Cognos components if required

**LDAP Mapping**

To bind a user to the LDAP server, the LDAP authentication provider must construct the distinguished name (DN). If the Use external identity property is set to True, it uses the External identity mapping property to try to resolve the user's DN. If it cannot find the environment variable or the DN in the LDAP server, it attempts to use the User lookup property to construct the DN.

If users are stored hierarchically within the directory server, you can configure the User lookup and External identity mapping properties to use search filters. When the LDAP authentication provider performs these searches, it uses the filters you specify for the User lookup and External identity mapping properties. It also binds to the directory server using the value you specify for the Bind user DN and password property or using anonymous if no value is specified.

When an LDAP namespace has been configured to use the External identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is specified. All users who log on to IBM Cognos using external identity mapping see the same users, groups, and folders as the Bind user.

If you do not use external identity mapping, you can specify whether to use bind credentials to search the LDAP directory server by configuring the **Use bind credentials for search** property. When the property is enabled, searches are performed using the bind user credentials or using anonymous if no value is specified. When the property is disabled, which is the default setting, searches are performed using the credentials of the logged-on user. The benefit of using bind credentials is that instead of changing administrative rights for multiple users, you can change the administrative rights for the bind user only.

Note that if you use a DN syntax, such as `uid=${userID}, ou=mycompany.com`, for the properties **User lookup**, **External identity mapping**, or **Bind user DN and password**, you must escape all special characters that are used in the DN. If you use a search syntax, such as `(uid=${userID})`, for the properties **User lookup** or **External identity mapping**, you must not escape special characters that are used in the DN.

**Configure an LDAP Namespace**

You can configure IBM Cognos components to use an LDAP namespace when the users are stored in an LDAP user directory. The LDAP user directory may be accessed from within another server environment, such as Active Directory Server or eTrust SiteMinder.
If you are configuring an LDAP namespace for a directory server other than LDAP, see the appropriate section:

- For Active Directory Server, see Configure an LDAP Namespace for Active Directory Server.
- For IBM Directory Server, see Configure an LDAP Namespace for IBM Directory Server.
- For Novell Directory Server, see Configure an LDAP Namespace for Novell Directory Server.
- For Oracle Directory Server, see Configure an LDAP Namespace for Oracle Directory Server.

You can also use LDAP authentication with DB2 and Essbase OLAP data sources by specifying the LDAP namespace when you set up the data source connection. For more information, see the Administration and Security Guide.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
   If no values are specified, the LDAP authentication provider binds as anonymous.
   If external identity mapping is enabled, Bind user DN and password are used for all LDAP access. If external identity mapping is not enabled, Bind user DN and password are used only when a search filter is specified for the User lookup property. In that case, when the user DN is established, subsequent requests to the LDAP server are executed under the authentication context of the end user.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that Use external identity is set to False.
   - Set Use bind credentials for search to True.
   - Specify the user ID and password for Bind user DN and password.
   If you do not specify a user ID and password, and anonymous access is enabled, the search is done using anonymous.
9. Check the mapping settings for required objects and attributes.
   Depending on the LDAP configuration, you may have to change some default values to ensure successful communication between IBM Cognos components and the LDAP server.
LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.

11. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Configure an LDAP Namespace for Active Directory Server**

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.

3. In the Name box, type a name for your authentication namespace.

4. In the Type list, click the appropriate namespace and then click OK.

   The new authentication provider resource appears in the Explorer window, under the Authentication component.

5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.

   **Tip:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

   The following settings are examples:
   
   - For User lookup, specify (sAMAccountName=${userID})
   - If you use single signon, for Use external identity, set the value to True.
   - If you use single signon, for External identity mapping, specify (sAMAccountName=${environment("REMOTE_USER")})
   - If you want to remove the domain name from the REMOTE_USER variable, specify(sAMAccountName=${replace(${environment("REMOTE_USER")}, "domain\","")}).
   - For Bind user DN and password, specify user@domain
   - For Unique identifier, specify objectGUID

7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.

   If no values are specified, the LDAP authentication provider binds as anonymous.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   
   - Ensure that Use external identity is set to False.
• Set **Use bind credentials for search** to **True**.
• Specify the user ID and password for **Bind user DN and password**.

9. To configure the LDAP advanced mapping properties for use with the Active Directory Server objects, use the values specified in the following table.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>group</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>user</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>displayName</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>unicodePwd</td>
</tr>
<tr>
<td></td>
<td>Postal address</td>
<td>postaladdress</td>
</tr>
<tr>
<td></td>
<td>Product locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Surname</td>
<td>sn</td>
</tr>
</tbody>
</table>
Table 25. LDAP advanced mapping values for use with Active Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>sAMAccountName</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Active Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.
11. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Related tasks

“Configuring IBM Cognos Components to Use Active Directory Server” on page 313

If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

Configure an LDAP Namespace for IBM Directory Server

If you configure a new LDAP namespace for use with an IBM Directory Server, you must modify the necessary settings and change the values for all properties of the IBM Directory objects.

Procedure

1. In each location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP, and then click OK. The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   • For User lookup, specify (cn=${userID})
   • For Bind user DN and password, specify cn=root
7. If you want the LDAP authentication provider to bind to the directory server using a specific **Bind user DN and password** when performing searches, then specify these values.
   If no values are specified, the LDAP authentication namespace binds as anonymous.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that **Use external identity** is set to **False**.
   - Set **Use bind credentials for search** to **True**.
   - Specify the user ID and password for **Bind user DN and password**.

9. To configure the LDAP advanced mapping properties for use with IBM Directory Server objects, use the values specified in the following table.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalunit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupofnames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetorgperson</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
</tbody>
</table>

*Table 26. LDAP advanced mapping values for use with IBM Directory Server objects*
Table 26. LDAP advanced mapping values for use with IBM Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>userPassword</td>
<td></td>
</tr>
<tr>
<td>Postal address</td>
<td>postaladdress</td>
<td></td>
</tr>
<tr>
<td>Product locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>uid</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default IBM Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.

Configure an LDAP Namespace for Novell Directory Server

If you configure a new LDAP namespace for use with a Novell Directory Server, you must modify the necessary settings and change the values for all properties of the Novell Directory objects.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP and then click OK.
   The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.

   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   • For User lookup, specify (cn=${userID})
   • For Bind user DN and password, specify the base DN for an administration user, such as cn=Admin,0=COGNOS
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
   If no values are specified, the LDAP authentication namespace binds as anonymous.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that Use external identity is set to False.
   - Set Use bind credentials for search to True.
   - Specify the user ID and password for Bind user DN and password.

9. To configure the LDAP advanced mapping properties for use with Novell Directory Server objects, use the values specified in the following table.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalunit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupofnames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetOrgPerson</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>Language</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Postal address</td>
<td>postaladdress</td>
</tr>
<tr>
<td></td>
<td>Product locale</td>
<td>Language</td>
</tr>
</tbody>
</table>

Table 27. LDAP advanced mapping values for use with Novell Directory Server objects
Table 27. LDAP advanced mapping values for use with Novell Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>uid</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Novell Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

For users to successfully log in to IBM Cognos Connection, they must have permission to read the ou and o attributes.

10. From the File menu, click Save.

**Configure an LDAP Namespace for Oracle Directory Server**

If you configure a new LDAP namespace for use with Oracle Directory Server, you must modify the necessary settings and change the values for all properties of the Oracle Directory Server objects.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP and then click OK.
   The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   The following settings are examples:
   • For User lookup, type (uid=${userID})
   • If you use single signon, for Use external identity, set the value to True.
   • If you use single signon, for External identity mapping, specify any attribute, such as the NT user domain ID or the user ID:
     (ntuserdomainid=$environment("REMOTE_USER"))
     (uid=$environment("REMOTE_USER"))
   • For Unique identifier, type nsuniqueid
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
If no values are specified, the LDAP authentication namespace binds as anonymous.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   • Ensure that Use external identity is set to False.
   • Set Use bind credentials for search to True.
   • Specify the user ID and password for Bind user DN and password.

9. To configure the LDAP advanced mapping properties for use with Oracle Directory Server objects, use the values specified in the following table.

Table 28. LDAP advanced mapping values for use with Oracle Directory Server objects

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupofuniquenames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>uniquemember</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetorgperson</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>preferredlanguage</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>userPassword</td>
</tr>
<tr>
<td></td>
<td>Postal address</td>
<td>postaladdress</td>
</tr>
</tbody>
</table>
Table 28. LDAP advanced mapping values for use with Oracle Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Product locale</td>
<td>preferredlanguage</td>
</tr>
<tr>
<td></td>
<td>Surname</td>
<td>sn</td>
</tr>
<tr>
<td></td>
<td>Username</td>
<td>uid</td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Oracle Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.

Make Custom User Properties for LDAP Available to IBM Cognos Components

You can use arbitrary user attributes from your LDAP authentication provider in IBM Cognos components. To configure this, you must add these attributes as custom properties for the LDAP namespace. The custom properties are available as session parameters through Framework Manager.

You can also use the custom properties inside command blocks to configure Oracle sessions and connections. You can use the command blocks with Oracle lightweight connections and virtual private databases. For more information, see the Administration and Security Guide.

For more information about session parameters, see the Framework Manager User Guide.

Procedure

1. In each location where you installed Content Manager, open Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the LDAP namespace.
3. In the Properties window, click in the Value column for Custom properties, and click the edit button.
4. In the Value - Custom properties window, click Add.
5. Click the Name column, and type the name you want IBM Cognos components to use for the session parameter.
6. Click the Value column, and type the name of the account parameter in your LDAP authentication provider.
7. Repeat the preceding two steps for each custom parameter.
8. Click OK.
9. From the File menu, click Save.
Enable Secure Communication to the LDAP Server

Secure LDAP protocol (LDAPS) encrypts the communication between the Access Manager component of Content Manager and the directory server. LDAPS prevents sensitive information in the directory server and the LDAP credentials from being sent as clear text.

To enable LDAPS, install a server certificate that is signed by a certificate authority in the directory server. Next, create a certificate database to contain the certificates. Finally, configure the directory server and the IBM Cognos LDAP namespace to use LDAPS.

The server certificate must be a copy of either
- the trusted root certificate and all other certificates that make up the chain of trust for the directory server certificate.
  The trusted root certificate is the certificate of the root certificate authority that signed the directory server certificate.
- the directory server certificate only

The certificates must be Base64 encoded in ASCII (PEM) format. All certificates except the trusted root certificate must not be self-signed.

Before you begin

IBM Cognos works with both the cert8.db and cert7.db versions of the client certificate database. You must use the certutil tool from Netscape OpenSource toolkit NSS_3_11_4_RTM to create the certificate database. IBM Cognos does not accept other versions of cert8.db files, including those from the certutil tool that is provided with Microsoft Active Directory. The appropriate certutil tool is available from the FTP Web site at Mozilla.

You must also use version 4.6.7 of the NSPR library, which is available from the FTP Web site at Mozilla.

Procedure

1. Create a directory for the certificate database.
2. Create the certificate database by typing
   ```
   certutil -N -d certificate_directory
   ```
   where `certificate_directory` is the directory that you created in step 1.
   This command creates a cert8.db file and a key3.db file in the new directory.
3. Add the certificate authority (CA) certificate or the directory server certificate to the certificate database by typing the appropriate command for the type of certificate:
   - For a CA certificate, type
     ```
     certutil -A -n certificate_name -d certificate_directory -i CA.cert -t C,C,C
     ```
   - For a directory server certificate, type
     ```
     certutil -A -n certificate_name -d certificate_directory -i server_certificate.cert -t P
     ```
     where `certificate_name` is an alias that you assign, such as the CA name or host name; and `server_certificate` is the prefix of the directory server certificate file.
4. Copy the certificate database directory to the `c10_location/configuration` directory on every location where Content Manager is installed.
5. Configure the directory server to use LDAPS and restart the directory server. For more information, see the documentation for the directory server.

6. In each Content Manager location where you configured the LDAP namespace to use the directory server, start IBM Cognos Configuration.

7. In the Explorer window, under Security > Authentication, click the LDAP namespace.

8. In the Properties window, for the Host and port property, change the port to the secure LDAPS port.
   For the SSL certificate database property, specify the path to the cert7.db file.

9. In the Explorer window, right-click the LDAP namespace and click Test.
   If the test fails, revise the properties, ensuring that the correct certificate is used.

10. From the File menu, click Save.

11. From the Actions menu, click Restart.

12. Repeat steps 6 to 11 on every other location where Content Manager is installed.

### Enabling Single Signon Between LDAP and IBM Cognos Components

You achieve single signon to IBM Cognos components by configuring the External Identity mapping property.

The External Identity mapping can refer to a CGI environment variable or an HTTP header variable. In the case of an application server gateway or dispatcher entry pointing to IBM Cognos components, the External Identity mapping can refer to the userPrincipalName session variable. The resolved value of the External Identity mapping property at runtime must be a valid user DN.

When an LDAP namespace is configured to use the External Identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is specified. All users who log on to IBM Cognos using external identity mapping see the same users, groups, and folders as the Bind user.

If you want IBM Cognos components to work with applications that use Java or application server security, you can configure the External identity mapping property to obtain the user ID from the Java user principal. Include the token ${environment("USER_PRINCIPAL")} in the value for the property. For more information, see the online help for IBM Cognos Configuration.

You can apply limited expression editing to the External Identity mapping property using the replace operation.

### Replace Operation

The replace operation returns a copy of the string with all occurrences of the old substring replaced by the new substring.

The following rules apply:
- The character \ escapes the characters in the function parameters. Characters such as \ and " need escaping.
- Nested function calls are not supported.
• Special characters are not supported.

Syntax

${replace(str , old , new)}

Parameters for the Replace Operation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>str</td>
<td>The string to search.</td>
</tr>
<tr>
<td>old</td>
<td>The substring to be replaced by the new substring.</td>
</tr>
<tr>
<td>new</td>
<td>The substring that replaces the old substring.</td>
</tr>
</tbody>
</table>

Examples

${replace(${environment("REMOTE_USER")},"NAMERICA\",""})

${replace(${environment("REMOTE_USER")},"NAMERICA\",""""})

Configuring IBM Cognos Components to Use eTrust SiteMinder

You can configure IBM Cognos components to use a Netegrity SiteMinder namespace as the authentication source, provided that you installed Content Manager on a non-Linux computer.

To configure an authentication provider in an eTrust SiteMinder environment, you configure an LDAP, NTLM, or Netegrity SiteMinder namespace depending on your eTrust SiteMinder configuration. Supported eTrust SiteMinder configurations are LDAP, Active Directory Server, and NTLM user directories.

Note: The authentication provider uses an eTrust SiteMinder Software Development Kit to implement a custom agent. The custom agent deployment requires that you set the Agent Properties in the eTrust SiteMinder Policy server administration console to support 4.x agents.

If you plan to run IBM Cognos Business Intelligence products within a 64-bit application server, you cannot configure a Netegrity SiteMinder namespace as your authentication source.

eTrust SiteMinder Configured for More Than One User Directory

If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After configuring the Netegrity SiteMinder namespace in IBM Cognos, you must also add a corresponding LDAP, Active Directory Server, or NTLM namespace to the IBM Cognos configuration for each user directory defined in eTrust SiteMinder.
When configuring a corresponding LDAP namespace, ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property. This does not mean that you must configure eTrust SiteMinder to set REMOTE_USER. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace when it receives successful user identification from the eTrust SiteMinder environment.

When configuring a corresponding Active Directory namespace, ensure that the singleSignOnOption property is set to IdentityMapping. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace using the REMOTE_USER environment variable when it receives successful user identification from the eTrust SiteMinder environment. For more information, see "Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER" on page 319.

### eTrust SiteMinder Configured With Only One User Directory

If eTrust SiteMinder is configured with only one user directory, the Netegrity SiteMinder namespace is not required. You can use the user directory as your authentication source by configuring the appropriate namespace, or you can configure the eTrust SiteMinder provider with one user directory. For example, if the eTrust SiteMinder user directory is NTLM, you can configure IBM Cognos components with an NTLM namespace or configure IBM Cognos components with one Netegrity SiteMinder namespace, referring to one user directory that is an NTLM namespace.

If the eTrust SiteMinder user directory is Active Directory, you can use an Active Directory namespace or an LDAP namespace that is configured for use with Active Directory.

If you want to use the user directory as your authentication source directly instead of configuring a Netegrity SiteMinder namespace, configure the appropriate LDAP namespace (for more information, see "Configure an LDAP Namespace" on page 326), Active Directory (for more information, see "Configure an LDAP Namespace for Active Directory Server" on page 328), or NTLM (for more information, see "Configuring IBM Cognos Components to Use an NTLM Namespace" on page 343) namespace. In this case, verify the Agent Configuration Object properties in eTrust SiteMinder Policy Server. Ensure that SetRemoteUser is activated.

**Note:** When configuring the LDAP namespace, in this case, ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property.

**Note:** When configuring the Active Directory namespace, in this case, ensure that the singleSignOnOption property is set to IdentityMapping. For more information, see "Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER" on page 319.

### Procedure

1. Configure IBM Cognos components to use a Netegrity SiteMinder namespace
2. Enable secure communication to the eTrust SiteMinder user directory if required
3. Enable single signon between eTrust SiteMinder and IBM Cognos
4. Protect the IBM Cognos Web alias
What to do next

You can hide the namespace from users during login. For more information, see “Hide the Namespace from Users During Login” on page 325.

Configure a Netegrity SiteMinder Namespace

If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After adding the Netegrity SiteMinder namespace, you must also add a corresponding LDAP or NTLM namespace for each user directory.

You can also configure an Netegrity SiteMinder namespace if users are stored in
- an LDAP server
- an NTLM server
- an Active Directory server

Procedure

1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the Netegrity SiteMinder namespace and then click OK. The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   
   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. In the Explorer window, under Security > Authentication, right-click the namespace and click New resource > SiteMinder Policy Server.
8. In the Name box, type a name for the policy server and click OK.
9. In the Properties window, specify the Host property and any other property values you want to change.
10. In the Explorer window, right-click the new SiteMinder Policy Server and click New resource > User directory.
   
   Tip: Configure a user directory for each user directory in the SiteMinder policy server.
11. In the Name box, type a name for the user directory and click OK.
   The name of the user directory must match the name that appears on the policy server.
12. In the Properties window, type a value for the Namespace ID reference property.
13. From the File menu, click Save.
14. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.
Configure a corresponding LDAP, Active Directory, or NTLM namespace for each LDAP, Active Directory, or NTLM user directory.

Ensure that you use the same value for the Namespace ID property that you use for the Namespace ID property for the Netegrity SiteMinder namespace.

Enabling Secure Communication to the eTrust SiteMinder User Directory

If you use an SSL connection to the directory server, you must appropriately configure the Cognos namespace for the user directory.

For more information, see "Configure an LDAP Namespace" on page 326.

Enable Single Signon Between eTrust SiteMinder and IBM Cognos

By configuring single signon, you are not prompted to reenter authentication information.

IBM Cognos components automatically refer to the eTrust SiteMinder session cookie for user session data.

If the eTrust SiteMinder user directory is LDAP or Active Directory, you must configure the eTrust SiteMinder user directory to use external identity mapping to the REMOTE_USER environment variable.

If the eTrust SiteMinder user directory is NTLM, integrated authentication on Microsoft Windows operating system is used for single signon and no additional configuration is required.

Protecting the IBM Cognos Web Alias

Ensure that eTrust SiteMinder is configured correctly to protect the IBM Cognos Web alias.

Use the test tool provided with eTrust SiteMinder to verify that the resource is protected, authenticated, and authorized. For more information, see your eTrust SiteMinder documentation.

Hide the Namespace from Users During Login

You can hide namespaces from users during login. You can have trusted signon namespaces without showing them on the namespace selection list that is presented when users login.

For example, you may want to integrate single signon across systems but maintain the ability for customers to authenticate directly to IBM Cognos without being prompted to choose a namespace.

Procedure

1. In each location where you configured an eTrust SiteMinder authentication provider, open IBM Cognos Configuration.
2. In the Explorer window, under Security, > Authentication, click the Netegrity SiteMinder authentication provider.
3. In the Properties window, click the box next to Selectable for authentication and then click False.
4. From the File menu, click Save.

**Results**

The namespace is not shown on the selection list that is presented at login.

---

**Configuring IBM Cognos Components to Use an NTLM Namespace**

You can configure IBM Cognos components to use the Microsoft Windows operating system native security, NT LAN Manager (NTLM), as the authentication source.

If you are not using NTLM in your IS environment, you cannot use an NTLM namespace.

If you want to use an NTLM user directory as your authentication source with eTrust SiteMinder, you must verify the Agent Configuration Object properties in the eTrust SiteMinder Policy Server. Ensure that SetRemoteUser is activated.

To use NTLM and to set up single signon, do the following:

1. **configure an NTLM namespace**
2. **enable single signon between NTLM and IBM Cognos components**

---

**Configure an NTLM Namespace**

You can configure IBM Cognos components to use an NTLM namespace when users are stored in an NTLM user directory. The NTLM user directory may also be accessed using an eTrust SiteMinder authentication provider.

**Procedure**

1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click NTLM and click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   **Tip:** Do not use colons (:) in the NamespaceID property.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. From the File menu, click Save.
8. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.
Enable Single Signon Between NTLM and IBM Cognos Components

By default, the IBM Cognos NTLM provider integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the NTLM namespace.

Procedure

1. Set up Windows integrated authentication on the IIS Web server.
2. Install Content Manager in a location that is part of the domain, for the active and standby Content Managers.
3. Set up the computers, or the user account under which Content Manager runs, to be trusted for delegation.
4. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Configuring IBM Cognos to Use a RACF Provider for Authentication

If you use a Resource Access Control Facility (RACF) provider for authentication in your enterprise environment, you can also use it for authentication in IBM Cognos products.

Procedure

1. **Configure IBM Cognos components to use a RACF namespace**
2. Configure secure communication
3. **Enable single signon between the RACF provider and IBM Cognos components**

Configuring a RACF Namespace

You can configure a Resource Access Control Facility (RACF) namespace using IBM Cognos Configuration.

Before you begin

Before you configure the RACF namespace, you must do the following:

- You must be running Tivoli Directory Server.
- Tivoli Directory Server must be configured for LDAP, to access the SDBM (RACF) database.

For more information, see the topic about configuring Tivoli Access Manager for LDAP in the IBM Information Center.

Procedure

1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. To create the namespace, do the following:
   • In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
   • In the Name box, type a name for your authentication namespace.
   • In the Type list, click RACF and then click OK.
     The new authentication provider resource appears in the Explorer window, under the Authentication component.

3. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   Do not use colons (:) in the Namespace ID property.

4. For the Host and port property, type the value that corresponds to the Tivoli Directory Server.

5. For the Base Distinguished Name property, type the value that matches the suffix that is configured for SDBM in the Tivoli Directory Server.

6. If you are using an SSL connection to the RACF provider, set the Enable SSL property to true.

7. To map to RACF account properties such as email and phone number, for the Base segment DATA and the TSO segment USERDATA properties under Account mappings, click in the value column and select the value from the drop-down list.

8. From the File menu, click Save.

9. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

### Enabling Single Signon Between RACF and IBM Cognos

Enable single signon between the Resource Access Control Facility (RACF) provider and IBM Cognos components to simplify the authentication process for users, avoid the need for multiple signons, and simplify user identity management across the network.

You achieve single signon by configuring identity mapping in IBM Cognos Configuration, configuring IBM WebSphere Application Server to set the REMOTE_USER, and then configuring WebSphere to authenticate against RACF.

When a RACF namespace is configured to use identity mapping for authentication, the RACF namespace binds to the RACF provider using the binding credentials or using anonymous if no binding credentials are specified. All users who log on to IBM Cognos using identity mapping see the same users, groups, and folders as the binding user.

### Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the Explorer window, under Security, right-click Authentication, and then click the RACF namespace.

3. In the Resource properties window, change Enable identity mapping to True.

4. Click the value column for Binding credentials and then click the edit button.

5. In the Value - Binding credentials dialog box, specify the User ID and Password.

6. In IBM Cognos Configuration, restart the service:
In the Explorer window, expand IBM Cognos services, and select the service.
From the Actions menu, click Restart.

7. Using the WebSphere documentation, configure WebSphere to set REMOTE_USER.
8. Using the WebSphere documentation, configure WebSphere to authenticate using the RACF provider.

Delete an Authentication Provider

If they are no longer required, you can delete namespaces that you added, or unconfigure namespaces that IBM Cognos components detected.

You must not delete the Cognos namespace. It contains authentication data that pertains to all users and is required to save the configuration.

When you delete a namespace, you can no longer log on to the namespace. Security data for the namespace remains in Content Manager until you permanently delete it in the portal. For more information, see the Administration and Security Guide.

Procedure

1. In each location where you installed Content Manager, open Cognos Configuration.
2. In the Explorer window, under Security > Authentication, right-click the namespace and click Delete.
3. Click Yes to confirm.
   The namespace disappears from the Explorer window and you can no longer log on to the namespace in that location.
4. From the File menu, click Save.
5. Repeat steps 1 to 4 for each location where you installed Content Manager.
   You must now log on to the portal and permanently delete the data for the namespace. For more information, see the Administration and Security Guide.

Results

After you delete a namespace, it appears as Inactive in the portal.
Chapter 13. Configuration Options

After you install and configure IBM Cognos components, you can change the configuration for your environment. Initially, default property settings are used to configure the components. However, you may want to change these default settings if existing conditions make the default choices inappropriate, or to better suit your environment.

For example, you can configure features for IBM Cognos Application Firewall or specify the amount of resources that IBM Cognos components use. Also, you can deliver IBM Cognos content using another portal by configuring Portal Services.

You can configure IBM Cognos components to use other resources, such as using an authentication provider and then enabling single signon for the database connection and the users.

If you use a load-balancing scheme in your environment, you can change settings to improve performance. For example, you can balance requests among dispatchers by changing their processing capacity or by setting the minimum and maximum number of processes and connections. For more information about tuning server performance, see the Administration and Security Guide.

If you are upgrading from ReportNet, you have several configuration options depending on if you want to continue to use your existing installation. For information about upgrade options, see “Upgrading from ReportNet, Metrics Manager, or Earlier Versions of IBM Cognos BI” on page 87.

As shown in the following diagram, if you change the value of a property, you must save the configuration and then restart the IBM Cognos service to apply the new settings. We recommend that you use the test feature in IBM Cognos Configuration to validate changes.

For all Microsoft Windows operating system and most UNIX and Linux operating system installations, use IBM Cognos Configuration to configure your settings. However, if the console attached to the UNIX or Linux computer on which you are installing IBM Cognos components does not support a Java-based graphical user interface you must manually edit the cogstartup.xml file in the c10_location/configuration directory, and then run IBM Cognos Configuration in silent mode.

Use these optional configuration tasks to customize your configuration so that IBM Cognos components easily integrate into your existing environment.

- Change default configuration settings
- Create a new content store using Cognos Content Database
- Configure the SSL protocol
Start IBM Cognos Configuration

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos, or to start and stop IBM Cognos services.

Before starting IBM Cognos Configuration, ensure that the operating environment is properly set up. For example, ensure that all variables have been set.

You should start IBM Cognos Configuration in the last page of the installation wizard on Microsoft Windows, UNIX, or Linux operating systems only if additional setup is not required. For example, if you use a database server other than Microsoft SQL for the content store, copy the JDBC drivers to the appropriate location before you start the configuration tool.

To start IBM Cognos Configuration on a Windows computer,

- From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.

To start IBM Cognos Configuration on a UNIX or Linux computer,

- Go to the $c10_location/bin directory and then type
  
  ./cogconfig.sh

Changing Default Configuration Settings

When you install IBM Cognos components, the installation uses default configuration settings. If you have any reason not to use these default values, such as a port is being used by another process, use IBM Cognos Configuration to change the value.

If you change the value of a property, you must save the configuration and then restart the IBM Cognos service to apply the new settings to your computer.

For distributed installations, ensure that you configured all computers where you installed Content Manager before you change default configuration settings on other IBM Cognos computers. For example, you can

- change the default user and password for Cognos Content Database
- change a URI
- configure cryptographic settings
- configure IBM Cognos components to use IBM Cognos Application Firewall
After you change the default behavior of IBM Cognos components to better suit your IBM Cognos environment, you can configure Portal Services, configure an authentication provider, or test the installation.

For IBM Cognos BI, you can install and configure Framework Manager. For Metric Studio, you can install and configure Metric Designer.

**Change Default User and Password for Cognos Content Database**

If you install Cognos Content Database, the default database that is created is given a user ID and password. Change this user ID and password.

Administration tasks for Cognos Content Database are performed using a utility named ij. For information about this utility, see the Apache Derby documentation. The documentation is available in the c10_location/derby10.1.2.1/docs directory where you installed Cognos Content Database.

**Changing the default user password**

If you install Cognos Content Database, the default database that is created is given a user ID and password. Change this user ID and password.

**Procedure**

1. On the computer where you installed Cognos Content Database, go to the c10_location/derby10.1.2.1/bin directory.
2. Start the ij utility using the ij.bat or ij.ksh script file.
   
   The ij utility is a command line utility for creating and managing Cognos Content Database.
3. Connect to the default database by typing the following ij utility command:
   
   ```plaintext
class 'jdbc:derby://localhost:1527/cm;user=cognos;password=cognos';
   ```
   
   If you changed the port number from the default 1527, use the correct port number for your Cognos Content Database.
   
   The default database is named cm. The database name is case sensitive.
4. Change the default password for the cognos user by typing the following ij utility command:
   
   ```plaintext
   CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.user.cognos', 'NewPassword');
   ```
   
   The new password must be used for the next connection to the database.
5. Close the ij utility by typing the following command:
   
   ```plaintext
disconnect;
   ```
Creating a new user and password
If you install Cognos Content Database, the default database that is created is given a user ID and password. Change this user ID and password.

Procedure
1. On the computer where you installed Cognos Content Database, go to the
   c10_location/derby10.1.2.1/bin directory.
2. Start the ij utility using the ij.bat or ij.ksh script file.
3. Connect to the default database by typing the following ij utility command:
   
   ```
   connect 'jdbc:derby://localhost:1527/cm;user=cognos;password=cognos';
   
   If you changed the port number from the default 1527, use the correct port number for your Cognos Content Database.
   
   The default database is named cm. The database name is case sensitive.
   ```
4. Create a new user by typing the following ij utility command:
   
   ```
   CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.user.NewUser', 'NewUserPassword');
   ```
5. Give the new user full access to the database by typing the following ij utility command:
   
   ```
   CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.database.fullAccessUsers', 'cognos, NewUser');
   
   The property that you are changing, the list of users, is a comma-delimited field. In this step, you are including the new user in the list of users with full access. The default user, cognos, is still part of the list of users with full access. You can remove the cognos user.
6. Close the ij utility by typing the following command:
   
   ```
   disconnect;
   ```

Removing a user
If you have user accounts that you are no longer using for Cognos Content Database, remove them.

Procedure
1. On the computer where you installed Cognos Content Database, go to the
   c10_location/derby10.1.2.1/bin directory.
2. Start the ij utility using the ij.bat or ij.ksh script file.
3. Connect to the default database by typing the following ij utility command:
   
   ```
   connect 'jdbc:derby://localhost:1527/cm;user=NewUser;password=NewUserPassword';
   ```
4. Choose the kind of user that you want to remove:
   
   • To remove a user from the list of users with full access, type the following ij utility command:
     
     ```
     CALL SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.database.fullAccessUsers', 'NewUser');
     ```
     You omit the user name from the list of users with full access. For example, the above command removes the default cognos user and keeps the new user that you just created.
   • To remove a user from the database, type the following ij utility command and omit the user password:
CALL
SYSCS_UTIL.SYSCS_SET_DATABASE_PROPERTY('derby.user.cognos', '');

This command removes the password for the default cognos user, which also
removes the user from the database.

5. Close the ij utility by typing the following command:
   disconnect;

Port and URI Settings

You can change certain elements in a URI depending on your environment. An
IBM Cognos URI contains the following elements:

- For a Content Manager URI, Dispatcher URI for external applications, or
dispatcher URI
  protocol://host_name_or_IP:port/context_root/alias_path
- For a Gateway URI or a Web content URI
  protocol://host_name_or_IP:port/virtual_directory/gateway_application
  or
  protocol://host_name_or_IP:port/context_root/alias_path

The elements are described in the following table:

Table 30. IBM Cognos URI elements and descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>protocol</td>
<td>Specifies the protocol used to request and transmit information, either Hyper Text Transfer Protocol or Hyper Text Transfer Protocol (Secure).</td>
</tr>
<tr>
<td>host name or IP</td>
<td>Specifies the identity of the host on the network. You can use an IP address, a computer name, or a fully qualified domain name. In a distributed installation, you must change the localhost element of a URI. In a mixed environment of UNIX and Microsoft Windows operating system servers, ensure that host names can be resolved to IP addresses by all servers in the environment.</td>
</tr>
<tr>
<td>port</td>
<td>Specifies the port on which the host system listens for requests. The default port for Tomcat is 9300. The default port for a Web server is 80.</td>
</tr>
<tr>
<td>context root</td>
<td>Used by Tomcat or an application server to determine the context of the application so that the request can be routed to the correct Web application for processing.</td>
</tr>
</tbody>
</table>

Example: http or https
Example: localhost or 192.168.0.1 or [2001:0db8:0000:0000:0000:0000:0000:0000]:80
Example: p2pd
Table 30. IBM Cognos URI elements and descriptions (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| alias path         | Used by the application server to route a request to the correct component within a Web application. The alias path must not be modified or IBM Cognos components will not function properly.  
Example: servlet/dispatch |
| virtual directory  | Used by the Web server to map a virtual directory or alias to a physical location.  
For example, in the default Gateway URI of http://localhost:80/ibmcognos/cgi-bin/cognos.cgi, the virtual directory is ibmcognos/cgi-bin.  
Example: ibmcognos/ |
| gateway application| Specifies the name of the Cognos gateway application that is used.  
For example, if you are accessing IBM Cognos components using a Common Gateway Interface (CGI), then the default gateway application would be cognos.cgi.  
Example: cognos.cgi |

If you are using collaboration with IBM Connections, ensure that you include the full domain for all hostname entries in IBM Cognos Configuration. For example, if your computer is named MyComputer and your domain is MyCompanyName.com, then for the host_name_or_IP value, use MyComputer.MyCompanyName.com. The domain must be included in order for IBM Connections to allow access. For more information, see “Allow access to IBM Connections from IBM Cognos BI” on page 306.

**Change a Port or URI Setting**

Use the following procedure to change URI properties in IBM Cognos Configuration.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window click the appropriate group or component:
   - To change an element for the dispatcher, click Environment.
   - To change an element for the local log server, under Environment, click Logging.
3. In the Properties window, click the Value box next to the URI property that you want to change.
4. Select the element and type the new information.

**Tips**

- To change the port used by the local dispatcher, change the value of the internal dispatcher URI property. Because the change affects all the URIs that are based on the local dispatcher, you must change the URIs of all local components.
• If you change the dispatcher port in the dispatcher URI, ensure that you specify the new port number when you configure remote computers that use the dispatcher, Content Manager, or Software Development Kit services on this system.

5. From the File menu, click Save.

**Configuring Cryptographic Settings**

IBM Cognos components require a cryptographic provider; otherwise they will not run. If you delete the default cryptographic provider, you must configure another provider to replace it.

You can configure the following cryptographic settings:
• general cryptographic settings
• settings for the default cryptographic provider
• settings for a cryptographic provider in an Entrust security infrastructure

**Configure General Cryptographic Settings**

In a distributed installation, IBM Cognos computers communicate with Content Manager to establish trust and obtain some cryptographic keys from Content Manager.

If you change the cryptographic keys in Content Manager, such as by changing application servers or reinstalling Content Manager, you must delete the cryptographic keys on the other IBM Cognos computers. You must then save the configuration on each computer so that they obtain the new cryptographic keys from Content Manager. In addition, all IBM Cognos components in a distributed installation must be configured with the same cryptographic provider settings.

Also, in a distributed environment, the symmetric key should only be stored on computers where Content Manager has been installed.

You can configure the following general cryptographic settings:
• common symmetric key store (CSK) properties
  The CSK is used by IBM Cognos to encrypt and decrypt data.
• secure sockets layer (SSL) settings
  These include mutual authentication and confidentiality.
• advanced algorithm settings
  These include signing and digest algorithms.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Cryptography.
3. In the Properties window, change the default values by clicking the Value box and then selecting the appropriate value:
   • On computers that do not contain Content Manager, if you do not want to store the CSKs locally, under CSK settings, change Store symmetric key locally to False.
     When Store symmetric key locally is False, the key is retrieved from Content Manager when required. The Common symmetric key store location property is ignored.
   • If you want the computers at both ends of a transmission to prove their identity, under SSL Settings, change Use mutual authentication to True.
Do not change the Use confidentiality setting.

- If you want to change the digest algorithm, for the Digest algorithm property, select another value.

4. From the File menu, click Save.
5. Test the cryptographic provider on a gateway computer only. In the Explorer window, right-click Cryptography and click Test.

IBM Cognos components check the availability of the symmetric key.

Results

After you configure the cryptographic settings, passwords in your configuration and any data you create are encrypted.

Configure Settings for the Default Cryptographic Provider

You can configure some cryptographic settings for the cryptographic provider.

The configurable settings include the following:
- algorithms and ciphersuites
- identity name settings
- signing key store properties
  The signing key pair includes the private key used to generate the digital signature and the public key used to verify authenticity.
- encryption key store properties
  The encryption key pair includes the private key used to encrypt data and the public key used to decrypt data.
- certificate authority settings
  These include properties for the provided certificate authority (CA) or a third-party CA.

Procedure

1. If you are using a JRE other than the one provided with IBM Cognos server, ensure that the following files from IBM Cognos exist in the location where the JRE is installed:
   - From c10_location/bin/jre/version/lib/ext, copy bcprov-jdk14-134.jar to JRE_location/lib/ext.
   - From c10_location/bin/jre/version/lib/security, copy local_policy.jar and US_export_policy.jar to JRE_location/lib/security.
   If you are using 64-bit components, copy the files from c10_location/bin64 instead of c10_location/bin.
2. If you are using a JRE other than one IBM provides, you must also download and install the unrestricted Java Cryptograph Extension (JCE) policy file for your JRE to ensure that all available algorithms and cipher suites are shown in IBM Cognos Configuration.
4. In the Explorer window, under Security, Cryptography, click Cognos.
5. In the Properties window, change the properties as needed.
   - To configure the confidentiality algorithm, under the appropriate property, Confidentiality algorithm or PDF Confidentiality algorithm, click in the Value column and then select the algorithm from the drop-down list.
   The value of a confidentiality algorithm determines how data is encrypted by IBM Cognos components. For example, database passwords entered in IBM
Cognos Configuration are encrypted when you save the configuration. The algorithm selected when the data is encrypted must also be available for the data to be decrypted at a later date.

The availability of confidentiality algorithms can change if there are changes to your environment. For example, if your Java Runtime Environment (JRE) has changed or if you have installed other cryptographic software on the computer. You must ensure that the Confidentiality algorithm that was selected when the data was encrypted is also available when you want to access the data.

If you have made changes to a computer, such as upgraded the JRE or installed software that has upgraded the JRE, this may affect the availability of confidentiality algorithms. To ensure that the available algorithms and cipher suites are shown in IBM Cognos Configuration, download and install the unrestricted Java Cryptography Extension (JCE) policy file. For Java that IBM provides, the unrestricted JCE policy file can be downloaded from https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk.

- To adjust the cipher suites, under Supported ciphersuites, click in the Value column and then click the edit button.
  Remove the cipher suites that are not applicable and move the remaining cipher suites up or down in the list so that the cipher suites in the highest range are higher in the list.
  Do not mix cipher suites in the 40- to 56-bit range with cipher suites in the 128- to 168-bit range.
- To change the location of the signing keys, under Signing key settings, change the Signing key store location property to the new location.
- To change the location of the encryption keys, under Encryption key settings, change Encryption key store location to the new location.
- To use another certificate authority, under Certificate Authority settings, change Use third party CA to True.
  You must also ensure that you use the same values for the -k parameter as you used for the Signing key store location and Encryption key store location properties.
  For more information, see “Configuring IBM Cognos BI Components to Use Another Certificate Authority” on page 468.

6. From the File menu, click Save.

Results

If you use another Certificate Authority (CA) server, configure IBM Cognos components to use the CA. For more information, see “Configuring IBM Cognos BI Components to Use Another Certificate Authority” on page 468.

Configure Cryptographic Provider Settings in an Entrust Security Infrastructure

To configure encryption in an Entrust security infrastructure, you replace the default cryptographic provider in IBM Cognos Configuration with a provider that you configure for Entrust and then you update security files in your IBM Cognos environment.
**Before you begin**

Ensure that the key store passwords match the one in your Entrust Profile (EPF).

To prevent gateway errors, ensure that the Internet Guest Account has read and write permission to the Entrust .epf file and read permission to the Entrust .ual file.

**Procedure**

1. If you are using a JRE other than the one provided with IBM Cognos server, ensure that the following files from IBM Cognos and Entrust exist in the location where the JRE is installed:
   - From `c10_location/bin/jre/version/lib/ext`, copy `bcprov-jdk14-134.jar` to `JRE_location/lib/ext`.
   - From `c10_location/bin/jre/version/lib/security`, copy `local_policy.jar` and `US_export_policy.jar` to `JRE_location/lib/security`.
   - From the Entrust Authority Security Toolkit that you download from Entrust, copy the .jar file, such as `enttoolkit.jar`, to `JRE_location/lib/ext`.
   If you are using 64-bit components, copy the `bcprov-jdk14-134.jar`, `local_policy.jar`, and `US_export_policy.jar` files from `c10_location/bin64` rather than `c10_location/bin`.

2. To ensure that all available algorithms and cipher suites are shown in IBM Cognos Configuration, download and install the unrestricted Java Cryptography Extension (JCE) policy file. For Java that IBM provides, the unrestricted JCE policy file can be downloaded from [https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk](https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk).


4. In the Explorer window, under the Security group, click Cryptography.

5. In the Properties window, under Advanced algorithm settings, change the Digest algorithm to the appropriate message digest or secure hash algorithm for your security policy.

6. In the Explorer window, under the Security group and the Cryptography component, right-click the IBM Cognos resource, and click Delete.


8. In the Name field, type a name for the encryption service you are creating.

9. In the Type field, click the arrow, and click Entrust, and then click OK. A branch with the name you assigned appears below Cryptography.

10. Click the branch you created.

    Resource properties appear in the properties window.

11. In the Properties window, enter the appropriate values, as listed in the following table.

**Table 31. Cryptography property values and descriptions**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INI file location</td>
<td>The location of the Entrust initialization file (.ini).</td>
</tr>
<tr>
<td>Identity file distinguished name (DN)</td>
<td>The distinguished name associated with the profile of the Entrust identity.</td>
</tr>
</tbody>
</table>
Table 31. Cryptography property values and descriptions (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity file location</td>
<td>The location of the Entrust identity profile file (.epf).</td>
</tr>
<tr>
<td>Use Entrust Server Login</td>
<td>The parameter that controls whether users must enter a password to log on to the Entrust PKI.</td>
</tr>
<tr>
<td>Identity file password</td>
<td>The Entrust Profile password, which must match the one in your Entrust Profile (EPF).</td>
</tr>
<tr>
<td>Confidentiality algorithm</td>
<td>The level of encryption that is required to comply with your security policy.</td>
</tr>
<tr>
<td>PDF Confidentiality algorithm</td>
<td>The encryption algorithm to use when encrypting PDF data.</td>
</tr>
<tr>
<td>Supported ciphersuites</td>
<td>The cipher suites that are supported in your security environment. Remove the ones that are not applicable and rearrange the remaining cipher suites from highest to lowest. This ensures that the most secure cipher suite is used first.</td>
</tr>
<tr>
<td>Signing Key Store Location</td>
<td>The location of the key store that contains the signing key pairs.</td>
</tr>
<tr>
<td>Encryption Key Store Location</td>
<td>The location of the key store that contains encryption key pairs.</td>
</tr>
</tbody>
</table>

**Important:** Record your passwords in a secure location.

12. From the **File** menu, click **Save**.

13. Update to Entrust Java Toolkit 7.2 SP2 Patch 152842.

**IBM Cognos Application Firewall**

IBM Cognos Application Firewall analyzes and validates HTTP and XML requests before they are processed by IBM Cognos servers. IBM Cognos Application Firewall may modify these HTTP and XML requests.

IBM Cognos Application Firewall protects IBM Cognos Web products from malicious data. The most common forms of malicious data are buffer overflows and cross-site scripting (XSS) attacks, either through script injection in valid pages or redirection to another Web site.

You can track firewall activity by checking the log file, which contains rejected requests. By default, log messages are stored in the `c10_location/logs/cogserver.log` file.

If you are using the collaboration features with IBM Connections, you must add the host name, domain, and port number on which IBM Connections is running to the **Valid domains and hosts** property for the Cognos Application Firewall.
All Cognos Application Firewall settings must be the same for all computers where IBM Cognos Application Tier Components are installed within a distributed environment. For example, if Cognos Application Firewall is disabled on some computers and enabled on others, unexpected behavior and product errors may result.

The following types of URLs are accepted by Cognos Application Firewall validation:

- fully qualified (absolute) URLs
  in the format `protocol://host:port/path`, where `protocol` is http or https and `host` is validated against the valid domain list

- URLs relative to the Web installation directory
  in the format `/Web_installation_root/.*` where `Web_installation_root` is the gateway Web directory, based on the ibmcognos alias that you configured on your Web server.
  For example,
  `/ibmcognos/ps/portal/images/action_delete.gif`

- specific allowed URLs, including the following (all case insensitive)
  - `about:blank`
  - `JavaScript:window.close( )`
  - `JavaScript:parent.close( )`
  - `JavaScript:history.back( )`
  - `parent.cancelErrorPage( )`
  - `doCancel( )`

### Configure IBM Cognos Components to Use IBM Cognos Application Firewall

Using IBM Cognos Configuration, you can change settings for other XSS tool support, and you can add host and domain names to the IBM Cognos list of valid names.

**Procedure**

1. In each location where IBM Cognos BI Application Tier Components are installed, start IBM Cognos Configuration.

2. In the **Explorer** window, under **Security**, click **IBM Cognos Application Firewall**.

3. In the **Properties** window, for the **Enable CAF validation** property, set the appropriate values.
   By default, IBM Cognos Application Firewall is enabled.

   **Important:** The IBM Cognos Application Firewall is an essential component of IBM Cognos security, helping to provide protection against penetration vulnerabilities. Disabling the IBM Cognos Application Firewall will remove this protection. Under normal circumstances, do not disable the IBM Cognos Application Firewall.

4. If you are using another XSS tool that checks for specific characters in GET request parameters, in the **Properties** window, for the **Is third party XSS checking enabled** property, change the value to **True**.
   The default characters that are prohibited include `>`, `<`, and `'`

5. Add host and domain names to the IBM Cognos list of valid names:
For the **Valid domains and hosts** property, click the value and then click the edit button.

- In the **Value - Valid domains or hosts** dialog box, click **Add**.
  You must include the domains from all hyperlinks that are added in IBM Cognos Connection. For more information, see the topic about creating a URL in the *Administration and Security Guide*.

  **Tip:** If you are using drill-through from IBM Cognos Series 7 to reports in IBM Cognos BI, add the hostnames of the IBM Cognos Series 7 gateway servers to the list.

- In the blank row of the table, click and then type the host or domain name. To allow a domain and all its sub-domains, use a wildcard character at the beginning of the domain name.
  For example, *.mycompany.com
  If you are using the collaboration features with IBM Connections, you must add the host, domain, and port number for the IBM WebSphere profile where you have installed IBM Connections. For example, if you installed IBM Connections on a computer named myserver, and your domain is mycompany.com, you would add myserver.mycompany.com:9080, where 9080 is the IBM WebSphere port number on which IBM Connections is running.

- Repeat the previous two bulleted steps for each name to be added.

- Click **OK**.
  IBM Cognos Application Firewall validates domain and host names to protect URLs that are created. By default, IBM Cognos Application Firewall considers domain names derived from the environment configuration properties to be safe domain names. Adding names to the list of valid names and hosts is useful when you need to redirect requests to non-IBM Cognos computers using the Back or Cancel functions or when using drill-through to different IBM Cognos product installations.

6. Save the configuration.
7. Restart the services.

**Encrypt Temporary File Properties**

Temporary files are used in IBM Cognos BI to store recently viewed reports and to store data used by the services during processing. You can change the location of the temporary files and you can choose to encrypt their content.

By default, IBM Cognos components store temporary files in the `c10_location\temp` directory and the files are not encrypted.

For optimum security, deny all access to the temp directory, except for the service account used to start the IBM Cognos services. Read and write permissions are required for the service account.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, for the **Temporary files location** property, specify the new location.
4. If you require the content of temporary files to be encrypted, set the `Encrypt temporary files` property to `True`.

5. Ensure that the user account under which IBM Cognos BI components run have the appropriate privileges to the temporary files location. For example:
   - on Microsoft Windows operating systems, full control privileges
   - on UNIX or Linux operating systems, read-write privileges

### Configure the Gateway to Use a Namespace

If IBM Cognos components use multiple namespaces, or if anonymous access is enabled and IBM Cognos components use one namespace, you can configure the gateway to connect to one namespace. Users logged onto the Web server where the gateway is located are not prompted to choose an authentication source. For example, if you have two Web servers, you can configure each Web server to use a different namespace.

**Procedure**

1. On the computer where the gateway is located, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, in the Value box next to the Gateway namespace property, type the Namespace ID of the namespace that you want to use.
4. From the File menu, click Save.
5. Restart your Web server.

### Enable and Disable Services

In a distributed installation, you can send certain types of requests to specific computers by enabling or disabling the installed services.

For example, to dedicate a computer to running and distributing reports, you can disable the presentation service on an Application Tier Components computer. To dedicate a computer in a distributed installation to processing Metric Studio application requests, disable the Data Integration Service on the computer.

**Note:** The default values for dispatcher service and presentation service are false on computers that only have Content Manager installed. On all other types of installations, the default values are true.

If you installed all components on several computers, you can disable appropriate services on each computer to get the distributed configuration you require. Requests are only sent to dispatchers where a given service is enabled.

Disabling a service prevents the service from loading into memory. When disabled, services do not start and therefore do not consume resources. The service does not run until you enable it.

If you disable the dispatcher service, the dispatcher-related services are disabled. Only dispatcher services that are enabled can process requests.

**Enabling and disabling services**

Use the following procedure to disable selected services on components in a distributed installation.
Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click IBM Cognos services.
3. In the Properties window, click the Value next to the service that you want to disable or enable.
   By default, all services are enabled.
4. Click the appropriate state for the services:
   • To disable the service, click False.
   • To enable the service, click True.
5. From the File menu, click Save.

Configuring Fonts
IBM Cognos components use fonts to render PDF reports on the IBM Cognos server. IBM Cognos components also use fonts to render charts used in PDF and HTML reports.

To show output correctly, fonts must be available where the report or chart is rendered. In the case of charts and PDF reports, the fonts must be installed on the IBM Cognos server. If a requested font is not available, IBM Cognos components substitute a different font.

Because HTML reports are rendered on a browser, the required fonts must be installed on the computer of each IBM Cognos user who will read the HTML report. If a requested font is not available, the browser substitutes a different font.

Use the following checklist if you want to use a new font in your reports.

- • Add the font to the list of supported fonts
- • Specify the file location of the new font
- • Map the new font to the physical font name if required.

Add Fonts to the IBM Cognos Environment
You can add fonts to the list of supported fonts in your IBM Cognos environment if you want to generate reports that use fonts that are currently not available. You can also remove fonts. By default, IBM Cognos components use a set of global fonts, which are available on all IBM Cognos server computers.

Procedure
1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Fonts tab.
4. Click Add.

   Tip: To remove a font from the list of supported fonts, click the box next to the font name and then click Remove.
5. In the Supported Font Name box, type the font name and then click OK.
6. From the File menu, click Save.
   All global fonts, including new fonts that you add, must be installed on all IBM Cognos computers in your environment.
Results

If a global font is not installed on all IBM Cognos computers, you must map the global font to an installed, physical font.

Specify the Location of Available Fonts
You must specify the installation location of all fonts, including fonts that you add to the list of supported fonts.

By default, the list of fonts consists of fonts installed in the c10_location/bin/fonts directory of the IBM Cognos computer. If IBM Cognos components are installed on a Microsoft Windows operating system computer, they also use the fonts installed in the Windows font directory.

You specify the font location on all computers where Application Tier Components are installed.

Procedure
1. On each Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, for the Physical fonts locations property, specify the location of the fonts.
   If there are multiple font paths, separate each path by a semicolon (;).
   If you are using an application server other than Tomcat, type the fully qualified path to the font location. For example: c10_location/bin/fonts.
4. From the File menu, click Save.

Map Supported Fonts to Installed Fonts
You can substitute global fonts, which are not installed on the computer, for physical fonts.

You map fonts on each computer where the Application Tier Components are installed.

For example, you add a font to the list of supported fonts that is not installed on the IBM Cognos computer. You can specify which font to use as a substitute.

If you want to print reports faster by using the built-in PDF fonts, you can map a global font such as Arial to one of the built-in PDF fonts, such as Helvetica-PDF, by following the steps below. You can also select one of the built-in PDF fonts for a text object in Report Studio or Query Studio. For more information, see the Query Studio User Guide or the Report Studio User Guide.

No mapping is required if you add a font to the supported font list that is installed on IBM Cognos computers. However, you must specify the location of the font.

Procedure
1. On each Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, click the Value box next to the Physical fonts map property, and then click the edit button.
The **Value - Physical fonts map** dialog box appears.

4. Click **Add**.

**Tip:** To remove a font, select the check box next to the font and click **Remove**.

5. In the **Global Font Name** box, type the name of the font you added to the supported font list.

6. Click the **Physical Font Name** box.

7. If you know the physical font name, type it. Otherwise, click the **Edit button**.

   In the **Physical Font Name** dialog box, click **Search Now** and then click a font name from the results.

8. Repeat steps 4 to 7 for each global font that requires mapping.

9. Click **OK**.

10. From the **File** menu, click **Save**.

**Results**

Now, if required, you must **specify the installation location of the fonts**.

**Considerations to Support Simplified Chinese**

IBM Cognos BI products support the GB18030-2000 character set, which is used in the encoding of Simplified Chinese locales. If you install on Windows, support is provided for the GB18030-2000 character set in the NSimSun-18030 font that is provided by Microsoft. If you install on other operating systems, or if you use Internet Explorer 6 on Windows, additional installation tasks are required:

- On operating systems other than Windows, you must install a font that supports GB18030-2000.
- If you use Internet Explorer 6 on Windows, you must **update the registry entries** for fonts that reference SimSun.

**Update the Registry Entries for Windows Font Links**

The GB18030-2000 character set includes CJK Unified Ideographs Extension A characters. When these characters are encoded as UTF-8 in Internet Explorer 6, they may not appear correctly in Web pages. To ensure that these characters appear correctly, you must add SimSun-18030 to all font link registry entries that specify SimSun.

**Procedure**

1. From the **Start** menu, select **Run**.
2. In the **Run** dialog box, type **regedit**.
3. Open the **HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\FontLink\SystemLink** directory.
4. In **Registry Editor**, right-click a font that contains SimSun in the **Data** field and select **Modify**.
5. In the **Edit Multi-String** dialog box, under **Value data**, click under the selected strings and type the following string:
   `SimSun18030.ttc,SimSun-18030`
6. Click **OK**.
7. Repeat steps 4 to 6 for every font that contains SimSun.
When complete, close Registry Editor.

**Change the Default Font for PDF Reports**

You can change the default font that IBM Cognos BI components use for PDF reports. You see this default font when you open a report.

You change the default font on the computer where Content Manager is installed. After you make the change, the font becomes the default for all computers in your installation. You change the font used for PDF reports using IBM Cognos Configuration.

Ensure that the default font is installed on all computers in your IBM Cognos installation.

**Procedure**

1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the General tab.
4. In the Value box, for Default font, type the font you want to use as the default for reports.
5. Click OK.
6. From the File menu, click Save.
7. On all Application Tier Components computers, ensure that the installation location of the default font is specified in the Physical fonts locations property (under Environment in the Explorer window) or that the font is in the Windows font directory.

**Configure Embedded Fonts for PDF Reports**

When a PDF report opens in Adobe Reader, all the fonts used in that report must be available. Fonts must be either embedded in the report or installed on the user's computer. If a font is not available in either of these locations, Adobe Reader tries to substitute an appropriate font. This substitution may cause changes in the presentation of the report or some characters may not be displayed.

To ensure that PDF reports appear correctly in Adobe Reader, IBM Cognos BI embeds required fonts in reports by default. To minimize the file size, IBM Cognos BI embeds only the characters (also called glyphs) used in the report rather than all characters in the font set. IBM Cognos BI embeds fonts only if they are licensed for embedding. The license information is stored in the font itself and is read by IBM Cognos BI.

If you are confident that the fonts used in reports are available on users' computers, you can limit or eliminate embedded fonts to reduce the size of PDF reports. When limiting fonts, you specify whether a font is always or never embedded, using an embedded fonts list in IBM Cognos Configuration.

**Procedure**

1. On the Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the **Properties** window, under **Font Settings**, click the value for **Fonts to embed** (Batch report service) or **Fonts to embed** (Report service), and then click the edit button.

4. If you are not using the default fonts directory or if you want to add a path to an additional directory, in the **Fonts to Embed in PDF Reports** dialog box, specify the new path in the font paths box.
   **Tip:** Click **Search Now** to get a list of the available fonts in the specified path or paths.

5. For a font that will always be available on users' computers, scroll to the font name, and click the **Never** check box.
   IBM Cognos BI does not embed the font with any reports. Adobe Reader picks up the font from the user's computer when the report is opened.

6. For a font that may not always be available on the users' computers, scroll to the font name and click the **Always** check box.
   IBM Cognos BI embeds the font with all reports that use it. Adobe Reader uses the embedded font when the report is opened.

7. Click **OK**.

### Saved Report Output

By default, report output files are saved in the content store. You have the option of saving a copy of the report output in another file location that is outside or inside IBM Cognos BI. If you use this option, a descriptor file with an '_descr' extension is also saved. Saved files are not managed by IBM Cognos BI.

#### Save Report Output Outside IBM Cognos BI

If you configure a file system location that is outside of IBM Cognos BI, you can then share the report output with external applications or people who don't have IBM Cognos BI. This is how most report output files are saved.

To use this feature, you must first configure a root directory in IBM Cognos Configuration. An administrator must then set the file location in IBM Cognos Administration. For more information, see the topic about setting a file location for report output saved outside of IBM Cognos BI, in the *Administration and Security Guide*.

#### Procedure

1. Create a directory for your file system.
   **Tip:** Ensure that the directory is accessible to users and separate from the installation directory. For example, in a distributed installation on Microsoft Windows, an archive folder such as `\servername\directory` could be used.

2. On the Content Manager computer, start IBM Cognos Configuration.

3. From the **Actions** menu, click **Edit Global Configuration**.

4. In the **Global Configuration** window, click the **General** tab.

5. For **Archive Location File System Root**, type a URI using the format
   `file://directory`
   where `directory` is the directory that you created in step 1.
   The `file://` portion of the URI is required. Windows UNC names, such as `\servername\directory`, can be used. If so, the URI must be formatted as follows:
   `file://\servername\directory`
6. To confirm that the correct location will be used, click **Test**.
7. Click **OK**.
8. From the **File** menu, click **Save**.

**Results**

The administrator must now configure the file location. For information, see the topic about setting a file location for report output saved outside of IBM Cognos BI, in the *Administration and Security Guide*.

**Save Report Output Inside IBM Cognos BI**

If you configure a file system location that is inside IBM Cognos BI, you can then use the report output again. This may also be useful for archive purposes, because files that are saved in the Content Store may be deleted regularly due to retention rules.

To use this feature, you must first enable the **Save report outputs to a file system** property in IBM Cognos Configuration. An administrator must then configure the file location using the CM.OutPutLocation parameter in IBM Cognos Administration. For more information, see the topic about setting a file location for report output saved inside IBM Cognos BI, in the *Administration and Security Guide*.

To protect the security of the report output when using this feature, the file system must have third-party encryption.

**Procedure**

1. Create a directory for your file system.

   **Tip:** Ensure that the directory is accessible to authorized users only.
2. On the Content Manager computer, start IBM Cognos Configuration.
3. In the **Explorer** window, click **Data Access > Content Manager**.
4. For the **Save report outputs to a file system** property, click **True**.
5. To test the connection to the report output directory, from the **Actions** menu, click **Test**.
6. From the **File** menu, click **Save**.

**Results**

The administrator must now configure the file location using the CM.OutPutLocation parameter. For information, see the topic about setting a file location for report output saved inside IBM Cognos BI, in the *Administration and Security Guide*.

** Changing the Location of Temporary Report Output **

When users run interactive reports, the report output is stored in Content Manager or in a temporary session cache in the local report file system. You can change the location of the temporary session cache to a remote computer such as a shared directory on a Microsoft Windows based system or a common mounted directory on a UNIX or Linux based system.

By default, the location of the temporary session cache on the report file system is `c10_location/temp/Session`. The Session directory is created by the report server when the first request from a user session is received.
To configure whether the temporary report output is stored in Content Manager or in the local report file system, see the topic about storing user session files on a local report file system in the *Administration and Security Guide*.

**Procedure**

1. On the computer where Application Tier Components are installed, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, click the value for Temporary files location, and then click the edit button.
4. In the Select Folder dialog box, use the Save in box to locate the computer and directory, and then click Select.
5. From the File menu, click Save.

When a user runs an interactive report session, the temporary report output is now stored in the new location.

**Change the Location of Map Charts for Report Studio**

IBM Cognos BI comes with a set of sample map charts that you can use in Report Studio. You can change the location of the map charts by using IBM Cognos Configuration.

By default, the map charts are stored in the `c10_location/maps` directory on the Application Tier Components computer.

For more information about using map charts, see the Report Studio *User Guide*.

For information about using custom maps from other sources, see the Map Manager *Installation and User Guide*.

**Procedure**

1. On the Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, click the value for Map files location.
4. Click the edit button.
5. In the Select Folder window, navigate to the directory you want and then click Select.
6. From the File menu, click Save.

**Change the Notification Database**

By default, the notification server uses the same database that Content Manager uses for the content store. You can use a separate database for notification in situations where you run large volumes of batch reports and email.

Using a separate database for notification involves the following tasks:

- Create a notification database.
  
  For DB2, Oracle, Microsoft SQL Server, or Sybase, use the same procedure that was used to create the content store database.
For DB2 on z/OS, use the instructions in "Suggested Settings for Creating a DB2 Notification Database on z/OS."

- Set up the database connectivity.
  
  You can use the same procedure as to set the connectivity for the content store database, "Set Up Database Connectivity for the Content Store Database" on page 133.

- Change the connection properties for the notification database.

**Suggested Settings for Creating a DB2 Notification Database on z/OS**

The database you create for the notification database must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the notification database.

Use the following checklist to help you set up the notifications database in DB2 on z/OS.

- Create a database instance, storage group, and a user account for the notification database.
  
  A user must have permissions to create and delete tables in the database.
  
  IBM Cognos BI uses the credentials of the user account to communicate with database servers.

- Ensure you reserve a buffer pool with a page size of 32 k, and a second one with a page size of 4 k for the database instance.

- Administrators must run a script to create tablespaces to hold Large Objects and other data for the notification database to use the tablespaces.

  For information about running the script, see "Create Tablespaces for the DB2 Notification Database on z/OS."

- Your database administrator must back up IBM Cognos BI databases regularly because they contain the IBM Cognos data.

  To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Create Tablespaces for the DB2 Notification Database on z/OS**

A database administrator must run scripts to create a set of tablespaces required for the notification database. The scripts must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

Ensure that you use the naming conventions for DB2 on z/OS. For example, all names of parameters must start with a letter and the length must not exceed 6 characters. For more information, see the IBM DB2 Information Center.

**Procedure**

1. Connect to the database as a user with privileges to create and drop tablespaces and to allow execution of SQL statements.

2. Go to the directory that contains the scripts:

   ```
c10_location/configuration/schemas/content/db2zOS
   ```

3. Open the NC_TABLESPACES.sql script file and use the following table to help you to replace the placeholder parameters with ones appropriate for your environment.
Table 32. Tablespace parameter names and descriptions for the DB2 notification database on z/OS

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCCOG</td>
<td>Specifies the name of the notification database.</td>
</tr>
<tr>
<td>DSN8G810</td>
<td>Specifies the name of the storage group.</td>
</tr>
<tr>
<td>BP32K</td>
<td>Specifies the name of the buffer pool.</td>
</tr>
</tbody>
</table>

Not all of the parameters listed are in the script, but may be added in the future.

4. Save and run the script.
5. Open the NC_CREATE.sql script file and replace the NCCOG placeholder parameter with the name of the notification database.
6. Save the script.
   The Job and Scheduling Monitor services will automatically run the script. However, you may choose to run it yourself.

Results

The notification database is created. You can now change the notification database in IBM Cognos Configuration.

Change the Connection Properties for the Notification Database

After you create a separate database for notification, you must configure IBM Cognos components to use the new database.

You must configure all Content Managers and Application Tier Components to use the same notification database.

Procedure

1. In each location where Content Manager or Application Tier Components is installed, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, click Notification.
3. Identify the database that is used for notification:
   - In the Explorer window, right-click Notification and select New resource > Database.
   - Type a name for the database resource.
   - Select the type of database from the pull-down menu.
   - Click OK.
4. In the Properties window, enter the values for the notification database resource.
5. From the File menu, click Save.
6. Test the notification. In the Explorer window right-click Notification and click Test.
   This tests the database connection and the mail server connection.
   If you have been using the content store database for notification, the schedules will be replicated in the tables of the new notification database.
Results

Ensure that the values used to identify the notification database resource are the same on all Content Manager and Application Tier Components computers. To use the default notification database, you do not have to edit the values in the Properties window.

Create a New Content Store Using Cognos Content Database

Follow the steps below if you want to create another content store database using Cognos Content Database. This may be required if you install more than one instance of your IBM Cognos product in the test location and you want to run the instances separately.

Before you begin

Only use Cognos Content Database for test or demonstration purposes. Cognos Content Database gets a test system running quickly. When moving to a production environment with your IBM Cognos product, set up the content store to use a supported database that can be secured and tuned for performance.

Before you create the new content store, do the following:

• Install the additional instance of your IBM Cognos wsproduct in a separate directory on the same computer.
  
  Ensure that you select Cognos Content Database on the Component Selection page of the installation wizard.

• Create a new user and password for the new content store database.

Procedure

1. In the location where you installed the new instance of Cognos Content Database, in the $c10_location/derby10.1.2.1/bin directory, use the ij.bat or ij.ksh script to create a new database.

   Use the following syntax:

   ```
   connect 'jdbc:derby://host:port/db_name;create=true;user=username;password=password';
   ```

   Ensure that you use a different name, user, and password for the new content store.

   For example, to create a database named contentstore2 on the localhost computer on port number 1527 as a user named cognos2 with a password of cognos2, you would type

   ```
   connect 'jdbc:derby://localhost:1527/contentstore2;create=true;user=cognos2;password=cognos2';
   ```

   The database name is case-sensitive.

   The database files are located in the $c10_location/contentstore directory.

2. When you are finished with the ij utility, disconnect by using the following command:

   ```
   disconnect;
   ```

Configuring the SSL Protocol

The Secure Sockets Layer (SSL) protocol is used to secure communication between IBM Cognos components installed on the same computer or on different computers.
In addition, you may want to set up SSL connections between IBM Cognos components and other servers. You must ensure that SSL is set up for the other servers before you set up a shared trust between IBM Cognos components and the other servers.

Use the following checklist to configure SSL protocol.

- Configure SSL for IBM Cognos components. For more information, see "Steps to Configure SSL for IBM Cognos Components" on page 373.
- Set up shared trust between IBM Cognos components and other servers, if required. For more information, see "Set Up Shared Trust Between IBM Cognos Servers and Other Servers" on page 373.
- Select and rank Cipher Suites to be used in an SSL connection, if required. For more information, see "Select and Rank Cipher Suites for SSL" on page 374.
- Enable SSL on your Web server. For more information, see "Enable SSL on the Web Server" on page 375.

After configuring the SSL protocol, you can select and rank cipher suites, which control the quality of protection used in the SSL connection.

**Configure SSL for IBM Cognos Components**

You can configure IBM Cognos components to use the SSL protocol for

- internal connections only
- external connections only
- internal and external connections
- connections to local and remote log servers

If you configure SSL for internal connections only, IBM Cognos components on the local computer communicate using this protocol. The dispatcher listens for secure connections on a different port than for remote, http requests. Therefore, you must configure two dispatcher URIs.

If you configure SSL for external connections only, communications from remote IBM Cognos components to the local computer use the SSL protocol. You must configure the dispatcher to listen for secure, remote requests on a different port than local, HTTP requests. You must also configure the Content Manager URIs and the dispatcher URI for external applications to use the same protocol and port as the external dispatcher.

If you configure SSL for all connections, the dispatcher can use the same port for internal and external connections. Similarly, if you do not use SSL for local or remote communication, the dispatcher can use the same port for all communications.

You must also update the Content Manager URIs, Dispatcher URI for external applications, and Gateway URI to use SSL, if required.

**Tomcat Connectors**

If the internal dispatcher URI is prefixed with http but the external dispatcher URI is prefixed with https, or vice versa, both the non-SSL Coyote HTTP/1.1 and SSL Coyote HTTP/1.1 connectors are enabled in the server.xml file.
If the internal and external dispatcher URIs use different protocol or ports, the internal dispatcher port is accessible only to the components on the local computer. The internal dispatcher URI must also specify localhost.

**Single Computer Installations**

In single computer installations, if you are running IBM Cognos without SSL, you must stop the service before adding SSL to your configuration. After you save the configuration with SSL settings, you can restart the service.

**Distributed Installations**

In distributed installations, if you are using the IBM Cognos certificate authority service, you must first configure all IBM Cognos computers to use the non-secure (http) protocol before you configure IBM Cognos components to use the SSL protocol. You must do this because you cannot set up the SSL protocol before trust has been established.

Also, ensure that you follow the required order of configuring computers in a distributed environment. That means that you must first configure the computer where the default active Content Manager is installed and then start the services on this computer before you configure other computers or start services on other computers. By first configuring the default active Content Manager computer and starting the services, you ensure that the certificate authority service on the default active Content Manager computer can issue certificates to other computers in the IBM Cognos environment.

After you configure all computers in the distributed installation to use the default, non-secure protocol, test your installation to ensure that IBM Cognos components are working properly. After you test your installation, you can configure the SSL protocol.

When you configure IBM Cognos to use the SSL protocol, ensure that you first configure the default active Content Manager computer to use the protocol and start the services on the default active Content Manager computer. After you do this, you can configure the SSL protocol on other IBM Cognos computers in your environment.

**Add a Computer to an Installation**

If you add a computer to an SSL-enabled environment, you will be prompted to temporarily accept trust for a certificate when you save the configuration. Accepting the temporary certificate will allow permanent trust to be established with the Content Manager computer.

**Add a Component to a Computer**

You can later add a component to the same location as other IBM Cognos components. If you add the component to a different location on the same computer as other IBM Cognos components, you will be prompted to temporarily accept trust for a certificate when you save the configuration. Accepting the temporary certificate will allow permanent trust to be established between the new component and the Content Manager computer.
Steps to Configure SSL for IBM Cognos Components

Use this procedure to configure SSL for internal connections, external connections, or all connections.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, type the appropriate values for the Internal dispatcher URI and External dispatcher URI values:
   - To configure SSL for internal connections only, for the Internal dispatcher URI property, type https and a port for SSL communication. For the External dispatcher URI property, type http and use the default or another available port.
   If you use Tomcat, the Internal dispatcher URI property must specify localhost.
   The ports in the two dispatcher URIs must be different.
   - To configure SSL for external connections only, for the External dispatcher URI property, type https and a secure port. For the Internal dispatcher URI property, type http and use the default or another available port.
   If you use Tomcat, the Internal dispatcher URI property must also specify localhost.
   The ports in the two dispatcher URIs must be different.
   - To configure SSL for all connections, type the same URI for both the Internal dispatcher URI and External dispatcher URI properties. Type https and a secure port, such as 9343.

   Note: You do not have to use port 9343, the default SSL port. You can choose any available port.
4. Configure the SSL protocol for the other environment URIs, including the Content Manager URIs, the Dispatcher URI for external applications, and Gateway URI.
   - For internal connections only, type https in the URIs that contain localhost.
   - For external connections only, type https in the URIs that do not contain localhost.
   - For all connections, type https in all the URIs.
5. In the Explorer window, click Security > Cryptography.
6. To use SSL protocol, you must specify passwords for the IBM Cognos encryption key stores. There are more settings under Security > Cryptography > Cognos.
7. From the File menu, click Save.

Set Up Shared Trust Between IBM Cognos Servers and Other Servers

If you want to use the default IBM Cognos certificate authority and you want to use SSL for connections from other servers to IBM Cognos servers, you must add the IBM Cognos certificate to the trust store on the other servers.

Note: If you use browsers to connect to IBM Cognos components, the browsers automatically prompt users to update their trust stores.
If you want the connection between IBM Cognos servers and the other server to be mutually authenticated, you must also copy the certificate from your certificate authority to the trust store for IBM Cognos servers.

If you have configured IBM Cognos components to use another certificate authority (CA), you do not have to set up shared trust between IBM Cognos server and other servers.

**Copying the IBM Cognos certificate to another server**
The first task in adding the IBM Cognos certificate to the trust store on other servers is to copy the certificate to the server.

**Procedure**
1. Go to the `c10_location/bin` directory.
2. Extract the IBM Cognos certificate by typing the following command:
   - On UNIX or Linux, type
     ```bash
     ThirdPartyCertificateTool.sh -E -T -r destination_file -k \
     c10_location/configuration/signkeypair/jCAKeystore -p password
     ```
   - On Windows, type
     ```bat
     ThirdPartyCertificateTool.bat -E -T -r destination_file -k \
     c10_location/configuration\signkeypair\jCAKeystore -p password
     ```
3. Import the certificate to the trust store on your server.
   For information on updating the server trust store, see the documentation for your server.

**Copying the CA certificate to IBM Cognos servers**
After copying the IBM Cognos certificate to the other servers, copy the certificate from the certificate authority to the IBM Cognos server.

**Procedure**
1. Copy the certificate from your certificate authority to a secure location on the IBM Cognos server.
   Ensure that the CA certificate is in Base-64 encoded X.509 format.
2. Import the CA certificate by typing the following command:
   - On UNIX or Linux, type
     ```bash
     ThirdPartyCertificateTool.sh -T -i -r CA_certificate_file -k \
     c10_location/configuration/signkeypair/jCAKeystore -p password
     ```
   - On Windows, type
     ```bat
     ThirdPartyCertificateTool.bat -T -i -r CA_certificate_file -k \
     c10_location/configuration\signkeypair\jCAKeystore -p password
     ```

**Select and Rank Cipher Suites for SSL**
An SSL connection begins with a negotiation in which the client and server present a list of supported cipher suites in a priority sequence. A cipher suite provides the quality of protection for the connection. It contains cryptographic, authentication, hash, and key exchange algorithms. The SSL protocol selects the highest priority suite that the client and the server both support.

A list of supported cipher suites for SSL is provided. You can eliminate cipher suites that do not meet your requirements and then assign a priority, or preference, to the remaining cipher suites. The selected cipher suites are presented in priority
sequence for the client and server sides of the negotiation. At least one of the
selected cipher suites between the client and server platforms must match.

The list of supported cipher suites is dynamically generated on each computer, and
depends on the Java Runtime Environment (JRE) or whether you have other
cryptographic software installed on the computer. If you have made changes to a
computer, such as upgraded the JRE or installed software that has upgraded the
JRE, this may affect the supported cipher suites available on that computer. If you
no longer have a supported cipher suite that matches the other computers in your
environment, you may have to change the JRE on the computer to match the other
computers in your environment.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Cryptography > Cognos.
3. In the Properties window, click the Value column for the Supported
   ciphersuites property.
4. Click the edit button.
   - To move a cipher suite to the Current values list, click the check box in the
     Available values list and then click Add.
   - To move a cipher suite up or down in the Current values list, click the check
     box and then click the up or down arrows.
   - To remove a cipher suite from the Current values list, click the check box
     and then click Remove.
5. Click OK.
6. From the File menu, click Save.

**Enable SSL on the Web Server**

Enable secure sockets layer (SSL) to encrypt a user's communication with the Web
server.

To enable SSL on your Web server, you must obtain a Web server certificate signed
by a Certificate Authority and install it into your Web server. The certificate must
not be self-signed, because self-signed certificates will not be trusted by IBM
Cognos components.

To enable IBM Cognos components to use an SSL-enabled Web server, you must
have copies of the trusted root certificate (the certificate of the root Certificate
Authority which signed the Web server certificate) and all other certificates which
make up the chain of trust for the Web server's certificate. These certificates must
be in Base64 encoded in ASCII (PEM) or DER format, and must not be self-signed.
The certificates must be installed on every computer where you have installed
Application Tier Components.

For more information about installing certificates into your Web server, see your
Web server documentation.

**Procedure**

1. Configure the Web server for SSL and start the Web server.
   - For more information, see your Web server documentation
2. On each Application Tier Components computer that points to the gateway on the Web server, in IBM Cognos Configuration, change the gateway URI from HTTP to HTTPS, and save the configuration. Do not start the IBM Cognos service yet.

3. On each Application Tier Components computer, go to the c10_location/bin directory and import all the certificates that make up the chain of trust, in order starting with the root CA certificate, into the IBM Cognos trust store. Import the certificates by typing the following command:

   On UNIX or LINUX, type
   
   ThirdPartyCertificateTool.sh -T -i -r certificate_fileName -D
   ./configuration/signkeypair -p password

   On Windows, type
   
   ThirdPartyCertificateTool.bat -T -i -r certificate_fileName -D
   ./configuration/signkeypair -p password

   Note: The password should have already been set. If not, the default password is NoPassWordSet.

4. On each Application Tier Components computer, in IBM Cognos Configuration, start the IBM Cognos service.

Results

You can verify trust, by creating and running a PDF report that contains pictures that are not stored locally but which the gateway gets from a remote computer. If the pictures appear, trust is established.

To avoid being prompted by a security alert for each new session, install the certificate into one of your Web browser's certificate stores.

In addition, you may want to set up SSL connections between IBM Cognos components and other servers. You must ensure that SSL is set up for the other servers and then you must set up a shared trust between IBM Cognos components and the other servers. For more information, see “Configuring the SSL Protocol” on page 370.

Configuring a Repository for Log Messages

The BI Bus protocol includes log message processing, an important diagnostic tool for investigating the behavior of IBM Cognos BI.

In addition to error messages, log messages provide information about the status of components and a high-level view of important events. For example, log messages can provide information about attempts to start and stop services, completion of processing requests, and indicators for fatal errors. Audit logs, which are available from a logging database, provide information about user and report activity.

The IBM Cognos services on each computer send information about errors and events to a local log server. A local log server is installed in the c10_location/logs folder on every IBM Cognos BI computer that contains Content Manager or Application Tier Components. Because the log server uses a different port from the other IBM Cognos BI components, it continues to process events even if other services on the local computer, such as the dispatcher, are disabled.
The following workflow shows the tasks that are required to prepare for logging.

During planning, determine the logging configuration that is suitable for your environment. For example, evaluate various log message repositories, such as remote log servers and log files, such as the UNIX or Linux syslog or the Windows NT Event log, in addition to the local log file. You can also send only audit logging information to a database. Consider security, such as methods available for protecting log files from system failures and user tampering. For information about planning, see the Architecture and Deployment Guide.

During configuration, define the startup properties for logging, such as connection settings for databases. You must also create a logging database if you plan to collect audit logs. If communication between a local log server and a remote log server must be secured, make the appropriate configuration changes on both IBM Cognos BI computers. You can also enable certain logging features, such as user-specific logging. For information about configuring logging, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

When setting up logging, specify the level of detail to log to focus messages on the information that is relevant in your organization. Audit reports may also be set up to track user and report activity. For information about setting up logging, see the IBM Cognos Business Intelligence Administration and Security Guide.

For information about using log messages to solve problems and resolving logging-related issues, see the IBM Cognos Business Intelligence Troubleshooting Guide.

Guidelines for Creating a Logging Database

You can create a database to store log messages. Creating a logging database involves the following tasks:

- Create a logging database.
- Set up the database connectivity.
- Specify the log messages repository.

Suggested Settings for Creating the DB2 Logging Database on z/OS

The database you create must contain the specified configuration settings.

Use the following checklist to help you set up the logging database on DB2.

- Log on to the z/OS system as a user with administrator privileges in DB2 on z/OS.
- Create a database instance, storage group, and a user account for the content store. IBM Cognos uses the credentials of the user account to communicate with the database server.
- Ensure that you allocate a buffer pool with a page size of 8 KB for the database instance.
- For a logging database in DB2 on z/OS, administrators must run a tablespace script to create tablespaces to hold large objects and other data for the logging database, and then grant user rights to the table. For information about running the tablespace script, see "Create Tablespaces for DB2 Logging Database on z/OS."

Create Tablespaces for DB2 Logging Database on z/OS

A database administrator must run a script to create a set of tablespaces required for the logging database. The script must be modified to replace the placeholder parameters with ones that are appropriate for your environment.

Ensure that you use the name convention for DB2 on z/OS. For example, all names of parameters must start with a letter and the length must not exceed 6 characters. For more information, see the IBM DB2 Information Center.

Procedure

1. Connect to the database as a user with privileges to create and drop tablespaces and to allow execution of SQL statements.
2. Open the LS_tablespace_db2zOS.sql script file and use the following table to help you to replace the generic parameters with ones appropriate for your environment.

Table 33. Tablespace parameter names and descriptions for DB2 Logging Database on z/OS

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPFSCRIPT_DATABASE</td>
<td>The name of the logging database.</td>
</tr>
<tr>
<td>IPFSCRIPT_STOGROUP</td>
<td>The name of the storage group.</td>
</tr>
<tr>
<td>IPFSCRIPT_TABLESPACE</td>
<td>The name of the tablespace that contains the base tables in the logging database. This tablespace is not for Auxiliary tables.</td>
</tr>
<tr>
<td>IPFSCRIPT_LS_ID</td>
<td>The instance identifier for the audit database. This value must not be longer than two characters.</td>
</tr>
<tr>
<td>IPFSCRIPT_BP</td>
<td>The name of the 8 k buffer pool that is allocated for regular objects.</td>
</tr>
<tr>
<td>IPFSCRIPT_USERNAME</td>
<td>The user account that accesses the logging database.</td>
</tr>
</tbody>
</table>

Not all of the parameters listed are in the script, but may be added in the future.

3. Save and run the script.
4. Grant the IBM Cognos user rights to the tablespaces that were created when you ran the LS_tablespace_db2zOS.sql script file:
   - Open the LS_rightsGrant_db2zOS.sql script file, which is located in the $c10_location/configuration/schemas/logging/db2zOS directory.
   - Replace the parameter values with those that are appropriate for your environment.

   **Tip:** Ensure you use the same values that you used when you created the buffer pools and user account.
Save and run the LS_rightsGrant_db2zOS.sql script.

Results

The logging database is created.

**Database Connectivity for the Logging Database**

After you create a database for audit logs, additional steps are required to set up the database client if you use Oracle, DB2, Informix Dynamic Server, or Sybase as the database server.

You cannot use Cognos Content Database as a logging database.

**Note:** In a distributed environment, the local log server on an Application Tier Component computer may send log messages to a remote log server, which then sends messages to the logging database. For Oracle, Sybase, and DB2, the appropriate JDBC driver and database client software (DB2 only) is required only on the Application Tier Components computer with the remote log server that connects to the logging database.

**Microsoft SQL Server Database**

If you use a Microsoft SQL Server database, the JSQLConnect.jar file is installed to the appropriate location by default. The only additional step is to ensure that the Microsoft SQL Server uses TCP/IP connectivity.

**Set Up the Database Connectivity for an Oracle Logging Database**

You must set up the JDBC driver on all Application Tier Components computers with a connection to the logging database. You must also set up the JDBC driver on the Content Manager computer, unless you are using the same type of database for the log messages as you use for the content store.

**Procedure**

1. On the computer where Oracle is installed, go to the `ORACLE_HOME/jdbc/11b` directory.
2. Copy the correct library file for your version of the Oracle client to the `c10_location\webapps\p2pd\WEB-INF\11b` directory on the computer where Content Manager or Application Tier Components are installed.
   - If you are using Oracle 10g, you must have ojdbc14.jar.
   - If you are using Oracle 11g, you must have ojdbc5.jar.
   - The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.

**Set Up the Database Connectivity for a DB2 Logging Database on UNIX, Linux, or Windows**

You must set up the database client software and the JDBC driver on all Application Tier Components computers with a connection to the logging database. You must set up the database client software and the JDBC driver on the Content Manager computer, unless you are using the same type of database for the log messages as you use for the content store. You must choose whether to use the type 2 or type 4 JDBC driver depending on how you want to connect to the logging database.
**Procedure**

1. If you are using type 2 JDBC connectivity, install the DB2 client software on the Content Manager computers.
   - If you use type 4 JDBC connectivity for DB2, you are not required to install the DB2 client software where Content Manager is installed.
   - For more information about the differences between type 2 and type 4 drivers, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 132.

2. If you are using type 2 JDBC connectivity, and the logging database is on a different computer than log server, configure a database alias to the logging database.
   - On Windows, run the DB2 Client Configuration Assistant.
   - On UNIX or Linux operating systems, use the DB2 command line interface.

   **Note:** If the logging database and log server are on the same computer, the logging database name automatically becomes the alias.

3. On Windows, stop the DB2 services and the HTML Search Server.

4. Copy the following files from the `DB2_installation/sqllib/java` directory to the `c10_location/webapps/p2pd/WEB-INF/lib` directory.
   - the universal driver file, `db2jcc.jar`
   - the license file
     - for DB2 on Linux, UNIX, or Windows, `db2jcc_license_cu.jar`
     - for DB2 on z/OS, `db2jcc_license_cisuz.jar`

   **Tip:** To check the driver version, run the command `java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version`.

5. On Windows, restart the DB2 services and the HTML Search Server.

6. Repeat this entire procedure on the IBM Cognos computers where the software must be installed.

**Set Up the Database Connectivity for a DB2 Logging Database on z/OS**

You must set up the database client software and the JDBC driver on all Application Tier Components computers with a connection to the DB2 logging database. You must set up the database client software and the JDBC driver on the Content Manager computer, unless you are using the same type of database for the log messages as you use for the content store. You must use type 4 JDBC connectivity.

If you are using a DB2 database on a z/OS operating system for the logging database, you must use type 4 JDBC connectivity.

The driver version must be at least JCC 3.7 from Linux or UNIX operating system, or Microsoft Windows operating system version 9.1 fix pack or JCC 3.42 from Linux, UNIX, or Windows version 9.5 fix pack 2.

**Procedure**

1. Go to the `DB2_installation/sqllib/java` directory.

2. Copy the following files to the `c10_location/webapps/p2pd/WEB-INF/lib` directory and `c10_location/bin` directories.
   - the universal driver file, `db2jcc.jar`
   - the license file, for example, `db2jcc_license_cisuz.jar`
Set Up the Database Connectivity for an Informix Logging Database
You must set up the JDBC driver on all Application Tier Components computers with a connection to the logging database. You must also set up the JDBC driver on the Content Manager computer, unless you are using the same type of database for the log messages as you use for the content store.

Procedure
1. On the computer where Informix is installed, go to the Informix_location/sql1ib/java directory.
2. Copy the following files to the c10_location/webapps/p2pd/WEB-INF/lib directory on every computer where Application Tier Components are installed.
   - the universal driver file, db2jcc.jar
   - the license file, db2jcc_license_cisuz.jar

Set Up the Database Connectivity for a Sybase Logging Database
You must set up the JDBC driver on all Application Tier Components computers with a connection to the logging database. You must also set up the JDBC driver on the Content Manager computer, unless you are using the same type of database for the log messages as you use for the content store.

Procedure
1. On the computer where Sybase is installed, enable the JDBC driver using the following script:
   Sybase_location/jConnect-6/sp/sql_server12.5.sql
2. Go to the Sybase_location/jConnect-6/classes directory.
3. Copy the jconn3.jar file to the c10_location/webapps/p2pd/WEB-INF/lib directory on the appropriate Content Manager or Application Tier Components computers.

Log Message Repositories
A local log server is automatically installed when you install Content Manager or the Application Tier Components. You can specify one or more repositories where the local log server sends log messages:

- remote log server
- file
- database
- UNIX or Linux syslog or the Windows NT Event log

For information about log messages, see the Architecture and Deployment Guide.

Remote Log Server
In a distributed installation, you can configure the log server on each IBM Cognos computer to send log messages to a single remote log server, which acts as a common log server. You can then configure the common log server to send the log messages to a local file or database on the same or different computer.

If the remote log server becomes unavailable, log messages are redirected to recovery files on the local computer in the c10_location/logs/recovery/remote directory. These recovery files have timestamp information in their file names, and
are not readable like regular log files. When the remote log server becomes available, an automatic recovery process moves all log information to the remote log server and deletes the local log files.

**File**

The log server is configured by default to send log messages to the `c10_location/logs/cogserver.log` file. If the default log file does not exist when the IBM Cognos service starts, it is created automatically.

You can configure the log server to send log messages to a different file. If you configure a different log file, IBM Cognos attempts to automatically create this file on startup, in addition to the default log file. If the location for the configured log file is different from the `c10_location/logs` directory, you must ensure the path to the log file exists before starting the IBM Cognos service. For example, if you configure the log server to send messages to the `/usr/lpp/logfiles/cognos.log` file, IBM Cognos attempts to automatically create the `cognos.log` file in the `/usr/lpp/logfiles` folder. If this folder does not exist, IBM Cognos does not create the `cognos.log` file and no log messages can be recorded in it. Note that these log messages are not recorded in the default log file. Although IBM Cognos automatically creates the default log file even when another log file is configured, the default log file is not used as a backup.

**Database**

The log server can also send audit logs to a database on the same or another computer. Audit logs provide information about user and report activity.

The logging database has the same configuration and user account requirements as the content store database. After you configure IBM Cognos components to send messages to a logging database, and restart the IBM Cognos service, IBM Cognos components create the required tables and table fields. You can test the connection to the logging database before you restart the IBM Cognos service.

**Specify the Log Messages Repository for DB2 on UNIX, Linux, or Windows**

You can configure a type of repository for the log messages, and then configure properties for the specific repository. You can also configure more than one repository for log messages.

**Before you begin**

Before you specify a database as a repository, ensure that you

- created the logging database
- set up the database client

**Procedure**

1. On the computer where you installed Content Manager or the Application Tier Components, start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click Logging.
3. In the Properties window, use the following table to help set the log server properties.
Table 34. Log server properties

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use TCP between IBM Cognos components on a computer and its local log server</td>
<td>Set the Enable TCP property to True. UDP provides faster communication with a lower risk of lost connections than TCP. However, the risk of losing a local TCP connection is low. TCP is always used for communication between a local log server and a remote log server.</td>
</tr>
<tr>
<td>Change the number of threads available to the local log server</td>
<td>Type the value in the Local log server worker threads property. Keep the default value of 10. The range is between 1 and 20. However, if you have a high number of log messages, you can allocate more threads to improve performance.</td>
</tr>
</tbody>
</table>

4. In the Explorer window, under Environment, right-click Logging, and click New resource > Destination.
5. In the Name box, type the name of the repository.
6. In the Type list, click the type of repository and then click OK.
7. If the repository is a file, in the Properties window, type the appropriate values for the mandatory and optional properties.
8. If the repository is a remote log server, in the Properties window, type the appropriate values for the mandatory and optional properties.
   - If the Internal dispatcher URI of the repository computer is configured to use SSL, in the Properties window, set the Enable SSL property to True. You must later specify the log messages repository when you configure the remote log server.
9. If the repository is a database, in the Explorer window, under Logging, specify the type of database and its properties, as follows:
   - Right-click the database name, and click New resource > Database.
   - In the Name box, type the name of the repository.
   - In the Type list, click the type of database and then click OK.
   - In the Properties window, type the appropriate values for the mandatory and optional properties.
     - For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     - To connect to a named instance, you must specify the instance name as a JDBC URL property or a data source property. For example, you can type <instance1> if no instance name property is specified, a connection to the default instance is created.
     - Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required

- Test the connection to the new database. In the Explorer window, under Environment, right-click Logging and click Test.

IBM Cognos components connect to the database. If you configured more than one database for logging messages, IBM Cognos components test all the databases.

10. Repeat steps 5 to 10 for each repository to which you want the log server to send messages.

11. From the File menu, click Save.

12. In the Explorer window, click IBM Cognos services > IBM Cognos.

13. From the File menu, click Restart.

If you selected a database as the repository, IBM Cognos components create the required tables and fields in the database that you created.

Results

If the repository was a remote log server, configure and start the remote log server. Then restart the IBM Cognos service on the local computer.

If the repository was a database, you can use IBM Cognos components to run log reports from the database.

You can also set the logging level, which controls the amount of detail and type of messages that are sent to a log file or database. For instructions, see the Administration and Security Guide.

Specify the Log Messages Repository for DB2 on z/OS

You can configure a type of repository for the log messages, and then configure properties for the specific repository. You can also configure more than one repository for log messages.

Procedure

1. On the computer where you installed Content Manager or the Application Tier Components, start IBM Cognos Configuration.

2. In the Explorer window, under Environment, click Logging.

3. In the Properties window, use the following table to help set the log server properties.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use TCP between IBM Cognos components on a computer and its local log server</td>
<td>Set the Enable TCP property to True.</td>
</tr>
<tr>
<td></td>
<td>UDP provides faster communication with a lower risk of lost connections than TCP.</td>
</tr>
<tr>
<td></td>
<td>TCP is used for communication between a local log server and a remote log server.</td>
</tr>
</tbody>
</table>
Table 35. Log server properties (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the number of threads available to the local log server</td>
<td>Type the value in the <strong>Local log server worker threads</strong> property. Keep the default value of 10. The range is between 1 and 20. However, if you have a high number of log messages, you can allocate more threads to improve performance.</td>
</tr>
</tbody>
</table>

4. In the **Explorer** window, under **Environment**, right-click **Logging**, and click **New resource > Destination**.
5. In the **Name** box, type the name of the repository.
6. In the **Type** list, click **Database** and then click **OK**.
7. In the **Explorer** window, under **Logging**, right-click the database name, and click **New resource > Database**.
8. In the **Name** box, type the name of the repository.
9. In the **Type** list, click **DB2 database** and then click **OK**.
10. In the **Properties** window, type the **Database server and port number**, **User ID and password**, and the **z/OS Database name**. Ensure that the User ID is the same as the value you specified for the **IPFSCRIPT_USERNAME** parameter in the **LS_tablespace_db2zOS.sql** script file “Create Tablespaces for DB2 Logging Database on z/OS” on page 378.
11. In the **Explorer** window, click **Local Configuration**.
12. In the **Properties** window, next to **Advanced properties**, click inside the **Value** box, and then click the edit button.
13. Click **Add**, and then add the configuration parameter names and values from the following table:

   **Table 36. Configuration parameter names and values**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPFSCRIPT_CREATE_IN</td>
<td>The base tables location.</td>
</tr>
<tr>
<td></td>
<td>For example, ( \text{databaseName.baseTablespaceName} )</td>
</tr>
<tr>
<td>IPFSCRIPT_STOGROUP</td>
<td>The name of the storage group.</td>
</tr>
<tr>
<td>IPFSCRIPT_DATABASE</td>
<td>The name of logging database.</td>
</tr>
<tr>
<td>IPFSCRIPT_LS_ID</td>
<td>The instance identifier for the audit database. This value must not be longer than two characters.</td>
</tr>
</tbody>
</table>

14. From the **File** menu, click **Save**.
15. Test the connection to the new database. In the **Explorer** window, under **Environment**, right-click **Logging** and click **Test**.
   IBM Cognos components connect to the database. If you configured more than one database for logging messages, IBM Cognos components test all the databases.
Specify the Log Messages Repository for Informix

You can configure a type of repository for the log messages, and then configure properties for the specific repository. You can also configure more than one repository for log messages.

Procedure

1. In the Explorer window, under Environment, click Logging.
2. In the Properties window, use the following table to help set the log server properties.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use TCP between IBM Cognos components on a computer and its local log server</td>
<td>Set the Enable TCP property to True.</td>
</tr>
<tr>
<td></td>
<td>UDP provides faster communication with a lower risk of lost connections than TCP.</td>
</tr>
<tr>
<td></td>
<td>TCP is used for communication between a local log server and a remote log server.</td>
</tr>
<tr>
<td>Change the number of threads available to the local log server</td>
<td>Type the value in the Local log server worker threads property.</td>
</tr>
<tr>
<td></td>
<td>Keep the default value of 10. The range is between 1 and 20. However, if you have a high number of log messages, you can allocate more threads to improve performance.</td>
</tr>
</tbody>
</table>

3. In the Explorer window, under Environment, right-click Logging, and click New resource > Destination.
4. In the Name box, type the name of the repository.
5. In the Type list, click Database and then click OK.
6. In the Explorer window, under Logging, right-click the database name, and click New resource > Database.
7. In the Name box, type the name of the repository.
8. In the Type list, click Informix Dynamic Server database and then click OK.
9. In the Properties window, type the values for Database server and port number, User ID and password, and Database name.
10. If you have multiple instances of an Informix logging database, create the advanced property IPFSCRIPTIDX and specify the account under which the instance runs:
    - In the Explorer window, click Local Configuration.
    - In the Properties window, click the Value column for Advanced properties and then click the edit button.
    - In the Value - Advanced properties dialog box, click Add.
    - In the Name column, type IPFSCRIPTIDX.
    - In the Value column, type the user ID of the account under which the instance of the logging database runs.
    - Use a different user account for each instance of Informix logging database.
• Repeat in every instance of IBM Cognos Configuration that uses an instance of an Informix logging database.

11. From the File menu, click Save.

12. Test the connection to the new database. In the Explorer window, under Environment, right-click Logging and click Test. IBM Cognos components connect to the database. If you configured more than one database for logging messages, IBM Cognos components test all the databases.

Enabling User-specific Logging
When diagnosing problems, you can temporarily set logging to track one or more specific users instead of all users at once. After you complete the diagnosis, you can resume normal logging. To enable user-specific logging, you use IBM Cognos Configuration to configure connection information for Java Management Extensions (JMX) a technology that supplies tools to manage and monitor applications and service-oriented networks. Then you configure JMX connection information in a deployment properties file.

After enabling user-specific logging for IBM Cognos components, enable logging for a specific user by using the Remote Process service for JMX. For information, see the topic about using logging to diagnose a problem for a specific user in the Administration and Security Guide.

You must install Oracle Java SE Development Kit or Java Software Development Kit for IBM before you can enable user-specific logging.

Configure JMX Connection Information using IBM Cognos Configuration
Configure JMX connection information in IBM Cognos Configuration by specifying a cookie value and then setting the JMX port and credentials.

Procedure
1. On the computer where Content Manager is installed, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, configure the JMX properties under Dispatcher Settings:
   • For External JMX port, type an available port number.
   • For External JMX credential, click the edit button in the Value column, type a user ID and password, and then click OK.
     The user ID and password ensure that only an authorized user can connect to the Java environment to specify the user or users to be logged, using the port specified in External JMX port.
4. Save the configuration.

Configure JMX Connection Information in a Deployment Properties File
To support the JMX settings on your application server, specify the JMX port in the p2pd deployment properties file.
Procedure

1. In a text editor, open the p2pd.deploy_defaults.properties file located at
   c10_location/webapps/p2pd/WEB-INF.
2. Uncomment the rmiregistryport line and set the value to the External JMX
   port that you configured in IBM Cognos Configuration.
4. Restart the services for IBM Cognos.

Results

IBM Cognos now supports logging for one or more specific users. For more
information, see the topic about using logging to diagnose a problem for a specific
user in the Administration and Security Guide.

Changing Global Settings

By default, IBM Cognos components ensure that all locales, which may come from
different sources and in various formats, use a normalized form. That means that
all expanded locales conform to a language and regional code setting. Each
computer has a default system locale and one user locale per user. The user locales
may be different from the default system locale. If you change global settings on
one Content Manager computer, you must make the same changes on the other
Content Manager computers.

You change global settings
  • to customize language support for the user interface
  • to customize currency support
  • to customize content locale support
  • to map the language used in the product user interface
  • to map content locales
  • to add fonts to your IBM Cognos environment
  • to customize the default time zone
  • to change the encoding for email messages
  • to customize cookie settings

Customize Language Support to the User Interface

Use the Product Locales table to add or remove the user interface language
support. For example, if you do not require a German user interface, you can
remove the language from the list.

If you change the user interface language of the product, data is not affected.

If you want users to see product documentation in a language other than English,
you must install the Supplementary Language Documentation. For more
information, see “Translated Product Documentation” on page 293.

Before you begin

Ensure that you install the appropriate fonts to support the character sets and
currency symbols you use. For Japanese and Korean currency symbols to appear
correctly, you must install the additional fonts from the Supplementary Language
Documentation disk.
Procedure
1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Product Locales tab.
   All supported locales are displayed.
4. Click Add.
   Tip: To remove support, select the check box next to the Supported Locale and then click Remove.
5. In the second column, type the language portion of a locale.
6. Repeat steps 3 to 5 for other language support that you want to add.
7. Click OK.
8. From the File menu, click Save.

Customizing Currency Support
If you require additional currencies or want to remove some from the user interface, you can update the list of supported currencies in the Currencies table. If you use Japanese or Korean currencies, you must configure support so that Japanese Yan and Korean Won characters display correctly.

By default IBM Cognos components show only a subset of supported currencies in the user interface. Currencies are identified by their ISO 4217 currency code. The complete list of supported currencies that can be added are listed in the i18n_res.xml file in the c10_location/bin directory.

Adding currencies to the IBM Cognos environment does not guarantee that your computer has a font with the required characters to display the currency. Ensure that you install the appropriate fonts to support the currency symbols you use. For example, to display the Indian currency symbol (rupee) correctly, you must install a font that contains that character. In addition, for Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk.

Add Currencies to the User Interface
You can add supported or unsupported currencies to the user interface. You add supported currencies in IBM Cognos Configuration. You add unsupported currencies to the i18n_res.xml file that is provided in IBM Cognos.

If you add a currency code that is not supported by IBM Cognos, you must manually add it to the i18n_res.xml file in the c10_location/bin directory. Copy this file to each IBM Cognos computer in your installation.

Procedure
1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Currencies tab.
4. Click Add.
   Tip: To remove support, select the check box next to the supported item and then click Remove.
5. In the second column, type an appropriate value.
The value you add must comply with ISO 4217 codes for the representation of currencies and formats. Usually the value you add is a three-letter alphabetic code. The first two characters are letters representing the ISO 3166 country or region code for the country or region the currency is from. The additional letter represents the first letter of the currency.

6. Repeat steps 3 to 5 for other types of support that you want to add.
7. From the File menu, click Save.

**Customize Content Locale Support**

To ensure users see reports, data or metadata in their preferred language, or specific to their region, you can add partial locales (language) or complete locales (language-region) to the Content Locales table. This way, if content is available in different languages, or in different locales, it is rendered to users based on their user locale. By default, content locale overrides product locale in the portal for some content.

If you view reports in Thai language, digits are not supported.

**Before you begin**

If a locale is not required, you can remove it from the list. You must leave at least one content locale in the list for the Application Tier Components to operate.

Adding incomplete locales (languages) to the IBM Cognos environment does not guarantee that your computer has a font that can display Web pages in your preferred languages. Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk. For more information, see “Additional Language Fonts” on page 293.

**Procedure**

1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Content Locales tab.
   - All supported locales are displayed.
4. Click Add.
   - Tip: To remove support, select the check box next to the supported item and then click Remove.
5. In the second column, type an appropriate value.
   - To add language support for report data and metadata, type a partial local (language) setting.
   - To add support specific to a region, type a complete locale (language-region) setting.
6. Repeat steps 3 to 5 for each additional locale that you want to support.
7. From the File menu, click Save.
Content Locales

Use the Content Locale Mappings table to map user locales to a complete (language-region) or partial (language) locale. You can also map a user's preferred language to another language if content is not available in the user's preferred language.

For example, if a report or scorecard is not available in a preferred language, for example Vietnamese, but is available in French and German, you can use the Content Mappings table to map the preferred language (Vietnamese) to another language (French or German). This way, you see the report or scorecard in the mapped language.

By default, the Content Locale Mappings table includes locales that do not contain the region. This allows you to use only the language portion of the locale when you specify locale settings and ensures that you always see the correct information. For example, in a multilingual database, data is usually available in different languages, such as French (fr), Spanish (es) and English (en), rather than being available in different locales, such as English Canada (en-ca), English United States (en-us), or French France (fr-fr).

The following examples show the method that IBM Cognos components use to determine which report or scorecard the user sees if the multiple language versions are available.

Example 1

A report is available in Content Manager in two locales, such as en-us (English-United States) and fr-fr (French-France), but the user locale is set to fr-ca (French-Canadian). IBM Cognos uses the locale mapping to determine which report the user sees.

First, IBM Cognos checks to see if the report is available in Content Manager in the user's locale. If it is not available in the user's locale, IBM Cognos maps the user's locale to a normalized locale configured on the Content Locale Mapping tab. Because the user's locale is fr-ca, it is mapped to fr. IBM Cognos uses the mapped value to see if the report is available in fr. In this case, the report is available in en-us and fr-fr, not fr.

Next, IBM Cognos maps each of the available reports to a normalized locale. Therefore, en-us becomes en and fr-fr becomes fr.

Because both report and the user locale maps to fr, the user having the user locale fr-ca will see the report saved with the locale fr-fr.

Example 2

The user's locale and the report locales all map to the same language. IBM Cognos chooses which locale to use. For example, if a user's locale is en-ca (English-Canada) and the reports are available in en-us (English-United States) and en-gb (English-United Kingdom), IBM Cognos maps each locale to en. The user will see the report in the locale setting that IBM Cognos chooses.


Example 3

The report and the user locales do not map to a common language. IBM Cognos chooses the language. In this case, you may want to configure a mapping. For example, if a report is available in en-us (English-United States) and fr-fr (French-France), but the user locale is es-es (Spanish-Spain), IBM Cognos chooses the language.

Map Content Locales

Use the Content Locale Mappings table to map user locales to a complete (language-region) or partial (language) locale. You can also map a user's preferred language to another language if content is not available in the user's preferred language.

Procedure

1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Content Locale Mapping tab.
4. Click Add.
5. In the Key box, type the user locale:
   - To ensure all regions for a user locale see content in a specific language, type the language portion of the locale, followed by a dash (-) and an asterisk (*).
     For example, type fr- *
   - To ensure a user locale (language-region) sees content in a specific language, type the complete locale.
     For example, type fr-ch
   - To map a preferred language to another language, type the preferred language portion of the locale.
     For example, type zh

   Tip: To specify the locale to use for a range of keys, use the wildcard character (*) with the Key value and then, in the Locale Mapping box, type the locale.
     For example, if you want all the German keys to use the German locale, type de* in the Key box and type in the Locale Mapping box.
6. In the Locale Mapping box, type the language portion of the locale.
   User locales specified in the Key box will see content in this language.
7. Repeat steps 3 to 5 for other mappings you want to do.
8. Click OK.
9. From the File menu, click Save.

Map Product Locales

Use the Product Locale Mappings table to specify the language used in the user interface when the language specified in the user’s locale is not available.

You can ensure that all regions for a locale use the same language, or that a specific, complete locale (language-region) uses a particular language.

By default, the user sees the product interface in the language that matches the language setting of the user locale.
Procedure
1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the Product Locale Mappings tab.
4. Click Add.
5. In the Key box, type the user locale:
   • To ensure all regions for a locale see the user interface in a specific language, type the language portion of the locale, followed by a dash (-) and an asterisk (*).
     For example, type es-*
   • To ensure a complete locale (language-region) see the user interface in a specific language, type the complete locale.
     For example, type es-es
   • To map a preferred language to another language, type the preferred language portion of the locale.
     For example, type zh

   Tip: To specify which locale to use as the default, use the wildcard character (*) for the Key value and then, in the Locale Mapping box type the locale.
6. In the Locale Mapping box, type the language portion of the locale.
   User locales specified in the Key box will see content in this language.
7. Repeat steps 3 to 5 for other mappings you want to do.
8. Click OK.
9. From the File menu, click Save.

Customize the Server Time Zone
You can customize the time zone used by Content Manager by selecting a different server time zone in IBM Cognos Configuration.

For UNIX installations that do not support a Java-based graphical user interface, you can view the list of acceptable time zones by opening IBM Cognos Configuration on the Windows computer where Framework Manager is installed.

Content Manager is configured to use the time zone of your operating system by default. All scheduled activities in IBM Cognos are set using this time zone. In addition, users in IBM Cognos Connection use this time zone if they set their preferences for the default time zone. For more information about setting user preferences in IBM Cognos Connection, see the Administration and Security Guide.

Procedure
1. Start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. In the Global Configuration window, click the General tab.
4. Click the Value column for Server time zone and select another time zone from the list.
5. From the File menu, click Save.

Encoding for Email Messages
By default, IBM Cognos components use UTF-8 encoding in emails. This value sets the default encoding used by the delivery service in this instance for all email
messages. You may have older email clients or send email from IBM Cognos to cell phones and PDAs that do not recognize UTF-8. If so, you can change the email encoding to a value that works on all your email clients (for example, ISO-8859-1, Shift-JIS). Each instance of IBM Cognos that has an available delivery service must be changed.

The specified encoding affects the entire message, including the subject, attachments, attachment names, and plain or HTML body text.

The encoding values are shown in the following table:

Table 38. Supported encoding values

<table>
<thead>
<tr>
<th>Character set</th>
<th>Supported encoding value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTF-8</td>
<td>utf-8</td>
</tr>
<tr>
<td>Western European (ISO 8859-1)</td>
<td>iso-8859-1</td>
</tr>
<tr>
<td>Western European (ISO 8859-15)</td>
<td>iso-8859-15</td>
</tr>
<tr>
<td>Western European (Windows-1252)</td>
<td>windows-1252</td>
</tr>
<tr>
<td>Central and Eastern European (ISO 8859-2)</td>
<td>iso-8859-2</td>
</tr>
<tr>
<td>Central and Eastern European (Windows-1250)</td>
<td>windows-1250</td>
</tr>
<tr>
<td>Cyrillic (ISO 8859-5)</td>
<td>iso-8859-5</td>
</tr>
<tr>
<td>Cyrillic (Windows-1251)</td>
<td>windows-1251</td>
</tr>
<tr>
<td>Turkish (ISO 8859-9)</td>
<td>iso-8859-9</td>
</tr>
<tr>
<td>Turkish (Windows-1254)</td>
<td>windows-1254</td>
</tr>
<tr>
<td>Greek (ISO 8859-7)</td>
<td>iso-8859-7</td>
</tr>
<tr>
<td>Greek (Windows-1253)</td>
<td>windows-1253</td>
</tr>
<tr>
<td>Japanese (EUC-JP)</td>
<td>euc-jp</td>
</tr>
<tr>
<td>Japanese (Shift-JIS)</td>
<td>shift_jis</td>
</tr>
<tr>
<td>Traditional Chinese (Big5)</td>
<td>big5</td>
</tr>
<tr>
<td>Simplified Chinese (GB-2312)</td>
<td>gb2312</td>
</tr>
<tr>
<td>Korean (EUC-KR)</td>
<td>euc-kr</td>
</tr>
<tr>
<td>Korean (KSC-5601)</td>
<td>ksc_5601</td>
</tr>
</tbody>
</table>
Change Encoding for Email Messages
You can change the email encoding to a value that works on all your email clients.

Procedure
1. Start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. In the Global Configuration window, click the General tab.
4. Click the Value column for the Email Encoding property.
5. Scroll to the desired setting and click it.
6. From the File menu, click Save.

Cookie Settings
Based on the requirements of your IBM Cognos environment, you may need to modify the settings that IBM Cognos components use to create cookies. You can use IBM Cognos Configuration to customize the cookie domain, path, and secure flag.

IBM Cognos components determine the cookie domain from the HTTP request submitted by the client, which is typically a Web browser. In most network configurations, HTTP requests pass through intermediaries such as proxy servers and firewalls as they travel from the browser to IBM Cognos components. Some intermediaries modify the information that IBM Cognos components use to calculate the cookie domain, and IBM Cognos components then cannot set cookies. The usual symptom of this problem is that users are repeatedly prompted to log on. To avoid this problem, configure the cookie domain.

To set the correct value for the cookie domain, use the format and value that represents the widest coverage for the host, as listed in the following table.

Table 39. Cookie settings

<table>
<thead>
<tr>
<th>Host</th>
<th>Format for domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>computer or server</td>
<td>computer or server name (no dots)</td>
</tr>
<tr>
<td></td>
<td>Example: mycompany</td>
</tr>
<tr>
<td>suffix is .com,.edu,.gov,.int,.mil,.net, or .org</td>
<td>.name.suffix</td>
</tr>
<tr>
<td></td>
<td>(two dots)</td>
</tr>
<tr>
<td></td>
<td>Example: .mycompany.com</td>
</tr>
<tr>
<td>other</td>
<td>.name1.name2.suffix</td>
</tr>
<tr>
<td></td>
<td>(three dots)</td>
</tr>
<tr>
<td></td>
<td>Example: .travelinfo.co.nz</td>
</tr>
</tbody>
</table>
Additionally, for security, administrators can set the HTTPOnly attribute to block scripts from reading or manipulating the CAM passport cookie during a user’s session with their web browser. For more information about this attribute, see the Administration and Security Guide.

**Customize Cookie Settings**
Use IBM Cognos Configuration to customize the cookie domain, path, and secure flag.

**Procedure**
1. On each Content Manager computer, start IBM Cognos Configuration.
2. From the Actions menu, click Edit Global Configuration.
3. Click the General tab.
4. Click in the Value column under Cookie Settings for each property that you want to change and specify the new value.
   If you leave the Domain property blank, the dispatcher derives the domain from the host name of the request.
5. Click OK.

**Changing the Gateway**
To improve Web server performance, you can configure IBM Cognos to use alternate gateways that replace the default CGI program. You can use one of the following gateways:
- Microsoft Internet Server Application Programming Interface (ISAPI) for Microsoft Internet Information Services on Windows
- Apache Web Server module for Apache Web Server and IBM HTTP Server
- Servlet Gateway Java application for application servers

There is no additional Web server configuration required to use ISAPI. To access IBM Cognos components using ISAPI, in IBM Cognos Configuration, change the cognos.cgi portion of the Gateway URI property to cognosisapi.dll. Then specify the ISAPI URL, http://host_name/ibmcognos/isapi, in your browser. If you use multiple Content Managers for failover protection, configure IBM Cognos to use an ISAPI gateway instead of the default CGI gateway. Otherwise, performance may be affected after failover.

Before you change the gateway, first ensure that the default CGI gateway and your configuration work in your environment.

**Configure the Gateway for Apache Server 1.3**
IBM Cognos provides three Apache modules. Use IBM Cognos Apache module for Apache Server 1.3.x.

**Procedure**
1. Stop Apache Web Server.
2. Append the c10_location/cgi-bin directory to the appropriate environment variable:
   - On Solaris or Linux, LD_LIBRARY_PATH
   - On HP-UX, SHLIB_PATH
   - On AIX, LBPATH
3. On HP-UX PA-RISC, do the following:
• Ensure that the LD_PRELOAD environment variable contains /usr/lib/libcl2.
• Set the COG_CGIBIN_DIR environment variable to c10_location/cgi-bin.

4. Go to the Apache_installation/conf directory.
5. Open the httpd.conf file in an editor.
6. Add the following to the end of the load module list:
   LoadModule cognos_module "c10_location/cgi-bin/mod_cognos.suffix"
   where suffix is as listed in the following table:

   Table 40. Load module list settings for Configure the Gateway for Apache Server 1.3

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA®, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

7. Add the following to the end of the add module list:
   AddModule mod_cognos.cpp
8. Add the following Apache Directive:
   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"
   Alias /ibmcognos "c10_location/webcontent"
   <Directory "c10_location/webcontent">
   Options Indexes MultiViews
   </Directory>
   The <Directory> directive is optional.

   Tip: Ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias.

9. Add the following to the server status reports section:
   <Location /ibmcognos/cgi-bin/mod_cognos.suffix>
   SetHandler cognos-handler
   </Location>
   Enter the code exactly as specified, except for suffix. Replace suffix with the appropriate value from the table in step 6.

10. To enable the gateway diagnostic page, add the following to the server status reports section:
    <Location /ibmcognos/cgi-bin/diag_mod_cognos.suffix>
    SetHandler cognos-handler
    </Location>
    Enter the code exactly as specified, except for suffix. Replace suffix with the appropriate value from the table in step 6.

11. On Windows, Solaris, and AIX, add the following to the user directory section:
    <IfModule mod_cognos.cpp>
    CGIBinDir "c10_location/cgi-bin"
12. Save and close the file.
14. Users must then specify the Apache module URI in their browser, as follows:
   http://host_name:port/ibmcognos/cgi-bin/cognos_module
   The cognos_module string must be entered exactly as specified.
   For example:
   http://123.432.154.12:5562/c10/cgi-bin/cognos_module

Configure the Gateway for Apache Server 2.0 or IBM HTTP Server 6.1

IBM Cognos provides three Apache modules. Use IBM Cognos Apache 2 module for Apache Server 2.0.x and IBM HTTP Server 6.1.

Procedure
1. Stop the Web Server.
2. Append the c10_location/cgi-bin directory to the appropriate environment variable:
   - On Solaris or Linux, LD_LIBRARY_PATH
   - On HP-UX, SHLIB_PATH and LD_LIBRARY_PATH
   - On AIX, LIBPATH
3. On HP-UX PA-RISC, ensure that the LD_PRELOAD environment variable contains /usr/lib/libcl.2.
4. Go to the Webserver_installation/conf directory.
5. Open the httpd.conf file in an editor.
6. For successful portal integration, ensure that both SERVERNAME and SERVER_PORT are specified in the ServerName property.
7. Add the following to the end of the load module list:
   LoadModule cognos_module "c10_location/cgi-bin/mod2_cognos.suffix"
   where suffix is as listed in the following table:

   Table 41. Load module settings for Configure the Gateway for Apache Server 2.0 or IBM HTTP Server 6.1

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

8. Add the following Apache Directive:
   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"
   Alias /ibmcognos "c10_location/webcontent"
   <Directory "c10_location/webcontent">
   Options Indexes MultiViews

398 IBM Cognos Business Intelligence Version 10.1.1: Installation and Configuration Guide
The `<Directory>` directive is optional.

**Tip:** Ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias.

9. Add the following to the server status reports section:

```html
<Location /ibmcognos/cgi-bin/mod2_cognos.suffix>
  SetHandler cognos-handler
</Location>
```

Enter the code exactly as specified, except for `suffix`. Replace `suffix` with the appropriate value from the table in step 6.

10. To enable the gateway diagnostic page, add the following to the server status reports section:

```html
<Location /ibmcognos/cgi-bin/diag_mod2_cognos.suffix>
  SetHandler cognos-handler
</Location>
```

Enter the code exactly as specified, except for `suffix`. Replace `suffix` with the appropriate value from the table in step 6.

11. Add the following to the user directory section:

```html
<IfModule mod2_cognos.c>
  CGIBinDir "c10_location /cgi-bin"
</IfModule>
```

12. Save and close the file.

13. On HP-UX, enable searching for SHLIB_PATH by running the following command in the `Apache_installation/bin` directory:

```bash
chatr +s enable +b enable httpd
```


15. Users must then specify the Apache module URI in their browser, as follows:

```plaintext
http://host_name:port/ibmcognos/cgi-bin/cognos_module
```

The `cognos_module` string must be entered exactly as specified.

For example:

```plaintext
http://123.432.154.12:5562/c10/cgi-bin/cognos_module
```

---

**Configure the Gateway for Apache Server 2.2.x or IBM HTTP Server 7.0**

IBM Cognos provides three Apache modules. Use IBM Cognos Apache 2.2 module for Apache Server 2.2.x and IBM HTTP Server 7.1.

**Procedure**

1. Stop the Web server.

2. Append the `c10_location/cgi-bin` directory to the appropriate environment variable:
   - On Solaris or Linux, `LD_LIBRARY_PATH`
   - On HP-UX, `SHLIB_PATH` and `LD_LIBRARY_PATH`
   - On AIX, `LIBPATH`

3. On HP-UX PA-RISC, ensure that the `LD_PRELOAD` environment variable contains `/usr/lib/libcl.2`. 

Chapter 13. Configuration Options 399
4. Go to the Apache_installation/conf directory.
5. Open the httpd.conf file in an editor.
6. For successful portal integration, ensure that both SERVERNAME and SERVER_PORT are specified in the ServerName property.
7. Add the following to the end of the load module list:
   ```
   LoadModule cognos_module "c10_location/cgi-bin/mod2_2_cognos.suffix"
   ```
   where suffix is as listed in the following table:

   Table 42. Load module settings for Configure the Gateway for Apache Server 2.2.x or IBM HTTP Server 7.0

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

8. Add the following Apache Directive:
   ```
   ScriptAlias /ibmcognos/cgi-bin " c10_location /cgi-bin"
   Alias /ibmcognos " c10_location /webcontent"
   <Directory " c10_location /webcontent">
   Options Indexes MultiViews
   </Directory>
   The <Directory> directive is optional.
   **Tip:** Ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias.

9. Add the following Apache Directive:
   ```
   ScriptAlias /ibmcognos/cgi-bin " c10_location /cgi-bin"
   Alias /ibmcognos " c10_location /webcontent"
   <Directory " c10_location /webcontent">
   Options Indexes MultiViews
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
   </Directory>
   <Directory " c10_location /cgi-bin">
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
   </Directory>
   ```

10. Add the following to the server status reports section:
    ```
    <Location /ibmcognos/cgi-bin/cognos_module>
    ```
SetHandler cognos-handler
Order allow,deny
Allow from all
</Location>
Enter the code exactly as specified, including the cognos_module string.

11. To enable the gateway diagnostic page, add the following to the server status reports section:
   <Location /ibmcognos/cgi-bin/diag_cognos_module>
     SetHandler cognos-handler
     Order allow,deny
     Allow from all
   </Location>
Enter the code exactly as specified, including the diag_cognos_module string.

12. On Windows, Solaris, and AIX, add the following to the user directory section:
   <IfModule mod2_2_cognos.c>
     CGIBinDir "c10_location /cgi-bin"
   </IfModule>

13. Save and close the file.
15. Users must then specify the Apache module URI in their browser, as follows
    http://host_name:port/ibmcognos/cgi-bin/cognos_module
    The cognos_module string must be entered exactly as specified.
    For example,
    http://123.432.154.12:5562/c10/cgi-bin/cognos_module

Configure the Servlet Gateway

If you configure the IBM Cognos Servlet Gateway to run on a supported application server, your environment does not require a Web server. The application server and the IBM Cognos Servlet Gateway replace the functions provided by a Web server and other IBM Cognos gateways.

Before you build and deploy the IBM Cognos Servlet Gateway, ensure the following:

- The application server is installed and running on each computer where the servlet gateway is to be installed.
- IBM Cognos Gateway components are installed on the same system as the application server.
- The IBM Cognos dispatcher and Content Manager components are installed and running in the environment.
- The application server user account has full access permissions for the IBM Cognos installation.

Create a new UNIX or Linux group named ibmcognos. This group must contain the user that starts the application server and the user that owns the IBM Cognos files. Change the group ownership of the IBM Cognos files to the ibmcognos group, and change the file permissions for all IBM Cognos files to GROUP READABLE/WRITABLE/EXECUTABLE. For simplicity, you can also use the application server user account to install and run IBM Cognos components.
To set up the IBM Cognos Servlet Gateway to run on your application server, do the following:

1. **Create a separate JVM instance**, if necessary.
   
   If you plan to run IBM Cognos BI and the IBM Cognos Servlet Gateway on the same application server, the servlet gateway must be deployed to a separate JVM instance.

2. **Check that IBM Cognos components are properly set up**

3. **Set environment variables**

4. **Configure IBM Cognos Servlet Gateway to run on the application server**

5. **Change the application server startup script**, if necessary.

6. **Configure application server properties and deploy IBM Cognos Servlet Gateway**

7. **Enable SSL**, if required.

8. **Configure the Web server**

You can then access IBM Cognos components using the IBM Cognos Servlet Gateway, by entering the gateway URI. For example,

http[s]:host_name:port/ServletGateway

The IBM Cognos Servlet Gateway URI is case-sensitive.

---

### Change the IP Address Version

IBM Cognos supports two IP address versions: IPv4 and IPv6. IPv4 uses 32-bit IP addresses and IPv6 uses 128-bit IP addresses. For example:

- IPv4: 192.168.0.1:80
- IPv6: [2001:0db8:0000:0000:0000:148:57ab]:80

In IBM Cognos Configuration, you can select IPv4 or IPv6 for IBM Cognos communication using the **IP Version for Host Name Resolution** property. By default IPv4 is employed.

The setting applies only to the computer where it is set. If you select **Use IPv4 addresses**, all outgoing IBM Cognos connections on that computer are established using IPv4 and the dispatcher accepts only incoming IPv4 connections. If you select **Use IPv6 addresses**, all outgoing IBM Cognos connections on that computer are established using IPv6 and the dispatcher accepts both incoming IPv4 and IPv6 connections.

IPv4 client computers can communicate with dispatcher computers that are configured for IPv6.

Hostnames specified within a URI are resolved based on the value of the **IP Version for Host Name Resolution** property. However, if a URI has been specified with a numeric address, it has precedence over this setting and communication takes place using IPv4.

For IBM Cognos Configuration to accept IPv6 addresses in the local URI properties, you must start IBM Cognos Configuration with the -ipv6 option. You can specify the option each time you open IBM Cognos Configuration from the command line.
On Windows, you can set the option permanently by adding the option to the Start menu shortcut.

**Setting the IP version**

Use IBM Cognos Configuration to select the IP version.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. Click the **Value** box for **IP Version for Host Name Resolution** and click **Use IPv4 addresses** or **Use IPv6 addresses**.
4. From the **File** menu, click **Save**.
5. Close IBM Cognos Configuration.

**Manually configuring IBM Cognos Configuration to start with the IPv6 option**

You can manually configure IBM Cognos Configuration to use the IPv6 option by specifying the option in the start command.

**Procedure**

1. Go to the `c10_location/bin` directory.
2. Start IBM Cognos Configuration by including the IPv6 option in the command, as follows:
   
   - On Windows, type `cogconfig.bat -ipv6`
   - On UNIX or Linux, type `./cogconfig.sh -ipv6`
3. Edit the URI properties that use IPv6 format, specify the values, and then from the **File** menu, click **Save**.

**Configuring IBM Cognos Configuration to always start with the IPv6 option on Windows**

You can configure IBM Cognos Configuration to always use the IPv6 option on Microsoft Windows operating systems by setting the option in the Start menu shortcut.

**Procedure**

1. From the **Start** menu, select **Programs** > **IBM Cognos 10**, and then right-click **IBM Cognos Configuration, Properties**.
2. On the **Shortcut** tab, in the **Target** box, type "c10_location\bin\cogconfigw.exe -ipv6"
3. Click **OK**.

**Configuring IBM Cognos Index Search**

Index search capability is included with your IBM Cognos Business Intelligence server product as the default search capability. To use index search, you must configure the indexing services and create at least one index. If a search result includes a URL, the URL must be in a trusted domain before users can access it.
**Important:** When an index is wcreated, data collection puts an extra load on the batch report service. To manage the additional indexing needs, plan and scale the batch report services appropriately. The total number of high-affinity connections that are available for indexing must be equal to the number of CPUs that are available on the servers that host the index update service.

If you use the Google Search Appliance for enterprise search, you can integrate IBM Cognos content in Google search results. For more information, see "Configuring the IBM Cognos OneBox Components" on page 502.

To configure index search, do the following:

- Upgrade from a previous version.
- Enable the index services for a distributed installation as required.
- Configure scalability for index search.
- Ensure that any URL that might turn up in a search result is added to the list of valid hosts and domains in IBM Cognos Configuration.
- Add IBM OmniFind® Enterprise Edition search functionality to IBM Cognos applications if required.
- Create at least one index.

For more information, see the Administration and Security Guide.

**Upgrading from a Previous Version of Index Search**

If you are upgrading from a product that used IBM Cognos Go! Search and you modified your card.xml file to publish the index to third-party search engines, you must migrate these settings to the new IBM Cognos BI version.

Some versions of IBM Cognos Go! Search included a csnconfig.xml file. If you refined your index in a previous version of Go! Search, you will find equivalent functionality in IBM Cognos Administration. Take note of any custom settings before deleting the csnconfig.xml file. For more information, see the Administration and Security Guide.

**Procedure**

1. After upgrading to IBM Cognos BI, copy the card.xml file from the backup location of your older version to the $c10_location$\bin\card directory.
2. If prompted to overwrite an existing file, click Yes.

**Enabling and Disabling Index Services in a Distributed Installation**

Typically, an IBM Cognos BI installation can host one instance of the index data service, one instance of the index update service, and any number of instances of index search services. To achieve specific operational goals such as more robustness or performance, more complex configurations are possible.

In a typical distributed IBM Cognos BI installation, enable the index services and index update service enabled in the applications tier, and the index data service enabled in the data tier.

**Procedure**

1. On the server where you installed Application Tier Components in the applications tier, start IBM Cognos Configuration and do the following:
In the Explorer window, expand Environment and click IBM Cognos services.

In the Properties window, change the value for Index data service enabled to False.

Save the configuration.

2. On the server where you installed Application Tier Components in the data tier, start IBM Cognos Configuration and do the following:

In the Explorer window, expand Environment and click IBM Cognos services.

In the Properties window, change the values for Index search service enabled and Index update service enabled to False.

Save the configuration.

3. For each additional instance of the index search service, on the server where you installed additional Application Tier Components in the applications tier, start IBM Cognos Configuration and do the following:

In the Explorer window, expand Environment and click IBM Cognos services.

In the Properties window, change the values for Index data service enabled and Index update service enabled to False.

Save the configuration.

Scaling Index Search by Using Index Sharing

To scale search operation, you can deploy multiple instances of the index data service to different servers. Because searching is CPU-bound, you can achieve load balancing by introducing new servers that share the same index. This configuration is known as index sharing.

Index sharing allows multiple index data services to search and update a single index that is located on the shared file system within the distributed IBM Cognos BI environment. All index data services can search all index files.

When your installation of IBM Cognos BI includes multiple data tier servers, all instances of the index data service must be identically configured and point to a shared file system. Otherwise, you may only activate one instance of the index data service at a time.

Procedure

1. Create the root directory for your index search index on one of the servers that is part of the data tier of your IBM Cognos BI deployment.

   For example, create a directory named sharedIndex on the host "indexsearch". The path is \indexsearch\sharedIndex.

   On a Microsoft Windows operating system, shared file locations must be specified using the Universal Naming Convention (UNC). Mapped drives are not supported.

2. Share the directory and make sure that all the servers that host an index data service can access it. This is the root directory of the shared index.

3. If you are using Windows, make sure that the Windows service for IBM Cognos BI runs under a user that has read and write permissions on that shared file system.

   Select Start > Control Panel > Administrative Tools > Computer Management.
• Expand **Services and Applications** and click **Services**.
• Double-click on the IBM Cognos service that hosts the index data service.
• Select the **Log On** tab and specify a domain account that has read and write permissions on the shared file system.

4. Log on to IBM Cognos Connection as an administrator.
5. In IBM Cognos Connection, in the upper-right corner, click **Launch > IBM Cognos Administration**.
6. Click the **Index Search** tab.
7. Click **Storage**, then click **Advanced**.
8. In the **Instances** box, ensure **All** is selected.
   This applies your changes to all index data service instances within the index search environment. We recommend this for most parameters.
9. Remove the default path and type the new path to the shared index directory beside the **CSN.IndexLocation** parameter.
   For example, delete the default setting and type `\indexsearch\sharedIndex` beside **CSN.IndexLocation**.
10. If the index data service is on a UNIX operating system Network File System (NFS), add the **CSN.IndexNFSSupport** parameter to the advanced configuration settings list and set the value to true.
11. Click **Save**.

### Adding IBM OmniFind Enterprise Edition Search Functionality to IBM Cognos Applications

If you plan to use IBM OmniFind Enterprise Edition with IBM Cognos BI, you must add the IBM Search and Index API (esapi.jar and siapi.jar files) to the IBM Cognos installation.

For more information about integrating IBM Cognos Applications with another search engine, see the IBM Cognos **Administration and Security Guide**.

Adding the IBM Search and Index API is not required if you plan to use IBM OmniFind Yahoo Edition.

#### Before you begin

IBM OmniFindEnterprise Edition product should already be installed and configured with a searchable collection (index).

#### Procedure

1. On the computer where the IBM OmniFindEnterprise Edition product is installed, go to the `OmniFind_installation_location\lib` directory.
2. Locate the esapi.jar and siapi.jar files and copy them into the `IBM_Cognos_installation_location\webapps\p2pd\WEB-INF\lib` directory on each computer where the index search service is enabled.

### Configuring the Collaboration Discovery URI

You can configure IBM Cognos Business Intelligence and IBM Cognos Business Insight to use IBM Connections for collaborative decision-making. Integration with IBM Connections allows business users to collaborate while creating or viewing reports, performing analysis, or monitoring workspaces. Users have access to IBM
Connections activities from within Business Insight and to the IBM Connections homepage from within IBM Cognos BI and Business Insight.

The Collaboration discovery URI specifies the IBM Connections server to use as the collaboration provider. When a URI is specified, collaboration-related support is added to IBM Cognos BI as follows:

- a link is added to the Cognos Connection Welcome page. If the user has access to the IBM Connections homepage, the link is named Access my social network and links the user to the homepage. If the user has access to IBM Connections activities, but not the homepage, the link is named My Activities and links the user to the activities page.
- a link to the IBM Connections homepage is added to the Launch menu in Cognos Connection
- a link to the IBM Connections homepage is added to the Actions menu in Business Insight
- the Collaborate menu button is added on the workspace application bar in Business Insight. This allows the user to create or view a workspace activity in IBM Connections.

**Procedure**

1. Start IBM Cognos Connection.
2. In the upper-right corner, click Launch, IBM Cognos Administration.
3. On the Configuration tab, click Dispatchers and Services to view the list of dispatchers.
4. From the toolbar in the upper-right corner of the page, click the set properties - configuration button.
5. Click the Settings tab.
6. For the Environment category, Collaboration discovery URI, specify the URI as follows:
   - `http://server_name:port_number/activities/serviceconfigs`
   - For example, `http://server_name:9080/activities/serviceconfigs`
   - where `server_name` represents the server name where IBM Connections is installed.
7. Click OK.

---

### Configuring IBM Cognos Business Insight

IBM Cognos Business Insight is included with IBM Cognos BI server. It delivers dynamic and customizable features that allow you to quickly and easily assemble interactive workspaces using IBM Cognos content, as well as external data sources. After you test that Business Insight is running, configure access to the secured functions and features.

Complete the following configuration tasks.

- Test IBM Cognos Business Insight
- Configure access to IBM Cognos Business Insight
- Configure Supported MIME Types in Microsoft Internet Information Services

After the configuration tasks are completed, you can perform the following tasks as required:

- Set up a database for annotations
Configure Business Insight to use metric objects
Configure Business Insight to use content from a TM1 Data Server
Configure Business Insight to access IBM Cognos TM1 Contributor
Change styles in your reports
Use the samples

Testing IBM Cognos Business Insight

You can test IBM Cognos Business Insight any time after the IBM Cognos service is started.

Procedure
1. Open a browser and log in to IBM Cognos Connection.
2. Click the new workspace button in the toolbar.
   - If an IBM Cognos Business Insight blank workspace canvas appears, the service started successfully.
3. If reports are available, expand a report folder into parts and drag a part onto the canvas.
   - If the report opens, IBM Cognos Business Insight is running properly.

Configuring Access to IBM Cognos Business Insight or its Functions

Configure access to IBM Cognos Business Insight by granting required permissions for the Executive Dashboard capability to specified namespaces, users, groups, or roles.

You can grant full access to IBM Cognos Business Insight or you can grant access only to the publishing function.

IBM Cognos BI must be configured and operating before you can configure access for IBM Cognos Business Insight.

Granting Full Access to IBM Cognos Business Insight

To grant access to IBM Cognos Business Insight and all its functionality, grant execute and traverse permissions for the Executive Dashboard capability.

Procedure
1. In IBM Cognos Connection, in the upper-right corner, click Launch, IBM Cognos Administration.
2. On the Security tab, click Capabilities.
3. Find the Executive Dashboard capability, click the actions button next to the capability name, and then select Set properties.
4. Select the Permissions tab.
5. Grant Execute permission to all user groups that should have access to IBM Cognos Business Insight, and then click OK.
Granting Access to the Publishing Function within IBM Cognos Business Insight

To grant access only to the publishing function within IBM Cognos Business Insight, grant traverse permissions for the Executive Dashboard capability and execute permissions for the Publish Dashboards to Collaboration Spaces secured function.

Procedure
1. In IBM Cognos Connection, in the upper-right corner, click Launch, IBM Cognos Administration.
2. On the Security tab, click Capabilities.
3. Find and select the Executive Dashboard capability.
4. Click the actions button next to Publish Dashboards to Collaboration Spaces, and click Set properties.
5. Select the Permissions tab.
6. To set access permissions explicitly for each entry, select the Override the access permissions acquired from the parent entry.
7. For each user group, select the check box beside the entry, and in the box next to the list, select the check boxes to grant permissions for the entry.
8. To add new entries to the list, click Add and choose how to select entries:
   - To choose from available entries, click the appropriate namespace, and then select the check boxes next to the users, groups, or roles.
   - To search for entries, click Search and in the Search string box, type the phrase you want to search for. For search options, click Edit. Find and click the entry that you want.
   - To type the name of entries that you want to add, click Type and type the names of groups, roles, or users using the following format, where a semicolon (;) separates each entry: namespace/group_name/namespace/role_name/namespace/user_name;
   You can then grant the appropriate permissions for each new entry.
9. Click OK.

Configuring Supported MIME Types in Microsoft Internet Information Services

If you use Microsoft Internet Information Services (IIS) 6.0, then for IBM Cognos Business Insight to load successfully, you must define the MIME type that Business Insight uses.

Procedure
1. Open the Microsoft IIS management console.
2. Right-click the local computer name, and click Properties.
3. Click MIME Types.
4. Click New.
5. In the Extension box, type .cfg.
6. In the MIME Type box, type text/plain.
7. Apply the new settings.
The changes will take effect when the worker process recycles. To avoid waiting, you can restart the World Wide Web Publishing Service. For more information, search the Microsoft online library for "Handling MIME Types in Internet Explorer".

Setting Up a Database for Human Tasks and Annotations

By default, the data used for the Human Tasks and Annotations feature in IBM Cognos Business Insight is stored in the same database as the content store. You can configure a separate database for Human Tasks and Annotations.

To set up the database, you must first create the database, create a user account under which the database will operate, and then configure the Human Tasks and Annotations feature to use the new database.

Procedure

1. Create a database using the same instructions as “Guidelines for Creating the Content Store” on page 60.
2. Create a user account that will be used to operate the database.
3. On the report server, where Application Tier Components are installed, start IBM Cognos Configuration.
4. In the Explorer, right-click Human Task and Annotation Services and select New resource > Database.
5. In the New Resource - Database dialog box, type a name for the database, select the type, and then click OK.
6. In the database resource properties window, configure the following:
   - Specify the mandatory values for all properties that are marked with an asterisk.
   - Specify the User ID and password for the account that operates the database.
7. From the File menu, click Save. The logon credentials are immediately encrypted.
8. To test the connection to the new database, from the Actions menu, click Test.
9. Repeat these steps on each report server and Content Manager computer.

Metric Objects in IBM Cognos Business Insight

By default, a Metric Studio contribution file is provided with IBM Cognos BI server, and metric objects appear in the Business Insight workspaces. If your product includes the IBM Cognos Metrics Manager and the metric service is enabled, you can access the objects from Metric Studio in your workspaces.

If your product does not include Metrics Manager, remove the Metric Studio contribution file. Otherwise, any metric package that exists continues to display in the Business Insight content pane, and attempts to access it will produce an error message.

Whether the Metric Studio contribution file is present or not, published metric packages always display in the IBM Cognos Business Insight workspaces. If the contribution file is present, metric application content appears in the Business Insight content pane. This content includes watchlist, scorecards, metrics, metric types and strategies. If the contribution file is not present, application content does not appear in the content pane. However, the metric package and all metric reports...
Appear in the content pane. All objects that appear in the content pane can be manipulated in the workspace in the same way that they are manipulated in IBM Cognos Connection.

Perform the following tasks as required to configure Business Insight to use metric objects:

- Add the domain of the metric server to the list of valid domains if required.
- Change the reports that are rendered by a metric object if required.
- Remove the metric contribution atom file if required.

**Adding the Metric Server Domain to the Valid Domain List for IBM Cognos BI Server**

If IBM Cognos Metrics Manager is installed on a different host than the IBM Cognos BI server, you must add the host to the list of valid hosts and domains for IBM Cognos BI server. This must be done on every report server in a multi-server installation.

**Procedure**

1. On the report server, where Application Tier Components for IBM Cognos BI server are installed, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click IBM Cognos Application Firewall.
3. In the Properties window, add the host name of the metric server to the IBM Cognos list of valid names:
   - For the Valid domains and hosts property, click the value and then click the edit button.
   - In the Value - Valid domains or hosts dialog box, click Add.
   - In the blank row of the table, click and then type the host name.
   To allow a domain and all its sub-domains, use a wildcard character at the beginning of the domain name.
   For example, *.mycompany.com
   - Click OK.
4. Save the configuration.

**Changing the Report Rendered by a Metric Object**

If an author has created new reports for a metric package, you can associate the new reports with the object types by editing the cmm_NOT.properties file.

Each type of metric object that is dragged into a workspace in IBM Cognos Business Insight renders a specific report, as shown in the following table:

<table>
<thead>
<tr>
<th>Object type</th>
<th>Report rendered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric</td>
<td>Metric history graph</td>
</tr>
<tr>
<td>Metric type</td>
<td>Metric type data</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Scorecard metric list</td>
</tr>
<tr>
<td>Strategy</td>
<td>Strategy metric list</td>
</tr>
</tbody>
</table>
The reports are created automatically with each metric package.

**Procedure**

1. On the report server computer, where Application Tier Components are installed, go to the directory `c10_location\webapps\p2pd\WEB-INF\classes`
2. Rename the file `cmm_NOT.properties` as `cmm.properties`
3. Open the renamed file in a text editor.
4. In the `##Default reports for BUX` section, find the object type that you want to replace in each report:
   - For metric,
     ```
     ##cmm.bux_report.metric=/folder[@name='Reports']/
     folder[@name='Reports']/report[@name='Metric History Graph']
     ```
   - For metric type,
     ```
     ##cmm.bux_report.metric_type=/folder[@name='Reports']/
     folder[@name='Reports']/report[@name='Metric Type Data']
     ```
   - For scorecard,
     ```
     ##cmm.bux_report.scorecard=/folder[@name='Reports']/
     folder[@name='Reports']/report[@name='Scorecard Metric List']
     ```
   - For strategy,
     ```
     ##cmm.bux_report.strategy=/folder[@name='Reports']/
     folder[@name='Reports']/report[@name='Strategy Metric List']
     ```
   - For watchlist,
     ```
     ##cmm.bux_report.watchlist=/folder[@name='Reports']/
     folder[@name='Workspace Reports']/report[@name='Watch List']
     ```
5. Uncomment the property.
6. Replace the values in the `/folder` strings with the folder names where the new report is located.
7. Replace the value in the `/report` string with the object_id parameter of the new report.

If the new report uses a parameter other than object_id, then do the following:

- find the CMM object_id property for the type of object being replaced:
  - For metric,
    ```
    ##cmm.bux_report.object_id.prompt_param_name.
    metric=object_id
    ```
  - For metric type,
    ```
    ##cmm.bux_report.object_id.prompt_param_name.
    metric_type=object_id
    ```
  - For scorecard,
    ```
    ##cmm.bux_report.object_id.prompt_param_name.
    scorecard=object_id
    ```
  - For strategy,
Uncomment the property.

• Replace the object_id string with the parameter name that the new report uses.

8. Repeat steps 4 to 7 for each object type that you wish to replace.
9. Save the cmm.properties file.
10. Restart the IBM Cognos service.

Removing the Metric Studio Contribution File
If your IBM Cognos BI installation does not include IBM Cognos Metrics Manager, any metric package continues to appear in the Business Insight content pane. However, clicking on it causes an error message to appear. To prevent this, remove the Metric Studio contribution atom file from your IBM Cognos BI installation. Metric packages then continue to appear, and clicking on them in the content pane shows their report content.

Procedure
1. Go to the c10_location/configuration/icd/contributions/contrib directory.
3. Restart the IBM Cognos service.

Results
The metric objects link no longer displays in the IBM Cognos Business Insight workspaces.

Configuring IBM Cognos Business Insight to Use Content from a TM1 Data Server
Before workspace users can see content from a TM1 server, you must configure IBM Cognos Business Insight with information about the TM1 server and configure components in the TM1 environment for integration with Business Insight.

To configure the TM1 data server for Business Insight, do the following:

• Specify the Web host, host name, and server name for each TM1 server.
• Configure the TM1 data server for integration with Business Insight.
• Configure the TM1 client for integration with Business Insight.
• Configure an IBM Cognos user as a TM1 administrator and add the IBM Cognos User groups to the TM1 server.
• Create the language feed files for the TM1 servers.
• Create translation files for TM1 Views folder.

Configuring the Web Host, Host Name, and Server Name for each TM1 Server
You must specify the URL to be used for Web access and the server host and server name so that IBM Cognos Business Insight can connect to the TM1 servers.

A sample contribution file is provided with Business Insight, that includes properties for a TM1 server that uses IBM Cognos authentication and properties for a TM1 server that does not use IBM Cognos authentication. You can add
comment tags to the section that does not apply. If you have more than one TM1 server, make copies as needed of the section that is appropriate for your authentication method.

If the IBM Cognos BI gateway is running on a different computer than TM1 Web, ensure that you use the fully qualified domain names for server name values, such as the **TM1WebHost**. For example, use `http://mycomputer.mydomain.com/ibmcognos` rather than `http://mycomputer/ibmcognos`. Also, you must use the fully qualified domain names for the server name values in the **Environment** section of IBM Cognos Configuration.

**Procedure**

1. In the `c10_location\configuration\icd\contributions\contrib` directory, rename the `tm1_contribution.atom.sample` file as `tm1_contribution.atom`.
2. Using a text editor, open the `tm1_contribution.atom` file.
3. Find the following string in the section that is appropriate for your authentication method:
   - For a TM1 server that does not use IBM Cognos authentication,
     ```
     <atom:link rel="alternate" type="application/atom+xml"
     href="{cgi}/xts.run?m=tm1/serverContent.xts&https=0&TIM1WebHost=TM1WebHostName&TIM1WebVirtualDirectory=tm1web&TIM1Host=TM1HostName&TIM1DataServer=TM1ServerHostWithoutCAM&TIM1username=admin&TIM1pass=apple"
title="">v
     ```
   - For a TM1 server that uses IBM Cognos authentication,
     ```
     <atom:link rel="alternate" type="application/atom+xml"
     href="{cgi}/xts.run?m=tm1/serverContent.xts&https=0&TIM1WebHost=TM1WebHostName&TIM1WebVirtualDirectory=tm1web&TIM1Host=TM1HostName&TIM1DataServer=CamAuthenticatedTM1ServerHost" title="">v
     ```
4. Specify the following properties:
   - **TM1WebHost**
     Replace `TM1WebHostName` with the host name of the TM1 Web server.
     For example,
     ```
     <atom:link rel="alternate" type="application/atom+xml"
     href="{cgi}/xts.run?m=tm1/serverContent.xts&https=0&TIM1WebHost=PlanningServer1.Mycompany.com&TIM1WebVirtualDirectory=tm1web&TIM1Host=TM1HostName&TIM1DataServer=CamAuthenticatedTM1ServerHost" title="">v
     ```
   - **TM1Host**
     Replace `TM1HostName` with the host name of the TM1 data server.
     For example,
     ```
     <atom:link rel="alternate" type="application/atom+xml"
     href="{cgi}/xts.run?m=tm1/serverContent.xts&https=0&TIM1WebHost=PlanningServer1.Mycompany.com&TIM1WebVirtualDirectory=tm1web&TIM1Host=TM1HostName&TIM1DataServer=CamAuthenticatedTM1ServerHost" title="">v
     ```
TM1WebHost=TM1WebHostName&amp;
TM1WebVirtualDirectory=tm1web&amp;
TM1Host=PlanningServer1.Mycompany.com&amp;
TM1DataServer=CamAuthenticatedTM1ServerHost" title="">

- TM1DataServer
  Replace TM1ServerHostWithoutCAM or CamAuthenticatedTM1ServerHost with the name of the TM1 data server.
  For example,
  <atom:link
  rel="alternate" type="application/atom+xml"
  href="[cgi]/xts.run?m=tm1/serverContent.xts&amp;
  https=0&amp;
  TM1WebHost=TM1WebHostName&amp;
  TM1WebVirtualDirectory=tm1web&amp;
  TM1Host=TM1HostName&amp;
  TM1DataServer=Planning%2520Sample"
  title="">

5. If you are not using the default values, change the following properties:

- https
  This property describes the protocol used for the TM1 Web server. If the TM1 Web is running with HTTP secure, replace 0 with 1.

- TM1WebVirtualDirectory
  This property is the name of the virtual directory for the TM1 Web. If the TM1 Web directory name is not tm1web, replace the value of the TM1WebVirtualDirectory property with the correct name.
  For example,
  <atom:link
  rel="alternate" type="application/atom+xml"
  href="[cgi]/xts.run?m=tm1/serverContent.xts&amp;
  https=0&amp;
  TM1WebHost=TM1WebHostName&amp;
  TM1WebVirtualDirectory=planningweb&amp;
  TM1Host=TM1HostName&amp;
  TM1DataServer=Planning%2520Sample"
  title="">

- TM1Toolbar
  This property determines whether the internal toolbar is visible. This is necessary when using versions of TM1Web older than version 9.5.2 which do not allow for an external toolbar. The default value of TM1Toolbar is 0. To display the internal toolbar, set the value to 1.

6. For a TM1 server that does not use IBM Cognos authentication, also specify the following properties:

- TM1username
  Replace admin with the user ID of the administrator account that is used for the TM1 server.

- TM1pass
  Replace apple with the password for the administrator account that is used for the TM1 server.

7. If you have more than one TM1 server, create a new section for each TM1 server in the tm1_contribution.atom file:

- Select the atom specification for the first TM1 server, which starts with <atom:entry> and ends with </atom.entry>.
Copy it and paste it at the end of the file.

Repeat the actions in steps 3 to 6 in the section that you just pasted, and replace rootfeed_title_1 with the appropriate rootfeed title string.

All atom:id values in all .atom entries must be unique. For example,

```xml
<atom:entry>
  <atom:id>tag:ibm.cognos.icd.com,2010-01-01:/tm1_rootfeed_2</atom:id>
</atom:entry>

<atom:entry>
  <atom:id>tag:ibm.cognos.icd.com,2010-01-01:/tm1_rootfeed_2b</atom:id>
</atom:entry>

are unique because of tm1_rootfeed_2 and tm1_rootfeed_2b.

8. Save and close the file.

Configuring the TM1 Data Server for Integration with Business Insight

For integration between the TM1 data server and IBM Cognos Business Insight, you must configure properties in a number of files in the TM1 environment.

Procedure

1. Go to the data directory of the TM1 server and open the Tm1s.cfg file in a text editor.

2. Add the following two properties to the file:

   - ServerCAMURI=http://Cognos_Internal_Dispatcher_Host:9300/p2pd/servlet/dispatch
     where Cognos_Internal_Dispatcher_Host is the host name of the IBM Cognos dispatcher that the TM1 server should use to connect to CAM.
   - ClientCAMURI=http://Cognos_Server_Host/ibmcognos/cgi-bin/cognos.cgi

   Ensure that the value matches the Gateway URI property in IBM Cognos Configuration.

   If the IBM Cognos BI gateway is running on a different computer than TM1 Web, ensure that you use the fully qualified domain name for the Cognos_Server_Host value.

   For example, use http://mycomputer.mydomain.com/ibmcognos rather than http://mycomputer/ibmcognos. Also, you must use the fully qualified domain names for the server name values in the Environment section of IBM Cognos Configuration.


4. Save and close the file.

5. Go to the location of the variables_TM1.xml file in the IBM Cognos BI server installation.

   This file is installed with the TM1 Viewer Portlets in the Gateway location for IBM Cognos BI server. By default, it is in the c10_location\templates\ps\portal directory.

6. If there is no variables_TM1.xml file in the location, rename the variables_TM1.xml.sample file as variables_TM1.xml.

7. Open the variables_TM1.xml file in an XML editor and edit the three URL values so that they indicate the host name of the TM1 Web server.

8. Save and close the file.
Configuring the TM1 Client for Integration with Business Insight

You must add two parameters to your Tm1p.ini file to allow you to perform security-related administrative tasks for IBM Cognos Business Insight from your TM1 client.

Procedure

1. On the TM1 client computer, go to the C:\Documents and Settings\username\Application Data\Applix\TM1 directory and open the Tm1p.ini file in a text editor.
2. Ensure that the AllowImportCAMClients property is set to T.
3. Specify the URL for the CognosGatewayURI property as follows:
   http://IP_address_or_hostname/ibmcognos/cgi-bin/cognos.cgi
   Ensure that the value matches the Gateway URI property in IBM Cognos Configuration.
   If the IBM Cognos BI gateway is running on a different computer than TM1 Web, ensure that you use the fully qualified domain name for the CognosGatewayURI value.
   For example, use http://mycomputer.mydomain.com/ibmcognos rather than http://mycomputer/ibmcognos.

Configuring an IBM Cognos User as a TM1 Administrator and Importing IBM Cognos Groups into TM1

Before an IBM Cognos administrator can successfully access the TM1 client using IBM Cognos authentication, the user must be a member of the TM1 ADMIN group. This IBM Cognos user is then used to import IBM Cognos groups into TM1.

Before you begin

Ensure the following:

- IBM Cognos BI server is not using anonymous authentication.
- The data server and the client are configured for integration with IBM Cognos Business Insight.
- The TM1 server has been restarted.

Procedure

1. Using the TM1 Architect program, add the IBM Cognos user as a TM1 client and assign the user to the ADMIN group.
   For instructions, see the section about Cognos Access Manager Authentication in the TM1 Operations Guide.
2. Close the TM1 Architect program and shut down the TM1 server.
3. Go to the data directory of the TM1 server and open the Tm1s.cfg file in a text editor.
4. Set the IntegratedSecurityMode parameter to indicate that the server should use IBM Cognos BI authentication.
   The parameter value depends on the TM1 components that you are using. If you are using TM1 Contributor with CAM authentication, set the parameter to 5. If you are not using the TM1 Contributor component, set the parameter to 4.
5. Start the TM1 server.
6. Using the TM1 Architect program, add the appropriate IBM Cognos groups to the TM1 server.
For instructions, see the section about Cognos Access Manager Authentication in the TM1 Operations Guide.

Ensure that you

- Log into the server as the user who was just added as an administrator.
- Select the namespace to which you are currently connected.

**Creating the Language Feed Files for Each TM1 Server**

You must create one or more language feed files in which you specify the name and description to be used for each TM1 server that will display content in IBM Cognos Business Insight workspaces.

**Before you begin**

Before you begin, ensure that the following tasks are completed:

- IBM Cognos TM1 is installed and running.
  For more information, see the IBM Cognos TM1 Installation Guide.
- Authentication between IBM Cognos BI server and the TM1 server is configured, as described in these topics:
  - “Configuring the TM1 Data Server for Integration with Business Insight” on page 416
  - “Configuring the TM1 Client for Integration with Business Insight” on page 417
  - “Configuring an IBM Cognos User as a TM1 Administrator and Importing IBM Cognos Groups into TM1” on page 417

**Procedure**

1. Go to the `c10_location\configuration\icd\contributions\contrib` directory.
2. Using a text editor, open the file named `tm1_en.properties`.
3. To configure the name that will appear in the content pane of the workspace, do the following:
   - For the `rootfeed_title_1` property, replace the value with the name to appear in the content pane.
   - For the `rootfeed_summary_1` property, replace the value with a description.
   - Repeat the preceding two bulleted steps for as many TM1 servers as you have in your environment.
     If you have more than two TM1 servers, add more rootfeed title and rootfeed summary variables, incrementing the number by one for each server.
4. Save the file.
5. If your environment supports multiple languages, do the following:
   - Make a copy of the `tm1_en.properties` file.
   - Rename the file as `tm1_language_code.properties`, where `language_code` is the two-character code for the language that you are using such as ja, es, and so on.
     A sample French properties file is provided: `tm1_fr.properties`.
   - Edit the file using a text editor and change the values for the rootfeed titles and rootfeed summaries to the appropriate translations.
   - Create one properties file for each supported language.

**Creating Translation Files for the TM1 Views Folder**

By default, IBM Cognos Business Insight displays an Applications folder and a Views folder for each TM1 server that is identified in the contribution .atom file.
The name of the Applications folder is returned by the TM1 server and the language is based on the language under which the TM1 server is configured. The name of the Views folder is determined by a messages file that is provided with Business Insight. You can create additional messages files to specify the Views folder name for each supported language in your environment.

**Procedure**
1. Go to the `c10_location\templates\ps\messages\` directory.
2. Create a copy of the `tm1buxmsgs_en.xml` file and name it using the appropriate language code.
   A sample French translation file is provided: `tm1buxmsgs_fr.xml`.
3. Open the new translation file in an XML editor.
4. In the following section,
   \[<string id="TM1_VIEWS" type="String" usage="TM1 views">Views</string>\]
   replace the string `Views` with the translated name.
5. Save and close the new file.
6. Repeat steps 2 to 5 for each supported language.

**Configuring IBM Cognos Business Insight to Access IBM Cognos TM1 Contributor**

The IBM Cognos BI server can access the Web client for IBM Cognos TM1 Contributor, Version 9.5.1 FP1 through an external iwidget that displays in the content pane of IBM Cognos Business Insight. Before the iwidget can display, use the TM1 Contributor documentation to perform the following tasks:

**Procedure**
1. Install TM1 Contributor, Version 9.5.1 FP1.
2. Configure TM1 Contributor for interoperability with the IBM Cognos BI server.
   When copying the `icon_active_application.gif` file to the Cognos BI server portal images folder, also copy this file to the `c10_location/webcontent/icd/feeds/images` folder.
3. Deploy TM1 Contributor applications.
   TM1 Contributor generates a URL, which the IBM Cognos BI server detects.

**Results**

The TM1 Contributor URL displays under **Public Folders** in the content pane of Business Insight.

**Changing the Style of Report Objects in Workspaces**

When you drag a report object onto a workspace in IBM Cognos Business Insight, it appears in the silver and blue gradient style of your IBM Cognos BI server product. You can make the report object appear in the original authored style by changing a global property in the IBM Cognos Viewer configuration file.

Report objects that are affected by the global setting include queries, analyses, reports, and report parts that were authored using IBM Cognos Version 1.x style, Version 8.x style, and financial (balance sheet) style. These objects pick up the global setting even if you saved them before changing the global setting. Workspace thumbnails are affected by the global setting only if you rerun the thumbnail.
Some report objects are not affected by the global setting and will always render in the authored style, such as PowerPlay reports and report object thumbnails.

**Procedure**

1. On the computers where Content Manager and Application Tier Components are installed, go to `c10_location\webapps\p2pd\WEB-INF\classes`.
2. Open the `viewerconfig.properties` in a text editor.
3. To make report objects appear in the original authored style, change the value for `useAuthoredReportStyles` to `true`.
4. Save the file and then restart the services.

**Accessing the IBM Cognos Business Insight Samples**

IBM Cognos Business Insight samples are included in the IBM Cognos BI Samples download or disk.

Business users can access the sample workspaces in Business Insight by selecting the option to open existing workspaces and then selecting **Samples > Models** > **Business Insight Samples**.

For more information about installing and setting up the samples, see "Install the IBM Cognos Business Intelligence Samples" on page 266 and "Setting Up the Samples" on page 267. For more information about using the sample workspaces, see the IBM Cognos Business Insight User Guide.

**Configure the Router to Test Dispatcher Availability**

If you use a router to distribute requests to IBM Cognos dispatchers, and the router can test the availability of a server using a test URL, you can configure the router to test the availability of an IBM Cognos dispatcher.

**Procedure**

Configure the router to use a URL with the path `/p2pd/servlet/ping`.

If the dispatcher is not ready, the following response is returned:

```
503 Service Unavailable
```

If the dispatcher is ready, the following response is returned:

```
200 OK
```

**Configuring IBM Cognos BI to Work with Other IBM Cognos Products**

Some IBM Cognos products provide functionality that is not available in IBM Cognos BI.

You can continue to use these products in the same environment. Additional configuration tasks may be required to ensure that IBM Cognos BI can access objects that were created using other IBM Cognos products. Additional requirements for access depend on how you choose to run the two products.
Enable Scheduled Reports and Agents for IBM Cognos Planning Contributor Data Sources

To run scheduled reports and agents, which are based on IBM Cognos Planning Contributor data sources, you must specify a shared, secret password. This helps to ensure secure communication between IBM Cognos BI servers and Contributor Data Server.

Procedure

1. On the Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, click Data Access, IBM Cognos Planning, Contributor Data Server.
3. In the Properties window, click the Value box next to the Signature password property and then click the edit button when it appears.
4. In the Value - Signature Password dialog box, type the password that will be digitally signed.
   The password is case-sensitive and must match the Signature password property that you configure in IBM Cognos Series 7, Configuration Manager, Cognos Planning/Cognos BI - Contributor Data Server/General properties.
5. From the File menu, click Save.

Results

A digital signature, based on the password, is created. The digital signature is encoded by IBM Cognos BI and decoded by Contributor Data Server.

File Location Properties on Windows Vista

If you install IBM Cognos client components in an environment that includes Windows Vista, you must change file locations properties in IBM Cognos Configuration so that IBM Cognos can use a single data location for all users. The changes must be made on all computers where IBM Cognos client components are installed.

Windows Vista has a security enhancement that restricts multiple users from sharing data locations. You can define environment variables and use them in IBM Cognos Configuration when specifying file locations. This allows you to direct applicable files to an area that will be accessible by IBM Cognos users. On Windows, two environment variables are preset for users: one for all users and one for the specific user.

In addition, if you install Transformer on a Windows Vista computer, and you plan to use the cogtr.xml.samples file as a template, you must update default preferences in the Transformer configuration file.

Because the environment variables represent system root locations, also include the root directory name of the installation location when you specify file locations in IBM Cognos Configuration. The default root directory for IBM Cognos is c10.
Update File Location Properties on Windows Vista

You must change file locations properties in IBM Cognos Configuration so that IBM Cognos can use a single data location for all users. The changes must be made on all computers where IBM Cognos client components are installed.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, click Deployment files location.
4. Replace the relative path element, ".\", with the appropriate environment variable and root directory:
   - For a single file location per user, %LOCALAPPDATA%
   - For a single file location for all users on the computer, %PUBLIC%
   For example, to set a single file location per user, specify the path %LOCALAPPDATA%/c10/deployment.
5. Repeat step 4 for the following properties:
   - Under Environment, Data files location
   - Map files location
   - Temporary files location
   - Under Environment, Logging, File, Log file location
   - Under Cryptography, Common symmetric key store location
   - Under Cryptography, Cognos, Certificate location
   - Signing key store location
   - Encryption key store location
6. From the File menu, click Save.

Results

The environment variables are resolved when the file locations are accessed during system activities.

Configuring IBM Cognos Transformer

After you install Transformer, you can perform these tasks:

- If you installed Transformer on a Windows Vista computer, and you plan to use the cogtr.xml.samples file as a template, update default preferences for Windows Vista.

- If you want to use Transformer models from IBM Cognos Series 7 and you want to continue to use IQD data sources, add IBM Cognos Series 7 Data Sources to the Transformer.

To make Transformer available for modelers to install and use, you can perform these tasks:

- Create a network installation location for Transformer modelers.
Update Default Preferences for Windows Vista

With security enhancements in Windows Vista, Microsoft changed the structure of user directories. If you want to use the cogtr.xml.samples file as a template, you must edit the default preferences settings. If you want all users to have the same default directories, you must change the default preferences to a common location to which users have access. If you want users to have the Windows Vista directories, you can delete the default preferences for the directories.

The instructions in this topic are for the installer or administrator. If you are the Transformer modeler or business specialist who wants to download and use Transformer, see “Deploying IBM Cognos Transformer for Modelers” on page 426.

Procedure

1. Log on as the administrator.
2. In the \c10_location\configuration directory, open cogtr.xml.sample in a text editor in elevated mode by right-clicking on the text editor and selecting Run as Administrator.
3. If you want all users to have the same default directories, change the directories to a location to which all users have read and write access.
   The directories to change are as follows:
   • `<Preference Name="CubeSaveDirectory" Type="string" Value="..\temp"/>
   • `<Preference Name="DataSourceDirectory" Type="string" Value="..\temp"/>
   • `<Preference Name="DataWorkDirectory" Type="string" Value="..\temp"/>
   • `<Preference Name="LogFileDirectory" Type="string" Value="..\logs"/>
   • `<Preference Name="ModelSaveDirectory" Type="string" Value="..\temp"/>
   • `<Preference Name="ModelWorkDirectory" Type="string" Value="..\temp"/>
4. If you want users to have the Windows Vista default directories, delete the preferences specified in step 3 from the file.
The Windows Vista default directories for Transformer are
   • CubeSaveDirectory
     Documents\Transformer\PowerCubes
   • DataSourceDirectory
     In IBM Cognos Configuration, under Environment, Data files location property
   • DataWorkDirectory
     In IBM Cognos Configuration, under Environment, Temporary files location property
   • LogFileDirectory
     Documents\Transformer\Logs
   • ModelSaveDirectory
     Documents\Transformer\Models
   • ModelWorkDirectory
     In IBM Cognos Configuration, under Environment, Temporary files location property
5. Change other settings as required.
6. Save the file as cogtr.xml.
   The changes are applied the next time you open Transformer.

**Add IBM Cognos Series 7 Data Sources to Transformer**

If you plan to use Transformer models and data sources from IBM Cognos Series 7, you must add the location of your IBM Cognos Series 7 data sources to the Transformer gateway file.

The instructions in this topic are for the installer or administrator. If you are the Transformer modeler or business specialist who wants to download and use Transformer, see “Deploying IBM Cognos Transformer for Modelers” on page 426

**Procedure**

1. Log on as the administrator.
2. In the $c10_location/CS7Gateways/bin directory, open cs7g.ini in a text editor.
   On Windows Vista, open it in elevated mode by right-clicking on the text editor and selecting **Run as Administrator**.
3. Add the locations for your IBM Cognos Series 7 data sources to the file.
4. Save the file.
   The changes are applied the next time you open Transformer.

**Create a Network Installation Location for Transformer Modelers**

Your organization may have specialized business or power users who want to build PowerCubes that are modeled on a combination of corporate and personal data sources. These users may want to do their own analysis of the data for their line of business or a small group of users. An installer or administrator can download an executable file to a Web or LAN location, where modelers can run the file to launch the IBM Cognos Transformer installation wizard.

The instructions in this topic are for the installer or administrator. If you are the Transformer modeler or business specialist who wants to download and use Transformer, see “Deploying IBM Cognos Transformer for Modelers” on page 426

**Before you begin**

Before you make the installation file available to Transformer modelers, other resources and permissions must be set up:

- Database client software is installed, or available for modelers to install, on the Transformer computers that are used to access IBM Cognos BI data sources or IBM Cognos Series 7 IQD data sources.
- Modelers must have privileges to create a data source in IBM Cognos Administration.
  Modelers do not need direct access to IBM Cognos Administration. They can create and update data sources by using Transformer or command line tools. You can provide modelers with a secured folder in IBM Cognos Connection in which to publish PowerCube packages.
- Modelers must have access to a location in which to store the PowerCube after building it.
  This location must also be accessible to the IBM Cognos service and can be a secured share on a LAN.
To build PowerCubes on a specific Transformer server, modelers should have FTP privileges to transfer models and execute privileges to build cubes on that server.

Modelers can transfer models and execute cube builds using scripts. Modelers can also use automated methods to build PowerCubes. For more information, see the Administration and Security Guide.

**Procedure**

1. Insert the disk for IBM Cognos Transformer modeling product.
2. If the Welcome page of the installation wizard appears, exit the wizard.
3. On the disk, locate the C8transformerinstall.exe file.
4. Copy the file to a secure location to which your Transformer modelers have access.

**Configuration Data for Transformer Modelers**

If you want to make the Transformer installation file available to Transformer modelers, the modelers will need the dispatcher and encryption settings to configure Transformer on their local computer. You can export the configuration from one Transformer computer for use with all other Transformer computers. The modelers can copy the exported configuration file to their Transformer installation directory and then run the command to configure the Transformer computer silently.

The instructions in this topic are for the installer or administrator. If you are the Transformer modeler or business specialist who wants to download and use Transformer, see “Deploying IBM Cognos Transformer for Modelers” on page 426.

If you updated the coglocale, cogtr.xml, or cs7g.ini files on the Transformer computer, you must copy these files to the Web or LAN location so that Transformer modelers can download them to their computer.

To export the configuration, the source computer must have the same IBM Cognos BI components as the Transformer modeler computers. If some modelers will be installing on Windows Vista, you must create an export file from a Windows Vista computer. We suggest creating separate folders on the Web or LAN location for Windows and Windows Vista.

**Exporting the Transformer configuration**

Use IBM Cognos Configuration to export the configuration from one Transformer computer for use with all other Transformer computers.

**Procedure**

1. In IBM Cognos Configuration, from the File menu, click Export as.
2. If you want to export the current configuration to a different folder, in the Look in box, locate and open the folder.
   
   Ensure that the folder is protected from unauthorized or inappropriate access.
3. In the File name box, type a name for the configuration file.
4. Click **Save**.
5. Rename the exported file to cogstartup.xml.
6. Copy the exported cogstartup.xml file from the source computer to the same Web or LAN location as the Transformer installation file.
7. If you changed the global configuration on the source computer, copy the coglocale.xml file from the source computer to the same Web or LAN location as the Transformer installation file.

   The default location of the coglocale.xml file is \c10\location\configuration.

**Copying updated Transformer configuration files**

If you updated certain configuration files, you must copy them to the same location as the Transformer installation file.

**Procedure**

1. If you updated the cogtr.xml, copy it from the \c10\location\configuration
directory to the same Web or LAN location as the Transformer installation file.
2. If you updated the cs7g.ini file, copy it from the \c10\location\CS7Gateways\bin
directory to the same Web or LAN location as the Transformer installation file.

**Deploying IBM Cognos Transformer for Modelers**

If you are the business specialist or Transformer modeler, you must now deploy Transformer so that you can build PowerCubes and publish them to selected users or groups.

If you have not completed the installation, follow the [steps to install Transformer](#).

To configure Transformer so that it can communicate with the IBM Cognos BI dispatcher, follow the [steps to configure Transformer](#).

If IBM Cognos Connection is secured, you must have privileges to create data sources and publish packages in IBM Cognos Connection.

You can upgrade models from Series 7.x versions of Transformer if you have saved them as MDL files.

You can continue to use PowerCubes built with Series 7.3 and higher versions of Transformer in IBM Cognos BI. However, to use IBM Cognos BI authentication providers, you must upgrade the PowerCubes. After upgrading, the PowerCubes are no longer compatible with Series 7 Transformer.

To upgrade PowerCubes to IBM Cognos BI PowerCubes, you must:

- open the Series 7.x Transformer model MDL file in IBM Cognos Transformer
- rebuild the PowerCube in the IBM Cognos Transformer

    For more information, see “Upgrading Transformer Models and PowerCubes” on page 118.

To support the use of IBM Cognos BI data sources (including packages and reports) in Transformer, ensure that the database client is installed on the Transformer computer.

**Installing Transformer**

As a business specialist or Transformer modeler, use the following steps to install Transformer from the Web or LAN location that the administrator provided.

**Procedure**

1. From the Web or LAN location that the administrator provided, run the C8transformerinstall.exe file.
The contents are expanded to the Documents and Settings\username\Local settings\Temp directory and then the Transformer installation wizard opens.

2. Follow the directions in the installation wizard and copy the required files to your computer.

   Tip: The Series 7 IQD Bridge component is not supported on Linux and HP-UX Itanium.

3. In the Finish page of the wizard, select View the Release Notes and then click Finish.

4. Create a MANPATH environment variable and configure it with the following value:

   /c10_location/webcontent/documentation/en/cogtr_a.html

   The cogtr_a.html document provides the syntax for UNIX command line options that are supported by IBM Cognos Transformer. The man page for IBM Cognos Transformer is accessible in UNIX by typing cogtr man from the c10_location/bin directory.

Configuring Transformer

As a business specialist or Transformer modeler, use the following steps to configure Transformer.

Procedure

1. Go to the same Web or LAN location as the Transformer installation file.

2. If any .xml files are present, copy them to the Transformer_location/configuration directory, where Transformer_location is the directory where you installed Transformer.

   The default location is C:\Program Files\Cognos\c10.

3. If an .ini file is present, copy it to the Transformer_location\CS7Gateways\bin directory.

4. Go to the Transformer_location/bin directory.

5. Type the configuration command:

   ./cogconfig.bat -s

   IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, generates digital certificates, and starts the IBM Cognos services.

6. To test IBM Cognos Transformer, from the Start menu, click Programs > IBM Cognos 10 > Transformer.

   If you see the Transformer window, your installation is working.

7. After Transformer is installed and running successfully, delete the installation files that were extracted from the installation file.
Chapter 14. Configuring Portal Services

Portal Services provides a set of IBM Cognos portlets that you can use in IBM Cognos Connection and in other portals. You can use the portlets to navigate, search, and view IBM Cognos reports in your working environment. Other users can view IBM Cognos information without needing to know how to use IBM Cognos products.

For more information, see the Administration and Security Guide.

Portal Services is installed automatically with IBM Cognos components. In a distributed environment, it is included with the Application Tier Components. The installation includes the deployment files for:

- SAP Enterprise Portal (SAP EP)
- IBM WebSphere Portal
- Oracle WebCenter Interaction Portal
- SharePoint Portal

For some deployments of Portal Services, you must modify some Portal Services property settings and prepare the IBM Cognos environment to support the other portal.

When used in another portal, Portal Services can authenticate users in only one namespace. If IBM Cognos components are configured with more than one namespace, you must install a separate gateway for each namespace that will be used to authenticate portal users. You must configure each gateway to use the appropriate namespace and then configure the deployed portlets to use that gateway.

After you configure the required properties, you must deploy the Cognos portlets to the other portal. For more information, see the Administration and Security Guide.

To use Portal Services with IBM Cognos components, do the following:

- Specify the location of the applications.xml file if required.
- Install and test the portlets on the other portal.
  
  For more information, see the Administration and Security Guide.
- Configure security for the other portal environment.

Specify the Location of the Applications.xml File

If you use the applications.xml file as part of a custom application portlet, all Application Tier Components computers in a distributed environment must reference the same applications.xml file. If you have multiple instances of the applications.xml file, they must be identical.

Note: The steps are required only if you want to use the Extended Applications portlet, which is included with the IBM Cognos Business Intelligence software development kit.
Procedure

1. On the Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click Portal Services.
3. In the Properties window, click the Value next to Location of 'applications.xml'.
4. Replace localhost with a valid host name or IP address and, if necessary, replace the default port number.
5. From the File menu, click Save.

Results

You can now deploy the IBM Cognos portlets to your portal server. For instructions, see the Administration and Security Guide.

Configuring Security for Portal Services

When using Portal Services in another portal, you must enable single signon to provide seamless integration between the other portal and IBM Cognos components.

Portal Services uses single signon to authenticate users. This means that users do not have to log on to other applications separately through the portal.

You must configure a URI into IBM Cognos components for each portlet in Portal Services.

To enable security between IBM Cognos components and the other portal, do the following:

- Disable anonymous access to IBM Cognos components.
  If your security infrastructure requires you to use another method for single signon, use one of the following methods:
- Enable single signon for the other portal using shared secret.
  If your security infrastructure requires you to use another method for single signon, use one of the following methods:
  - “Enable Single Signon for WebSphere Portal Using the Application Server” on page 438
  - “Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication” on page 438
  - “Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder” on page 439
- Configure IBM Cognos components for SSL access, if required.

Disable Anonymous Access to IBM Cognos Components

Portal Services uses single signon for authentication. If anonymous logon is enabled in IBM Cognos components, Portal Services logs all portal users as anonymous. You must ensure that anonymous access is disabled in IBM Cognos components for single signon in Portal Services to be successful. However, you can test the Portal Services connections using anonymous logon to ensure that the portlets are working in the other portal.
If Portal Services fails to authenticate a user, the user receives an error message at the other portal.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security > Authentication**, click **Cognos**.
3. In the **Properties** window, ensure that **Allow anonymous access** is set to **False**.
4. From the **File** menu, click **Save**.
5. Repeat steps 1 to 4 on all servers where you installed IBM Cognos components.

**Enable Single Signon Using Shared Secret**

You can use shared secret for single signon between IBM Cognos portlets and IBM Cognos components. The Cognos portlets send a message that contains an encrypted version of the portal user ID. The encryption key is determined by the value of a secret character string shared between the portlets and the custom Java security provider on the IBM Cognos server.

You can use shared secret for the other portal only if portal user IDs can be looked up in an NTLM, LDAP, or IBM Cognos Series 7 authentication namespace that is shared by IBM Cognos components.

IBM Cognos components must have access to a directory server that contains user IDs for all your portal users. Using IBM Cognos Configuration, you must configure an authentication namespace so that the portal and IBM Cognos components share the same authentication source.

You must also create a Custom Java Provider namespace to register the shared secret Java provider that is provided with IBM Cognos components. Within the portlets or iViews, you must link the portlets or iViews to the Custom Java Provider namespace within your respective portal:

- Cognos iViews (SAP EP)
- Cognos Portlet Application (WebSphere Portal)
- remote server (Oracle WebCenter Interaction Portal)
- Cognos WebPart (SharePoint Portal)

You are not required to configure access to the Portal Services Web content. However, if you deploy the portlets to another portal, you can configure access to an alternate URI for Portal Services images and Web content.

**Configure the Required Namespaces**

IBM Cognos components must have access to a directory server that contains user IDs for all your portal users. Using IBM Cognos Configuration, you must configure an authentication namespace so that the portal and IBM Cognos components share the same authentication source.

**Procedure**

1. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
2. For an LDAP namespace, configure the following properties:
   - For the **Use external identity** property, change the setting to **True**.
   - For the **External identity mapping** property, set it to (uid=${environment("REMOTE_USER")})
For SharePoint Portal, if SharePoint is on a different machine from the LDAP server, set External identity mapping to
(uid=${replace($environment("REMOTE_USER"),"SharePoint_Server\",""}))

3. For an IBM Cognos Series 7 namespace, map the portal user IDs to IBM Cognos Series 7 user IDs using OS signons.
   For more information, see the IBM Cognos Series 7 documentation.

4. In IBM Cognos Configuration, create and configure a Custom Java Provider namespace.
   - For the Namespace ID property, specify any new ID.
     For example, cpstrusted
     This new ID must be used in the portlet configuration settings.
   - For the Java class name property, type
     com.cognos.cps.auth.CPSTrustedSignon
     Java class names are case-sensitive.

5. In IBM Cognos Configuration, under Environment > Portal Services, configure the following properties:
   - For Trusted Signon Namespace ID, type the namespace ID of the LDAP, NTLM, or IBM Cognos Series 7 namespace that you configured in step 1.

     **Tip:** The trusted signon namespace acts as an intermediary and must be attached to a real directory-based namespace of type LDAP, NTLM, or IBM Cognos Series 7.

   - For Shared Secret, type the key to be used for single signon.
     This parameter represents the authorization secret that must be shared between the Cognos portlets and the IBM Cognos server. Consider this a secret password. You must use the same character string when you configure the portlet application. You must use a single word as the key.
     For security reasons, specify a non-null value.

6. Under Environment, for Gateway Settings, set the Allow Namespace Override property to true.

7. From the File menu, click Save.

8. Restart the IBM Cognos service.

**Configure Access to the Portal Services Web Content**
After creating the required namespaces, you must configure access so that users can access the Web content.

**Procedure**
1. On the computer where you installed the Application Tier Components, start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click Portal Services.
3. In the Properties window, click the Value box next to Web Content URI.
4. Specify the host name or IP address of the gateway and a port number using the format
   host_or_IP_address:port
5. From the File menu, click Save.
Configure the Cognos iViews for SAP EP

Within the iViews, you must link the iViews to the Custom Java Provider namespace within your respective portal.

Procedure

1. Open the iView editor for each Cognos iView.
2. In the Property Category box, select Show All.
3. For the cpsauthsecret: CPS Authorization Secret property, enter the secret character string that you used for the Shared Secret property when you configured the Custom Java Provider namespace.
4. For the cps: authentication namespace ID property, enter the Custom Java Provider namespace ID.
5. For the cpsserver: CPS Connection Server property, enter the URL path to access Portal Services components through the gateway.

The format of the URL is as follows:

- For Cognos content portlets
  Gateway_URI=wsrp/cps4/portlets/nav?wsdl&b_action=cps.wsdl
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/nav?wsdl &b_action=cps.wsdl
  Example for a servlet gateway:

- For Cognos Extended Applications
  Gateway_URI=wsrp/cps4/portlets/sdk?wsdl&b_action=cps.wsdl
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/sdk?wsdl &b_action=cps.wsdl
  Example for a servlet gateway:

- For Metrics Manager Watchlist portlets
  Gateway_URI=wsrp/cps4/portlets/cmm?wsdl&b_action=cps.wsdl
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/cmm?wsdl &b_action=cps.wsdl
  Example for a servlet gateway:

Configure the Cognos Portlets for WebSphere Portal

Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.

Procedure

1. For each Cognos portlet application, click the edit value icon.
2. For the cps_auth_secret property, enter the secret character string that you used for the Shared Secret property when you configured the Custom Java Provider namespace.
3. For the cps_auth_namespace property, enter the Custom Java Provider namespace ID.
4. For the **CPS Endpoint** property, enter the URL path to access Portal Services components through the gateway.

The format of the URL is as follows:

- **For Cognos content portlets**
  
  \[ Gateway\_URI/wsrp/cps4/portlets/nav?wsdl&b\_action=cps.wsdl \]

  Example for a CGI gateway:
  
  \[ http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/nav?wsdl \\&b\_action=cps.wsdl \]

  Example for a servlet gateway:
  
  \[ http://172.0.16.1:9500/wsrp/cps4/portlets/nav?wsdl&b\_action=cps.wsdl \]

- **For Cognos Extended Applications**
  
  \[ Gateway\_URI/wsrp/cps4/portlets/sdk?wsdl&b\_action=cps.wsdl \]

  Example for a CGI gateway:
  
  \[ http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/sdk?wsdl \\&b\_action=cps.wsdl \]

  Example for a servlet gateway:
  
  \[ http://172.0.16.1:9500/wsrp/cps4/portlets/sdk?wsdl&b\_action=cps.wsdl \]

- **For Metrics Manager Watchlist portlets**
  
  \[ Gateway\_URI/wsrp/cps4/portlets/cmm?wsdl&b\_action=cps.wsdl \]

  Example for a CGI gateway:
  
  \[ http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrp/cps4/portlets/cmm?wsdl \\&b\_action=cps.wsdl \]

  Example for a servlet gateway:
  
  \[ http://172.0.16.1:9500/wsrp/cps4/portlets/cmm?wsdl&b\_action=cps.wsdl \]

**Configure the Remote Server for Oracle WebCenter Interaction Portal**

Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.

**Procedure**

1. Using a plain ASCII editor, such as Notepad, edit the cpsalui.properties file in the `c10_location/cps/oracle/webapps/gadgets/WEB-INF/classes` directory.

2. Configure the settings shown in the following table.
### Table 43. Settings for the cpsalui.properties file

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>cps_endpoint</td>
<td>The URL to connect to the Application Tier Components and extract the WSDL information. Specify the URI to the gateway. For a servlet or ISAPI gateway, replace the localhost/ibmcognos/cgi-bin/cognos.cgi portion with the values to target the gateway. For example, http://host_name/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&amp;b_action=cps.wsdl</td>
</tr>
<tr>
<td>forward_cookies</td>
<td>The names of the cookie that should be sent to the Application Tier Components for single signon. Leave blank.</td>
</tr>
<tr>
<td>cps_auth_secret</td>
<td>The shared secret code IBM Cognos uses to encrypt an HTTP header variable that carries the user identity. This parameter represents the authorization secret that must be shared between the Cognos portlets and the IBM Cognos server. Consider this as a secret password. Use the same value that you used for Shared Secret in IBM Cognos Configuration. For security reasons, specify a non-null value.</td>
</tr>
<tr>
<td>cps_auth_namespace</td>
<td>The namespace ID for the Custom Java Provider.</td>
</tr>
</tbody>
</table>

3. Go to the `c10_location/cps/oracle` directory and run the following build file:
   - On UNIX or Linux operating systems, `build.sh`
   - On Microsoft Windows operating system, `build.bat`
   This creates a `cps-wci.war` file in the `c10_location/cps/oracle/gadgets` directory.

4. If IBM Cognos BI components are using Tomcat,
   - Stop IBM Cognos BI.
   - Copy the `cps-wci.war` file to the `c10_location/webapps` directory.
     Tomcat automatically expands the WAR file and starts the remote server.
   - Start IBM Cognos BI.

5. If IBM Cognos BI components are running under another type of application server, copy the `cps-wci.war` file to the application server.
   For instructions, see the administration guide for your application server.
Results

Single signon is configured.

Configure Properties for the Cognos WebPart for SharePoint Portal

Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.

Procedure

1. Using a plain ASCII editor, such as Notepad, edit the web.config file in the drive\Program Files\Common Files\Microsoft Shared\web server extensions\12\CONFIG directory.
2. Find the following string:
   
   `<SSO cps_auth_namespace="" cps_auth_secret="" />

3. Set cps_auth_namespace to the namespace ID for the Custom Java Provider namespace.
4. Set cps_auth_secret to the value that you used for Shared Secret in IBM Cognos Configuration.

Enable Single Signon for SAP EP with the SAP Logon Ticket

If you enable single signon with the SAP Logon Ticket, you must configure IBM Cognos components with an SAP namespace that links to an SAP BW server.

Then you must copy the certificate that was generated during SAP EP installation to the SAP BW personal security environment.

Users must have the same user ID in all SAP systems that are accessed through single signon.

Before you start, ensure that you have

- configured IBM Cognos components to use an SAP authentication source
- enabled single signon between IBM Cognos components and SAP BW
- installed the latest service packs on the SAP BW server

  Service packs can be downloaded from SAPNET.
- installed the latest hot patches for the SAP portal
- installed the Enterprise Portal plug-in that corresponds to the SAP EP release or SAP BW server

  For SAP releases earlier than 6.2, on SAPNET, download EP50_PLUG-IN for Basis 620 (SAPKINE32A). Using transaction SAINST, install SAPKINE32A.
- installed the SAP Security Library on the SAP BW servers

  From sapservX, under /general/misc/security/SAPSECU/platform, download sapsecin and sepsecu.dll and place both files in the /run directory of the SAP BW server.

To enable SSO for SAP EP, complete the procedures for single signon with SAP logon tickets in the SAP Enterprise Portal Security Guide.

You can now use the Cognos iViews in the SAP Enterprise Portal. For more information, see the Administration and Security Guide.
Enable Single Signon for SAP EP with User Mapping

If you enable single signon with user mapping, you define an IBM Cognos data source in SAP EP. Individual users or an administrator can enter the user IDs and passwords for IBM Cognos components in the data source. You must map the users logon credentials in the data source to an LDAP or IBM Cognos Series 7 or NTLM namespace. Portal Services iViews transmit the logon credentials to IBM Cognos components using HTTP Basic Authentication.

Prepare the Environment

Before you map user logon credentials, you must perform certain tasks in the security environment.

Procedure

1. Configure the gateway URI that will be used by Portal Services to require authentication using HTTP Basic Authentication.
   For information about configuring a URL to use HTTP Basic Authentication, see the documentation for the gateway or for your Web server.
2. Adjust the iView configuration to access the secure URL.
   For information, see the documentation for your Web server.
3. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
4. If you use an LDAP namespace, configure the following properties:
   - For the Use external identity property, change the setting to True.
   - For the External identity mapping property, set it to (uid=${environment("REMOTE_USER")})

Create the Data Source and Map the Users

You must set up the logon credentials and define the user mappings for the Cognos iViews.

Procedure

1. In the SAP portal, ensure that the following properties are configured for the data source in the /PortalContent/other_vendors/every_user/com.cognos.pct.c8/systems/Cognos directory:
   - Logon Method = UIDPW
   - server name = the name of the IBM Cognos server
   - port number = port number of the gateway
   - Protocol of Target system = HTTP
   - User Mapping Type = admin,user
   - system alias (Create a system alias)
   For more information, see the SAP Enterprise Portal Administration Guide.
2. For each Cognos iView, enable user mapping for the data source by entering the name of the system alias at the iView level, in an attribute called CPS: User Mapping Datasource.
   For more information, see the SAP Enterprise Portal Administration Guide.
3. For each Cognos iView, set the CPS: Authentication Namespace ID property to the namespace that you want to use for authentication.
4. Register the IBM Cognos credentials for the portal users.
   Users can enter their own user IDs and passwords.
   For more information, see the SAP Enterprise Portal Administration Guide.
5. Enable secure communication between SAP EP and IBM Cognos.

**Results**

You can now use the Cognos iViews in the SAP Enterprise Portal. For more information, see the *Administration and Security Guide*.

**Enable Secure Communication Between SAP EP and IBM Cognos Components**

A secure connection, using SSL, is not required between SAP EP and IBM Cognos components. It is more important if you enabled single signon with user mapping.

To enable SSL between SAP EP and IBM Cognos components, see your SAP EP security documentation.

After SSL is enabled, edit properties for the all iViews so that the `cpsServer: CPS Connection Server` property uses `https` instead of `http`.

You can now use the IBM Cognos portlets in the SAP Enterprise Portal. For more information, see the *Administration and Security Guide*.

**Enable Single Signon for WebSphere Portal Using the Application Server**

The Portal Services portlets can use the Active Credentials objects provided by WebSphere Portal to connect to IBM Cognos components. Portal Services supports the following Active Credentials objects: `HttpBasicAuth`, `LtpaToken`, `SiteMinderToken`, and `WebSealToken`.

Credentials for the portal user are passed to the gateway using this object. For more information about Active Credential objects, see the documentation for IBM WebSphere Portal.

To use application server single signon, see the documentation for IBM WebSphere Application Server.

For information about SSL for IBM Cognos components on a WebSphere Application Server, see [“Configuring the SSL Protocol” on page 370](#).

After single signon is set up, you can use the IBM Cognos portlets in the WebSphere Portal. For more information, see the *Administration and Security Guide*.

**Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication**

You can configure a portlet in WebCenter Interaction Portal to send the username and password as an HTTP Basic authentication header. The header can be used with an NTLM, LDAP, or IBM Cognos Series 7 authentication namespace to provide single signon.

**Procedure**

1. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
2. Install an alternate CGI or ISAPI or servlet gateway in IBM Cognos.
3. Configure the gateway.
4. In the administration console of the Web server, configure the virtual directories to access the gateway.
   For more information, see the documentation for your Web server.

5. Configure the WebCenter Interaction remote server to access IBM Cognos BI:
   - Edit the cpsalui.properties file in the c10_location/cps/oracle/webapps/gadgets WEB-INF/classes directory.
   - Change the cps_endpoint property to indicate the URL of the gateway.
     For a CGI gateway, you can use the default setting if the gateway and the remote server are on the same computer. Otherwise, replace the localhost portion with host:port
     For a servlet or ISAPI gateway, replace the localhost/ibmcognos/cgi-bin/cognos.cgi portion with the values to target the gateway.
     For example,
     http://host:port/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&b_action=cps.wsdl
   - Set the cps_auth_namespace property to the namespace that you want to use for authentication.

Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder

If you use eTrust SiteMinder to provide single signon in your security infrastructure, you can also use it for single signon with WebCenter Interaction Portal.

You must configure a SiteMinder authentication namespace in IBM Cognos BI. WebCenter Interaction Portal sends the SiteMinder active authentication token to the remote server, which sends the token to the IBM Cognos gateway.

Procedure
1. In IBM Cognos Configuration, configure a SiteMinder authentication namespace.
   For instructions, see "Configuring IBM Cognos Components to Use eTrust SiteMinder" on page 339.
2. Configure the remote server to forward the authentication token:
   - Edit the cpsalui.properties file in the c10_location/cps/oracle/webapps/gadgets WEB-INF/classes directory.
   - Change the forward_cookies property to include the name of the active authentication token that SiteMinder provides.
   - Change the cps_endpoint property to indicate the URL of the gateway.
     For a CGI gateway, you can use the default setting if the gateway and the remote server are on the same computer. Otherwise, replace the localhost portion with host:port
     For a servlet or ISAPI gateway, replace the localhost/ibmcognos/cgi-bin/cognos.cgi portion with the values to target the gateway.
     For example,
     http://host:port/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&b_action=cps.wsdl
   - Change the cps_auth_namespace property to the namespace that you want to use for authentication.
Chapter 15. Configuring IBM Cognos Business Intelligence for an Application Server other than Tomcat

IBM Cognos Business Intelligence installs and uses Tomcat as the application server by default. You can choose to run IBM Cognos BI within another supported server instead:

- Oracle WebLogic Server
- IBM WebSphere Application Server
- Oracle Application Server
- Red Hat JBoss
- SAP NetWeaver
- Sun GlassFish Enterprise Server (for Microsoft Windows, Linux, and Solaris operating systems only)

For IBM Cognos BI for Linux on System z, IBM WebSphere Application Server is supported.

To ensure that your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

It is important to note that the Linux operating system is available in a number of distributions and supports a number of hardware platforms. Ensure that the combination of the operating system and hardware that you are using is supported.

You can choose to run the IBM Cognos Servlet Gateway on a supported application server instead of using a Web server. When using the servlet gateway, your environment does not require a Web server. The application server and the servlet gateway replace the functions provided by the Web server and other IBM Cognos gateways.

If you are upgrading from ReportNet to IBM Cognos BI, see “Upgrade to IBM Cognos Business Intelligence in an Application Server Environment” on page 463.

If you are upgrading from Metrics Manager to IBM Cognos Metrics Manager, see “Upgrade from Metrics Manager to IBM Cognos Business Intelligence in an Application Server Environment” on page 464.

For information about configuring a multi-server distributed installation of IBM Cognos BI in an application server environment, contact the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

IBM Cognos BI must be installed and running prior to configuring and deploying the IBM Cognos Servlet Gateway.
To set up IBM Cognos BI to run on your application server, do the following:

- **Create a separate JVM instance** if necessary.
- **Check that IBM Cognos components are properly set up**.
- **Back up any existing IBM Cognos data and encryption keys** if required.
- **Set environment variables**.
- **Add user role to enable single signon for collaboration with IBM Connections**.
- **Configure IBM Cognos components to run within the application server**.
- **Identifying the JDK for WebLogic 9 on AIX**, if necessary.
- **Change the application server startup script**, if necessary.
- **Configure application server properties and deploy IBM Cognos BI**.
- **Enable SSL**, if required.
- **Configure the web server**.
- **Unregister dispatchers that are no longer used**.
- **Import any backed up content store data**.

After setting up IBM Cognos BI to run on your application server, you can perform some additional configuration tasks to customize the behavior of IBM Cognos components to better suit your reporting environment. Chapter 13, “Configuration Options,” on page 347.

**Tip:** Do not use install paths that contain spaces for the application server or IBM Cognos BI. Spaces interfere with the internal scripts and command parameters. If you must use an install path that includes spaces, use the 8.3 DOS naming convention when referring to these locations.

**Related concepts**

“Review Supported Environments” on page 57

To ensure that your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

---

**Create a Separate JVM Instance**

To eliminate potential Java class or system resource conflicts, IBM Cognos Business Intelligence must be run in a Java Virtual Machine (JVM) instance isolated from other existing applications. This ensures that IBM Cognos BI does not affect any existing customer applications. When possible, IBM Cognos BI must be installed in a JVM instance that is separate from the application server admin processes to isolate both IBM Cognos BI and the administrative functions of the application server.

An isolated JVM instance can be established by creating one of the following:

- a separate server instance in IBM WebSphere
- a separate managed server in Oracle WebLogic
- a separate OC4J instance in Oracle 10g Application Server
- a separate server instance for Red Hat JBoss
- a separate Java instance for SAP NetWeaver
- a separate domain for Sun GlassFish Enterprise Server

If you are using the IBM Cognos Servlet Gateway, it must be run in an instance that is separate from IBM Cognos BI.
Check the Setup of IBM Cognos Components

Ensure that the following is done before you set up IBM Cognos components to run on the application server:

- IBM Cognos components are installed.
- Before you start IBM Cognos Business Intelligence, the database for the content store must be set up. Install and configure the database clients, if required, and then test the database connectivity.
- The application server is installed and operational on each computer where IBM Cognos components are installed.
  For more information about installation, see your application server documentation.
- The fully qualified installation location of all fonts is specified on all Application Tier Component computers. You specify this location in IBM Cognos Configuration. By default, the installation location does not use a fully qualified path.
- The application server user account has full access permissions for the IBM Cognos installation.

Tip: Create a new UNIX or Linux operating system group named ibmcognos. This group must contain the user that starts the application server and the user that owns the IBM Cognos files. Change the group ownership of the IBM Cognos files to the ibmcognos group and change the file permissions for all IBM Cognos files to GROUP READABLE/WRITEABLE/EXECUTABLE. For simplicity, you can also use the application server user account to install and run IBM Cognos components.

Back Up Existing IBM Cognos Information

You must back up existing IBM Cognos information if IBM Cognos Business Intelligence components are running on an application server (including Tomcat) and you are changing to an application server that ships with its own JVM. You must also back up existing IBM Cognos information if you must change the JVM you are using.

Note: You must back up existing IBM Cognos information within the working environment prior to upgrade.

Before configuring IBM Cognos BI components to run on the new application server or JVM, you must back up

- content store data by creating a deployment export.
- configuration information by exporting it. Any encrypted data is decrypted during the export.
- cryptographic keys by saving them to an alternate location. New cryptographic keys must be created using the same JVM that the application server uses. Because these keys can be created only if the previous keys are deleted, it is important to back up the previous keys.

To ensure the security and integrity of your IBM Cognos data, back up the content store, configuration information, and cryptographic keys to a directory that is protected from unauthorized or inappropriate access.
Tip: To check if any cryptographic keys exist, look in the $c10_location$/
configuration directory. Cryptographic keys exist if this directory includes the
following subdirectories: csk, encryptkeypair or signkeypair.

Procedure

1. If data exists in the content store, start the IBM Cognos service and export the
total content store using the Deployment tool.
   For more information, see the topic about creating an export deployment
   specification in the Administration and Security Guide.
2. In IBM Cognos Configuration, from the File menu, click Export As and save
   the configuration information in a decrypted format. When naming the file, use
   a name such as "decrypted.xml".
   Export the data to a directory that is protected from unauthorized or
   inappropriate access because passwords are stored in plain text. You are
   prompted to acknowledge that the export is an unsecure operation.
3. Stop the IBM Cognos service:
   • If you use Tomcat, stop the IBM Cognos service and close IBM Cognos
     Configuration.
   • If you use an application server other than Tomcat, shut down IBM Cognos
     BI in your environment.
4. Back up any existing cryptographic keys by saving the appropriate files and
directories to an alternate location that is secure.
   The files are
   • $c10_location$/configuration/cogstartup.xml
   • $c10_location$/configuration/caSerial
   • $c10_location$/configuration/cogconfig.prefs
   • $c10_location$/configuration/coglocale.xml
   The directories are
   • $c10_location$/configuration/csk
   • $c10_location$/configuration/encryptkeypair
   • $c10_location$/configuration/signkeypair
5. Delete the caSerial and cogconfig.prefs files and the three directories: csk, encryptkeypair, and signkeypair.
6. Replace the $c10_location$/configuration/cogstartup.xml file with the file that
contains the data exported from IBM Cognos Configuration (for example,
"decrypted.xml").
   In the $c10_location$/configuration directory, the file must use the name
"cogstartup.xml".
   The information in this file will be automatically re-encrypted using new
   cryptographic keys when you save the configuration in IBM Cognos
   Configuration.

Set Environment Variables

You must set environment variables to identify the location of the Java Virtual
Machine (JVM) environment and the library path.

You can set environment variables using any of the following methods:
• On Microsoft Windows operating system, set a system or user variable, or edit
  the application server's startup script.
If you set a user variable, ensure that you set it for the user account that will run the application server, or administration console.

- On UNIX and Linux operating systems, set an environment variable in the user profile, or edit the application server's startup script.

For information about editing an application server's startup script, see "Change the Application Server Startup Script" on page 451.

Tip: Most application server versions ship with a script specifically intended for setting environment variables. For example, some IBM WebSphere versions ship with setupCmdLine.bat or setupCmdLine.sh, WebLogic ships with setEnv.cmd or setEnv.sh, and Oracle ships with iasenv.bat or iasenv.sh. These scripts can be modified to set appropriate values for use with IBM Cognos components. Most of these scripts set the JAVA_HOME environment variable by default.

**Procedure**

1. Set the JAVA_HOME environment variable to point to the JVM used by the application server.

   Tip: If the application server ships with a JVM, then the JAVA_HOME environment variable must be set to reference it.

   IBM Cognos Configuration uses this variable to create encryption keys for IBM Cognos components that are compatible with the JVM used by the application server.

   For example, for WebLogic under Windows, the JVM used by the application server is specified as:

   `drive:/WebLogic_location/jdkversion`

2. Append `c10_location/bin` to the appropriate environment variable from the following table.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris and Linux</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

The library path environment variable is used to locate the IBM Cognos library files.

Tip: To install multiple instances of IBM Cognos Business Intelligence on a single server, set the PATH, LIBPATH, LD_LIBRARY_PATH, or SHLIB_PATH variable within the application server instance scope and not as a global variable to ensure that each instance has a unique value.

**Results**

Note: The CRN_ROOT and COG_ROOT variables are no longer required in a non-clustered environment and should be removed if they were used in a previous installation.
Note: Ensure that the 32-bit or 64-bit library files are set in your environment variables. For a 64-bit version of IBM Cognos BI, the 64-bit library files must be listed first. For a 32-bit version, the 32 bit library files must be listed first.

Adjust the Default Connection Time-out for IBM Cognos Business Intelligence

The default connection pool time-out value used in IBM Cognos Business Intelligence is 25 seconds. Some application servers, such as IBM WebSphere, use a shorter value for the default connection time-out. To avoid conflicts between the default connection time-out settings, set the connection pool time-out value in IBM Cognos BI to a shorter duration than that configured for the application server.

Procedure
1. Using an editor, open the c10_location/configuration/BIBusTK_Config.xml file.
2. Find the following string:
   &lt;BIBUSTK_CONNECTION_TIMEOUT&gt;25000&lt;/BIBUSTK_CONNECTION_TIMEOUT&gt;
3. Change the value to 90% of the value specified for the application server.
   For example, WebSphere uses a default connection time-out value of 30 seconds. Calculate 90% of 30 seconds, which is 27 seconds. Change the string to
   &lt;BIBUSTK_CONNECTION_TIMEOUT&gt;27000&lt;/BIBUSTK_CONNECTION_TIMEOUT&gt;
4. Save the file.
5. Repeat these steps on every computer where you installed IBM Cognos BI.

Results
The setting will be applied when you deploy IBM Cognos BI to the server instance that you create for it.

Add User Role to Enable Single Signon Between IBM WebSphere Profiles

If you are using collaboration with IBM Connections, and you want to enable single signon between your IBM WebSphere profiles, you must modify two IBM Cognos Business Intelligence configuration files before you build and install your IBM Cognos BI application.

To set up single signon, you must set a shared password between the profile you are using for IBM Connections and the profile you are using for IBM Cognos BI.
For more information, see the IBM WebSphere http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp.

Single signon between IBM Cognos BI and IBM Connections is enabled by IBM WebSphere. This means that you must access IBM Cognos BI directly through the dispatcher, rather than through your Web server. For example, instead of accessing the IBM Cognos BI application from a URL such as http://webserver_name/ibmcognos, you will have to access it though the dispatcher URL, such as http://WebSphere_servername.domain:port/p2pd/servlet/dispatch/ext, where port is the port number of the IBM WebSphere profile where you have installed IBM Cognos BI. The URL is the same as that for your Dispatcher URIs for gateway in IBM Cognos Configuration.
Procedure
1. Go to the cognos_install_location\war\p2pd directory.
2. Open the file named application.xml.template in a text editor.
3. Edit the application section to include the following elements:
   <application>
     <display-name>IBM Cognos 10</display-name>
     <module>
       <web>
         <web-uri>@p2pdwar@</web-uri>
         <context-root>@p2pd@</context-root>
       </web>
     </module>
     <security-role id="SecurityRole_Cognos_BI_User">
       <description/>
       <role-name>BI User</role-name>
     </security-role>
   </application>
4. Save and close the file.
5. Go to the cognos_install_location\webapps\p2pd\WEB-INF directory.
6. Open the file named web.xml.withCM in a text editor.
7. After the last servlet-mapping section, and before the </web-apps> element, add the following:
   <security-constraint>
     <web-resource-collection>
       <web-resource-name>Cognos Dispatcher</web-resource-name>
       <url-pattern>/servlet/dispatch/ext/*</url-pattern>
       <http-method>GET</http-method>
       <http-method>POST</http-method>
     </web-resource-collection>
     <auth-constraint>
       <role-name>BI User</role-name>
     </auth-constraint>
   </security-constraint>
   <login-config>
     <auth-method>BASIC</auth-method>
     <realm-name>Cognos Dispatcher</realm-name>
   </login-config>
   <security-role>
     <role-name>BI User</role-name>
   </security-role>
8. Save and close the file.

Results
You can now configure IBM Cognos components to run within IBM WebSphere.

Configure IBM Cognos Components to Run Within the Application Server

IBM Cognos Business Intelligence must be configured with the application server configuration information, and the configuration must be saved to create new cryptographic keys. IBM Cognos Configuration uses the Java Virtual Machine (JVM) that is defined by the JAVA_HOME environment variable.

You must set the JAVA_HOME environment variable to the JVM supplied or used by the application server before you run IBM Cognos Configuration.
If you are using IBM WebSphere, you can use the Build Application Wizard to create the application as well as install it. You do not have to use the IBM WebSphere administration console to set properties or install the application. For more information, see “Use the Build Application Wizard to build and install IBM Cognos on IBM WebSphere” on page 450.

Procedure

1. Stop the IBM Cognos service if it is running.

2. From the c10_location/bin directory, start IBM Cognos Configuration:
   - On Microsoft Windows operating system, type cogconfig.bat in a command window or select IBM Cognos Configuration from the Start menu.
   - On UNIX or Linux operating systems, type cogconfig.sh

   If you have existing incompatible encryption keys, you will be prompted to automatically generate new ones at this time.

   Tip: Ensure that the existing keys are backed up to a secure location before proceeding. There is no undo action available after you generate new keys.

3. Use the Build Application Wizard to create the application file that will be deployed to the application server. To launch the Build Application Wizard from IBM Cognos Configuration, under Actions, click Build Application Files. The wizard allows you to select the type of application to build and the context root used to access the application.

   You must build the application file on the same computer on which you will be deploying the file.

   The context root value entered in the wizard must be the same as is entered in the Environment tab, and used to deploy to the application server. For IBM Cognos BI, the default context root and application directory name is p2pd, which can be used in most cases. For the IBM Cognos Servlet Gateway, the default context root and application directory name is ServletGateway. Other default application deployment values, such as the application name, may be changed to better suit your environment.

   Note: If you are installing IBM Cognos BI on IBM WebSphere and using collaboration with IBM Connections, ensure that you select Include static files from the Webcontent folder. This will allow you to access the application without using a Web server and allow you to configure single signon between IBM Cognos BI and IBM Connections.

   Tip: It is not necessary to rebuild or redeploy the archive file when you make configuration changes because configuration information is stored externally to the application.

   For WebLogic and JBoss, you can use the Build Application wizard in IBM Cognos Configuration to build the application to an expanded directory.

   For example, for WebLogic, you put the application in C:\bea\user_projects\domains\apps\p2pd, where p2pd is the name of the application. When deploying the application from the WebLogic Administration Console, you would select the p2pd directory.

   For JBoss, if you use the Expand files into a folder option, you must include the .war extension in the name of the folder where the wizard will create the p2pd application. When the wizard prompts for the folder location, go to JBoss_location/server/instance_name/deploy and create a folder named p2pd.war.
For information about which type of application file, WAR, EAR or expanded
directory, is supported in your environment, see your application server
documentation.

4. In the Explorer window of IBM Cognos Configuration, expand Environment
and then change the following properties to use the port number and host
name or IP address of the server where the IBM Cognos BI component and
application server are installed.
   • All URIs for the dispatcher, including
     Dispatcher URIs for Gateway
     External dispatcher URI
     Internal dispatcher URI
     Dispatcher URI for external applications
   • Gateway URI
   • Content Manager URIs

   The application server must be configured to listen on the host name or IP
   address entered in the URI. For more information, see your application server
documentation.

   If you change the context root from the default value of p2pd, you must change
   the context root portion of the URI as well.

   **Important:** If you are using collaboration with IBM Connections, ensure that
   you use the full domain name of the computer where your services are running
   for the URIs. If you do not include the domain, IBM Connections will not allow
   access as it cannot verify the domain from which the access is coming.
   For example, you must change values such as http://localhost:9300 to use the
   server name, domain, and the transport port number for your IBM WebSphere
   profile. If you have IBM WebSphere installed on a computer named
   MyComputer that is running on your domain named MyCompanyName.com,
   then localhost must be changed to MyComputer.MyCompanyName.com. If you
   are using the default IBM WebSphere transport port number, 9080, then
   MyComputer.MyCompanyName.com:9080/.

5. Under Environment > IBM Cognos services, right-click IBM Cognos, and then
   click Delete.
   The entry for the IBM Cognos service is used to configure environment settings
   for running under Tomcat. The entry is not required when using a different
   application server.

6. Complete other required configuration changes such as
   • specifying properties for the Content Manager database
   • entering user IDs and passwords

   If you used the default settings for the IBM Cognos installation, you may only
   have to make minor changes to the default configuration settings.

7. Save the configuration.
   New cryptographic keys are created using the JVM that is defined by the
   JAVA_HOME variable.

8. Close IBM Cognos Configuration.
Use the Build Application Wizard to build and install IBM Cognos on IBM WebSphere

Use the Build Application Wizard to build, install, and configure your IBM Cognos application on IBM WebSphere.

You can perform all of the actions in sequence, or you can perform them individually. The following task describes the process in sequence.

**Before you begin**

IBM WebSphere must be installed on the same computer as you have installed IBM Cognos BI.

You must set the JAVA_HOME environment variable to the JVM supplied or used by the application server before you run IBM Cognos Configuration.

IBM WebSphere does not need to be running to use the Build Application Wizard to install IBM Cognos BI.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, under IBM Cognos services, right-click IBM Cognos, and click Delete.
4. Enter a Name, and select WebSphere in the Type box.
5. Click OK.
6. In the WebSphere Application Server location box, click the browse button, and select the location of your IBM Websphere Application Server installation.
7. In the Profile box, select the name of the profile into which you want IBM Cognos BI installed.
   - You can enter a new name in the Profile box. IBM Cognos Configuration will create a new profile using the name you enter.
   - If a previous installation of IBM Cognos exists in the profile you select, the Build Application Wizard will allow you to uninstall the previous installation before installing the new one.
8. In the Server Instance box, select the server instance for your IBM WebSphere profile.
9. Right-click the name you gave your IBM WebSphere configuration, and click Build.
   - The Build Application Wizard appears. Follow the instructions in the wizard and click the Help button for more information for each page. The wizard will allow you to build the application, and install it to the IBM WebSphere profile you entered above.
   - The application will be configured to run. For example, the path values will be added and the correct JVM settings will be applied.
   - On the Configure IBM Cognos for WebSphere page, ensure that you enter the correct port numbers for the IBM WebSphere profile. The values are provided in the top section of the page. These values will be applied to the IBM Cognos Configuration Environment settings.
Tip: To test your IBM WebSphere configuration, right-click the name you gave your IBM WebSphere configuration, and click Test. The dialog will show any configuration errors. Click the Details button to view any messages.

10. Restart your IBM WebSphere profile.

You can uninstall your IBM Cognos application from IBM WebSphere from IBM Cognos Configuration. Right-click the name you gave your IBM WebSphere configuration, and click Uninstall.

### Identifying the JDK for WebLogic 9 on AIX

WebLogic 9 requires Java Development Kit (JDK) 1.5. If you use WebLogic Server 9 on AIX, you must update the Java options in the commEnv.sh file to specify the appropriate serial version unique identifier (UID). If you do not make this update, a serial version UID mismatch occurs when using WebLogic Server 9 with IBM Java 5.

**Procedure**

1. Open the WebLogic9_location/common/bin/commEnv.sh file.
2. Modify the file to include the following command:
   ```
   JAVA_OPTIONS="${JAVA_OPTIONS} -Dcom.sun.xml.namespace.QName.useCompatibleSerialVersionUID=1.0" export JAVA_OPTIONS
   ```
3. Save and close the commEnv.sh file.

### Change the Application Server Startup Script

Some application servers have specific requirements that you must meet before you can run IBM Cognos Business Intelligence. Depending on the application server, you may have to define environment variables, copy files, and add or change code in files.

If you are using Red Hat JBoss or Oracle WebLogic Server, you must make changes to the application server startup script.

If you are using IBM WebSphere Application Server or Oracle Application Server, no changes to its startup script are required unless you want to add the environment variable changes. If you do make changes, the Administrative Console can be used.

If your environment contains a JRE that you are using for other products, the JRE folder may contain .jar files that are not compatible with the .jar files that are provided with IBM Cognos BI. This may result in a failure to start IBM Cognos BI on your application server. In this situation, direct IBM Cognos BI to use the endorsed .jar files by including the following parameter in the Java command line:

```
-Djava.endorsed.dirs=${ibmcognos_home}/tomcat[version]/common/endorsed
```

### Change the Application Server Startup Script for WebLogic

If you are using Oracle WebLogic Server, the startup script must be modified to specify Java Virtual Machine (JVM) settings. For WebLogic 9, use the Administration Console to modify the WebLogic environment.

**Procedure**

1. Create a WebLogic Server (WLS) domain for IBM Cognos BI.
If you are configuring the IBM Cognos Servlet Gateway, create a second domain for this application.

For information about creating domains, see the WebLogic documentation.

2. Go to the WebLogic_location/user_projects/domains/domain_name/bin directory and open the application server startup script in an editor.

   The name of the startup script may vary depending on the type of WebLogic installation performed. For example, in a managed server installation, the name of the startup script is startManagedWebLogic.sh (UNIX operating system) or startManagedWebLogic.cmd (Microsoft Windows operating system).

3. For non-IBM JRE versions, select the JVM run mode, and change the default setting from JAVA_VM= to JAVA_VM=-server

4. Modify the JAVA_OPTIONS to set the appropriate XML parser for IBM Cognos BI. Add the third line, as shown in this example:

   ```
   JAVA_OPTIONS=
   -Dweblogic.security.SSL.trustedCAKeyStore=%WL_HOME%/server/lib/cacerts
   -Dorg.xml.sax.driver=org.apache.xerces.parsers.SAXParser
   ```

5. Set the minimum and maximum memory used by the JVM.

   Typically, the memory is set using two JVM parameters: -Xms and -Xmx. A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment.

   The MaxPermSize parameter must also be set. Here is an example:

   ```
   -XX:MaxPermSize=128m
   ```

   For information about JVM parameters, see the JVM or application server documentation.

6. Ensure that the production mode is enabled by changing

   ```
   PRODUCTION_MODE=
   ```

   to

   ```
   PRODUCTION_MODE=true
   ```

7. Save and close the file.

### Change the Application Server Startup Script for JBoss

If you are using Red Hat JBoss, the startup script must be modified to specify Java Virtual Machine (JVM) settings. You must also specify a log4j argument.

For Red Hat JBoss, create a copy of the default server instance so that you can use the original default server instance as a backup. Give the copy a name that does not use spaces, such as cognos.

#### Procedure

1. Go to the JBoss_location/bin directory and open the application server startup script in an editor. Do one of the following:
   - For Windows, open run.bat
   - For UNIX or Linux operating systems, open run.sh

2. Go to the JAVA_OPTS variable and add the following parameters:

   ```
   -Xms512m -Xmx1024m
   -XX:PermSize=64m -XX:MaxPermSize=256m
   -Dorg.jboss.resolver.warning=true
   -Dsun.rmi.dgc.client.gcInterval=3600000
   -DLog4j.defaultInitOverride=true
   ```
The minimum and maximum memory settings are suggested starting values. You can change these values to suit your environment. For information about these parameters, see the JVM or application server documentation.

3. For HP Itanium 64 bit, also add the following parameters:
   -Djava.library.path=/install_location/bin64
   -d64
   -Xss4m
   If SSL is enabled, increase the Java thread stack to 12 MB. For example, -Xss12m.

4. Save and close the file.

Configure Application Server Properties and Deploy IBM Cognos Components

You must configure application server properties and deploy the IBM Cognos components.

Configure Application Server Properties and Deploy IBM Cognos Components for WebSphere

You must configure application server properties and deploy the IBM Cognos components.

Procedure
1. Start the WebSphere Application Server, and then access the WebSphere Administrative Console.

2. Create a new server instance into which the IBM Cognos Business Intelligence application will be deployed, if this option is available in the version you are running.
   
   If you are deploying the IBM Cognos Servlet Gateway, create a second separate server instance.

3. Install a new Enterprise Application using the application file that was built by IBM Cognos Configuration.

   For IBM Cognos BI, the default context root is p2pd, which can be used in most cases. For the IBM Cognos Servlet Gateway, the default context root is ServletGateway. Other default application deployment values, such as the application name, may be changed to better suit your environment. The context root value used to deploy the application must be the same as the context root value entered in IBM Cognos Configuration when running the Build Application wizard.

4. Set the memory used by the JVM.
   Usually, the memory is set by adding or changing the initial and maximum Java heap size. For information about these parameters, see the JVM or application server documentation.

   **Tip:** A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment.

5. Set other JVM options, if required.

   The JVM process can be tuned by specifying various options as arguments to the Java process. For information about the possible parameters, see the JVM documentation.

6. In the server properties, add an environment variable, as listed in the following table, that references the `installation_location/bin` directory.
Ensure that you use the appropriate library files for the version of the IBM Cognos BI server that you install. IBM Cognos BI requires 32-bit library files when running in a 32-bit application server and it requires 64-bit library files when running in a 64-bit application server. Depending on the version of DB2 that you have installed, you may have to change the library files or change the order in which the library files are listed so that IBM Cognos BI server can find the correct files. Whichever version of library files are needed must be listed first.

7. If you are using collaboration with IBM Connections, you must enable access for the BI User role you added in “Add User Role to Enable Single Signon Between IBM WebSphere Profiles” on page 446.
   • In the IBM WebSphere administration console, click Applications > Enterprise applications.
   • Click IBM Cognos.
   • In the Detail properties section, click Security role to user/group mapping.
   • Select the Select check box for BI User, and select the All authenticated? check box.
   • Click OK, and then click Save.

8. Stop and then restart the WebSphere application server instance used for IBM Cognos components.

9. Verify that IBM Cognos components are running by looking for the following message in the application server admin console or in the application server log file:
   The dispatcher is ready to process requests.

### Configure Application Server Properties and Deploy IBM Cognos Components for WebLogic

You must configure application server properties and deploy the IBM Cognos components.

**Procedure**

1. If you used the expanded directory option when building the application in IBM Cognos Configuration, go to step 2. If you created a WAR file, expand the application manually:
   • Create a directory in a location that is accessible to the application server, giving the directory the same name as the context root.
   For IBM Cognos BI, the default context root and application directory name is p2pd, which can be used in most cases. For the IBM Cognos Servlet Gateway, the default context root is ServletGateway. Other default application deployment values, such as the application name, may be
changed to better suit your environment. The context root value used to
deploy the application must be the same as the context root value entered
in IBM Cognos Configuration.

- From the directory you just created, extract the application WAR file to the
  WebLogic installation using the following command from a command
  prompt:

  \[WebLogic_location/jdk_version/bin/jar xvfm "installation_location/
  application.war".\]

  A space and then a period are required at the end of the command. In this
  command, the period does not refer to the current directory.

2. Start the WebLogic Administration Server and the WebLogic Managed Server
   associated with the IBM Cognos domain.

   Node Manager must be started before you can start and stop Managed Server
   instances using the Administration Console

3. You must modify the environment in the WebLogic Administration Console
   before deploying IBM Cognos BI. Logon to the Administration Console and
   navigate to the Managed Server instance that will host the IBM Cognos BI
   application. Select the Server Start tab for the Managed Server instance and
   enable edit mode.

4. In the Java Home box, enter the path for the JVM. This value must be the
   same as is used for IBM Cognos BI. You must use the JVM that is included
   with the WebLogic installation.

5. Set the Java arguments.

   The Java arguments include all JVM settings, such as memory settings
   specified using two JVM parameters: -Xms and -Xmx.

   The MaxPermSize must also be set. You must also set the appropriate XML
   parser for IBM Cognos BI.

   For example, in the Arguments box, type

   \[-Xms768m -Xmx768m -XX:MaxPermSize=128m\]
   \[-Dorg.xml.sax.driver=org.apache.xerces.parsers.SAXParser\]

   If you use WebLogic on AIX, you must also specify the appropriate serial
   version UID in the Java arguments. If you do not make this update, a serial
   version UID mismatch occurs when using WebLogic with Java 5 because
   WebLogic requires JDK 1.5.

   For example, in the Arguments box, type

   \[-Xms768m -Xmx768m -XX:MaxPermSize=128m\]
   \[-Dorg.xml.sax.driver=org.apache.xerces.parsers.SAXParser\]
   \[-Dcom.sun.xml.namespace.QName.useCompatibleSerialVersionUID=1.0\]

   For information about JVM parameters, see the JVM or application server
   documentation.

6. Save and apply the changes.

   You can now start and stop the Managed Server instance from the Control
   tab.

7. Start the server instance. The server instance must be started before deploying
   IBM Cognos BI or IBM Cognos Servlet Gateway.

8. Deploy the IBM Cognos BI or IBM Cognos Servlet Gateway application in the
   WebLogic console using a new Web application as follows:

   - Set the application name.

     For example, ibmcognos
Set the path to the directory where the expanded application files are located.

Note: IBM Cognos BI uses a custom loader. You must use the expanded directory option when deploying.

Select the target server instance.

Use the Administration Server only for WebLogic administration tasks and deploy the IBM Cognos BI application to its own Managed Server instance.

9. After the deployment has completed successfully, set the reload period for the Web application to -1 to improve performance. This will prevent WebLogic from checking for updated application files that are used only in a development environment.

10. Stop and then restart the WebLogic Managed Server associated with the IBM Cognos domain to activate the changes.

11. Verify that IBM Cognos components are running by looking for the following message in the application server console window or in the application server log file:

The dispatcher is ready to process requests.

Configure Application Server Properties and Deploy IBM Cognos Components for SAP NetWeaver on Windows

You must configure application server properties and deploy the IBM Cognos components.

Procedure

1. Open the configuration tool by typing

   drive:\usr\sap\sapid\JCxx\j2ee\configtool\configtool.bat

   For example, if the SAP ID is J2E and the installation is on drive D, you would type

   D:\usr\sap\J2E\JC00\j2ee\configtool\configtool.bat

2. When prompted to use the default DB settings, click Yes.

3. Under cluster-data, instance_IDxxxxxxx, Dispatcher_IDxxxxxxx, services, where xxxxxxx is the ID number for your installation, highlight http.

4. Under Global Properties, highlight KeepAliveTimeout and type a higher number and then click Set.

   Tip: We suggest an initial KeepAliveTimeout number of at least 60.


6. Set the memory used by the JVM.

   Follow the recommendations from SAP. For more information, see SAP Note 723909 in the SAP Support Portal.

   If your computer has less than 1.5 GB of memory, you may have issues when you run SAP NetWeaver. We suggest a minimum value of 768 MB.

7. In the Java parameters box, set the XML parser as follows:

   -Dorg.xml.sax.driver=org.apache.xerces.parsers.SAXParser

8. For IBM Cognos BI environments that use Report Studio, under cluster-data, instance_IDxxxxxxx, highlight Server_IDxxxxxxx, services, and highlight http.

9. Under Global Properties, highlight CompressedOthers, type false, and then click Set.

10. Save the changes.
You are prompted to restart the server.

11. Restart the server by using the SAP Management Console or by restarting the services in Services.

12. Use the Deploy tool to create a new project.

13. Load the IBM Cognos application file you created using IBM Cognos Configuration. By default, the file is named p2pd.ear for IBM Cognos BI and ServletGateway.ear for IBM Cognos Servlet Gateway.

14. Using the Deploy tool, connect to the Administration tool and deploy the application file.

15. When you are prompted to start the application, click Yes.

16. Save the project.

**Configure Application Server Properties and Deploy IBM Cognos Components for Oracle Application Server Release 3**

You must configure application server properties and deploy the IBM Cognos components.

**Procedure**

1. Create an OC4J instance for IBM Cognos components to run within.

2. On Windows only, comment out the following entries in the `Oracle_location\j2ee\Cognos_OC4j_instance\config\global-web-application.xml` file:
   ```xml
   <welcome-file-list>
   <welcome-file>index.html</welcome-file>
   <welcome-file>default.jsp</welcome-file>
   <welcome-file>index.htm</welcome-file>
   <welcome-file>index.jsp</welcome-file>
   </welcome-file-list>
   ```


4. Add an environment variable that references the `installation_location/bin` directory and set variables for data sources.

Here is an example for Windows and DB2:

```xml
<environment>
  <variable id="PATH" value="c10_location/bin" append="true"/>
  <variable id="DB2DIR" value="location"/>
  <variable id="DB2INSTANCE" value="instance_name"/>
  <variable id="INSTHOME" value="location"/>
</environment>
```

The following table lists the environment variables for each operating system that must reference the `c10_location/bin` directory.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris</td>
<td>LD_LIBRARY_PATH</td>
</tr>
</tbody>
</table>
Operating system | Environment variable
---|---
HP-UX | SHLIB_PATH

5. Set the memory used by the JVM.
   A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment. For information about these parameters, see the JVM or application server documentation.

   Here is an example:
   `<data id="java-options" value="-server -Xmx768m -XX:MaxNewSize=384m -XX:NewSize=192m -XX:MaxPermSize=128m -classpath c10_location\bin;c10_location\webapps\p2pd\WEB-INF\lib -"/>

6. Define the OC4J userThreads setting.
   Here is an example:
   `<data id="oc4j-options" value="-userThreads"/>

7. Add the -Dcom.sun.management.jmxremote option to the start parameters section.
   For example:
   `<category id="start-parameters">
   <data id="java-options" value="-Dcom.sun.management.jmxremote"/>
   You can also set this by selecting the **Enable J2SE 5.0 Platform MBeans** option in the server properties page for the OC4J instance.

8. Save and close the Oracle_location/opmn/conf/opmn.xml file.

9. Deploy the IBM Cognos application file (named p2pd.ear for IBM Cognos BI or ServletGateway.ear for IBM Cognos Servlet Gateway, by default) created by IBM Cognos Configuration.
   The value of the Map to URL parameter must be the same as the context root value entered in IBM Cognos Configuration.

10. Start the OC4J instance that you created for IBM Cognos components.

11. Verify that IBM Cognos components are running by looking for the following message in the application server console window or in the application server log file:
    The dispatcher is ready to process requests.

**Configure Application Server Properties and Deploy IBM Cognos Components for JBoss**

You must configure application server properties and deploy the IBM Cognos components.

**Procedure**

1. If you do not want to use the default port of 8080, open the `JBoss_location/server/instance_name/deploy/jbossweb-tomcat55.sar/server.xml` file.

2. In the server.xml file, change the default port number of 8080 used by the server instance to the port specified in IBM Cognos Configuration. For example,
   `<Service name="jboss.web"
    className="org.jboss.web.tomcat.tc5.StandardService">
   <Connector port="8080" address="${jboss.bind.address}"
   </Connector>`
3. Save and close the server.xml file.

4. Put the p2pd application in the $JBoss_location/server/instance_name/deploy folder, if it is not already in this location.

5. Start the application server.
   For jBoss 5.0, the default behaviour is to bind its services to the localhost (127.0.0.1). However, this may cause errors when you access your IBM Cognos BI application. To avoid these errors, add the -b attribute when you start the server. For example, use a command like
   ```
   run.bat -c <server_name> -b #.#.#.#
   ```
   In a test environment, to run jBoss 5.0 with legacy behaviour, you can use -b 0.0.0.0, which binds to all available interfaces.

   **Important:** For a production environment, ensure that you secure your application server properly and do not use -b 0.0.0.0 as the binding address. For more information, see the jBoss documentation.

   The p2pd application is automatically detected and started by the application server.

6. Verify that IBM Cognos components are running by looking for the following message in the application server console window or in the application server log file:
   ```
   The dispatcher is ready to process requests.
   ```

---

**Configure Application Server Properties and Deploy IBM Cognos Components for Sun GlassFish Enterprise Server**

You must configure application server properties and deploy the IBM Cognos components.

**Procedure**

1. Use the Sun GlassFish Enterprise Server Admin Console to add a new JVM Option to set the XML Parser that will be used by the IBM Cognos Application. For example:
   ```
   ```

2. Add a JVM Option to set the Maximum Java Heap Size to limit the maximum amount of memory that can be used by the Java process. Usually, the memory is set by adding or changing the initial and maximum Java heap size. For information about these parameters, see the JVM or application server documentation.
   For example, add "-Xmx768M" to set 768M of memory as a maximum value for the Java process.

   **Tip:** A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment.

3. Increase the "Maximum number of request processing threads" from the default of 5 to a value appropriate for your environment.
Tip: Start with a value of 250. If the value is too low, system instability and failed processes occur. If the value is too high, system resources are reserved unnecessarily.

4. Copy the c10_location\webapps\p2pd\WEB-INF\lib\xercesImpl.jar file to SJSAS_location\domains\<domain name>\lib\ext.

5. Deploy the IBM Cognos application file (named p2pd.ear for IBM Cognos BI or ServletGateway.ear for IBM Cognos Servlet Gateway, by default) created by IBM Cognos Configuration.
In the Sun GlassFish Enterprise Server Admin Console, go to Common Tasks > Applications > Enterprise Applications, and use the local packaged file option to select the ear file you want to deploy.

Enable SSL

If you use the Secure Socket Layer (SSL) for IBM Cognos components, you must also enable SSL in the application server environment. You then identify the SSL server certificate to IBM Cognos components.

Procedure

1. Configure the application server to use SSL.
   An SSL server certificate is generated by another Certificate Authority (CA). The certificate of the CA that generated the SSL server certificate is also provided.
   For more information about configuring the application server to use SSL, refer to the application server documentation. For information about using CA certificates with your application server, see the CA documentation.

2. Copy the CA certificate to the installation_location/bin directory and rename the file to ca.cer.
   This file must be Base-64 encoded X.509 format.

3. From the installation_location/bin directory:
   - On Microsoft Windows operating system, type:
     ThirdPartyCertificateTool.bat -T -i -r ca.cer -k ../configuration/signkeypair/jCAKeystore -p password
   - On UNIX or Linux operating systems, type:
     ThirdPartyCertificateTool.sh -T -i -r ca.cer -k ../configuration/signkeypair/jCAKeystore -p password
   You must type jCAKeystore as the name of the CA key store.

Configuring Web Communication

For most types of supported application servers, you use a Web server and an IBM Cognos gateway for Web communication. In that situation, perform the tasks in this section.

For information about configuring the WebSphere Web server plugin, contact the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

If you are using SAP NetWeaver on Microsoft Windows operating system and you are not using a Web Server and an IBM Cognos gateway for web communication, follow the steps to [configure a virtual directory].
Configure the Web Server

For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal. If you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool. The steps for creating an application pool vary depending on your operating system.

For IBM Cognos BI for reporting, you must also set the content expiry for the images directory in your Web server so that the Web browser does not check image status after the first access.

On UNIX and Linux operating systems, the account under which the Web server runs must have read access to the cogstartup.xml file in the c10_location/configuration directory. By default the cogstartup.xml file has read permission for others. If you run your Web server under a specific group, you can change the cogstartup.xml file permissions to ensure that it belongs to the same group as the Web server. You can then remove the read permission for others.

Creating Virtual Directories

For all installations, before you use Web pages generated by IBM Cognos Business Intelligence, you must configure your Web server. You must create virtual directories, or aliases, so that users can connect to IBM Cognos BI in the portal.

Procedure

1. Create the virtual directories shown in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias and you must change the virtual directory in the Gateway URI property to match the new IBM Cognos alias.

If you are upgrading from ReportNet or an earlier version of IBM Cognos BI, you can continue to use the existing aliases. If you install IBM Cognos BI reporting components in a different location from the earlier version, change the existing aliases to include the new location. If you have more than one version of ReportNet or IBM Cognos BI on one computer, you must use different alias names for IBM Cognos BI.

For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. The ibmcognos/cgi-bin alias must be defined as a ScriptAlias.

2. If you want to use the Report Studio image browser, enable Web Distributed Authoring and Versioning (WebDAV) on your Web server.

If you use Apache Web Server, specify a directory in which to enable WebDAV. For information about configuring WebDAV, see your Web server documentation.
If you use Microsoft Internet Information Services (IIS), enable the Read and Directory Browsing properties for the URL you want to access.

3. For IBM Cognos BI for reporting, set the content expiry on the c10_location/webcontent/pat/images virtual directory in your Web server.

   Each time a user opens Report Studio, their Web browser checks with the Web server to determine if images are current. Because there are over 600 images, this can result in excess network traffic. You can postpone this check until a specified date by using the content expiry feature of the Web server.

   For information on setting content expiry, see the documentation for your Web server.

   **Note:** When you upgrade, Report Studio users must clear their Web browser cache to get the latest images.

**Results**

If you use Web aliases other than ibmcognos, or your Web server is on another computer, or you are using Microsoft Internet Application Interface (ISAPI), apache_mod or a servlet gateway, change the Gateway URI when you configure IBM Cognos components.

**Creating an Application Pool**

If you are using Microsoft IIS as your Web server and you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool.

For more information about creating an application pool, see your Web server documentation.

**Configure a Virtual Directory for SAP NetWeaver on Windows**

If you are using SAP NetWeaver on Microsoft Windows operating system and you are not using a Web Server and an IBM Cognos gateway for web communication, you must create a virtual directory, also known as a Web alias.

This virtual directory is required to allow the static content (html pages, images, and so on) to load. When building the IBM Cognos application file, select the option to include the static files from the webcontent folder. Create a virtual directory that uses the context root value as a name (by default, p2pd for IBM Cognos Business Intelligence or ServletGateway for the IBM Cognos Servlet Gateway). Ensure the virtual directory points to the c10_location/webcontent folder.

**Procedure**

Create the virtual directory listed in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>context_root (for example, p2pd)</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
</tbody>
</table>
Unregister Dispatchers

After you start the application server and the IBM Cognos application, unregister any IBM Cognos dispatchers that were previously registered and that are no longer used. For example, unregister any Tomcat dispatchers that are now running under the application server.

You remove dispatchers using IBM Cognos Administration. To access this tool, you must have execute permissions for the Administration secured function.

Procedure
1. Open IBM Cognos Connection by connecting to the IBM Cognos Business Intelligence portal and clicking IBM Cognos Content on the Welcome page.
2. In the upper-right corner, click Launch > IBM Cognos Administration.
3. On the Configuration tab, click Dispatchers and Services.
4. For the dispatcher you want to unregister, from the Actions column, click More.
5. Click Unregister.
6. In the confirmation dialog box, click OK.

Results
The dispatcher information is removed from Content Manager.

Import Content Store Data
If you exported the content store before setting up IBM Cognos components to run in your application server, import the deployment to restore and encrypt the data using the new encryption keys.

Procedure
1. Start IBM Cognos Business Intelligence.
2. Import the entire content store using the Deployment tool.
   For more information, see the topic about importing to a target environment in the Administration and Security Guide.

Upgrade to IBM Cognos Business Intelligence in an Application Server Environment
If you are upgrading from a supported release to IBM Cognos Business Intelligence, perform the following steps.

Procedure
2. Use the administrative tools for your application server to undeploy the existing IBM Cognos application.
   For information about undeploying applications, see your application server documentation.
   If the directory to which the existing IBM Cognos application was originally deployed is not removed during the undeploy process, delete the directory.
Also, remove any IBM Cognos .jar files that are cached in your application server environment.
In WebLogic 8.1, the cache location is %WL_HOME%\user_projects\domains\domain-name\managed-server-name\wlnotdelete\extract\crn_p2pd_p2pd\ jarfiles

3. Uninstall the existing version.
4. Install IBM Cognos BI.
5. Follow the appropriate instructions in this chapter for changing to your application server.
   Most installations must perform the following:
   • Configure IBM Cognos BI to run within the application server
   • Configure application server properties and deploy IBM Cognos BI
6. To activate new features after upgrading, save the configuration in IBM Cognos Configuration, and then restart the services.

Upgrade from Metrics Manager to IBM Cognos Business Intelligence in an Application Server Environment

If you are upgrading from Metrics Manager to IBM Cognos Business Intelligence, perform the following steps.

Procedure
1. Follow the procedure to upgrade Metrics Manager to IBM Cognos BI "Upgrade Metrics Manager to IBM Cognos BI" on page 109.
2. Follow the appropriate instructions in this chapter for changing to your application server.
   Most installations must perform the following:
   • Configure IBM Cognos BI to run within the application server
   • Configure application server properties and deploy IBM Cognos BI
3. To activate new features after upgrading, you must save the configuration in IBM Cognos Configuration, and then restart the services.
Chapter 16. Advanced Configuration Options

Advanced configuration options enhance security, improve performance, or change the default behavior of IBM Cognos BI components.

Advanced configuration options are changes that you make after installation to the configuration properties of the resources that IBM Cognos Business Intelligence components use. You cannot use IBM Cognos Configuration to make these changes.

Changing the Version of Java Runtime Environment Used by IBM Cognos BI Components

IBM Cognos BI components require Java Runtime Environment (JRE) to operate.

If you want to change your current JRE, some configuration changes are required. Changing may be appropriate in the following situations:

- You want to use IBM Cognos BI components with an application server that requires a specific JRE version.
- You already use a JRE version with other applications.

The current version provided with IBM Cognos BI is JRE 6.0. For more information about the supported JRE versions, see the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

IBM Cognos Configuration and other IBM Cognos BI components use the JRE referenced by the JAVA_HOME environment variable. On Microsoft Windows operating system, if JAVA_HOME is not set, the JRE that is packaged with IBM Cognos BI components is used by default.

Changing the JRE versions

Change the JRE version in the following situations: you want to use IBM Cognos BI components with an application server that requires a specific JRE version or you already use a JRE version with other applications.

Before you begin

Ensure that IBM Cognos BI components are installed and that JRE you want to use is installed.

Procedure

1. Back up existing IBM Cognos data and encryption keys, if required.
2. Update the Java environment
3. Import data to the content store, if required.

Back Up Existing IBM Cognos Information

You must back up existing IBM Cognos information if IBM Cognos Business Intelligence components are running on an application server (including Tomcat).
and you are changing to an application server that ships with its own JVM. You must also back up existing IBM Cognos information if you must change the JVM you are using.

**Note:** You must back up existing IBM Cognos information within the working environment prior to upgrade.

Before configuring IBM Cognos BI components to run on the new application server or JVM, you must back up
- content store data by creating a deployment export.
- configuration information by exporting it. Any encrypted data is decrypted during the export.
- cryptographic keys by saving them to an alternate location. New cryptographic keys must be created using the same JVM that the application server uses. Because these keys can be created only if the previous keys are deleted, it is important to back up the previous keys.

To ensure the security and integrity of your IBM Cognos data, back up the content store, configuration information, and cryptographic keys to a directory that is protected from unauthorized or inappropriate access.

**Tip:** To check if any cryptographic keys exist, look in the `c10_location/configuration` directory. Cryptographic keys exist if this directory includes the following subdirectories: csk, encryptkeypair or signkeypair.

**Procedure**

1. If data exists in the content store, start the IBM Cognos service and export the entire content store using the Deployment tool.
   
   For more information, see the topic about creating an export deployment specification in the *Administration and Security Guide*.

2. In IBM Cognos Configuration, from the **File** menu, click **Export As** and save the configuration information in a decrypted format. When naming the file, use a name such as “decrypted.xml”.

   Export the data to a directory that is protected from unauthorized or inappropriate access because passwords are stored in plain text. You are prompted to acknowledge that the export is an unsecure operation.

3. Stop the IBM Cognos service:
   - If you use Tomcat, stop the IBM Cognos service and close IBM Cognos Configuration.
   - If you use an application server other than Tomcat, shut down IBM Cognos BI in your environment.

4. Back up any existing cryptographic keys by saving the appropriate files and directories to an alternate location that is secure.

   The files are
   - `c10_location/configuration/cogstartup.xml`
   - `c10_location/configuration/caSerial`
   - `c10_location/configuration/cogconfig.prefs`
   - `c10_location/configuration/coglocale.xml`

   The directories are
   - `c10_location/configuration/csk`
   - `c10_location/configuration/encryptkeypair`
Update the Java Environment

You can use an existing Java Runtime Environment (JRE) or the JRE that is provided with IBM Cognos Business Intelligence. To support the cryptographic services in IBM Cognos BI, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

JAVA_HOME

If you want to use your own JRE and have JAVA_HOME set to that location on Microsoft Windows operating system or if you are installing on a UNIX or Linux operating system, you must update JAVA_HOME for the cryptographic services.

On Windows, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it may be necessary to restart your computer for it to take effect. If you set it as a user variable, set it so that the environment in which Tomcat (or other application server) is running can access it.

If you do not have a JAVA_HOME variable already set on Windows, the JRE files provided with the installation will be used, and you do not have to update any files in your environment. If JAVA_HOME points to a Java version that is not valid for IBM Cognos BI, you must update JAVA_HOME with the path to a valid Java version.

Unrestricted JCE Policy File

Whether you use the default Windows JRE or download a JRE for UNIX or Linux, the JRE includes a restricted policy file that limits you to certain cryptographic algorithms and cipher suites. If your security policy requires a wider range of cryptographic algorithms and cipher suites than are shown in IBM Cognos Configuration, you can download and install the unrestricted JCE policy file.

Update the Java Environment

To support the cryptographic services in IBM Cognos BI, you may be required to update or set a JAVA_HOME environment variable. Depending on your security policy, you may also have to install the unrestricted Java Cryptography Extension (JCE) policy file.

Procedure

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.
   For example, to set JAVA_HOME to the JRE files provided with the installation, the path is $c10_location/bin/jre/version.
2. Start IBM Cognos Configuration.
3. Save the configuration.
   IBM Cognos Configuration generates new keys and encrypts the data.
4. Download and install the unrestricted java policy file from the following location:

Import Content Store Data
If you exported the content store before changing the JVM, import the deployment to restore and encrypt the data using the new encryption keys.

Procedure
To import the content store data, start the IBM Cognos BI service and import the entire content store using the Deployment tool. For more information, see the topic about importing to a target environment in the Administration and Security Guide.

Configuring IBM Cognos BI Components to Use Another Certificate Authority
By default, IBM Cognos BI components use their own certificate authority (CA) service to establish the root of trust in the IBM Cognos security infrastructure. You can configure IBM Cognos BI components to use another certificate authority, if you already have an existing certificate authority, such as iPlanet or Microsoft, in your reporting environment.

When you configure IBM Cognos BI components to use another certificate authority, ensure that you specify the same information in both the command line utility tool and in IBM Cognos Configuration.

Use the following checklist to configure IBM Cognos BI components to use another certificate authority.
1. Generate IBM Cognos security keys and certificate signing requests to use with your CA.
2. Submit the Cognos security keys and certificates to your third-party certificate authority.
3. Configure IBM Cognos BI components to use a your certificate authority.

Command syntax for generating keys and certificate signing requests
Use the command line utility to generate all the keys for the IBM Cognos key stores and to generate the certificate signing requests (CSR).

The following tables list the options for the command-line tool used to generate keys and signing requests.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>Create a new CSR</td>
</tr>
<tr>
<td>-i</td>
<td>Import a certificate</td>
</tr>
</tbody>
</table>
Table 46. Operation modifiers

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-s</td>
<td>Work with the signing identity</td>
</tr>
<tr>
<td>-e</td>
<td>Work with the encryption identity</td>
</tr>
<tr>
<td>-T</td>
<td>Work with the trust store (only with -i)</td>
</tr>
</tbody>
</table>

Table 47. Information flags

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d</td>
<td>DN to use for certificate</td>
</tr>
<tr>
<td>-r</td>
<td>CSR or certificate file location (depends on mode)</td>
</tr>
<tr>
<td>-t</td>
<td>certificate authority certificate file (only with -i)</td>
</tr>
<tr>
<td>-p</td>
<td>Key Store password (must be provided)</td>
</tr>
<tr>
<td>-a</td>
<td>Key pair algorithm. RSA or DSA.</td>
</tr>
<tr>
<td></td>
<td>Default: RSA</td>
</tr>
<tr>
<td>-D</td>
<td>Directory location</td>
</tr>
</tbody>
</table>

The sample values from the following table are used:

Table 48. Sample values

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signing certificate DN</td>
<td>CN=SignCert,O=MyCompany,C=CA</td>
</tr>
<tr>
<td>Encryption certificate DN</td>
<td>CN=EncryptCert,O=MyCompany,C=CA</td>
</tr>
<tr>
<td>Key store password</td>
<td>password</td>
</tr>
</tbody>
</table>

Generate Keys and Certificate Signing Requests

Use the following steps to generate all the keys for the IBM Cognos key stores and to generate the certificate signing requests (CSR).

Procedure

1. In the c10_location\configuration directory, back up the cogstartup.xml file to a secure location.
2. Back up the contents of the following directories to a secure location:
   - c10_location\configuration\signkeypair
   - c10_location\configuration\encryptkeypair
3. Using IBM Cognos Configuration, export the configuration in clear text by doing the following:
   - Open IBM Cognos Configuration.
   - From the File menu, click Export As.
   - When prompted about exporting decrypted content, click Yes.
   - In the Export As dialog box, select cogstartup.xml and then click Save.
   - When prompted about replacing the existing file, click Yes.
   - When the tasks are complete, close the IBM Cognos Configuration dialog box.
   - Save the configuration.
4. Go to the `c10_location\bin` directory.

5. Create the certificate signing request for the signing keys by typing the following command:

   On UNIX or Linux operating system, type
   
   ```bash
   ThirdPartyCertificateTool.sh -c -s "CN=SignCert,O=MyCompany,C=CA" -r signRequest.csr -D ./configuration/signkeypair -p password
   ```
   
   On Microsoft Windows operating system, type
   
   ```bat
   ThirdPartyCertificateTool.bat c -s "CN=SignCert,O=MyCompany,C=CA" -r signRequest.csr -D ./configuration/signkeypair -p password
   ```
   
   Tip: UNIX or Linux filenames are case-sensitive and must be entered exactly as shown.
   
   You can safely ignore any warnings about logging.
   
   The command creates the `jSignKeystore` file in the `signkeypair` directory, sets the specified password, creates a new keypair and stores it in the keystore, and exports the `signRequest.csr` file to the `c10_location\bin` directory.

6. Create the certificate signing request for the encryption keys by typing the following command:

   On UNIX or Linux, type
   
   ```bash
   ThirdPartyCertificateTool.sh -c -e -d "CN=EncryptCert,O=MyCompany,C=CA" -r encryptRequest.csr -D ./configuration/encryptkeypair -p password
   ```
   
   On Windows, type
   
   ```bat
   ThirdPartyCertificateTool.bat c -e -d "CN=EncryptCert,O=MyCompany,C=CA" -r encryptRequest.csr -D ./configuration/encryptkeypair -p password
   ```
   
   You can safely ignore any warnings about logging.
   
   The command creates the `jEncKeystore` file in the `encryptkeypair` directory, sets the specified password, creates a new keypair and stores it in the keystore, and exports the `encryptRequest.csr` file to the `c10_location\bin` directory.

7. Copy the `signRequest.csr` and `encryptRequest.csr` files that were generated in steps 5 and 6 to a directory that is accessible by your certificate authority.

8. Input the `signRequest.csr` and `encryptRequest.csr` files into the certificate authority.

   The certificate authority produces a signing certificate and an encryption certificate.
   
   For more information, see your CA documentation.

9. Copy the contents of the signing certificate into a file named `signCertificate.cer`.

10. Copy the contents of the encryption certificate into a file named `encryptCertificate.cer`.

11. Find the root CA certificate for the certificate authority and copy the contents into a file named `ca.cer`.

12. Copy `ca.cer`, `signCertificate.cer`, and `encryptCertificate.cer` to `c10_location/bin`. These files must be PEM (Base-64 encoded ASCII) format.

13. Import the signing certificate from step 10 into the IBM Cognos signing key store by typing the following command:
On UNIX or Linux, type:
```
ThirdPartyCertificateTool.sh -i -s -r signCertificate.cer -D ../configuration/signkeypair -p password -t ca.cer
```
On Windows, type:
```
ThirdPartyCertificateTool.bat -i -s -r signCertificate.cer -D ../configuration/signkeypair -p password -t ca.cer
```
You can safely ignore any warnings about logging.
The command reads the signCertificate.cer and ca.cer files in the `c10_location\bin` directory and imports the certificates from both files into the jSignKeystore file in the signkeypair directory using the specified password.

14. Import the encryption certificate from step 11 into the IBM Cognos encryption key store by typing the following command:
On UNIX or Linux, type:
```
ThirdPartyCertificateTool.sh -i -e -r encryptCertificate.cer -D ../configuration/encryptkeypair -p password -t ca.cer
```
On Windows, type:
```
ThirdPartyCertificateTool.bat -i -e -r encryptCertificate.cer -D ../configuration/encryptkeypair -p password -t cacert.cer
```
You can safely ignore any warnings about logging.
The command reads the encryptCertificate.cer and ca.cer files in the `c10_location\bin` directory and imports the certificates from both files into the jEncKeystore file in the encryptkeypair directory using the specified password.

15. Import the CA certificate from step 12 into the IBM Cognos trust store by typing the following command:
On UNIX or Linux, type:
```
ThirdPartyCertificateTool.sh -i -T -r ca.cer -D ../configuration/signkeypair -p password
```
On Windows, type:
```
ThirdPartyCertificateTool.bat -i -T -r ca.cer -D ../configuration/signkeypair -p password
```
The command reads the ca.cer file and imports the contents into the jCAKeystore file in the signkeypair directory using the specified password.

**Results**
The certificates are now ready to be configured for IBM Cognos BI.

**Configure IBM Cognos BI Components to Run Within Another Certificate Authority**

You must configure each IBM Cognos computer to use an external certificate authority by setting the appropriate property in IBM Cognos Configuration.

By setting this property, IBM Cognos BI components assume that all required keys have been generated and vetted by the external certificate authority.

Ensure that the key store locations and password in IBM Cognos Configuration match the ones you typed in the command-line tool.
Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security > Cryptography, click Cognos.
3. In the Properties window, under Certificate Authority settings property group, click the Value box next to the Use third party CA property and then click True.

   Note: When you set this property to true, all properties for the certificate authority and identity name are ignored.

4. Configure the following properties to match the ones you typed in the command line utility:
   - Signing key store location
   - Signing key store password
   - Encryption key store location
   - Encryption key store password
   - Certificate Authority key store password

5. From the File menu, click Save.

6. If you want to start the IBM Cognos service, from the Actions menu, click Start.

   This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.
Chapter 17. Performance Maintenance

This section includes topics about using IBM Cognos and other tools and metrics to maintain the performance of your IBM Cognos Business Intelligence environment.

System Performance Metrics

IBM Cognos BI provides system metrics that you can use to monitor the health of the entire system and of each server, dispatcher, and service. You can also set the thresholds for the metric scores. Some examples of system performance metrics are the number of sessions in your system, how long a report is in a queue, how long a Java Virtual Machine (JVM) has been running, and the number of requests and processes in the system.

System performance metrics reside in the Java environment, but can be monitored in IBM Cognos Administration through IBM Cognos Connection. For more information about monitoring system performance metrics, see the Administration and Security Guide.

You can take a snapshot of the current system metrics so that you can track trends over time or review details about the state of the system at a particular time. For more information, see the topic about the metric dump file in the IBM Cognos Business Intelligence Troubleshooting Guide.

You can also monitor system metrics externally to IBM Cognos Administration by using Java Management Extensions (JMX), a technology that supplies tools to manage and monitor applications and service-oriented networks.

Monitoring System Metrics Externally

You can monitor system metrics outside of IBM Cognos Administration by using industry standard Java Management Extensions (JMX). First, you configure two JMX properties in IBM Cognos Configuration to enable secure access to the metrics in the Java environment. Then you use a secure user ID and password to connect to the metrics through a JMX connection tool.

Before you begin

You must install Oracle Java SE Development Kit or the Java Software Development Kit from IBM before you can use the external monitoring feature.

Procedure

1. In the location where Content Manager is installed, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, under Dispatcher Settings, click External JMX port.
4. In the Value column, type an available port number.
5. Click External JMX credential.
6. In the Value column, click the edit button, type a user ID and password, and then click OK.
The user ID and password ensure that only an authorized user can connect to the system metrics data in the Java environment, using the port specified in **External JMX port**.

7. Save the changes and restart the service.

8. To access the system metrics data, specify the following information in the JMX connection tool:
   - the URL to connect to the system metrics data
     For example,  
     ```
     service:jmx:rmi:///Content_Manager_server/jndi/rmi://monitoring_server:<JMXport>/proxyserver
     ```
     where JMXport is the value that you typed for **External JMX port**, and Content_Manager_server and monitoring_server are machine names. Do not use localhost, even if connecting locally.
   - the user ID and password to secure the connection
     Use the same values that you configured for **External JMX credential**.

### Enabling Only Services That are Required

If some IBM Cognos BI services are not required in your environment, you can disable them to improve the performance of other services.

For example, to dedicate a computer to running and distributing reports, you can disable the presentation service on an Application Tier Components computer. When you disable the presentation service, the performance of the Application Tier Components will improve.

**Note:**
- The Presentation service must remain enabled on at least one computer in your IBM Cognos BI environment.
- If you want to use Query Studio, you must enable the Presentation service.
- If you want to use Analysis Studio, you must enable the Report service.
- If some IBM Cognos BI components are not installed on a computer, you should disable the services associated with the missing components. Otherwise the IBM Cognos BI components will randomly fail.

### IBM Cognos services

After you install and configure IBM Cognos BI, one dispatcher is available on each computer by default. Each dispatcher has a set of associated services, listed in the following table.

<table>
<thead>
<tr>
<th>Service</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent service</td>
<td>Runs agents. If the conditions for an agent are met when the agent runs, the agent service asks the monitor service to run the tasks.</td>
</tr>
<tr>
<td>Service</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Annotation service</td>
<td>Enables the addition of commentary to reports via the IBM Cognos Workspace. These comments persist across versions of the report.</td>
</tr>
<tr>
<td>Batch report service</td>
<td>Manages background requests to run reports and provides output on behalf of the monitor service.</td>
</tr>
<tr>
<td>Content Manager cache service</td>
<td>Enhances the overall system performance and Content Manager scalability by caching frequent query results in each dispatcher.</td>
</tr>
<tr>
<td>Content Manager service</td>
<td>• Performs object manipulation functions in the content store, such as add, query, update, delete, move, and copy</td>
</tr>
<tr>
<td></td>
<td>• Performs content store management functions, such as import and export</td>
</tr>
<tr>
<td>Data movement service</td>
<td>Manages the execution of data movement tasks in IBM Cognos BI. Data movement tasks, such as Builds and JobStreams, are created in Data Manager Designer and published to IBM Cognos BI.</td>
</tr>
<tr>
<td>Delivery service</td>
<td>Sends emails to an external SMTP server on behalf of other services, such as the report service, job service, agent service, or data integration service</td>
</tr>
<tr>
<td>Event management service</td>
<td>Creates, schedules, and manages event objects that represent reports, jobs, agents, content store maintenance, deployment imports and exports, and metrics</td>
</tr>
<tr>
<td>Graphics service</td>
<td>Produces graphics on behalf of the Report service. Graphics can be generated in 4 different formats: Raster, Vector, Microsoft Excel XML or PDF.</td>
</tr>
<tr>
<td>Human task service</td>
<td>Enables the creation and management of human tasks. A human task such as report approval can be assigned to individuals or groups on an ad hoc basis or by any of the other services.</td>
</tr>
<tr>
<td>Index data service</td>
<td>Provides basic full-text functions for storage and retrieval of terms and indexed summary documents.</td>
</tr>
<tr>
<td>Index search service</td>
<td>Provides search and drill-through functions, including lists of aliases and examples.</td>
</tr>
<tr>
<td>Service</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Index update service</td>
<td>Provides write, update, delete, and administration functions.</td>
</tr>
<tr>
<td>Job service</td>
<td>Runs jobs by signaling the monitor service to run job steps in the background. Steps include reports, other jobs, import, exports, and so on.</td>
</tr>
</tbody>
</table>
| Log service             | Records log messages generated by the dispatcher and other services. The log service can be configured to record log information in a file, a database, a remote log server, Windows Event Viewer, or a UNIX system log. The log information can then be analyzed by customers or by Cognos Software Services, including:  
  - security events  
  - system and application error information  
  - selected diagnostic information |
| Metadata service        | Provides support for data lineage information displayed in Cognos Viewer, Report Studio, Query Studio, and Analysis Studio. Lineage information includes information such as data source and calculation expressions. |
| Metric Studio service   | Provides the Metric Studio user interface for monitoring and entering performance information                                            |
| Migration service       | Manages the migration from IBM Cognos Series 7 to IBM Cognos BI.                                                                          |
| Monitor service         | - Manages the monitoring and execution of tasks that are scheduled, submitted for execution at a later time, or run as a background task  
  - Assigns a target service to handle a scheduled task. For example, the monitor service may ask the batch report service to run a report, the job service to run a job, or the agent service to run an agent.  
  - Creates history objects within the content manager and manages failover and recovery for executing entries |
| PowerPlay service       | Manages requests to run PowerPlay reports.                                                                                               |
Table 49. IBM Cognos services (continued)

<table>
<thead>
<tr>
<th>Service</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation service</td>
<td>• Transforms generic XML responses from another service into output format, such as HTML or PDF</td>
</tr>
<tr>
<td></td>
<td>• Provides display, navigation, and administration capabilities in IBM Cognos Connection</td>
</tr>
<tr>
<td>Query service</td>
<td>Manages Dynamic Query requests and returns the result to the requesting batch or report service.</td>
</tr>
<tr>
<td>Report data service</td>
<td>Manages the transfer of report data between IBM Cognos BI and applications that consume the data, such as IBM Cognos BI for Microsoft Office and IBM Cognos Mobile.</td>
</tr>
<tr>
<td>Report service</td>
<td>Manages interactive requests to run reports and provides output for a user in IBM Cognos Connection or a studio.</td>
</tr>
<tr>
<td>Statistics service</td>
<td>If you install IBM Cognos Statistics, the optional Statistics service is available in IBM Cognos Administration. The Statistics service computes statistical results using the integrated IBM SPSS® statistics engine. This service generates textual statistics and statistical visualizations.</td>
</tr>
</tbody>
</table>

Tuning a DB2 Content Store

If you use a DB2 database for the content store, you can take steps to improve the speed with which requests are processed.

By default, DB2 assigns tables that contain large objects (LOBS) to a database-managed tablespace. As a result, the LOBS are not managed by the DB2 buffer pools. This results in direct I/O requests on the LOBS, which affects performance. By reassigning the tables that contain LOBS to a system-managed tablespace, you reduce the number of direct I/O requests.

Before changing a DB2 content store, allocate sufficient log space to restructure the database.

To reconfigure the DB2 content store, do the following:
• Export the data from the tables that contain at least one large object (LOB).
• Create the tables in a system-managed table space.
• Import the data into the tables.

Adjusting the Memory Resources for the IBM Cognos Service

To improve performance in a distributed environment, you can change the amount of resources that the IBM Cognos service uses.
By default, the IBM Cognos service is configured to use minimal memory resources to optimize startup time.

The configuration settings for the IBM Cognos service apply only to Tomcat, the application server that IBM Cognos BI uses by default. If you want to configure IBM Cognos BI to run on another application server, do not use IBM Cognos Configuration to configure the resources. Instead, configure the resources within that application server environment.

The IBM Cognos service is available only on the computers where you installed Content Manager or the Application Tier Components.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, expand **Environment > IBM Cognos services**, and then click **IBM Cognos**.
3. In the **Properties** window, change the value for **Maximum memory in MB**.
   - To reduce the startup time, memory footprint, and resources used, use the default setting of 768.
   - To balance between fast startup time and quick operating speeds, type a value about 1.5 times the default value, such as 1152.
   - To maximize operating speeds and if performance is more important than fast startup time and if your computer has a lot of resources, type a value about double the default value, such as 1536.
4. From the **File** menu, click **Save**.

**Reducing the number of requests per process**

Use the following steps to reduce the number of requests per process for an instance of the IBM Cognos service.

**Procedure**

1. Go to the `c10_location/webapps/p2pd/WEB-INF/services` directory.
2. Open the `reportservice.xml` file in an XML editor.
3. Change the value for `default_process_use_limit` from 0 (unlimited) to a fixed number of requests.
4. Save the file.
5. Restart the IBM Cognos service.
6. If you deployed IBM Cognos BI to an application server, rebuild the application file and deploy it to the application server.
   For example, for WebSphere, regenerate the EAR file and deploy it to the WebSphere application server.

**Tune Apache Tomcat Settings**

If you use Apache Tomcat, you can edit settings to improve performance.

You can edit the `maxProcessor` and `acceptCount` settings in the `server.xml` file.

**Procedure**

1. Open the `server.xml` file.
2. Edit the settings that appear after the following comment:
<!-- Define a non-SSL Coyote HTTP/1.1 Connector on port 8080 -->
Find the following line:
maxProcessors=75
and change it to the following:
maxProcessors=1000
3. Find the following line:
acceptCount=100
and change it to the following:
acceptCount=500
4. Save the updated server.xml file.

Increase the Request-handling Capacity for Cognos Content Database

Cognos Content Database is configured for use with a small system. If you use Cognos Content Database in a large system, where the number of simultaneous requests is greater than ten, you must adjust the default JVM memory settings and increase the page cache size for Derby.

Procedure
1. On the computer where you have installed the Cognos Content Database component, go to the c10_location\bin directory.
2. Open the derby.bat file (on Windows) or derby.sh file (on UNIX or Linux).
3. Find the following line:
   set MEM_SETTINGS=-Xmx256m
   and change it to the following:
   set MEM_SETTINGS=-Xmx1152m -XX:MaxPermSize=128M -XX:MaxNewSize=576m -XX:NewSize=288m
4. In the c10_location\configuration directory, rename derby.properties.sample to derby.properties.
5. In the same directory, open the derby.properties file.
6. Comment out the following line:
   derby.storage.pageCacheSize=15000

Improve Metric Store Database Performance

IBM Cognos BI provides a script called cmm_update_stats that updates your metric store database indexes, which improves performance. Typically, you use this script before or after loading data when the volume or distribution of data has changed significantly. For example, performance may improve if you run this script after increasing the number of scorecards from 100 to 1000.

Procedure
1. Ensure that there is no activity in the metric store database.
2. Go to the following directory:
   c10_location\configuration\schemas\cmm
3. Go to the appropriate database directory.
4. Depending on the database type, run one of the following scripts from the command line:
   • For Microsoft SQL Server or DB2:
cmm_update_stats host_name metric_store_name Admin_user_name password

• For Oracle:
cmm_update_stats metric_store_name Admin_user_name password

---

**Reduce Delivery Time for Reports in a Network**

Reports that are distributed globally take longer to open in remote locations than to open locally. In addition, HTML reports take longer than PDF reports to open because more requests are processed for HTML reports.

You can reduce the amount of time for reports to open in remote locations in two ways. You can reduce the number of requests between the browser and the server by running the report in PDF format. If HTML reports are required, you can speed up the delivery of the report by configuring additional gateways in some of the remote locations. Static content, such as graphics and style sheets, will be delivered faster.

---

**Increase Asynchronous Timeout in High User Load Environments**

If you have a high user load (over 165 users) and interactive reports are running continuously in a distributed installation, you may want to increase the asynchronous timeout setting to avoid getting error messages. The default is 30000.

You may also want to set the Queue Time Limit setting to 360. For information, see the IBM Cognos BI Administration and Security Guide.

To resolve this problem, increase the wait timeout.

**Procedure**

1. Go to the following directory:
c10_locationwebapps/p2pd/WEB-INF/services/
2. Open the reportservice.xml file in a text editor.
3. Change the async_wait_timeout_ms parameter to 120000.
4. Save the file.
5. Restart the service.
Chapter 18. Manually Configuring IBM Cognos BI

The console attached to the UNIX or Linux operating system computer on which you are installing IBM Cognos Business Intelligence may not support a Java-based graphical user interface. You must perform the following tasks manually.

- **Manually change default configuration settings** by editing the cogstartup.xml file, located in the `<c10_location>/configuration` directory.
- **Manually change language or currency support, or locale mapping** by editing the coglocale.xml file, located in the `<c10_location>/configuration` directory.
- **Apply the configuration and the locale settings to your computer** by **starting the IBM Cognos services in silent mode**.
- **Deploy IBM Cognos BI into an application server environment** by **manually creating an IBM Cognos application file**.

For all installations, some configuration tasks are required so that IBM Cognos BI works in your environment. If you distribute IBM Cognos BI components across several computers, the order in which you configure and start the computers is important.

Other configuration tasks are optional and depend on your reporting environment. You can change the default behavior of IBM Cognos BI by editing the cogstartup.xml file to change property values. You can also use sample files that enable IBM Cognos BI to use resources that already exist in your environment.

**Manually Configuring IBM Cognos BI on UNIX and Linux**

The console attached to the UNIX or Linux operating system computer on which you are installing IBM Cognos BI may not support a Java-based graphical user interface. You must

- **manually change default configuration settings** by editing the cogstartup.xml file, located in the `<c10_location>/configuration` directory.
- **manually change language or currency support, or locale mapping** by editing the coglocale.xml file, located in the `<c10_location>/configuration` directory.
- **apply the configuration and the locale settings to your computer** by **running IBM Cognos Configuration in silent mode**.

For all installations, some configuration tasks are required so that IBM Cognos BI works in your environment. If you distribute IBM Cognos BI components across several computers, the order in which you configure and start the computers is important.

Other configuration tasks are optional and depend on your reporting environment. You can change the default behavior of IBM Cognos BI by editing the cogstartup.xml file to change property values. You can also use sample files that enable IBM Cognos BI to use resources that already exist in your environment.
Manually Change Default Configuration Settings on UNIX and Linux Computers

If the console attached to your UNIX or Linux operating system computer does not support a Java-based graphical user interface, you must edit the cogstartup.xml to configure IBM Cognos BI to work in your environment.

Note: Some configuration settings are not saved in the cogstartup.xml file unless you use the graphical user interface. For example, the server time zone is not set for your IBM Cognos components when you modify the cogstartup.xml file directly and then run IBM Cognos Configuration in silent mode. In this case, other user settings that rely on the server time zone may not operate as expected.

If you want IBM Cognos BI to use a resource, such as an authentication provider that already exists in your environment, you can add a component to your configuration. You do this by copying the required XML code from the sample files into the cogstartup.xml file and then edit the values to suit your environment.

By default, the cogstartup.xml file is encoded using UTF-8. When you save the cogstartup.xml file, ensure that you change the encoding of your user locale to match the encoding used. The encoding of your user locale is set by your environment variables.

When you edit the cogstartup.xml file, remember that XML is case-sensitive. Case is important in all uses of text, including element and attribute labels, elements and values.

Before you edit the cogstartup.xml file, ensure that you
• make a backup copy
• create the content store on an available computer in your network
• review the configuration requirements for your installation type

Procedure
1. Go to the c10_location/configuration directory.
2. Open the cogstartup.xml file in an editor.
3. Find the configuration setting you want to change by looking at the help and description comments that appear before the start tag of the <crn:parameter> elements.
4. Change the value of the <crn:value> element to suit your environment.
   Tip: Use the type attribute to help you determine the data type for the configuration property.
5. Repeat steps 3 to 4 until the configuration values are appropriate your environment.
6. Save and close the file.

Results

You should now use a validating XML editor to validate your changes against the rules in the cogstartup.xsd file, located in the c10_location/configuration.


Add a Component to Your Configuration

The cogstartup.xml file contains configuration settings used by IBM Cognos BI and by default components. You can change the components that IBM Cognos BI uses by copying XML elements from sample files into the cogstartup.xml file. You can then edit the configuration values to suit your environment.

For example, to use an Oracle database for the content store, you can use the ContentManager_language_code.xml sample file to replace the default database connection information.

IBM Cognos BI can use only one instance at a time of the following elements:

- the database for the content store
- a cryptographic provider
- a configuration template for the IBM Cognos service

You should be familiar with the structure of XML files before you start editing them.

Procedure

1. Go to the c10_location/configuration/samples directory.
2. Choose a sample file to open in an editor:
   - To use Oracle, DB2, or Sybase for the content store, open the ContentManager_language_code.xml file.
   - To use an authentication provider, open the Authentication_language_code.xml file.
   - To use a cryptographic provider, open the Cryptography_language_code.xml file.
   - To send log messages somewhere other than a file, open the Logging_language_code.xml file.
   - To use a medium or large template for the amount of resources the IBM Cognos BI process uses, open the CognosService_language_code.xml file.
3. Copy the elements that you need.
   Tip: Ensure that you copy the code including the start and end tags for the <crn:instance> element.
   For example, look for the (Begin of) and (End of) comments:
   
   <!--
   ===================================================================
   (Begin of) DB2 template
   -->
   <crn:instance ...
   ...
   </crn:instance ...
   <!--
   End of) DB2 template
   ===================================================================
   -->
4. Go to the c10_location/configuration directory.
5. Open the cogstartup.xml file in an editor.
6. Paste the code from the sample file to the cogstartup.xml file and replace the appropriate <crn:instance> element.
7. Change the values of these new elements to suit your environment.
For the `<crn:instance>` element, don't change the class attribute. You can change the name attribute to suit your environment.

For example, if you use an Oracle database for the content store, change only the name attribute to suit your environment.

```xml
<crn:instance class="Oracle" name="MyContentStore">
```

8. Save and close the file.

9. Run IBM Cognos Configuration in silent mode by typing the following command:

   ```bash
   ./cogconfig.sh -s
   ```

   This ensures that the file is valid and that passwords are encrypted.

### Manually Change Encrypted Settings

You can manually change encrypted settings, such as passwords and user credentials, in the `cogstartup.xml` file.

To prompt IBM Cognos Configuration to save an encrypted setting, you change the value and then set the encryption flag to false.

**Procedure**

1. Go to the `c10_location/configuration` directory.
2. Open the `cogstartup.xml` file in an editor.
3. Find the encrypted setting you want to change by looking at the help and description comments that appear before the start tag of the `<crn:parameter>` elements.
4. Change the value of the `<crn:value>` element to suit your environment.

   **Tip:** Use the type attribute to help you determine the data type for the configuration property.

5. Change the encryption value to false.

   For example,
   ```xml
   <crn:value encrypted="false">
   ```

6. Repeat steps 3 to 5 until the configuration values are appropriate for your environment.

7. Save and close the file.

8. Type the following configuration command:

   ```bash
   ./cogconfig.sh -s
   ```

**Results**

The new settings are saved and encrypted.

### Global Settings on UNIX and Linux Computers

If the console attached to your UNIX or Linux operating system computer does not support a Java-based graphical user interface, you must manually edit the `coglocale.xml` file.

You can change global settings

- to specify the language used in the user interface when the language in the user's locale is not available
- to specify the locale used in reports when the user's locale is not available
• to add currency or locale support to report data and metadata
• to add language support to the user interface

By default, IBM Cognos BI components ensure that all locales, which may come from different sources and in various formats, use a normalized form. That means that all expanded locales conform to a language and regional code setting.

Before you can add language support to the user interface, you must install the language files on all computers in your distributed installation. For more information, contact your support representative.

Example 1

A report is available in Content Manager in two locales, such as en-us (English-United States) and fr-fr (French-France), but the user locale is set to fr-ca (French-Canadian). IBM Cognos uses the locale mapping to determine which report the user sees.

First, IBM Cognos checks to see if the report is available in Content Manager in the user's locale. If it is not available in the user's locale, IBM Cognos maps the user's locale to a normalized locale configured on the Content Locale Mapping tab. Because the user's locale is fr-ca, it is mapped to fr. IBM Cognos uses the mapped value to see if the report is available in fr. In this case, the report is available in en-us and fr-fr, not fr.

Next, IBM Cognos maps each of the available reports to a normalized locale. Therefore, en-us becomes en and fr-fr becomes fr.

Because both report and the user locale maps to fr, the user having the user locale fr-ca will see the report saved with the locale fr-fr.

Example 2

The user's locale and the report locales all map to the same language. IBM Cognos chooses which locale to use. For example, if a user's locale is en-ca (English-Canada) and the reports are available in en-us (English-United States) and en-gb (English-United Kingdom), IBM Cognos maps each locale to en. The user will see the report in the locale setting that IBM Cognos chooses.

Example 3

The report and the user locales do not map to a common language. IBM Cognos chooses the language. In this case, you may want to configure a mapping. For example, if a report is available in en-us (English-United States) and fr-fr (French-France), but the user locale is es-es (Spanish-Spain), IBM Cognos chooses the language.

Manually Change the Global Settings on UNIX and Linux Computers

Use the following steps to change global settings on UNIX and Linux operating systems using the coglocale file.

Procedure

1. On every computer where you installed Content Manager, go to the \c10_location/configuration directory.
2. Open the coglocale.xml file in an editor.
3. Add or modify the required element and attribute between the appropriate start and end tags.

The elements, attributes, and start and end tags are listed in the following table.

<table>
<thead>
<tr>
<th>Type of element</th>
<th>Start tag</th>
<th>End tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>&lt;supportedProductLocales&gt;</td>
<td>&lt;/supportedProductLocales&gt;</td>
</tr>
<tr>
<td>Content Locales</td>
<td>&lt;supportedContentLocales&gt;</td>
<td>&lt;/supportedContentLocales&gt;</td>
</tr>
<tr>
<td>Currency</td>
<td>&lt;supportedCurrencies&gt;</td>
<td>&lt;/supportedCurrencies&gt;</td>
</tr>
<tr>
<td>Product Locale Mapping</td>
<td>&lt;productLocaleMap&gt;</td>
<td>&lt;/productLocaleMap&gt;</td>
</tr>
<tr>
<td>Content Locale Mapping</td>
<td>&lt;contentLocaleMap&gt;</td>
<td>&lt;/contentLocaleMap&gt;</td>
</tr>
<tr>
<td>Fonts</td>
<td>&lt;supportedFonts&gt;</td>
<td>&lt;/supportedFonts&gt;</td>
</tr>
<tr>
<td>Cookie settings, archive location for reports</td>
<td>&lt;parameter name=&quot;setting&quot;&gt;</td>
<td>&lt;/parameter&gt;</td>
</tr>
</tbody>
</table>

**Tip:** To remove support, delete the element.

4. Save and close the file.

**Results**

**Tip:** Use a validating XML editor to validate your changes against the rules in the cogstartup.xsd file, located in the c10_location/configuration.

If you add a currency code that is not supported, you must manually add it to the i18n_res.xml file in the c10_location/bin/ directory. Copy this file to each IBM Cognos computer in your installation.

### Starting and Stopping IBM Cognos Business Intelligence in Silent Mode on UNIX and Linux Computers

You run IBM Cognos Configuration in silent mode to apply the configuration settings and start the services on UNIX or Linux operating system computers that do not support a Java-based graphical user interface.

Before you run the configuration tool in silent mode, you should ensure the cogstartup.xml file is valid according to the rules defined in the cogstartup.xsd file. The cogstartup.xsd file is located in the c10_location/configuration directory.

**Starting IBM Cognos Business Intelligence in Silent Mode on UNIX and Linux Computers**

Use the following steps to start the IBM Cognos Business Intelligence software in silent mode.

**Procedure**

1. Ensure that the cogstartup.xml file, located in the c10_location/configuration directory, has been modified for your environment.
For more information, see “Manually Change Default Configuration Settings on UNIX and Linux Computers” on page 482.

2. Go to the c10_location/bin directory.

3. Type the following command
   
   ```
   ./cogconfig.sh -s
   ```

   **Tip:** To view log messages that were generated during an unattended configuration, see the cogconfig_response.csv file in the c10_location/logs directory.

**Results**

IBM Cognos Configuration applies the configuration settings specified in the cogstartup.xml file, encrypts credentials, generates digital certificates, and if applicable, starts the IBM Cognos service or process.

**Stopping IBM Cognos Business Intelligence in Silent Mode on UNIX and Linux Computers**

Use the following steps to stop the IBM Cognos Business Intelligence software in silent mode.

**Procedure**

1. Go to the c10_location/bin directory.

2. Type the following command
   
   ```
   ./cogconfig.sh -stop
   ```

---

### Manually Create an IBM Cognos Application File

IBM Cognos BI and the servlet gateway must be packaged into an application file for deployment to supported application servers. IBM Cognos BI provides a Build Application wizard that you can use to create the application file.

You can create a Web archive (.war) file, an Enterprise archive (.ear) file, or an expanded directory that includes all the files necessary for the application. For information about WAR and EAR files or expanded directories and to determine what is supported by your application server, see the documentation provided with the application server.

If you choose not to use the Build Application wizard, you must complete the following steps to create the application file.

If the application server is not being used as a Web server, you do not need to include the IBM Cognos static content (html pages, images, and so on) in the application file. Excluding the static content when creating the application file reduces the size of the file.

---

**Creating an IBM Cognos application file for the Business Intelligence software**

If you choose not to use the Build Application wizard, you must complete the following steps to create the application file.
**Procedure**

1. Stop the IBM Cognos service if it is running.
2. Go to the $c10\_location/war/p2pd$ directory.
3. Run the build script by using the following command syntax:
   - For Microsoft Windows operating system, 
     `build.bat file_type option`
   - For UNIX or Linux operating systems, 
     `build.sh file_type option`

   where `file_type` can be one of the values listed in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>war</td>
<td>WAR file with static content</td>
</tr>
<tr>
<td>war_without_webcontent</td>
<td>WAR file with no static content</td>
</tr>
<tr>
<td>war_without_docsamples</td>
<td>WAR file with static content and with no documentation and sample files</td>
</tr>
<tr>
<td>ear</td>
<td>EAR file with static content</td>
</tr>
<tr>
<td>ear_without_webcontent</td>
<td>EAR file with no static content</td>
</tr>
<tr>
<td>ear_without_docsamples</td>
<td>EAR file with static content and with no documentation and sample files</td>
</tr>
<tr>
<td>expand</td>
<td>directory containing the application with static content</td>
</tr>
<tr>
<td>expand_without_webcontent</td>
<td>directory containing the application with no static content</td>
</tr>
<tr>
<td>expand_without_docsamples</td>
<td>directory containing the application with static content and with no documentation and sample files</td>
</tr>
</tbody>
</table>

   and where `option` can be one or more of the values listed in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Dappserver_type=value</td>
<td>jboss</td>
<td>Perform actions for a JBoss application server</td>
</tr>
<tr>
<td></td>
<td>other (default)</td>
<td>Perform actions for a non-JBoss application server</td>
</tr>
<tr>
<td>-Dcontext_root=value</td>
<td>p2pd (default)</td>
<td>Preset a context root value for the application</td>
</tr>
<tr>
<td>-Dwar_name=value</td>
<td>path/file</td>
<td>Path and name of the WAR file to be created</td>
</tr>
<tr>
<td></td>
<td>filename</td>
<td>Default is .../p2pd.war</td>
</tr>
</tbody>
</table>
Creating an IBM Cognos application file for a servlet gateway

If you choose not to use the Build Application wizard, you must complete the following steps to create the application file.

Procedure

1. Stop the IBM Cognos service if it is running.
2. Go to the c10_location/war/gateway directory.
3. Run the build script by using the following command syntax:
   - For Windows,  
     build.bat file_type option
   - For UNIX or Linux,  
     build.sh file_type option

where file_type can be one of the values listed in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>gateway_war</td>
<td>WAR file with static content</td>
</tr>
<tr>
<td>gateway_war_without_docsamples</td>
<td>WAR file with static content and with no documentation and sample files</td>
</tr>
<tr>
<td>gateway_ear</td>
<td>EAR file with static content</td>
</tr>
<tr>
<td>gateway_ear_without_docsamples</td>
<td>EAR file with static content and with no documentation and sample files</td>
</tr>
<tr>
<td>expand</td>
<td>directory containing the application with static content</td>
</tr>
<tr>
<td>expand_without_docsamples</td>
<td>directory containing the application with static content and with no documentation and sample files</td>
</tr>
</tbody>
</table>

and where option can be one or more of the values listed in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Dear_name=value</td>
<td>path/filename</td>
<td>Path and name of the EAR file to be created</td>
</tr>
<tr>
<td>Default is ../../p2pd.ear</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Dexpand_location=value</td>
<td>path/directory</td>
<td>Path to directory where the application files are to be expanded</td>
</tr>
<tr>
<td>(For expand file types)</td>
<td>Default is ../../temp/expand</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>-Dappserver_type=value</td>
<td>jboss</td>
<td>Perform actions for a JBoss application server</td>
</tr>
<tr>
<td></td>
<td>other (default)</td>
<td>Perform actions for a non-JBoss application server</td>
</tr>
<tr>
<td>-Dcontext_root=value</td>
<td>ServletGateway (default)</td>
<td>Preset a context root value for the application</td>
</tr>
<tr>
<td>-Dwar_name=value</td>
<td>path/filename</td>
<td>Path and name of the WAR file to be created</td>
</tr>
<tr>
<td></td>
<td>Default is</td>
<td>Default is ../ServletGateway.war</td>
</tr>
<tr>
<td>-Dear_name=value</td>
<td>path/filename</td>
<td>Path and name of the EAR file to be created</td>
</tr>
<tr>
<td></td>
<td>Default is</td>
<td>Default is ../ServletGateway.ear</td>
</tr>
<tr>
<td>-Dexpand_location=value</td>
<td>path/directory</td>
<td>Path to directory where the application files are to be expanded</td>
</tr>
<tr>
<td></td>
<td>Default is</td>
<td>Default is ../..temp/expand</td>
</tr>
</tbody>
</table>
Chapter 19. Setting Up an Unattended Installation and Configuration

Set up an unattended installation and configuration to do the following:

- install an identical configuration across several computers on your network
- automate the installation and configuration process by specifying options and settings for users
- install and configure components in a UNIX or Linux environment that does not have XWindows

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all other software that you need is installed and configured.

You can also set up an unattended uninstallation.

Procedure

1. Configure a transfer specification file (.ats) to specify installation options.
2. Run the installation tool in silent mode.
3. Use a pre configured configuration file from another computer.
4. Run the configuration tool in silent mode.

Results

After you complete these tasks, ensure that the IBM Cognos Business Intelligence installation directory on all computers is protected from unauthorized or inappropriate access. Then you will be ready to use IBM Cognos BI.

Unattended Installation

Use a transfer specification file (.ats) to copy IBM Cognos BI components to your computer without being prompted for information.

By default, each time you install IBM Cognos BI components using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed IBM Cognos BI components on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the disk. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.
Set Up an Unattended Installation Using a File From an Installation on Another Computer

Use the following steps to copy IBM Cognos BI components from another installation without being prompted for information.

Procedure

1. Use the installation wizard to install IBM Cognos BI components on one computer.
2. Go to \c10_location\instlog.
3. Locate the transfer specification file (.ats) that was generated.
   The filename format is ts-product_code-version-yyyyymmdd_hhmm.ats
   where product_code is as listed in the following table:

<table>
<thead>
<tr>
<th>Product_code</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>BISRVR</td>
<td>IBM Cognos BI Server</td>
</tr>
<tr>
<td>CRNSRVR</td>
<td>IBM Cognos BI Reporting Server</td>
</tr>
<tr>
<td>CPPSRVR</td>
<td>IBM Cognos BI Analysis Server</td>
</tr>
<tr>
<td>BIMODEL</td>
<td>Framework Manager</td>
</tr>
<tr>
<td>CMMSRVR</td>
<td>IBM Cognos Metrics Manager</td>
</tr>
<tr>
<td>BIMEMOD</td>
<td>Metric Designer</td>
</tr>
<tr>
<td>BITRSFRMR</td>
<td>IBM Cognos BI Transformer</td>
</tr>
<tr>
<td>BISAMPLES</td>
<td>Samples</td>
</tr>
<tr>
<td>LP</td>
<td>Supplementary Language Documentation</td>
</tr>
</tbody>
</table>

4. Copy the transfer specification file to the computer where you plan to install IBM Cognos BI.
5. On the computer where you plan to install the software, insert the appropriate disk and copy the contents of the disk to your computer.
6. Open the transfer specification file that you copied in a text editor.
7. In the License Agreement dialogs, change the I Agree property to y.
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the LA_language_code and notices files in either of these locations:
   • on the product disk - in the root installation directory for the operating system
   • on the computer from which you copied the response.ats file - in the \c10_location\license\product directory
8. Save the transfer specification file in the directory where you copied the contents of the installation disk.
9. Install IBM Cognos BI:
   • On Windows, open a Command Prompt window, and change to the win32 directory where you copied the contents of the disk, and then type the following command, where location is the directory where you copied filename, the transfer specification file:
     isetup -s location\filename.ats
On UNIX or Linux, change to the directory where you copied the contents of the disk, and in the directory for your operating system, type the following command, where location is where you copied filename, the transfer specification file:

```
./issetup -s location/filename.ats
```

On UNIX or Linux on a computer where you do not have XWindows, change to the directory where you copied the contents of the disk, and in the directory for your operating system, type the following command, where location is where you copied filename, the transfer specification file:

```
./issetupnx -s location/filename.ats
```

Results

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the c10_location\instlog directory in a summary error log file. The filename format is tl-product_code-version-yymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-product_code-version-yymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

Set Up an Unattended Installation Using the Response.ats File

Use the following steps to install IBM Cognos BI components without being prompted for information.

Procedure

1. On the target computer, insert the disk and copy the contents to your computer.
2. Go to the directory for your operating system and open the response.ats file in a text editor.
   
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.
3. In the License Agreement dialogs, change the I Agree property to y.
   
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the LA_language_code and notices files in the root installation directory for the operating system on the product disk.
4. Type the installation location of the program files for IBM Cognos BI in APPDIR=location.

   Tip: There should be no space on either side of the equal sign, (=).
5. For the server components of IBM Cognos BI, in the section named [Component List], next to each component:
   
   • To install the component, type 1
   • To not install the component, type 0

   Note: You do not select components for Framework Manager.
Note: You do not select components for Metric Designer. All required files are installed.

6. For a Windows installation, for the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.

Tip: To ensure that the shortcut folder is visible to all users, type 1 for the ALLUSERS_FLAG= property.

7. For the install information in the [Install Conditions] section:
   - To specify the condition is true, type 1
   - To specify the condition is false, type 0

8. Save the response.ats file to a local directory after you make the necessary changes.

9. Go to the directory where you saved the response.ats file.
10. At the command prompt type the following command, where location is the directory where you copied response.ats:
    - On Windows, 
      `issetup -s location/response.ats`
    - On UNIX or Linux, 
      `./issetup -s location/response.ats`
    - On UNIX or Linux without XWindows, 
      `./issetupnx -s location/response.ats`

Results

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the `c10_location\instlog` directory in a summary error log file. The filename format is `tl-product_code-version-yyyyymmdd-hhmm_summary-error.txt`.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is `tl-product_code-version-yyyyymmdd-hhmm.txt`.

What to do next

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

Set Up an Unattended Configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has the same IBM Cognos BI components installed. You can then run IBM Cognos Configuration in silent mode.

The exported configuration contains the properties of the IBM Cognos BI components that you installed on the source computer. If you made changes to the global configuration, you must also copy the global configuration file from the source computer to the computer where you plan to run an unattended configuration. Global configuration includes such settings as content locale, product locale, currencies, fonts, and cookie settings.
For more information, see “Changing Global Settings” on page 388.

**Before you begin**

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos BI computer with the same installed components. For example, if you changed the host name portion of the Gateway URI property from local host to an IP address or computer name, ensure this setting is appropriate for the new computer’s configuration.

**Procedure**

1. In IBM Cognos Configuration, from the File menu, click Export as.
2. When prompted about exporting decrypted content, click Yes.
3. If you want to export the current configuration to a different folder, in the Look in box, locate and open the folder.
   Ensure that the folder is protected from unauthorized or inappropriate access.
4. In the File name box, type a name for the configuration file.
5. Click Save.
6. Copy the exported configuration file from the source computer or network location to the c10_location/configuration directory on the computer where you plan to do an unattended configuration.
7. Rename the file to cogstartup.xml.
8. If you changed the global configuration on the source computer, copy the coglocale.xml file from the source computer to the c10_location/configuration directory on the computer where you plan to do an unattended configuration.
9. Go to c10_location/bin.
10. Type the configuration command:
   - On UNIX or Linux, type
     
     `. cogconfig.sh -s`
   - On Windows, type
     
     `cogconfig.bat -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the cogconfig_response.csv file in the c10_location/logs directory.
   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

**Results**

IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, generates digital certificates, and if applicable, starts IBM Cognos service or process.

**Set Up an Unattended Uninstallation**

Set up an unattended uninstallation to automate the removal of components on several computers that have the same components or remove components on a UNIX or Linux environment that does not have XWindows.
Procedure

1. Go to the c10_location/uninstall directory.
2. Open the file named uninst.ini in a text editor.
3. In the section named [Package List], specify the components to remove.
   - To remove the component, type 1
   - To leave the component installed, type 0
   By default, all installed components are set to be removed.
   The packages listed in the [Package List] section are described in the following table:

<table>
<thead>
<tr>
<th>Package code</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>BISRVR</td>
<td>IBM Cognos BI Server</td>
</tr>
<tr>
<td>CRNSRVR</td>
<td>IBM Cognos BI Reporting Server</td>
</tr>
<tr>
<td>CPPSRVR</td>
<td>IBM Cognos BI Analysis Server</td>
</tr>
<tr>
<td>BIMODEL</td>
<td>Framework Manager</td>
</tr>
<tr>
<td>CMMSRVR</td>
<td>IBM Cognos Metrics Manager</td>
</tr>
<tr>
<td>BIMEMOD</td>
<td>Metric Designer</td>
</tr>
<tr>
<td>BITRSFRMR</td>
<td>IBM Cognos BI Transformer</td>
</tr>
<tr>
<td>BISAMPLES</td>
<td>Samples</td>
</tr>
<tr>
<td>LP</td>
<td>Supplementary Language Documentation</td>
</tr>
</tbody>
</table>

4. Save and close the file.
5. From the operating system command line, change to the c10_location/uninstall directory.
6. At the command prompt, type the following command:
   - On Windows,
     \uninst -u -s
   - On UNIX or Linux,
     ./uninst -u -s
   - On UNIX or Linux without XWindows,
     ./uninstnx -u -s
Chapter 20. Uninstalling IBM Cognos BI

It is important to use uninstall programs to completely remove all files and modifications to system files. To uninstall IBM Cognos Business Intelligence, you uninstall server components and modeling tools.

If you are running IBM Cognos BI in an application server environment, use the administration tool provided with the application server to stop the application if it is running and undeploy the Java portion of IBM Cognos BI components. Many application servers do not completely remove all deployed application files or directories during an undeployment; therefore, you may have to perform this action manually. After you have undeployed IBM Cognos BI components, complete the steps in this section to uninstall on UNIX and Microsoft Windows operating systems.

Important: Do not delete the configuration and data files if you are upgrading to a new version of IBM Cognos BI and you want to use the configuration data with the new version.

Important: If you are using Cognos Content Database, the default location for the database files is in the `c10_location/contentstore` directory. If you want to keep your database after uninstalling, do not delete this directory.

Uninstall IBM Cognos Business Intelligence on UNIX or Linux

If you no longer require IBM Cognos Business Intelligence or if you are upgrading on your UNIX or Linux operating system, uninstall IBM Cognos BI.

If you are upgrading from an older version of ReportNet to IBM Cognos BI, follow the uninstallation instructions in the documentation for the older version of ReportNet.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them manually.

Procedure

1. If the console attached to your computer does not support a Java-based graphical user interface, determine the process identification (pid) of the IBM Cognos BI process by typing the following command:
   ```bash
   ps -ef | grep cogbootstrapservice
   ```
2. Stop the IBM Cognos BI process:
   - If you run XWindows, start IBM Cognos Configuration, and from the Actions menu, click Stop.
   - If you do not run XWindows, type:
     ```bash
     kill -TERM pid
     ```
3. To uninstall IBM Cognos BI, go to the `c10_location/uninstall` directory and type the appropriate command:
   - If you use XWindows, type
     ```bash
     ./uninst -u
     ```
Uninstall IBM Cognos Business Intelligence on Windows

If you no longer require IBM Cognos Business Intelligence or if you are upgrading, uninstall all IBM Cognos BI components and the IBM Cognos service.

If you installed more than one component in the same location, you can choose the packages to uninstall using the uninstall wizard. All components of the package will be uninstalled. You must repeat the uninstallation process on each computer that contains IBM Cognos BI components.

It is not necessary to back up the configuration and data files on a Microsoft Windows operating system. These files are preserved during the uninstallation.

Close all programs before you uninstall IBM Cognos BI. Otherwise, some files may not be removed.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them. Do not delete the configuration and data files if you are upgrading to a new version of IBM Cognos BI and you want to use the configuration data with the new version.

Procedure

1. From the Start menu, click Programs, IBM Cognos 10, Uninstall IBM Cognos, Uninstall IBM Cognos.
   The Uninstall wizard appears.

   **Tip:** IBM Cognos BI is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the components.
   The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.

   **Tip:** To find the log file, look in the Temp directory.

3. Delete all temporary Internet files from the Web browser computers.
   For more information, see your Web browser documentation.
Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center [http://www.ibm.com/able](http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

### Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

**Note:** The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.
Table 52. List of keyboard shortcuts on the License Agreement page

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

Table 53. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a UNIX or Linux operating system.

Table 54. List of keyboard shortcuts for IBM Cognos Configuration on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
</tbody>
</table>
Appendix B. Google OneBox Integration for IBM Cognos Business Intelligence

IBM Cognos worked with Google to provide Google OneBox integration for IBM Cognos Business Intelligence content. With Google OneBox integration, if a search request includes predefined trigger keywords, IBM Cognos content appears in the OneBox section of the results page. The type of content depends on the search terms used, and how the IBM Cognos OneBox components are configured. The OneBox results can show IBM Cognos BI content such as a report or metric, or a list of index search results similar to what would appear if the user ran the search from IBM Cognos Connection.

You must use Google Search Appliance for an enterprise search to take advantage of this feature. Ensure that the index search capability is configured. For more information, see "Configuring IBM Cognos Index Search" on page 403.

Google OneBox integration uses two IBM Cognos components:
- an IBM Cognos OneBox module
  This component must be installed and configured on Google Search Appliance
- an IBM Cognos OneBox Provider
  This component is installed automatically with IBM Cognos BI. You can customize the way results for specific search requests are processed and appear in the OneBox results.

Search request process

The following diagram shows communication among components when a search is processed by Google Search Appliance with an IBM Cognos OneBox module.
1. The search request is sent to Google Search Appliance.
2. Google Search Appliance processes the request in two ways:
   - It requests a result set from the index maintained by Google Search Appliance.
   - It requests a result set from the Google OneBox capability.
3. If the search request matches trigger criteria, the IBM Cognos OneBox module located on the Google Search Appliance sends the request to the IBM Cognos OneBox provider.
4. The IBM Cognos OneBox provider processes the request based on a rule set defined in the provider configuration.
5. The IBM Cognos OneBox provider returns results to the Google OneBox module, either specific content such as a report or metric, or an index search result set.
6. Search results, including IBM Cognos content shown as OneBox results, are returned to the user.

**Configuring the IBM Cognos OneBox Components**

To set up the integration of IBM Cognos content in Google OneBox search results, you must install and configure at least one IBM Cognos OneBox module. Then you can customize the Google OneBox integration for IBM Cognos BI by using either of the following methods:

- Install and configure additional IBM Cognos OneBox modules on Google Search Appliance.

With more than one module, you can configure the IBM Cognos OneBox components to return more than one type of IBM Cognos content for specific
search requests. For example, with more than one module, the search term inventory report may return both a report and a metric.

- Create a map.xml file.

  Specify how to process search requests received from one or more IBM Cognos OneBox modules. For example, you can define processing rules that return a specific report when a user enters "inventory report" as a search request.

Test a variety of configurations to determine what level of OneBox customization is useful for users.

**Installing and Configuring IBM Cognos OneBox Modules**

You can install one or more IBM Cognos OneBox modules on Google Search Appliance. Each IBM Cognos OneBox modules must know the location of the IBM Cognos OneBox provider component.

The default configuration of the IBM Cognos OneBox components uses a single module. After you specify the location of the IBM Cognos OneBox provider for that module, a list of IBM Cognos BI search results appears as OneBox results when a default trigger term is used in a search query.

If you install more than one module, this provides more options for configuring the processing of specific search requests. You can configure each module to process search requests based on search term triggers.

**Procedure**

1. Obtain the IBM Cognos OneBox module from the Google or Cognos Web site.
2. Follow the instructions about installing and configuring Google OneBox modules in the documentation that is included with Google Search Appliance to do the following:
   - Install the IBM Cognos OneBox module on Google Search Appliance.
   - Configure a unique name for the module.
   - Specify the location of IBM Cognos OneBox Provider for the module.
3. Repeat step 2 to add more modules.

**Creating a Map File for IBM Cognos OneBox Provider**

The IBM Cognos OneBox provider is included with IBM Cognos BI. You can configure the provider component to customize the way results for specific search requests are processed and appear in the OneBox results.

With the default configuration, when a search request returns IBM Cognos content in the OneBox results, the results are a prioritized list of IBM Cognos BI search results.

To change the default configuration of the IBM Cognos OneBox provider, use a map.xml file to specify how to process search requests received from one or more IBM Cognos OneBox modules. For example, you can define processing rules that return a specific report when a user enters "inventory report" as a search request.

You can create the map.xml file or use the sample map.xml file that is included with IBM Cognos BI. The sample configuration file includes comments to help you understand the function of the entries. For more information, see "IBM Cognos OneBox Provider Configuration Examples" on page 504.
Procedure
1. For each report that you want to use as a target for Google OneBox results, run and save the report in XHTML format.
   For more information about selecting XHTML format for a report, see the topic about advanced report options in the IBM Cognos BI Administration and Security Guide.
2. On the computer where you installed IBM Cognos BI, open $c10_location/templates/ps/onebox/sample-map.xml$ in an XML or text editor.
3. Modify the entries to define processing behavior for one or more modules.
   The comments in the sample-map.xml file describe the purpose of the entries.
4. Rename the file to map.xml and save it to the $c10_location/templates/ps/onebox$ directory.

Results
You do not need to restart any IBM Cognos BI or Google services to activate the configuration changes. To test the configuration changes, run a variety of searches to ensure that the expected content is returned as OneBox results. Reports that are used as search targets must be small enough to fit in the limited space provided for OneBox results. Check the search results to ensure that the appearance of reports is acceptable.

IBM Cognos OneBox Provider Configuration Examples
The following examples will help you understand how you can customize search processing for the IBM Cognos OneBox provider to return specific content as Google OneBox results, such as a report or metric.

In addition to modifying the IBM Cognos OneBox provider configuration using the map.xml file, you must install and configure one or more IBM Cognos OneBox modules on the Google Search Appliance. For more information about working with Google OneBox modules, see the Google documentation.

To use a report as a target for use as Google OneBox results, you must run and save the report in XHTML format. Also, the report must be small enough to fit in the limited space provided for OneBox results. You should test all reports used for Google OneBox results to ensure the display is acceptable.

Additional authoring steps are not required for metric charts used as OneBox results. A metrics chart is generated dynamically as a response to a search request. Unlike a chart format report, a metric chart does not have to be pre-authored and tested to ensure an acceptable appearance in OneBox results.

For more information about selecting XHTML format for a report, see the IBM Cognos Administration and Security Guide.

Example - Configure the IBM Cognos OneBox Provider to Return a Report
You have two reports that you want to use as Google OneBox results, Revenue Report and Inventory Report. You want one of the reports returned when a search query includes the keyword report and one or more of the following keywords, revenue and inventory. Google Search Appliance includes an IBM Cognos OneBox module named cognos_report. The keyword report is one of the triggers for this module.
You modify the map.xml file to include the following module entry:

```xml
<module oneboxName="cognos_report">
<mapEntries>
  <mapEntry provider="cm">
    <regex>.*revenue.*</regex>
    <path type="output"/@name='Onebox Reports']/query[@name='RevenueReport']
  </path>
  <mapEntry provider="cm">
    <regex>.*inventory.*</regex>
    <path type="output"/@name='Onebox Reports']/query[@name='InventoryReport']
  </path>
</mapEntries>
</module>
```

The following communication flow takes place when a user types report inventory as a search term.

1. Google Search Appliance receives the search query and requests a result set from both its own index capability and from the OneBox capability.
2. The OneBox capability identifies the search term report as a trigger for the cognos_report module and passes the query to this module as a search request.
3. The cognos_report module passes the query to the IBM Cognos OneBox provider.
4. The provider evaluates the search request and, based on the map.xml file entries, determines that Inventory Report should be returned as the search result.
   - If the search query included both terms revenue and inventory, the Revenue Report would be returned as the search result because this is the first mapEntry.
5. The provider returns the Inventory Report to Google Search Appliance.
6. Google Search Appliance formats the report using the XSL stylesheet included with the cognos_report module.
7. The Inventory Report appears as a OneBox result along with the search results returned from the Google index.

**Example - Configure the IBM Cognos OneBox Provider to Return a Chart**

In addition to crosstab and list reports, you have chart reports. To return a chart when a search request includes the term margin, you add an additional <mapEntry> entry to the map.xml file. Like the map.xml example for reports, the <mapEntry> order is important. If the search request includes both the terms revenue and margin, the Revenue Report is returned because revenue is the first <mapEntry>. Margin Chart is returned only when the search request includes the term margin, but not the term revenue or inventory.

Google Search Appliance includes an IBM Cognos OneBox module named cognos_report. The search term report is one of the triggers for this module.

You modify the map.xml file to include the following module entry:

```xml
<module oneboxName="cognos_report">
<mapEntries>
  <mapEntry provider="cm">
    <regex>.*revenue.*</regex>
  </mapEntry>
</mapEntries>
</module>
```
The following communication flow takes place when a user enters the term report margin as a search query.

1. Google Search Appliance receives the search query and requests a result set from both its own index capability and from the OneBox capability.
2. The OneBox capability identifies the search term report as a trigger for the cognos_report module and passes the query to this module as a search request.
3. The cognos_report module passes the query to the IBM Cognos OneBox provider.
4. The provider evaluates the search request and, based on the map.xml file entries, determines that Margin Chart should be returned as the search result.
   If the search query included the term revenue or inventory, a report is returned because the <mapEntry> items for these keyword appear before the <mapEntry> for margin.
5. The provider returns the Margin Chart to Google Search Appliance.
6. Google Search Appliance formats the report using the XSL stylesheet included with the cognos_report module.
7. Margin Chart appears as a OneBox result along with the search results returned from the Google index.

Another configuration option is to add an additional IBM Cognos OneBox module to process search requests that include a trigger for charts. In this case, the map.xml file includes separate <module_oneBox name> items. The IBM Cognos OneBox provider processes requests from each module separately. The order of the modules in the map.xml file does not affect results. An advantage to using more than one module is that the OneBox results for a single search term may return both a report and a chart.

**Example - Configure the IBM Cognos OneBox Provider to Return Both a Report and a Chart**

You want to return both a crosstab report and a chart when a search request includes inventory. You use two <path type> items in the same <mapEntry>.

You modify the map.xml file to include the following module entry:

```xml
<module oneboxName="cognos_report">
  <mapEntries>
    <mapEntry provider="cm">
      <regex>.*inventory.*</regex>
      <path type="output">/content/package
        [@name='Onebox Reports']/query[@name='InventoryReport']
      </path>
    </mapEntry>
    <mapEntry provider="cm">
      <regex>.*margin.*</regex>
      <path type="output">/content/package
        [@name='Onebox Reports']/query[@name='MarginChart']
      </path>
    </mapEntry>
  </mapEntries>
</module>
```
The following communication flow takes place when a user enters the term report inventory as a search query.

1. Google Search Appliance receives the search query and requests a result set from both its own index capability and from the OneBox capability.

2. The OneBox capability identifies the search term report as a trigger for the cognos_report module and passes the query to this module as a search request.

3. The cognos_report module passes the query to the IBM Cognos OneBox provider.

4. The provider evaluates the search request and, based on the map.xml file entries, determines that both Inventory Chart and Inventory Report should be returned as the search result.

   If the search query included both the terms revenue and inventory, the Revenue Report would be returned as the search result because this is the first mapEntry.

5. The provider returns the Inventory Chart and Inventory Report to Google Search Appliance.

6. Google Search Appliance formats the reports using the XSL stylesheet included with the cognos_report module.

7. Inventory Chart and Inventory Report appear as a OneBox result along with the search results returned from the Google index.

Another configuration option is to add an additional IBM Cognos OneBox module to process search requests that include a trigger for charts. In this case, the map.xml file includes separate <module_OneBox name> items. The IBM Cognos OneBox provider processes requests from each module separately. The order of the modules in the map.xml file does not affect results.

**Example - Configure the IBM Cognos OneBox Provider to Return a Metric**

You can configure the IBM Cognos OneBox provider to return the chart and data of a specified metric. The package name is specified in the map.xml file with the attribute <path>. You specify a different <mapEntry provider> in the map.xml file compared to reports, <mapEntry provider="mm"> instead of <mapEntry provider="cm">.

You can install and configure one or more IBM Cognos OneBox modules to process requests for reports and metrics. You want to return both a report and a metric for a single search request. To support this type of OneBox result, you install an additional IBM Cognos OneBox module on Google Search Appliance and configure
the module to use metric as a trigger. Google Search Appliance includes two IBM Cognos OneBox modules, each with a unique name, cognos_report and cognos_metric.

You modify the map.xml file to include the following module entry:

```xml
<module oneboxName="cognos_report">
  <mapEntries>
    <mapEntry provider="cm">
      <regex>.*revenue.*</regex>
      <path type="output">/content/package[@name='Onebox Reports']/query[@name='RevenueReport']</path>
    </mapEntry>
    <mapEntry provider="cm">
      <regex>.*inventory.*</regex>
      <path type="output">/content/package[@name='Onebox Reports']/query[@name='InventoryReport']</path>
    </mapEntry>
  </mapEntries>
</module>

<module oneboxName="cognos_metric">
  <mapEntries>
    <mapEntry provider="mm">
      <regex>.*</regex>
      <path>International Sales</path>
    </mapEntry>
  </mapEntries>
</module>
```

The following communication flow takes place when a user enters the term metric revenue or revenue metric as a search query.

1. Google Search Appliance receives the search query and requests a result set from both its own index capability and from the OneBox capability.
2. The OneBox capability identifies the search term metric as a trigger for the cognos_metric module and passes the query to this module as a search request.
3. The cognos_metric module passes the query to the IBM Cognos OneBox provider.
4. The provider evaluates the search request and, based on the map.xml file entries, requests results from the provider used for metrics.
5. The metrics provider searches the International Sales package and returns the chart and data for a metric whose name best matches revenue.
6. The IBM Cognos OneBox provider returns the metric to Google Search Appliance.
7. Google Search Appliance formats the metric using the XSL stylesheet included with the cognos_metric module.
8. The metric appears as OneBox results along with the search results returned from the Google index.

Another configuration option is to use a single IBM Cognos OneBox module and add <mapEntry provider="mm"> entries to the map.xml file. With this configuration, OneBox results can include content from only one of the provider types, cm or mm, but not both.
Customizing the Search Results for Google OneBox Integration

By default, the IBM Cognos OneBox components required for Google OneBox integration are configured to return a list of IBM Cognos BI search results. Other than normal setup, such as configuring the IBM Cognos OneBox module to specify the location of the IBM Cognos OneBox provider, you do not need to customize the configuration to show IBM Cognos content as OneBox results.

You can modify the default configuration to customize search processing and to show specific IBM Cognos content, such as a report or metric, instead of a list of IBM Cognos BI search results. For example, you can configure the IBM Cognos OneBox components to return a specific report when a user enters "inventory report" as a search request.

Configuring Secure Authentication with Google OneBox for Enterprise

By default, Google OneBox applications are open and anonymous. If your application requires secure authentication, you must configure the Google Search Appliance and your IBM Cognos installation appropriately.

Before you begin

You must be familiar with the Google Search Appliance administration interface and the Google OneBox authentication options. For more information, see the Google Search Appliance documentation.

Procedure

1. Issue a certificate to the Google Search Appliance that is specifically issued for both client authentication and server authentication.
   This key usage is required as the certificate authenticates the Google Search Appliance to both the end-user browser and the IBM Cognos provider installation.
2. Disable force secure connections when serving in the Google Search Appliance SSL Settings.
   When defining the address of the IBM Cognos provider, ensure that you specify the protocol as https:// and append the address with ?CAMNamespace=onebox as in the following example:
   https://server_name/c10/cgi-bin/cognos.cgi/onebox?CAMNamespace=onebox
3. Use IBM Cognos Configuration to set up the custom security provider:
   - Add a Java security namespace to IBM Cognos BI with a type of "Custom Java Provider".
   - Give the namespace an ID.
   - For the Java class name, type
     ClientCertTrustedSignon
4. Configure a custom Java provider.
   The Java keystore must be generated that contains the certificate of the Certificate Authority that generated the certificate used by the OneBox machine. The keystore can be generated by executing the following command:
   keytool -import -file <file containing PEM version of CA's certificate> -keystore <java keystore filename>
The keytool utility is located in: c10_location/bin/jre/6.0/bin and the maximum Certificate Authority key length that can be processed by the java keytool utility is 2048 bits.

5. Create the following file and add it to the c10_location/configuration directory:

ClientCertTS_namespace_ID.properties

Obtain the namespace ID from IBM Cognos Configuration. The file must contain the following information, modified for your environment.

# Identifies the keystore location and password
keystoreFileName=trustedCAs/mykeystore.ks
# java keystore file as generated by "keytool"
keystorePassword=yapwd4KS
# password (in the clear) for the keystore file
redirectNamespaceID=ldap
# the Cognos BI namespace ID to which the user should be authenticated

To improve the user experience in environments that use Microsoft Windows operating system authentication methods, configure your Web server to use "Integrated Windows Authentication".
Appendix C. Command Line Options

Use command line options with the configuration command to modify the behavior of IBM Cognos Configuration when it starts.

The command line option you specify sets the mode of operation of IBM Cognos Configuration. If you run IBM Cognos Configuration in interactive mode, you use a graphical user interface to configure IBM Cognos BI components. If you start IBM Cognos Configuration in silent mode, it runs silently in the background.

By default, IBM Cognos Configuration runs in interactive mode.

You can use the following command line options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-s</code></td>
<td>Runs IBM Cognos Configuration in silent mode. Uses property values specified in the cogstartup.xml file to configure installed components and then starts all services.</td>
</tr>
<tr>
<td><code>-stop</code></td>
<td>Runs IBM Cognos Configuration in silent mode and stops all IBM Cognos services.</td>
</tr>
<tr>
<td><code>-test</code></td>
<td>Tests configuration settings in silent mode. Uses property values specified in the cogstartup.xml file to do the test.</td>
</tr>
<tr>
<td><code>-utf8</code></td>
<td>Saves the configuration in UTF-8 encoding when used with <code>-s</code> to run IBM Cognos Configuration in silent mode.</td>
</tr>
<tr>
<td><code>-l language ID</code></td>
<td>Runs IBM Cognos Configuration using the language specified by the language ID.</td>
</tr>
<tr>
<td><code>-e filename.xml</code></td>
<td>Exports the current configuration settings to the specified file in silent mode.</td>
</tr>
<tr>
<td><code>-log</code></td>
<td>Runs IBM Cognos Configuration and creates an error log named cogconfig timestamp.log in Cognos_location/logs.</td>
</tr>
</tbody>
</table>
| `-java:{local|env}` | Runs IBM Cognos Configuration on Microsoft Windows operating system using the Java Runtime Environment version that is defined as either:

  - env: environmentally in the JAVA_HOME environment variable
  - local: locally in the Cognos_location/bin/jre directory

If you do not set this flag, IBM Cognos BI uses the JAVA_HOME environment variable. |
You can use more than one command line option at a time. For example, you can run IBM Cognos Configuration in silent mode and send all error messages to a log file.

---

**Run IBM Cognos Configuration in Silent Mode**

Run IBM Cognos Configuration in silent mode to apply configuration settings on UNIX or Linux computers that do not support the XWindows system, or to apply similar configuration settings to multiple computers.

Some configuration settings are not saved in the cogstartup.xml file unless you use the graphical user interface. For example, the server time zone is not set for your IBM Cognos components when you modify the cogstartup.xml file directly and then run IBM Cognos Configuration in silent mode. In this case, other user settings that rely on the server time zone may not operate as expected.

Before you run IBM Cognos Configuration in silent mode, you must export a configuration from another computer that has the same installed IBM Cognos components and then copy it to the computer that you want to configure. You cannot just copy a saved cogstartup.xml file from one computer to another.

**Procedure**

1. Copy the exported configuration file from the source computer or network location to the Cognos_location/configuration directory on the computer you want to configure.
2. Rename the file to cogstartup.xml.
3. Go to Cognos_location/bin.
4. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -s`
   - On UNIX or Linux, type `./cogconfig.sh -s`

   **Tip:** To view messages that were generated and determine when the processing is complete, see the cogconfig_response.csv file in the Cognos_location/logs directory.

IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, creates certificates, and, if applicable, starts all services or processes for your IBM Cognos component. The results of the activity are stored in the file Cognos_location/logs/cogconfig_response.csv.

---

**Stop the IBM Cognos Service in Silent Mode**

If you want to stop the IBM Cognos service, you can run IBM Cognos Configuration using the stop option. This option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
IBM Cognos Configuration runs in silent mode and stops all services or processes for your IBM Cognos component.

**Test IBM Cognos BI Configuration**

If you want to test the current configuration settings, you can run IBM Cognos Configuration using the test option. This option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -test`
   - On UNIX or Linux, type `./cogconfig.sh -test`

IBM Cognos Configuration runs in silent mode and tests the IBM Cognos components using the property values specified in the `cogstartup.xml` file. During the test, IBM Cognos Configuration checks the CSK availability and tests the connections to the content store and to the mail server.

**Save the Configuration in UTF-8 Encoding**

You can save the current configuration in UTF-8 encoding when you run IBM Cognos Configuration in silent mode. If you do not specify this option, the configuration is saved in the default encoding of your computer.

You cannot use this option when running IBM Cognos Configuration in interactive mode. Use the menu command to save the configuration in UTF-8 encoding.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -s -utf8`
   - On UNIX or Linux, type `./cogconfig.sh -s -utf8`

IBM Cognos Configuration applies the configuration settings specified in the local copy of `cogstartup.xml`, encrypts credentials, creates certificates, and, if applicable, starts the service or process for your IBM Cognos component.

**Run IBM Cognos Configuration in Another Language**

You can run IBM Cognos Configuration in interactive mode and view the user interface in a supported language that is different from the one selected in the installation wizard.
The language option does not control the specification for the character encoding. If you use more than one language for the local configuration properties, ensure that you save the configuration in UTF-8 encoding.

Use a supported language code. For more information about supported languages, see the IBM Cognos Customer Service Center [http://www.ibm.com/software/data/support/cognos_crc.html](http://www.ibm.com/software/data/support/cognos_crc.html).

**Procedure**

1. Go to Cognos_location/bin.
2. Type the appropriate configuration command, where language ID is the product locale such as en (English) or zh-cn (Simplified Chinese).
   - On Microsoft Windows operating system, type
     
     cogconfig.bat -l language ID
   - On UNIX or Linux, type
     
     /cogconfig.sh -l language ID

For example,

```
cogconfig.bat -l zh-cn
```

IBM Cognos Configuration starts, and the interface uses the specified language. If the language that you specify is invalid or not supported, English is used.

---

**Export Configuration Settings in Silent Mode**

You can export the current configuration to a specified XML file using the export option. You can then use the XML file to configure another computer in an unattended configuration.

The export option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
     
     cogconfig.bat -e filename.xml
   - On UNIX or Linux, type
     
     cogconfig.sh -e filename.xml

**Create an Error Log**

You can create a log file that records configuration errors. Use this log file for troubleshooting.

**Procedure**

1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
     
     cogconfig.bat -log
   - On UNIX or Linux, type
     
     /cogconfig.sh -log

The cogconfig_timestamp.log file is created in Cognos_location/logs.
Run IBM Cognos Configuration on Windows using Specified JVM

On Microsoft Windows operating system, you can specify which Java Virtual Machine (JVM) IBM Cognos Configuration uses.

By default, IBM Cognos BI uses the JVM defined by the JAVA_HOME environment variable. For example, if you use an application server such as WebSphere, you may have set up this environment variable.

If you do not set this environment variable, IBM Cognos Configuration uses the local JVM. The local JVM is installed in the Cognos_location/bin/jre directory.

Procedure
1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   • To run IBM Cognos Configuration in interactive mode, using the local JVM, type:
     cogconfig.bat - java:local
   • To run IBM Cognos Configuration in interactive mode, using the JVM defined in the JAVA_HOME environment variable, type:
     cogconfig.bat
Appendix D. Troubleshooting

Use this troubleshooting reference information and these solutions as a resource to help you solve specific problems you may encounter during or after the installation of IBM Cognos Business Intelligence components.

For more information about troubleshooting resources, see the Troubleshooting section of the Administration and Security Guide.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you. Another valuable troubleshooting tool is the Knowledge Base, which is available on the IBM Cognos Resource Center [http://www.ibm.com/software/data/support/cognos_crc.html]. The Knowledge Base is a database of problems and solutions for all IBM Cognos products.

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Troubleshooting a problem

Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine why something does not work as expected and how to resolve the problem.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions help you and the IBM technical-support representative know where to start to find the cause of the problem. This step includes asking yourself basic questions:

• What are the symptoms of the problem?
• Where does the problem occur?
• When does the problem occur?
• Under which conditions does the problem occur?
• Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead to a resolution of the problem.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is “What is the problem?” This question might seem straightforward; however, you can break it down into several focused questions that create a more descriptive picture of the problem. These questions can include:

• Who, or what, is reporting the problem?
What are the error codes and messages?
How does the system fail? For example, is the problem a loop, hang, crash, performance degradation, or incorrect result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in resolving a problem. Many layers of technology can exist between the reporting and failing components. Networks, disks, and drivers are only a few of the components to consider when you are investigating problems.

The following questions help you to isolate the problem layer:
• Is the problem specific to one platform or operating system, or is it common across multiple platforms or operating systems?
• Is the current environment and configuration supported?

If one layer reports the problem, the problem does not necessarily originate in that layer. Part of identifying where a problem originates is understanding the environment in which it exists. Take some time to completely describe the problem environment, including the operating system and version, all corresponding software and versions, and the hardware. Confirm that you are running within an environment that is supported; many problems can be traced back to incompatible levels of software that are not intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for cases that are one-time occurrences. You can most easily develop a timeline by working backward: Start at the time an error was reported (as precisely as possible, even down to the millisecond), and work backward through the available logs and information. Typically, you need to look only as far as the first suspicious event that you find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:
• Does the problem happen only at a certain time of day or night?
• How often does the problem happen?
• What sequence of events leads up to the time that the problem is reported?
• Does the problem happen after an environment change, such as an upgrade or an installation of software or hardware?

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important part of troubleshooting. These questions about your environment can help you to identify the cause of the problem:
• Does the problem always occur when the same task is being performed?
• Does a certain sequence of events need to occur for the problem to occur?
• Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs and correlate any dependencies. Remember that just
because multiple problems might have occurred around the same time, the problems are not necessarily related.

**Can the problem be reproduced?**

Problems that you can reproduce are often easier to solve. However, problems that you can reproduce can have a disadvantage. If the problem as a significant business impact, you do not want it to recur. If possible, re-create the problem in a test or development environment, which typically offers you more flexibility and control during your investigation. Answer the following questions:

- Can the problem be re-created on a test system?
- Are multiple users or applications encountering the same type of problem?
- Can the problem be re-created by running a single command, a set of commands, or a particular application?

**Searching knowledge bases**

You can often find solutions to problems by searching IBM knowledge bases. You can optimize your results by using available resources, support tools, and search methods.

**About this task**

You can find useful information by searching the information center for IBM Cognos, but sometimes you need to look beyond the information center to resolve problems.

**Procedure**

To search knowledge bases for information that you need, use one or more of the following approaches:

- Find the content that you need by using the [IBM Support Portal (IBM Cognos Business Intelligence Support Portal)](https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos)

  The IBM Support Portal is a unified, centralized view of all technical support tools and information for all IBM systems, software, and services. The IBM Support Portal lets you access the IBM electronic support portfolio from one place. You can tailor the pages to focus on the information and resources that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM Support Portal by viewing the demo videos (https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos) about this tool. These videos introduce you to the IBM Support Portal, explore troubleshooting and other resources, and demonstrate how you can tailor the page by moving, adding, and deleting portlets.

- Search for content about IBM Cognos by using one of the following additional technical resources:
  - [IBM Cognos BI APARs (problem reports)](https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos)
  - Searching technotes
  - [IBM Cognos forums and communities](https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos)
  - [Cognos Customer Center](https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos)

- Search for content by using the IBM masthead search. You can use the IBM masthead search by typing your search string into the Search field at the top of any ibm.com® page.
• Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an external search engine, your results are more likely to include information that is outside the ibm.com domain. However, sometimes you can find useful problem-solving information about IBM products in newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include “IBM” and the name of the product in your search if you are looking for information about an IBM product.

Getting fixes
A product fix might be available to resolve your problem.

Procedure

To find and install fixes:
1. Determine which fix you need [Fix Central]
2. Download the fix. Open the download document and follow the link in the “Download package” section.
3. Apply the fix by following the instructions in the “Installation Instructions” section of the download document.
4. Subscribe to receive weekly email notifications about fixes and other IBM Support information.

Contacting IBM Support
IBM Support provides access to a variety of IBM resources for help with software questions.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can contact IBM Support. Before contacting IBM Support, your company must have an active IBM maintenance contract, and you must be authorized to submit problems to IBM. You should also have the following information at hand:
• Your customer identification number
• Your service request number, if it is an ongoing service request
• The phone number where you can be reached
• The version of the software you use
• The version of the operating environment you use
• A description of what you were doing when the problem occurred
• The exact wording of any error messages that display
• Any steps you took to attempt to solve the problem

For information about the types of available support, see the Support portfolio topic in the Software Support Handbook.

Procedure

Complete the following steps to contact IBM Support with a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For more information, see the Getting IBM support topic in the Software Support Handbook.
2. Gather diagnostic information.

3. Submit the problem to IBM Support in one of the following ways:
   • Using IBM Support Assistant (ISA): Use this feature to open, update, and view an Electronic Service Request with IBM. Any data that has been collected can be attached to the service request. This expedites the analysis and reduces the time to resolution.
   • Online through the IBM Support Portal: You can open, update, and view all your Service Requests from the Service Request portlet on the Service Request page.
   • By phone: For the phone number to call, see the directory of worldwide contacts web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support Web site daily, so that other users who experience the same problem can benefit from the same resolution.

Exchanging information with IBM

To diagnose or identify a problem, you might need to provide IBM Support with data and information from your system.

In other cases, IBM Support might provide you with tools or utilities to use for problem determination.

Sending information to IBM Support

To reduce the time that it takes to resolve your problem, you can send trace and diagnostic information to IBM Support.

Procedure

To submit diagnostic information to IBM Support:

1. Open a problem management record (PMR). You can use the IBM Support Assistant or the IBM Service Request tool.

2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to resolve your PMR. You can collect the diagnostic data manually or automatically.

3. Compress the files by using the TRSMAIN or AMATERSE program. Download the free utility from the IBM to the IBM Cognos BI system and then install the utility using the TSO RECEIVE command.

4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:
   • The Service Request tool
   • Standard data upload methods: FTP, HTTP
   • Secure data upload methods: FTPS, SFTP, HTTPS
   • Email
If you are using an IBM Cognos product and you use ServiceLink / IBMLink to submit PMRs, you can send diagnostic data to IBM Support in an email or by using FTP. All of these data exchange methods are explained on the [IBM Support site](#).

**Receiving information from IBM Support**
Occasionally an IBM technical-support representative might ask you to download diagnostic tools or other files. You can use FTP to download these files.

**Before you begin**
Ensure that your IBM technical-support representative provided you with the preferred server to use for downloading the files and the exact directory and file names to access.

**Procedure**

To download files from IBM Support:

1. Use FTP to connect to the site that your IBM technical-support representative provided and log in as anonymous. Use your email address as the password.
2. Change to the appropriate directory:
   a. Change to the /fromibm directory.
      
   `cd fromibm`
   b. Change to the directory that your IBM technical-support representative provided.
      
   `cd nameofdirectory`
3. Enable binary mode for your session.
   
   `binary`
4. Use the get command to download the file that your IBM technical-support representative specified.
   
   `get filename.extension`
5. End your FTP session.
   
   `quit`

**Subscribing to Support updates**

To stay informed of important information about the IBM products that you use, you can subscribe to updates.

**About this task**

By subscribing to receive updates, you can receive important technical information and updates for specific Support tools and resources. You can subscribe to updates by using one of two approaches:

**RSS feeds and social media subscriptions**

The following RSS feeds and social media subscriptions are available for IBM Cognos BI:

- [RSS feed for a developerWorks® forum](#)
- Subscription to Cognos Support notebook blog
- [RSS feed for the Support site for IBM Cognos Business Intelligence](#)
For general information about RSS, including steps for getting started and a list of RSS-enabled IBM web pages, visit the IBM Software Support RSS feeds site.

**My Notifications**

With My Notifications, you can subscribe to Support updates for any IBM product. You can specify that you want to receive daily or weekly email announcements. You can specify what type of information you want to receive, such as publications, hints and tips, product flashes (also known as alerts), downloads, and drivers. My Notifications enables you to customize and categorize the products that you want to be informed about and the delivery methods that best suit your needs.

**Procedure**

To subscribe to Support updates:

1. Subscribe to the *Product* RSS feeds.
2. To subscribe to My Notifications, begin by going to the IBM Support Portal and clicking **My Notifications** in the **Notifications** portlet.
3. If you have already registered for My support, sign in and skip to the next step. If you have not registered, click **Register now**. Complete the registration form using your email address as your IBM ID and click **Submit**.
4. Click **Edit profile**.
5. Click **Add products** and choose a product category; for example, **Software**.
6. In the second list, select a product segment; for example, **Data & Information Management**.
7. In the third list, select a product subsegment, for example, **Databases**.
8. Select the products that you want to receive updates for.
9. Click **Add products**.
10. After selecting all products that are of interest to you, click **Subscribe to email** on the **Edit profile** tab.
11. Select **Please send these documents by weekly email**.
12. Update your email address as needed.
13. In the **Documents list**, select the product category; for example, **Software**.
14. Select the types of documents that you want to receive information for.
15. Click **Update**.

**Results**

Until you modify your RSS feeds and My Notifications preferences, you receive notifications of updates that you have requested. You can modify your preferences when needed (for example, if you stop using one product and begin using another product).

**Log Files**

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product.

Operations performed in IBM Cognos BI are recorded in various log files for tracking purposes. For example, if you experienced problems installing IBM Cognos BI, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

Appendix D. Troubleshooting 523
Before you begin viewing log files, ensure that they contain the information that you need. The number of log files and the information they contain are set by parameters in IBM Cognos Connection and in IBM Cognos Configuration.

Use IBM Cognos Administration to learn about logging categories and how to set the level of detail to log for each category.

For more information, see the IBM Cognos BI Administration and Security Guide.

Use IBM Cognos Configuration to specify the size, number, and location of log files, and to configure the properties of the log server.

When troubleshooting, the following files can assist you:

**The Transfer Log File**

This file records the activities that the installation wizard performed while transferring files.

The transfer log file is located in the `c10_location\instlog` directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

`tl-BISRVR-8.1-0.0-20080901_1122.txt`

**The Transfer Summary-Error Log File**

This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components.

The transfer summary-error log file is located in the `c10_location\instlog` directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

`tl-BISRVR-8.1-0.0-20080901_1122_summary_error.txt`

**The Startup Configuration File**

This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml.

If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file. The backup configuration files are located in the `c10_location\configuration` directory. The following is an example of the file name format for backup configuration files:

`cogstartup_200811231540.xml`

**The Startup Configuration Lock File**

This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window.

If you experience problems opening IBM Cognos Configuration, you can check the `c10_location\configuration` directory for the cogstartup.lock file. If the file exists and
IBM Cognos Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. You can delete the lock file and then open IBM Cognos Configuration.

**The Locale Configuration File**

This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support.

If you experience problems with language support in the user interface or in reports, use these files to track your changes. The backup configuration files are located in the `c10_location/configuration` directory. The following is an example of the file name format:

coglocale_200811231540.xml

**The Runtime Log File**

The default IBM Cognos log file, named cogserver.log file, or other log files that you configure to receive log messages from the log server, record information after you start the IBM Cognos BI service. They are located in the `c10_location/logs` directory. If you configured another destination for log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you to diagnose problems in your runtime environment.

**The Gateway Log File**

The gateways record errors in the gateway log file, which is located in the `c10_location/logs` directory.

You can use the gateway log file to troubleshoot problems that prevent the gateway from processing requests or from using encryption. Symptoms of these problems are as follows:

- User IDs and passwords do not work
- Single signon does not work
- The dispatcher is running but users receives an error message advising that the IBM Cognos BI server is not available

The gateway log file uses the following naming format, where `gateway_interface` is cgi, mod (Apache 1.3 module), mod2 (Apache 2.0 module), or isapi.

gw.gateway_interface.log (for example, gwcgi.log)

**The Uninstallation Log File**

This file records the activities that the Uninstall wizard performed while uninstalling files. The log file is named cognos_uninst_log.htm and is located in the Temp directory. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos BI components.
The Silent Mode Log File

This file records the activities that IBM Cognos Configuration performed while running in silent mode. This log file is named cogconfig_response.csv and is located in the c10_location/logs directory.

The ReportNet to IBM Cognos BI Upgrade File

This file contains a summary of the results of an upgrade from ReportNet to IBM Cognos BI. The log file is named upgradeLog.xml and is located in the c10_location/logs directory. The file is in xml format and references an xslt style sheet. You can double-click the file to have it display in your browser.

Problems starting IBM Cognos Business Intelligence

You can perform the following tasks when encountering problems starting IBM Cognos Business Intelligence.

You may encounter problems when you try
- to start the IBM Cognos BI service
- to open the Welcome page for the IBM Cognos BI portal for the first time
- to start an application server, such as WebLogic or WebSphere

The following table shows some common symptoms and their solutions.

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You do not see the splash screen for the IBM Cognos BI portal when you start IBM Cognos BI.</td>
<td>Check your Web server configuration.</td>
</tr>
<tr>
<td>The service starts, but no tables are created in the content store database.</td>
<td>Check your content store configuration.</td>
</tr>
<tr>
<td>The service does not start.</td>
<td>Ensure that you wait a few moments before submitting a request.</td>
</tr>
<tr>
<td>The application server does not start.</td>
<td>Check the file permissions and directory names of the application server installation location.</td>
</tr>
</tbody>
</table>

Ensure that you use other software that is supported by IBM Cognos components. You can view an up-to-date list of environments, such as operating systems, patches, browsers, Web servers, directory servers, and database servers on the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

CFG-ERR-0106 error when starting the IBM Cognos service in IBM Cognos Configuration

When you start the IBM Cognos Business Intelligence service, you may receive the following error message:
CFG-ERR-0106 IBM Cognos Configuration received no response from the IBM Cognos service in the allotted time. Check that IBM Cognos service is available and properly configured.

There are two possible causes for this problem:
- The IBM Cognos service needs more time to start.
- A standby Content Manager computer may be configured incorrectly.

The IBM Cognos service needs more time

By default, IBM Cognos Configuration checks the progress of the start request every half second for three minutes. If IBM Cognos Configuration does not receive a response within this time, the error message displays.

The amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos service is controlled by the ServiceWaitInterval and ServiceMaxTries properties.

The ServiceWaitInterval property represents the time interval, in milliseconds, at which IBM Cognos Configuration checks the progress of the start request. By default, its value is 500, which is equivalent to half a second.

The ServiceMaxTries property represents the number of times that IBM Cognos Configuration checks the progress of the start request. By default, its value is 360.

Content Manager is configured incorrectly

If the error message displays on a standby Content Manager computer, the setting for storing the symmetric keys may be incorrect.

Changing the wait time for the IBM Cognos service

If you received the CFG-ERR-0106 error because the IBM Cognos service needs more time to start, change the amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos service.

Procedure

1. Using IBM Cognos Configuration, stop the IBM Cognos service.
2. Open the $c10_location/configuration/cogconfig.prefs$ file in an editor.
   This file is created automatically the first time you open IBM Cognos Configuration.
3. Add the following code to the file:
   
   ```
   ServiceWaitInterval=number of milliseconds
   ServiceMaxTries=number of times
   ```
   
   Tip: Add the numeric values that correspond to your configuration needs.
4. Save the file.
5. Using IBM Cognos Configuration, start the IBM Cognos service.

Changing the location where symmetric keys are stored

If you received the CFG-ERR-0106 error on a standby Content Manager computer, configure the computer to store the symmetric keys locally.
Procedure
1. On the standby Content Manager computer, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, click **Cryptography**.
3. In the **Properties** window, under **CSK settings**, set **Store symmetric key locally** to **True**.
4. From the **File** menu, click **Save**.
5. From the **Actions** menu, click **Start**.
   
   This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the **Actions** menu.

Cryptographic error when starting IBM Cognos Business Intelligence

If the following error occurs when you try to start the IBM Cognos Business Intelligence service after installing server or client components, then your Java Runtime Environment (JRE) is missing the encryption and decryption routines.

If you receive this error, then you must copy the Java Archive (.jar) file that is provided to your JRE director since it is required by IBM Cognos BI.

[Cryptography]
1. [ ERROR ] java.lang.NoClassDefFoundError:
   
   \texttt{javax/net/ServerSocketFactory:}
   
   Your Java Runtime Environment (JRE) is missing the encryption and decryption routines that are required by IBM Cognos BI. You must copy the Java Archive (.jar) file that is provided to your JRE directory.

Procedure

Copy the bcprov-jdknm-nnn.jar file from the \texttt{c10\_location/bin/jre\_version/lib/ext} directory to the \texttt{Java\_location/jre/lib/ext} directory.

If you are using 64-bit components, copy the file from \texttt{c10\_location/bin64} rather than \texttt{c10\_location/bin}.

Unable to start the IBM Cognos service because the port is used by another process

You may not be able to start the IBM Cognos Business Intelligence service or process if one of the default ports is used by another process.

Tip: To view the current network TCP/IP network connections, use the **netstat** command.

Use IBM Cognos Configuration to change the default port that IBM Cognos BI uses.

When you change the port used by the local dispatcher, you must change the value of the Dispatcher URI properties. Because the change affects all the URIs that are based on the local dispatcher, you must change the URIs of all local components. By default, local components contain localhost in the URI.
For example, if you install all components on one computer and you want to change the dispatcher port, replace 9300 in all dispatcher and Content Manager URIs with the new port number.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click the appropriate group or component:
   - To access the port number in the dispatcher and Content Manager URIs, click **Environment**.
   - To access the port number for the local log server, under **Environment**, click **Logging**.
   - To access the shutdown port number, under **Environment**, click **IBM Cognos services > IBM Cognos BI**.
   - To access the port number for the location of the applications.xml file used by Portal Services, under **Environment**, click **Portal Services**.
3. In the Properties window, click the Value box next to the property that you want to change.
4. Change the value from 9300 to the new value.
   Ensure that you change the ports in all URIs that contain localhost:9300.
5. From the File menu, click **Save**.
6. From the Action menu, click **Start**.

**IBM Cognos service does not start or fails after starting**

You start the IBM Cognos BI service but services either do not start correctly or are very slow to start. After services start, the system fails a short time afterwards. While services are starting, Java uses 100 percent of the CPU time.

You may also receive multiple occurrences of error messages such as the following:

- **DPR-DPR-1035 Dispatcher detected an error.**
- **CAM-CRP-1157 Unable to synchronize the local common symmetric key store with Content Manager.**

**Procedure**

If you use a DB2 database for the content store, ensure that the database version and Java version are compatible.

For DB2 version 8.2, Java 1.5 is not supported. For DB2 version 9, Java 1.5 is supported on all operating systems except HPUX and Solaris.

**Results**

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

**IBM Cognos Business Intelligence server fails to start and gives no error message**

An IBM Cognos BI server may fail to start after an upgrade or new installation, but no error message displays. This may occur when a previously running or new IBM Cognos BI server is configured to use a large amount of memory.
If the server on which IBM Cognos BI is installed contains version 1.0 of Microsoft security update 921883, there may be an issue when a lot of contiguous memory is requested by an application.

This is a known issue with version 1.0 of Microsoft security patch 921883. Microsoft distributed a second version of the patch to fix the problem. As a workaround, uninstall the first security patch, or install version 2.0 of the patch. Alternatively, you can configure the IBM Cognos BI server to use less memory.

For more information, see the Microsoft knowledge base article about programs using a lot of contiguous memory failing, at the Microsoft support Web site.

**IBM Cognos Business Intelligence server not available when starting IBM Cognos BI**

After you configure IBM Cognos components and start the IBM Cognos services, when you connect to the IBM Cognos Business Intelligence portal, the following error message may display:

*The Cognos Gateway is unable to connect to the Cognos BI server.*

*The server may be unavailable, or the gateway may not be correctly configured.*

Check the IBM Cognos server log file for more information. By default, the cogserver.log file is located in the `c10_location/logs` directory. If you configured another destination for log messages, check the appropriate file or database.

Content Manager may not be able to connect to the content store if the content store is not configured properly. This may occur if

- the content store uses an unsupported character encoding
- the content store uses a database collation sequence that is case sensitive
- the configuration settings you specified in IBM Cognos Configuration are not valid

**Unsupported character encoding**

If the following messages display in the log file, the database you created for the content store does not use a supported character encoding:

- For Oracle:
  
  *CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.*
  
  *CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.*
  
  *CM-SYS-5126 The content store database server uses the character set US7ASCII.*
  
  *CM-SYS-5125 The content store database client uses the character set US7ASCII.*

- For DB2 UDB:
  
  *CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.*
  
  *CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.*
  
  *CM-SYS-5124 The content store database server uses the code page 1252.*

- For Sybase:
CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.

For Content Manager to connect to the content store, the content store must use the appropriate character encoding, as listed in the following table.

<table>
<thead>
<tr>
<th>Database</th>
<th>Character encoding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 9i</td>
<td>AL32UTF8</td>
</tr>
<tr>
<td></td>
<td>AL32UTF16</td>
</tr>
<tr>
<td>DB2 UDB</td>
<td>Codeset UTF-8</td>
</tr>
<tr>
<td>Sybase ASE</td>
<td>UTF-8</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>UTF8</td>
</tr>
<tr>
<td></td>
<td>UTF16</td>
</tr>
</tbody>
</table>

To resolve this problem, you must recreate the content store database using the correct character encoding, or convert the character encoding. For more information, see the database documentation.

**Case-sensitive collation sequence**

If the following messages are in the log file, the database you created for the content store uses a database collation sequence that is case sensitive:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5122 The content store database has a default collation that is case-sensitive. Content Manager requires a content store that has a case-insensitive collation.

CM-SYS-5123 The content store database server uses the collation <parameter>.

CM-SYS-5007 Content Manager build @cm_build_version@ failed to start! Review the Content Manager log files and then contact your system administrator or customer support.

To resolve this problem, you must recreate the content store database using a database collation sequence that is not case sensitive. For more information, see the database documentation.

**Invalid configuration settings**

If the following or similar messages are in the log file, you did not configure the content store correctly in IBM Cognos Configuration.

- For Microsoft SQL Server:
  
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is "jdbc:JSQLConnect://localhost:1433/cm".

• For DB2:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-SYS-5003 Content Manager is unable to access the content store. Verify your database connection parameters and then contact your database administrator.
[IBM][CLI Driver] SQL1013N The database alias name or database name “CM123” could not be found.

• For Oracle:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is "jdbc:oracle:thin:@localhost:1521:pb1".
  ORA-01017: invalid username/password; logon denied.

• For Sybase:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is "jdbc:sybase:Tds:localhost:5000/cm".
  JZ006: Caught IOException: java.net.ConnectException: Connection refused: connect.

If you are using an Oracle database, do not use illegal characters, such as an underscore in IBM Cognos Configuration for the Service Name property. If the Service Name includes illegal characters, tables are not created in the content store database when the IBM Cognos service is started.

**Configuring a content store in IBM Cognos Configuration**

If you received a CM-CFG-5036 or CM-CFG-5063 error code, the content store might not be configured correctly.

To resolve the issue, reconfigure the content store (see “Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store” on page 147).

**Related concepts**

“Set Up Database Connectivity for the Content Store Database” on page 133

If you are using a database other than Cognos Content Database or Microsoft SQL Server as the content store, you may have to install database client software, or Java Database Connectivity (JDBC) drivers, or both, on each computer where you install Content Manager. Doing this allows Content Manager to access the content store database.

**Cannot log on to a namespace when using IBM Cognos Connection**

You open IBM Cognos Business Intelligence through IBM Cognos Connection. However, when you attempt to create a data source and log on to a namespace, the following error messages display:

• PRS-CSE-1255 Exception error encountered in data decryption.
CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error.

This issue may occur if you do not have the necessary permissions for the following directories:
- c10_location\configuration
- c10_location\configuration\csk
- c10_location\configuration\encryptkeypair
- c10_location\configuration\signkeypair

Enable the read and execute permissions on the directories listed above for anyone who must start the IBM Cognos service.

**IBM Cognos services fail to restart after a network outage**

The IBM Cognos Bootstrap Service restarts IBM Cognos services after a network outage.

For Tomcat installations where a network IP address is specified in the internal dispatcher URI, the IBM Cognos services may not initialize successfully during the restart. This requires a manual restart after the network is restored.

**Procedure**

To resolve the problem, configure the Internal dispatcher URI property in IBM Cognos Configuration to use localhost or the network host name.

**No warning that installing a later version of IBM Cognos Business Intelligence will automatically update the earlier version of the content store**

You have a version of ReportNet or IBM Cognos BI installed on your computer. You install a later version into a new location. You use the same database for the content store for both versions. After you configure the later version and start the IBM Cognos service, the earlier version of ReportNet or IBM Cognos BI no longer works because all content is automatically upgraded.

If you want to use different versions of ReportNet and IBM Cognos BI after you upgrade, ensure that before you install the later version, you
- back up the database you use for the content store
- restore the backup to a new location

Alternatively, you can choose to use the deployment tool to import the entire content store from an earlier version to the later version. All existing content in the content store database is replaced by the imported content. You receive a warning message about this.

**Download of resource fails**

If the download resource fails, it may be caused by recent Microsoft XMLHTTP upgrades if you do not have a language preference set in Internet Explorer.

You start Report Studio in Internet Explorer and the following error message displays:
The download of the specified resource has failed.

**Procedure**

To resolve the problem, specify a language preference in Internet Explorer.

**DB2 returns SQL1224N error when connecting from AIX**

If your content store is a DB2 database and you receive an SQL1224N error on AIX, check the db2diag.log file for additional information about the error.

If the error includes reason code 18, you might need to change the DB2 configuration to accept more connections. For more information, see the IBM DB2 support pages for the error SQL1224N.

**Content Manager error when starting IBM Cognos Business Intelligence**

After starting IBM Cognos BI, no BIBUSTKSERVMA process is started. There are errors listed in the pogo******.log and cogserver.log files. Users receive errors in the browser when connecting to the IBM Cognos BI portal.

In the pogo******.log file, an error related to Content Manager displays.

In the cogserver.log file, the following error displays:

*An attempt to register the dispatcher in Content Manager was unsuccessful. Will retry periodically.*

When connecting to http://computer name/ibmcognos, the following error messages display in the browser:

- DPR-ERR-2058 The dispatcher cannot service the request at this time. The dispatcher is still initializing
- SoapSocketException: Connection Refused

IBM Cognos Configuration uses a user ID to bind to the LDAP database. If this user ID is moved to another group, IBM Cognos Configuration can no longer locate it.

**Procedure**

To correct the problem, move the user ID back to the original group.

**Content Manager fails to start or takes a long time to start**

On Microsoft Windows, you try to start the service on the computer where you installed Content Manager. As the service is starting, the details include errors similar to the following:

*DPR-CMI-4006 Unable to determine the active Content Manager. Will retry periodically.*

*CM-SYS-5007 Content Manager build x.x.x.x failed to start!*

Details within the error log may also include references to OutOfMemoryError.

To resolve this problem, start the service using the DuseCMLargeResultSet parameter. You can add the parameter to the bootstrap configuration file and then
start the service using IBM Cognos Configuration or you can add the parameter to
the startup configuration file and then run the file.

Resolving an out-of-memory error using the bootstrap
configuration file
Start the IBM Cognos service by adding the DuseCMLargeResultSet parameter to
the bootstrap configuration file.

Procedure
1. Go to the c10_location\bin directory and open bootstrap_win32.xml in an XML
editor.
2. Find the section that begins with <param>"${install_path}.
3. Add the DuseCMLargeResultSet parameter to that section, in the location
shown by the bold text in the following example.
   <param>"Catalina.base=${install_path}/tomcat"</param>
   <param>"Catalina.home=${install_path}/tomcat"</param>
   <param>"java.io.tmpdir=${temp}"</param>
   <param>"DuseCMLargeResultSet=true"</param>
4. Save and close the file.
5. Start IBM Cognos Configuration and start the service.

Resolving an out-of-memory error using the startup
configuration file
Start the IBM Cognos service by adding the DuseCMLargeResultSet parameter to
the startup configuration file.

Procedure
1. Go to the c10_location\bin directory and open startup.bat in a text editor.
2. Find the following line:
   set CATALINA_OPTS=-Xmx768m -XX:MaxNewSize=384m -XX:NewSize=192m
   -XX:MaxPermSize=128m
   %DEBUG_OPTS%
3. Append the DuseCMLargeResultSet parameter to the line, as shown by the
   bold text in the following example:
   set CATALINA_OPTS=-Xmx768m -XX:MaxNewSize=384m -XX:NewSize=192m
   -XX:MaxPermSize=128m
   %DEBUG_OPTS%-DuseCMLargeResultSet=true
4. Save and close the file.
5. Start the service by running the startup.bat file.

DPR-ERR-2014 error displays in log file on Content Manager
computer
If Content Manager is installed on a separate computer and the event management
service on the Content Manager computer is disabled.

The following error message may be in the cogserver.log file:

DPR-ERR-2014 Unable to load balance the request because no nodes in the cluster are
available, or no nodes are configured for the service: eventManagementService

To correct the problem, turn off the event management service.
Procedure
1. Start IBM Cognos Configuration on the Content Manager computer.
2. In the Explorer pane, go to Environment > IBM Cognos services.
3. Set the Event management service enabled property to False.

Non-ASCII characters in installation directory cause run-time errors
On all operating systems, if you use non-ASCII characters in the installation directory for IBM Cognos Business Intelligence, it causes run-time errors. It also causes some product functions, such as report execution, to fail.

Install IBM Cognos BI in the default directory or use a directory name that contains only ASCII Latin-1 characters.

Cannot Open an MS Cube or PowerCube
You are unable to open an MS Cube or PowerCube, or you can open an MS Cube but only metadata is shown. For an MS Cube, you may receive the following error message:

MO-ERR-0030

"Cannot connect to the datasource. Please set the service to run as a domain user with the correct privileges."

To solve this problem, ensure that the user running the IBM Cognos Business Intelligence service has access rights to the cube.

PowerCubes are accessed through mapped drives or UNC path names.

Assigning access rights to MS cubes
For a user account to open MS cubes, it must be assigned the appropriate privileges in the system administrative tools.

Procedure
1. Add the domain user account that starts the IBM Cognos service to the Act as part of the operating system privilege:
   • Under Administrative Tools, select Local Security Policy.
   • Expand Security Settings, Local Policies and click User Rights Assignment.
   • Right-click the Act as part of the operating system policy and select Properties.
   • Click Add User or Group and add the user account that starts the IBM Cognos service.
2. If you use the domain userID and password method of authentication, add the user account that starts the IBM Cognos service to the domain that includes Content Manager, the Application Tier Components, IIS Web server, and the data source server (Microsoft SQL Server or Microsoft Analysis Server).
3. If you use an external namespace, such as Active Directory Server, for authentication, add the user account that starts the IBM Cognos service to the domain that includes the authentication provider.
   This domain must also include Content Manager, the Application Tier Components, IIS Web server, and the data source server (Microsoft SQL Server or Microsoft Analysis Server).
For more information about configuring external namespaces for authentication, see the topics about authentication providers in the *Installation and Configuration Guide*.

**Assigning access rights to PowerCubes**

For a user account to open PowerCubes, it must be assigned the appropriate privileges in IBM Cognos Administration.

**Procedure**

Ensure that the IBM Cognos user profile has sufficient operating system or domain access rights to open the PowerCube file.

For more information, see the *Administration and Security Guide*.

**The page cannot be found when starting IBM Cognos Business Intelligence in Windows 2003**

Installing IBM Cognos Business Intelligence on Microsoft Windows operating system 2003 may cause an error message when you try to start IBM Cognos BI.

The following error is caused by a security feature in Windows 2003 Internet Information Services (IIS). This security feature does not allow unknown cgi file extensions.

*The page cannot be found. The page you are looking for might have been removed, had its name changed, or is temporarily unavailable. HTTP Error 404 - File or Directory not found.*

**Procedure**

To resolve this problem, add a new file extension in IIS for the cognos.cgi file. For more information, see the IIS documentation.

**The page is not shown when opening a portal after installing IBM Cognos Business Intelligence**

After you install and configure IBM Cognos Business Intelligence, you are unable to connect to the Cognos BI portal.

This may be because the Web server is not properly configured. For example, the virtual directories required for IBM Cognos BI may not exist or they may point to the wrong physical folders.

For information about configuring the Web server, see the *Installation and Configuration Guide*.

**DPR-ERR-2058 Error Displays in Web Browser When Starting IBM Cognos Business Intelligence**

After you start the services in IBM Cognos Configuration and then try to open the portal, a message similar to one of the following may display:

**DPR-ERR-2058** The dispatcher encountered an error while servicing a request. XTS handler must be initialized before being invoked.

**DPR-ERR-2058** The dispatcher cannot service the request at this time. The dispatcher is still initializing. Please try again or contact your administrator.
These error messages usually occur when the dispatcher cannot communicate with Content Manager. To help you determine the specific cause, look in the cogserver.log file in the c10_location/logs directory. The most common causes are listed below, with solutions.

**IBM Cognos Services are Not Done Initializing**
After you start the services in IBM Cognos Configuration and the configuration tool shows that the services are running, wait a few minutes for all services to start before you open the portal.

**Content Manager is Not Available**
In a distributed installation, ensure that Content Manager is installed, configured, and running. Ensure also that the other IBM Cognos computers are configured with the correct Content Manager URI.

**The Content Store is Not Available or is Not Configured Properly**
Ensure that the content store database was created and that you configured it correctly in IBM Cognos Configuration.

**Tables are Not Created in the Content Store**
Ensure that you are using a version of DB2, Microsoft SQL Server, Oracle, or Sybase that is supported by IBM Cognos components.

**The Logon Credentials for the Content Store Are Incorrect**
Check whether the information changed. For example, DB2 reads information from the NT user management. If the password for the NT account changed, you must also change the logon credentials for the content store in IBM Cognos Configuration.

Check for special characters in the logon password. Occasionally, the JDBC driver does not accept characters that are reserved for xml, such as %, !, <, and >.

**The User Does not Have Appropriate Permissions**
Ensure that the user has the appropriate permissions.

**Out of Memory on HP-UX**
If you are using Tomcat, you can determine the issue is related to HP-UX server configuration. You may be exceeding the expected maximum number of simultaneously active threads per process.

**Increasing the maximum number of threads per process on HP-UX:**

If you are exceeding the expected maximum number of simultaneously active threads per process on HP-UX, increase the number of active threads.

**Procedure**

1. Have your system administrator change the Kernel parameter as follows:
   - max_thread_proc = 512
   - nkthread = 1024
2. Ensure that the ulimit settings are unlimited.

**Checking for an HP-UX configuration problem:**

If increasing the maximum number of active threads per process does not resolve the out-of-memory error on HP-UX, perform the following steps.
Procedure
1. In the /bin/startup.sh file, find
   `../tomcat/bin/catalina.sh start "$@"`
2. Change it to the following:
   `../tomcat/bin/catalina.sh run "$@"`
   The run command causes the Tomcat output to display in the console window
   for IBM Cognos BI.
3. Stop and restart IBM Cognos BI using the .shutdown.sh and .startup.sh
   commands.
4. If the following error message displays in the console window for any of the
   application servers, the issue is an HP-UX configuration problem:
   `OutOfMemoryException error: Unable to create new native thread on HP-UX.`
   The problem is that the default values for HP-UX 11.0 and 11i are set too low
   for most Java applications.

   Tip: You can check the number of threads in your process by using the -eprof
   option available in JDK 1.1.8 and by analyzing the Java.eprof file using
   HPjmeter by selecting the threads metric.

Content Manager Cannot Connect to the Content Store on Oracle
If you are using an Oracle database as a content store, the DPR-ERR-2058 error
may be generated when logging onto the portal All tables are created on the
database.

You may also receive the following error messages:
- `CM-CFG-5036 Content Manager failed to connect to the content store.`
- `ORA-01017: invalid username/password; logon denied`

Setting the Oracle database server name:
The Content Manager might fail to connect to an Oracle database because of
inconsistencies between the Oracle server name in IBM Cognos Configuration and
the server name in the tnsnames.ora file.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click Data Access, Content Manager, Content Store.
3. Change the Oracle database server name to a fully qualified name such as
   host_name.companyname:1534 to match the name in the tnsnames.ora file.

Report Studio does not start
You may not be able to start Report Studio if you are using pop-up blocking
software on your computer.

When you start Report Studio, it opens in a new browser window. In addition, a
new browser window opens when you run a report and when an error is detected.

Procedure
To correct the problem, disable any pop-up blocking software when working in
Report Studio.
DPR-ERR-2022 error displays in Web browser when starting IBM Cognos Business Intelligence

After you start the services in IBM Cognos Configuration and then try to open the portal, a message similar to the following may display:

DPR-ERR-2022 No response generated. This may be due to an incorrect configuration, a damaged installation, or the dispatcher not having finished initializing.

This problem can occur if
• You try to open the portal before IBM Cognos services are initialized.
• A system.xml file has been edited.

In this case, replace the edited system.xml file in the appropriate subdirectory in c10_location\templates\ps with a copy from backup or use an XML editor to edit it.

There are many instances of system.xml in the directories in c10_location\templates\ps. Ensure that you replace the correct file.

Corrupt characters while installing in some languages on Linux

When running the installation wizard on Linux in Korean, Chinese (simplified or traditional), or Japanese, you may see corrupted characters in the dialog boxes of the user interface or in messages that display during the installation.

To avoid the problem of corrupt characters in the user interface during installation, you can use one of the following solutions:
• Configure the Asian fonts on the Linux server:
  – Set the locale to utf8.
    For example, ko_KR.utf8, ja_JP.utf8, zh_CN.utf8, or zh_TW.utf8
  – Ensure that Asian language Fontset *medium-r*--14* is available on X server.
• Run an unattended installation using the default response.ats file that is provided with your IBM Cognos BI product. For information about setting up an unattended installation, see the Installation and Configuration Guide.

Unable to download the cognos.xts file

After installing IBM Cognos BI, you are prompted to download the cognos.xts file when connecting to the IBM Cognos Business Intelligence portal. The following error message may display:

You have chosen to download a file from this location. cognos.xts from servername

This problem occurs when the permissions on the virtual directories are not set properly. You must provide the cgi-bin virtual directory in the Microsoft Internet Information Service (IIS) with execute permissions.

To resolve this problem, recreate the virtual directories in IIS with the permissions from the following table, where c10_location represents the installation location.
<table>
<thead>
<tr>
<th>Alias</th>
<th>Path</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>\c10_location\webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos\ cgi-bin</td>
<td>\c10_location\cgi-bin</td>
<td>Read Execute</td>
</tr>
</tbody>
</table>

For example, the default installation location is `C:\Program Files\IBM\Cognos\c10`.

**Application server startup script fails**

You may have problems running the startup scripts for an application server to deploy the IBM Cognos application if IBM Cognos Business Intelligence components are installed in a directory with a name that includes spaces.

**Procedure**

1. Reinstall to a new directory and do not include spaces in the new name.
2. If this solution is not easily handled by the startup scripts, try adding quotation marks around the directory name that includes spaces or use the 8.3 DOS naming convention.

**IBM Cognos Business Intelligence running under WebLogic Application Server on AIX fails**

The IBM Cognos Business Intelligence server instance may go into a FAILED_NOT_RESTARTABLE state in the WebLogic Administration Console on AIX.

Numerous core files and Java core files are written to the IBM Cognos BI domain directory. IBM Cognos BI terminates and is not accessible via the portal. This behavior occurs only when the IBM Cognos BI Managed Node is started with the WebLogic Administration Console.

**Procedure**

Start the IBM Cognos BI Managed Node using the WebLogic startup scripts instead.

**Deploying IBM Cognos Business Intelligence to an Oracle Application Server or IBM WebSphere Application Server fails**

Deploying IBM Cognos BI to an Oracle application server or an IBM WebSphere application server may fail.

These errors can occur because the application file that you are trying to deploy is too large. If a deployment fails, any of the following errors may occur:

- *Browser timeout in administration console*
- *HTTP 500 Internal Error*
- *Deployment failed: Base Exception: java.rmi.RemoteException (Oracle)*
- *Return to application file selection page* (IBM WebSphere)

For more information about deploying IBM Cognos BI to an application server, see the *Installation and Configuration Guide*. 
Procedure

1. If you are using the **Build Application Wizard**, clear the **Include static files from the Webcontent folder** check box when you select the application to build.

   This will reduce the size of the application file. If static content is required, you can manually copy it to the deployed application location after you have successfully deployed IBM Cognos BI into the application server.

2. If you are deploying the application file manually for an Oracle application server, type the following command:

   ```
dcmctl deployapplication -f path_and_name_of_ear_file -a application_name -co OC4f_instance_name
   
   This command is not supported for Oracle Release 3.
   ```

Unable to deserialize context attribute error when deploying the p2pd.war file to WebLogic

An error may occur when you deploy the p2pd.war file to WebLogic.

This error does not affect the deployment of the p2pd.war file.

**Error [context]Could not deserialize context attribute**

```
java.io.NotSerializableException: com.cognos.logserver.LogService
```

Procedure

To avoid this problem, add at least one language preference in Internet Explorer.

Error displays after upgrading IBM Cognos Business Intelligence on a WebLogic Application Server

You are using WebLogic and upgrade IBM Cognos BI from an earlier release.

After you deploy the p2pd.war file for the new installation, a message similar to the following may display:

```
<BEA-101215> <Malformed Request "null". Request parsing failed, Code: -10>
```

About this task

This can occur if you undeploy IBM Cognos BI from WebLogic and some files from the earlier version are not removed from the system.

To solve the problem, do the following:

Procedure

1. Use the administrative tools for your application server to ensure that IBM Cognos BI has been undeployed.
   
   For information about undeploying applications, see your application server documentation.

2. If the directory to which IBM Cognos BI was originally deployed is not removed during the undeploy process, delete the directory.
   
   Also, remove any IBM Cognos BI .jar files that are cached in your application server environment.
3. After you remove all files from the previous installation, redeploy IBM Cognos BI.

**Chinese, Japanese, or Korean characters are different after upgrade**

If you use Chinese, Japanese, or Korean characters, you may notice differences in some characters after upgrading from ReportNet to IBM Cognos Business Intelligence.

**Examples**

- You run an existing report. When you compare the output to the same report in ReportNet, you see that some of the characters are different.
- You do a search that you did in ReportNet and get different results.

The differences occurred because the conversion tables that are used for Chinese, Japanese, and Korean were modified to meet global standards. If your report specifications or search filters contain expressions that use constant values, the results may be affected.

**Procedure**

If you want to use the same conversion table that you used in ReportNet, run the following script in the `c10_location\bin` directory:

- On UNIX, type `conv_compat.sh`
- On Linux, type `conv_compat.sh`
- On Microsoft Windows operating system, type `conv_compat.cdm`

**Accented or double-byte characters may not display correctly when installing IBM Cognos Business Intelligence on Linux**

If you are using issetup under a UTF-8 locale, accented or double-byte characters may not display correctly.

**Procedure**

1. To resolve this problem when installing in German or French, use a non-UTF-8 locale and then launch issetup to install IBM Cognos BI.
2. To resolve this problem when installing in Japanese, change the encoding setting of X Terminal to Shift-JIS, and then install IBM Cognos BI using an unattended installation.

**RSV-SRV-0066 a soap fault has been returned or RQP-DEF-0114 the user cancelled the request errors display in high user load environments**

These errors may be in the IBM Cognos cogserver.log if you have a high user load (over 165 users) and interactive reports are running continuously in a distributed installation.
Procedure

1. Increase the async_wait_timeout_ms parameter parameter in webapps/p2pd/WEB-INF/services/reportservice.xml file.
   For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

2. Increase the Queue Time Limit setting to 360.
   For information, see the IBM Cognos BI Administration and Security Guide.

Problems configuring IBM Cognos Business Intelligence

After you install IBM Cognos Business Intelligence components, you may encounter problems when you save changes in IBM Cognos Configuration.

Ensure that you

- configure and start the services on the computer where Content Manager is located before you configure other components
- restart the IBM Cognos service after you make any configuration changes

Configuration Tool cogconfig.sh Return Values Are Not Compliant with Conventional UNIX Return Values

On UNIX platforms, the configuration tool command cogconfig.sh returns 0 for an unsuccessful execution and 1 for a successful execution. These return values are not compliant with the conventional UNIX return results, where a return value of 0 indicates a successful execution and a non-zero return value indicates an error.

The non-compliant behavior will be corrected in a future release. You may be required to make changes to your customer applications and scripts before making use of the new behavior.

Running Database and Index Cleanup Scripts

In some troubleshooting situations, you may be advised to start with new configuration data.

You can run SQL scripts to delete all the tables in any of the following databases that IBM Cognos BI components use:

- content store for data that IBM Cognos BI needs to operate
- delivery database for report notifications
- metric store for metric package content and Metric Studio user preferences
- database for human tasks and annotations

You can run SQL scripts to delete all the tables and indexes in the following database:

- logging database for log messages

When you delete a table, its structural definition and data are deleted permanently from the database. For the metric store, database objects may also be deleted.

When you delete the indexes from a logging database, they are deleted permanently from the database.
When you restart the IBM Cognos service, a new set of required database tables and indexes are created automatically in the location specified by your configuration settings.

**Procedure**

1. On each computer where Content Manager is located, stop the IBM Cognos service.
2. Go to the appropriate directory:
   - To delete tables and indexes from the logging database, go to `c10_location/configuration/schemas/logging`.
   - To delete tables from the content store, go to `c10_location/configuration/schemas/content`.
   - To delete tables from the notification database, go to `c10_location/configuration/schemas/delivery`.
   - To delete tables from the metric store, go to `c10_location/configuration/schemas/cmm`.
   - To delete tables from the human task and annotation database, go to `c10_location/configuration/schemas/hts`.
3. Go to the appropriate database directory.
4. Depending on the database and database type, run one of the following scripts in the appropriate database tool to delete the tables.

   **The following table lists the script names for the content store database.**

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>dbClean_db2.sql</td>
</tr>
<tr>
<td>DB2 on z/OS</td>
<td>dbClean_db2zOS.sql</td>
</tr>
<tr>
<td>Derby</td>
<td>dbClean_derby.sql</td>
</tr>
<tr>
<td>Informix</td>
<td>dbClean_informix.sql</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>dbClean_mssqlserver.sql</td>
</tr>
<tr>
<td>Oracle</td>
<td>dbClean_oracle.sql</td>
</tr>
<tr>
<td>Sybase</td>
<td>dbClean_sybase.sql</td>
</tr>
</tbody>
</table>

   **The following table lists the script names for the notification database.**

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>NC_DROP_DB2.sql</td>
</tr>
<tr>
<td>DB2 on z/OS</td>
<td>NC_DROP_DB2.sql</td>
</tr>
<tr>
<td>Derby</td>
<td>NC_DROP_Derby.sql</td>
</tr>
</tbody>
</table>
The following table lists the script names for the metric store database.

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>LS_dbClean_db2.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_db2.sql</td>
</tr>
<tr>
<td>DB2 on z/OS</td>
<td>LS_dbClean_db2zOS.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_db2zOS.sql</td>
</tr>
<tr>
<td>Derby</td>
<td>LS_dbClean_derby.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_derby.sql</td>
</tr>
<tr>
<td>Informix</td>
<td>LS_dbClean_informix.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_informix.sql</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>LS_dbClean_mssql.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_mssql.sql</td>
</tr>
<tr>
<td>Oracle</td>
<td>LS_dbClean_oracle.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_oracle.sql</td>
</tr>
<tr>
<td>Sybase</td>
<td>LS_dbClean_sybase.sql</td>
</tr>
<tr>
<td></td>
<td>LS_dbCleanIndexes_sybase.sql</td>
</tr>
</tbody>
</table>

The following table lists the script names to clean up tables and indexes for the logging database.

For Informix, the index cleanup script must be edited if you host more than one audit logging database on the Informix instance and use them at the same time. See step 5.

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informix</td>
<td>NC_DROP_IFX.sql</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>NC_DROP_MS.sql</td>
</tr>
<tr>
<td>Oracle</td>
<td>NC_DROP_ORA.sql</td>
</tr>
<tr>
<td>Sybase</td>
<td>NC_DROP_SYBASE.sql</td>
</tr>
</tbody>
</table>
### Table 58. Script names for the metric store database

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>cmm_uninstall <em>dbalias</em> username password</td>
</tr>
<tr>
<td></td>
<td>Specify the dbalias only if a database with the</td>
</tr>
<tr>
<td></td>
<td>same name is already cataloged.</td>
</tr>
<tr>
<td>Microsoft SQL</td>
<td>cmm_uninstall <em>metric_store_name</em></td>
</tr>
<tr>
<td></td>
<td><em>database_name</em> Admin_user_name password</td>
</tr>
<tr>
<td>Oracle</td>
<td>cmm_uninstall <em>database_name</em></td>
</tr>
<tr>
<td></td>
<td><em>database_user_name</em> password</td>
</tr>
<tr>
<td></td>
<td>Replace <em>database_name</em> with the name in the</td>
</tr>
<tr>
<td></td>
<td>tnsnames.ora file that refers to the database</td>
</tr>
<tr>
<td></td>
<td>SID for Metric Studio</td>
</tr>
</tbody>
</table>

The following table lists the script names for the Human Task and Annotation database.

### Table 59. Script names for the Human Task and Annotation database

<table>
<thead>
<tr>
<th>Database type</th>
<th>Script name</th>
</tr>
</thead>
<tbody>
<tr>
<td>all types</td>
<td>humanTaskService-dropScript.sql</td>
</tr>
</tbody>
</table>

5. If you have host more than one audit logging database on your Informix instance, do the following:
   - Go to `c10_location/configuration/schemas/logging/informix` and open the file `LS_dbCleanIndexes_informix.sql` in a text editor.
   - Replace every instance of IPFSCRIPTIDX with the value that you specified when you created the IPFSCRIPTIDX property in IBM Cognos Configuration. For more information, see the topic about specifying a log messages repository in the *Installation and Configuration Guide*.
   - Save and close the file.

6. Start the IBM Cognos service.

### Error trying to encrypt information when saving your configuration

When you save your configuration using the configuration tool, you may see an error message that the cryptographic information cannot be encrypted. An error occurred when requesting a certificate from the Certificate Authority.

The cryptographic information cannot be encrypted. Do you want to save the configuration in plain text?

Before you can encrypt your configuration settings, the computer where Content Manager is installed must be configured and running. On UNIX operating systems, ensure that you copied the appropriate .jar files to the installation location of your Java Runtime Environment. In addition, ensure that your Java environment is configured correctly, the URIs are correct, and the same certificate authority password is configured for all Content Manager computers.
On Linux operating systems, ensure that you copied the appropriate .jar files to the installation location of your Java Runtime Environment.

Also, an error message similar to the following may display:

```
java.lang.NoClassDefFoundError: javax/net/ServerSocketFactory
```

The cryptographic error usually means the Java environment is not configured correctly. Ensure that the JAVA_HOME environment variable is set correctly and the appropriate security providers are installed, such as JSSE for JRE 1.5.

**Checking the URI properties and certificate authority password**

To ensure that configuration settings can be encrypted, ensure that the URI properties and certificate authority password in IBM Cognos Configuration are correct.

**Procedure**

1. On the Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, verify these properties:
   - Under Gateway Settings > Gateway URI
   - Under Dispatcher Settings > External dispatcher URI and Internal dispatcher URI
   - Under Other URI Settings > Dispatcher URI for external applications and Content Manager URIs
4. In the Explorer window, click Security > Cryptography > Cognos.
5. In the Properties window, under Certificate Authority settings, click the value for Password.
   
   Ensure that the same password is used on all Content Manager computers.
6. Save the configuration and restart IBM Cognos BI.

**Problems generating cryptographic keys in IBM Cognos Configuration**

When you uninstall IBM Cognos Business Intelligence, some temporary folders are left behind. Reinstalling the product to the same location without first removing the temporary folders may cause problems while attempting to generate the cryptographic keys in IBM Cognos Configuration.

**Procedure**

1. Uninstall IBM Cognos BI.
2. Remove the c10_location/temp/cam folder.
3. Reinstall IBM Cognos BI.

**CAM-CRP-1315 error when saving configuration**

When you save your configuration, an error occurs when there has been a change to your environment's trust domain.

The trust domain is managed by the certificate authority associated with the content store. The following error occurs if the content store you originally used
was removed or if you modified your configuration to use a Content Manager associated with a different content store after you have saved your original configuration.

**CAM-CRP-1315** Current configuration points to a different Trust Domain than originally configured.

To resolve the problem, change your configuration to use the original content store or regenerate the cryptographic keys using the following steps.

**Procedure**

1. On the Content Manager computer, back up the existing cryptographic keys by saving the following directories to an alternate location that is secure:
   - `c10_location/configuration/csk`
   - `c10_location/configuration/encryptkeypair`
   - `c10_location/configuration/signkeypair`
2. Delete the csk, encryptkeypair, and signkeypair directories.
3. In IBM Cognos Configuration, save the configuration and restart the services.
4. Repeat steps 1 to 3 on all computers that have IBM Cognos BI components installed.

**CAM-CRP-0221 error when logging into the portal**

After installing IBM Cognos Business Intelligence on Microsoft Windows operating system (either a 32-bit or 64-bit system) and configuring IBM HTTP Server as the gateway, attempts to log in to the IBM Cognos BI portal result in an error message that contains the following:

**CAM-CRP-0221** Unable to load the provider ‘CAM_Crypto_TOpenSSL.dll’ specified in the configuration file.

This error occurs when incompatible versions of OpenSSL libraries are loaded. To resolve the problem, load the OpenSSL libraries that are provided with IBM Cognos BI.

**Procedure**

1. On the gateway computer, go to `IBM_HTTP_location\conf` directory and open `httpd.conf` in a text editor.
2. Add the following lines to the file:
   ```
   LoadFile "c10_location/cgi-bin/ssleay32.dll"
   LoadFile "c10_location/cgi-bin/libeay32.dll"
   ```
   where `c10_location` is the path to the IBM Cognos BI installation directory.

**Manually changing the installation directory name affects installations running under an application server**

After installing IBM Cognos Business Intelligence using the installation wizard and later renaming the installation directory or manually copying the contents to another directory, you attempted to run IBM Cognos Business Intelligence within an application server.

One of the following problems occurs:

- IBM Cognos BI does not start.
• Log directories are empty.
• Logs contain a linkage error or unsatisfied link error.

When you manually change the installation directory, the information in the IBM Cognos BI root directory becomes invalid. To resolve the problem, you must either update the IBM Cognos BI root directory before you create the IBM Cognos BI application file to deploy to the application server or you must reinstall IBM Cognos BI in the original location. If you reinstall IBM Cognos BI, follow the process for upgrading.

**Procedure**

1. In the new or renamed installation directory, open `c10_location/webapps/p2pd/WEB-INF/classes/cogroot.link` in a text editor.
2. Replace the path with the new location of the installation directory and save the file.
3. To build the application file to be deployed to the application server, in IBM Cognos Configuration, from the **Actions** menu, select **Build Application Files**.
4. If you built and deployed an application file to the application server before updating the cogroot.link file, undo the deployment.
5. Deploy the new application file to the application server.

   For more information about configuring IBM Cognos BI for another application server, see the **Installation and Configuration Guide**.

**Configuration data is locked by another instance of IBM Cognos Configuration**

You may get an error message that the configuration data is locked by another instance of IBM Cognos Configuration.

When you start IBM Cognos Configuration, it checks to see if the cogstartup.lock file exists in `c10_location/configuration`. The file may exist if a previous instance did not shut down properly or if another instance of IBM Cognos Configuration is running.

**Procedure**

1. If another instance of IBM Cognos Configuration is running, exit that instance. Otherwise, any changes you make to the local configuration may result in errors.
2. If no other instance of IBM Cognos Configuration is running, delete the cogstartup.lock file in `c10_location/configuration`.
3. If the IBM Cognos service is stopped, click **Start**.

**Unable to exit a tab sequence when using keyboard-only navigation in IBM Cognos Configuration**

If you use the Tab key to navigate in IBM Cognos Configuration, you may experience problems exiting a tab sequence. For example, in the Properties window, you can press the Tab key to move from one property to another.

However, because IBM Cognos Configuration is a Java application, when you want to close the Properties window, you must press Ctrl+Tab.
Unable to save your configuration

You may be unable to save your configuration because you are missing a resource. For example, you delete a resource such as the Cognos namespace, a cryptographic provider, or the content store. You can specify a different database type for the content store with Oracle, Microsoft SQL Server, Informix, or Sybase. You can also configure a new cryptographic provider. You cannot specify a new Cognos namespace, but you can recreate it. However, you must then recreate your Cognos groups and roles.

For more information about creating groups and roles in IBM Cognos Connection, see the Administration and Security Guide.

Recreating the Cognos namespace

If you deleted the Cognos namespace, you must recreate it and then recreate your Cognos groups and roles.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication and then click New resource > Namespace.
3. In the Name box, type a name for the resource.
4. In the Type box, click Cognos, and then click OK.
   The Cognos namespace displays in the Explorer window.
5. From the File menu, click Save.
6. Recreate the Cognos groups and roles using IBM Cognos Administration.
   For more information, see the Administration and Security Guide.

Java error when starting IBM Cognos Configuration

When you start IBM Cognos Configuration, you may receive an error message that the Java Runtime Environment (JRE) has changed and that the current cryptographic information is not compatible with the new JRE. You may then be prompted to regenerate the cryptographic information for the new JRE or exit to switch back to the previous JRE.

This error may occur for one of these reasons:

- Your configuration data was encrypted using a different JRE than the one IBM Cognos BI components are currently using.
- The cryptographic information may have been corrupted.

If you click Regenerate in the error dialog, the IBM Cognos service is stopped and the cryptographic information is regenerated.

If you click Exit in the error dialog, you must set the JAVA_HOME environment variable to point to the JRE that you used to save your configuration.

On Microsoft Windows operating system, if you want IBM Cognos BI components to use the JRE that is installed by default, unset JAVA_HOME or set JAVA_HOME to c10_location/bin/jre.

**Note:** If you want to change from one JRE to another, see the topic on changing the version of JVM that IBM Cognos BI components use. For more information, see the Installation and Configuration Guide.
Cryptographic error when starting IBM Cognos Configuration

When you start IBM Cognos Configuration, the following error message may display:

_The cryptographic information may have been corrupted or the cogstartup.xml file is invalid. You may have to fix this file or remove it from disk. For more information, see the Installation and Configuration Guide._

This error occurs when IBM Cognos BI components detect an error in the cogstartup.xml file. This can occur when the cogstartup.xml file is manually edited and there is an error in the changed text.

To resolve the problem, replace the cogstartup.xml file with a copy from your backup location.

Restarting the IBM Cognos service to apply configuration settings

After changing default property values or adding a resource to your installation in IBM Cognos Configuration and then saving the configuration, you may not see the changes or be able to use the resource in the run-time environment.

To apply the new settings to your computer, you must restart the IBM Cognos service.

Procedure

1. Start IBM Cognos Configuration.
2. From the Actions menu, click the appropriate command:
   • If the IBM Cognos service is currently running, click Restart.
     This action starts all installed services that are not running and restarts services that are running. If you want to restart a particular service, select the service node in the Explorer window and then click Restart from the Actions menu.
   • If the IBM Cognos service is stopped, click Start.
     This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

CM-CFG-029 error when trying to save a configuration that specifies a Microsoft SQL Server content store

In IBM Cognos Configuration, you try to save a configuration and the following error message is in the cogserver.log file:

_CM-CFG-029 Content Manager is unable to determine whether the content store is initialized._

_EXECUTE permission is denied on object "sp_tables", database "master", owner "dbo"._

This indicates that you do not have the correct permissions to initialize a content store or create a table in the database.

Ensure that the content store user has permissions to use the sp_tables stored procedure in the master database.
DB2 not found error for Linux on System z

You installed IBM Cognos Business Intelligence and after you ran the C8DB2.sh script, an error stating that DB2 cannot be found is displayed or written to the log files.

Procedure

1. Create a profile that sources the sqllib/db2profile from the user's home directory for the user you enter when you run the script.
   An example .profile would contain something like the following:
   ```
   if [ -f /home/db2user/sqllib/db2profile ]; then
     ./home/db2user/sqllib/db2profile
   fi
   ```
2. Run the C8DB2.sh script again.

DPR-ERR-2079 when Content Manager configured for failover

You configured multiple computers as standby computers to ensure failover for Content Manager.

However, the following error message displays to the user:

DPR-ERR-2079 Firewall Security Rejection. Your request was rejected by the security firewall

About this task

This error message can occur if you have not configured all the standby computers as valid hosts for the IBM Cognos Application Firewall.

To solve this problem, on each distributed computer, start IBM Cognos Configuration and enter the names of all the computers that you are configuring for failover.

Procedure

1. In the Explorer pane, click Security > IBM Cognos Application Firewall.
2. In the right pane, click in the Value column next to Valid domains or hosts.
3. Click the edit button.
4. Enter the names of all the computers that you are configuring for failover.
5. Save and start the configuration.

Importing a large content store in Solaris using JRE 1.5 fails

If you export a content store that is greater than 2 GB when exported, and then attempt to import it in Solaris using JRE 1.5, the import fails with the following error message:

CM-SYS-5001 A Content Manager internal error occurred.

This is due to a bug in JRE 1.5 on Solaris. Use JRE 1.4.2 instead.
Importing a large deployment in Windows crashes the Java virtual machine

The Java virtual machine under Microsoft Windows operating system may crash under the following circumstances.

- The maximum Java memory setting is 1152 MB or higher.
- You are importing a large archive from a previous release of IBM Cognos Business Intelligence.
- The archive contains large models that require upgrading.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer, under Environment, IBM Cognos services, click IBM Cognos.
3. Set the Maximum memory in MB property to 768.

CCL-BIT-0006 error message when using WebSphere Application Server on a heavily loaded system

On a heavily loaded system that uses Websphere Application Server, some connections might terminate before IBM Cognos Business Intelligence finishes processing a request.

You might see the following message in the c10_location/logs cogserver.log file:

Failure RSV-SRV-0063 An error occurred while executing the 'asynchRun_Request' command. CCL-BIT-0006 The HTTP message is unexpectedly short.

When the connection closes before the request is processed, the request is lost and the user must resubmit the request.

You can help reduce the frequency of this error by increasing the Persistent Timeout parameter for the Web container transport chains in the WebSphere Administrative Console.

Increase the time in 10-15 second intervals until the error no longer or rarely occurs.

Users are prompted for Active Directory credentials

The single signon mechanism does not work when IBM Cognos Business Intelligence is configured as follows:

- Microsoft Internet Explorer runs on a Microsoft Windows operating system NT computer.
- The authentication namespace is configured with the Active Directory provider.

As a result, users are prompted for their Active Directory credentials.

This problem occurs because the IBM Cognos BI Active Directory provider uses ADSI protocol and Kerberos delegation for authentication in a single signon environment. When Microsoft Internet Explorer runs on Windows NT, it cannot authenticate to the IIS server using Kerberos delegation.
When your system is configured for Windows Integrated Authentication, for the single signon to work with IIS, you must
- configure IBM Cognos BI to communicate with the Active Directory server using the LDAP provider.
- configure the external identity mapping property to read the REMOTE_USER environment variable.

**Font on UNIX not found when starting IBM Cognos Configuration**

A common problem occurs on UNIX, when you start IBM Cognos Configuration.

The following error message may display:

*Font specified in font.properties not found...*

This error occurs if the Java Virtual Machine (JVM) is trying to use one or more fonts that are not installed on your computer. However, the JVM should use the system default, and IBM Cognos Configuration should start and run normally.

**Procedure**

Add the missing fonts to your Java Runtime Environment by editing the font.properties files.
Several font.properties files, which contain standard font environment information, are installed with your Java Software Development Kit. You can find these files in the *JRE_location/lib* directory.
For more information, see the Java documentation.

**ESSBASEPATH cannot be detected**

For Windows and UNIX platforms, Oracle Essbase software uses the ESSBASEPATH environment variable to locate the Essbase 11 client software. The Oracle Hyperion Enterprise Performance Management (EPM) System Installer creates ESSBASEPATH as a user environment variable.

If the IBM Cognos service is configured to run or log on as a system account, you must manually add ESSBASEPATH as a system environment variable, if it does not exist. When IBM Cognos software cannot locate the ESSBASEPATH environment variable, you receive the following error:

*DB2-ERR-0044 Essbase environment variable "ESSBASEPATH" cannot be detected. Check if Essbase client is installed.*

To resolve this issue, do one of the following, and then restart the IBM Cognos service:
- Double-click IBM Cognos service, and on the Log On tab, specify a user account that has access to ESSBASEPATH.
- Add ESSBASEPATH as a system environment variable.

Note that if you are upgrading to Essbase 11 software from Essbase 9 software, you must install the appropriate client and then edit the qfs_config.xml file to change the library name.
Changing the library name in the qfs_config.xml file
If you are upgrading to Essbase 11 software from Essbase 9 software, then after installing the appropriate client, you must change the library name in the qfs_config.xml file.

**Procedure**
1. In the c10_location/configuration directory, open the file named qfs_config.xml.
2. Find the line of code `<provider name="DB2OlapODP" libraryName="essodp93" connectionCode="DO"/>` and change the library name from essodp93 to essodp111.
3. Save the changes.

Problems testing data source connections with IBM Cognos BI deployed on SAP NetWeaver Application Server 7.1.1 on UNIX
If you have deployed IBM Cognos BI on SAP NetWeaver Application Server 7.1.1 running on a UNIX operating system, you may receive an error when you test your data source connections in IBM Cognos Administration.

To resolve this problem, you must update the library path and all paths used for database client access in a SAP environment file named .sapenv_servername.sh, where servername is the name of your server.

**Procedure**
1. Go to the SAP administrator user’s home directory.
2. Locate the file named .sapenv_servername.sh, where servername is the name of your server.
3. Open the file in a text editor.
4. Add c10_location/bin64 to the library path and any path locations required for database client access.
   For example, if you have installed IBM Cognos BI to /server1/home/ibm/cognos/c10, your library path would look like the following:
   LIBPATH=/server1/home/ibm/cognos/c10/bin64:/db/oracle/11.1.0.6/lib32:
   /server1/home/db2user/sql1lib/lib32:/usr/lib:/lib:$_DEF_EXE; export LIBPATH
5. Save the file, and restart the SAP and IBM Cognos BI processes.
6. Test your database connections again in IBM Cognos Connection.

Query fails when using Oracle Essbase Server
You run a query to retrieve metadata or data from an Oracle Essbase server and you receive a message similar to one of the following messages:
- The IBM Cognos gateway is unable to connect to the IBM Cognos BI server. The server may be unavailable or the gateway may not be correctly configured.
- DB2-ERR-0005 An unknown error occurred during the login. Database error code: 1,042,006.
- XQE-DS-0006 Unable to logon to the data source.

These IBM Cognos errors can result from Windows not having enough sockets or ports available on the Microsoft Windows operating system. A lack of sufficient ports can cause data retrieval from Essbase to fail because of network communication errors.
To resolve this problem, increase the number of Windows sockets or ports that are available for program use.

**Increasing the number of Windows sockets or ports**
To resolve connection errors with an Oracle Essbase Server, increase the number of sockets or ports on the Microsoft Windows operating system that are available for program use by adding two entries in Microsoft Registry Editor.

**Important:** Use Microsoft Registry Editor at your own risk. Incorrect use may cause problems that require you to reinstall your operating system. Microsoft cannot guarantee that you can solve problems that result from using Registry Editor incorrectly.

**Procedure**
1. From the Windows **Start** menu, run the regedit application.
2. In the **HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters** directory, create a new **DWORD** value named **MaxUserPort**.
3. Set the properties for **MaxUserPort** to use a value of **65534** and a base of **Decimal**.
   The range for value is from 30000 to 65534.
4. In the same directory, add another **DWORD** value named **TcpTimedWaitDelay**.
5. Set the properties for **TcpTimedWaitDelay** to use a value of **50** and a base of **Decimal**.
   The range for value is from 30 seconds to 300 seconds, with a default value of 240 seconds (4 minutes).
6. After closing the regedit application, restart the Microsoft CRM server or restart your computer.

**Results**
For more information, visit the technet2.microsoft.com Web site and search on the terms **MaxUserPort** and **TcpTimedWaitDelay**.

**Group membership is missing from Active Directory namespace**
If an Active Directory namespace is configured for the same forest and a user is authenticated using a credential, the group membership will be missing.

The process identity of IBM Cognos Business Intelligence, when running as a local system account or a domain user, must have one of these privileges:
- impersonate a client after authentication
- act as part of the operating system

If the privilege is missing, there is no group membership for the authenticated user.

**Adding group membership for an Active Directory namespace**
To add group membership for an Active Directory namespace, you must add the process identity for IBM Cognos Business Intelligence to the local security policy.
Procedure
1. From the Start menu, click Settings, Control Panel.
2. Click Administrative Tools, and then double-click Local Security Policy.
3. In the console tree, click Security Settings, Local Policies.
4. Click User Rights Assignment.
5. Add the process identity of IBM Cognos BI to one of the following policies:
   - Impersonate a client after authentication
     The default is Administrators, Service.
     For more information, see the library article fe1fb475-4bc8-484b-9828-a096262b54ca1033.mspx at the Microsoft Web site.
   - Act as part of the operating system
     The default is Local system.
     For more information, see the library article ec4fd2bf-8f91-4122-8968-2213f96a95dc1033.mspx at the Microsoft Web site.
Both of these privileges give an account the ability to act as another user.
The privilege Impersonate a client after authentication is similar to the Act as part of the operating system privilege except that it will only allow a process to impersonate after authentication, whereas the privilege Act as part of the operating system allows a process to impersonate before authentication.
For more information, see the library article tkerbdel.mspx at the Microsoft Web site.

Errors displayed when deploying to Oracle 10G Application Server
You are deploying IBM Cognos Business Intelligence to an Oracle 10G Application Server.
The following error messages may occur:

*CMM-APP-3254 The initialization of the metrics store failed.*

*DIS-ERR-3115 Task execution failed.*

*MDS-RUN-3213 Unable to locate database bulk load utility. Please install the appropriate database tool for this platform (‘bcp’ for SQL Server, ‘sqlldr’ for Oracle)*

These errors occur because the bulk loading utilities (SQL Loader on Oracle) are not included in the deployment file created by IBM Cognos Configuration.

Procedure
To install the missing components, use the Oracle client software on the computer where you installed the Oracle 10G Application Server.
Ensure that you install SQL Loader.

Page cannot be found error running reports using IBM Cognos for Microsoft Office
In a Microsoft Office document configured for IBM Cognos for Microsoft Office, you use Run Report but receive a “The page cannot be found” error message.

This can occur if the IBM Cognos BI gateway and dispatcher use “localhost” as the server name values on the IBM Cognos BI server.
**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer, click Environment.
3. Ensure that the localhost portion of all URI properties is replaced by the computer name.

**Error initializing Oracle content store after upgrade from ReportNet**

You are creating a content store in Oracle or upgrading a ReportNet content store in Oracle to IBM Cognos BI and you receive an error message.

The following error message displays, and this error occurs if the Oracle database compatibility level is set lower than 9.0.1:

*Content Manager can not initialise the content store with the assistance of the initialisation file: dbupgrade2_0021-to-2_0022_oracle.sql ORA-22858 invalid alteration of datatype*

**Procedure**

1. Change the compatibility level to 9.0.1 or higher.
2. Restart the Oracle instance.

**CGI timeout error while connected to IBM Cognos Business Intelligence through a Web browser**

When performing operations through your Web browser, you receive the following error message:

*CGI Timeout, process will be deleted from server.*

The error occurs when you use Microsoft Internet Information Services (IIS) as your Web server and the gateway is configured to use CGI. IIS has a default timeout for CGI applications.

To resolve this problem, you can configure the gateway to use ISAPI or increase the CGI timeout in IIS.

IIS does not have a default timeout for ISAPI applications. Or, if you want to keep using a CGI gateway, you can increase the CGI timeout in IIS.

**Changing the gateway to ISAPI**

To resolve a CGI timeout error in the Web browser, you can change the gateway from CGI to ISAPI.

**Procedure**

1. On the gateway computer, start IBM Cognos Configuration.
2. Under Environment, for the Gateway URI property, change the cognos.cgi portion of the URI to cognosisapi.dll
3. In your Web browser, specify the ISAPI URI:

   `http://computer_name/ibmcognos/isapi`
**Increasing the CGI timeout**
To resolve a CGI timeout error in the Web browser, you can increase the duration of the CGI timeout in IIS.

**Procedure**
1. In the administrative tools for Microsoft Windows operating system, open Internet Information Services.
2. Under the local computer node, right-click Websites and select Properties.
3. In the Home Directory tab, click Configuration.
4. In the Process Options tab, increase the CGI script timeout.

**Servlet class fails to load in WebLogic**
You may have problems when configuring a distributed server installation and using WebLogic as the application server for IBM Cognos BI.

When deploying the p2pd.war for the Application Tier Components computer, you may receive servlet exceptions and the dispatcher does not start. The cogserver.log is also not created.

The following error messages display in the WebLogic Server console:

```plaintext
<Jul 9, 2004 3:47:37 PM EDT> <Error> <HTTP><BEA-101249> Servlet class com.cognos.pogo.isolation.ServletWrapper for servletcfgss could not be loaded because the requested class was not found in the classpath /host2/bea812/user_projects/domains/c10/applications/p2pd/WEB-INF/classes. java.langClassNotFoundException: com.cognos.pogo.isolation.ServletWrapper.>

<Jul 9, 2004 3:47:37 PM EDT> <Error> <HTTP> <BEA-101216> Servlet: "cfgss" failed to preload on startup in Web application: "p2pd".

javax.servlet.ServletException:
[HTTP:101249][ServletContext(id=19023494,name=p2pd,context-path=/p2pd]): Servlet class com.cognos.pogo.isolation.ServletWrapper for servlet cfgss could not be loaded because the requested class was not found in the classpath /host2/bea812/user_projects/domains/c10/applications/p2pd/WEB-INF/classes. java.langClassNotFoundException: com.cognos.pogo.isolation.ServletWrapper. at weblogic.servlet.internal.ServletStubImpl.prepareServlet (ServletStubImpl.java:799)

at weblogic.servlet.internal.WebAppServletContext.preloadServlet (WebAppServletContext.java:3252)
```

To avoid this problem, do not deploy the p2pd application from the WebLogic applications directory. Create the p2pd directory in another location and deploy p2pd from there.

**Deploying the p2pd application outside of the WebLogic applications directory**
To resolve issues with the servlet class failing to load when deploying IBM Cognos Business Intelligence to WebLogic, deploy the p2pd application to a different directory than the WebLogic applications directory.
**Procedure**

1. Open IBM Cognos Configuration and configure the Application Tier Components computer.
2. Restart the Content Manager computer.
3. Create a p2pd directory in a location that is accessible by the WebLogic server but is not in the WebLogic applications directory.
   
   For example, create a directory named p2pd in the following location:
   
   `WebLogic_location/user_projects/domain_name`
4. Create the p2pd.war file.
5. In the p2pd directory, extract the p2pd.war file to the WebLogic installation using the following command:
   
   `%JAVA_HOME%/bin/jar xvfm "c10_location/p2pd.war"`
7. In the WebLogic Server Console, deploy the p2pd application.

**Desktop icons or IBM Cognos Configuration window flicker on Windows**

When you run IBM Cognos Configuration on Microsoft Windows operating system, you may notice that the desktop icons or the IBM Cognos Configuration window flickers.

**Procedure**

Start IBM Cognos Configuration using the -nodraw command line option.
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo, ibm.com, Impromptu, PowerPlay, ReportNet, TM1, and Cognos are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.
- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.
- Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Index

Special characters

.sas file
using to remove components 496
.otl files 283

Numerics

32-bit installation
requirement for 32-bit library files 61
32-bit installations
default paths 13
32-bit Windows
installing IBM Cognos for Microsoft Office 117
64-bit
report server 145, 204
64-bit application server
problem connecting to IBM Cognos BI portal 549
64-bit installation
configuring shared resources for IBM Cognos Metrics Manager 206
requirement for 64-bit library files 61
64-bit installations 37
default paths 13
64-bit Windows
installing IBM Cognos for Microsoft Office 117

A

accented characters
not displayed properly 543
acceptCount
increasing for Apache Tomcat 478
access
requirements to install IBM Cognos for Microsoft Office 117
accessibility features 499
active Content Manager 170
Active Directory Server
advanced properties 317
authenticating in multiple domains 317
enabling single signon 318
enabling SSL 316
missing group membership 557
using for authentication 314
with an LDAP namespace 328
active scripting
enabling in Web browsers 70
additional fonts
installing 294
agent service 474
aggregating
samples and time dimensions 262
AIX
environment variables to install IBM Cognos BI 125, 171, 191, 217
error connecting to DB2 database 534
support for RACF namespace 344
aliases
configuring on Apache Web Server 396
configuring on Web servers 151, 225, 461
Analysis Studio
changes after upgrading 21
analysis styles
in workspaces 420
annotation service 475
anonymous access
enabling for PowerPlay report data in IBM Cognos BI for Microsoft Office 298
anonymous logon
disabling 312
Apache Derby
migrate to content manager database 100
Apache gateways
configuring 396
Apache Tomcat
tuning 478
Apache Web servers
configuring aliases 151, 225, 461
configuring as gateways 396
apache_mod file
configuring for gateways 233, 234
application pools 151, 225, 461
application servers
changing from the default 441
configuring 453
deployment location for Metric Studio 210
problems running IBM Cognos BI 550
servlet class fails to load in WebLogic 560
servlet gateways 401
startup script fails 541
startup scripts 451
startup scripts for Oracle application server 457
upgrading IBM Cognos BI 463
Application servers
startup scripts for Sun GlassFish Enterprise Server 459
application tier components
configuration requirements 36, 47
installing on separate computer 34
installing on separate computer for IBM Cognos BI
scorecarding 46
Application Tier Components
configuring shared resources for IBM Cognos Metrics Manager 206
installing 124
log server 376
ARBORPATH
evironment variables 143, 202
Architect models
migration to IBM Cognos BI 52
archival times
specifying 256
archiving
report output 366
ASCII
requirements for installation directory 536
Asynchronous timeout 480
audience of document 1
audit
logs 376
audit logs
See also log messages
audit logs (continued)
See also troubleshooting
log destinations 376
authentication
Active Directory Server 314
configuring IBM Cognos Series 7 namespace 320
custom authentication providers 324
custom properties for Active Directory Server 316
custom user properties for LDAP 336
deleting namespaces 346
disabling anonymous logon 312
domain trees for Active Directory Server 317
eTrust Siteminder 340, 341, 342
LDAP 326, 327
LDAP using Active Directory Server 328
LDAP using IBM Directory Server 330
LDAP using Novell Directory Server 332
LDAP using Oracle Directory Server 334
NTLM 343
requirements for single signon with Microsoft Analysis Server or Microsoft SQL Server 314
SaferAPIGetTrustedSignon function 322
single signon for NTLM 344
single signon using Active Directory Server 318
single signon using eTrust SiteMinder 342
single signon using IBM Cognos Series 7 namespace 322
single signon using LDAP 338
single signon using RACF 345
SSL for eTrust SiteMinder 342
SSL using LDAP 337
trusted signon plug-ins for IBM Cognos Series 7 322
using namespaces 311
authentication provider
configuring IBM Cognos BI to use security 145, 189

B
backing up
IBM Cognos BI information 444, 466
backslashes appear instead of currency 295
basic installations
multiple locations 167
batch report service 475
Batch report service
list of embedded fonts for PDF reports 364
BEA ALUI portal
See Oracle WebCenter Interaction Portal
BI bus
upgrade considerations 90
Bind user DN and password property
special characters for LDAP namespace 326
blackout periods
specifying 256
Build Application Wizard 450
builds
running in IBM Cognos Connection by using Data Movement service 54
Business Insight
requirements to load for Microsoft IIS 409
samples 420
Business Insightapproved domains 357
Business Viewpoint Studio 55
C
CSDB2.sh script
error 553
CA,
See certification authority
calendars
upgrading Metrics Manager custom calendars 114
CAM-CRP-1157 error 529
card.xml
migrating 404
CCL-BIT-OOO6
error message 554
certificate authority
configuring 468
certificate signing requests
generating 468
certification authority
configuring the service 468
CGI timeout errors 559
changing
collection template 478
default configuration settings 348
default email encoding 394
IBM Cognos BI gateway 396
Java versions 465
URLs 351
characters
encoding not supported 530
characters improperly displayed 543
chart animation
activating support in upgraded workspaces 98
charts
using as Google OneBox results 506
chase_referral files 317
Chinese
characters display incorrectly after upgrade 543
corrupt characters during installation on Linux 540
chunking patches
application servers 443
cipher suites
setting a priority for SSL connections 375
client setup
IBM DB2 databases 133, 178
client software
installing 117
CM-SYS-5001 A Content Manager internal error occurred 553
CM-SYS-5007 error 534
code pages for data sources 153, 230, 241, 252
cogconfig.bat 512, 513
cogconfig.sh 512, 513
cogconfig.sh return codes
not UNIX compliant 544
Cognos BI
See IBM Cognos BI
Cognos Content Database
changing users and passwords 349
component description 27
improving performance 479
installing on a separate server 174
Cognos namespace
recreating 551
Cognos OneBox provider 504
Cognos service
See IBM Cognos service
Cognos Viewer
component description 26
cogroot.link file 550
cogstartup.lock file 524

cogstartup.xml 512

cogstartup.xml file 482, 486
  changing properties manually 484
invalid file 552

collaboration
  using IBM Connections 301, 357, 447, 448

Collaboration discovery URI
  configuring 407

collation sequences
  case-sensitive 530

command line
  test option 513
command line options 511

commands
  export option 514

common gateway interface
  replacing 396

common symmetric key 353

communications
  Google OneBox integration 501

compatible query mode 138, 197

components 25
  application tier components 34, 36
  Cognos Content Database 27
  Cognos OneBox provider 504
  Cognos Viewer 26
  Composite Information Server 28
  Content Manager 27, 34, 47, 124
  content store 29
  data sources 29
  distributing Metric Designer 43
  Event Studio 26
  Framework Manager 28
  gateways 25, 33, 124
  IBM Cognos Administration 26
  IBM Cognos BI for Microsoft Office 27
  IBM Cognos BI samples 28
  IBM Cognos Configuration 25
  IBM Cognos Connection 26
  installation requirements for 64-bit systems 37
  installing 124
  installing on one computer 32
  Map Manager 29
  Metric Designer 28
  metric store 29
  Metric Studio 26
  optional 27
  other 25
  Query Studio 26
  quick tours 28
  report server 124
  Report Studio 26
  Transformer 28

components for IBM Cognos BI scorecarding
  installing Application Tier Components on separate computer 46
  installing gateway on separate computer 46
  installing on one computer 45

Composite Information Server
  component description 28
  Confidentiality algorithm 354
configuration
  adding resources 482
  advanced options 465
  automating 491
  backing up 444, 466

configuration (continued)
  changing defaults settings 348
  changing the template 478
  Content Manager 34, 47
  cryptographic information cannot be encrypted 547
  data locked 550
default settings 348
error when encrypting information 547
  global settings 388
in silent mode for upgrade 99
issues 544
lock file 524
manual 481
recording errors 514
requirements for Metric Designer 44
requirements for single signon with Microsoft Analysis Server or Microsoft SQL Server 314
running from command line 486
running multiple versions of IBM Cognos BI 114
saving in silent mode 513
settings for IBM Cognos BI 59, 348
settings not applied 552
startup 512
testing 153
Tomcat settings 59
unable to open IBM Cognos Configuration 524
unable to save 551
unattended 491, 495
UNIX 512
upgrade considerations 91, 102

configuration files
  applications.xml for Portal Services 430
coglocale.xml 484
cogstartup.xml 482
exporting 495

configuring
  Active Directory namespace 314
  apache_mod for the gateway 233, 234
  application server properties 453
certificate authority service 468
cognos_onebox components 502
Cognos OneBox modules 503
Cognos OneBox provider 504
custom authentication providers 324
default time zone 393
destination for log messages 376
environment properties for application tier components 203
eTrust SiteMinder namespace 341
forns 361
Framework Manager 41
Framework Manager on different computer 232
gateways 223
IBM Cognos BI 67
IBM Cognos BI for application servers 448
IBM Cognos BI for Microsoft Office 296
IBM Cognos BI to work with other IBM Cognos products 420
IBM Cognos service 478
index search 404
index sharing 405
ISAPI for the gateway 233, 234
LDAP namespace 327
LDAP namespace for Active Directory Server 328
LDAP namespace for IBM Directory Server 330
mail server 188
mail server accounts 149
configuring (continued)
  map charts for Report Studio 367
  notification databases 369
  NTLM namespace 343
  Portal Services 429
  properties in an unattended configuration 484
  RACF namespace 344
  routers 420
  servlets for the gateway 233, 234
  shared trust with other servers 373
  SSL protocol 371
  standby Content Manager 187
  temporary file location 359
  transfer specification files (.ats) 491
  Transformer 41, 250
  unattended 495
  Web browsers 70
  Web server 151, 225, 461
connections
  data source 278
  OLAP data sources 283
console mode
  for installing on UNIX and Linux 17
content expiry
  images directory 151, 225, 461
content locales
  customizing 390
  displaying supported locales 390
  mapping to user locale 391
content manager
  migrate from Apache Derby 100
Content Manager
  active and standby 170
  attempt to register the dispatcher 534
  changing time zones 393
  component 34, 47
  component description 27
  configuration 34, 47
  configuring on multiple computers 187
  error messages 553
  failover protection 34, 47
  fails to start 534
  installation options 34, 47
  installing 124
  log server 376
  requirements for changing application server 443
  requirements if using IBM Cognos Transformer with Series 7 namespace 124, 245, 320
  setting up a content store 370
  standby 34, 47
  upgrade considerations 89
Content Manager service 475
Content Manager URLs 187, 203
content store
  and other locations to store report output 365
  backing up 444, 466
  compatible versions of DB2 and Java 529
  component description 29
  connection management 146, 183
  creating 123, 370
  creating on Oracle 64
  DB2 JDBC drivers 10, 132
  deleting tables from the database 545
  deploying 79
  error initializing in Oracle 559
  importing data 463, 468
  invalid settings 530
content store (continued)
  new default in Version 8.4 15
  requirements for changing application server 443
  support for DB2 on z/OS for Version 8.4 11
  support for Oracle in version 8.4 12
  upgrading 90, 533
  context attribute cannot be deserialized 542
  context error 542
Controller,
  See IBM Cognos Controller
cookies
  customizing 395
  enabling in Web browsers 70
  settings 395
creating
  content store 123
  data source connections to metric store 160, 213
  metric package 160, 213
  metric store 155, 206
cross-script checking
  configuring in IBM Cognos Application Firewall 357
cryptographic error 552
  cogstartup.xml file invalid 552
  JRE error 551
  problems after upgrading 548
  cryptographic information cannot be encrypted 547
  cryptographic keys
    backing up and deleting 444, 466
    generating for other certificate authorities 468
    regenerating 549
cubes
  cannot open 536
  upgrading a secured cube 120
  upgrading PowerCubes 118
Cubing Services
  data source connectivity 138, 197
currency
  customizing support 389
  fonts required for Yen or Won character 294
  won 295
  yen 295
custom authentication providers 324
custom user properties
  Active Directory Server 316
  LDAP 336
D
data
  IBM Cognos samples 267
  importing 83
  locked by IBM Cognos Configuration 550
Data files location
  configuring for Windows Vista 421
Data integration service
  using in IBM Cognos BI 54
Data Movement service
  using in IBM Cognos BI 54
Data Manager
  using in IBM Cognos BI 54
data source connections
  metric stores 160, 213
  setting 146, 183
data sources
  component description 29
  for Framework Manager 153, 230
  for IBM Cognos Transformer 153, 252
  for Metric Designer 153, 241
data sources (continued)
  ODBC connections 140, 199
  samples connections 278
data store,
  See metric store
  database cleanup scripts 545
database client
  requirements for the metric store 211, 238
  requirements for Transformer 42
  requirements for Transformer modelers 424
  setting up for a logging database 379
database connection strings
  IBM DB2 146, 183
  Microsoft SQL Server 146, 183
  Oracle 146, 183
database connections 183
database connectivity
  content store 159
  JDBC connections 141, 200
  OLAP data sources for dynamic query mode 141, 200
  query database 138, 197
  relational data sources for dynamic query mode 141, 200
  reporting database 138, 197
database drivers
  DB2 133, 178
  Informix 137, 181, 381
  Oracle 137, 181
  Sybase 138, 182
databases
  bulk load utility missing 558
  content store 370
  deleting tables 545
  IBM Cognos samples 267
  logging 382
  logging database client 379
  metric store 155, 206
  notification 188
  returning to original state in Event Studio 292
DB2
  client setup 133, 178
  code pages 153, 230, 241, 252
  database connectivity 138, 197
  database drivers 133, 178
  JDBC drivers 10, 132
  metric store 156, 207
  specifying as a log messages repository 382
  supported Java versions 529
DB2 content store 477
  error when running C8DB2.sh script 553
  script 134, 179
DB2-ERR-0005 556
db2java.zip
  deprecated in Version 8.4 17
DecisionStream
  requirements to upgrade catalogs to IBM Cognos BI 51
DecisionStream to IBM Cognos BI
  upgrade consideration 50
  default connection pool time-out
  conflicts between IBM Cognos BI and some application servers 446
deleteTask 258
deleting
  IBM Cognos samples 292
delivery
  decreasing the time to open reports 480
  delivery service 475
deploying
  configuration objects 82
  content store 79
  exporting 79
  failure on Oracle or WebSphere Application Server 542
  importing 83
  moving archives 82
  testing 84, 85
  Transformer for modelers 426
deploying IBM Cognos BI 453
deployment
  permissions 78
  planning 78
  deployment archives moving 82
Deployment files location
  configuring for Windows Vista 421
deployment location for Metric Studio 210
deployments
  creating an export specification 79
Derby
  page cache size 479
diagnostics
  See troubleshooting
dimensional analysis 55
directory not found error 537
disabling
  content maintenance job 290
dispatcher
  unregistering 463
dispatchers
  Application Tier Components computer 560
  importing 82
  system metrics 473
  distributed installations
    configuring Framework Manager 232
    configuring Transformer 250
    Metric Designer 43
    scenarios 31, 44
documentation
  Software Development Kit 6
  translated files 14
domains
  Active Directory Server domain trees 317
  approved for Business Insight 357
  setting for cookies 395
do double-byte characters
  improperly displayed 543
download of resource fails 534
DPR-CMI-4006 error 534
DPR-DPR-1035 error 529
DuseCMLargeResultSet parameter 534
dynamic query mode 138, 197
E
EAR files,
  See Enterprise archive files
e-mail
  configuring mail server accounts 149
e-mail messages
  changing the encoding 394
  embedded fonts 364
  enabling
    IBM Cognos Application Firewall 357
    services 360
Index 571
SSL for an application server 460
Encrypt temporary files property 359
encryption changing settings in unattended configuration 484
configuration errors 547
Enterprise archive files deploying IBM Cognos BI 487
environment properties 144
environment variables configuring for application tier components 203
configuring for Metric Designer 239
for Oracle data source 229
for Transformer on Linux and UNIX 247
requirements on Windows Vista 421
setting for application servers 445
setting up on UNIX for metric store 68
to install IBM Cognos BI on UNIX or Linux 125, 171, 191, 217
environments supported 57
error logs 514
error messages
CAM-CRP-1064 532
CAM-CRP-1315 Current configuration points to a different trust domain 549
CFG-ERR-0106 Cognos Configuration received no response 527
CGI timeout 559
CM-CFG-029 Content Manager is unable to determine 552
CMM-APP-3254 The initialization of the metrics store failed 558
corrupt cryptographic information 552
could not deserialize context attribute 542
cryptographic information cannot be encrypted 547
DIS-ERR-3115 Task execution failed 558
download of specified resource fails 534
DPR-ERR-2014 536
DPR-ERR-2022 No response generated 540
DPR-ERR-2058 534, 537
DPR-ERR-2079 553
HTTP Error 404 537
Java Runtime Environment 551
malformed request 542
MDS-RUN-3213 Unable to locate database bulk load utility 558
page not found 537
PRS-CSE-1255 532
RQP-DEF-0114 544
RSV-SRV-0066 544
servlet class fails to load on WebLogic 560
SoapSocketException 534
SQL1224N 534
Unable to load balance the request 536
you have chosen to download a file 540
errors
ESSBASEPATH 555
Essbase
cube sample 283
ESSBASEPATH adding 555
environment variables 143, 202
eTrust SiteMinder configuring namespaces 341
cross-script checking in IBM Cognos Application Firewall 357
enabling single sign on 342
flicker 561
font embedding lists 364
fonts changing for PDF reports 364
changing the default 364
configuring 361
list of embedded fonts for PDF reports 364
not found when starting IBM Cognos Configuration on UNIX 555
requirements for Japanese and Korean characters 17
requirements for support 363
Framework Manager
accessing IBM Cognos BI outside a firewall 233, 234
component description 28
configuring 41
configuring on different computer 232
cryptographic error 528
installation options 41
installing 227
managing metadata 9
Framework Manager (continued)
sample models 290
setting up data sources 153, 230
system requirements 228
testing installation and configuration 235
uninstalling 498
upgrade considerations 90

G
gateway
configuring for Transformer 250
connection issues 549
gateways
adding in a network to decrease delivery times 480
component description 25
configuration requirements 33, 46
configuring 223
configuring a servlet 233, 234
configuring apache_mod 233, 234
configuring for IBM Cognos BI 396
configuring ISAPI 233, 234
configuring to use a namespace 360
installing 124
installing on separate computer 33
installing on separate computer for IBM Cognos BI
scorecarding 46
log file 525
recommended settings for Microsoft IIS 559
when to use ISAPI 559
go_office.msi file 117
Go! Search
renamed as index search 6
Google OneBox
communication for IBM Cognos BI integration 501
configuration examples 504
configuring Cognos OneBox components 502
Google OneBox for Enterprise
secure authentication 509
Google Search Appliance
Google OneBox integration for IBM Cognos BI 501
graphics service 475
groups
missing membership in Active Directory Server 557

H
histories
deployment 84, 85
HP-UX
environment variables to install IBM Cognos BI 125, 171, 191, 217
HTML cookies,
See cookies
HTTP Error 404 537
HTTP message is unexpectedly short 554
human task service 475

I
IBM Cognos
samples 267
IBM Cognos Administration
component description 26
IBM Cognos Application Firewall
configuring 357
IBM Cognos BI
changing application servers 441
components 25
configuring 67
default settings 123
deploying 453
dispatchers 477
does not start on an application server 550
Google OneBox integration 501
installation options 31
installing 124
logging in 145, 189
maintenance package installation 129, 175, 195, 220
running on same computer as ReportNet 114
service does not start 529
services 477
sharing components on same computer 36
system requirements 58
troubleshooting installations 517
uninstalling 497
updater 129, 175, 195, 220
IBM Cognos BI for Microsoft Office
changed features 20
component description 27
configuring 296
SSL 297
template files 296
using PowerPlay reports 298
IBM Cognos BI portal
problem connecting on 64-bit WebSphere Application Server 549
IBM Cognos BI samples 28
IBM Cognos BI scorecarding
distributing components 44
installing Application Tier Components on separate computer 46
installing components on one computer 45
installing gateway on separate computer 46
IBM Cognos BI server
fails to start 530
IBM Cognos Business Insight
and collaboration 5
report styles 420
test the installation 408
IBM Cognos Configuration
component description 25
font not found error on UNIX 555
invalid settings 530
problems opening 524
problems saving a configuration 544
problems with keyboard navigation 550
trouble generating cryptographic keys after install 548
unable to start 550
unattended mode 495
IBM Cognos Connection
component description 26
unable to open 537
IBM Cognos Controller
considerations when upgrading IBM Cognos BI 91
data access in IBM Cognos BI 53
IBM Cognos DecisionStream
requirements to upgrade catalogs to IBM Cognos BI 51
IBM Cognos Finance
data access in IBM Cognos BI 53
IBM Cognos for Microsoft Office
deploying the client components 298
error using Run Reports 559
IBM Cognos for Microsoft Office (continued)

macro security level for Microsoft Office XP 299
SSL 299
uninstalling 116
upgrading 116

IBM Cognos Go! Dashboard
renamed as IBM Cognos Business Insight 7

IBM Cognos Metrics Manager
creating metric package 160
requirements to upgrade to IBM Cognos BI 51
sharing resources with the IBM Cognos BI server 206
upgrading saved reports from version 2.x to IBM Cognos BI 90
upgrading to IBM Cognos BI 50, 88

IBM Cognos Metrics Manager, install 129, 174, 195, 220

IBM Cognos Mobile
mobile reports 55

IBM Cognos NoticeCast
duplication of functionality in IBM Cognos BI 56

IBM Cognos Office Connection,
See IBM Cognos for Microsoft Office

IBM Cognos Planning - Analyst
data access in IBM Cognos BI 53

IBM Cognos Planning - Contributor
data access in IBM Cognos BI 53
enabling scheduled reports and agents 421
migration to IBM Cognos BI 52

IBM Cognos Portal Services
migration overview 56
IBM Cognos PowerPlay Web
requirements to upgrade reports to IBM Cognos BI 51

IBM Cognos Query
duplication of functionality in IBM Cognos BI 56

IBM Cognos samples 267

IBM Cognos Series 7
enabling single signon 322
enabling SSL 321
migration to IBM Cognos BI 52
trusted signon plug-ins 322
using for authentication 320

IBM Cognos Series 7 PowerCubes
publishing after upgrade 108
requirements for successful language conversion 53

IBM Cognos Series 7 Transformer models
preparing for upgrade to IBM Cognos BI 120

IBM Cognos service
configuring 478
requirements for the user account that is used for the service 143, 182, 202, 222, 348
server not available 530
starting 552
starting from IBM Cognos Configuration 150
starting from the command line 486
stopping 512
stopping from the command line 486

IBM Cognos Transformer
setting up data sources 153, 252

IBM Cognos Visualizer
duplication of functionality in IBM Cognos BI 56

IBM Cognos Web Services
migration overview 56
IBM CognosScript
migration overview 56

IBM Connections
30, 301, 307, 357, 447, 448
fix packs 305
ifixes 305
set up collaboration 407

IBM Connections (continued)
using with IBM Cognos Business Insight for solving business problems 5
IBM DB2
creating connection strings 146, 183
IBM Directory Server
with an LDAP namespace 330
IBM Java Software Development Kit 387
IBM OmniFind Enterprise Edition
adding search function to IBM Cognos BI 406
IBM Support
contacting 520
sending and receiving information 521
IBM WebSphere 441
install Cognos BI 450
IBM WebSphere Application Server
requirements for collaboration with IBM Connections 5
single signon with RACF 345
IBM WebSphere Portal
configuring 429
IIS Web servers
single signon for PowerPlay report based IBM Cognos BI for Microsoft Office documents 298
single signon using Active Directory 318
images
content expiry 151, 225, 461
loading in Report Studio 151, 225, 461
import
custom classes to FileNet 256
importing
configurations 82
data into target environment 83
MDL files from IBM Cognos Series 7 120
samples 288
Impromptu catalogs and reports
migration to IBM Cognos BI 52
Impromptu Web Reports
migration to IBM Cognos BI 52
index data service 475
index search
configuring 404
index search service 475
index update service 476
Informix
creating a logging database 66
creating the content store 66
database drivers 137, 181, 381
specifying as a log messages repository 382
Informix Dynamic Server 8
installation
basic for multiple locations 167
checklist 123
modes 123, 168
options for Content Manager 34, 47
options for Framework Manager 41
options for Transformer 41
requirements for directory name 536
server component options 37
testing 153
testing Framework Manager 235
testing Metric Designer 243
testing Transformer 254
unattended 491
installation directory
differences for 32-bit and 64-bit installations 13
problems after renaming or moving 550
installation file
downloading for Transformer modelers 424
installation options
modeling components 39
installation wizard 117
installing
additional fonts 294
Cognos Content Database separately 174
Framework Manager 227
IBM Cognos BI 123, 124, 491, 492
IBM Cognos BI on Linux 543
in an environment that includes IBM Cognos Controller 91
Metric Designer 236
quick tours 295
sequence for server components 167
Supplementary Language Documentation 293
testing 190, 205, 226
Transformer 21, 245
unattended install 491, 492
using transfer specification file (.ats) 491, 492
using transfer specification files (.ats) 492
Integrated Facility for Linux (IFL) 37
Integrated Windows Authentication
issues 554
interface
customizing language support 388
Internet Explorer
browser settings 70
requirements to support Simplified Chinese 363
invalid cogstartup.xml file 552
invalid settings
content store 530
IBM Cognos Configuration 530
IP address version 402
IPv4 402
IPv6 402
ISAPI
accessing IBM Cognos BI 396
configuring for gateway 233, 234
when to use for a gateway 559
ISAPI gateway
recommended with multiple Content Managers 396

J
Japanese characters
corrupt during installation on Linux 540
display incorrectly after upgrade 543
Japanese currency 295
Japanese font 17
Japanese Yen
font requirements 294
jar file 230
error when starting configuration 551
Java
changing versions 465
configuring servlet gateway for Java-compatible Web servers 401
supported versions for DB2 content store 529
updating runtime environments 131, 177, 230, 467
uses all of CPU 529
Java Archive files,
See jar file
Java error when starting configuration 551
Java Management Extensions
configuring JMX properties for remote monitoring of system metrics 473
with user logs 387
Java Runtime Environment
IBM JRE replaces Sun Java Runtime Environment 15
Java scripts
enabling in Web browsers 70
Java Software Development Kit from IBM 473
Java virtual machine
crashes when importing deployment 554
JAVA_HOME
setting 551
java.lang.NoClassDefFoundError 528
JDBC
database connectivity for content store 159
JDBC connections 141, 200
JDBC driver for DB2
requirements for the metric store 211
JDBC drivers 10, 132
db2java.zip deprecated in Version 8.4 17
setting up Oracle databases 379
job service 476
JobStreams
running in IBM Cognos Connection by using Data Movement service 54
JREs
updating 131, 177, 230, 467
JVM
crashing 444, 465, 466
copying security provider files 230, 467
memory settings for Cognos Content Database 479

K
keyboard
navigation problems 550
keyboard shortcuts 499
Korean characters
corrupt during installation on Linux 540
display incorrectly after upgrade 543
Korean currency 295
Korean font 17
Korean Won
font requirements 294

L
language
customizing for user interface 388
customizing locale content support 390
setting for Transformer user interface 246
language support 14
languages
conversion tables 543
incompatibility after upgrade 543
new support in Version 8.4 9
user interface and message files 17
latency
improving 480
LDAP
Active Directory Server 328
configuring a namespace 327
custom properties 336
editing the External identity mapping property 338
enabling single signon 338
LDAP (continued)
  enabling SSL 337
  IBM Directory Server 330
  Novell Directory Server 332
  Oracle Directory Server 334
  using for authentication 326
library files
  for 32-bit versus 64-bit installation 61
Lifecycle Manager 55
  renamed in IBM Cognos BI, version 10.1.0 6
Linux
  characters not displayed properly 543
  console-mode installation is deprecated 17
  corrupt characters during installation 540
  environment variables for IBM Cognos BI 125, 171, 191, 217
  environment variables for Transformer 247
  log messages 382
  ODBC connections to data sources 140, 199
  on System z 12
  starting and stopping the IBM Cognos service 486
  system requirements 123
  unsupported features and components 57
Linux on System z
  C8DB2.sh script error 553
Linux on System Z
  support for RACF namespace 344
load balancing 67
  configuring mail server settings 188
  enabling and disabling services 360
  setting 34, 46
locales
  displaying supported content locales 390
  displaying supported product locales 388
localhost
  requirement to change to host name or IP address 144
locations
  map charts 367
log database
  deleting tables 545
log destinations
  types of 376
log files 514, 523
  gateway errors 525
  locale configuration 525
  run-time 525
  silent mode 526
  startup configuration 524
  transfer 524
  transfer summary 524
  uninstallation 525
log messages
  See also audit logs
  See also troubleshooting
  enabling for IBM Cognos Application Firewall 357
  log destinations 376
  remote log server 376
logging
  configuring 382
  database 382
  database client 379
  remote log servers 381
  using files 382
logging database
  creating on z/OS 377
  creating using DB2 61
  creating using Informix Dynamic Server database 66
logging database (continued)
  creating using Microsoft SQL Server 65
  creating using Oracle 64
  creating using Sybase 66
  support for DB2 on z/OS for Version 8.4 11
logging in
  configuring security 145, 189
  hiding namespaces during 325, 342
logs
  message processing 376
  service 476
M
mail server
  configuring 188
  mail server accounts configuring 149
maintenance
  improving system performance 473
map charts 367
Map files location
  configuring for Windows Vista 421
Map Manager
  component description 29
  maxProcessor
  increasing for Apache Tomcat 478
MDL files
  importing from IBM Cognos Series 7 120
Metadata service 476
Metric Designer
  component description 28
  configuration requirements 44
  distributing components 43
  installing 236
  setting up data sources 153, 241
  system requirements 236
  testing installation and configuration 243
  uninstalling 498
metric packages
  creating 160, 213
metric store
  component description 29
  creating 155, 206
  creating data source connections 160, 213
  database client requirements 211, 238
  DB2 156, 207
  improving performance 479
  Microsoft SQL Server 157, 207
  Oracle 157, 158, 208, 209
  setting up environment variables on UNIX 68
  upgrading 90, 163, 215
metric stores
  failure 558
Metric Studio
  component description 26
  manually defining the deployment location 210
metrics
  for servers, dispatchers, and services 473
  using as Google OneBox results 507
Metrics Manager
  uninstalling 110
  upgrading 110
  upgrading custom calendars 114
  upgrading security information 110
Metrics Manager service 476
Metrics Manager, install 129, 174, 195, 220
Microsoft
  security update affects memory 530
  Microsoft .NET Framework 298
  Microsoft Analysis Server
    namespace requirement 314
  Microsoft Analysis Services
    setting up MSAS cube samples 280
    setting up the data source environment 153, 230, 241, 252
    single signon to MSAS data sources 318
  Microsoft Analysis Services (MSAS)
    data source connectivity 138, 197
  Microsoft IIS
    requirements to load Business Insight 409
  Microsoft IIS Web servers
    recommended gateway settings 559
  Microsoft Office
    report data service 477
  Microsoft Registry Editor
    increasing sockets or ports 556
  Microsoft SQL Server
    creating connection strings 146, 183
    database connectivity 138, 197
    metric store 157, 207
    namespace requirement 314
    specifying as a log messages repository 382
  migrating
    card.xml 404
    Cognos Go! Search 404
    from other IBM Cognos products to IBM Cognos BI 87
  migration
    from other IBM Cognos products to IBM Cognos BI 52
  Migration service 476
  MIME types
    must be specified in Microsoft IIS to load Business Insight 409
  mobile devices
    using to access reports 55
  modelers
    deploying Transformer 426
  modeling components 28
  installation file for Transformer modelers 424
  installation options 39
  models
    database samples 290
    importing from IBM Cognos Series 7 Transformer 120
    modifying for samples 288
    sample models and packages 263
  monitor service 476
  moving
    deployment archives 82
  Moving from trial upgrade to production environment 85
  MS Cube 536
  MSAS, See Microsoft Analysis Services
  multi_domain_tree 317
  multiple languages 514

N
namespace
  RACF 344
namespaces
  Active Directory Server
    missing group membership 557
    authentication 311
    cannot log on 532
    configuring custom authentication providers 324
    configuring for a gateway 360
    namespaces (continued)
    deleting 346
    hiding during login 325, 342
    recreating 551
    requirements for Content Manager if using Transformer
      with Series 7 namespace 124, 245, 320
  Netegrity SiteMinder
    See eTrust SiteMinder
  Netezza
    data source connectivity 138, 197
    setting up ODBC connections 140, 199
  network outage
    services fail to start 533
  New Metric Package wizard
    upgrading metric store 163, 215
    no response generated 540
  notification database
    configuring 369
    creating 367
    deleting tables 545
    settings for DB2 on z/OS 368
    support for DB2 on z/OS for Version 8.4 11
    tablespaces for DB2 on z/OS 368
  Novell Directory Server
    with an LDAP namespace 332
  NTLM 343
    configuring 343
    enabling single signon 344
  NTLM, 343

O
ODBC connections for data sources 140, 199
OLAP data sources 536
  connections 283
  members missing or inaccessible 557
  operating systems
    affect on upgrade 91
  Oracle
    application server 457
    creating connection strings 146, 183
    database connectivity 138, 197
    database drivers 137, 181
    database JDBC drivers 379
    deployment errors 558
    environment variables for data source 229
    environment variables for metric store on UNIX 68
    metric store 157, 158, 208, 209
    multilingual support 153, 230, 241, 252
    specifying as a log messages repository 382
  Oracle application server 441
  Oracle Application Server
    IBM Cognos BI deployment failure 542
  Oracle content store
    compatibility levels 559
    error initializing 559
  Oracle Directory Server
    with an LDAP namespace 334
  Oracle Essbase
    configuring 142, 201
    query fails 556
    UNIX and 64-bit Microsoft Windows 143, 202
  Oracle ESSBASE
    data source connectivity 138, 197
  Oracle Java SE Development Kit 387, 473
  Oracle WebCenter Interaction Portal 8
    configuring 429
planning an upgrade 75
portal
- errors in starting 537, 540
portal problems
- unable to open 537
Portal Services 429
- availability on Linux 57
- specifying the applications.xml file 430
ports
- changing 351
- default configuration settings 59
- running multiple versions of IBM Cognos BI 114
ports already in use 529
PowerCubes
- access in IBM Cognos BI 53
- cannot open 536
- data source connectivity 138, 197
- published from IBM Cognos Series 7 after upgrade 108
- requirements for successful language conversion 53
- Series 7 120
- upgrading 118
PowerPlay
- considerations for upgrading to IBM Cognos BI 50, 87
- enabling anonymous access for IBM Cognos BI for Microsoft Office 298
- migrating PowerPlay Web reports to IBM Cognos BI 52
PowerPlay Web
- requirements to upgrade reports to IBM Cognos BI 51
presentation service 477
Presentation service
- requirements 474
privileges
- required to install IBM Cognos for Microsoft Office 117
problem determination
- exchanging information with IBM Support 521
- processing log messages 376
product
- name changes 14
- product codes
  - in transfer specification files 496
  - product locales
    - displaying supported locales 388
    - mapping for user interface 393
  - product versions 129, 175, 195, 220
- properties
  - changing in unattended configuration 484
  - configuring for application server 453
- temporary file location 359
protocol
- IP address 402
Q
quality of protection in SSL connections 375
query databases 29
query mode
- compatible versus dynamic 138, 197
query service 477
Query Studio
- changes after upgrading 21
- component description 26
query styles
- in workspaces 420
quick tours
- component description 28
- installing 295
R
RACF
- authentication settings for IBM Cognos BI administrators 344
- connectivity 344
- enabling single signon 345
- RACF account properties
  - mapping to RACF namespace 344
- RACF namespace 344
- recreating the Cognos namespace 551
- relational data sources
  - members missing or inaccessible 557
- release notes
  - reviewing before you install 57
- remote log servers 381
- configuring 382
- removing components from multiple servers 496
- report data service 477
- report distribution
  - on a network 480
- report output
  - reusing 366
  - saving to a file system 365
- sharing with users outside IBM Cognos BI 365
- report server
  - enable 64-bit 145, 204
- Report service
  - list of embedded fonts for PDF reports 364
- requirements 474
- report services 477
samples (continued)
  Essbase cubes 283
  Event Studio 291
  GO data warehouse 263
  GO Sales transactional database 264
  importing 288
  InfoSphere Warehouse Cubing Services 280
  Metric Designer 267
  Metric Studio 286
  models 290
  MSAS cube 280
  OLAP data sources 283
  packages 265
  restoring backup files using scripts for db2 271
  restoring backup files using scripts for oracle 274
  restoring samples databases 268
  sales and marketing data 262
  setting up 267
  The Sample Outdoors Company 260
  TM1 281
  SAP BW
    data source connectivity 138, 197
  SAP Enterprise Portal
    configuring 429
  SAP NetWeaver 441
  saving
    configuration in silent mode 513
    screen flicker 561
  scripts
    creating a content store in DB2 134, 179
    to delete tables from databases 545
    to improve metric store performance 479
  search
    configuring index search 404
    secure authentication
      Google OneBox for Enterprise 509
    secure flag
      setting for cookies 395
    secure LDAP communication 337
  Secure Sockets Layer,
  See SSL protocol
  security
    enabling 145, 189
    issues with Integrated Windows Authentication 554
    settings for Web browsers 58
    upgrading Metrics Manager 110
  security provider files
    copying to application server JVM 230, 467
  Series 7
    migrating to IBM Cognos BI 87
  Series 7 IQD Bridge
    installing 245
      Transformer component 28
    Series 7 PowerCubes
      requirements for successful language conversion 53
  Series 7 PowerPlay
    upgrading saved reports from ReportNet to IBM Cognos BI 90
  Series 7 secured cubes
    opening 120
    upgrading 120
  Series 7 Transformer models
    preparing for upgrade to IBM Cognos BI 120
  server components 25
    installation options 37
    installation sequence 167
server time zones
  changing 393
servers
  system metrics 473
service
  graphics 475
  human task 475
  index data 475
  index search 475
  index update 476
  stopping 512
service pack
  installing 129, 175, 195, 220
services
  adjusting to improve performance 474
  agent 474
  annotation 475
  batch report 475
  Content Manager 475
  data integration 475
  delivery 475
  enabling and disabling 360
  event management 475
  fail to start after network outage 533
IBM Cognos BI 477
  job 476
  log 476
Metadata 476
Metrics Manager 476
Migration 476
monitor 476
presentation 474, 477
query 477
report 477
  Report 474
  report data 477
  starting from the command line 486
  stopping from the command line 486
  system metrics 473
  unable to start 529
  uninstalling 497
servlet gateway
  configuring 401
setting up
  samples 267
  shared deployment location folder
    for Metric Studio 210
shared trust
  setting up between IBM Cognos BI and other servers 373
SharePoint Portal
  configuring 429
shortcut keys 499
shortcut paths
  differences for 32-bit and 64-bit installations 13
silent configurations, 491
silent installations, 491
silent mode, 491
silent uninstallation 496
Simplified Chinese
  requirements if using Internet Explorer 6 363
single signon (continued)
  NTLM namespace 344
  RACF namespace 345
  using IBM Cognos Series 7 namespace 322
smart client
  removed from IBM Cognos BI for Microsoft Office 20
Software Development Kit
  documentation 6
  Software Development Kit applications
    upgrade considerations 89
Solaris
  environment variables to install IBM Cognos BI 125, 171,
    191, 217
  JRE 1.5 553
source control system
  for Framework Manager metadata 9
Source Control Systems property 9
special characters
  in LDAP namespace properties 326
SQL scripts
  to delete databases 545
SSL
  Active Directory Server 316
    configuring for IBM Cognos BI for Microsoft Office 297
    configuring for IBM Cognos for Microsoft Office 299
  enabling for an application server 460
  enabling on Web servers 375
eTrust SiteMinder user directory 342
LDAP namespace 337
quality of protection 375
setting up shared trust with other servers 373
using IBM Cognos Series 7 namespace 321
SSL protocol
  configuring 371
standby Content Manager 34, 47, 170
  configuring 187
starting
  IBM Cognos BI service in silent mode 512
  IBM Cognos Configuration in silent mode 512
  the IBM Cognos service from IBM Cognos
    Configuration 150
starting the IBM Cognos service
  from the command line 486
startup
  configuration lock file 524
  DB2 returns SQL1224N error when connecting from
    AIX 534
download of resource fails 534
  failure without error 530
  IBM Cognos service 552
  page not found 537
  problems 526
  Report Studio does not start 539
  script fails 541
  unable to download cognos.xls 540
  unable to open IBM Cognos Connection 537
  unable to start service 529
startup options 511
startup scripts,
  See application servers
statistics services 477
starting
  IBM Cognos BI service in silent mode 512
  stopping the IBM Cognos service
    from the command line 486
stopping
  IBM Cognos service 552
  IBM Cognos service 512
subscribing
  troubleshooting templates 522
Sun GlassFish Enterprise Server 459
Sun Java Runtime Environment replaced by IBM JRE 15
Supplementary Language Documentation installing 293
new in Version 8.4 14
supported environments 57
Sybase
creating the content store 66
database drivers 138, 182
specifying as a log messages repository 382
Sybase IQ
setting up ODBC connections 140, 199
syslog
destination for log messages 382
system metrics
access from outside IBM Cognos Administration 9
remote monitoring 473
system requirements 58
Framework Manager 228
Metric Designer 236
Transformer 246
System z
installing on Linux 12

T
Tab key
problems in IBM Cognos Configuration 550
tables
deleting from a database 545	
tables spaces 477
DB2 Notification Database on z/OS 368
template
changing the size of template 478
temporary directories
deleting before reinstall 548
temporary file location 359
configuring 359
Temporary files location
configuring for Windows Vista 421
Teradata
data source connectivity 138, 197
test option for command line interface 513
testing
configuration 153
deployment 84, 85
Framework Manager 235
installation 153
Metric Designer 243
Transformer installation 254
testing IBM Cognos configuration silent mode 513
testing the installation 190, 205, 226
IBM Cognos Business Insight 408
Thai email encoding
JRE requirements 394
The Sample Outdoors Company 28
thread execution times
specifying 257
time zones
changing 393
TM1
data source connectivity 138, 197
Tomcat
default configuration settings 59
tuning 478
transfer specification file
using to remove components 496
transfer specification files (.ats)
configuration 491
Transformer
accessing IBM Cognos BI outside a firewall 250
component description 28
component for linking to IQD files from Series 7 28
configuring 41, 250
data access in IBM Cognos BI 53
deploying for modelers 426
environment variables on Linux and UNIX 247
installing options 41
installing 245
language of user interface 246
new features in IBM Cognos BI 21
preparing Series 7 models for upgrade to IBM Cognos BI 120
requirements for Content Manager if using Series 7
namespace 124, 245, 320
steps to test installation 254
system requirements 246
uninstalling 498
upgrading cubes 118
Transformer installation file 424
Transformer models
importing from IBM Cognos Series 7 120
trial upgrade 77
planning the move to the production environment 85
troubleshooting 517
contacting IBM Support 520
Content Manager fails to start 534
exchanging information with IBM Support 521
fixes
getting 520
for a specific user 387
getting fixes 520
identifying problems 517
knowledge bases
searching for troubleshooting solutions 519
logging 376
searching knowledge bases 519
subscribing to support 522
trust domain error
when saving the configuration 549
tuning
Apache Tomcat settings 478
DB2 content store 477

U
UDB,
See DB2
unable to open IBM Cognos Configuration 524
unattended configuration 512
changing properties 484
setting up 491
unattended configurations
upgrading 99
unattended installation
setting up 491
unattended mode 491
unattended uninstallation 496
uninst command 496
uninstalling
Framework Manager 498
IBM Cognos BI 497, 498
uninstalling (continued)
  IBM Cognos for Microsoft Office 116
  Metric Designer 498
  Metrics Manager 110
  ReportNet service 109
  Transformer 498
  uninstnx command 496

UNIX
  console-mode installation is deprecated 17
  deployment location for Metric Studio 210
  environment variables for IBM Cognos BI 125, 171, 191, 217
  environment variables for Oracle data source 229
  environment variables for Transformer 247
  font not found error 555
  log messages 382
  ODBC connections to data sources 140, 199
  setting up environment variables for metric store 68
  starting and stopping the IBM Cognos service 486
  system requirements 123
  UNIX AIX
    support for RACF namespace 344
  unregistering dispatchers 463
  unsupported characters 530
  updater
    installing 129, 175, 195, 220
  updating
    java environment 131, 177, 230, 467
  Upfront
    migrating content to IBM Cognos BI 52
    upgrade
      Series 7 secured PowerCube 120
    upgrading
      See also migrating
  affect on Chinese, Japanese, or Korean characters 543
  changes in product behavior 21
  content store 533
  create test environment 78
  from Metrics Manager 73
  from other IBM Cognos products to IBM Cognos BI 49
  from ReportNet 73
  from Series 7 73
  from Series 7, 87
  IBM Cognos BI 91
  IBM Cognos BI on an application server 463
  IBM Cognos for Microsoft Office 116
  in an environment that includes IBM Cognos Controller 91
  metric store 90, 163, 215
  Metrics Manager 110
  Metrics Manager and security information 110
  other products 99
  planning the move from test to production environment 85
  preparation 75
  problems with cryptographic keys 548
  process 74
  published IBM Cognos Series 7 PowerCubes 108
  ReportNet 88
  ReportNet to IBM Cognos BI 102
  resources 75
  tools that support upgrading from IBM Cognos
    ReportNet 55
  unable to uninstall ReportNet Service 109
  using silent configuration 99

URI
  changing 351
  (continued)
    default configuration settings 59
    URI properties
      requirement to change localhost to host name or IP address 144
    User account
      requirements to run the IBM Cognos service 143, 182, 202, 222, 348
    user credentials
      changing in unattended configuration 484
      user interface
        customizing language support 388
        mapping for product locale 393
        setting the language for Transformer 246
      user locale
        mapping to content locale 391
      user logs 387
    User lookup property
      special characters for LDAP namespace 326
      users
        changing for Cognos Content Database 349
        using multiple languages 513, 514
        UTF-8 513
        encoding for email messages 394

V
  versions
    supported ReportNet upgrades 88
  virtual directories
    IBM Cognos BI 151, 225, 461
  virtual servers
    configuring for IBM Cognos BI 151, 225, 461

W
  WAR files,
    See Web archive files
  Web aliases
    IBM Cognos BI 151, 225, 461
  Web archive files
    deploying IBM Cognos BI 487
  Web browsers
    configuring 70
    errors in starting the Web portal 540
    errors when starting the web portal 537
    security settings 58
  Web servers
    configuring 151, 225, 461
    enabling SSL 375
    servlet gateways 401
    setting Report Studio load time 151, 225, 461
    single signon using Active Directory and IIS Web server 318
  WebLogic
    application server 454, 458
    could not deserialize context attribute 542
    deploying p2pd.war file 542
    servlet class fails to load 560
    startup script 451
    startup script fails 541
  WebLogic Application Server
    IBM Cognos BI fails 541
  WebSphere
    application server 453
    install Cognos BI 450